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Dashboard 

FAQs > Dashboard 

1. What is the Tax Official’s Dashboard? 

The Dashboard is the personalized page of the Tax Official that helps in planning day-to-day work. It is 

the post-login landing page for a Tax Official. 

2. What does it look like? How do I know I have reached the Dashboard? 

Here is a screenshot of the Tax Official’s Dashboard for your reference:  

  

 

3. How can I view the roles allocated to me? 

You can view the roles allocated to you by accessing your profile. You can access your profile by clicking 

on the down arrow provided next to your name and designation in the top right section of the Dashboard. 

A drop-down will appear with the option to view My Profile. 



 

 

4. What are those two icons next to the name and designation of the Tax 

Official? 

The two icons are Alerts (bell icon) & Notifications (notes icon). The numbers on the icons indicate the 

total number of unread Alerts and Notifications. 

5. What are Alerts and Notifications? 

Alerts are the information items that need attention of the Tax Official. For example, work items assigned 

w.r.t New Registration Application Received, Amendment Application Received.  

Notifications are the information items that need attention of the Tax Official due to change in role, 

jurisdiction or any other such matter. For example, New Role Assigned, New Target Allocated.  

6. In the Dashboard, what does Today, Tomorrow and Day After Tomorrow 

indicate? 

The work items are organized based on the statuary timeline within which the Tax Official must take 

action on the work item. 

All pending work items are marked in three colors: 

Red - Critical & due by end of day 

Amber - Due by end of day tomorrow 

Green - Due date is not before end of day tomorrow 

7. What do the numbers in the top bar of the Dashboard indicate? 

The number in the top bar of the Dashboard indicate the number of module-wise pending work items.  
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I have been assigned a new role by my system administrator. Where can I 

view the updated role in the GST Portal?  

You can view the new role as well as work item assigned to you by your system administrator in the alerts 

section at the GST Portal. To view alerts, perform following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click on the alerts icon that appears at the top right of the page to view the various alerts.  

  

Note: 

The bell icon indicates the alerts. By default, the Dashboard of the primary jurisdiction you have been 

assigned will be displayed. All the alerts pertaining to the role assigned to you will be listed. The work-

items triggered from the Taxpayers’ Interface and any new items are also listed under the Alerts section. 

The number on the bell indicate the number of the new work items. 

  

 



 

 

Manual > View Notifications 

My system administrator has reassigned me a couple of work items and 

changed my PAN. Where can I check these changes on the GST Portal? 

The reassigned work items and change in PAN will be listed under the Notifications section. To access 

the notifications section on the GST Portal, perform following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

4. Click the Notification icon that appears at the top right of the page to view the various notifications 

generated for the jurisdiction you have been assigned to. 

3. Click the View All link to view all the notifications. The option enables you to view all the notification 

that are triggered from the System Administrators / Tax Officials’ Interface.  

  

 



 

 

Manual > View Pending Work-Items 

I need to plan my day on the basis of pending work items and follow ups I 

have to complete today. Where can I check the pending work items along 

with their current status on the GST Portal? 

  

You can check the pending work items along with their current status on the dashboard after logging in to 

the GST Portal using valid credentials. To view your dashboard, and view pending work items related to 

different modules, perform following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. The registration tile available at the main page enables you to view the function-wise summary of all 

the pending work items related to registration. Example: Registration, Amendment, Surrender, 

Cancellation Application 

  

 

  

The number of applications listed against different categories count to the total of the number that is 

displayed at the top at the Registration tile. The section under Registration Application displays summary 

based on due date of the application. The work items are displayed on the basis of list -wise and date-

wise breakdown.  

You can click the ARN link to work on the pending work-item. 

  



 

 

 

  

The Monthly Recap section lists the Received vs Pending Applications in a graphical presentation.  

   

 



 

 

Display Holiday Calendar 

FAQs > Display Holiday Calendar 

1. What is the need of creating state wise holiday calendar? 

The State Admin needs to update the list the holidays in calendar so that working days’ calculation of the 

work items is done by the system accurately. 

2. What are the classifications of days in the Holiday Calendar? 

The classifications of days in the Holiday Calendar are as follows:  

1. Working days 

2. Non-working days (All Sundays and non-working Saturdays) 

3. Holidays 

3. Will a State Admin need to create a new Holiday Calendar every year? 

No, the existing calendar will be copied by default for the next calendar year and the necessary edits can 

be made to the calendar. 



 

 

Manual > View Holiday Calendar 

How can I view the holiday calendar on the GST Portal. How can I view? 

To view the holiday calendar on the GST Portal, perform following steps.  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click Help > Holiday Calendar. 

  

The Holiday Calendar is displayed.  



 

 

Leave Application Including Addition of Link Officer 

FAQs > Leave Application Including Addition 
of Link Officer 

1. How can I apply leave on the GST Portal? 

To apply for leave, navigate to Services > Work > Leave Application > Apply Leave  option. In order to 

apply leave, a “link officer” will have to be nominated to take care of work items during the leave period.  

2. What is the role of “Link Officer” while applying for leave? 

Link Officer will be responsible to dispose any pending, and new, work items while the original officer is 

on leave. For example, if an officer Mr. X having “Registration Approval” role in ward-1 is on leave from 

10th Aug 2017 to 15th Aug 2017, then the system will assign all registration ARNs during this period to the 

link officer. It may be noted that current work items and new work items will be assigned to linked officer 

for the time duration for which he/ she has been linked with a tax officer during his/ her leave. It is as good 

as the link officer having additional charge of Mr. X for duration from 10 th Aug 2017 to 15th Aug 2017. 

3. When can I apply for leave? 

Application for leave can be applied on or before leave start date. If there is already a leave applied in the 

GST Portal, system doesn’t allow application of another leave that starts within 5 days of already applied 

leave. In such a case, the previously applied leaves will have to be revoked by the applicant and new 

leaves will have to be applied in system. 

4. How are the applied leaves approved or rejected? 

System shall forward the applied leaves to the reporting officer in the primary jurisdiction. The reporting 

officer has option to reject the leave if he/she disagrees. If the reporting officer takes no action on the 

leave application, the application will be approved by the system 3 days prior to leave start date. 

In case, leave is applied 1 or 2 days prior to leave start date, then it is auto approved by the GST Portal.  

5. How can I view leaves applied by me on the GST Portal? 

To view the applied leaves, navigate to Services > Work > Leave Application > History of Leave 

Applied option. 

6. How can I act on the pending leave applications as a supervisor? 



 

 

To view pending leave applications, navigate to Services > Work > Leave Application > Leave 

Application Pending for your Action option. The reporting officer is not required to approve leaves 

manually – he/she can reject the leave if required. Approval will be done by the system automatically 3 

days prior to the leave start date. 

In case, leave is applied 1 or 2 days prior to leave start date, then it is auto approved by the GST Portal. 

7. I have applied for leaves on the GST Portal. My supervisor has not taken 

action my leave application. What to do next? 

In case, your supervisor has not taken any action, the leave application will be approved by the system 3 

days prior to the leave start date. 

8. Who can be the link officer for my leave duration? 

Link officer is the person responsible to act on the work items under your charge during your leave period. 

The system will assign him/her your roles/jurisdiction (if not already assigned) for the leave period. Upon 

completion of the leave period, or if the leave is revoked early, the role/jurisdiction and related work items 

will be transferred to you by the system. 

Link Officer will be intimated through email for all the success and failure cases for which jurisdiction and 

concerned roles are transferred. 

9. How can I know if my leave application has been approved or rejected? 

The approval/ rejection/ cancellation of leave application is communicated to the leave applicant via 

Email/SMS. Alternatively, the approval status will be available on the GST Portal also.  

10. I have applied for leaves. Can I revoke it now? 

The applicant can revoke his leave application at any point of time for unexpired period of leaves. 

Navigate to Services > Work > Leave History > Revoke  link to revoke the leave application. 

In case, the leave is cancelled before starting of the leave period, the assignment of work items will not 

happen to the link officer. 

In case, the leave is cancelled during the period of leave, the role and work items assigned to the link 

officer will be given back to the applicant.  

11. I have applied for leaves. Can I modify it now? 

Navigate to Services > Work > Leave History > Modify link to modify the leave application. 



 

 

12. I am going on leave. I have assigned my task to a link officer. The link 

officer is also going on leave. What to do next? 

In case, if the link officer also goes on leave by nominating another link officer, this new link officer will 

have access to other linked profiles of the user. 

13. I am a State admin, the present role of the officer on leave is shown as 

Blank. Why? 

During the leave period, the roles of the officer on leave would show as blank. State admin would be able 

to see the past roles in user profile as usual. 

Since the leave use case is to facilitate management of work items, the system shall not restrict state 

admin to assign roles during leave period. However, it is strongly recommended that his/her role and 

jurisdiction access SHOULD NOT be altered through other applications like User Role & Jurisdiction, 

Transfer of Charge etc till the leave period is complete, or till the leave is revoked.  

14. How can link officer be changed in a leave application, either by the 

supervisor or state admin? 

Link officer in an already applied can only be changed by the applicant by modifying the leave application 

before it is approved. Once the transfer of charge is initiated, an e-mail is sent to the linked officer. 



 

 

 

Manual > Leave Application Including 
Addition of Link Officer 

A. Apply for leave 

B. View Leave History 

B. Revoke Leave Application 

C. Modify Leave Application 

D. Act on Pending Leave Application 

How can I apply for leave on the GST Portal? 

To apply for leave on the GST Portal, perform following steps.  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click Services > Work > Leave Application. 

  

 

  

4. The Leave Application page is displayed. Select the Apply Leave link. 

  

 

  

5. The Apply Leave page is displayed.  

  



 

 

 

  

6. The Applied on date is selected by default for the date on which you are applying as today's date. 

7. Select the Type of Leave from the drop-down list. 

  

 

  

8. Select the Applied for Dates for which you want to apply for leaves using the calendar. Once you 

select the dates, Number is days for which leave us applied is auto-populated. 

9. In the Remarks Submitted field, enter the remarks. 

10. Click the Choose File button to upload any document.  

Note: You can upload PDF or JPEG file format with maximum size of upload as 500 KB.  

11. Select the Click here link to link an official to enable access for your work during leave period.  

  



 

 

 

  

12. In the Search Tax Official Name field, enter the Name of the Tax Official to be linked. 

  

 

  

13. Select the name of the Tax Official to enable access for your work during leave period. 

14. Click the LINK button. 

  

 

  

15. Click the CONFIRM button. 

  



 

 

 

  

16. The Tax Official is linked to access your work during leave period. You can click Change/ Remove link 

to change or remove the linked Tax Official. 

Note: Link Officer will be intimated through email for all the success and failure cases for which 

jurisdiction and concerned roles are transferred. 

17. Click the SUBMIT button. 

  

 

  

18. Click the CONFIRM button. 

  



 

 

 

  

19. A confirmation message is displayed. 

  

 

How can I view the history of leaves applied on the GST Portal? 

To view the history of leaves applied on the GST Portal, perform following steps.  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click Services > Work > Leave History. 

  

 

  

4. The History of Leave Applied page is displayed. You can modify/ revoke the leave application.  



 

 

  

 

  

5. Click the Application Number link to view the leave application. 

  

 

  

6. Leave Application details are displayed. 

  

 

How can I revoke the leaves applied on the GST Portal? 

To revoke the leaves applied on the GST Portal, perform following steps.  

  

1. Access the GST Portal. The GST Home page is displayed. 



 

 

2. Using your valid credentials, login to the GST Portal.  

3. Click Services > Work > Leave History. 

  

 

  

4. The History of Leave Applied page is displayed. 

  

 

  

5. Click the Revoke link to revoke the leave application. 

  

 

  

6. Click the CONFIRM button. 

  

 

  



 

 

7. A confirmation message is displayed that leave application has been revoked successfully.  

  

 

How can I modify the leaves applied on the GST Portal? 

To modify the leaves applied on the GST Portal, perform following steps.   

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click Services > Work > Leave History. 

  

 

  

4. The History of Leave Applied page is displayed. 

  

 

  

5. Click the Modify link to modify the leave application. 

  



 

 

 

  

6. Make the changes to the leave application as desired. 

7. Click the MODIFY button to modify the leave application. 

  

 

  

8. Click the CONFIRM button. 

  

 

  

9. A confirmation message is displayed that leave application has been modified successfully.  

  



 

 

 

How can I act on the leave application pending for my action on the GST 

Portal? 

To act on the leave application pending for my action on the GST Portal, perform following steps.  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click Services > Work > Leave Application. 

  

 

  

4. The Leave Application page is displayed. Select the Leave Application Pending for your Action 

link. 

  



 

 

 

  

5. The Leave Application Pending for Action is displayed. Click the Application Number link. 

  

 

  

6. The Leave Application is displayed. 

  

 

  

7 (a). Approve Leave Application 

  

i. Enter the remarks by approver. 

ii. Click the APPROVE button. 



 

 

  

 

  

iii. Click the CONFIRM button. 

  

 

  

iv. A confirmation message is displayed that leave application has been approved. The leave applicant 

will receive and email/sms for intimation. 

  



 

 

 

  

7 (b). Reject Leave Application 

  

i. Enter the remarks by approver. 

ii. Click the REJECT button. 

  

 

  

iii. Click the CONFIRM button. 



 

 

  

 

  

iv. A confirmation message is displayed that leave application has been rejected. The leave applicant will 

receive and email/sms for intimation. 
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Processing Letter of Undertakings (LUT) Filed 

FAQs > Processing Letter of Undertakings 
(LUT) Filed 

1. I am not getting LUT link in my Dashboard. Why? 

You may not have been assigned the role of LUT Processing by the State Admin. Request your State 

Admin to assign you the role of LUT Processing. Once the role is assigned, you will be able to access 

LUT link for further action. 

  

Click here to learn about various roles available in Tax Officials Interface and how Admin can assign the 

role to Tax Officials. 

2. How can I as a Tax Official process LUT applications filed by the 

taxpayer?  

Login to the GST Portal with valid credentials. On the dashboard, navigate to Statutory Functions > LUT 

> Applications for LUT to process Letter of Undertakings (LUT) applications filed by the taxpayer.  

3. How can I as a Tax Official view/ download LUT filed by the taxpayer?  

Login to the GST Portal with valid credentials. On the dashboard, navigate to Services > Applications 

for LUT.  

Click the ‘ARN’ hyperlink. GST Form RFD-11 filed by the taxpayer is displayed and you can click the 

DOWNLOAD AS PDF button to download the LUT. 

4. What will happen if a Tax Official doesn't process the LUT application?  

If the LUT application is not processed by Tax Official within 3 working days, then the application will be 

deemed approved and the status of LUT application will be changed to “Deemed Approved”. When the 

application would be deemed approved after 3 working days, then an order copy will be generated 

through the GST Portal and order will be available for the taxpayer in the downloadable form. Alert will be 

sent to Tax Official on deemed approval along with intimation to the taxpayer.  

5. How can I issue a notice? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > LUT > Applications 

for LUT > Search ARN Page > Case Detail > NOTICES > NOTICE option. 



 

 

6. How can I issue an adjournment? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > LUT > Applications 

for LUT > Search ARN Page > Case Detail > NOTICES > ADJOURNMENT option. 

7. Where can the taxpayers view the notice and order issued to them? 

After logging in to the GST portal, the taxpayers can navigate to Services > User Services > Additional 

Notices & Order option to view the notice and order issued to them.  

8. Where can I view the reply filed by the taxpayers? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > LUT > Applications 

for LUT > Search ARN Page > Case Detail > REPLIES  option. 

9. How can I issue an order? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > LUT > Applications 

for LUT > Search ARN Page > Case Detail > ORDERS option. 

10. In case I need to upload additional documents related to a particular 

case on the GST Portal, where do I upload? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > LUT > Applications 

for LUT > Search ARN Page > Case Detail > ADDITIONAL DOCUMENT option. 

11. What are the various status of the LUT application filed by the 

taxpayer? 

The list below provides the list of statuses of the LUT application filed by the taxpayer: 

1. Submitted: Status of RFD-11 ARN after Taxpayer submits the application successfully   

2. Pending for Clarification: Status of RFD-11 ARN after LUT Processing officer issues notice for 

seeking clarification  

3. Pending for Order: Status of RFD-11 after Taxpayer submitted the reply for notice within 15 working 

days Or Taxpayer do not submit the order within 15 working days and system changes the status from 

pending for clarification to pending for order  

4. Approved: Status of RFD-11 ARN after Tax Official accepts the security furnished by Taxpayer  

5. Rejected: Status of RFD-11 ARN after Tax Official rejects the security furnished by Tax Official  

6. Deemed Approved: Status of RFD-11 ARN in case Tax Official doesn't take any action within 3 

working days 



 

 

7. Expired: On the expiry of LUT application for the particular FY, the status of the LUT application will 

get changed to Expired at the end of the respective FY. 

  



 

 

 

Manual > Processing Letter of Undertakings 
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How can I process Letter of Undertakings (LUT) application filed by the 

taxpayer on the GST Portal? 

To process Letter of Undertakings (LUT) application filed by the taxpayer on the GST Portal, in the role of 

LUT Processing, perform following steps: 

  

A. Search ARN for LUT Processing 

B. Take action using APPLICATIONS tab: View LUT Application filed by the taxpayer 

C. Take action using NOTICES tab:  

 C(1). Issue Notice to the Taxpayer 

 C(2). Issue Adjournment to the Taxpayer, if needed 

D. Take action using REPLIES tab: View Replies furnished by the Taxpayer 

E. Take action using ORDERS tab:  

 E(1). Issue Acceptance Order 

 E(2). Issue Rejection Order 

F. Take action using ADDITIONAL DOCUMENT tab: Upload Additional Document 

  

Click each hyperlink above to know more. 

A. Search ARN for LUT Processing 

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Navigate to Statutory Functions > LUT > Applications for LUT option. 

  

 

  

4. Applications for LUT page is displayed. Choose any one of the displayed fields as your search criteria 

and enter the required information: ARN, Status, From and To Date. 

Note: You must enter data in at least one field to proceed.   

  



 

 

 

  

5. Click the SEARCH button. 

  

 

  

6. Based on your search criteria, the required ARN(s) gets displayed. Click the ARN hyperlink of the LUT 

application you want to act on.   

  

 

  

7. LUT Processing Case Detail page is displayed. From this page, you can initiate LUT processing by 

operating on the tabs provided at the left-hand side of the page: APPLICATIONS, NOTICES, REPLIES, 

ORDERS and ADDITIONAL DOCUMENT. 

  



 

 

 

  

Go back to the Main Menu 

B. View LUT Application filed by the taxpayer 

To view the LUT application filed by the taxpayer, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the APPLICATIONS tab if it is not selected 

by default. This tab displays the LUT application submitted by the taxpayer.  

2. Click the DOWNLOAD AS PDF button to download the LUT application submitted by the taxpayer.  

  



 

 

 



 

 

  

3. The LUT application is downloaded in PDF format. 

  



 

 

 



 

 

  

Go back to the Main Menu 

C (1). Issue Notice to the taxpayer 

To issue notice to the taxpayer, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (Notice/Adjournment) issued against the case created.  

2. Click ADD NOTICE to open the drop-down list and select NOTICE. 

  

 

  

3. The Notice page is displayed. The Subject field is auto-populated.  

  



 

 

 

  

4. Click the Generate Notice Number hyperlink. Notice Number field gets auto-populated.  

5. In case of any previous date of hearing, select the Previous Date of Hearing using the calendar. 

6. In case of any previous date of hearing, select the Status of Previous Hearing using the calendar. 

  

 

  

7. Select the New Date of Hearing using the calendar. 

8. Select the New Time of Hearing. 

9. In the Place of Hearing field, enter the name of the place where you would like to call the taxpayer for 

personal hearing.   

10. Click Upload Notice to upload the document(s) from your system that state the reasons of issuing 

notice. 

  



 

 

 

  

11. Click SUBMIT.  

  

 

  

12. Click PROCEED. 

  



 

 

 

  

13. A success message is displayed that the notice has been issued successfully. The updated Case 

Detail page is displayed, with the table containing the record of the notice just issued and the Status 

updated to "Pending for Clarification". Also, system would send the intimation to the Taxpayer via email 

and SMS, and make this notice available on the Taxpayer's dashboard.  

  

 

  

Go back to the Main Menu 

C (2). Issue an Adjournment, if needed 

To update adjournment details, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (Notice/Adjournment) issued against the case created.  

2. Click ADD NOTICE to open the drop-down list and select ADJOURNMENT. 

  



 

 

 

  

3. The ADJOURNMENT page is displayed. The Subject field is auto-populated.  

  

 

  

4. Click the Generate Notice Number hyperlink. Notice Number field gets auto-populated.  

5. Select the Previous Date of Hearing using the calendar. 

6. Select the Status of  Previous Hearing using the calendar. 

  



 

 

 

  

7. Select the New Date of Hearing using the calendar. 

8. Select the New Time of Hearing. 

9. In the Place of Hearing field, enter the name of the place where you would like to call the taxpayer for 

personal hearing.   

10. Click Upload Notice to upload the document(s) from your machine that state the reasons of issuing 

adjournment. 

  

 

  

11. Click SUBMIT.  

  



 

 

 

  

12. Click PROCEED. 

  

 

  

13. A success message is dispayed that the notice has been issued successfully. The updated Case 

Detail page is displayed, with the table containing the record of the adjournment just issued and the 

Status updated to "Pending for Clarification". Also, system would send the intimation to the Taxpayer via 

email and SMS, and make this notice available on the Taxpayer's dashboard.  

  



 

 

 

  

Go back to the Main Menu 

D. View Replies furnished by the Taxpayer 

To view replies submitted by the taxpayer, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the REPLIES tab. This tab displays all 

replies filed by the Taxpayer. 

2. Click the Reply Number link to view the reply submitted by the taxpayer and you can click the 

documents in the Attachments section to download and ascertain contents of any additional documents, 

if any.  

  

 

  

Go back to the Main Menu 

E (1). Issue Acceptance Order 



 

 

To issue acceptance order for LUT application submitted by the taxpayer, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab if it is not selected by 

default. This tab displays a table of all the records for which you would issue orders against the case 

created.  

2. Click ADD ORDER to open the drop-down list and select ACCEPTANCE ORDER. 

  

 

  

3. The Acceptance Order page is displayed. 

  

 

  

4. Click the Generate Order Number hyperlink. Order Number field gets auto-populated.  

5. Click the Upload Order to upload the order from your machine. 

  



 

 

 

  

6. Click SUBMIT.  

  

 

  

7. Click PROCEED. 

  

 

  

8. A success message is dispayed that the order has been passed successfully. The updated Case 

Detail page is displayed, with the table containing the record of the order just issued and the Status 



 

 

updated to "Approved". Also, system would send the intimation to the Taxpayer via email and SMS, and 

make this order available on the Taxpayer's dashboard.  

  

 

  

Go back to the Main Menu 

E (2). Issue Rejection Order 

To issue rejection order for LUT application submitted by the taxpayer, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab if it is not selected by 

default. This tab displays a table of all the records for which you would issue orders against the case 

created.  

2. Click ADD ORDER to open the drop-down list and select REJECTION ORDER. 

  

 

  

3. The Rejection Order page is displayed. 

  



 

 

 

  

4. Click the Generate Order Number hyperlink. Order Number field gets auto-populated.  

5. Click the Upload Order to upload the order from your machine. 

  

 

  

6. Click SUBMIT.  

  



 

 

 

  

7. Click PROCEED. 

  

 

  

8. A success message is dispayed that the order has been passed successfully. The updated Case 

Detail page is displayed, with the table containing the record of the order just issued and the Status 

updated to "Rejected". Also, system would send the intimation to the Taxpayer via email and SMS, and 

make this order available on the Taxpayer's dashboard.  

  



 

 

 

  

Go back to the Main Menu 

F. Upload Additional Document 

To upload any additional document related to the case, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ADDITIONAL DOCUMENT tab if it is 

not selected by default.  

2. Click ADD DOCUMENT. 

  

 

  

3. Select the Date of Hearing using the calendar. 

4. In the Document Description field, enter the description of the document which is being uploaded.  

5. In the Document Submitted By field, enter the name of the person whic has submitted the document 

which is being uploaded. 

6. Click Upload Additional Document to upload the document(s) from your machine. 

  



 

 

 

  

7. Click SUBMIT. 

  

 

  

8. Click PROCEED. 

  

 

  



 

 

9. A success message is dispayed that the document has been issued successfully. The updated Case 

Detail page is displayed, with the table containing the record of the document just uploaded.  

  

 

  

Go back to the Main Menu 

  



 

 

Enable or Disable LUT 

Manual > Enable or Disable LUT 

How can I enable or disable Letter of Undertakings (LUT) on the GST 

Portal? 

To enable or disable Letter of Undertakings (LUT) on the GST Portal, in the role of LUT Processing, 

perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Navigate to Statutory Functions > LUT> Enable or Disable LUT option. 

  

 

  

4. The Enable or Disable LUT page is displayed. 

  

 

  

5. Enter the GSTIN to be enabled or disabled for LUT. 

6. Click the ADD button. 

Note: Maximum 10 valid GSTINs can be entered at a time. 

  



 

 

 

  

7. In case, you want to add more GSTIN, enter the GSTIN and click the ADD button. 

  

 

  

8. Select the radio button for Letter of Undertaking. 

9. Enter the reason for enabling or disabling the GSTIN. 

10. Click ENABLE or DISABLE to enable or disable the GSTIN. 

  



 

 

 

  

11. A confirmation is displayed that Letter of Undertaking is enabled or disabled for GSTIN.  

 If LUT Processing Officer clicks on Enable button, the LUT filing will get enabled for the entered 

GSTIN(s). SMS and Email will be sent to Taxpayer intimating about the enabling of LUT filing.  

 If LUT Processing Officer clicks on Disable button, the LUT filing will get disabled for entered 

GSTIN(s). SMS and Email will be sent to Taxpayer intimating about the enabling of LUT filing.  

  

 

  



 

 

 



 

 

FAQs > Enable or Disable LUT 

1. I am not getting Enable or Disable LUT link in my Dashboard. Why? 

You may not have been assigned the role of LUT Processing by the State Admin. Request your State 

Admin to assign you the role of LUT Processing. Once the role is assigned, you will be able to access 

Enable or Disable LUT link for further action. 

  

Click here to learn about various roles available in Tax Officials Interface and how Admin can assign the 

role to Tax Officials. 

2. How can I as a Tax Official Enable or Disable LUT filing by the taxpayer?  

Login to the GST Portal with valid credentials. On the dashboard, navigate to Statutory Functions > LUT 

> Enable or Disable LUT option. 

3. When can I disable LUT filing by the taxpayer?  

If any taxpayer has satisfied the conditions of furnishing LUT, then LUT Processing Officer can disable 

LUT for such taxpayer on the GST Portal. 

4. When can I enable LUT filing by the taxpayer?  

You can enable LUT filing  for those Taxpayers who paid there IGST Tax liabilities along with interest and 

fulfill the criteria for furnishing LUT as per GST Law.  

5. Can a taxpayer raise request from GST Portal to enable LUT?  

If LUT Processing Officer has disabled the furnishing of LUT for some taxpayer, then to get it enabled, 

taxpayer has to communicate to LUT Processing Officer physically. From GST Portal, taxpayer cannot 

raise the request to enable furnishing of LUT. 

6. How many GSTINs can be enabled or disabled for LUT filing at a time?  

Maximum 10 GSTINs can be enabled or disabled for LUT filing at a time.  

7. What will happen when Tax Official enables or disabled LUT filing for 

GSTIN?  



 

 

 If LUT Processing Officer clicks on Enable button, the LUT filing will get enabled for the entered 

GSTIN(s). SMS and Email will be sent to Taxpayer intimating about the enabling of LUT filing.  

 If LUT Processing Officer clicks on Disable button, the LUT filing will get disabled for entered 

GSTIN(s). SMS and Email will be sent to Taxpayer intimating about the enabling of LUT filing.  

  





 

 

Processing Registration Application 

Overview > Processing Registration 
Application 

Processing of New Registration Application 

 FAQs 

 Manual 

Processing of Application for Extension of Registration Period for Casual / 

Non Resident Taxpayer  

 FAQs 

 Manual 

Processing of Enrolment Applications for Migrated Taxpayers 

 FAQs 

 Manual 

Processing of Amendment Application 

 FAQs 

 Manual 

Processing of Enrolment of GST Practitioner 

 FAQs 

 Manual 

Processing of TDS/ TCS Registration Application 

 FAQs 

 Manual 

Processing of Non-Resident Taxable Person Registration Application 

 FAQs 



 

 

 Manual 

Processing of Application for allotment of UIN by UN bodies, Embassies or 

Other Notified Person 

 FAQs 

 Manual 

Processing of Application for Revocation of Cancelled Registration 

 FAQs 

 Manual 

Processing of Cancellation of Registration Application 

 FAQs 

 Manual 

Correction of Jurisdiction before Approval 

 FAQs 

 Manual 

Reset of email address/ and mobile phone number of Authorized Signatory 

 FAQs 

 Manual 

Addition of Authorised Signatory In Case of Death of Sole Proprietor 

 FAQs 

Suo Moto Registration 

 FAQs 

 Manual 

Suo Moto Cancellation 

 FAQs 

 Manual 



 

 

Handling Registrations for Non-Resident Online Services Provider on 

Request Basis 

 FAQs 

Post Registration Field Visit 

 FAQs 

 Manual 

“GST Field Visit” Mobile App 

 FAQs 

 Manual 

  



 

 

 

Overview > Processing Registration 
Application 

Processing of New Registration Application 

 FAQs 

 Manual 

Processing of Application for Extension of Registration Period for Casual / 

Non Resident Taxpayer  

 FAQs 

 Manual 

Processing of Enrolment Applications for Migrated Taxpayers 

 FAQs 

 Manual 

Processing of Amendment Application 

 FAQs 

 Manual 

Processing of Enrolment of GST Practitioner 

 FAQs 

 Manual 

Processing of TDS/ TCS Registration Application 

 FAQs 

 Manual 

Processing of Non-Resident Taxable Person Registration Application 

 FAQs 

 Manual 



 

 

Processing of Application for allotment of UIN by UN bodies, Embassies or 

Other Notified Person 

 FAQs 

 Manual 

Processing of Application for Revocation of Cancelled Registration 

 FAQs 

 Manual 

Processing of Cancellation of Registration Application 

 FAQs 

 Manual 

Correction of Jurisdiction before Approval 

 FAQs 

 Manual 

Reset of email address/ and mobile phone number of Authorized Signatory 

 FAQs 

 Manual 

Addition of Authorised Signatory In Case of Death of Sole Proprietor 

 FAQs 

Suo Moto Registration 

 FAQs 

 Manual 

Suo Moto Cancellation 

 FAQs 

 Manual 



 

 

Handling Registrations for Non-Resident Online Services Provider on 

Request Basis 

 FAQs 

Post Registration Field Visit 

 FAQs 

 Manual 

“GST Field Visit” Mobile App 

 FAQs 

 Manual 

  

  



 

 

Processing of New Registration Application 

FAQs > Processing of New Registration 
Application 

1. How can I access the pending New Registration Applications? 

Here is a screenshot of the Tax Official’s Dashboard detailing the access for pending New Registration 

Applications for your reference: 

  

 

  

Step 1: Click on Registration tile 

Step 2: Click on Registration Applications 

Step 3: Select the application to process from the list by clicking on the relevant ARN 

2. How do I know the due date for processing an application? 

The due date for a New Registration Application submitted by the taxpayer is displayed in the list -wise 

breakdown of pending applications. Not only that, all applications are colour coded to indicate criticality of 

action w.r.t. the due date as follows: 



 

 

Red – due today 

Amber - due tomorrow 

Green – due day after tomorrow 

3. I have opened an application for processing. What is the next step? 

Once you open an application for processing, you can begin a section-wise review. After reviewing a 

particular section, click the VERIFY & CONTINUE button at the bottom right of the page to move to the 

next section. 

Once you have completed all the sections, you can APPROVE or RAISE NOTICE SEEKING 

CLARIFICATION in case you have raised queries. 

4. There are multiple sections in the application form. Can I navigate to 

other sections during processing the application? 

Yes, as a Tax Official, you can view the sections of the application in any order you choose.  

5. Can I verify and continue even if I have raised a query in the section? 

Yes, you must click on VERIFY & CONTINUE for every section before you can pass an order on the 

application. 

Every time you successfully verify a section without any queries, the section header will turn blue along 

with a check mark indicating you have reviewed the section. 

In case you have raised queries, the number of queries raised in a particular section will be displayed via 

a yellow flag in the section header. 

Please refer to screenshot: 

  

 

6. How do I raise a query? 

In every section, you can see monitor-like icons next to the sub-sections. Simply click on this icon and a 

query box will open as a pop-up. You can choose any of the predefined queries or select the ‘Others’ 

option to add a custom query. Once you have selected the query, click on add query and the relevant 

field (on which the query has been raised) will get underlined in yellow. 

Note: It is mandatory to add custom remarks/comments even if you select a predefined query.  

7. How many queries can I raise in a given application? 



 

 

There is no restriction on the number of queries. 

8. Where can I see the number of queries I have raised? 

In case you have raised queries, the number of queries raised in a particular section will be displayed via 

a yellow flag in the section header. 

Please refer to screenshot: 

  

 

9. There is a Remarks section on the final page. What is it for? 

The Remarks section is for any comments you wish to add to the application for your personal reference. 

These are confidential remarks and cannot be seen by anyone except you. 

10. I have processed the complete application and want to reject it but I 

can’t see a REJECT button. Why? 

As a Tax Official, you cannot reject an application upon first review. The principal of natural justice 

demands that you afford the applicant an opportunity to be heard. Therefore, if there are inconsistencies 

in the application, you can raise a Notice Seeking Clarification. The taxpayer has seven working days to 

respond to this notice. In case the taxpayer fails to respond to the notice or provides an unsatisfactory 

response, only then can you reject their application. 

11. I am not being able to APPROVE or raise a NOTICE SEEKING 

CLARIFICATION. Why? 

Please make sure you have reviewed each section and clicked on VERIFY & CONTINUE. You also need 

to mandatorily enter a comment in the Remarks section. 

12. New Registration Application is auto approved. What action do I as a 

tax Official need to take? 

No action needs to be taken by the Tax Official. In case, you want  to cancel the registration, you can 

initiate cancellation of the Registration Application, as and when the facility is provided to the Tax official.  

13. What happens when I approve the application? 



 

 

Once you successfully approve the application, the system generates your approval order and that is e-

mailed to the applicant taxpayer along with the Registration Certificate digitally signed.  

You can preview the e-mail and certificate before sending it to the taxpayer. 

14. What happens when I raise a Notice Seeking Clarification? 

Once you raise a Notice Seeking Clarification, the system generates your order and sends an e-mail to 

the applicant taxpayer with a summary of all the queries raised duly digitally signed. You can preview the 

e-mail and notice before sending it to the taxpayer. 

15. I work in a densely populated district/ ward. Is there any facility for bulk 

approval of New Registration Applications? 

No, there is no bulk approval facility. As a Tax Official, you are required to review each application 

independently and pass the necessary statutory  order. 

16. How can I track existing registrations mapped to same PAN of the 

business/ entity on the GST Portal during processing of the new 

registration application? 

While processing the enrollment application of GSTP or any registration application of a taxpayer, you 

can click on ‘Existing Registrations’ hyperlink available above Application header.  

You will thus be able to view all the submitted applications mapped to a single PAN.  

17. Where can a taxpayer add Bank Account details? 

Details to be entered in Bank Accounts tab has been made optional w.e.f. 27th Dec 2018 . Taxpayer can 

now enter the Bank Accounts details by filing an Amendment application. When a taxpayer logs in for the 

first time on the GST Portal, he/ she will be prompted to file a non-core amendment application to enter 

Bank Accounts details. 



 

 

 

Manual > Processing of Registration 
Application for New Registration 

How can I process the application filed for new registration? 

Once the Application for Registration gets filed, the application form will be forwarded to one of the Tax 

Authorities (Centre/ State) based on a predefined logic.  

For processing the application for new registration, perform following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. The Tax Official’s Dashboard is displayed. Click on the Registration tab. This tab shows all the 

different type of applications pending with tax official for processing. Click on the Registration 

Application link to view the list of ARN Numbers of Registration Applications that needs to be processed.  

  

 

  

4. Select the ARN Number of the Registration Application.  

Note: 

 The ARNs are arranged in the descending order of the Due Date. The application submitted first 

will be shown above in the list. 

 The Due Date column displays the date by when the pending task/ action should be completed. 

 The Status column displays the current status of the registration application.  



 

 

  

 

  

Note: In case Tax Official takes no action or fails to take any action, within three working days from the 

date of submission of the Registration application, the application for registration shall deemed to have 

been approved. 

  

On clicking ARN, the application form filed by the taxpayer is displayed for processing. The header 

contains various blocks containing information pertaining to each section. The rest of the webpage forms 

the application body and contains information filled-in by the Taxpayer. 

  



 

 

 

Existing Registrations 

Note: To view existing registrations mapped to same PAN, click on ‘Existing Registrations’ hyperlink 

available above Application header. 
It is possible that an applicant is registered as a taxpayer as well as GSTP. In such cases, the existing 
registrations of the applicant as taxpayer 'having same PAN' will be visible from Existing Registrations’ 

hyperlink.  

  

 

  



 

 

On clicking, ‘Existing Registrations’ hyperlink, a new screen will be populated displaying details of as on 

date: 

(i) Status of all the applications for registrations (ARNs) mapped to PAN and pending with tax official for 

processing / clarifications / Order / Rejected. 

(ii) Status of all the application for registration (ARNs) mapped to PAN and approved.  

(iii) Status of the GSTIN. This will include Temporary IDs generated against that PAN. 

  

 

  

(a) Click ARN hyperlink. 

  

 

  

On clicking ARN hyperlink, Tax Official will be redirected to ‘Search ARN Details'’ page, from where he 

can retrieve the details of that ARN. 

Click here to know more about Search ARN Details. 



 

 

  

 

  

(b) Click GSTIN/ UIN/ GSTPID hyperlink. 

  

 

  

On clicking GSTIN/ UIN/ GSTPID hyperlink, Tax Official will be redirected to ‘Get Taxpayer Details’ page, 

from where he can retrieve the details of that GSTIN. 

Click here to know more Get Taxpayer Details. 

  

 

  

(c) Click Reason for Rejection hyperlink. 

  



 

 

 

  

On clicking Reason for Rejection hyperlink, the reasons for rejection of application is displayed. Click the 

OK button. 

  

 

  

Note: During processing of a new Registration application, you can: 

 Raise a query in case you wish to seek any clarification from the Taxpayer, with respect to 

deficient information or any document required to furnish the application.  

 Generate notice seeking clarification regarding the query raised.  

  

Add Query 

Review each section thoroughly. Click the monitor icon displayed adjacent to the section headers to raise 

a query. The Queries page is displayed. 

  



 

 

 

  

a. In the Choose the field drop-down list, select the field for which you want to raise the query. 

b. In the Choose the query drop-down list, select the query to be raised. 

c. Click the ADD QUERY button. Queries will be displayed in the below table. 

  

 

  

d. Once added, your query appears as shown. You can raise multiple queries, if required. Once done, 

click OK.  

  

 

  



 

 

The section with queries gets highlighted with a yellow underline.  

  

 

  

Query section of each page has an option of “Others”. You can select this option to add free text query in 

the page. 

  

5. Click the VERIFY & CONTINUE button to move ahead and review other tabs. 

  

 

  

To approve a registration application, you must visit each tab and verify each page of the form. A check 

mark appearing on the tab indicates, the page has been verified.  

  



 

 

 

  

6. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference. 

  

 

  

 In case Tax Official takes no action or fails to take any action, within 3 working days from the date of 

the receipt of application, the application for registration shall deemed to have been approved.  

 In case of GENERATE SCN: 

a. Click the GENERATE SCN button. The Notice for seeking clarifications is generated for the 

queries raised. 

b. Click the GENERATE SCN button again. 



 

 

c. Click the PROCEED button. 

d. Affix your DSC. 

Note: The Taxpayer will be given 7 working days’ time to file reply to the Notice for seeking 

clarifications. In case taxpayer does not respond within 7 working days’ time, work -item will go 

back to Tax Official for processing and the Tax Official can only reject the application.  

 In case of APPROVE: 

a. Click the APPROVE button. 

b. Click the PROCEED button. 

c. Affix your DSC. 

Note: 

On approval, work-item will get closed. The Registration Certificate will be issued to the taxpayer. 

The taxpayer/ applicant will be communicated about approval through SMS and Email of the 

Primary Authorized Signatory. 

 Reject button will not be visible to the Tax Official until response to Notice generated has been 

received or time limit of filing of response to Notice of 7 working days has been expired.  

  

Once the taxpayer has responded to the queries. Tax Official can approve or reject the application within 

7 working days. 

Note: 

 In case Tax Official takes no action, within seven working days from the date of receipt of 

clarification/ additional information/ documents, the application for registration shall deemed to 

have been approved. 

 GENERATE SCN button will be disabled as notice can only be raised once. 

 Application can be approved only when all the tabs are verified.  

  

In case of APPROVE: 

a. Click the APPROVE button. 

b. Click the PROCEED button. 

c. Affix your DSC. 

Note: 

On approval, work-item will get closed. The Registration Certificate will be issued to the taxpayer. The 

Primary Authorized Signatory will be communicated about approval of the application through SMS or 

Email. 

  

In case of REJECT: 

a. Click the REJECT button. 

b. Order of rejection is generated. Click the GENERATE ORDER button. 

c. Click the PROCEED button. 

d. Affix your DSC. 

Note:  

 On rejection, work-item will get closed. 



 

 

 Auto-rejection of the application is not allowed in the system. 

 Rejection order will be generated specifying the reasons for rejection of the application. The 

Primary Authorized Signatory will be communicated about rejection of the application through 

SMS or Email. 



 

 

Processing of Application for Extension of 
Registration Period for Casual / Non Resident 
Taxpayer 

FAQs > Processing of Application for 
Extension of Registration Period for Casual / 
Non Resident Taxpayer 

1. How can I access, Extension of Registration Period for Casual / Non 

Resident Taxpayer Applications, for processing? 

You will receive Work item to process the application for Extension of Registration Period for Casual / 

Non Resident Taxpayer Applications in your Dashboard under the head – Registrations > Application 

for Extension of Registration Period for Casual and NRTP Taxpayer. 

2. I have opened a pending Extension of Registration Period for Casual / 

Non Resident Taxpayer Application for processing. What is the next step? 

Once you click on “Application for Extension of Registration Period for Casual / Non Resident Taxpayer 

for processing”, you can begin a section-wise review. After reviewing a particular section, click the 

VERIFY & CONTINUE button at the bottom right of the page to move to the next section.  

Once you have completed all the sections, you can APPROVE or GENERATE SCN in case you have 

raised queries. 

3. What actions can be taken by Tax Official for processing of Extension of 

Registration Period for Casual / Non Resident Taxpayer Application? 

Description/ Activity 
Time Frame and Action to be taken by 

Tax Official  

First time processing of 

Extension of Registration Period 

for Casual / Non Resident 

Taxpayer Application  

While processing the application, Tax Official 

is required to take action within 3 working days 

from the date of generation of ARN. 

Tax Official can either ‘Approve’ or Raise SCN 

for the Application within 3 working days of 

ARN generation.   

No Action by Tax Official on 

application  

Deemed approved if no action is taken by Tax 

Official in 3 working days of ARN generation. 



 

 

In case of incomplete application 

or documents  

Tax Official can generate SCN within 3 

working days of ARN generation. 

Time Limit for Taxpayer to 

respond to the Show Cause 

Notice (SCN) issued  

Within 7 working days of receiving the Show 

Cause Notice. 

If no reply has been submitted by the 

Taxpayer within <7> working days of issue of 

SCN, Application cannot be approved. Form 

can only be rejected by the Tax Official and 

only order for rejection can be issued.  

Action (Approve/ Reject) to be 

taken by the Tax Officer on 

receipt of response of Show 

Cause Notice (SCN)  

Tax Official to ‘Approve’ or ‘Reject’ the 

Application within 7 working days from date of 

receipt of response to Notice Seeking 

Clarification. 

If no action is taken by Tax Official, New 

Registration Application will be deemed 

Approved within 7 working days from the 

receipt of the response to notice seeking 

clarification 

4. There are multiple sections in the application form. Can I navigate to 

other sections during processing the application? 

Yes, as a Tax Official, you can view the sections of the application in any order you choose. But you need 

to click on verify and continue in every section you navigate in order to save the queries raised, if any.  

5. Can I verify and continue even if I have raised a query in the section? 

Yes, you are required to click on VERIFY & CONTINUE for every section before you can pass an order 

on the application. 

  

Every time you successfully verify a section without any queries, the section header will turn blue along 

with a check mark, indicating that you have reviewed that section.  

6. How do I raise a query? 

In every section, you can see monitor-like icons next to the sub-sections. Simply click on this icon and a 

query box will open as a pop-up. You can choose any of the predefined queries or select the ‘Others’ 

option to add a custom query. Once you have selected the query, click on Add Query and the relevant 

field (on which the query has been raised) will get underlined in yellow.  

  



 

 

Note: It is mandatory to add custom remarks/comments even if you select a predefined query.  

7. How many queries can I raise in a given application? 

There is no restriction on the number of queries that can be raised. You can raise multiple queries.  

8. There is a Remarks section on the final page. What is it for? 

The Remarks section is for any comments you wish to add to the application for your internal reference. 

These are confidential remarks and cannot be seen by anyone except you.  

9. I have processed the complete application and want to reject it but I can’t 

see a REJECT button. Why? 

As a Tax Official, you cannot reject an application upon first review. The principal of natural justice 

demands that you afford the applicant an opportunity to be heard. Therefore, if there are inconsistencies 

in the application, you can generate Show Cause Notice (SCN). The Taxpayer has seven working days to 

respond to this notice. In case the Taxpayer fails to respond to the notice or provides an unsatisfactory 

response, only then you can reject the application.  

10. What happens when I approve the application for Extension of 

Registration Period for Casual / Non Resident Taxpayer? 

1. On Approval of the application, work-item will get closed. Status of the ARN will change to 

“Approved” 

2. Extended Registration Certificate will be generated with updated “Valid To” date and intimated to the 

taxpayer via Email and SMS. “Valid From” date shall remain the same.  

3. GSTIN status as “Active” will be extended for the time period for which extension has been granted.  

4. Registration Certificate will also be available at the Dashboard of the Taxpayer for view, print and 

download. 

11. What happens when I raise a Show Cause Notice? 

1. Status of ARN changes to Pending for Clarifications. 

2. Notice Seeking Clarifications is generated and the same will be available on dashboard to help 

taxpayer to provide clarifications. 

3. Notice in the predefined format will be generated, digitally signed and sent to the applicant and the 

same is available in “Notices and Orders” section on taxpayer's dashboard.  

4. An intimation is sent to taxpayer that Notice Seeking Clarifications has been generated via email and 

sms.  



 

 

12. What happens when I reject the application for Extension of 

Registration Period for Casual / Non Resident Taxpayer? 

1. On rejection of the application, work-item will get closed. ARN status will be changed to “Rejected” 

2. Rejection Order will get generated stating the reasons for rejection of the application.  

3. The taxpayer will be communicated about rejection by SMS/ Email.  

4. Rejection order digitally signed by the Tax Official, would be available on the GST Portal.  

5. Intimation of Rejection Order and ID will be sent to primary authorized signatory via email and SMS.  

13. What happens when I don't sign the RC? 

After deemed approval, every day an alert will be displayed on your dashboard, for such an ARN, to sign 

the Registration Certificate. 
In case you fail to sign the RC within 3 days from the deemed approval of application, an alert will be sent 
to Commissioner. 



 

 

 

Manual > Processing of Application for 
Extension of Registration Period for Casual / 
Non Resident Taxpayer 

How can I process the application filed for extension of Registration Period 

for Casual / Non Resident Taxpayer? 

For processing the application filed for extension of Registration Period for Casual / Non Resident 

Taxpayer, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal. The Tax Official’s Dashboard is displayed.  

3. Click the Registration tab. This tab shows all the different type of applications pending with tax official 

for processing. 

4. Click the Application for Extension of Registration Period for Casual and NRTP Taxpayer  link to 

view the list of corresponding ARNs that are waiting to be processed. 

  

 

  

5. Select the ARN that you wish to process. 

Note: 

 The ARNs are arranged in the descending order of the Due Date. The application submitted first 

will be shown above in the list. 

 The Due Date column displays the date by when the pending task / action should be completed.  



 

 

 The Status column displays the current status of the registration application.  

  

 

  

6. If the Application for extension of Registration Period has come for first time for processing, or is it a 

resubmitted application, please notice that: 

 In case the application has been routed to the Tax Official for processing for the first time, the 

Status will be "Pending for Processing". 

 In case the application has been re-submitted with responses to the queries to the Tax Official, 

the Status will be "Pending for Order". 

  

7. On clicking ARN, the application form filed by the applicant is displayed for processing. The header 

contains various blocks containing information pertaining to each section. The rest of the webpage forms 

the application body and contains information filled-in by the applicant. 

  

 

  

8. (a) In case the application for extension of Registration Period is processed for the first time, the Tax 

Officials can take the following actions: 

• Generate SCN 

• Approve 

  

(b) In case Tax Official takes no action or fails to take any action, within 3 working days from the date of 

generation of ARN, the application for extension of Registration Period will be deemed approved.  

In case the Tax Official fails to sign the Registration Certificate within 3 days from the deemed approval of 

application, an alert will be sent to Commissioner. 

  



 

 

Accordingly, the Tax Official can view only two buttons - Approve and Generate SCN. 

  

(c) In case the Tax Official does not take any action, or fails to take an action within 7 working days from 

the date of the receipt of response to SCN, the application for extension of Registration Period will be 

deemed approved. 

In case the Tax Official fails to sign the Registration Certificate within 3 days from the deemed approval of 

application, an alert will be sent to Commissioner. 

  

(d) Tax Officials can take following actions, in case the application for extension of Registration Period is 

resubmitted with clarification: 

• Approve 

• Reject 

  

Accordingly, the Tax Official can view only two buttons - Approve and Reject. 

Generate SCN in case of first time receipt of the application for extension 

of Registration Period 

While processing the application for extension of Registration Period, you can:  

• Raise a query in case you wish to seek any clarification from the applicant, with respect to deficient 

information or any document required to furnish the application. 

• Generate Show Cause Notice (SCN) on the query raised. 

  

9. Review each section thoroughly. Click the monitor icon displayed adjacent to the section headers to 

raise queries. 

  

 

  



 

 

10. In the Field drop-down list, select the field for which you want to raise a query.  

11. In the Query Description drop-down list, select the query to be raised. 

12. Click the ADD QUERY button to add the queries in the table given below the fields. 

  

 

  

13. You can raise multiple queries, if required. Once done, click OK. 

  

 

  

Note: You can click the Delete button to delete any raised query. 

  

The section with queries gets highlighted as shown in the screenshot below.  

  



 

 

 

  

14. Verify each page of the application by visiting each tab. Click the VERIFY & CONTINUE button to 

move ahead and review other tabs. 

  



 

 

 

  

A check mark appearing on the tab indicates the page has been verified. 

  

 

  



 

 

15. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your reference and will not be 

displayed to the applicant. 

16. Click the GENERATE SCN button. 

  

 

  

17. Click the GENERATE SCN button. 

  



 

 

 

  

18. Click the PROCEED button. 

  

 

  

19. Affix your DSC and click the Sign button. 

  



 

 

 

  

20. A success message will be displayed. Click the OK button. 

  

 

  

Note: The applicant will be given 7 working days’ time to provide reply to the Notice for seeking 

clarifications. In case the applicant does not respond within 7 working days’ time, the work -item will go 

back to the Tax Official to take action, and the Tax Official will only be able to reject the application. 

Approval button will be disabled. 



 

 

Approve Application for application for extension of Registration Period 

9. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review the 

information given for Cancellation of Registration in other tabs. 

10. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your reference and will not be 

displayed to the applicant. 

11. Click the APPROVE button. 

  

 

  

12. Click the PROCEED button. 

  



 

 

 

  

13. Affix your DSC and click the Sign button. 

  

 

  



 

 

14. A success message will be displayed. Click the OK button. 

  

 

  

Note:  

1. On Approval of the form, work-item will get closed. Status of the ARN will change to “Approved” 

2. Extended Registration Certificate will be generated with updated “Valid To” date and intimated to the 

taxpayer via Email and SMS. “Valid From” date shall remain the same.  

3. GSTIN status as “Active” will be extended for the time period for which extension has been granted.  

4. Registration Certificate will also be available at the Dashboard of the Taxpayer for view, print and 

download. 

Approve the Resubmitted Application for extension of Registration Period 

Once the applicant has responded to the SCN, the Tax Official can approve or reject the application.  

  

9. Review each section thoroughly. The section with yellow highlight shows the amended information by 

the applicant.  

10. Click the monitor icon displayed adjacent to the section headers to view the responses to the queries. 

  



 

 

 

  

11. Visit each tab and verify each page of the resubmitted application. A check mark appearing on the tab 

indicates the page has been verified. Click the VERIFY & CONTINUE button to move ahead and review 

the information given by the applicant in other tabs. 

12. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your reference and will not be 

displayed to the applicant. 

13. Click the APPROVE button. 

  



 

 

 

  

14. Click the PROCEED button. 

  

 

  

15. Affix your DSC and click the Sign button. 

  



 

 

 

  

16. A success message will be displayed. Click the OK button. 

  

 

  

Note:  

1. On Approval of the form, work-item will get closed. Status of the ARN will change to “Approved” 

2. Extended Registration Certificate will be generated with updated “Valid To” date and intimated to the 

taxpayer via Email and SMS. “Valid From” date shall remain the same.  

3. GSTIN status as “Active” will be extended for the time period for which extension has been granted.  



 

 

4. Registration Certificate will also be available at the Dashboard of the Taxpayer for view, print and 

download. 

Reject the Resubmitted Application for extension of Registration Period 

Once the applicant has responded to the SCN, the Tax Official can either "approve" or "reject" the 

application. 

  

In case the applicant does not respond within 7 working days’ time, work-item will go back to Tax Official 

for processing and the Tax Official can only reject the application.  

  

9. Review each section thoroughly. The section with yellow highlight shows the amended information by 

the applicant.  

10. Click the monitor icon displayed adjacent to the section headers to view the responses to the queries.  

  

 

  



 

 

11. Visit each tab and verify each page of the resubmitted application. A check mark appearing on the tab 

indicates the page has been verified. Click the VERIFY & CONTINUE button to move ahead and review 

the information given by the applicant in other tabs. 

12. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your reference and will not be 

displayed to the applicant. 

13. Click the REJECT button. 

  

 

  

14. The Rejection Order is generated. Select the relevant checkboxes for the appropriate reason. Click 

the GENERATE ORDER button. You can also enter the reasons for rejection. 

  



 

 

 

  

15. Click the PROCEED button. 

  

 

  

16. Affix your DSC and click the Sign button. 

  



 

 

 

  

17. A success message will be displayed. Click the OK button. 

  

 

  

Note: 

1. On rejection of the Form, work-item will get closed. ARN status will be changed to “Rejected” 

2. Rejection Order will get generated stating the reasons for rejection of the application.  

3. The taxpayer will be communicated about rejection by SMS/ Email.  

4. Rejection order digitally signed by the Tax Official, would be available on the GST Portal. 

5. Intimation of Rejection Order and ID will be sent to primary authorized signatory via email and SMS.  

  



 

 

Processing of Enrolment Applications for Migrated 
Taxpayers 

FAQs > Processing of Enrolment Applications 
for Migrated Taxpayers 

1. Are the Enrolment Applications of Migrated Taxpayers to be processed 

by the Tax Officials or are they auto-approved? 

Enrolment Applications which are not processed by Tax Officials within 15 days of filing of the Application 

or 15 days from the appointed date i.e. 22 June 2017, whichever is later, shall be auto approved. Other 

applications shall be processed and approved by the Tax Officials.  

2. How can I access Enrolment Applications for processing? 

You will receive the Work item of the Enrolment Applications in your Dashboard under the head – 

Registrations > Application for Enrolment.  

3. Is the approval process for New Registration Applications (applied after 

appointed date) or Enrolment Applications of Migrated Taxpayers 

different? 

The differences in approval process for New Registration Applications (applied after appointed date) or 

Enrolment Applications of Migrated Taxpayers are given below:  

  

Description/ 

Activity 

New 

Registration 

Applications 

applied after 

appointed date 

    

Enrolment Applications 

signed and submitted 

successfully by the Migrated 

Taxpayers 

Processing of 

the Application 

Processed by Tax 

Official  

If 15 days have passed from the 

date of filing of enrolment 

application, it will be auto 

approved and it will not be 

processed by Tax Official. Other 

applications will be processed by 

Tax Officials in normal course 



 

 

No Action by 

Tax Official on 

application  

  

Deemed approved 

if no action taken 

by Tax Official in 3 

working days of 

ARN generation  

  

Deemed approved if no action 

taken by Tax Official in 15 working 

days of ARN generation  

In case of 

incomplete 

application or 

documents  

  

Tax Official can 

raise a notice 

seeking clarification 

within 3 working 

days of ARN 

generation 

Tax Official can raise a notice 

seeking clarification within 15 

working days of ARN generation 

Time Limit for 

Taxpayer to 

respond to the 

Notice Seeking 

Clarification/ 

Show Cause 

Notice (SCN) 

issued  

  

Within 7 working 

days of receiving 

the Notice Seeking 

Clarification 

Within 7 working days of receiving 

the SCN 

Action 

(Approve/ 

Reject) to be 

taken by the 

Tax Officer on 

receipt of 

response of 

notice seeking 

clarification/ 

Show Cause 

Notice (SCN) 

  

Tax Official to 

Approve or Reject 

the New 

Registration 

Application within 7 

working days for 

processing from 

date of receipt of 

response to Notice 

Seeking 

Clarification. 

  

If no action is taken 

by Tax Official, 

New Registration 

Application will be 

deemed Approved 

within 7 working 

Tax Official to Approve or Reject 

the Enrolment Application within 7 

working days from the date of 

receipt of response to SCN. 

  

If no action is taken by Tax 

Official, Enrolment Application will 

be deemed Approved within 7 

working days from the receipt of 

the response to SCN. If taxpayer 

does not give any response to 

SCN within 7 days of issue of 

SCN, tax official has only option to 

reject the enrollment application.  



 

 

days from the 

receipt of the 

response to notice 

seeking clarification 

4. If a taxpayer submits incomplete application what action is required to 

be taken? Can I send a show cause notice? 

You can generate a Show Cause Notice for seeking clarifications in such cases within 15 working days of 

successful submission of enrolment application. 

5. Taxpayer has filled in incorrect jurisdiction, how can its jurisdiction be 

changed? 

Once, the enrollment application is processed by the Tax Official, jurisdiction of the Taxpayer can be 

changed through the functionality “Update jurisdiction of the Taxpayer” available to official having State 

Admin or Sub-State Admin role. 



 

 

 

Manual > Processing of Application for 
Enrolment of Migrated Taxpayer  

How can I process the application for enrolment of migrated taxpayer? 

Once the enrollment application gets filed, the application will be forwarded to the State or Centre based 

on the Source Authority i.e. the Authority which had requested for the allotment of the provisional ID.  

  

Refer the pictorial presentation depicting the steps in processing the application for enrolment of migrated 

taxpayer. 

  

 

  

For processing the enrollment application of migrated taxpayer, perform following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. The Tax Official’s Dashboard is displayed. Click on the Registration tab. This tab shows all the 

different type of applications pending with tax official for processing. Click on the Application for 

Enrolment link to view the list of ARN of the Enrolment Applications that needs to be processed.  

  



 

 

 

  

4. Click the ARN Number of the Enrolment Application that you want to process.  

Note: 

 The ARNs are arranged in the descending order of the Due Date. The application submitted first 

will be shown on top of the list. 

 The Due Date column displays the date by when the pending task/ action should be completed.  

 The Status column displays the current status of the Enrolment Application. 

  

 

  

5. Notice, if the Enrolment Application has come for first time for processing or it is a resubmi tted 

application. 



 

 

On clicking ARN, the enrollment application filed by the taxpayer is displayed for processing. The header 

contains various sections containing information pertaining to each section. The rest of the enrollment 

application body contains information filled-in by the Taxpayer. 

  

In case the application has been routed to the Tax Official for processing for the first time, the 

Status will be Pending for Processing. 

In case the application has been resubmitted with responses to the queries to the Tax Official, the 

Status will be Pending for Order. 

  

Be careful about the timelines when processing the Enrollment application! 

  

In case Tax Official takes no action or fails to take any action, within 15 working days from the date of 

generation of ARN, the enrollment application will be deemed approved. 

  

In case the enrollment application is processed for first time, the Tax Officials can take the following 

actions 

• Generate SCN 

• Approve  

  

Accordingly, the Tax Official can view only two buttons - Approve and Generate SCN 

. 

The Tax Officials can take the following actions, in case the enrollment application is resubmitted with 

clarification 

• Reject  

• Approve 

  

Accordingly, the Tax Official can view only two buttons - Approve and Reject 

  

In case Tax Official takes no action or fails to take any action on the resubmitted application, within 7 

working days from the date of the receipt of application, the application will be deemed approved.  

Generate SCN in case of first time receipt of the Enrollment Application 

During processing of an Enrolment application, you can: 

• Raise a query to seek more clarification from the Taxpayer or any document required to process 

the enrolment application. 

• Generate Show Cause Notice (SCN) on the query raised. 

  



 

 

 

  

6. Review each section thoroughly. Click the monitor icon displayed adjacent to the section headers to 

raise a query. The Queries page is displayed. 

  



 

 

 

  

7. In the Choose the field drop-down list, select the field for which you want to raise a query.  

8. In the Choose the query drop-down list, select the type of query to be raised. 

9. Click the ADD QUERY button. Queries will be displayed in the below table. 

  

 

  

 10. Once added, your query appears as shown. You can raise multiple queries, if required on the page. 

Once done, click OK.  

  

 



 

 

  

The section with queries gets highlighted with a yellow underline. 

  

 

  

Query section of each page has an option of “Others”. You can select this option to add free text query in 

the page. 

  

 

  

11. To approve an Enrolment application, you have to visit each tab and verify each page of the 

application. A check mark appearing on the tab indicates the page has been verified.  

  



 

 

 

  

12. On the Remarks page, enter Remarks and Notings in free text and click the ADD REMARKS button. 

These remarks are for your reference and will not be displayed to the taxpayer.  

  



 

 

 

  

13. Click the GENERATE SCN button.  

  



 

 

 

  

14. A Show Cause Notice for seeking clarifications is generated for the queries raised. Click the 

GENERATE SCN button. 

  



 

 

 

  

15. Click the PROCEED button. 

  



 

 

 

  

16. Affix your DSC and click the Sign button. 

  

 

  

17. A success message will be displayed. Click the OK button. 

  



 

 

 

  

Note: The Taxpayer will be given 7 working days’ time to file reply to the Notice for seeking clarifications.  

Approve Enrollment Application in case of first time receipt of the 

Enrollment Application 

Note: The first 5 steps are same as shown above. 

6. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review the 

information given by taxpayers in other tabs. 

  

 

  

7. Visit each tab and verify each page of the application. A check mark appearing on the tab indicates the 

page has been verified.  

  



 

 

 

  

8. On the Remarks page, enter Remarks and Notings in free text and click the ADD REMARKS button. 

These remarks are for your reference and will not be displayed to the taxpayer. 

9. Click the APPROVE button. 

  

 

  

10. Click the PROCEED button. 

  



 

 

 

  

11. Affix your DSC and click the Sign button. 

  

 

  

12. A success message will be displayed. Click the OK button. 

  



 

 

 

  

Note: On approval, work-item will get closed. Final Registration Certificate will be issued to the taxpayer. 

The taxpayer/ applicant will be communicated about approval through SMS and Email of the Primary 

Authorized Signatory. 

Approve the Resubmitted Enrollment Application 

Note: The first 5 steps are same as shown above. 

Once the taxpayer has responded to the SCN, the Tax Official can approve or reject the application within 

7 working days. 

  

6. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review the 

information given by taxpayers in other tabs. 

Click the monitor icon for the fields where you want to verify if the taxpayer has responded to the queries 

raised. 

  



 

 

 

  

Notice, if the taxpayer has responded to the queries raised by the Tax Official. 

  

 

  

7. Visit each tab and verify each page of the resubmitted application. A check mark appearing on the tab 

indicates the page has been verified.  



 

 

8. On the Remarks page, enter Remarks and Notings in free text and click the ADD REMARKS button. 

These remarks are for your reference and will not be displayed to the taxpayer.  

  

9. Click the APPROVE button. 

  

 

  

10. Click the PROCEED button. 



 

 

 

  

11. Affix your DSC and click the Sign button. 

  

 

  

12. A success message will be displayed. Click the OK button. 

  



 

 

 

  

Note: On approval, work-item will get closed. The Registration Certificate will be issued to the taxpayer. 

The Primary Authorized Signatory will be communicated about approval of the application through SMS 

or Email given while filling up of part A of the Enrolment application.  

Reject the Resubmitted Enrollment Application 

Note: The first 5 steps are same as shown above. 

Once the taxpayer has responded to the SCN, the Tax Official can approve or reject the application within 

7 working days. 

  

In case taxpayer does not respond within 7 working days’ time, work-item will go back to Tax Official for 

processing and the Tax Official can only reject the application.  

6. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review the 

information given by taxpayers in other tabs. Click the monitor icon for the fields where you want to verify 

if the taxpayer has responded to the queries raised. 

  



 

 

 

  

Notice, if the taxpayer has responded to the queries raised by the Tax Official.  

  

 

  

7. Visit each tab and verify each page of the resubmitted application. A check mark appearing on the tab 

indicates the page has been verified.  



 

 

8. On the Remarks page, enter Remarks and Notings in free text and click the ADD REMARKS button. 

These remarks are for your reference and will not be displayed to the taxpayer.  

  

9. Click the REJECT button. 

  

 

  

10. The Rejection Order is generated. Click the GENERATE ORDER button. 

  



 

 

 

  

11. Click the PROCEED button. 

  

 

  

12. Affix your DSC and click the Sign button. 

  



 

 

 

  

13. A success message will be displayed. Click the OK button. 

  

 

  

Note:  

 On rejection, work-item will get closed. 

 Auto-rejection of the application is not built in the system. 



 

 

 Rejection order will be generated specifying the reasons for rejection of the application. The 

Primary Authorized Signatory will be communicated about rejection of the application through 

SMS or Email. 



 

 

Processing of Amendment Application 

FAQs > Processing of Amendment Application 

1. Does a Tax Official need to approve all types of amendments to 

registration that are filed by the Taxpayer? 

All amendments of details in application for registration are classified under two category Core and Non-

core fields. Tax Officials need to approve/ raise SCN/ reject only those amendments that are done by the 

taxpayer in the Core fields of the registration. Amendments to Non-core fields of registration do not 

require Tax Official's approval and are auto approved. However, the concerned Tax Official gets a 

notification of non-core amendments in registration filed by the Taxpayer.  

2. Where can I see the pendency of amendment application on my 

Dashboard? 

Navigate to Dashboard > Registration tab > Application for Amendment link to view the pendency of 

amendment application. 

  

 

3. What are core fields? 

 Following fields of the registration application are called core fields.  

• Name of the Business, (Legal Name) if there is no change in PAN 

• Addition / Deletion of Stakeholders 



 

 

• Principal Place of Business (other than change in State) or Additional Place of Business (other than 

change in State) 

4. What are non-core fields? 

Fields of the registration application except legal name of the business, Addition/ deletion of stakeholder 

details and principal place of business or Additional place of business are called non-core fields. 

Non-core fields are available for editing, and changes in it are auto populated in registration of the 

taxpayer. No approval is required from the Tax Official if any amendments are made to these fields by the 

taxpayers. 

5. Who can file the Application for Amendment of Registration? 

Any taxpayer of following category, registered under GST, can file Application for Amendment of 

Registration: 

a) Normal and Casual Taxpayers 

b) TDS/ TCS Registrants, UN Bodies, Embassies & Other Notified person having UIN 

d) Non Resident Taxable Person 

e) GST Practitioner 

f)  Online Information and Database Access or Retrieval Service Provider 

Note: The GSTIN of the taxpayer should be Active. 

6. How many queries can I raise in a given application? 

There is no restriction on the number of queries. However, the queries can be raised only once.  

7. I have processed the complete application and want to reject it, but I 

can’t see a REJECT button. Why? 

As a Tax Official, you cannot reject an application upon first view. The principal  of natural justice is 

applicable and implies that the applicant should be given an opportunity to be heard. Therefore, if there 

are inconsistencies in the application, you can generate Notice Seeking Clarification. The applicant has 

seven working days to respond to this notice. In case the applicant fails to respond to the notice or 

provides an unsatisfactory response, only then you can reject the application.  

8. What is the specified time limit for processing the application filed for 

Amendment of Core fields? 

The concerned Tax Official must process the application for Amendment of Core fields within 15 working 

days of receipt of application.  



 

 

Application would be automatically approved if no action (No Notice for seeking clarifications or approval) 

is taken by Tax Official within 15 working days of receipt of application or 7 working days from receipt of 

reply to the Notice issued. 

9. How many times can I issue a Notice Seeking Clarification to the 

Taxpayer? 

A Notice Seeking Clarification can be issued to a Taxpayer by Tax official only once. 

10. What to do if the Amendment requires a change in jurisdiction? 

If the Amendment requires change in jurisdiction, as per the change in Principal Place of Business field, 

the Tax Official will select the response as YES, for the field "Is there any change in the Jurisdiction?", 

and will have an option to select the new Jurisdiction based on the Principal Place of Business provided 

in the form by the Taxpayer. Please note that State field is non editable as the amendment cannot be 

done for change in jurisdiction out of the State and fresh registration is required in this case.  

11. Do I need to take any action if the Amendment application has already 

got deemed approved? 

The amendment application gets deemed approved if you do not take any action on the Amendment form 

within the stipulated time frame, or if you do not process the Taxpayer's responses to clarifications sought 

within the specified time limit. 

If an Amendment application is deemed approved, you do not need to take any action as the system will 

sign the order of amendment and Amended Registration Certificate.   

  

However, an alert will be sent to the Commissioner in case of deemed approval.  

12. In case of deemed approved application, how the jurisdictional details 

of an applicant taxpayer will be updated? 

Click here to know more about how to update jurisdiction of taxpayer. 

13. What actions can be taken by Tax Official for processing of Amendment 

Application? 

Description/ Activity 
Time Frame and Action to be taken by 

Tax Official  

First time Processing of the 
Amendment Application  

Tax Official to Approve or Raise SCN for the 

Amendment Application within 15 working 
days of ARN generation.  



 

 

No Action by Tax Official on 
application  

Deemed approved if no action taken by Tax 
Official in 15 working days of ARN generation. 

In case of incomplete application 
or documents  

Tax Official can raise a notice seeking 
clarification within 15 working days of ARN 

generation. 

Time Limit for Taxpayer to 
respond to the Notice Seeking 

Clarification/ Show Cause Notice 
(SCN) issued  

Within 7 working days of receiving the Notice 

Seeking Clarification 
If no reply has been submitted by the 
Taxpayer within <7> days of issue of Notice, 

Application cannot be approved, only order for 
rejection can be issued.  

Action (Approve/ Reject) to be 
taken by the Tax Officer on 
receipt of response of notice 

seeking clarification/ Show 
Cause Notice (SCN)  

Tax Official to Approve or Reject the 

Amendment Application within 7 working days 

for processing from date of receipt of response 

to Notice Seeking Clarification. 

  
If no action is taken by Tax Official, 

Amendment Application will be deemed 
Approved within 7 working days from the 
receipt of the response to notice seeking 

clarification. 

  



 

 

 

Manual > Processing of Amendment 
Application 

How can I process the application for amendment of core fields? 

Once the application for amendment gets filed by the taxpayer, the application will be forwarded to the 

jurisdictional tax authorities. 

For processing the application for amendment of core fields, perform the following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. The Tax Official’s Dashboard is displayed. Click on the Registration tab. This tab shows all the 

different type of applications pending with tax official for processing. Click on the Application for 

Amendment link to view the list of ARN of the Amendment Applications that needs to be processed. 

  

 

  

4. Click the ARN Number of the Amendment Application that you want to process.  

Note: 

 The ARNs are arranged in the descending order of the Due Date. The application submitted first 

will be shown on top of the list. 

 The Due Date column displays the date by when the pending task/ action should be completed.  

 The Status column displays the current status of the Amendment Application. 

  



 

 

 

  

5. Notice, if the Amendment Application has come for first time for processing or it is a resubmitted 

application. 

  

Notice, if the Amendment Application has come for first time for processing or it is a resubmitted 

application. 

In case of first time for processing, the status of will be Pending for Processing.  

In case of resubmitted application, if the taxpayer has submitted response to notice seeking clarification, 

the status will be Clarification Filed -Pending for Order. 

In case of resubmitted application, if the taxpayer has not submitted response to notice seeking 

clarification, the status will be Clarification Not Filed -Pending for Order. 

  

On clicking ARN, the Amendment application filed by the taxpayer is displayed for processing. The 

header contains various sections containing information pertaining to each section. The rest of the 

amendment application body contains information filled-in by the Taxpayer. 

  

Be careful about the timelines when processing the Amendment application! 

  

In case Tax Official takes no action or fails to take any action, within 15 working days from the date of 

generation of ARN, the Amendment application will be deemed approved.  

  

In case the amendment application is processed for first time, the Tax Officials can take the following 

actions 

• Generate SCN 

• Approve  

  

Accordingly, the Tax Official can view only two buttons - Approve and Generate SCN. 

. 

The Tax Officials can take the following actions, in case the Amendment application is resubmitted with 

clarification 

• Reject  



 

 

• Approve 

  

Accordingly, the Tax Official can view only two buttons - Approve and Reject. 

  

In case Tax Official takes no action or fails to take any action on the resubmitted application, within 7 

working days from the date of the receipt of application, the application will be deemed approved.  

Generate SCN in case of first time receipt of the Amendment Application 

During processing of an Amendment application, you can: 

• Raise a query to seek more clarification from the Taxpayer or any document required to process 

the Amendment application. 

• Generate Show Cause Notice (SCN) on the query raised. 

  

Notice, the date of amendment and reason provide by the taxpayer for amendment of core fields is 

displayed. 

  

 

  

6. Review each section thoroughly. Click the monitor icon displayed adjacent to the section headers to 

raise a query.  

  



 

 

 

  

7. The Queries page is displayed. In the Choose the field drop-down list, select the field for which you 

want to raise a query. 

8. In the Choose the query drop-down list, select the type of query to be raised.  

9. Click the ADD QUERY button. 

  

 

  

10. Queries will be displayed in the below table. 

  



 

 

 

  

Query section of each page has an option of “Others”. You can select this option to add free text query in 

the page. 

  

 

  

11. You can raise multiple queries, if required on the page. Once done, cl ick OK.  

The section with queries gets highlighted with a yellow underline.  

  



 

 

 

  

12. Verify each page of the application by visiting each tab. Click the VERIFY and CONTINUE button. 

  



 

 

 

  

 A check mark appearing on the tab indicates the page has been verified.  

  



 

 

 

  

13. On the Remarks page, enter Remarks and Notings in free text and click the ADD REMARKS button. 

These remarks are made for your reference and will not be displayed to the taxpayer. 

  

 



 

 

  

14. In case you want to change the jurisdiction, select Yes for Is there any change in jurisdiction. 

15. In the Ward/Circle/Sector No drop-down list, select the Ward/Circle/Sector No for the new 

jurisdiction. 

  

 

  

16. Click the GENERATE SCN button.  

  

 

  

17. A Show Cause Notice for seeking clarifications is generated for the queries raised. In case, the Tax 

Official intends the taxpayer to appear before him and sort out the queries, he can select the checkbox 

and enter the date and time before which the taxpayer needs to appear to the authority.  

  

Click the GENERATE SCN button. 

  



 

 

 

  

18. Click the PROCEED button. 

  

 

  

19. Affix your DSC and click the Sign button. 

  



 

 

 

  

20. A success message will be displayed. Click the OK button. 

  

 

  

Note: The Taxpayer will be given 7 working days’ time to file reply to the Notice for seeking clarifications.  



 

 

Approve Amendment Application in case of first time receipt of the 

Amendment Application 

Notice, the date of amendment and reason provided by the taxpayer for amendment of core fields is 

displayed. 

  

 

  

6. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review the 

information given by taxpayers in other tabs. 

  



 

 

 

  

7. Visit each tab and verify each page of the application. A check mark appearing on the tab indicates the 

page has been verified. 

8. On the Remarks page, enter Remarks and Notings in free text and click the ADD REMARKS button. 

These remarks are for your reference and will not be displayed to the taxpayer. 

  



 

 

 

  

9. In case you want to change the jurisdiction, select Yes for Is there any change in jurisdiction. 

10. In the Ward/Circle/Sector No drop-down list, select the Ward/Circle/Sector No for the new 

jurisdiction. 

  

 

  

11. Click the APPROVE button. 

  



 

 

 

  

12. Order for amendment is generated. Click the GENERATE ORDER button. 

  

 

  

13. Click the PROCEED button. 

  



 

 

 

  

14. Affix your DSC and click the Sign button. 

  

 

  

15. A success message will be displayed. Click the OK button. 

  



 

 

 

  

Note: On approval, work-item will get closed. The taxpayer/ applicant will be communicated about 

approval through SMS and Email of the Primary Authorized Signatory.  

Approve the Resubmitted Amendment Application 

Once the taxpayer has responded to the SCN, the Tax Official can approve or reject the application within 

7 working days. 

  

6. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review the 

information given by taxpayers in other tabs. 
Click the monitor icon for the fields where you want to verify if the taxpayer has responded to the queries 
raised.  

  



 

 

 

  

Notice, if the taxpayer has responded to the queries raised by the Tax Official.  

  

 

  

7. Visit each tab and verify each page of the resubmitted application. A check mark appearing on the tab 

indicates the page has been verified. 



 

 

8. On the Remarks page, enter Remarks and Notings in free text and click the ADD REMARKS button. 

These remarks are for your reference and will not be displayed to the taxpayer.  

9. Click the APPROVE button. 

  

 

  

10. Order for amendment is generated. Click the GENERATE ORDER button. 

  



 

 

 

  

11. Click the PROCEED button. 

  

 

  

12. Affix your DSC and click the Sign button. 

  



 

 

 

  

13. A success message will be displayed. Click the OK button. 

  

 

  

Note: On approval, work-item will get closed. The taxpayer/ applicant will be communicated about 

approval through SMS and Email of the Primary Authorized Signatory.  



 

 

Reject the Resubmitted Amendment Application 

OOnce the taxpayer has responded to the SCN, the Tax Official can approve or reject the application 

within 7 working days. 

  

In case taxpayer does not respond within 7 working days’ time, work-item will go back to Tax Official for 

processing and the Tax Official can only reject the application.  

6. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review the 

information given by taxpayers in other tabs. Click the monitor icon for the fields where you want to verify 

if the taxpayer has responded to the queries raised.  

  

Click the monitor icon for the fields where you want to verify if the taxpayer has responded to the queries 

raised. 

  

 

  

Notice, if the taxpayer has responded to the queries raised by the Tax Official.  

  



 

 

 

  

7. Visit each tab and verify each page of the resubmitted application. A check mark appearing on the tab 

indicates the page has been verified.  

8. On the Remarks page, enter Remarks and Notings in free text and click the ADD REMARKS button. 

These remarks are for your reference and will not be displayed to the taxpayer. 

9. Click the REJECT button. 

  

 



 

 

  

10. Order for rejection is generated. Select the checkox for the reason for rejection and click the 

GENERATE ORDER button. 

  

 

  

11. Click the PROCEED button. 

  

 



 

 

  

12. Affix your DSC and click the Sign button. 

  

 

  

13. A success message will be displayed. Click the OK button. 

  

 

  



 

 

Note:  

 On rejection, work-item will get closed. 

 Auto-rejection of the application is not built in the system. 

 Rejection order will be generated specifying the reasons for rejection of the application. The 

Primary Authorized Signatory will be communicated about rejection of the application through 

SMS or Email. 



 

 

Processing of Enrolment of GST Practitioner 

FAQs > Processing of Enrolment of GST 
Practitioner 

1. How can I access the Application of Enrolment as GSTP that are waiting 

in my queue for processing? 

Navigate to Dashboard > Application of Enrolment as GSTP to access the Enrolment Applications filed 

by GST Practitioners that are waiting in your queue. 

2. While processing the Application of Enrolment as GSTP, can I mark the 

applicant's site for field visit for a physical survey? 

Yes, the Tax Officials can flag the ARN / work item for Post Registration Field Visit at any stage while 

processing the Application of Enrolment as GSTP. 

3. How many queries can I raise in an Application of Enrolment as GSTP? 

A Tax Official can raise multiple queries, but all of these queries need to be raised together in one go. 

4. I have verified the section of the Application of Enrolment as GSTP. I 

want to reject the Application of Enrolment but I can’t see a REJECT 

button. Why?  

As a Tax Official, you cannot reject Application of Enrolment as GSTP upon first review. You can: 

• Generate Show Cause Notice  

• Approve  

The principal of natural justice demands that you give an opportunity to the applicant to be heard. 

Therefore, if there are inconsistencies in the application, you can raise a notice seeking clarification. The 

applicant has seven working days to respond to this notice. In case the applicant fails to respond to the 

notice or provides an unsatisfactory response, then you can reject their application.  

5. I am neither able to APPROVE the Application of Enrolment as GSTP, nor 

raise a Show Cause Notice. Why? 



 

 

Please make sure you have verified each section and clicked the VERIFY & CONTINUE button in each 

section available at the bottom of the page. When you do so, the sections will be highlighted in blue 

colour. 

6. I have verified the section of the Application of Enrolment as GSTP. I 

want to issue SCN in the Application of Enrolment but I can’t do it. Why?  

Once the applicant has responded to the queries of Tax Official, the Tax Official cannot raise an SCN 

again. Based on the response of the applicant, you can: 

• Reject in case the responses to queries are not satisfactory  

• Approve in case the responses to queries are satisfactory 

7. What is the time limit for processing the Application of Enrolment as 

GSTP? 

 There is no time limit specified to process the Application of Enrolment as GSTP. However, the GST 

Portal will send an alert notification to the concerned Tax Official after 15 days from the date of receipt of 

the Enrollment Application. 

8. What is the specified time limit for processing Application of Enrolment 

as GSTP once the applicant has responded to the Tax Official's queries? 

There is no time limit specified to process the applicant's responses filed for Application of Enrolment as 

GSTP. However, the GST Portal will send an alert notification to the concerned Tax Official after 15 days 

from the date of receipt of responses to remind him / her of the pending item in their queue.  

9. Which role can approve the Application of Enrolment as GSTP? 

Tax Official who has been assigned the GSTP Approval role can approve the Application of Enrolment as 

GSTP. 

10. What are the various statuses of the Application of Enrolment as 

GSTP? 

• In case the application has been routed to the Tax Official for processing for the first time, the Status will 

be Pending for Processing. 

• In case the application has been resubmitted with responses to the queries to the Tax Official, the 

Status will be Pending for Order. 



 

 

11. Will the Application of Enrolment as GSTP be assigned at jurisdiction 

levels? 

Application of Enrolment as GSTP will be assigned at state level. There is otherwise no need to assign 

“GSTP Approval” role at each jurisdictional/ territorial level.  

12. Who will process the Application of Enrolment as GSTP? 

GST Practitioner can select either “centre” or “state” as their approving authority. Enrolment Applications, 

where applicant has chosen “State” as approving authority, shall get assigned to the designated state 

officer. If there are more than one officers in “GSTP Approval” role in a state, applications will get 

assigned in round-robin pattern. 

13. Can a GST Practitioner operate only under the state with which he/ she 

is registered? 

Once application is approved, GST Practitioner can operate anywhere in India.  

14. How is the GST Practitioner informed about the action taken by an 

officer? 

The GST Practitioner will be communicated through SMS and E-mail message about any action taken by 

the Tax Official on the Enrolment Application of GSTP like approval / rejection/ raise query. 

15. How can I track existing registrations mapped to same PAN of the 

business/ entity on the GST Portal during processing of the Enrollment 

application of the GSTP? 

While processing the enrollment application of GSTP or any registration application of a taxpayer, you 

can click on ‘Existing Registrations’ hyperlink available above Application header.  

You will thus be able to view all the submitted applications mapped to a single PAN.  



 

 

 

Manual > Processing of Enrolment of GST 
Practitioner 

How can I process for enrolment of GST Practitioner? 

For processing the application for enrolment of GST Practitioner (GSTP), perform the following steps:  

  

1. Access the GST Portal for Tax Official. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal. 

3. The Tax Official’s Dashboard is displayed. Click on the Registration tab. This tab shows all the 

different type of applications pending with tax official for processing. Click on the Application of 

Enrolment as GSTP link to view the list of ARN of the Enrolment as GSTP Applications that needs to be 

processed. 

  

 

  

4. Click the ARN Number of the Enrolment as GSTP Applications that you want to process.  

Note: 

 The ARNs are arranged in the descending order of the Due Date. The application submitted first 

will be shown on top of the list. 

 The Due Date column displays the date by when the pending task/ action should be completed. 

 The Status column displays the current status of the Enrolment as GSTP  Applications. 

  



 

 

 

  

5. Notice, if the Enrolment as GSTP Application has come for first time for processing or it is a 

resubmitted application. 

In case the application has been routed to the Tax Official for processing for the first time, the 

Status will be Pending for Processing. 

In case the application has been resubmitted with responses to the queries to the Tax Official, the 

Status will be Pending for Order. 

  

On clicking ARN, the Enrolment as GSTP Application filed by the GST Practitioner is displayed for 

processing. The header contains various sections containing information pertaining to each section. The 

rest of the application body contains information filled-in by the Taxpayer . 

  



 

 

 

Existing Registrations 

Note: To view existing registrations mapped to same PAN, click on ‘Existing Registrations’ hyperlink 

available above Application header. 
It is possible that an applicant is registered as a taxpayer as well as GSTP. In such cases, the existing 

registrations of the applicant as taxpayer 'having same PAN' will be visible from Existing Registrations’ 
hyperlink.  

  

 

  



 

 

On clicking, ‘Existing Registrations’ hyperlink, a new screen will be populated displaying details of as on 

date: 

(i) Status of all the applications for registrations (ARNs) mapped to PAN and pending with tax official for 

processing / clarifications / Order / Rejected. 

(ii) Status of all the application for registration (ARNs) mapped to PAN and approved.  

(iii) Status of the GSTIN. This will include Temporary IDs generated against that PAN.  

  

 

  

(a) Click ARN hyperlink. 

  

 

  

On clicking ARN hyperlink, Tax Official will be redirected to ‘Search ARN Details'’ page, from where he 

can retrieve the details of that ARN. 

Click here to know more about Search ARN Details. 



 

 

  

 

  

(b) Click GSTIN/ UIN/ GSTPID hyperlink. 

  

 

  

On clicking GSTIN/ UIN/ GSTPID hyperlink, Tax Official will be redirected to ‘Get Taxpayer Details’ page, 

from where he can retrieve the details of that GSTIN. 

Click here to know more Get Taxpayer Details. 

  

 

  

(c) Click Reason for Rejection hyperlink. 

  



 

 

 

  

On clicking Reason for Rejection hyperlink, the reasons for rejection of application is displayed. Click the 

OK button. 

  

 

  

In case the Enrolment as GSTP Application is processed for first time, the Tax Officials can take the 

following actions 

• Generate SCN 

• Approve  

  

Accordingly, the Tax Official can view only two buttons - Approve and Generate SCN. 

. 

The Tax Officials can take the following actions, in case the Enrolment as GSTP  Application is 

resubmitted with clarification 

• Reject  



 

 

• Approve 

  

Accordingly, the Tax Official can view only two buttons - Approve and Reject. 

  

There is no time limit specified to process the application filed for enrolment of GSTP. However, an alert 

will be sent to Tax Official after 15 days from the date of receipt of application to process the application 

or receipt of reply of Notice seeking clarification, whichever is later.  

Generate SCN in case of first time receipt of the Enrolment as GSTP 

Application 

During processing of Enrolment as GSTP Application, you can:  

• Raise a query to seek more clarification from the GST Practitioner or any document required to 

process the Enrolment as GSTP Application. 

• Generate Show Cause Notice (SCN) on the query raised.  

  

6. Review each section thoroughly. Click the monitor icon displayed adjacent to the section headers to 

raise a query. 

  



 

 

 

  

7. The Queries page is displayed. In the Field drop-down list, select the field for which you want to raise a 

query. 

8. In the Query Description drop-down list, select the type of query to be raised.  

9. Click the ADD QUERY button. 

  



 

 

 

  

10. Queries will be displayed in the below table. 

  

 

  

Query section of each page has an option of “Others”. You can select this option to add free text query in 

the page. 

11. You can raise multiple queries, if required on the page. Once done, cl ick SAVE. 

Note: You can click the Delete button to delete any query or click the Edit button to edit the queries 

raised . 

  



 

 

 

  

The section with queries gets highlighted with a yellow underline. 

  



 

 

 

  

12. Verify each page of the application by visiting each tab. Click the VERIFY and CONTINUE button. 

  



 

 

 

  

 A check mark appearing on the tab indicates the page has been verified.  

  



 

 

 

  

13. On the Remarks page, enter Remarks and Notings in free text and click the ADD REMARKS button. 

These remarks are for your reference and will not be displayed to the GST Pract itioner. 

14. Click the GENERATE SCN button. 

  



 

 

 

  

15. A Show Cause Notice for seeking clarifications is generated for the queries raised. Click the 

GENERATE SCN button. 

  



 

 

 

  

16. Click the PROCEED button. 

  

 



 

 

  

17. Affix your DSC and click the Sign button. 

  

 

  

18. A success message will be displayed. Click the GO BACK button. 

  

 

  

Note: The GST Practitioner will be given 7 working days’ time to file reply to the Notice for seeking 

clarifications.  

Approve Enrolment as GSTP Application in case of first time receipt of the 

Enrolment as GSTP Application 

6. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review the 

information given by GST Practitioner in other tabs. 

  



 

 

 

  

7. On the Remarks page, enter Remarks and Notings in free text and click the ADD REMARKS button. 

These remarks are for your reference and will not be displayed to the GST Practitioner.  

8. Click the APPROVE button. 

  



 

 

 

  

9. Click the PROCEED button. 

  

 

  

10. Affix your DSC and click the Sign button. 

  



 

 

 

  

11. A success message will be displayed. Click the GO BACK button. 

  

 

  

Note: On approval, work-item will get closed. Enrolment Certificate will be issued to the GST Practitioner. 

The GST Practitioner will be communicated about approval through SMS and Email.  

Approve the Resubmitted Enrolment as GSTP Application 

Once the GST Practitioner has responded to the SCN, the Tax Official can approve or reject the 

application. 

  

6. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review the 

information given by GST Practitioner in other tabs.  

The section with yellow highlight shows the amended information by the GSTP. 

7. Visit each tab and verify each page of the resubmitted application. A check mark appearing on the tab 

indicates the page has been verified .  



 

 

  

 

  

8. On the Remarks page, enter Remarks and Notings in free text and click the ADD REMARKS button. 

These remarks are for your reference and will not be displayed to the taxpayer.  

9. Click the APPROVE button. 

  



 

 

 

  

10. Click the PROCEED button. 

  

 

  

11. Affix your DSC and click the Sign button. 

  



 

 

 

  

12. A success message will be displayed. Click the GO BACK button. 

  

 

  

Note: On approval, work-item will get closed. The GST Practitioner will be communicated about approval 

through SMS and Email. 

Reject the Resubmitted Enrolment as GSTP Application 

Once the GST Practitioner has responded to the SCN, the Tax Official can approve or reject the 

application. 

  

In case taxpayer does not respond within 7 working days’ time, work-item will go back to Tax Official for 

processing and the Tax Official can only reject the application. 

6. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review the 

information given by taxpayers in other tabs. 

The section with yellow highlight shows the amended information by the GSTP. 



 

 

  

7. Visit each tab and verify each page of the resubmitted application. A check mark appearing on the tab 

indicates the page has been verified.  

  

 

  

8. On the Remarks page, enter Remarks and Notings in free text and click the ADD REMARKS button. 

These remarks are for your reference and will not be displayed to the taxpayer.  

9. Click the REJECT button. 

  



 

 

 

  

11. The Rejection Order is generated. Select the checkbox for the reason. Click the GENERATE ORDER 

button. You can also enter the reasons for rejection. 

  



 

 

 

  

11. Click the PROCEED button. 

  



 

 

 

  

12. Affix your DSC and click the Sign button. 

13. A success message will be displayed. Click the GO BACK button. 

  

 

  

Note:  

 On rejection, work-item will get closed. 

 Auto-rejection of the application is not built in the system. 

 The GST Practitioner will be communicated about rejection of the application through SMS or 

Email message. 



 

 

Processing of TDS/ TCS Registration Application 

FAQs > Processing of TDS/ TCS Registration 
Application 

1. How can I access the pending TDS / TCS Registration Applications? 

Here is a screenshot of the Tax Official’s Dashboard detailing the access for pending TDS / TCS 

Registration Applications for your reference: 

  

 

  

Step 1: Click on Registration tile 

Step 2: Click on Application for Registration as TDS / TCS link 

Step 3: Select the application to process from the list by clicking on the relevant ARN 

2. How do I know the due date for processing an application? 

The due date for a TDS / TCS Registration Application submitted by the Taxpayer is displayed in the list -

wise breakdown of pending applications. Not only that, all applications are colour-coded to indicate 

criticality of action w.r.t. the due date as follows:  



 

 

Red – due today 

Amber – due tomorrow 

Green – due day after tomorrow 

3. I have opened a TDS / TCS application for processing. What is the next 

step? 

Once you open a TDS / TCS application for processing, you can begin a section-wise review. After 

reviewing a particular section, click the VERIFY & CONTINUE button at the bottom right of the page to 

move to the next section. 

  

Once you have completed all the sections, you can APPROVE or RAISE NOTICE SEEKING 

CLARIFICATION in case you want to raise queries. 

4. There are multiple sections in the application form. Can I navigate to 

other sections during processing the application? 

Yes, as a Tax Official, you can view the sections of the application in any order you choose.  

5. Can I verify and continue even if I have raised a query in the section? 

Yes, you must click on VERIFY & CONTINUE for every section before you can pass an order on the 

application. 

  

Every time you successfully verify a section without any queries, the section header will turn blue along 

with a check mark, indicating that you have reviewed that section.  

6. How do I raise a query? 

In every section, you can see monitor-like icons next to the sub-sections. Simply click on this icon and a 

query box will open as a pop-up. You can choose any of the predefined queries or select the ‘Others’ 

option to add a custom query. Once you have selected the query, click on Add Query and the relevant 

field (on which the query has been raised) will get underlined in yellow.  

  

Note: It is mandatory to add custom remarks/comments even if you select a predefined query.  

7. How many queries can I raise in a given application? 

There is no restriction on the number of queries that can be raised. You can raise multiple queries.  



 

 

8. Where can I see the number of queries I have raised? 

In case you have raised queries, the total number of queries raised in an application form will be 

displayed in the Queries Raised column on the dashboard, before signing the application using your 

digital signature. Please refer to the below screenshot:  

  

 

9. There is a Remarks section on the final page. What is it for? 

The Remarks section is for any comments you wish to add to the application for your personal reference. 

These are confidential remarks and cannot be seen by anyone except you.  

10. I have processed the complete application and want to reject it but I 

can’t see a REJECT button. Why? 

As a Tax Official, you cannot reject an application upon first review. The principal of natural justice 

demands that you afford the applicant an opportunity to be heard. Therefore, if there are inconsistencies 

in the application, you can raise a Notice Seeking Clarification. The Taxpayer has seven working days to 

respond to this notice. In case the Taxpayer fails to respond to the notice or provides an unsatisfactory 

response, only then you can reject their application. 

11. I am unable to APPROVE or raise a NOTICE SEEKING CLARIFICATION. 

Why? 

Please make sure that you have reviewed each section and clicked on VERIFY & CONTINUE button to 

mark each section as complete. You also need to mandatorily enter a comment in the Remarks section. 



 

 

12. TDS / TCS Registration Application is auto-approved. Now what actions 

do I need to take as a Tax Official? 

Once a TDS / TCS Registration Application has been auto-approved, there is no action required by the 

Tax Official. However, in case you want to cancel the registration, you can initiate cancellation of the 

Registration Application as and when the facility is provided to the Tax Official.  

13. What happens when I approve the application? 

Once you successfully approve the application, the system generates an approval order and e-mails it to 

the applicant Taxpayer along with the digitally signed Registration Certificate. You can preview the e-mail 

and certificate before the GST Portal sends it to the Taxpayer.  

14. What happens when I raise a Notice Seeking Clarification? 

When you raise a Notice Seeking Clarification, the system generates your order and sends an e-mail to 

the applicant Taxpayer with a summary of all the queries raised, digitally signed by the concerned Tax 

Official. You can preview the e-mail and notice before the GST Portal sends it to the Taxpayer.  

15. I work in a densely populated district / ward. Is there any facility for bulk 

approval of TDS / TCS Registration Applications? 

No, there is no bulk approval facility. As a Tax Official, you are required to review each application 

independently and pass the necessary statutory  order. 

16. How can I track existing registrations mapped to same PAN of the 

business/ entity on the GST Portal during processing of of TDS/ TCS 

registration application? 

While processing of application for allotment of UIN by UN bodies, you can click on ‘Existing 

Registrations’ hyperlink available above Application header.  

You will thus be able to view all the submitted applications mapped to a single PAN.  

  



 

 

 

Manual > Processing of TDS/ TCS 
Registration Application 

How can I process the application filed for new TDS/ TCS registration? 

Once the Application for TDS / TCS Registration gets filed, the application form will be forwarded to one 

of the Tax Authorities (Centre/ State) based on a predefined logic.  

For processing the application for new registration, perform the following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal. The Tax Official’s Dashboard is displayed.  

3. Click the Registration tab. This tab shows all the different type of applications pending with tax official 

for processing. 

4. Click the Application for Registration as TDS / TCS link to view the list of corresponding ARNs that 

are waiting to be processed. 

  



 

 

 

  

5. Select the ARN that you wish to process. 

Note: 

 The ARNs are arranged in the descending order of the Due Date. The application submitted first 

will be shown above in the list. 

 The Due Date column displays the date by when the pending task / action should be completed.  

 The Status column displays the current status of the registration application. 

  



 

 

 

  

6. Notice if the Application of Registration as TDS / TCS has come for first time for processing, or is it a 

resubmitted application: 

 In case the application has been routed to the Tax Official for processing for the first time, the 

Status will be Pending for Processing. 

 In case the application has been resubmitted with responses to the queries to the Tax Official, the 

Status will be Pending for Order. 

  

On clicking ARN, the application form filed by the applicant is displayed for processing. The header 

contains various blocks containing information pertaining to each section. The rest of the webpage forms 

the application body and contains information filled-in by the applicant. 

  



 

 

 

  

Existing Registrations 

Note: To view existing registrations mapped to same PAN, click on ‘Existing Registrations’ hyperlink 

available above Application header. 
It is possible that an applicant is registered as a taxpayer as well as TDS. In such cases, the existing 
registrations of the applicant as taxpayer 'having same PAN' will be visible from Existing Registrations’ 
hyperlink.  

  

 

  

On clicking, ‘Existing Registrations’ hyperlink, a new screen will be populated displaying details of as on 

date: 

(i) Status of all the applications for registrations (ARNs) mapped to PAN and pending with tax official for 

processing / clarifications / Order / Rejected. 

(ii) Status of all the application for registration (ARNs) mapped to PAN and approved.  

(iii) Status of the GSTIN. This will include Temporary IDs generated against that PAN.  

  



 

 

 

  

(a) Click ARN hyperlink. 

  

 

  

On clicking ARN hyperlink, Tax Official will be redirected to ‘Search ARN Details'’ page, from where he 

can retrieve the details of that ARN. 

Click here to know more about Search ARN Details. 

  



 

 

 

  

(b) Click GSTIN/ UIN/ GSTPID hyperlink. 

  

 

  

On clicking GSTIN/ UIN/ GSTPID hyperlink, Tax Official will be redirected to ‘Get Taxpayer Details’ page, 

from where he can retrieve the details of that GSTIN. 

Click here to know more Get Taxpayer Details. 

  

 

  

(c) Click Reason for Rejection hyperlink. 

  



 

 

 

  

On clicking Reason for Rejection hyperlink, the reasons for rejection of application is displayed. Click the 

OK button. 

  

 

  

Be careful about the timelines when processing a new TDS / TCS Registration application! 

  

In case the TDS / TCS Registration application is processed for the first time, the Tax Officials can take 

the following actions: 

• Generate SCN 

• Approve 

  

Accordingly, the Tax Official can view only two buttons - Approve and Generate SCN. 

  



 

 

In case the Tax Official does not take any action, or fails to take an action within 3 working days from the 

date of the receipt of application, the application shall deemed to have been approved.  

  

Tax Officials can take following actions, in case the TDS / TCS Registration application is resubmitted 

with clarification: 

• Reject 

• Approve 

  

Accordingly, the Tax Official can view only two buttons - Approve and Reject. 

Generate SCN in case of first time receipt of the TDS / TCS Registration 

Application 

While processing the TDS / TCS Registration application, you can:  

• Raise a query in case you wish to seek any clarification from the applicant, with respect to deficient 

information or any document required to furnish the application. 

• Generate Show Cause Notice (SCN) on the query raised. 

  

7. Review each section thoroughly. Click the monitor icon displayed adjacent to the section headers to 

raise queries. 

  



 

 

 

  

8. In the Field drop-down list, select the field for which you want to raise a query.  

9. In the Query Description drop-down list, select the query to be raised. 

10. Click the ADD QUERY button to add the queries in the table given below the fields. 

  

 

  

Query section of each page has an option of “Others”. You can select this option to add free text query in 

the page. 

  



 

 

 

  

Note: You can click the Delete button to delete any raised query. 

  

 

  

11. You can raise multiple queries, if required. Once done, click OK. 

  

The section with queries gets highlighted with a yellow underline.  

  

 

  



 

 

12. Verify each page of the application by visiting each tab. Click the VERIFY & CONTINUE button to 

move ahead and review other tabs. 

  

 

  

A check mark appearing on the tab indicates the page has been verified.  

  

 

  

13. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your reference and will not be 

displayed to the applicant. 

  



 

 

 

  

14. Click the GENERATE SCN button. 

  

 

  



 

 

15. A Show Cause Notice for seeking clarifications is generated for the queries raised. Click the 

GENERATE SCN button. 

  

 

  

16. Click the PROCEED button. 

  

 

  



 

 

17. Affix your DSC and click the Sign button. 

  

 

  

18. A success message will be displayed. Click the OK button. 

  

 

  

Note: The applicant will be given 7 working days’ t ime to file reply to the Notice for seeking clarifications. 

In case the applicant does not respond within 7 working days’ time, the work -item will go back to the Tax 

Official for processing, and the Tax Official will only be able to reject the application.  



 

 

Approve Registration Application of TDS / TCS Applicants in case of first 

time receipt of the Enrolment 

7. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review the 

information given by TDS / TCS applicant in other tabs. 

  

 

  

8. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your reference and will not be 

displayed to the applicant. 

  

9. Click the APPROVE button. 

  



 

 

 

  

10. Click the PROCEED button. 

  



 

 

 

  

11. Affix your DSC and click the Sign button. 

  

 



 

 

  

12. A success message will be displayed. Click the OK button. 

  

 

  

Note: On approval, work-item will get closed. Enrolment Certificate will be issued to the TDS / TCS 

applicant. The applicant will be communicated about approval through SMS and Email.  

Approve the Resubmitted Registration Application of TDS / TCS Applicant 

Once the TDS / TCS applicant has responded to the SCN, the Tax Official can approve or reject the 

application. 

  

7. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review the 

information given by the applicant in other tabs. 

The section with yellow highlight shows the amended information by the applicant.  

  

8. Visit each tab and verify each page of the resubmitted application. A check mark appearing on the tab 

indicates the page has been verified. 

  

 

  



 

 

9. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your reference and will not be 

displayed to the applicant. 

  

 

  

10. Click the APPROVE button. 

  



 

 

 

  

11. Click the PROCEED button. 

  



 

 

 

  

12. Affix your DSC and click the Sign button. 

  

 



 

 

  

13. A success message will be displayed. Click the OK button. 

  

 

  

Note: On approval, work-item will get closed. The applicant will be communicated about approval through 

SMS and Email. 

Reject the Resubmitted Registration Application of TDS / TCS Applicant 

Once the TDS / TCS applicant has responded to the SCN, the Tax Official can approve or reject the 

application. 

  

In case the applicant does not respond within 7 working days’ time, work-item will go back to Tax Official 

for processing and the Tax Official can only reject the application.  

7. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review the 

information given by the applicant in other tabs. 

The section with yellow highlight shows the amended information by the applicant.  

  

8. Visit each tab and verify each page of the resubmitted application. A check mark appearing on the tab 

indicates the page has been verified. 

  

 



 

 

  

9. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your reference and will not be 

displayed to the applicant. 

  

 

  

10. Click the REJECT button. 

  



 

 

 

  

11. The Rejection Order is generated. Select the relevant checkboxes for the appropriate reason. Click 

the GENERATE ORDER button. You can also enter the reasons for rejection. 

  



 

 

 

  

12. Click the PROCEED button. 

  



 

 

 

  

13. Affix your DSC and click the Sign button. 

  

 



 

 

  

14. A success message will be displayed. Click the GO BACK button. 

  

 

  

Note: 

 On rejection, work-item will get closed. 

 Auto-rejection of the application is not built in the system. 

 The applicant will be communicated about rejection of the application through SMS or Email.  



 

 

Processing of Non-Resident Taxable Person 
Registration Application 

FAQs > Processing of Non-Resident Taxable 
Person Registration Application 

1. Who all can be considered as Non-Resident Taxable Persons for GST 

Registration? 

Non-Resident Taxable Persons are those foreign Taxpayers who undertake business transactions   in 

India for a very short time. They do not have any fixed place of business in India. For example, foreign 

entities participating in Trade Fairs, Exhibitions, etc.  

2. What is the validity period of GST Registration, once issued to a Non-

Resident Taxable Person? 

The GST Registration certificate issued to a Non-Resident Taxable Person is valid for the period specified 

in the Registration Application form, or 90 days from the effective date of registration, whichever is earlier.  

3. Can the Registration period of a Non-Resident Taxable Person be 

extended? 

The Registration period of a Non-Resident Taxable Person can be extended only once. The extension 

can be granted for an additional period of 90 days, only if the applicant files for an extension before the 

expiry of the initial registration period. 

4. How can I track existing registrations mapped to same PAN of the 

business/ entity on the GST Portal during processing of the Non-Resident 

Taxable Person Registration Application? 

While processing the Non-Resident Taxable Person Registration Application, you can click on ‘Existing 

Registrations’ hyperlink available above Application header.  

You will thus be able to view all the submitted applications mapped to a single PAN.  

5. Where can a taxpayer add Bank Account details? 

Details to be entered in Bank Accounts tab has been made optional w.e.f. 27th Dec 2018 . Taxpayer can 

now enter the Bank Accounts details by filing an Amendment application. When a taxpayer logs in for the 



 

 

first time on the GST Portal, he/ she will be prompted to file a non-core amendment application to enter 

Bank Accounts details. 



 

 

 

Manual > Processing of Non-Resident Taxable 
Person Registration Application 

How can I process the application filed for registration by Non-Resident 

Taxable Person? 

Once the Application for Non-Resident Taxable Person gets filed, the application form will be forwarded 

to one of the Tax Authorities (Centre / State) based on a predefined logic.  

  

For processing the application for such registrations, please perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal and ensure that Tax Official’s Dashboard is 

displayed. 

3. Click the Registration tab. This tab shows all the different type of applications pending with Tax Official 

for processing. 

4. Click the Application for Registration as Non Resident Taxable Person link to view the list of 

corresponding ARNs that are waiting to be processed. 

  

 

  

5. Select the ARN that you wish to process. 

Notes: 

 The ARNs are arranged in descending order of the Due Date. The application submitted first will 

be shown above in the list. 



 

 

 The Due Date column displays the date by when the pending task / action should be completed.  

 The Status column displays the current status of the registration application.  

 The Queries Raised column displays the number of queries that have been raised by the Tax 

Official in case the application form is already under processing, or in case the applicant has filed 

responses to the previously raised queries. 

  

 

  

6. Notice if the Application of Registration as Non-Resident Taxable Person has come for first time for 

processing, or is it a resubmitted application: 

 In case the application has been routed to the Tax Official for processing for the first time, t he 

Status will be Pending for Processing. 

 In case the application has been resubmitted with responses to the queries to the Tax Official, the 

Status will be Pending for Order. 

  

On clicking ARN, the application form filed by the applicant is displayed for processing. The header 

contains various sections containing information pertaining to each section. The rest of the webpage 

holds the application body and contains information as furnished by the applicant.  

  



 

 

 

  

Existing Registrations 

Note: To view existing registrations mapped to same PAN, click on ‘Existing Registrations’ hyperlink 

available above Application header. 
It is possible that an applicant is registered as a taxpayer as well as Non-Resident Taxable person. In 
such cases, the existing registrations of the applicant as taxpayer 'having same PAN' will be visible from 

Existing Registrations’ hyperlink.  

  



 

 

 

  

On clicking, ‘Existing Registrations’ hyperlink, a new screen will be populated displaying details of as on 

date: 

(i) Status of all the applications for registrations (ARNs) mapped to PAN and pending with tax official for 

processing / clarifications / Order / Rejected. 

(ii) Status of all the application for registration (ARNs) mapped to PAN and approved.  

(iii) Status of the GSTIN. This will include Temporary IDs generated against that PAN. 

  

 

  

(a) Click ARN hyperlink. 

  



 

 

 

  

On clicking ARN hyperlink, Tax Official will be redirected to ‘Search ARN Details'’ page, from where he 

can retrieve the details of that ARN. 

Click here to know more about Search ARN Details. 

  

 

  

(b) Click GSTIN/ UIN/ GSTPID hyperlink. 

  



 

 

 

  

On clicking GSTIN/ UIN/ GSTPID hyperlink, Tax Official will be redirected to ‘Get Taxpayer Details’ page, 

from where he can retrieve the details of that GSTIN. 

Click here to know more Get Taxpayer Details. 

  

 

  

(c) Click Reason for Rejection hyperlink. 

  

 

  



 

 

On clicking Reason for Rejection hyperlink, the reasons for rejection of application is displayed. Click the 

OK button. 

  

 

  

In case the Non-Resident Taxable Person Registration application is processed for the first time, the Tax 

Officials can take the following actions: 

• Generate SCN 

• Approve 

  

Accordingly, the Tax Official can view only two buttons - Approve and Generate SCN. 

  

In case the Tax Official does not take any action, or fails to take an action within 3 working days from the 

date of the receipt of application, the application shall deemed to have been approved.  

  

Tax Officials can take following actions, in case the Non-Resident Taxable Person Registration 

application is resubmitted with clarification: 

• Reject 

• Approve 

  

Accordingly, the Tax Official can view only two buttons - Approve and Reject. 

Generate SCN in case of first time receipt of the Non-Resident Taxable 

Person Registration Application 

While processing the Non-Resident Taxable Person Registration application, you can: 

• Raise a query in case you wish to seek any clarification from the applicant, with respect to deficient 

information or any document required to furnish the application. 



 

 

• Generate Show Cause Notice (SCN) on the query raised. 

  

7. Review each section thoroughly. Click the monitor icon displayed adjacent to the section headers to 

raise queries. 

  

 

  

8. In the Field drop-down list, select the field for which you want to raise a query. 

9. In the Query Description drop-down list, select the query to be raised. 

10. Click the ADD QUERY button to add the queries in the table given below the fields. 

  

 

  

Query section of each page has an option of “Others”. You can select this option to add free text query in 

the page. 

  



 

 

 

  

11. You can raise multiple queries, if required. Once done, click OK. 

  

 

  

The section with queries gets highlighted with a yellow underline. 

  

 

  

12. Verify each page of the application by visiting each tab. Click the VERIFY & CONTINUE button to 

move ahead and review other tabs. 



 

 

  

 

  

A check mark appearing on the tab indicates the page has been verified.  

  

 

  

13. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your reference and will not be 

displayed to the applicant. 

  

 



 

 

  

14. Click the GENERATE SCN button. 

  

 

  

15. A Show Cause Notice for seeking clarifications is generated for the queries raised. Click the 

GENERATE SCN button. 

  

 



 

 

  

16. Click the PROCEED button. 

  

 

  

17. Affix your DSC and click the Sign button. 

  



 

 

 

  

18. A success message will be displayed. Click the OK button. 

  

Note: The applicant will be given 7 working days’ time to file reply to the Notice for seeking clarifications. 

In case the applicant does not respond within 7 working days’ time, the work -item will go back to the Tax 

Official for processing, and the Tax Official will only be able to reject the application.  

Approve Registration Application of Non-Resident Taxable Person 

Applicants in case of first time receipt of the Application 

7. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review the 

information given by applicant in other tabs. 

  



 

 

 

  

8. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your reference and will not be 

displayed to the applicant. 

9. Click the APPROVE button. 

  



 

 

 

  

10. Click the PROCEED button. 

  

 

  

11. Affix your DSC and click the Sign button. 

  



 

 

 

  

12. A success message will be displayed. Click the OK button. 

  

 

  

Note: On approval, work-item will get closed. Registration Certificate will be issued to the applicant. The 

applicant will be communicated about approval through SMS and Email.  

Approve the Resubmitted Registration Application of Non-Resident 

Taxable Person Applicant 



 

 

Once the Non-Resident Taxable Person applicant has responded to the SCN, the Tax Official can 

approve or reject the application. 

  

7. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review the 

information given by the applicant in other tabs. 

The section with yellow highlight shows the amended information by the applicant.  

  

8. Visit each tab and verify each page of the resubmitted application. A check mark appearing on the tab 

indicates the page has been verified. 

9. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your reference and will not be 

displayed to the applicant. 

10. Click the APPROVE button. 

11. Click the PROCEED button. 

  

 

  

12. Affix your DSC and click the Sign button. 

  



 

 

 

  

13. A success message will be displayed. Click the OK button. 

  

Note: On approval, work-item will get closed. The applicant will be communicated about approval through 

SMS and Email. 

Reject the Resubmitted Registration Application of Non-Resident Taxable 

Person Applicant 

Once the Non-Resident Taxable Person applicant has responded to the SCN, the Tax Official can 

approve or reject the application. 

  

In case the applicant does not respond within 7 working days’ time, work-item will go back to Tax Official 

for processing and the Tax Official can only reject the application.  

7. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review the 

information given by the applicant in other tabs. 

The section with yellow highlight shows the amended information by the applicant.  

  

8. Visit each tab and verify each page of the resubmitted application. A check mark appearing on the tab 

indicates the page has been verified. 



 

 

9. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your reference and will not be 

displayed to the applicant. 

10. Click the REJECT button. 

11. The Rejection Order is generated. Select the relevant checkboxes for the appropriate reason. Click 

the GENERATE ORDER button. You can also enter the reasons for rejection. 

12. Click the PROCEED button. 

  

 

  

13. Affix your DSC and click the Sign button. 

  



 

 

 

  

14. A success message will be displayed.  

  

Note: 

 On rejection, work-item will get closed. 

 Auto-rejection of the application is not built in the system. 

 The applicant will be communicated about rejection of the application through SMS or Email.  



 

 

Processing of Application for allotment of UIN by UN 
bodies, Embassies or Other Notified Person 

FAQs > Processing of Application for 
allotment of UIN by UN bodies, Embassies or 
Other Notified Person 

1. What does UIN stand for? 

UIN stands for Unique Identity Number, granted to UN Bodies and Embassies and any other Notified 

Persons (as may be notified by the Commissioner).  

2. What is the relevance of UIN and how is it used? 

UIN enables UN Bodies, Embassies and Other Notified Persons in respective states to make purchases 

by providing their UIN to the goods and/or services providers. The relevance of UIN is that it needs to be 

mentioned on purchase invoices, by their suppliers, so that the UIN holder could claim refund of GST paid 

on such transactions by filing Form GSTR-11. 

3. From which date does the UIN Registration become valid? 

Effective date of registration would be the date of allotment and generation of UIN.  

4. What is the format of UIN? 

UIN has separate formats for UN Bodies / Embassies, and Other Notified Persons.  

  

The UIN format for UN Bodies / Embassies is: 0717AUS12345UN1, where: 

 First 2 digits - State Code 

 Next 2 digits - Year 

 Next 3 digits - Country Code 

 Next 5 digits - Sequential five-digit serial number repeated every year 

 Next 2 digits - UN 

 Next 1 digit - Checksum Digit 

  

The UIN format for Other Notified Persons is: 0717IND12345ON1, where: 

 First 2 digits - State Code 

 Next 2 digits - Year 



 

 

 Next 3 digits - Country Code 

 Next 5 digits - Sequential five-digit serial number repeated every year 

 Next 2 digits - ON 

 Next 1 digit - Checksum Digit 

5. How can I access the pending Application filed for allotment of UIN by 

Other Notified Person? 

Here is a screenshot of the Tax Official’s Dashboard detailing the access for Application filed for allotment 

of UIN by Other Notified Person: 

  

 

  

Step 1: Click on Registration tile 

Step 2: Click on Application for Allotment of UIN by UN Bodies, Embassies or Other Notified 

Person  

6. I have opened a pending Application filed for allotment of UIN by Other 

Notified Person for processing. What is the next step? 

Once you open a pending Application filed for allotment of UIN by Other Notified Person for processing, 

you can review the application.  

Once you have reviewed the application, you can either APPROVE or GENERATE SCN in case you may 

want to raise queries, within 3 working days from the submission of the application.  



 

 

7. How do I raise a query? 

While viewing the application, in every section, you can see monitor-like icons  next to the sub-

sections. Simply click on this icon and a query box will open as a pop-up. You can choose any of the 

predefined queries or select the ‘Others’ option to add a custom query. Once you have selected the 

query, click on Add Query and the relevant field (on which the query has been raised) will get underlined 

in yellow. 

8. How many queries can I raise in a given application? 

There is no restriction on the number of queries that can be raised. You can raise multiple queries for any 

application received. 

9. I have processed the complete application and want to reject it but I can’t 

see a REJECT button. Why? 

As a Tax Official, you cannot reject an application upon first review. The principal of natural justice 

demands that you afford the applicant an opportunity to be heard. Therefore, if there are inconsistencies 

in the application, you can generate Show Cause Notice (SCN). The Taxpayer has 7 working days to 

respond to this notice. In case the Taxpayer fails to respond to the notice or provides an unsatisfactory 

response, only then you can reject their application. 

10. What happens when I raise a Show Cause Notice? 

When you raise a Show Cause Notice, the system sends an intimation about SCN on the e-mail and SMS 

to the primary authorized signatory of the applicant. 

The applicant is expected to respond to the notice seeking clarifications on the GST Portal within 7 

working days’ time. 

11. What actions can be taken by Tax Official for processing of Application 

filed for allotment of UIN by Other Notified Person? 

Description/ Activity 
Time Frame and Action to be taken by 

Tax Official  

First time processing of 

"Application filed for allotment of 

UIN by Other Notified Person" 

Tax Official to Approve or Generate SCN for 

the Application filed for allotment of UIN by 

Other Notified Person within 3 working days of 

ARN generation.  



 

 

No Action by Tax Official on 

application within 3 working days 

of ARN generation 

Application deemed to have been approved if 

no action taken by Tax Official within 3 

working days of ARN generation 

In case of incomplete application 

or documents  

Tax Official can issue Show Cause Notice 

(SCN) within 3 working days' of ARN 

generation. 

Time Limit for Taxpayer to 

respond to the Show Cause 

Notice (SCN) issued  

Within 7 working days of receiving the SCN. 

If no reply has been submitted by the 

Taxpayer within 7 working days of issue of 

SCN, Application cannot be approved, only 

order for rejection can be issued.  

Action (Approve/ Reject) to be 

taken by the Tax Officer on 

receipt of response of Show 

Cause Notice (SCN)  

Tax Official to Approve or Reject the 

Application filed for allotment of UIN by Other 

Notified Person within 7 working days for 

processing from date of receipt of response to 

Show Cause Notice. 

  

Application will be Deemed to have been 

approved if no action is taken by Tax Official 

within 7 working days’ time from date of 

receipt of response to Show Cause Notice.  

12. What happens when I approve the Application filed for allotment of UIN 

by Other Notified Person? 

Once you successfully approve the Application filed for allotment of UIN by Other Notified Person:   

1. UIN will get generated and allotted to the taxpayer. 

2. Certificate for UIN is generated. 

3. The UIN, username and temporary password will be generated and communicated to the applicant via 

e-mail provided at the time of submission of application.  

4. Intimation of the allotment of UIN is sent via (SMS) on the registered email ID and mobile number of 

primary authorized signatory. 

5. Intimation of issue of RC, UIN and application form will be forwarded to the IT system of the other 

concerning Tax Authority 

6. RC will also be available at the Dashboard of the Taxpayer for view, print and download.  

7. Status of ARN is updated to "Approved". 

13. What happens when I reject the Application filed for allotment of UIN by 

Other Notified Person? 



 

 

Once you reject the Application filed for allotment of UIN by Other Notified Person:   

1. Rejection Order is generated. 

2. Intimation of Rejection is sent to primary authorized signatory via email and mobile number provided at 

the time of filing registration application.  

3. Rejection Order is also available at the Dashboard of the Taxpayer for view, print and download.  

4. Intimation of rejection, application form and copy of Rejection Order is also forwarded to the IT system 

of the other concerning tax authority.  

14. How allotment of UIN is communicated? 

The intimation of UIN and temporary password will be sent to the primary authorized signatory of the 

respective UN Bodies, Embassy or Other Notified Person (as applicable) via e-mail and SMS. 

15. How can I track existing registrations mapped to same PAN of the 

business/ entity on the GST Portal during processing of application for 

allotment of UIN by UN bodies, Embassies or Other Notified Person? 

While processing of application for allotment of UIN by UN bodies, Embassies or Other Notified Person, 

you can click on ‘Existing Registrations’ hyperlink available above Application header.  

You will thus be able to view all the submitted applications mapped to a single PAN.  

  



 

 

 

Manual > Processing of application for 
allotment of UIN by UN bodies, Embassies or 
Other Notified Person 

How can I process the application filed for allotment of UIN by Other 

Notified Person? 

Once the Application for allotment of UIN gets filed, the application form for UN Bodies and Embassies 

will be forwarded to Centre by default. 

  

The application form for Other Notified Person will be forwarded to one of the Tax Authorities (Centre / 

State) as per the selection made by the ‘Other Notified Person’ in the application form.  

  

For processing the application for such registrations, please perform following steps:  

  

1. Access the GST Back Office Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal and ensure that Tax Official’s Dashboard is 

displayed. 

3. Click the Registration tab. This tab shows all the different type of applications pending with Tax Official 

for processing. 

4. Click the Application for Allotment of UIN by UN Bodies, Embassies or Other Notified Person link 

to view the list of corresponding ARNs that are waiting to be processed.  

  



 

 

 

  

5. Select the ARN that you wish to process. 

Notes: 

 The ARNs are arranged in descending order of the Due Date. The application submitted first will 

be shown above in the list. 

 The Due Date column displays the date by when the pending task / action should be completed.  

 The Status column displays the current status of the registration application. 

 The Queries Raised column displays the number of queries that have been raised by the Tax 

Official in case the application form is already under processing, or in case the applicant has filed 

responses to the previously raised queries. 

  



 

 

 

  

6. Notice if the Application of Allotment of UIN has come for first time for processing, or is it a resubmitted 

application: 

 In case the application has been routed to the Tax Official for processing for the first time, the 

Status will be Pending for Processing. 

 In case the application has been resubmitted with responses to the queries to the Tax Offic ial, the 

Status will be Pending for Order. 

  

7. On clicking ARN, the application form filed by the applicant is displayed for processing. The header 

contains various sections containing information pertaining to each section. The rest of the webpage 

holds the application body and contains information as furnished by the applicant.  

  



 

 

 

Existing Registrations 

Note: To view existing registrations mapped to same PAN, click on ‘Existing Registrations’ hyperlink 

available above Application header. 
It is possible that an applicant is registered as a taxpayer as well as GSTP. In such cases, the existing 

registrations of the applicant as taxpayer 'having same PAN' will be visible from Existing Registrations’ 
hyperlink.  

  

 

  

On clicking, ‘Existing Registrations’ hyperlink, a new screen will be populated displaying details of as on 

date: 

(i) Status of all the applications for registrations (ARNs) mapped to PAN and pending with tax official for 

processing / clarifications / Order / Rejected. 

(ii) Status of all the application for registration (ARNs) mapped to PAN and approved.  

(iii) Status of the GSTIN. This will include Temporary IDs generated against that PAN.  

  



 

 

 

  

(a) Click ARN hyperlink. 

  

 

  

On clicking ARN hyperlink, Tax Official will be redirected to ‘Search ARN Details'’  page, from where he 

can retrieve the details of that ARN. 

Click here to know more about Search ARN Details. 

  



 

 

 

  

(b) Click GSTIN/ UIN/ GSTPID hyperlink. 

  

 

  

On clicking GSTIN/ UIN/ GSTPID hyperlink, Tax Official will be redirected to ‘Get Taxpayer Details’ page, 

from where he can retrieve the details of that GSTIN. 

Click here to know more Get Taxpayer Details. 

  

 

  

(c) Click Reason for Rejection hyperlink. 

  



 

 

 

  

On clicking Reason for Rejection hyperlink, the reasons for rejection of application is displayed. Click the 

OK button. 

  

 

  

8. The Tax Official need to verify all the information shared by the taxpayer in the application. The Tax 

Official need to review each tabs like Basic details, Entity Details etc. In case the allotment of UIN 

application is processed for the first time, the Tax Officials can take the following actions: 

• Generate SCN 

• Approve 

  

Accordingly, the Tax Official can view only two buttons - Approve and Generate SCN. 

  

In case Tax Official takes no action or fails to take any action, within 3 working Days’ time from the date of 

generation of ARN, the application will be deemed to have been 



 

 

approved. 

  

Accordingly, the Tax Official can view only two buttons - Approve and Generate SCN. 

  

9. In case, the UIN generation application is resubmitted with clarification, Tax Officials can take following 

actions: 

• Approve 

• Reject 

  

Accordingly, the Tax Official can view only two buttons - Approve and Reject. 

In case Tax Official takes no action or fails to take any action, within 7 working Days’ time from the date of 

receipt of reply to SCN, the application will be deemed approved. 

Generate SCN in case of first time receipt of the Allotment of UIN 

application 

While processing the Allotment of UIN Application for Other Notified person, Tax officer can:  

• Raise a query in case you wish to seek any clarification from the applicant, with respect to 

deficient information or any document required to furnish the application.  

• Generate Show Cause Notice (SCN) on the query raised.  

  

8.1. Review each section thoroughly. Click the monitor icon displayed adjacent to the section headers to 

raise queries. 

  

 

  



 

 

8.2. In the Field drop-down list, select the field for which you want to raise a query.  

8.3. In the Query Description drop-down list, select the query to be raised. 

8.4. Click the ADD QUERY button to add the queries in the table given below the fields. 

  

 

  

8.5. Query section of each page has an option of “Others”. You can select this option to add free text 

query in the page. 

  

 

  

8.6. You can raise multiple queries, if required. Once done, click OK. 

  



 

 

 

  

8.7. The section with queries gets highlighted with a yellow underline. 

  

 

  

8.8. Verify each page of the application by visiting each tab. Click the VERIFY & CONTINUE button to 

move ahead and review other tabs.  

  

 

  

8.9. A check mark appearing on the tab indicates the page has been verified. 



 

 

  

 

  

8.10. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your internal reference and will 

not be displayed to the applicant.  

  

 

  

8.11. Click the GENERATE SCN button. 

  



 

 

 

  

8.12. A Show Cause Notice for seeking clarifications is generated for the queries raised. Click the 

GENERATE SCN button. 

  

 

  

8.13. Click the PROCEED button. 

  



 

 

 

  

8.14. Affix your DSC and click the Sign button. 

  

 

  

8.15. A success message will be displayed. Click the OK button. 

  



 

 

 

  

Note: The applicant will be given 7 working days’ time to file reply to the Notice for seeking clarifications. 

In case the applicant does not respond within 7 working days’ time, the work -item will go back to the Tax 

Official for processing, and in such case the Tax Official will only be able to reject the application.  

Approve Registration Application of Allotment of UIN in case of first time 

receipt of the Application 

Note: The first 7 steps are same as shown above. 

  

8.1. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review 

the information given by applicant in other tabs. 

  

 

  



 

 

8.2. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your reference and will not be 

displayed to the applicant. 

8.3. Click the APPROVE button. 

  

 

  

8.4. Click the PROCEED button. 

  

 



 

 

  

8.5. Affix your DSC and click the Sign button. 

  

 

  

8.6. A success message will be displayed. Click the OK button. 

  

 

  

Note: On approval, work-item will get closed. Registration Certificate will be issued to the applicant. The 

primary authorized signatory will be communicated about approval of the application through SMS and 

Email. 



 

 

Approve the resubmitted UIN Registration Application 

Note: The first 8 steps are same as shown above. 

  

Once the Other Notified Person applicant has responded to the SCN, the Tax Official can approve or 

reject the application. 

Tax official can approve the application in case he/ she is satisfied with the response received from the 

taxpayer. 

  

9.1. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review 

the information given by the applicant in other tabs.  

The section with yellow highlight shows the amended information by the applicant.  

9.2. Click the monitor icon for the fields where you want to verify if the taxpayer has responded to the 

queries raised. 

  

 

  

9.3. The response to queries are displayed. Click the CLOSE button. 

  



 

 

 

  

9.4. Visit each tab and verify each page of the resubmitted application. A check mark appearing on the 

tab indicates the page has been verified. 

9.5. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your reference and will not be 

displayed to the applicant. 
9.6. Click the APPROVE button.  
   

 

  

9.7. Click the PROCEED button. 

  



 

 

 

  

9.8. Affix your DSC and click the Sign button. 

  

 

  

9.9. A success message will be displayed. Click the OK button. 

  



 

 

 

  

Note: On approval, work-item will get closed. Registration Certificate will be issued to the applicant. The 

primary authorized signatory will be communicated about approval of the application through SMS and 

Email. 

Reject the Resubmitted UIN Registration Application 

Note: The first 8 steps are same as shown above. 

  

Once the Other Notified Person applicant has responded to the SCN, the Tax Official can approve or 

reject the application. 

Tax official can approve the application in case he/ she is satisfied with the response received from the 

taxpayer. 

  

9.1. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review 

the information given by the applicant in other tabs.  

The section with yellow highlight shows the amended information by the applicant.  

9.2. Click the monitor icon for the fields where you want to verify if the taxpayer has responded to the 

queries raised. 

  



 

 

 

  

9.3. The response to queries are displayed. Click the CLOSE button. 

  

 

  

9.4. Visit each tab and verify each page of the resubmitted application. A check mark appearing on the 

tab indicates the page has been verified. 

9.5. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your reference and will not be 

displayed to the applicant. 

9.6. Click the REJECT button. 

  



 

 

 

  

9.7. The Rejection Order is generated. Select the relevant checkboxes for the appropriate reason. Click 

the GENERATE ORDER button. You can also enter the reasons for rejection. 

  

 

  

9.8. Click the PROCEED button. 

  



 

 

 

  

9.9. Affix your DSC and click the Sign button. 

  

 

  

9.10. A success message will be displayed. Click the OK button. 

  



 

 

Note: 

 On rejection, work-item will get closed. 

 Auto-rejection of the application is not built in the system.  

 The primary authorized signatory will be communicated about rejection of the application through 

SMS or Email. 



 

 

Processing of Application for Revocation of Cancelled 
Registration 

FAQs > Processing of Application for 
Revocation of Cancelled Registration 

1. When a taxpayer can apply for revocation of cancelled registration? 

A taxpayer can apply for revocation of cancelled registration when his registration has been suo moto 

cancelled by Tax Official. 

2. How can I access the pending Application for Revocation of Cancelled 

Registration? 

Here is a screenshot of the Tax Official’s Dashboard detailing the access for Application for Revocation of 

Cancelled Registration for your reference: 

  

 

  



 

 

Step 1: Click on Registration tile 

Step 2: Click on Revocation of Cancelled Registration 

Step 3: Select the application to process from the list by clicking on the relevant ARN 

3. I have opened a pending Application for Revocation of Cancelled 

Registration for processing. What is the next step? 

Once you open a pending Application for Revocation of Cancelled Registration for processing, you can 

review the application. Once you have reviewed the application, you can APPROVE or GENERATE SCN 

in case you have want to raise queries within 30 days of the submission of the application.  

4. What actions can be taken by Tax Official for processing of Application 

for Revocation of Cancelled Registration? 

Description/ Activity 
Time Frame and Action to be taken by 

Tax Official  

First time processing of 

Application for Revocation of 

Cancelled Registration 

Tax Official to Approve or Raise SCN for the 

Application for Revocation of Cancelled 

Registration within 30 days of ARN generation.  

No Action by Tax Official on 

application  

An alert will be sent to tax official in case he 

does not process the application within 30 

days from the date of receipt of application 

In case of incomplete application 

or documents  

Tax Official can generate SCN within 30 

working days of ARN generation. 

Time Limit for Taxpayer to 

respond to the Show Cause 

Notice (SCN) issued  

Within 7 working days of receiving the Show 

Cause Notice. 

If no reply has been submitted by the 

Taxpayer within <7> days of issue of SCN, 

Application cannot be approved, only order for 

rejection can be issued.  

Action (Approve/ Reject) to be 

taken by the Tax Officer on 

receipt of response of Show 

Cause Notice (SCN)  

Tax Official to Approve or Reject the 

Application for Revocation of Cancelled 

Registration within 30 days for processing 

from date of receipt of response to Show 

Cause Notice. 

  

An alert will be sent to tax official in case he 

does not process the application from 30 days 

from the date of reply to Show Cause Notice. 



 

 

5. How do I raise a query? 

In every section, you can see monitor-like icons  next to the sub-sections. Simply click on this icon 

and a query box will open as a pop-up. You can choose any of the predefined queries or select the 

‘Others’ option to add a custom query. Once you have selected the query, click on Add Query and the 

relevant field (on which the query has been raised) will get underlined in yellow.  

  

Note: It is mandatory to add custom remarks/comments even if you select a predefined query.  

6. How many queries can I raise in a given application? 

There is no restriction on the number of queries that can be raised. You can raise multiple queries.  

7. I have processed the complete application and want to reject it but I can’t 

see a REJECT button. Why? 

As a Tax Official, you cannot reject an application upon first review. The principal of natural justice 

demands that you afford the applicant an opportunity to be heard. Therefore, if there are inconsistencies 

in the application, you can generate Show Cause Notice (SCN). Taxpayer has 7 working days to respond 

to this notice. In case, taxpayer fails to respond to the notice or provides an unsatisfactory response, only 

then you can reject their application. 

8. What happens when I approve the Application for Revocation of 

Cancelled Registration? 

Once you successfully approve the application, following happens:  

1. Order for approval of application of Revocation of cancelled registration will be issued 

2. Cancelled GSTIN status will change from “Inactive” to “Active” in the GSTIN master data.  

3. Taxpayer will be intimated via SMS and email of the approval of application.  

4. Order to be made available on the taxpayer’s dashboard.  

9. What happens when I reject the Application for Revocation of Cancelled 

Registration? 

Once you reject the application, following happens: 

1. Rejection order will be generated 

2. GSTIN status will remain “Inactive” in the GSTIN master data.  

3. Taxpayer will be intimated via SMS and email of the rejection of the application.  

4. Order will be made available on the taxpayer’s dashboard. 



 

 

10. What happens when I raise a Show Cause Notice? 

When you raise a Show Cause Notice, the system sends an intimation about SCN on the e-mail and SMS 

to the primary authorized signatory of the applicant. 



 

 

 

Manual > Processing of Application for 
Revocation of Cancelled Registration 

How can I process the application filed for Revocation of Cancelled 

Registration? 

Once the Revocation of Cancelled Registration application gets filed, application form will appear in the 

work-item list of the Tax Official (State/Centre) based on relevant jurisdictional administrative authority.  

For processing the application for Revocation of Cancelled Registration, perform the following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal. The Tax Official’s Dashboard is displayed.  

3. Click the Registration tab. This tab shows all the different type of applications pending with tax official 

for processing. 

4. Click the Revocation of Cancelled Registration link to view the list of corresponding ARNs that are 

waiting to be processed. 

  

 



 

 

  

5. Select the ARN that you wish to process. 

Note: 

 The ARNs are arranged in the descending order of the Due Date. The application submitted first 

will be shown above in the list. 

 The Due Date column displays the date by when the pending task / action should be completed.  

 The Status column displays the current status of the registration application. 

  

 

  

6. Notice, if the application for Revocation of Cancelled Registration has come for first t ime for 

processing, or is it a resubmitted application: 

 In case the application has been routed to the Tax Official for processing for the first time, the 

Status will be Pending for Processing. 

 In case the application has been resubmitted with responses to the queries to the Tax Official, the 

Status will be Pending for Order. 

  

On clicking ARN, the application form filed by the applicant is displayed for processing.  

  



 

 

 

  

(A) In case the application for Revocation of Cancelled Registration is processed for the first time, the Tax 

Officials can take the following actions: 

• Generate SCN 

• Approve 

  

Accordingly, the Tax Official can view only two buttons - Approve and Generate SCN. 



 

 

  

In case the Tax Official does not take any action, or fails to take an action within 30 days from the date of 

the receipt of application, an alert will be sent to tax official if he does not process the application within 

30 days from the date of receipt of application or from 30 days from the date of reply to Show Cause 

Notice. 

  

(B) Tax Officials can take following actions, in case the application for Revocation of Cancelled 

Registration is resubmitted with clarification: 

• Approve 

• Reject 

  

Accordingly, the Tax Official can view only two buttons - Approve and Reject. 

Generate SCN in case of first time receipt of the Application for Revocation 

of Cancelled Registration  

While processing the application for Revocation of Cancelled Registration, you can: 

• Raise a query in case you wish to seek any clarification from the applicant, with respect to deficient 

information or any document required to furnish the application. 

• Generate Show Cause Notice (SCN) on the query raised. 

  

7. Review the application form thoroughly. Click the monitor icon displayed adjacent to the section 

headers to raise queries. 

  

 

  

8. In the Field drop-down list, select the field for which you want to raise a query.  

  

 

  



 

 

9. In the Query Description drop-down list, select the query to be raised. 

  

 

  

10. Click the ADD QUERY button to add the queries in the table given below the fields. 

  

 

  

Query section of each page has an option of “Others”. You can select this option to add free text query in 

the page. 

  

 

  

Note: You can click the Edit/ Delete button to edit or delete any raised query. 

  



 

 

 

  

11. You can raise multiple queries, if required. Once done, click OK. 

  

 

  

The section with queries gets highlighted as shown in the screenshot below.  

  



 

 

 

  

12. Click the GENERATE SCN button. 

In case you want to save the application details, click the SAVE button. 

  



 

 

 

  

13. A Show Cause Notice for seeking clarifications is generated for the queries raised. Select the 

checkbox for declaration. 

14. Select the date and time when you want to applicant to appear before the undersigned authority.  

15. Click the GENERATE SCN button. 

  



 

 

 

  

16. Click the PROCEED button. 

  

 

  

17. Affix your DSC and click the Sign button. 

  



 

 

 

  

18. A success message will be displayed. Click the OK button. 

  

 

  

Note: The applicant will be given 7 working days’ time to file reply to the Notice for seeking clarifications. 

In case the applicant does not respond within 7 working days’ time, the work-item will go back to the Tax 

Official for processing, and the Tax Official will only be able to reject the application.  



 

 

Approve Application for Revocation of Cancelled Registration in case of 

first time receipt of the Application 

7. Review the application form given for application of revocation of cancelled registration.  

8. Click the APPROVE button. 

  

 

  



 

 

9. Click the APPROVE button. 

  

 

  

10. Click the PROCEED button. 

  

 

  

11. Affix your DSC and click the Sign button. 

  



 

 

 

  

12. A success message will be displayed. Click the OK button. 

  

 

  

Note:  

1. Order for approval of application of Revocation of cancelled registration will be issued 

2. Cancelled GSTIN status will change from “Inactive” to “Active” in the GSTIN master data.  

3. Taxpayer will be intimated via SMS and email of the approval of application. 

4. Order to be made available on the taxpayer’s dashboard. 



 

 

Approve the Resubmitted Application for Revocation of Cancelled 

Registration  

Once the applicant has responded to the SCN, the Tax Official can approve or reject the application. 

  

7. Review the application form thoroughly. The section with yellow highlight shows the amended 

information by the applicant.  

8. Click the monitor icon displayed adjacent to the section headers to view the responses to t he queries. 

  

 

  

9. Click the APPROVE button. 

  



 

 

 

  

10. Click the APPROVE button. 



 

 

  

 

  

11. Click the PROCEED button. 

  

 

  

12. Affix your DSC and click the Sign button. 

  



 

 

 

  

13. A success message will be displayed. Click the OK button. 

  

 

  

Note:  

1. Order for approval of application of Revocation of cancelled registration will be issued 

2. Cancelled GSTIN status will change from “Inactive” to “Active” in the GSTIN master data. 

3. Taxpayer will be intimated via SMS and email of the approval of application.  

4. Order to be made available on the taxpayer’s dashboard. 



 

 

Reject the Resubmitted Application for Revocation of Cancelled 

Registration  

Once the applicant has responded to the SCN, the Tax Official can approve or reject the application.  

  

In case the applicant does not respond within 7 working days’ time, work-item will go back to Tax Official 

for processing and the Tax Official can only reject the application. Once the applicant has responded to 

the SCN, the Tax Official can approve or reject the application.  

  

7. Review each section thoroughly. The section with yellow highlight shows the amended information by 

the applicant.  

8. Click the monitor icon displayed adjacent to the section headers to view the responses to the queries.  

  

 

  

9. Click the REJECT button. 

  



 

 

 

  



 

 

10. The Rejection Order is generated. Select the relevant checkboxes for the appropriate reason. Click 

the GENERATE ORDER button. You can also enter the reasons for rejection. 

  

 

  

11. Click the PROCEED button. 

  

 

  

12. Affix your DSC and click the Sign button. 



 

 

  

 

  

13. A success message will be displayed. Click the OK button. 

  

 

  

Note: 

1. Rejection order will be generated 

2. GSTIN status will remain “Inactive” in the GSTIN master data.  

3. Taxpayer will be intimated via SMS and email of the rejection of the application.  

4. Order to be made available on the taxpayer’s dashboard. 



 

 

Processing of Cancellation of Registration Application 

FAQs > Processing of Cancellation of 
Registration Application 

1. How can I access the pending Cancellation of Registration Applications? 

Here is a screenshot of the Tax Official’s Dashboard detailing the access for pending Cancellation of 

Registration Applications for your reference: 

  

 

  

Step 1: Click on Registration tile 

Step 2: Click on Cancellation proceedings of Registration 

Step 3: Select the application to process from the list by clicking on the relevant ARN 

2. I have opened a pending Cancellation of Registration Application for 

processing. What is the next step? 

Once you open a pending Cancellation of Registration Application for processing, you can begin a 

section-wise review. After reviewing a particular section, click the VERIFY & CONTINUE button at the 

bottom right of the page to move to the next section. 

Once you have completed all the sections, you can APPROVE or GENERATE SCN in case you have 

raised queries. 



 

 

3. What actions can be taken by Tax Official for processing of Cancellation 

of Registration Application? 

Description/ Activity 
Time Frame and Action to be taken by 

Tax Official  

First time processing of 

Cancellation of Registration 

Application  

Tax Official to Approve or Raise SCN for the 

cancellation Application within 30 working 

days of ARN generation.  

No Action by Tax Official on 

application  

An alert will be sent to tax official in case he 

does not process the application within 30 

days from the date of receipt of application 

In case of incomplete application 

or documents  

Tax Official can generate SCN within 30 

working days of ARN generation. 

Time Limit for Taxpayer to 

respond to the Show Cause 

Notice (SCN) issued  

Within 7 working days of receiving the Show 

Cause Notice 

If no reply has been submitted by the 

Taxpayer within <7> days of issue of SCN, 

Application cannot be approved, only order for 

rejection can be issued.  

Action (Approve/ Reject) to be 

taken by the Tax Officer on 

receipt of response of Show 

Cause Notice (SCN)  

Tax Official to Approve or Reject the 

Cancellation Application within 30 working 

days for processing from date of receipt of 

response to Show Cause Notice. 

  

An alert will be sent to tax official in case he 

does not process the application from 30 days 

from the date of reply to Show Cause Notice. 

4.Can I approve the application for Cancellation of Registration in case the 

dues are pending for payment by the taxpayer? 

Yes, you can approve the application for Cancellation of Registration even if the dues are pending for 

payment by the taxpayer. 

5. There are multiple sections in the application form. Can I navigate to 

other sections during processing the application? 

Yes, as a Tax Official, you can view the sections of the application in any order you choose.  



 

 

6. Can I verify and continue even if I have raised a query in the section? 

Yes, you are required to click on VERIFY & CONTINUE for every section before you can pass an order 

on the application. 

  

Every time you successfully verify a section without any queries, the section header will turn blue along 

with a check mark, indicating that you have reviewed that section. 

7. How do I raise a query? 

In every section, you can see monitor-like icons next to the sub-sections. Simply click on this icon and a 

query box will open as a pop-up. You can choose any of the predefined queries or select the ‘Others ’ 

option to add a custom query. Once you have selected the query, click on Add Query and the relevant 

field (on which the query has been raised) will get underlined in yellow.  

  

Note: It is mandatory to add custom remarks/comments even if you select a predefined query. 

8. How many queries can I raise in a given application? 

There is no restriction on the number of queries that can be raised. You can raise multiple queries.  

9. Where can I see the number of queries I have raised? 

In case you have raised queries, the total number of queries raised in an application form will be 

displayed in the Queries Raised column on the dashboard, before signing the application using your 

digital signature. Please refer to the below screenshot:  

  

 

10. There is a Remarks section on the final page. What is it for? 

The Remarks section is for any comments you wish to add to the application for your personal reference. 

These are confidential remarks and cannot be seen by anyone except you.  



 

 

11. I have processed the complete application and want to reject it but I 

can’t see a REJECT button. Why? 

As a Tax Official, you cannot reject an application upon first review. The principal of natural justice 

demands that you afford the applicant an opportunity to be heard. Therefore, if there are inconsistencies 

in the application, you can generate Show Cause Notice (SCN). The Taxpayer has seven working days to 

respond to this notice. In case the Taxpayer fails to respond to the notice or provides an unsatisfactory 

response, only then you can reject their application.  

12. What happens when I approve the application for cancellation of 

registration? 

Once you successfully approve the application, the system generates an order of cancellation of 

registration and an intimation is sent to taxpayer via e-mail and sms about the approval. Consequent to 

the approval of the Cancellation of Registration application, the taxpayer’s GSTIN Status will be changed 

to "Cancelled".  

13. What happens when I raise a Show Cause Notice? 

When you raise a Show Cause Notice, the system sends an intimation about SCN on the e-mail and sms 

to the Taxpayer. 



 

 

 

Manual > Processing of Cancellation of 
Registration Application 

How can I process the application filed for Cancellation of Registration 

Application? 

Once the Cancellation of Registration Application gets filed, Form will appear in the work -item list of the 

Tax Official (State/Centre) based on relevant jurisdictional administrative authority. 

For processing the Cancellation of Registration Application, perform the following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal. The Tax Official’s Dashboard is displayed. 

3. Click the Registration tab. This tab shows all the different type of applications pending with tax official 

for processing. 

4. Click the Cancellation proceedings of Registration link to view the list of corresponding ARNs that 

are waiting to be processed. 

  

 

  

5. Select the ARN that you wish to process. 

Note: 

 The ARNs are arranged in the descending order of the Due Date. The application submitted first 

will be shown above in the list. 



 

 

 The Due Date column displays the date by when the pending task / action should be completed.  

 The Status column displays the current status of the registration application. 

  

 

  

6. Notice, if the Application for Cancellation of Registration has come for first time for processing, or is it a 

resubmitted application: 

 In case the application has been routed to the Tax Official for processing for the first time, the 

Status will be Pending for Processing. 

 In case the application has been resubmitted with responses to the queries to the Tax Official, the 

Status will be Pending for Order. 

  

 

  

On clicking ARN, the application form filed by the applicant is displayed for processing. The header 

contains various blocks containing information pertaining to each section. The rest of the webpage forms 

the application body and contains information filled-in by the applicant. 

  

 

  

In case the Cancellation of Registration application is processed for the first time, the Tax Officials can 

take the following actions: 



 

 

• Generate SCN 

• Approve 

  

Accordingly, the Tax Official can view only two buttons - Approve and Generate SCN. 

  

In case the Tax Official does not take any action, or fails to take an action within 30 working days from the 

date of the receipt of application, an alert will be sent to tax official if he does not process the application 

within 30 days from the date of receipt of application or from 30 days from the date of reply to Show 

Cause Notice. 

  

Tax Officials can take following actions, in case the Cancellation of Registration application is resubmitted 

with clarification: 

• Approve 

• Reject 

  

Accordingly, the Tax Official can view only two buttons - Approve and Reject. 

Generate SCN in case of first time receipt of the Cancellation of 

Registration Application 

While processing the Cancellation of Registration application, you can: 

• Raise a query in case you wish to seek any clarification from the applicant, with respect to deficient 

information or any document required to furnish the application. 

• Generate Show Cause Notice (SCN) on the query raised. 

  

7. Review each section thoroughly. Click the monitor icon displayed adjacent to the section headers to 

raise queries. 

  

 



 

 

  

8. In the Field drop-down list, select the field for which you want to raise a query. 

9. In the Query Description drop-down list, select the query to be raised. 

10. Click the ADD QUERY button to add the queries in the table given below the fields. 

  

 

  

Query section of each page has an option of “Others”. You can select this option to add free text query in 

the page. 

  

 

  

Note: You can click the Delete button to delete any raised query. 

11. You can raise multiple queries, if required. Once done, click SAVE. 

  



 

 

 

  

The section with queries gets highlighted as shown in the screenshot below.  

  

 

  

12. Verify each page of the application by visiting each tab. Click the VERIFY & CONTINUE button to 

move ahead and review other tabs. 

  



 

 

 

  

A check mark appearing on the tab indicates the page has been verified.  

  



 

 

 

  

13. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your reference and will not be 

displayed to the applicant. 

14. Click the GENERATE SCN button. 

  

 

  

15. A Show Cause Notice for seeking clarifications is generated for the queries raised. Select the 

checkbox for declaration. 

16. Select the date and time when you want to applicant to appear before the undersigned authority.  

17. Click the GENERATE SCN button. 

  



 

 

 

  

18. Click the PROCEED button. 

  

 

  

19. Affix your DSC and click the Sign button. 

  



 

 

 

  

20. A success message will be displayed. Click the OK button. 

  

 

  

Note: The applicant will be given 7 working days’ time to file reply to the Notice for seeking clarifications. 

In case the applicant does not respond within 7 working days’ time, the work-item will go back to the Tax 

Official for processing, and the Tax Official will only be able to reject the application.  



 

 

Approve Application for Cancellation of Registration in case of first time 

receipt of the Application 

7. Review each section thoroughly. Click the VERIFY & CONTINUE button to move ahead and review the 

information given for Cancellation of Registration in other tabs. 

8. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your reference and will not be 

displayed to the applicant. 

9. Click the APPROVE button. 

  

 

  

10. Select the effective date of cancellation of registration. 

11. You can also input any amount already pending on taxpayer for payment. Please note that any 

amount entered will be only for informative purpose. No new demand can be issued through this order.  

12. Click the GENERATE ORDER button. 

  



 

 

 

  

13. Click the PROCEED button. 

  



 

 

 

  

14. Affix your DSC and click the Sign button. 

  

 

  

15. A success message will be displayed. Click the OK button. 

  



 

 

 

  

Note:  

1. On approval, work-item will get closed. The applicant will be communicated about approval through 

SMS and Email. 

2. Consequent to the approval of the Cancellation of Registration application, the taxpayer’s GSTIN 

status will be changed to "Cancelled".  

3. Taxpayer will be able to access the GST portal to upload the pending returns, make payment for pre-

cancellation period prior to effective date of cancellation of registration.  

4. The cancellation of registration will not affect the liability of taxpayer to pay tax and other dues. The tax 

official can approve the application for cancellation even if the dues are pending for payment by the 

taxpayer.  

5. Once the Application for cancellation is approved, the details of Cancelled status of GSTIN will be 

intimated to other tax authority (State / Centre). 

6. Order of Cancellation of registration will also be available at the dashboard of the Taxpayer for view, 

print and download. 

Approve the Resubmitted Application for Cancellation of Registration 

Once the applicant has responded to the SCN, the Tax Official can approve or reject the application.  

  

7. Review each section thoroughly. The section with yellow highlight shows the amended information by 

the applicant.  

  



 

 

 

  

8. Click the monitor icon displayed adjacent to the section headers to view the responses to the queries.  

  



 

 

 

  



 

 

 

  

9. Visit each tab and verify each page of the resubmitted application. A check mark appearing on the tab 

indicates the page has been verified. Click the VERIFY & CONTINUE button to move ahead and review 

the information given by the applicant in other tabs. 

10. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your reference and will not be 

displayed to the applicant. 

10. Click the APPROVE button. 

  

 

  

10. Select the effective date of cancellation of registration. 



 

 

11. You can also input any amount already pending on taxpayer for payment. Please note that any 

amount entered will be only for informative purpose. No new demand can be issued through this order.  

12. Click the GENERATE ORDER button. 

  

 

  

13. Click the PROCEED button. 

  



 

 

 

  

14. Affix your DSC and click the Sign button. 

  

 

  

15. A success message will be displayed. Click the OK button. 

  



 

 

 

  

Note:  

1. On approval, work-item will get closed. The applicant will be communicated about approval through 

SMS and Email. 

2. Consequent to the approval of the Cancellation of Registration application, the taxpayer’s GSTIN 

status will be changed to “Cancelled”.  

3. Taxpayer will be able to access the GST portal to upload the pending returns, make payment for pre-

cancellation period prior to effective date of cancellation of registration. 

4. The cancellation of registration will not affect the liability of taxpayer to pay tax and other dues. The tax 

official can approve the application for cancellation even if the dues are pending for payment by the 

taxpayer.  

5. Once the Application for cancellation is approved, the details of cancelled status of GSTIN will be 

intimated to other tax authority (State / Centre). 

6. Order of Cancellation of registration will also be available at the dashboard of the Taxpayer for view, 

print and download. 

Reject the Resubmitted Application for Cancellation of Registration 

Once the applicant has responded to the SCN, the Tax Official can approve or reject the application.  

  

In case the applicant does not respond within 7 working days’ time, work-item will go back to Tax Official 

for processing and the Tax Official can only reject the application. Once the applicant has responded to 

the SCN, the Tax Official can approve or reject the application.  

  

7. Review each section thoroughly. The section with yellow highlight shows the amended information by 

the applicant.  

  



 

 

 

  

8. Click the monitor icon displayed adjacent to the section headers to view the responses to the queries.  

  



 

 

 

  



 

 

 

  

9. Visit each tab and verify each page of the resubmitted application. A check mark appearing on the tab 

indicates the page has been verified. Click the VERIFY & CONTINUE button to move ahead and review 

the information given by the applicant in other tabs. 

10. On the Remarks page, you may give closure remarks or mention any noteworthy points for future 

reference and click the ADD REMARKS button. These remarks are for your reference and will not be 

displayed to the applicant. 

10. Click the REJECT button. 

  

 

  



 

 

11. The Rejection Order is generated. Select the relevant checkboxes for the appropriate reason. Click 

the GENERATE ORDER button. You can also enter the reasons for rejection. 

  

 

  

12. Click the PROCEED button. 

  

 

  

13. Affix your DSC and click the Sign button. 

  



 

 

 

  

14. A success message will be displayed. Click the GO BACK button. 

  

 

  

Note: 

 On rejection, work-item will get closed. 

 Auto-rejection of the application is not built in the system. 

 The applicant will be communicated about rejection of the application through SMS or Email. 

 On rejection of the Cancellation application, a rejection order will be generated.  

 Rejection order will be available on the taxpayer’s dashboard.  



 

 

 Intimation of rejection, copy of Rejection Order and application form will also be forwarded to the 

IT system of the other concerning Tax Authority. 



 

 

Correction of Jurisdiction before Approval 

FAQs > Correction of Jurisdiction before 
Approval 

1. I have received a Registration Application in which the applicant has 

mentioned incorrect jurisdiction. Can I correct the Jurisdiction or should I 

reject the Registration application? 

Yes, you can correct the jurisdiction in case applicant has entered the wrong jurisdiction in the 

Registration Application. You need not reject the application but forward it to correct jurisdictional 

authority. 

2. If I, as Tax Officer have corrected the jurisdiction of an applicant in the 

Registration Application, who will process the Registration Application? 

Once you correct the Jurisdiction of the taxpayer in the Registration Application, the work item will be 

forwarded and gets assigned to the “New Jurisdiction” and that ARN will be forwarded to the correct 

jurisdictional officer for processing. The ARN will be removed from Dashboard of the tax Official who 

originally received the Registration Application.  

  

The Registration Application will be deemed approved if tax official did not take any action for three 

working days, even in cases where jurisdiction is corrected by the Tax Official.  

3. Is there a limit of number of times, a Tax Official can correct jurisdiction 

in a Registration Application? 

No. 

4. How is the time of three working days calculated when jurisdiction is 

corrected in the Registration Application? For example, If I as tax officer 

transfer the Registration Application on second day of the receipt of the 

application, how many days will the Tax official in the corrected 

Jurisdiction get to process the application? 



 

 

Time limit of processing the Registration Application will NOT be effected. It wi ll remain same and the 

Registration Application has to be processed within <3> working days from the date of receipt of the 

application by the first officer.  

5. At what stage can I as Tax officer forward the registration application? 

Can I forward the registration application after reply to SCN is received? 

You can correct the jurisdiction in the Registration Application only if no action (Approve/ raise SCN) is 

taken by the Tax Official. Once the Registration Application is processed, Tax official cannot correct the 

jurisdiction. 

6. When I as Tax officer forward the registration application to new 

jurisdiction does taxpayer receive any communication via email/Mobile? 

No, Taxpayer will NOT receive any communication regarding correction of Jurisdiction.  

7. When I as Tax Officer forward the registration application to new 

jurisdictional officer does new jurisdictional officer receive any 

communication email/mobile? 

No, New jurisdictional officer will not receive any communication. ARN will be added to the Das hboard.  



 

 

Manual > Correct of Jurisdiction before 
Approval 

How can I correct the jurisdiction in a Registration Application, if it is 

wrongly mentioned by the applicant? 

To correct the Jurisdiction in a Registration Application, perform following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Login with valid credentials. The Tax Official’s Dashboard is displayed.  

3. Select the ARN for which Jurisdiction needs to be corrected. ARN will open and Registration 

Application is displayed. 

4. Select the Correct Jurisdiction option. 

  

 

  

5. The Correct Jurisdiction screen is displayed. The Jurisdiction details filled by the applicant are 

displayed in the Old Jurisdiction fields. You need to enter the correct jurisdiction details in the New 

Jurisdiction fields. 

6. Enter your comments in the Remarks field and click the Forward button. 

  



 

 

 

  

The work item will be assigned to a tax Official in the New Jurisdiction and the ARN will be removed from 

your Dashboard and ARN will be forwarded to the correct jurisdictional officer for processing. 

Note:  

1. There will be no communication regarding Jurisdiction correction sent to Tax Payer or new Tax official 

to whom ARN is forwarded to.  

2. Tax official need not digitally sign while forwarding the application to new Jurisdiction.  



 

 

Reset of email address/ and mobile phone number of 
Authorized Signatory 

FAQs > Reset of email address/ and mobile 
phone number of Authorized Signatory 

1. Which role can reset the password for a taxpayer to login to the GST 

Portal? 

The Tax Official who has been assigned the role of Registration Approval can reset the password for a 

taxpayer to login to the GST Portal. 

2. Can I mark an existing promoter/ partner as a Primary Authorized 

signatory? 

Yes, you can mark an existing promoter/ partner as a Primary Authorized Signatory after proper 

authentication. 

3. Can I update the details of a taxpayer who is already added as an 

Authorized signatory? 

Yes, you can update the details of a taxpayer who is already added as an Authorized signatory after 

proper authentication. You need to ensure that the correct person has approached for updating the 

details. 

4. Can Model 1 States and Centre Tax Officials add a taxpayer as an 

Authorized signatory? 

Yes, Model 1 States and Centre Tax Officials can add a taxpayer as an Authorized signatory. Taxpayer 

can contact relevant Jurisdictional Tax Officer in their State to set a new Authorized Signatory in the GST 

Portal. The updated details will be integrated with the GST Portal.  

5. I am not able to update the details of a taxpayer. Why? 

You can update the details for GSTIN with Status "Active Pending Verification" or "Active".  

6. Can a Jurisdictional Officer add a taxpayer as an Authorized signatory? 



 

 

Yes, a Jurisdictional Officer can add a taxpayer as an Authorized signatory.  

7. Can a Jurisdictional Officer add two Authorized signatories for a single 

GSTIN? 

Yes, a Jurisdictional Officer can add two Authorized Signatories for a single GSTIN but primary 

Authorized Signatory can only be one. 

  



 

 

 

Manual > Reset of email address/ and mobile 
phone number of Authorized Signatory 

Note: This manual is for amendment by Tax Officers. 

  

Update Authorized Signatory’s details 

Add Authorized Signatory’s details 

1. How can I update Authorized Signatory’s details to login to the GST 

Portal? 

To update Authorized Signatory’s details to login to the GST Portal, perform the following steps:  

  

1. Access the GST Portal for Tax Official. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. The Tax Official’s Dashboard is displayed. Click on the Services > Taxpayer Account > Update 

Authorized Signatory link. 

  

 

  

4. The Update Authorized Signatory page is displayed. In the GSTIN field, enter the GSTIN of the 

taxpayer whose details needs to be updated. 

5. Click the GO button. 

  

 

  

6. The list of all Authorized Signatories/ Stakeholders is displayed. 



 

 

7. Before you edit any detail, click the VIEW button to view the details of Authorized Signatories/ 

Stakeholders. 

  

 

  

8. The details are displayed. View the details and click the CLOSE button. 

  



 

 

 

  

You will be redirected to the Details of Authorized Signatory/Stakeholders page. 

  

You can update details of: 

Primary Authorized Signatory 

Update Details of Authorized Signatory, also Promoter 

Authorized Signatory 

  

Refer the legend given at the top right of the page. 

  



 

 

 

  

Update Details of Primary Authorized Signatory: 

  

9. Click the EDIT button next to the details of Primary Authorized Signatory. You can refer the legend 

given at top right of the page. 

  

 

  



 

 

10. The details of the Primary Authorized Signatory are displayed. Click the EDIT icon to update the email 

address/ mobile number of Primary Authorized Signatory. 

  

 

  

11. In the Email Address field, enter the updated email address. 

12. In the Mobile Number field, enter the updated mobile number. 

13. In the Remarks field, enter the remarks. 

14. In the Reasons for Update field, enter the reasons for updating the details of Authorized Signatory. 

15. Select Choose File button to upload the supporting document. 

You can upload PDF or JPEG file size with maximum upload limit as 1 MB.  

16. Click the UPDATE button. 

  



 

 

 

  

17. Click the CONFIRM button. 

  

 

  

18. Click the OK button. 

  



 

 

 

  

A confirmation message is displayed that Authorized Signatory has been updated successfully.  

  

 

  

Note: The Username and Temporary password will be communicated to the email address as entered by 

you. You need to advise the taxpayer to: 

• Login to the GST Portal available at https://www.gst.gov.in/ and login using the First time login link.  

  



 

 

 

  

• The taxpayer will be forced to change username and password after first time login with the Username 

and Temporary password that was emailed on the updated e-mail address of the Primary Authorized 

Signatory. 

  

Update Details of Authorized Signatory, also Promoter: 

  

9. Click the EDIT button next to the Authorized Signatory, also Promoter. You can refer the legend 

given at top right of the page. 

  

 

  



 

 

10. The details of the Authorized Signatory are displayed. Click the EDIT icon to update the email 

address/ mobile number of Authorized Signatory. 

  

 

  

In case you want to assign the Authorized Signatory as primary Authorized Signatory, select the Set as 

Primary Authorized Signatory as Yes. 

11. In the Email Address field, enter the updated email address. 

12. In the Mobile Number field, enter the updated mobile number. 

13. In the Remarks field, enter the remarks. 

14. In the Reasons for Update field, enter the reasons for updating the details of Authorized Signatory. 

15. Select Choose File button to upload the supporting document. 

You can upload PDF or JPEG file size with maximum upload limit as 1 MB. 

16. Click the UPDATE button. 

  



 

 

 

  

17. Click the CONFIRM button. 

  

 

  

A confirmation message is displayed that Authorized Signatory has been updated successfully.  

  



 

 

 

  

Update Details of Authorized Signatory: 

  

9. Click the EDIT button next to the Authorized Signatory. You can refer the legend given at top right of 

the page. 

  

 

  



 

 

10. The details of the Authorized Signatory are displayed. Click the EDIT icon to update the email 

address/ mobile number of Authorized Signatory. 

  

 

  

In case you want to assign the Authorized Signatory as primary Authorized Signatory, select the Set as 

Primary Authorized Signatory as Yes. 

11. In the Email Address field, enter the updated email address. 

12. In the Mobile Number field, enter the updated mobile number. 

13. In the Remarks field, enter the remarks. 

14. In the Reasons for Update field, enter the reasons for updating the details of Authorized Signatory. 

15. Select Choose File button to upload the supporting document. 

You can upload PDF or JPEG file size with maximum upload limit as 1 MB.  

16. Click the UPDATE button. 

  



 

 

 

  

17. Click the CONFIRM button. 

  

 

  

A confirmation message is displayed that Authorized Signatory has been updated successfully.  

  



 

 

 

2. How can I add Authorized Signatory’s details to login to the GST Portal? 

To add Authorized Signatory’s details to login to the GST Portal, perform the following steps:  

  

1. Access the GST Portal for Tax Official. The GST Home page is displayed.  

2. Using your valid credentials, login to the GST Portal. 

3. The Tax Official’s Dashboard is displayed. Click on the Services > Taxpayer Account > Update 

Authorized Signatory link. 

  

 

  

4. The Update Authorized Signatory page is displayed. In the GSTIN field, enter the GSTIN of the 

taxpayer. 

5. Click the GO button. 

  



 

 

 

  

6. The list of all Authorized Signatories/ Stakeholders is displayed. 

Note: You can click the VIEW and EDIT button to view or edit the details of Authorized Signatories/ 

Stakeholders. 

7. Click the ADD NEW button to add the details of Authorized Signatory. 

  

 

  

Note: The details of Authorized Signatory added will be the primary Authorized Signatory.  

  

8. In the Personal Information section, enter the personal details of the authorized signatory like name, 

date of birth, mobile number, email address and gender. 

9. In the Identity Information section, enter the official information of the stakeholder.  

10. In the Residential Address section, enter the address details of the authorized signatory. Based on 

the State selected, select the district and enter the corresponding pin code 

11. In the Document Upload section, click the Choose file button. Navigate and select the Proof of 

Appointment and photograph of the authorized signatory. 

  



 

 

Note: 

 You can upload PDF or JPEG files with maximum file size for upload of as 1 MB for Proof 

of appointment of the primary Authorized Signatory and 100 KB as photograph of the primary 

authorized signatory. 

  



 

 

 

  



 

 

12. Click the CONFIRM button. 

  

 

  

A confirmation message is displayed that Primary Authorized Signatory has been added successfully.  

  

 

  

The Username and Temporary password will be communicated to the email address as entered by you. 

You need to advise the taxpayer to: 

• Login to the GST Portal available at https://www.gst.gov.in/ and login using the First time login link.  

  

 

  

• The taxpayer will be forced to change username and password after first time login with the Username 

and Temporary password that was emailed on the e-mail address of the Primary Authorized Signatory. 



 

 

Addition of Authorised Signatory In Case of Death of 
Sole Proprietor 

FAQs > Addition of Authorised Signatory in 
Case of Death of Sole Proprietor 

1. What is the process to cancel the registration in case of death of sole 

proprietor? 

1. In case of death of sole proprietor, Legal heir has to visit office of the Proper Officer (Jurisdiction 

Officer) and submit the Death Certificate of the sole proprietor along with the Succession Certificate 

before the Proper Officer as documentary evidence. 

2. Proper Officer will add legal heir as the authorized signatory on the GST Portal.  

 In case the successor is minor, he cannot be added as an authorized signatory. In such cases, 

minor successor needs to be represented by his legal/ natural / testamentary (appointed by will) 

guardian. The legal guardian needs to be appointed or nominated by the competent authority 

(Normally District Judge). Legal guardian can take decisions on behalf of minor legal heir/ 

successor and he can also appoint authorized signatory for this purpose.  

3. Legal heir has to apply for new registration. 

4. Once the new registration is approved, Legal heir has to apply for the transfer of ITC by filing FORM 

GST ITC–02 to new entity. However, there is no restriction on filing of ITC-02 pre or post cancellation. It is 

an independent form and has no relation with cancellation of the sole proprietorship firm. 

5. Username and Temporary password reset will be communicated to the e-mail address of the newly 

added authorized signatory as entered by the Tax Officer in your jurisdiction. Next, the newly added 

authorized signatory need to login to the GST Portal available at https://www.gst.gov.in/ and login using 

the First time login link. He/ She will be forced to change your username and password after first time 

login with the Username and Temporary password that was emailed on the newly added e-mail address 

of the Primary Authorized Signatory. 

6. Legal heir or his/ her authorized signatory has to submit the application for cancellation and select the 

“Death of Proprietor” as reason of Cancellation of Registration and attach sufficient proof.  

  



 

 

Suo Moto Registration 

FAQs > Suo Moto Registration 

1. What is Suo Moto Registration? 

Suo- moto registration is done by the tax officials pursuant to any survey, enquiry, inspection, search or 

any other proceedings under the GST provisions in case it is found that a person who is liable to be 

registered under GST provisions has failed to obtain registration.    

  

Tax officials working in enforcement wings of their respective State can initiate the process of generation 

and allotment of Temporary ID through this Suo moto registration facility. The Tax Officials can do so to 

deposit the amount collected from unregistered persons especially during enforcement proceedings.  

2. Is Suo Moto Registration available to all Tax officials? 

Suo moto Registration functionality is available only to authorized Tax Officials working in enforcement 

wings of the respective State. 

Admin can assign the role of Registration Enforcement to Tax Officials to have access to Suo Moto 

Registration functionality. 

3. How will Tax Official initiate Suo Moto Registration? 

Tax Officials can generate a temporary ID using the Tax Official’s Interface.  

Using this temporary ID, unregistered persons are required to deposit GST. Tax Officials are also 

authorised to collect amount for payment (without limit) from the unregistered person(s) and deposit it into 

the bank as tax on behalf of the unregistered person(s).  

4. What are the pre-conditions for Tax Officials to initiate Suo Moto 

Registration? 

1. The Tax Official should be authorized to generate and allot Temporary ID. Admin can assign the role of 

Registration Enforcement to Tax Officials to have access to Suo Moto Registration.  

2. The Tax Official has the Detention Memo or Seizure Memo (including survey activity) or Statement of 

the unregistered person, based on which details would be filled in Form for generation of Temporary ID.  

3. The Tax Official has passed an order for collection of amount from taxpayer in relation to enforcement/ 

scrutiny/ survey/ audit case. 

4. Mobile number of the Tax Official is updated in his profile on the GST Portal.  

5. Tax Official has a valid DSC. 



 

 

5. How taxpayer will be intimated of Temporary ID & Password after Suo 

Moto Registration? 

Tax payer will be intimated of Temporary ID & Password by Email and SMS. The same can be used by 

the taxpayer to login to the GST Portal and they will have access to limited functionalities like payment, 

viewing and replying to notices, viewing orders etc.  

  

The tax payer will be required to apply for fresh registration within 90 days from the grant of temporary 

registration or within 30 days from the date of issuance of order upholding the liability to register against 

the appeal filed by the taxpayer.   

6. Can I generate the temporary ID for making payments from unregistered 

persons especially during enforcement proceedings? 

You can generate the temporary ID for making payments from unregistered persons especially during 

enforcement proceedings. After login as tax official, Click the Registration > Registration > Suo Moto 

Registration link available on your dashboard. Fill up the form and submit, then temporary ID will be 

indicated in the acknowledgement generated.  

7. Can I generate the Challan for making payments against the temporary 

ID? 

You can generate the Challan for making payments against the temporary ID. Click the Payments > 

Payment > Create Challan link. 

Taxpayer can make the payments using all the available modes i.e. E-Payment, OTC and NeFT/ RTGS.  

Tax Official can pay on behalf of the Taxpayer only using OTC mode and in that case, there will not be 

any limit on amount for payment.  

8. What step I need to take if I have created an incorrect challan by 

mistake? 

Do not submit the incorrect challan at Bank’s counter, keep this challan as it is. After 15 days  it will 

automatically get expired. Meanwhile you can create a new challan with correct data and submit this 

correct challan at Bank’s counter. 

9. Is information about creation of Temporary ID sent to other Tax 

Officials? 

Information about creation of Temporary ID will be sent to the other Tax Authorities of the concerned Tax 

Departments. 



 

 

10. How can I give the acknowledgement for the amount collected to the 

taxpayer? 

Email and SMS sent to the taxpayer will be considered as an acknowledgment for the amount collected.  

After Cash/Cheque/Demand Draft is collected from Taxpayer and CPIN is generated, you will be having a 

download option, using which you can download the challan and a receipt. The receipt you need to give 

to the Taxpayer as an acknowledgement of Cash Payment or DD/ Cheque received from  him/ her and 

the challan you need to take to the Bank to deposit the amount in cash/ DD/ Cheque collected from 

Taxpayer. 

  

To download the receipt, navigate to Payments > Payment > Create Challan. Enter the Challan details 

and Click the GENERATE CHALLAN button. Click the DOWNLOAD button. Payment Challan and 

receipt is downloaded. 

  



 

 

 

  



 

 

 

11. How will the Tax Official initiate Suo Moto Registration? 

Tax Officials in the role of Registration Enforcement can generate a Temporary ID in following two ways: 

1. Access the Tax Official’s Interface of the GST Portal and fill the details of the unregistered person. This 

will generate a Temporary ID and complete the Suo Moto Registration of the unregistered person.  

2. Use Mobile Phone to initiate Suo Moto Registration. This method is used in case of Enforcement 

activities carried from outside office like check posts or borders.  

a. Send SMS from the registered mobile phone number of the Tax Officials in the role of 

Registration Enforcement to generate the Temp ID. 

b. And then access the Tax Official’s Interface of the GST Portal and fill the details of the 

unregistered person for the Temp ID that was generated. This will complete the Suo Moto 

Registration of the unregistered person. 



 

 

12. I am unable to view link of Suo Moto Registration in the Tax Official 

Interface of the GST Portal? 

Only Tax Officials in the role of Registration Enforcement can initiate Suo Moto Registration. 

The State Admin can assign the role of Registration Enforcement to any tax official. 

13. What do I need to do once Temporary ID is generated through SMS? 

You need to login to the GST Portal and navigate to Registration > Registration > Suo moto 

Registration link to complete the details. 

Refer to the Suo moto Registration manual to know how to fill details. 

14. From where I can get the Memo number? 

Each state may have a different practice of issuing memo number for example, some states follow 

practice of mentioning a memo number from the printed detention memo book. Please consult your 

departmental authorities, if required. 

15. I have made payment on behalf of the taxpayer. Where can I see those 

details? 

You can navigate to Payments > Payment > Challan History > Enter GSTIN/ Temporary ID to view the 

details of the payments done on behalf of the taxpayer.  

16. I have made payment on behalf of the taxpayer. Where can a taxpayer 

see those details? 

The taxpayer can login to the GST Portal and check the payment in following two ways:  

Navigate to Services > Payments > Challan History to view the details of the payments done on his 

behalf. 

Navigate to Services > Ledgers> Electronic Cash Ledger. The payment will also be reflected in the 

Electronic Cash Ledger of the taxpayer. 

17. I have made payment on behalf of the taxpayer. Does the taxpayer get 

any intimation for payments made on his behalf? 

Once the payment is made on behalf of the taxpayer, taxpayer gets an intimation about the payment 

through e-mail message and SMS. Electronic Cash Ledger of the taxpayer is also updated once the 
payment is done.  



 

 

18. What is the format of SMS to be sent to the designated mobile phone 

number to generate the Temporary ID through SMS? 

Format of SMS to be sent to the designated mobile phone number 8505985059 to generate the 

Temporary ID through SMS is: 

  

SUOREG<space>State code<space>Detention Memo Number<space>Legal Name 

Example: SUOREG 07 DM0000001234 AAA BBB CCC 

  

 State Code: 2 digit 

 Detention Memo Number: Maximum 15 digit can be numeric or alpha numeric  

 Legal Name: 20 characters’ maximum for First Name, Middle Name and Last Name 

  

Note: State code sent in the SMS should match with the jurisdictional State of the Tax Official who has 

sent the SMS. 

You can refer the table below to know your State Code. 

  



 

 

 



 

 

 

Manual > Suo Moto Registration 

A Tax Official can generate Temporary ID is following 2 ways:  

  

 Method 1 : Generation of Temporary ID through GST Portal Tax Officials Interface 

 Method 2 : Generation of Temporary ID through SMS 

Method 1- How can I initiate the Suo Moto registration and generate the 

temporary ID for unregistered persons? 

To initiate the Suo Moto registration for unregistered persons and generate the temporary ID, perform 

following steps: 

  

1. Access the GST Portal, Tax Official’s interface and complete the Suo Moto Registration details  

2. Collect the amount in either Cash/ Cheque/ Demand Draft  

3. Generate Challan 

4. Deposit Cash/ Cheque/ Demand Draft collected in the Authorized Bank 

1. Access the GST Portal, Tax Official’s interface and complete the Suo 

Moto Registration details 

1. Access the GST Portal for Tax Official. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. On your dashboard, click the Registration > Registration > Suo Moto Registration link. 

  

 

  

The Suo-moto Registrations page is displayed. 

In case of Suo-moto registrations done through SMS, you can see the Temporary ID generated with 

status as Draft. Click the Edit button to edit the details. 



 

 

  

 

  

4. Click the NEW button. 

Note: You can click the VIEW button to view the Suo-moto registrations done previously. 

  

 

  

The Suo Moto Registration form with various tabs is displayed.  

On the top of the page, there are three tabs as Tax Payer Details, Seized Documents and Declaration. 

Click each tab to enter the details. 

  

 

  

Tax Payer Details tab: 

  



 

 

The Tax Payer Details tab is selected by default. This tab displays the taxpayer's information to be filled.  

  

a) In the Seizure / Detention Memo / Any other supporting documents field, enter the seizure/ 

detention statement number. 

b) Select the Date of Seizure / Detention Memo / Any other supporting documents using the 

calendar. 

c) In the Reasons for temporary registration (Max Characters allowed 1000) field, enter the reasons 

for temporary registration. 

Note: You can enter 1000 characters only. 

d) In the Details of the Person in whose name temporary registration is to be granted  section, enter 

the personal details of the taxpayer like name, gender, date of birth, and father's name. 

d) In the Address of the Person section, enter the address details of the taxpayer.  

e) In the Contact Information section, enter the Mobile number and email address of the taxpayer.  

f) If the taxpayer has PAN, select Yes for Do you have a PAN and in the PAN of the person field, enter 

the PAN number of the taxpayer. 

  

 

  

If the taxpayer does not have PAN, select No for Do you have a PAN. Select the appropriate choice from 

the Other ID drop-down list and in the ID Number field, enter the ID number of the selected ID. 

  

 

  

g) In the Attachment of ID Proof field, click the Choose file button. Navigate and upload the proof for 

the ID selected. 

Note: You can upload PDF or JPEG files with maximum file size for upload of as 1 MB.  



 

 

  

h) Click the SAVE & CONTINUE button. 

  



 

 

 



 

 

  

You will notice a blue tick on the Tax Payer Details section indicating the completion of the tab 

information 

  

You will notice a blue tick on the Tax Payer Details section indicating the completion of the tab 

information 

  

Seized Documents tab: 

  

This tab displays the information about the documents seized by the Tax Officials.  

  

a) Select the type of document seized from the Document Description drop-down list. 

b) Select the date on which document was seized using the calendar.  

c) In the Attachment field, click the Choose file button. Navigate and upload the proof for the document 

seized. 

Note: You can upload PDF or JPEG files with maximum file size for upload of as 1 MB.  

d) Click the ADD button. 

  

 

  

e) Notice the document is added. You can also click the Delete button to delete the document, if required. 

  

You can also add and upload any number of documents which you deem fit.  

After adding and uploading the documents, click the SAVE & CONTINUE button. 

  



 

 

 

  

Declaration tab: 

  

a) Select the checkbox for declaration. 

b) Click the SUBMIT WITH DSC button. 

  

 

  



 

 

c) Click the PROCEED button. 

  

 

  

d) Select the certificate and click the SIGN button. 

  

 

  

Acknowledgement receipt is generated. 

  



 

 

 

  

e) Click the Registration > Registration > Suo Moto Registration link. Temporary ID is generated. 

Note: You can click the VIEW button to view the details. 

Tax payer will be intimated of Temporary ID & Password by Email and SMS. The same can be used by 

the taxpayer to login to the GST Portal. 

Information about creation of Temporary ID will be sent to the other Tax Authority of the concerned Tax 

Departments. 

  

 

2. Collect the amount in Cash/ Cheque/ Demand Draft 

1. Collect the amount in Cash/ Cheque or Demand Draft from the unregistered person on account of GST 

to be paid. 

The Tax Official in the role of Enforcement Officer can collect  Cash/ Cheque or Demand Draft from the 

unregistered person. 

3. Generate Challan 

To make the payment through temporary ID for unregistered persons, perform the following steps:  



 

 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal. 

3. On your dashboard, click the Payments > Payment > Create Challan link. 

  

 

  

4. In the Enter GSTIN/Temporary ID field, enter the temporary ID generated for unregistered persons.  

5. Click the PROCEED button. 

  

 

  

6. The Create Multiple Challan page is displayed. In the Tax Liability Details grid, enter the details of 

payment to be made. 

The Total Challan Amount field and Total Challan Amount (In words) fields are auto-populated with total 

amount of payment to be made. 

7. Select the Name of the Bank where the cash or instrument has to be deposited. 

8. Select the payment mode as Cash/ Cheque/ Demand Draft. 

9. Click the GENERATE CHALLAN button. 

  



 

 

 

  

A success message is displayed that the challan is generated. Once the Challan is generated, taxpayer 

/tax official can make the GST Payments using the generated Challan (CPIN).  

  

Note: You can also download the GST Challan by clicking the DOWNLOAD button. 

You can also create another Challan by clicking the CREATE ANOTHER CHALLAN button. 

  



 

 

 

  

 Payment Challan and receipt is downloaded. 

  



 

 

 

  



 

 

 

4. Deposit Cash/ Cheque/ Demand Draft collected in the Authorized Bank 

1. Deposit the cash collected from the unregistered person in the bank selected on the GST Portal while 

creating the Challan. 

The Tax Official in the role of Enforcement Officer can collect Cash/ Cheque or Demand Draft from the 

unregistered person. 

Method 2: How can I as an Tax Officer initiate the Suo Moto registration and 

generate the temporary ID for unregistered persons through SMS? 

Tax Official in the role of Registration Enforcement, can generate a temporary ID through SMS by 

following the steps: 



 

 

  

1. Collect the details of the unregistered person 

2. Send SMS to designated mobile phone number to generate temporary ID 

3. Access the GST Portal, Tax Official’s interface and complete the Suo Moto Registration details  

4. Collect the amount in either Cash/ Cheque/ Demand Draft  

5. Generate Challan 

6. Deposit the collected Cash/ Cheque/ Demand Draft in Authorized Bank 

1. Collect the details of the unregistered person 

1. Tax Official in the role of Registration Enforcement will collect the details of the unregistered person for 

Suo-moto Registration during enforcement activity. This will be done outside the system. Note the name 

and mobile phone number. 

2. Send SMS to designated mobile phone number to generate temporary ID 

Note: Suo Moto Registration functionality is available only to authorized Tax Officials who are assigned 

the the role of Registration Enforcement and are working in enforcement wings of the respective State. 

The State Admin can assign the role of Registration Enforcement to such Tax Officials.  

  

1. Send the below details as an SMS to 8505985059 mobile number from your registered mobile number. 

SUOREG<space>State code<space>Detention Memo Number<space>Legal Name 

Example: SUOREG 07 DM0000001234 AAA BBB CCC 

  

 State Code: 2 digit 

 Detention Memo Number: Maximum 15 digit can be numeric or alpha numeric 

 Legal Name: 20 characters’ maximum for First Name, Middle Name and Last Name 

  

Note: State code sent in the SMS should match with the jurisdictional State of the Tax Official who has 

sent the SMS. 

  

3. GST Portal will validate the mobile phone number from which you have sent the message to system 

and the State Numeric as per Tax Officer profile in the database. If it is not validated, “Invalid Number” or 

“Invalid State” message will be sent back and no action will be taken by the system.  

4. If Mobile number is valid, system will generate Temporary ID and send following details through an 

SMS to the same mobile number from which you sent the SMS.  

Example: 07 DM0000001234 AAA BBB DDD Temp ID: 221712345678TMP 

  

S.No Triggering Point  Message  

1 Tax official sends the SUOREG<space> <State code><space><Memo 



 

 

details as an SMS 

from his registered 

mobile number.  

No.><space><Name> 

  

Example: SUOREG 07 DM0000001234 AAA BBB DDD 

2 For Success Message  

<State code><space><Memo No.><space><Legal 

Name><space><Temp ID:><Generated TempId > 

  

Example: 07 DM0000001234 AAA BBB DDD Temp ID: 

221712345678TMP 

Temporary ID is generated by system and is of 15 digits.  

3 If Memo already exists  
<State code><space><Memo No.><space><Legal 

Name><space><Error:><Space><Memo No. Already exists>  

4 

If mobile number not 

exists in our database 

or state code is invalid  

<State code><space><Memo No.><space><Legal 

Name><space><Error:><Space><Unauthorized Mobile Number or 

Invalid State> 

3. Access the GST Portal, Tax Official’s interface and complete the Suo 

Moto Registration details 

1. Access the GST Portal for Tax Official. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. On your dashboard, click the Registration > Registration > Suo Moto Registration link. 

  

 

  

The Suo-moto Registrations page is displayed. 

4. In case of Suo-moto registrations done through SMS, you can see the Temporary ID generated with 

status as Draft. Click the Edit button to edit the details. 

  



 

 

 

  

The Suo Moto Registration form with various tabs is displayed.  

On the top of the page, there are three tabs as Tax Payer Details, Seized Documents and Declaration. 

Click each tab to enter the details. 

  

 

  

Tax Payer Details tab: 

  

The Tax Payer Details tab is selected by default. This tab displays the taxpayer's information to be filled.  

  

The Temporary ID is displayed along with effective date of registration. 

  

a) In the Seizure / Detention Memo / Any other supporting documents field, enter the seizure/ 

detention statement number. 

b) Select the Date of Seizure / Detention Memo / Any other supporting documents using the 

calendar. 

c) In the Reasons for temporary registration (Max Characters allowed 1000) field, enter the reasons 

for temporary registration. 

Note: You can enter 1000 characters only. 

d) In the Details of the Person in whose name temporary registration is to be granted section, enter 

the personal details of the taxpayer like name, gender, date of birth, and father's name.  

Note: The details of the person in whose name temporary registration is to be granted needs to be 

entered on the discretion of the Jurisdictional Officer. 

d) In the Address of the Person section, enter the address details of the taxpayer.  

e) In the Contact Information section, enter the Mobile number and email address of the taxpayer.  



 

 

f) If the taxpayer has PAN, select Yes for Do you have a PAN and in the PAN of the person field, enter 

the PAN number of the taxpayer. 

  

 

  

If the taxpayer does not have PAN, select No for Do you have a PAN. Select the appropriate choice from 

the Other ID drop-down list and in the ID Number field, enter the ID number of the selected ID. 

  

 

  

g) In the Attachment of ID Proof field, click the Choose file button. Navigate and upload the proof for 

the ID selected. 

Note: You need to scan the document and then upload on the GST Portal.  You can upload PDF or JPEG 

files with maximum file size for upload of as 1 MB. 

  

h) Click the SAVE & CONTINUE button. 

  



 

 

 

  



 

 

You will notice a blue tick on the Tax Payer Details section indicating the completion of the tab 

information 

  

Seized Documents tab: 

  

This tab displays the information about the documents seized by the Tax Officials.  

  

a) Select the type of document seized from the Document Description drop-down list. 

b) Select the date on which document was seized using the calendar.  

c) In the Attachment field, click the Choose file button. Navigate and upload the proof for the document 

seized. 

Note: You can upload PDF or JPEG files with maximum file size for upload of as 1 MB.  

d) Click the ADD button. 

  

 

  

e) Notice the document is added. You can also click the Delete button to delete the document, if required.  

  

You can also add and upload multiple documents which you deem fit.  

After adding and uploading the documents, click the SAVE & CONTINUE button. 

  



 

 

 

  

Declaration tab: 

  

a) Select the checkbox for declaration. 

Name of the Officer, Place, Designation and Date will be auto-populated. 

b) Click the SUBMIT WITH DSC button. 

  

 



 

 

  

c) Click the PROCEED button. 

  

 

  

d) Select the certificate and click the SIGN button. 

  

 

  

Acknowledgement receipt is generated. 



 

 

Order of Grant of Temporary Registration / Suo Moto Registration will be generated. An intimation for the 

generation of Temporary ID & Password by Email and SMS to the applicant. Taxpayer can login through 

the credentials sent to him via SMS message or an email message.  

  

 

  

e) Click the Registration > Registration > Suo Moto Registration link. 

Note: The status is changed to Pending Regular Registration. You can click the VIEW button to view 

the details. 

  

 

4. Collect the amount in Cash/ Cheque/ Demand Draft  

1. Collect the amount in Cash/ Cheque/ Demand Draft from the unregistered person.  

5. Generate Challan 

To make the payment through temporary ID for unregistered persons, perform the following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. On your dashboard, click the Payments > Payment > Create Challan link. 

  



 

 

 

  

4. In the Enter GSTIN/Temporary ID field, enter the temporary ID generated for unregistered persons.  

5. Click the PROCEED button. 

  

 

  

6. The Create Multiple Challan page is displayed. In the Tax Liability Details grid, enter the details of 

payment to be made. 

The Total Challan Amount field and Total Challan Amount (In words) fields are auto-populated with total 

amount of payment to be made. 

7. Select the Name of the Bank where the cash or instrument has to be deposited.  

8. Select the payment mode as Cash/ Cheque/ Demand Draft. 

9. Click the GENERATE CHALLAN button. 

  



 

 

 

  

A success message is displayed that the challan is generated. Once the Challan is generated, taxpayer 

/tax official can make the GST Payments using the generated Challan (CPIN).  

  

Note: You can also download the GST Challan by clicking the DOWNLOAD button. 

You can also create another Challan by clicking the CREATE ANOTHER CHALLAN button. 

  



 

 

 

  

 Payment Challan and receipt is downloaded. 

  



 

 

 

  



 

 

 

6. Deposit Cash/ Cheque or Demand Draft collected in the Authorized Bank 

1. Deposit the Cash/ Cheque or Demand Draft collected from the unregistered person on account of GST 

in the bank selected on the GST Portal while creating the Challan.  

  

The Tax Official in the role of Enforcement Officer can collect  Cash/ Cheque or Demand Draft from the 

unregistered person. 



 

 

Suo Moto Cancellation 

FAQs > Suo Moto Cancellation 

1. What is Suo Moto cancellation of registration? 

Suo Moto cancellation of registration is action taken by the tax authorities to cancel registration of a 

taxpayer under various possible situations as specified under the provisions of the GST Law (for details 

please refer Section 29 of the CGST Act and Rule 22 of CGST Rules).  

2. Under which circumstances can I initiate Suo Moto cancellation of 

registration? 

Suo Moto Cancellation of registration may be initiated by the Tax Official  under various situations as 

specified under the provisions of the GST Law (Section 29(2) of the CGST Act) like: - 

 Failure to furnish Application for Enrollment within 3 months from the appointed day or such 

extended period specified 

 Any Taxpayer other than composition taxpayer has not filed returns for a continuous period of six 

months 

 Supplies any goods and / or services without issue of any invoice, in violation of the provisions of 

the Act or rules made thereunder, with the intention to evade tax  

 Issues any invoice or bill without supply of goods and/or services in violation of the provisions of 

this Act, or the rules made thereunder leading to wrongful availment or utilization of input tax 

credit or refund of tax 

 Collects any amount as representing the tax but fails to pay the same to the account of the 

Central/State Government beyond a period of three months from the date on which such payment 

becomes due 

 Fails to pay any amount of tax, interest or penalty to the account of the Central/State Government 

beyond a period of three months from the date on which such payment becomes due 

 Person is no longer liable to deduct tax at source as per the provisions of GST Law 

 Person is no longer liable to collect tax at source as per the provisions of GST Law 

 Person no longer required to be registered under provisions of GST Law 

 GST Practitioner is found guilty of misconduct in connection with any proceeding under the GST 

Law. 

 Discontinuation/Closure of Business 

 Change in Constitution leading to change in PAN 

 Ceased to be liable to pay tax 

 Transfer of business on account of amalgamation, merger/demerger, sale, lease or otherwise 

disposed of etc. 



 

 

 Death of Sole Proprietor  

 Composition person has not furnished returns for three consecutive tax periods  

 Registration has been obtained by means of fraud, wilful misstatement or suppression of facts, 

Etc. 

 Others 

3. For what kind of taxpayers Suo Moto cancellation of Registration can be 

initiated? 

Suo Moto Cancellation of Registration can be initiated for following taxpayer:  

1. Normal Taxpayer 

2. Non Resident Taxable Person 

3. GST Practitioner 

4. Non-Resident Online Services provider 

5. Tax Deductor at Source 

6. Tax Collector at Source 

7. Composition Dealers 

8. OIDAR Service Providers 

4. What is the precondition for Suo Moto Cancellation of Registration? 

There must be a valid reason for initiation of proceeding for Suo Moto cancellation as specified under 

Section 29 of the CGST/SGST Act. 

5. How can I initiate the Suo Moto cancellation of Registration? 

Navigate to Registration > Cancellation > Cancel Registration to initiate the Suo Moto cancellation of 

Registration and follow the process to issue Notice. 

6. Is issuance of Show Cause Notice (SCN) to the taxpayer mandatory 

before the Suo Moto cancellation of Registration? 

Yes. In case of Suo Moto Cancellation, Registration cannot be cancelled without a show-cause notice 

being given to taxpayer and a reasonable opportunity of being heard to be provided by the Tax Official. 

Thus, in case of Suo Moto cancellation of registration, a show-cause notice shall be issued by the Tax 

Official/ Proper officer to the taxpayer and taxpayer would be given a chance to file his reply in the 

stipulated time limit. 

  

In case, UN Bodies/ Embassies /Other Notified Persons approaches the Tax Authority to cancel the UIN 

registration, Tax Official can cancel the same without issuing SCN. 



 

 

7. What happens when Suo Moto cancellation of registration is initiated by 

tax Official by issuing a SCN? 

a. Primary Authorized Signatory will be intimated about issuance of SCN by SMS & Email. 

b. The status of GSTIN/ Provisional ID/ UIN/ GST Practitioner ID will be changed to “Proceeding for 

Cancellation Initiated”. 

c. The taxpayer will be given 7 working days' time to file reply to SCN using the "Application for filing 

clarification". 

8. I have initiated Suo Moto cancellation of registration and issued SCN to 

the taxpayer. In how many days, taxpayer needs to respond to SCN? 

Taxpayer is required to provide response within the prescribed time limit of 7 working days’ time to file 

reply to the Show Cause Notice (SCN) using the Services > Registration > Application for Filing 

Clarifications link. If no response is given within prescribed 7 working days, the Tax Official may proceed 

further with Cancellation of registration.  

9. What actions can be taken by Tax Official for processing of Show cause 

notice regarding Suo Moto Cancellation of Registration? 

Description/ Activity 
Time Frame and Action to be taken by 

Tax Official  

One time issuance of SCN for 
Suo Moto Cancellation of 

Registration  

Tax Official to issue SCN for initiating 
proceeding for Suo Moto Cancellation of 

Registration of the taxpayer.  

Time Limit for Taxpayer to 

respond to the Show Cause 

Notice (SCN) issued  

Within 7 working days of issuance of the Show 

Cause Notice. 

  

Action (Cancel Registration/ Drop 

proceeding) to be taken by the 

Tax Officer on receipt of 

response of Show Cause Notice 

(SCN)  

Tax Official has to issue order for Cancel 

Registration/ Drop proceeding within a period 

of 30 days from the date of reply to the show 

cause notice issued.  

  

In case, no reply is received from the taxpayer, 

within 7 working days from the date of the 

receipt of the application, Tax Official can only 

cancel the Registration. 

10. What happens once Show Cause Notice is Dropped? 



 

 

In case the Tax Official is satisfied with the response received from the taxpayer on the Show Cause 

Notice issued, the proceedings can be dropped. An order (REG 20) will be issued by the tax official.   

a. Primary Authorized Signatory will be intimated by SMS and Email about issuance of Order (Form GST 

REG 20) for dropping of cancellation proceedings initiated vide SCN.  

b. Order will also be available on the taxpayer’s dashboard to view, print and download.  
c. Status of GSTIN will change from “Proceeding for Cancellation Initiated” to “Active”.  

11. What shall be the effective date of cancellation of registration? 

Effective date of cancellation will be the date as mentioned in the cancellation order.  

12. Is Suo Moto Cancellation of registration be proceeded separately for 

each act? 

Cancellation of registration under the CGST Act or SGST/UTGST or IGST Act shall be deemed to be a 

cancellation of registration under SGST Act / UTGST Act or CGST Act respectively and vice versa.  

13. What happens once Registration is cancelled? 

a. Once registration is cancelled by the Tax Official, taxpayer will be intimated about the same via SMS 

and Email. 

b. Order for Cancellation of Registration will be issued and intimated to the Primary Authorized Signatory 

by Email and SMS. 

c. Order will be made available on taxpayer’s dashboard to view, print and download.  

d. Status of the GSTIN/UIN/GSTP ID from ‘Proceeding for Cancellation initiated’ to ‘Inactive’ and will be 

intimated to the other concerned Tax Authority. 

f. Taxpayer would not be allowed to file return or upload invoices for the period falling after date of 

cancellation mentioned in the cancellation order. Also, GSTP will not be able to carry out GSTP functions 

for any Taxpayer for the period falling after the date of cancellat ion mentioned in the cancellation order. 

g. Taxpayer will not be able to amend registration details after issuance of cancellation order. However, 

email address and mobile number can be updated till dues/ refund are cleared.  

h. The facility to file application for revocation (if applicable) will be open for the Cancelled Registration.  

14. Can a taxpayer login to the GST Portal after Suo Moto cancellation of 

registration? 

Yes, a taxpayer can login to the GST Portal after Suo Moto cancellation of registration. 

15. Can a taxpayer update his/ her email and mobile after Suo Moto 

cancellation of registration? 



 

 

Taxpayer will not be able to amend registration after issuance of cancellation order. However, he/ she can 

update email address and mobile number till dues/ refund are cleared. 

16. Can a taxpayer submit returns of the earlier period after Suo Moto 

cancellation of registration? 

Yes, a taxpayer can submit returns of the earlier period (i.e. for the period before date of cancellation as 

mentioned in the cancellation order), after Suo Moto cancellation of registration. However, he/ she will not 

be allowed to file return or upload invoices for the period after the date of cancellation as mentioned in the 

cancellation order. Also, GSTP will not be able to carry out GSTP functions on Taxpayer’s behalf for the 

period after the date of cancellation mentioned in the cancellation order.  



 

 

Manual > Suo Moto Cancellation 

How can I initiate the Suo Moto cancellation of registration of a taxpayer? 

To initiate the Suo Moto cancellation of registration of a taxpayer, perform following steps: 

  

Note: 

a. In case, Suo Moto cancellation is initiated for the first time, Tax Officials can take following 

actions: 

• Generate SCN 

  

Thus, the Tax Official will have view of only one button - Generate SCN. 

  

b. Once SCN is raised, taxpayer is given 7 working days’ time to reply to SCN. In case, no reply is 

received from the taxpayer, within 7 working days from the date of the receipt of the application, 

Tax Official can only cancel the Registration. 

  

c. Tax Officials can take following actions, in case reply is received by the taxpayer in response to 

the notice issued: 

• Drop Proceedings 

• Cancel Registration 

  

d. Tax Official will have 30 days from the date of receipt of response from the taxpayer or after the 

expiry of 7 days from the date of issuance of SCN (in case no reply  to show cause notice is 

received from taxpayer), to take any action. 

Generate SCN 

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

4. Click the Registration > Cancellation > Cancel Registration link.  

  

 

  

5. In the GST Registration Number field, enter the GSTIN/ UIN/ GSTPID of the taxpayer whose 

registration needs to be cancelled. 

6. Click the SEARCH button. 



 

 

  

 

  

7. The details of the taxpayer are displayed. Click the INITIATE CANCELLATION button. 

  

 

  

8. The Suo Moto Cancellation form is displayed. Select the reason to initiate the Suo Moto cancellation of 

registration from the drop-down list. 

  

 

  

In case of reason as Others, enter the other reason for Suo Moto cancellation of registration. 

  

 



 

 

  

9. Select the declaration checkbox and select the date and time when you want the taxpayer to appear 

before the undersigned authority. 

10. Click the Choose File button to upload any supporting document. You can upload PDF or JPEG file 

with maximum size of upload as 1 MB. 

11. Click the GENERATE SCN button. 

  

 

  

12. Click the PROCEED button. 



 

 

13. Affix your DSC and click the Sign button. 

  

 

  

14. A success message is displayed that Show Cause Notice has been generated. Click the OK button. 

  

 

  

Note: 

a. Primary Authorized Signatory will be intimated about issuance of SCN by SMS & Email.  



 

 

b. The status of GSTIN/ Provisional ID/ UIN/ GST Practitioner ID will be changed to “Proceeding for 

Cancellation Initiated”. 

c. The taxpayer will be given 7 working days' time to file reply to SCN using the "Application for filing 

clarification". 

Suo Moto Cancellation Proceedings 

The Tax Official will have 30 days from the date of receipt of response from the taxpayer or after the 

expiry of 7 days from the date of issuance of SCN, whichever is earlier, to take any action.  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal. The Tax Official’s Dashboard is displayed.  

3. Click the Registration tab. This tab shows all the different type of applications pending with Tax Official 

for processing. 

4. Click the Suo-moto Cancellation Proceedings link to view the list of corresponding ARNs that are 

waiting to be processed. 

  

 

  

5. Select the GSTIN that you wish to process. 

Note: 



 

 

 The GSTINs are arranged in the descending order of the Due Date. The application submitted 

first will be shown above in the list. 

 The Due Date column displays the date by when the pending task / action should be completed.  

 The Status column displays the current status of the application. 

  

 

  

On clicking GSTIN, the cancellation form with response submitted by the taxpayer is displayed.  

You can either drop the proceedings or cancel the registration. 

  

 

Drop Proceedings 

6. If you are satisfied with the response of the taxpayer, click the DROP PROCEEDINGS button to drop 

the proceeding for cancellation of registration. 

  



 

 

 

  

7. Enter the reason for dropping the proceeding for cancellation of registration. 

8. Click the DROP PROCEEDINGS button. 

  



 

 

 

  

9. Click the PROCEED button. 

10. Affix your DSC and click the Sign button. 

  



 

 

 

  

11. A success message will be displayed that Show Cause Notice has been dropped successfully. Click 

the OK button. 

  

 

  

Note: 

a. Primary Authorized Signatory will be intimated about dropping of SCN by SMS & Email.  

b. Issuance of Order for dropping of SCN will also be intimated to the Primary Authorized Signatory by 

Email and SMS. 



 

 

c. Order will be made available on the taxpayer’s dashboard to view, print and download. 

d. Status of GSTIN will change from “Proceeding for Cancellation Initiated” to “Active”.  

Cancel Registration 

6. If you are not satisfied with the response of the taxpayer, click the CANCEL REGISTRATION button to 

cancel the registration. 

  

 

  

7. Select the check boxes for response to the Show Cause notice.  

8. Select the effective date of cancellation of registration. 

9. You can also input any amount pending for payment by taxpayer.  

10. Click the CANCEL REGISTRATION button. 

  



 

 

 

  

11. Click the PROCEED button. 

12. Affix your DSC and click the Sign button. 

  



 

 

 

  

13. A success message is displayed that registration has been cancelled. Click the OK button. 

  

 

  

Note: 

a. Once registration is cancelled by the Tax Authority, the taxpayer will be intimated about the same via 

SMS and Email. 

b. Order for Cancellation of Registration will be issued and intimated to the Primary Authorized Signatory 

by Email and SMS. 

c. Order will be made available on taxpayer’s dashboard to view, print and download.  



 

 

d. Status of the GSTIN/UIN/GSTP ID from ‘Proceeding for Cancellation initiated’ to ‘Inactive’ and 

intimated to the other concerned Tax Authority. 

f. Taxpayer would not be allowed to file the return or upload invoices for the period after date of 

cancellation mentioned in the cancellation order. Also, GSTP will not be able to carry out GSTP functions 

for any Taxpayer for the period after the date of cancellation mentioned in the cancellation order.  

g. Taxpayer will not be able to amend registration after issuance of cancellation order. However, email 

address and mobile number can be updated till dues/ refund are cleared.  

h. The facility to file application for revocation (if applicable) will be open for the Cancelled Registration.  



 

 

Handling Registrations for Non-Resident Online 
Services Provider on Request Basis 

FAQs > Handling Registrations for Non-
Resident Online Services Provider on Request 
Basis 

1. What is the format of GSTIN issued to Non-Resident Online Services 

Providers? 

The format of GSTINs issued to Non-Resident Online Services Providers is: 9917IND12345OS1, where: 

 First 2 digits – State Code (State Code assigned for NROSPs is ‘99’) 

 Next 2 digits – Year 

 Next 3 digits – Country Code 

 Next 5 digits – Sequential five-digit serial number repeated every year 

 Next 1 digit – Alphabet ‘O’ 

 Next 1 digit – Alphabet ‘S’ 

 Last 1 digit – Check Digit 

2. What is the current process of Registering as a Non-Resident Online 

Services Provider? 

Till the time the functionality to register Non-Resident Online Services Providers is not released in the 

GST Portal, the GSTIN of such Taxpayers is generated offline on request basis by GSTN and sent to the 

primary authorized signatory along with the username and temporary password. Presently, as 

communicated by GSTN, only the GSTINs have been generated and shared with such Taxpayers, which 

will enable them to make purchases and provide their GSTIN to the suppliers to ensure that the same is 

mentioned on the tax invoice. The Registration Certificates for such GSTINs will be generated at a later 

point in time. Applications for registration of Non-Resident Online Services Provider is always assigned to 

the Central Tax Authorities and not to States. 

3. Who all can request for Registration as a Non-Resident Online Services 

Provider? 

Registration as Non-Resident Online Services Provider is required by foreign business entities that 

provide online services such as (but not limited to) advertising on the Internet, cloud storage, online 

gaming, etc. to unregistered persons or consumers (B2C) in India. Some of the companies that fall under 

this category are, Amazon, Netflix, etc. In case the service provider does not register under GST, the 



 

 

recipient of such services from such unregistered service providers will need to pay GST on their behalf 

under reverse charge. 

4. From which date does the Registration of Non-Resident Online Services 

Provider become valid? 

GST registration of all existing Non-Resident Online Services Provider companies such as Amazon, 

Netflix, etc. is valid from 1st July 2017. However, once the Application / Form for grant of such 

registrations become available in the GST Portal, such future GSTINs will be valid from the date on which 

they will be issued by the respective Tax Officials.  

5. What are the steps to handle the application for grant of Registration for 

Non-Resident Online Services Providers on request basis? 

Following steps need to be followed by Tax Authorities to issue Registration for Non-Resident Online 

Services Providers: 

 Step-1: Generate the GSTIN offline basis the GSTIN format for Non-Resident Online Services 

Providers. Such current GSTINs were generated offline on request basis prior to 1st July, 2017. 

 Step-2: Data related to the generated registration is collected in the prescribed template.  

 Step-3: If the collected information is not enough, then the Central Tax Official will request the 

Taxpayer for additional information. However, if the collected information has all the required 

details, then the batch is run on a timely basis to populate the data in database. This allows the 

system to generate username (GSTIN) and temporary password for the GSTIN generated for the 

entity. 

 Step-4: Intimation is sent to the primary authorized signatory of the Taxpayer about the 

Username (GSTIN) and temporary Password. This intimation is sent through e-mail only. 

The Taxpayer will then use this information to login to the GST Portal through first -time login functionality 

and change the temporary password as well as create a username for future use.  

6. Where can a taxpayer add Bank Account details? 

Details to be entered in Bank Accounts tab has been made optional w.e.f. 27th Dec 2018 . Taxpayer can 

now enter the Bank Accounts details by filing an Amendment application. When a taxpayer logs in for the 

first time on the GST Portal, he/ she will be prompted to file a non-core amendment application to enter 

Bank Accounts details. 



 

 

Post Registration Field Visit 

FAQs > Post Registration Field Visit - Tax 
Official 

1. What is Post Registration Field Visit? Which roles perform this activity? 

Post Registration Field Visit is a visit by the tax authorities, to the premises of the taxpayer, post grant of 

registration to the taxpayer. 

  

Activities that can be performed by 
Tax Official  

Activities that can be performed by 
Field Visit Officer  

1. Allocate field visit to the Field 

Visit Officer 

2. View Report of Field Visits 

3. Initiate Cancellation of already 

allocated Field Visit 

4. Close Field Visit 

5. Re-Initiate a closed Field Visit 

6. Reassign Field Visit 

7. Extend Time for Field Visit 

1. Prepare and Submit Report post a 

Field Visit 

2. View Registration Form of the 

taxpayer whose Field Visit is being 

conducted 

3. Registration Certificate of the 

taxpayer whose Field Visit is being 

conducted 

  

2. When can I initiate Field Visit of the premises of the taxpayer? 

The Field visit can be initiated only after grant of registration.  

3. Who will conduct the Field Visit of the premises of the taxpayer? 

The Field visit will be conducted by the Field Visit Officer to whom field visit is allocated by the Tax 

Official. 

4. On what parameters can I select the taxpayer for Field Visit? 

The selection of the taxpayer for field visit is on judgment/ decision of the Tax Official.  

5. How can I allocate Field Visit to a Field Visit Officer working under me? 

If you are Tax officer, navigate to Registration > Registration > Field Visit option to allocate Field Visit 

to a Field Visit Officer working under you. 



 

 

7. Can I re-initiate a Field Visit if the Field Visit has been already conducted 

at the premises of the taxpayer? 

Yes, you can re-initiate a Field Visit, if the Field Visit has been already conducted at the premises of the 

taxpayer. However, re-initiated Field Visit ID cannot be assigned to the same field visit officer again. 

8. What is the time line that I can provide to Field Visit Officer to conduct 

the Field Visit of the premises of the taxpayer? 

The time line provided by Tax Official for conducting Field visit can’t be less than <1> day and more than 

<15> days. It can be further extended for another maximum <15> days by the Tax Official.  

Post Registration Field Visit – Field Visit 
Officer 

1.   How can I upload Field Visit Report for a Field Visit assigned to me? 

If you are field visit officer, navigate to Registration > Registration > Field Visit Reports option and 

upload Field Visit Report, for the Field Visit conducted by you.  

The maximum number of days allowed on the GST Portal to upload verification reports is 15 days. 

However, in GST Portal we can select the days which can be anything between 1 to 15 days, subject to 

extension if required. 

Please ensure that the field visit report is submitted before the expiry of the completion time.  

2. What is Post Registration Field Visit? Which roles perform this activity? 

Post Registration Field Visit is a visit by the tax authorities, to the premises of the taxpayer, post grant of 

registration to the taxpayer. 

  

Activities that can be performed by 
Tax Official  

Activities that can be performed by 
Field Visit Officer  

1. Allocate field visit to the Field 

Visit Officer 

2. View Report of Field Visits 

3. Initiate Cancellation of already 

allocated Field Visit 

4. Close Field Visit 

5. Re-Initiate a closed Field Visit 

6. Reassign Field Visit 

7. Extend Time for Field Visit 

1. Prepare and Submit Report 

post a Field Visit 

2. View Registration Form of the 

taxpayer whose Field Visit is 

being conducted 

3. Registration Certificate of the 

taxpayer whose Field Visit is 

being conducted 

  



 

 

  



 

 

 

Manual > Post Registration Field Visit 

A. Initiate and Allocate Post Registration Field Visit  

B. Submit Field Visit Report 

A. How can I initiate and allocate post registration field visit to Field Visit 

Officer for registration verification? 

To initiate and allocate post registration field visit to Field Visit Officer for registration verification, perform 

following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Navigate to Registration > Registration > Field Visit option. 

  

 

  

4. The Field Visit page is displayed. 

  

 

  

There are three tabs displayed as Allocate Field Visit, Pending Field Visit and Closed Field Visit.  

Click each link to know more about them. 

  

A (i) Allocate Field Visit 

A (ii) Pending Field Visit 

A (iii) Closed Field Visit 

A (i) Allocate Field Visit 



 

 

The Allocate Field Visit tab is selected by default.  

a. In the GST Registration Number field, enter the GSTIN/ UIN of the taxpayer for whom the field visit 

has to be initiated. 

b. Click the SEARCH button. 

  

 

  

c. The search results are displayed. Click the ALLOCATE button to allocate the field visit to the Field Visit 

Officer. 

  

 

  

d. Select the name of the Verification Official from the Allocate Verification Official drop-down list. 

e. Select the Time Limit for last date for completion of field visit using the calendar. 

f. Enter the Reason for the field visit.  

Note: You can enter maximum of 1000 characters.  

g. Click the SUBMIT button. 

  



 

 

 

  

h. A confirmation message is displayed that field is allocated successfully.  

  

 

  

i. On successful allocation, an automated Email and SMS will also be sent to the Field Visit Officer. An 

alert will also be sent on Field Visit Official Dashboard. 

A (ii) Pending Field Visit 

a. Click the Pending Field Visit tab. 

  



 

 

 

  

b. The list of GSTINs is displayed. 

  

 

  

There are five buttons displayed on this page.  

Click each link to know more about them. 

  

View Report 

Initiate Cancellation 

Close Field Visit 

Re-Initiate Field Visit 

Reassign 

Extend Time 

  

View Report 

  

i. To view the reports submitted by the Field Visit Officer, select the Field Visit ID and click the VIEW 

REPORT button. 

  



 

 

 

  

ii.  Click the DOWNLOAD REPORT to download the report 

  



 

 

 



 

 

  

Initiate Cancellation 

  

i. To initiate cancellation of registration, select the Field Visit ID and click the INITIATE CANCELLATION 

button. 

  

 

  

ii. The Suo Moto Cancellation page is displayed with the GST Registration number auto-populated to 

cancel the registration. 

This action will mark the Field Visit work item as Closed.  

  

 

  

Click here to know more about the Suo Moto Cancellation of Registration.  



 

 

  

Close Field Visit 

  

i. To close the field visit, select the Field Visit ID and click the CLOSE FIELD VISIT button. 

  

 

  

A success message is displayed and the Field Visit ID can be viewed under Closed Field Visit tab.  

  

Re-Initiate Field Visit 

  

i. To re-initiate the field visit, select the Field Visit ID and click the RE-INITIATE FIELD VISIT button. 

  



 

 

 

  

b. Select the name of the Verification Official from the Allocate Verification Official drop-down list. 

c. Select the Time Limit for last date for completion of field visit using the calendar. 

d. Enter the Reason for the field visit. 

e. Click the SUBMIT button. 

  



 

 

 

  

A confirmation message is displayed that field visit is re initiated successfully.  

  

Reassign 

  

i. To reassign the field visit to another Field Visit Officer, select the Field Visit ID and click the REASSIGN 

button. 

  



 

 

 

  

ii. Select the name of the Verification Official from the Allocate Verification Official drop-down list. 

iii. Select the Time Limit for last date for completion of field visit using the calendar.  

iv. Enter the Reason for the field visit. 

v. Click the SUBMIT button. 

  



 

 

 

  

A confirmation message is displayed that field is allocated successfully.  

  

Extend Time 

  

i. To extend the time for last date for completion of field visit, select the Field Visit ID and click the 

EXTEND TIME button. 

  



 

 

 

  

ii. Select the Target date for completion of field visit using the calendar. 

iii. Click the SUBMIT button. 

  

 

  

A success message is displayed that time is extended successfully.  

A (iii) Closed Field Visit 



 

 

a. Click the Closed Field Visit tab. 

  

 

  

b. The list of closed field visit is displayed. You can click the Field Visit ID to view the Field Visit Report. 

  

 

  

B. How can I submit the field visit report for registration verification? 

To submit the field visit report for registration verification, perform following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal as Field Visit Officer.  

3. Navigate to Registration > Registration > Field Visit Reports option. 

  

 

  



 

 

4. The Reports page is displayed. 

  

 

  

There are three tabs displayed as New Allocations, Saved Reports and Submitted Reports.  

Click each link to know more about them. 

  

B (i) New Allocations 

B (ii) Saved Reports 

B (iii) Submitted Reports 

B (i) New Allocations 

a. The New Allocations tab is selected by default. 

  



 

 

 

  

There are three buttons displayed as Prepare and Submit Report, View Registration Form and 

Registration Certificate.  

Click each link to know more about them. 

  

Prepare and Submit Report 

View Registration Form 

Registration Certificate 

  

Prepare and Submit Report 

  

i. To prepare and submit the report, select the Field Visit ID and click the PREPARE AND SUBMIT 

REPORT button. 

  

 



 

 

  

ii. Select the Date and Time of visit. 

iii. In the Location details section, enter the location details.  

iv. In case address is same as mentioned in the application, select Yes or else select No.  

v. Enter the particulars of the person available at the time of visit.  

vi. Enter the residential address and details of the premises. 

vii. In case documents are verified, select Yes or else select No.  

viii. Click the Choose File button to upload the photograph. 

ix. Enter the remarks in the Comments box. 

x. Click the SUBMIT WITH DSC button. 

Note: Click the SAVE button to save the report. Once saved, you can access the saved report under 

Saved Reports tab. 

  



 

 

 



 

 

  

xi. A success message is displayed. Click the OK button. 

  

 

  

View Registration Form 

  

i. To view the registration form, select the Field Visit ID and click the VIEW REGISTRATION FORM 

button. 

  

 

  

ii. The Get Taxpayer Details page is displayed. You can view the details related to taxpayer.  

  



 

 

 

  

Registration Certificate 

  

i. To view the registration certificate, select the Field Visit ID and click the REGISTRATION 

CERTIFICATE button. 

  

 

  

ii. The most recent Registration Certificate is downloaded in PDF format.  

  



 

 

 

  

B (ii) Saved Reports 

a. To view the saved reports, click the Saved Reports tab. 

  



 

 

 

  

b. Select the Field Visit ID and prepare and submit the saved report  as discussed earlier in above section. 

B (iii) Submitted Reports 

a. To view the submitted reports, click the Submitted Reports tab. 

  

 

  

b. The list of submitted reports is displayed. You can click the View Report in to view the submitted report.  

  



 

 

 

  

c. The submitted report is displayed. 

  



 

 

 



 

 



 

 

“GST Field Visit” Mobile App 

FAQs and Manual > “GST Field Visit” Mobile 
App 

1. What steps are needed by a Tax Official before using the “GST Field 

Visit” mobile app? 

1. Download the “GST Field Visit” mobile app from Play Store in your android mobile device. 

2. Register in the “GST Field Visit” mobile app using username as used to login to the GST Portal, Tax 

Officials Interface. 

Note: You can register in the “GST Field Visit” from maximum of two devices.  

3. Login to the GST Portal, Tax Officials Interface and activate the device using the My Profile > My 

Devices link. 

Note: You can activate only one device at a time. 

2. What is the minimum Internet connectivity required to download/ upload 

data on the mobile app? 

There is no minimum Internet connectivity required to download/ upload data on the mobile app. You can 

try downloading/ uploading data at any speed. 

3. How do I register in the “GST Field Visit” mobile app? 

1. You can login to the “GST Field Visit” app using the username as used to login to the GST Portal, Tax 

Officials Interface. In case you are a field visit officer, enter the Username in the app for the first time from 

your mobile device and Tap Register. 

2. You will be prompted to Register in the Mobile App. You will receive an OTP on your registered mobile. 

Enter OTP and tap Proceed. 

3. Once the OTP is validated, the device will be registered. PIN is required to login to the device. Tap Set 

PIN. This PIN is needed for subsequent login into the App.  

4. Enter PIN and tap Proceed. 

5. PIN is set on the device for subsequent login. Tap Login Now . 

  



 

 

 

4. My username is not going through the mobile app. Why? 

To login to the “GST Field Visit” app, username should be linked to a Field Verification Official role on the 

Back Office GST Portal. 

Note: Please also refer to question no 1 for details. 

5. How do I activate or deactivate my device to use the “GST Field Visit” 

Mobile App? 

1. Login to the GST Portal, Tax Officials Interface with valid credentials.  

2. Access Home > My Profile > My Devices menu. 

  

 

  



 

 

3. On the My Devices page, select the device and select the Activate or Deactivate option. The status of 

the device will accordingly change to Registered-Active or Registered-Inactive and a message to that 

effect will be displayed. By default, status of a newly registered device is "Registered-Inactive".  

Note: Unregistered devices are not shown in “My Devices” list.  

  

 

6. I have two mobile phones. Can I activate both my phones so that I can 

access the “GST Field Visit” Mobile App from any of my phone? 

Yes you can activate both mobile phones to access the “GST Field Visit” mobile app. However, only one 

device can be activated at a time.  

7. Do I get any intimation for successful registration of the device? 

You will receive intimation on your e-mail ID and mobile through SMS for successful registration of the 

device. 

8. How do I login to the mobile app? 

1. Open the “GST Field Visit” mobile app. 

2. Enter 4 digit PIN and tap Login. 

3. The Dashboard screen is displayed. 

  



 

 

 

9. I have not received OTP on my mobile device. What do I do next? 

You need to tap Resend OTP to receive new OTP on your mobile device. “Resend OTP” button will get 

enabled only after 30 seconds has passed, after first OTP generation.  

10. What is the validity period of OTP received on my mobile device? 

OTP received on your mobile device is valid for 10 minutes only. 

11. How can I know the version of mobile app? 

Tap Menu icon > Version on the Top-left corner of the home screen to view the version of “GST Field 

Visit” mobile app. 

12. I have forgotten my PIN. How can I generate new PIN? 



 

 

1. Tap Forgot PIN. 

2. Enter new Login PIN and tap Proceed.  

3. New PIN is generated. 

Note: The device needs to be activated again from the GST Portal.  

  

 

13. When I am required to reset my PIN? 

You need to reset your PIN in case PIN has expired or you have exceeded the maximum number of 

incorrect entries of the PIN while login. 

14. How can I reset PIN to login to the mobile app? 

1. Tap Reset PIN. 

2. Enter new Login PIN and tap Proceed. PIN is reset. 

Note: The device needs to be activated again from the GST Portal.  

  



 

 

 

15. What is the validity of PIN? 

PIN, once set, will be valid for 60 Days. You need to mandatorily change PIN after 60 days.  

16. Can I reset my PIN without connecting to Internet? 

PIN cannot be reset in Offline mode. You need to be connected to Internet to reset your PIN. 

17. I have entered wrong PIN multiple times and app is locked. What do I do 

next? 

You are given 5 maximum attempts to enter the correct PIN. If correct PIN is not entered in 5 attempts, 

then mobile app access will be blocked. Now, you need to reset your PIN using “Reset PIN” functionality 

and the device needs to be activated again from the GST Portal. To reset the PIN, perform the following 

steps: 

1. Tap Reset PIN. 

2. Enter new Login PIN and tap Proceed. PIN is reset. 

Post successful device activation, use the new PIN to login to the mobile app.  

18. How can I prepare and submit the site verification report? 

1. Tap New Allocations on Dashboard screen. 

2. Tap Field Visit ID. 



 

 

3. Tap Prepare and Submit Report. 

  

 

  

4. Camera on your mobile device will be on and you can take images of the premises along with the 

person visited. 

5. You can preview the image. Tap Add Another Photo to add more images, if required. You can add 

maximum of 10 photos. 

7. Tap Confirm & Save. 

  



 

 

 

  

8. Enter the location details. Choose Yes if the address is same as mentioned in the application, or else 

select No. 

9. Tap Save & Proceed. Here, the work-item will move to Saved Reports. In case you want to submit the 

report at a later point in time, you can go to Saved Reports tab on Dashboard screen. Saving can be 

done at any point in time post capturing the Longitude, Latitude and image in the mobile app.  

  



 

 

 

  

10. Enter the details of the person who was available at the time of visit, residential address, other 

information like mobile number, designation etc. and details of the premises.  

11. Tap Save & Proceed. You can upload your report now by tap Upload Now . This saved report will be 

available for edit on the GST Portal after login in the back  

office. 

  



 

 

 

  

12. Enter the comments. You can enter maximum of 1000 words. 

  



 

 

 

  

13. In case you want to submit report, tap Submit. A confirmation message is displayed that "Data has 

been submitted successfully". Tap OK.  

  



 

 

 

  

14. To upload report on GST Portal, tap Upload Now . This report now cannot be edited on the GST 

Portal after login in the back office. You can see this submitted report under Submitted Reports tab on 

Dashboard screen. 



 

 

  

 

  

15. Enter the OTP received on your mobile device. In case your mobile device has allowed SMS access 

for “GST Field Visit” mobile app, app will read the OTP automatically.  

16. Tap Proceed. 

  



 

 

 

  

17. A confirmation message is displayed that data has been uploaded successfully.  

  



 

 

 

19. I am getting an error "Unable to upload data online. Please check 

connectivity and try again." while uploading report. What do I do? 

Please check mobile or internet connectivity on your mobile device to upload data online on the BO 

Portal. 

20. What is the minimum camera resolution required for clicking 

photographs? 



 

 

There is no minimum camera resolution required for clicking photographs.  

21. How longitude and latitude is captured through mobile device? 

When you click the picture of the premises, longitude and latitude is captured along with it. The last 

picture taken determines the longitude and latitude of the place. 

22. Do I need to connect to internet every time to work on the mobile app? 

You don't need to connect to internet every time to work on the mobile app. You can work both in Online 

and Offline mode.  

In offline mode, you can work on the downloaded field visit tasks, prepare, save and submit the report 

locally saved on the mobile device. 

  

To upload the Saved or Submitted report on the Back Office GST Portal, you need to connect to internet 

to upload data on the server. 

23. Can I edit the report after uploading the saved report on the Back Office 

GST Portal? 

Data once uploaded successfully from Saved Reports on the device, will be shown on the Back Office 

GST Portal in "Pending Field Visits" and can be edited.  

24. Can I edit the submitted report uploaded on the Back Office GST Portal 

from mobile device? 

No, you cannot edit the submitted report uploaded on the Back Office GST Portal through mobile 

application or mobile device. 

25. How can I view the saved site verification report? 

1. Tap Saved Reports on Dashboard screen. 

2. You can view the list of field visit reports saved by you. 

  



 

 

 

26. I am not able to save the site verification report. Why? 

Site verification report can be saved only after Longitude, Latitude and image is captured in the mobile 

app. 

27. How can I view the submitted site verification report? 

1. Tap Submitted Reports on Dashboard screen. 

2. You can view the reports submitted by you. 

  



 

 

 

28. Where can I view the saved/ submitted site verification report on the 

Back Office GST Portal? 

Saved reports: Uploaded data is displayed on the Back Office GST Portal in editable form under “Pending 

Field Visits”. 

Submitted Reports: Uploaded data is displayed on the Back Office GST Portal under Field Visit History 

List and also in "Submitted Reports" tab. 

29. How can I view the Registration Certificate of the taxpayer? 

1. Tap New Allocations tab on Dashboard screen. 

2. Tap Field Visit ID. 

3. Tap Registration Certificate tab. 

4. You can view the Business Details, Additional Places of Business, Promoters/Partners and Tax 

Officer Details by tapping the respected links. 

The downloaded Registration Certificate details would be the most recent Registration Certificate mapped 

to the GSTIN. 

  



 

 

 

30. Where can I view the summary of all closed field visits? 

Tap Field Visits History tab on Dashboard screen to view the summary of all closed Field Visits in past 

60 days. Latest closed report is displayed at top. 

  

 

31. How can I logout from the “GST Field Visit” mobile app? 



 

 

Tap Menu icon > Log Out on the Top-left corner of the home screen to Iogout from the “GST Field Visit” 

mobile app. 

32. I am logged out of the mobile app. Why? 

The login session on the mobile app will be active only for 15 minutes. If the mobile app remains unused 

for 15 minutes, session will expire. You will have to log in again to the mobile app using your 4 digit PIN.  

33. I have deactivated the device on the GST Portal. Will this delete data 

from my mobile device as well? 

Deactivating the device on the GST Portal will end the current session on the deactivated device (if any). 

However, this will not delete any data saved on the device or uploaded on the database.  However, If the 

report is saved only and not uploaded in database, the same will not available in case of uninstallation.  

34. Where can I view the Helpdesk details? 

Tap Menu > Support on Dashboard screen to view the Helpdesk details. 



 

 

Compulsory Withdrawal from Composition Levy 

FAQs > Compulsory Withdrawal from 
Composition Levy 

1. What is meant by Compulsory Withdrawal from Composition Levy? 

A taxpayer can opt out of Composition levy in any of the two ways:  

1. Voluntarily opt out of Composition levy by filing Form GST CMP-02 on the GST Portal or 

2. Compulsorily removed out of Composition levy by Tax official at any time during the financial 

year. 

In case, the taxpayer does not opt out of the Composition levy within 7 days of disqualifying event, 

proceedings for compulsory withdrawal from Composition levy, for that particular taxpayer, can be 

initiated by the Tax Official. 

2. What are the pre-conditions for Compulsory Withdrawal from 

Composition Levy? 

Listed below are the pre-conditions for Compulsory Withdrawal from Composition Levy:  

1. Taxpayer has a valid and active GSTIN. 

2. Composition Taxpayer has successfully submitted “Application to Opt for Composition levy” for the 

subsequent financial year Or Applicant is flagged as Composition taxpayer as on the current date.  

3. How can I issue SCN to taxpayer for Compulsory Withdrawal from 

Composition Levy? 

After logging in to the GST Back Office portal, navigate to Registration > Registration > Compulsory 

Withdrawal from Composition Levy > enter the GSTIN/ UIN of the taxpayer option. 

4. By when can a taxpayer reply to SCN issued by Tax Official for 

Compulsory withdrawal from Composition levy? 

On issue of SCN to taxpayer for Compulsory withdrawal, taxpayer needs to file a reply within 15 days 
from date of issue of such notice.  

5. Can I Compulsory Withdraw a taxpayer from Composition Levy without 

issuing SCN? 



 

 

Compulsory withdrawal from Composition levy cannot be initiated without giving the taxpayer an 

opportunity of being heard. Hence, issuance of notice is required for such a proceeding.  

6. Can I save the form for issuing SCN for Compulsory Withdraw a taxpayer 

from Composition Levy? 

You can click the SAVE button to save and access the form for issuing SCN for Compulsory Withdraw a 

taxpayer from Composition Levy at a later point in time. In case, you do not take any action after saving 

the draft i.e. the status of the work item is “Draft”, the same will be purged after 60 days from the date of 

last action taken. 

7. What do I need to do in case taxpayer has not replied to SCN issued by 

me? 

The Tax Official will have 30 calendar days’ time from the date of receipt of clarification from taxpayer on 

SCN or 15 days if no reply is received from taxpayer on SCN issued, whichever is earlier, to take any of 

following action on the work item: 

 Drop proceedings  

 Withdraw Composition levy of the taxpayer. 

In case, taxpayer doesn’t submit clarifications within 15 days from date of issue of SCN, Tax Official can 

only “Withdraw Composition”. 

8. I have initiated Compulsory Withdrawal of a taxpayer from Composition 

Levy. What will happen in case taxpayer has applied for new registration 

with same PAN? 

If any new registration application is pending for the same PAN, which is not approved or rejected, the 

decision of the approval/ rejection of Compulsory withdrawn from Composition will also apply to the new 

GSTIN. 

  

After issue of “Order for Compulsory Withdrawal from Composition levy”, any new Registration 

(GSTIN) granted over the same PAN (having effective date of Registration earlier than withdrawal date), 

will be deemed to be flagged as “Normal”, from the date of withdrawal of composition and “Composition” 

till the date of withdrawal. 

9. What will happen if I Compulsory Withdraw a taxpayer from Composition 

Levy? 

Once you Compulsory Withdrawal a taxpayer from Composition Levy:  

1. GST Portal will generate a withdrawal order. 



 

 

2. Taxpayer as well as all GSTINs mapped to the same PAN will be intimated about compulsory 

withdrawal via e- mail and SMS. 

3. GST Portal will remove the ‘Composition’ flag, against all the GSTINs mapped to the same PAN.  

4. Information about compulsory withdrawal will be passed on to the concerned State/Centre Tax 

Authorities of such GSTINs. 

10. What will happen once I drop proceedings for Compulsory Withdrawal 

of a taxpayer from Composition Levy? 

Once you drop proceedings for Compulsory Withdrawal of a taxpayer from Composition Levy: 

1. GST Portal will generate order for dropping of proceedings. 

2. Taxpayer will be intimated about dropping of proceedings via e-mail and SMS. 

3. Information about dropping the proceedings will be passed on to the concerned State/Centre Tax 

Authorities of such GSTINs. 

11. What are the various statuses for Compulsory Withdrawal of a taxpayer 

from Composition Levy? 

Various statuses for Compulsory Withdrawal of a taxpayer from Composition Levy are:  

1. Pending for Clarification: On issuance of SCN and pending reply by taxpayer  

2. Pending for Order: On receipt of reply to SCN and pending order by Tax Official  

3. Order Issued: On passing of Order for Withdrawal by Tax Official 

4. Proceeding Dropped: On passing of Order by Tax Official for dropping of SCN  

5. Draft: On saving of Draft application by Tax Official for issuance of SCN for Compulsory Withdrawal of 

a taxpayer from Composition Levy 



 

 

 

Manual > Compulsory Withdrawal from 
Composition Levy 

How can I initiate Compulsory Withdrawal from Composition Levy of a 

taxpayer? 

To initiate Compulsory Withdrawal from Composition Levy of a taxpayer, perform following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Registration > Registration > Compulsory Withdrawal from Composition Levy link.  

  

 

  

4. The list of taxpayers for whom compulsory withdrawal from composition levy has been initiated is 

displayed. Once you issue a SCN for compulsory withdrawal from composition levy of a taxpayer, the 

reference number is displayed here. 

5. In the GST Registration Number field, enter the GSTIN/ UIN of the taxpayer for whom compulsory 

withdrawal from composition levy has to be initiated. 

6. Click the GENERATE SCN button. 

  



 

 

 

  

7. The Compulsory Withdrawal from Composition Levy page is displayed. 

  

 

  

8. Select the reasons for Compulsory Withdrawal from Composition Levy. 

Note: In case of Others, you can enter details in the textbox provided for Other Reason. 

  



 

 

 

  

9. Select the Date and Time of hearing. 

10. Enter the reason in details to issue SCN for Compulsory Withdrawal from Composition Levy.  

Note: You can click the SAVE button to save and access it a later point in time. In case, you do not take 

any action after saving the draft i.e. the status of the work item is “Draft”, the same will be purged after 60 

days from the date of last action taken. 

11. Click the SAVE & PROCEED button. 

  

 

  

12. Click the GENERATE SCN button. 

  



 

 

 

  

13. Click the YES button. 

  



 

 

 

  

14. Select the DSC certificate. 

15. A success message is displayed that SCN is issued. Click OK. 

  

 

  

16. The list of taxpayers for whom compulsory withdrawal from composition levy has been initiated is 

displayed. The status is changed to "Pending for Clarification".  

  



 

 

 

  

17. The Tax Official will have 30 calendar days’ time from the date of receipt of clarification from taxpayer 

on SCN or 15 days if no reply is received from taxpayer on SCN issued, whichever is earlier, to take any  

of following action on the work item: 

 Withdraw Composition levy of the taxpayer 

 Drop Proceedings  

Withdraw Composition levy of the taxpayer 

18.1. In case you do not receive any reply from taxpayer within 15 days from date of issue of SCN, you 

can only Withdraw a taxpayer from Composition scheme. To initiate Compulsory Withdrawal from 

Composition Levy of a taxpayer, perform following steps : 

  

18.1.1. Select the GSTIN against whom compulsory withdrawal from composition levy has to be 

performed. 

  



 

 

 

  

18.1.2. Click the WITHDRAW COMPOSITION button. 

  

 

  



 

 

18.1.3. Select the reason for issuing order of rejection of reply to Show Cause Notice. 

18.1.4. Click the WITHDRAW COMPOSITION button. 

  



 

 

 

18.1.5. Click the YES button. 

  

 

  

18.1.6. Select the DSC certificate. 

18.1.7. A success message is displayed that SCN is issued. Click OK. 

  

 

  

18.1.8. The list of taxpayers for whom compulsory withdrawal from composition levy has been initiated is 

displayed. The status is changed to "Order Issued". 

  



 

 

 

  

18.1.9. Once you Compulsory Withdrawal a taxpayer from Composition Levy:  

1. GST Portal will generate a withdrawal order. 

2. Taxpayer as well as all GSTINs mapped to the same PAN will be intimated about compulsory 

withdrawal via e- mail and SMS. 

3. GST Portal will remove the ‘Composition’ flag, against all the GSTINs mapped to the same PAN.  

4. Information about compulsory withdrawal will be passed on to the concerned State/Centre Tax 

Authorities of such GSTINs. 

Drop Proceedings  

18.2. To drop proceedings for Compulsory Withdrawal from Composition Levy of a taxpayer, perform 

following steps: 

  

18.2.1. Select the GSTIN against whom compulsory withdrawal from composition levy initiated has to be 

dropped. 

  



 

 

 

  

18.2.2. Click the DROP PROCEEDINGS button. 

  

 

  

18.2.3. The Form GST CMP-07 is displayed. Click the DROP PROCEEDINGS button. 

  



 

 

 

  

18.2.4. Click the YES button. 

  

 

  

18.2.5. Select the DSC certificate. 

18.2.6. A success message is displayed that SCN is issued. Click OK. 

  



 

 

 

  

18.2.7. The list of taxpayers for whom compulsory withdrawal from composition levy has been initiated is 

displayed. The status is changed to "Proceeding Dropped". 

  

 

  

18.2.8. Once you drop the proceedings for Compulsory Withdrawal of a taxpayer from Composition Levy:  

1. GST Portal will generate order for dropping of proceedings. 

2. Taxpayer will be intimated about dropping of proceedings via e- mail and SMS. 

3. Information about dropping the proceedings will be passed on to the concerned State/Centre 

Tax Authorities of such GSTINs. 
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Processing Advance Ruling 

FAQs > Processing Advance Ruling 

1. What are the steps for processing the advance ruling application? 

1. Advance Ruling Authority or Registrar of Advance Ruling Authority will login to GST BO Portal using 

their Username and password.  

2. Navigate to Statutory Functions > Advance Ruling > Application Inbox option. 

3. Registrar issues notice of personal hearing for Admission/ Rejection of Advance Ruling Application, 

with details of authority, date, place and time of hearing. 

4. On the date of hearing, parties appear before the authority.  

5. Proceedings of the hearing are recorded by Steno on the GST Portal.  

6. In case of adjournment, if Adjournment is granted, Registrar issues adjournment notice with details of 

new date, new place and new time of hearing. 

7. Authority passes the order of admitting or rejecting the application. 

 In case of rejection of the application, email and SMS is sent to the applicant, Jurisdictional 

Officer and Concerned Officer. 

 In case of admitting the application, email and SMS is sent to the applicant, Jurisdictional Officer 

and Concerned Officer and Registrar issues new date of hearing for disposal of admitted advance 

ruling application. 

 Admission/ Rejection Order is available on the GST Portal.  

8. In case of admitting the application all the parties may attend the hearing for Advance Ruling 

Application. After the hearing, Authority for Advance Ruling will pronounce the Advance Ruling and 

upload that Advance Ruling Order in Back office of the GST Portal.  

 In case of concurrence, Authority passes the Advance Ruling order. Order is passed in regards of 

those points for which ruling is given by the Authority.  

 In case of partial difference of opinion, both order and reference is made. On points of differences 

of opinion, the Advance Ruling application will be referred to Appellate Authority for Advance 

Ruling. 

 Authority may also refer the complete application to Appellate Authority for advance ruling 

(AAAR), in case there is difference of opinion on all the questions asked by the applicant.  

9. Once order is passed, email and SMS is sent to the applicant, Jurisdictional Officer and Concerned 

Officer.   

2. What are the preconditions to reject the application filed by the 

applicant, for seeking advance ruling? 

Following are the preconditions to reject the application filed by the applicant for seeking advance ruling 



 

 

1. Applicant has submitted the application on the GST Portal without payment of prescribed fees.  

2. The question raised in the application is already pending or decided in any proceedings in the case of 

applicant under any of the provisions of the Act. 

Note: An Advance Ruling Application shall not be rejected unless the applicant has been given an 

opportunity of being heard. 

3. What are the preconditions to admit the application filed by the 

applicant, for seeking advance ruling? 

Following are the preconditions to admit the application filed by the applicant for seeking advance ruling 

1. Applicant has submitted the application on the GST Portal along with the prescribed fees.  

2. The question raised in the application is not pending or decided in any proceedings in the case of the 

applicant under any of the provisions of the Act. 

4. From where can I as an Officer admit / reject the application filed by the 

applicant for giving advance ruling? 

To admit / reject the application filed by the applicant for giving advance ruling, navigate to Statutory 

Functions > Advance Ruling > Application Inbox  option. 

Open the ARN to be admitted / rejected. 

a. Go to Application Folder – to view the submitted Application 

b. Go to Notices Folder – to issue Notice for personal hearing, if required. 

c. Go to Orders Folder – to pass Admission / Rejection order. 

5. Who can upload Proceedings, Order, Additional Documents details on 

the GST Portal? 

Only Steno and Authority Members can upload Proceedings, Order, Additional Document details on the 

GST Portal. Registrar, Concerned Officer and Jurisdictional Officer can only view/download those details. 

Order sheet of the proceedings cannot be downloaded until allowed by the authority Member.  

6. Who assigns the roles for processing advance ruling? 

State Admin can assign the roles for processing advance ruling.  

7. From where can I initiate rectification of order? 

For rectification of order, navigate to Statutory Functions > Advance Ruling > Application Inbox  

option. 



 

 

Open the ARN > Go to Orders Folder, select Order to be rectified and click on INITIATE 

RECTIFICATION. 

8. From where can I initiate void proceedings? 

To initiate void proceedings, navigate to Statutory Functions > Advance Ruling > Application Inbox  

option. 

Open the ARN > Go to Orders Folder, select the Advance Ruling Order and click on INITIATE VOID 

ORDER. 

9. What are the different roles available in GST Portal for processing 

advance ruling? 

Below roles are available in GST Portal for processing advance ruling. 

  

S.No. 
Name of Role in 

GST Portal 
Primary Responsibilities  Level of Assignment  

1 

CGST Member - 

Authority for 

Advance Ruling  

1. Admission and rejection 

of application for advance 

ruling  

2. Issue AR order basis the 

hearing 

3. Refer to Appellate AR 

authority 

4. Initiate Suo Moto 

Rectification 

5. Initiate Void Proceedings 

State Level 

as per GST Law, there could 

be only one AR Authority for 

each State and there will be 

one member representing 

Centre in each State AR 

Authority.  

2 

SGST Member - 

Authority for 

Advance Ruling  

1. Admission and rejection 

of application for advance 

ruling  

2. Issue AR order basis the 

hearing 

3. Refer to Appellate AR 

authority 

4. Initiate Suo Moto 

Rectification 

5. Initiate Void Proceedings 

State Level 

as per GST Law, there could 

be only one AR Authority for 

each State and there will be 

one member representing 

State in each State AR 

Authority.  

3 

Registrar - 

Authority for 

Advance Ruling  

1. Issue notice for date of 

hearing 

2. Refer to Appellate AR 

State Level 

If state choose to have 

multiple Registrar, then 



 

 

authority system will assign ARN on 

round-robin manner 

4 

Steno - Authority 

for Advance 

Ruling  

1. Drafting Orders, 

Recording the hearing 

proceedings, uploading 

Additional documents 

State Level 

If state choose to have 

multiple Steno, then system 

will assign ARN on round-

robin manner 

5 

Jurisdictional 

Officer- Authority 

for Advance 

Ruling   

1. View notice/reply 

2. View/download AR Order  

3. File Appeal against AR 

order passed under section 

98. 

4. File rectification 

application against any 

order passed under section 

98 or section 101. 

Jurisdictional Level 

This Officer may assist 

concerned officer during 

hearing before AAR and 

will/may represent department 

before AAAR during hearing 

in case appeal is filed by him. 

  

6 Concerned Officer  

1. View notice/reply 

2. View/download AR Order  

3. File Appeal against AR 

order passed under section 

98. 

4. File rectification 

application against any 

order passed under section 

98 or section 101. 

State Level 

Will represent department 

before AAR/AAAR during 

hearing. 

If state choose to have 

multiple Concerned Officers, 

then system will assign ARN 

on round-robin manner 

7 

CGST Member - 

Appellate 

Authority for 

Advance Ruling  

1. Issue AR order basis the 

appeal hearing or Referred 

Application, Rectification 

Application 

2. Initiate Suo moto 

Rectification  

3. Initiate Void Proceedings 

State Level 

as per GST Law, there could 

be only one AR Appellate 

Authority for each State and 

there will be one member 

representing Centre in each 

State AR Appellate Authority.  

8 

SGST Member - 

Appellate 

Authority for 

Advance Ruling  

1. Issue AR order basis the 

appeal hearing or Referred 

Application, Rectification 

2. Initiate Suo moto 

Rectification  

3. Initiate Void Proceedings 

State Level 

as per GST Law, there could 

be only one AR Appellate 

Authority for each State and 

there will be one member 

representing State in each 

State AR Appellate Authority.  



 

 

9 

Registrar - 

Appellate 

Authority for 

Advance Ruling  

1. Issue notice for date of 

appeal hearing or AR order 

in case of Referred 

Application 

State Level 

If state choose to have 

multiple Appellate Registrar, 

then system will assign ARN 

on round-robin manner 

10 

Steno - Appellate 

Authority for 

Advance Ruling  

1. Drafting Orders, 

Recording the hearing 

proceedings, uploading 

Additional Documents 

State Level 

If state choose to have 

multiple Appellate Steno, then 

system will assign ARN on 

round-robin manner 

10. What happens after successful admission of the application for seeking 

Advance Ruling, filed by the applicant? 

On successful admission of the application for seeking Advance Ruling, filed by the applicant the:  

1. Order for admission of Advance Ruling application is issued 

2. Status of the ARN is changed from Submitted to Admitted.  

3. Registrar will issue new date and time of hearing for Advance Ruling application to applicant and to the 

concerned officer and/jurisdictional officer is copied in mail.  

4. Email will be sent to the applicant and concerned officer with jurisdictional officer is copied in mail, 

regarding admission of the application. 

11. What happens after rejection of application for seeking Advance 

Ruling? 

On rejection of the application for seeking Advance Ruling, filed by the applicant:  

1. Order for Rejection of Advance Ruling application is issued. 

2. Status of the ARN is changed from Submitted to Rejected. 

3. Email will be sent to the Applicant and Concerned Officer with Jurisdictional Officer is copied in mail, 

regarding the Rejection of Application. 

12. What are the various status of the application for processing advance 

ruling application? 

The list below provides the list of statuses of the application for processing advance ruling application.  

  

1. Application disposed: When Authority/ Appellate Authority for Advance Ruling pass an Order for 

Rectification Application 

2. Admitted: When Authority pass an Order for Admission of Advance Ruling Application / When 

Application for Condonation of Delay is accepted by the Appellate Authority (in case of Appeal)  



 

 

3. Disposed by Appellate Authority: When Appellate Authority for Advance Ruling pass Advance Ruling 

(for referred Application) or Appeal Order 

4. Disposed by Authority: When Authority for Advance Ruling pass Advance Ruling 

5. Pending for Order: Appeal Application submitted against Advance Ruling 

6. Referred by Authority: When Advance Ruling Application is referred by Authority to the Appellate 

Authority for Advance Ruling. 

7. Rejected: When Authority for Advance Ruling pass an Order for Rejection of Advance Ruling 

Application / When Application for Condonation of Delay is rejected by the Appellate Authority for 

Advance Ruling (in case of Appeal) 

8. Rectification Submitted: When Rectification Application is submitted by Applicant/ JO/CO or Suo 

moto initiated by Authority / Appellate Authority for Advance Ruling 

9. Void Proceedings Initiated: When Authority / Appellate Authority for Advance Ruling initiate Void 

proceedings for any Advance Ruling Application 

13. What type of orders can be issued by AAR? 

Following type of orders can be issued by AAR: 

• Declaring Advance Ruling Void 

• Dropping Void Proceedings 

• Admission of Advance Ruling Application 

• Rejection of Advance Ruling Application 

• Advance Ruling Order 

• Rectification of Order 

• Rejection of Rectification Application 

14. What type of orders can be issued by AAAR? 

Following type of orders can be issued by AAAR: 

• Declaring Advance Ruling Void 

• Dropping Void Proceedings 

• Acceptance of Condonation of Delay 

• Rejection of Condonation of Delay 

• Appeal Order (Confirming Advance Ruling) 

• Appeal Order (Modifying Advance Ruling) 

• Appeal order (Order passed against reference) 

• Rectification of Order 

• Rejection of Rectification Application 

15. What type of notices can be issued by AAR? 

Following type of notices can be issued by AAR: 



 

 

• Notice of Personal Hearing for Admitting or Rejecting Filed Application seeking Advance Ruling 

• Notice of Personal Hearing for application filed for seeking Advance Ruling (Admitted application) 

• Notice for Adjournment of Personal Hearing 

• Notice of Personal Hearing in respect of rectification application 

• Notice of Personal Hearing in respect of Suo Moto rectification  

• Notice of Personal Hearing in respect of declaring advance ruling order void 

16. What type of notices can be issued by AAAR? 

Following type of notices can be issued by AAAR: 

• Notice of Personal Hearing for Admitting or Rejecting Application for Condonation of Delay  

• Notice of Personal Hearing for Advance Ruling Appeal 

• Notice for Adjournment of Personal Hearing 

• Notice of Personal Hearing in respect of referred Advance Ruling application 

• Notice of Personal Hearing in respect of rectification application 

• Notice of Personal Hearing in respect of Suo Moto rectification  

• Notice of Personal Hearing in respect of declaring advance ruling order void 

17. From where can I initiate reference of an order? 

To initiate reference of an order, navigate to Statutory Functions > Advance Ruling > Application 

Inbox > Refer option. 

18. Will I get any alert for disposing the Advance Ruling / Appeal 

Application? 

Yes, you will get e-mail and SMS alerts to dispose the Advance Ruling / Appeal Applications. 

  

 GST portal sends the alert (email) to the Registrar and member of authority/appellate authority to 

dispose the matter on expiry of 60 days from the date of receipt of application/ filing of appeal or 

from date of receipt of reference.  

 GST portal sends the alert (email) to the Registrar and member of authority/appellate authority to 

dispose the matter on expiry of 75 days from the date of receipt of application/filing of appeal or 

from date of receipt of reference.  

 GST portal sends the alert (email and SMS) to the Registrar and member of authority/appellate 

authority to dispose the matter on expiry of 85 days from the date of receipt of application/filing of 

appeal or from date of receipt of reference. 



 

 

 

Manual > Processing Advance Ruling 

How can I process advance ruling application filed by the Applicant on GST 

Portal? 

To process the advance ruling application filed by the Applicant on GST Portal, perform following steps:  

  

A. Go to Advance Ruling application page by either searching for the ARN (Application Reference 

Number)/Status/Period 

B. View Advance Ruling Documents submitted by the taxpayer 

C. Issue Notice 

1. Issue Personal Hearing 

2. Issue Adjournment 

3. Reply to Notice 

D. View Replies by Taxpayer 

E. Add Proceedings Details 

F. Issue an Order 

1. Issue an Order 

2. File Appeal 

3. Initiate Rectification by Jurisdictional Officer/ Concerned Officer / Authority/ Appellate Authority for 

Advance Ruling Member 

4. Initiate Void Order 

G. Refer Order 

1. Refer Partial Reference Order 

2. Refer Complete Reference Order 

H. View Rectifications Details 

I. Add Additional Document 

J. View Void Order Details 

  

Click each hyperlink above to know more. 

A. Go to Advance Ruling application page by either searching for the ARN 

(Application Reference Number)/Status/Period 

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Navigate to Statutory Functions > Advance Ruling > Application Inbox option. 

  



 

 

 

  

4. The Application Inbox  page is displayed. All the pending Advance Ruling applications will be visible 

under Application Inbox. You can click the ARN/RFN hyperlink to view that particular ARN details or you 

can also search a particular ARN.   

  

Note:  

 The functionality “Application Inbox” will be used by both the members of Authority, Registrar, 

Steno and Jurisdictional officer/ Concerned Officer in case of Advance Ruling.  

 Similarly, for the Advance Ruling Appeal Applications and Referred AR Applications, this 

functionality will be used by both the members of Appellate Authority for Advance Ruling, 

Registrar, Steno and Jurisdictional Officer Concerned Officer. 

  

The purpose of “Application Inbox” is to process the Applications which are pending for their action. 

  

 

  

5. To search an ARN, in the ARN field, enter the Advance Ruling ARN number of the application 

submitted by the Applicant, you can select the Status of the application from the Status drop-down list. 

  



 

 

 

  

6. Select the From and To date of filing the application using the calendar. 

7. The search results are displayed. Click the ARN/RFN hyperlink to view the ARN details. 

  

 

  

8. After opening a particular ARN, eight tabs are displayed as APPLICATIONS, NOTICES, REPLIES, 

PROCEEDINGS, ORDERS, REFER, RECTIFICATION, ADDITIONAL DOCUMENT and VOID ORDER. 

APPLICATIONS tab is selected by default. 

  



 

 

 

  

Go back to the Main Menu 

B. View Advance Ruling Documents submitted by the taxpayer 

To view advance ruling document submitted by the taxpayer, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the APPLICATIONS tab if it is not selected 

by default.  

2. Click the View link under Action to view the application in PDF mode. 

  

 

  

Go back to the Main Menu 

C (1). Issue Personal Hearing Notice 

Issue Personal Hearing Notice functionality will be used by either Registrar or any of the two Authority 

members to issue a notice for personal hearing. 



 

 

  

To issue personal hearing notice, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (Hearing/Adjournment) issued against the case created.  

2. Click ADD NOTICE to open the drop-down list and select Hearing. 

Note: After examining the application and other documents submitted by the applicant, appropriate 

authority may pass an order admitting the application without any hearing.   

  

 

  

3. The HEARING page is displayed. 

  



 

 

 

  

4. Click the Generate Notice Number to generate a new notice number. Copy the number generated by 

the system and enter this same number in the notice to be uploaded. 

5. Select the Subject from the drop-down list to select the purpose of calling the hearing. 

  

 

  

6. Select the Previous Date of Hearing using the calendar. 

7. Select the Status of Previous hearing from the drop-down list. 

Note: Previous Date of Hearing and Status of Previous fields are optional if Type of Notice is selected as 

“Hearing” and these fields are mandatory if Type of Notice is selected as "Adjournment".  

  



 

 

 

  

8. Select the New Date of Hearing using the calendar. 

9. Select the New Time of Hearing from the drop-down list. 

10. In the Place of Hearing field, enter the address of place where hearing will happen. 

11. Click the Choose File button to upload the notice. 

Note: You can upload PDF file with maximum size of upload as 5 MB. You can click the DELETE button 

to delete the uploaded notice. 

12. Click the SUBMIT button. 

  

 

  

13. Click the PROCEED button. 

Note: Intimation of this Notice will be sent through an email to the applicant and concerned officer and 

Jurisdictional Officer will be copied as CC in the mail. 



 

 

In case of unregistered applicant, Notice will be sent through an email to the applicant and Concerned 

Officer and/or Jurisdictional Officer will be copied as CC in the mail.  

  

 

  

14. The updated Case Detail page is displayed, with the table containing the record of the hearing just 

issued. Also, system would send the intimation to the taxpayer via email and SMS, and make this 

personal hearing notice available on the taxpayer’s dashboard.  
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C (2). Issue Adjournment Notice 

Issue Adjournment Notice functionality will be used by either Registrar or any of the two Authority 

Members to issue notice for adjournment of personal hearing and intimating the new date and time for 

personal hearing. 

  

To issue adjournment notice, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (Hearing/Adjournment) issued against the case created.  

2. Click ADD NOTICE to open the drop-down list and select Adjournment. 

  

 

  

3. The Adjournment page is displayed. 

  



 

 

 

  

4. Click the Generate Notice Number to generate a new notice number. Copy the number generated by 

the system and enter this same number in the notice to be uploaded. 

5. Select the Subject from the drop-down list to select the purpose of calling the hearing. 

  

 

  

6. Select the Previous Date of Hearing using the calendar. 

7. Select the Status of Previous hearing from the drop-down list. 

Note: Previous Date of Hearing and Status of Previous fields are mandatory if Type of Notice is selected 

as “Adjournment” and optional if Type of Notice is selected as “Hearing".  

  



 

 

 

  

8. Select the New Date of Hearing using the calendar. 

9. Select the New Time of Hearing from the drop-down list. 

10. In the Place of Hearing field, enter the address of place where hearing will happen. 

11. Click the Choose File button to upload the notice. 

Note: You can upload PDF file with maximum size of upload as 5 MB. You can click the DELETE button 

to delete the uploaded notice. 

12. Click the SUBMIT button. 

  

 

  

13. Click the PROCEED button. 

  



 

 

 

  

Note: Intimation of this Notice will be sent through an email to the applicant and concerned officer and 

Jurisdictional Officer will be copied as CC in the mail. 

In case of unregistered applicant, Notice will be sent through an email to the applicant and Concerned 

Officer and/or Jurisdictional Officer will be copied as CC in the mail.  

  

14. The updated Case Detail page is displayed, with the table containing the record of the adjournment 

just issued. Also, system would send the intimation to the taxpayer via email and SMS, and make this 

adjournment notice available on the taxpayer’s dashboard.  
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C (3). Reply to Notice 

Reply to Notice functionality will be used by the Applicant (Taxpayer) and Jurisdictional Officer/ 

Concerned Officer. 



 

 

Whenever Authority or Appellate Authority issues notice for personal hearing, the Taxpayer / 

Jurisdictional officer / Concerned Officer may submit their reply to that Notice. They can also submit any 

required document using this service, if asked by the Authority in the Notice.  

  

This functionality is optional if the applicant wants to physically submit any additional document. They can 

submit the document at the time of personal hearing. 

  

To reply to notice, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (Hearing/Adjournment) issued against the case created.  

2. Select the NOTICE NUMBER. 

3. Click the REPLY button. 

  

 

  

4. The Reply application is displayed. Application Details and your details are auto-populated. The 

remaining details must be filled manually.  

  



 

 

 

  

5. Click Download Template  to download and manually fill details of Reply. After the details are filled, 

convert the file into a pdf format. Click Choose File button under Details of Reply field to upload the this 

PDF on the GST Portal.  

6. If required, you can also upload supporting documents. This is not a mandatory field. To upload, first fill 

Enter Document Description field and then click Choose File to upload them. 

7. Enter Verification details and Place. 

8. Click PREVIEW to download and review your Reply.  



 

 

  

 

  

9. The PDF is displayed. 

  



 

 

 

  

10. Click PROCEED TO FILE.  

  



 

 

 

  

11. Click PROCEED.  

  



 

 

 

  

12. The Submit Application page is displayed. Click ISSUE WITH DSC. 

  

 

  

13. The Acknowledgement page is displayed. Click OK.  

  

 

  

14. GST System automatically directs you to the REPLIES tab where the reply you just filed will be 

displayed in a table. 

  



 

 

 

  

Note: Once the reply is submitted, the Reply link in the NOTICES tab will get disabled. You can submit 

only one reply per each Notice.  
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D. View Replies by Taxpayer 

To view replies submitted by the taxpayer, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the REPLIES tab. This tab displays all 

replies filed by the taxpayer. 

2. Click the Reply No. link to download the reply of the taxpayer in PDF format. You can also click the 

documents link in the Supporting Documents section to download supporting documents attached by 

the taxpayer.  
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E. Add Proceedings Details 



 

 

Add Proceedings details functionality will be used by Steno or any of the two members of the Authority to 

upload the Case Proceedings Record Sheet. 

After every hearing, a case proceedings record sheet is prepared by Steno, which will be uploaded here 

using Add Proceedings functionality. 

  

This tab displays all the proceedings record sheet regarding a particular hearing. Only Steno and 

Authority Members can upload the proceedings record sheet. Registrar can only view the Proceeding 

details. 

  

1. To add details related to proceedings, navigate to Services > Search ARN link. 

  

 

  

2. Enter the ARN number. 

3. Click the SEARCH button. 

  

 

  

4. Click the ARN/RFN hyperlink to view the ARN/RFN details. 

  

 

  

5. Click the PROCEEDINGS tab. 

6. Click the ADD PROCEEDINGS button. 

  



 

 

 

  

7. Select the Date of Hearing using the calendar for which proceedings are uploaded. 

8. In the Name of the Parties Appeared field, enter the name of those people who attended the hearing. 

All the names has to be separated by comma. 

9. Click the Choose File button to upload the Proceedings Record sheet. 

Note: You can upload PDF file with maximum size of upload as 5 MB. 

10. Click the SUBMIT button. 

Note: You can click the DELETE button to delete the uploaded file. You can delete the proceedings 

uploaded, till the proceedings are not submitted.  

  

 

  

11. Click the PROCEED button. 

  



 

 

 

  

12. The updated Case Detail page is displayed, with the table containing the record of the proceedings 

just added. After Proceeding are successfully submitted, the updated details will be visible to Registrar, 

Steno, Jurisdictional Officer- Authority for Advance Ruling, concerned Officer and both the Authority 

Members. 
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F (1). Issue an Order 

Issue an Order functionality will be used by any of the two Authority Members / Steno of Authority. 

Authority members/ Steno will use this functionality to upload and issue the pdf Order, which they have 

prepared offline. 

  

To add order details, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab if it is not selected by 

default. This tab displays all the orders passed against that application.  



 

 

2. Select the type of order to be issued from the ADD ORDER drop-down list. 

  

 

  

3. The Order page is displayed. 

  

 

  

4. Click the Generate Order Number to generate a new order number. Copy the number generated by 

the system and enter this same number in the order to be uploaded. 

Note: In the Passed By - Member (Centre) and Passed By - Member (State) field, name of the member 

from Centre and State who will pass the order is auto-populated. 

5. Click the Upload Order button to upload the PDF copy of the order. 

Note:  

 You can upload PDF file with maximum size of upload as 10 MB. 

 Authority members must attach their own DSC inside the PDF before uploading it on the GST 

portal. GST Portal will not check the PDF whether DSC is attached in it or not. 

6. Click the SUBMIT button. 



 

 

Note: You can click the DELETE button to delete the uploaded file. You can delete the order uploaded, till 

the order is not submitted.  

  

 

  

7. Click the PROCEED button. 

  

 

  

8. The updated Case Detail page is displayed, with the table containing the record of the order just 

issued.   

  



 

 

 

  

Note: 

 Steno and Registrar themselves will not have the facility to initiate Suo moto Rectification and 

Initiate Void Order. 

 Authority members will have the facility to initiate Suo moto Rectification and Initiate Void Order. 
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F (2) File Appeal 

Appeal can be filed either by the Applicant (i.e. Taxpayer) or the Department (i.e. Jurisdictional officer / 

Concerned Officer) against the Advance Ruling pronounced by the Authority for Advance Ruling. Appeal 

is filed, in case, if the Taxpayer or the Department are aggrieved by the ruling given by the Authority. 

  

To file appeal, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab if it is not selected by 

default. This tab displays all the orders passed against that application.  

2. Select the Order No. and click the FILE APPEAL button. 

  

 

  



 

 

3. The File Appeal page is displayed. Application Details and your details are auto-populated. The 

remaining details must be filled manually.  

  



 

 

 



 

 

  

4. Click Download Template  to download and manually fill details of Reply. After the details are filled, 

convert the file into a pdf format. Click Choose File button under Details of Reply field to upload the this 

PDF on the GST Portal.  

5. If required, you can also upload supporting documents. This is not a mandatory field. To upload, first fill 

Enter Document Description field and then click Choose File to upload them. 

6. Select Yes/ No for Whether the Jurisdictional Officer / Concerned Officer wishes to be heard in person? 

field. 

7. Enter Verification details and Place. 

8. Click PREVIEW to download and review your Reply.  

  



 

 

 



 

 

  

9. The PDF is displayed. 

  

 

  

10. Click PROCEED TO FILE.  

  



 

 

 



 

 

  

11. Click PROCEED.  

  

 

  

12. The Submit Application page is displayed. Click ISSUE WITH DSC. 

  

 

  

13. The Acknowledgement page is displayed. Click OK.  

14. GST System automatically directs you to the APPLICATIONS tab. 
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F (3). Initiate Rectification by Jurisdictional Officer/ Concerned Officer 

Initiate rectification functionality will be used by only the Authority / Appellate Authority members.  

Authority / Appellate Authority members will use this functionality if they want to initiate Rectification 

against any order. 

  

1. To initiate rectification, select the Order No. radio button and click the INITIATE RECTIFICATION 

button. 

  

 

  

2. The Rectification of Order page is displayed. 

  



 

 

 



 

 

  

3. To download the filing details for Rectification of Order, Click Download Template . 

  

 

 

4. TemplateforRectificationdetailsbyJOCO.docx  will be downloaded in Downloads folder. 

  

 

  

5. Open the document and click Enable Editing. 

  

 

  

6. Update the template with required information. 

  



 

 

 

  
7. Click Save As and Choose the folder to save the Template.   
    



 

 

 
    

8. Select Save As Type to  PDF(*.pdf). 

9. Click SAVE. 

  



 

 

 

  

10. Under Details of Rectification of Order, upload, click the Choose file button. Navigate and select the 

Filled template. 

  

 

  

Note: You can upload only PDF file with maximum file size for upload of as 5 MB. 

  

11.  After the document is uploaded, you can click the Delete button if you want to delete the uploaded 

document. 



 

 

 

 
 

12. Under Upload Supporting Documents, Enter Document Description and click the Choose 

File button. Navigate and select the Supporting Documents. 

Note: You can upload only PDF file with maximum file size for upload of as 5 MB.  

 
 

 

13. Select the Verification checkbox. 

14. Select the Name of Jurisdictional Officer / Concerned Officer from the drop-down list. 

15. Enter the place where form is filled. 

16. Click the PREVIEW button to preview the document before submitting. 

  



 

 

 



 

 

  

17. The application for rectification of order is downloaded in PDF format. 

  

 

  

18. Click the PROCEED TO FILE button. 

  



 

 

 



 

 

  

19. Click the PROCEED button. 

  

 

  

20. Click the SUBMIT WITH DSC button. 

  

 

  

21. A confirmation message is displayed that rectification has been filed and Rectification Reference 

Number is displayed. Click the OK button. 

  

 



 

 

  

22. The Rectification details are displayed in RECTIFICATION tab. 
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F (4). Initiate Rectification by Authority/ Appellate Authority for Advance 

Ruling Member 

1. To initiate rectification, select the Order No. radio button and click the INITIATE RECTIFICATION 

button. 

  

 

  

2. Click the Choose File button to upload details of rectification. Navigate and select the document. 

Note: You can upload only PDF file with maximum file size for upload of as  5 MB. 

  



 

 

 

  

3.  After the document is uploaded, you can click the Delete button if you want to delete the uploaded 

document. Click the SUBMIT button. 

  

 

  

4. Click the PROCEED button. 

  



 

 

 

  

5. The Rectification details are displayed in RECTIFICATION tab. 
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F (5). Initiate Order Void 

Initiate Order Void functionality will be used by only Authority / Appellate Authority members.  

Authority / Appellate Authority members will use this functionality, if they want to initiate Void Proceedings 

for Advance Ruling pronounced by them. 

  

1. To initiate Order to be void, select the Order No. radio button and click the INITIATE ORDER VOID 

button. 

  



 

 

 

  

2. Click the Choose File button to upload details of Order Void. Navigate and select the document.  

  

 

  

3.  After the document is uploaded, you can click the Delete button if you want to delete the uploaded 

document. Click the SUBMIT button. 

  



 

 

 

  

4. Click the PROCEED button. 

  

 

  

5. The Void Order details are displayed in VOID ORDER tab. 

  



 

 

 

  

Go back to the Main Menu 

G (1). Refer Partial Reference Order 

Refer Partial Reference functionality will be used by Registrar or Members of Authority when they want to 

partially refer any Advance Ruling to the Appellate Authority for Advance Ruling. 

  

To refer order for partial reference, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the REFER tab if it is not selected by 

default. This tab displays all the orders referred against that application.  

2. Select the type of reference as Partial Reference to be issued from the REFER ORDER drop-down 

list. 

  

 

  

3. The Order page is displayed. 

  



 

 

 

  

4. Click the Choose File button to upload the copy of advance ruling order issued and details of 

reference. 

Note: You can upload PDF file with maximum size of upload as 5 MB. 

5. Click the SUBMIT button. 

Note: You can click the DELETE button to delete the uploaded file. You can delete the order uploaded, till 

the order is not submitted.  

  



 

 

 

  

6. Click the PROCEED button. 

  

 

  

7. The updated Case Detail page is displayed, with the table containing the record of the order just 

issued.   
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G (2). Refer Complete Reference Order 

To refer order for complete reference, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the REFER tab if it is not selected by 

default. This tab displays all the orders referred against that application.  

2. Select the type of reference as Complete Reference  to be issued from the REFER ORDER drop-down 

list. 

  

 

  

3. The Order page is displayed. 

  



 

 

 

  

4. Click the Upload File button to upload the PDF copy of the details. 

Note: You can upload PDF file with maximum size of upload as 5 MB. 

5. Click the SUBMIT button. 

Note: You can click the DELETE button to delete the uploaded file. 

  

 

  

6. Click the PROCEED button. 

  

 



 

 

  

7. The updated Case Detail page is displayed, with the table containing the record of the reference just 

issued.   
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H. View Rectification Details 

1. To view rectification details, click the link RECTIFICATION tab. 
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I. Add Additional Document 

This tab displays the additional documents submitted physically by any party (i.e. Applicant or 

Jurisdictional Officer- Authority for Advance Ruling or Concerned Officer) during the hearing. Only Steno 

and Authority members can upload the additional documents. Registrar can only view the uploaded 

documents. 



 

 

  

1. Navigate to Services > Search ARN link.. 

  

 

  

2. Enter the ARN number. 

3. Click the SEARCH button. 

  

 

  

4. Click the ARN/RFN hyperlink to view the ARN/RFN details. 

  

 

  

5. Click the ADDITIONAL DOCUMENT tab. 

6. Click the ADD DOCUMENTS button. 

  

 



 

 

  

7. Select the Date of Hearing using the calendar. 

8. In the Document Description field, enter the description of the document i.e. the name or type of 

document that is provided during hearing. 

9. In the Documents Submitted By field, enter the name of the person who submitted the additional 

document. In case of multiple names, all the names will be separated by comma. 

10. Click the Upload Documents button to upload the additional document. 

Note:  

 You can upload PDF file with maximum size of upload as 5 MB. 

 Maximum 5 additional documents can be attached for one Date of hearing.  

  

 

  

11. Click the ADD DOCUMENT button. 

  



 

 

 

  

12. Click the SUBMIT button. 

Note: You can click the DELETE or PREVIEW button to delete or preview the uploaded additional 

documents. You can delete the document uploaded, till the document is not submitted.  

You can also add another additional documents here. 

  

 

  

13. Click the PROCEED button. 

  



 

 

 

  

14. The updated Case Detail page is displayed, with the table containing the record of the documents 

just added.  

  

 

  

Go back to the Main Menu 

J. View Void Order Details 

1. To view void order details, click the VOID ORDER tab. 
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Cause List 

FAQs > View Cause List 

1. What is a cause list? 

When an application is filed/referred or order has to be rectified by the authorities or to be declared as 

void ab initio, a date of hearing is issued by the Tax Official and communicated to the parties by the GST 

Portal. 

A cause list of all such dates is maintained in the GST Portal. This cause list can be printed/ saved in 

PDF. 

2. From where can I view the cause list? 

To view the cause list, navigate to Statutory Functions > Cause List option. 

3. Is the Cause List updated in real time? 

Yes, Cause list is updated on real time basis. 

4. Who can view Cause List? 

Cause List can be viewed by any Tax Official irrespective of their role.  



 

 

Manual > Advance Ruling > View Cause List 

To search and view Cause List of advance ruling applications, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Navigate to Statutory Functions > Cause List option. 

  

 

  

4. The Cause List screen is displayed.  

  

 

  

5. Select the Type of Authority from the drop-down list. 

  

 

  

6. Select the Jurisdiction from the drop-down list. 

7. Select the From and To Date using the calendar. 

8. Click SEARCH. 

9. The Cause List of the day is displayed. 

  



 

 

 

  





 

 

Search Taxpayer Details 

Overview > Search Taxpayer Details 

Get Taxpayer Details 

 FAQs 

 Manual  

Utilizing Cash/ ITC for Payment of Demand 

 FAQs 

 Manual  

Search ARN 

 FAQs 

 Manual  

Find GSTIN/UIN 

 FAQs 

 Manual  

Record Search 

 FAQs 

 Manual  

Record Search Returns 

 FAQs 

 Manual  

  



 

 

Overview > Search Taxpayer Details 

Get Taxpayer Details 

 FAQs 

 Manual  

Utilizing Cash/ ITC for Payment of Demand 

 FAQs 

 Manual  

Search ARN 

 FAQs 

 Manual  

Find GSTIN/UIN 

 FAQs 

 Manual  

Record Search 

 FAQs 

 Manual  

Record Search Returns 

 FAQs 

 Manual  

  

  



 

 

Get Taxpayer Details 

FAQs > Get Taxpayer Details 

1. I am unable to view details of some GSTINS, using the Get Taxpayer 

Details functionality? 

As a tax official, you can view details of the GSTIN if it belongs to your state. For taxpayers not registered 

in your state, you can view only primary details. 

  

Details Visible for taxpayers 

registered in your State 

Details Visible for taxpayers not 

registered in your State 

GSTIN/UIN/Temporary ID GSTIN/UIN/Temporary ID 

Legal Name of Business Legal Name of Business 

Constitution of Business Constitution of Business 

Nature of Business Nature of Business 

Status  Status  

State Jurisdiction State Jurisdiction 

Centre Jurisdiction Centre Jurisdiction 

Date of Registration Date of Registration 

Date of Cancellation Date of Cancellation 

Date of effect of Registration Date of effect of Registration 

Registered Mobile Number Registered Mobile Number 

Registered Email Address Registered Email Address 

Principal Address of Business Principal Address of Business 

Name & Contact of Authorized 

Signatory 

Name & Contact of Authorized 

Signatory 

Name & Contact of GST 

Practitioner 

Name & Contact of GST 

Practitioner 

Taxpayer Type Taxpayer Type 

Risk Profile Risk Profile 

Compliance Rating Compliance Rating 

Field Visit Conducted Field Visit Conducted 

Registration Details Registration Details 

Details of Other Registrations Details of Other Registrations 



 

 

Details of Owners Details of Owners 

Details of Authorized Signatories Details of Authorized Signatories 

Payment Towards Demand   

View Returns filed    

Registration Certificate   

View Electronic Liability Register 

(Part- I)  
  

View Cash Ledger    

View Credit Ledger    

View Payment History    

View Applications Submitted    

View Notices and Orders    

View Electronic Liability Register 

(Part- II)  
  

  

2. Can I search for a taxpayer, if I don’t know the GSTIN? 

You can search for the taxpayer details by using the Find GSTIN functionality. The functionality allows 

you to enter the e-mail ID, PAN details of the taxpayer, Legal Name of Business or State and all the 

GSTINs associated with the given e-mail ID or PAN Card will be displayed. 

3. What ledgers can be viewed of a particular taxpayer? 

You can view the below ledgers for a particular taxpayer:  

 Electronic Cash Ledger 

 Electronic Credit Ledger 

 Electronic Liability Register (Return related) 

 Electronic Liability Register (Other than return related) 

4. What other details can be viewed of a particular taxpayer? 

You can view the below details for a particular taxpayer:  

 GSTIN/ UIN/ TEMP ID 

 Legal Name of Business 

 Constitution of Business 

 Nature of Business 

 Registration Details 



 

 

 Details of other Registration 

 Details of Owners 

 Details of Authorized Signatories 

5. Can I view the form submitted by the taxpayer to engage with GST 

Practitioner? 

Yes, you can view the form submitted by the taxpayer to engage with GST Practitioner.  

Navigate to Services > Taxpayer Account > Get Taxpayer Details > Enter the GSTIN of the taxpayer > 

Name & Contact of GST Practitioner hyperlink. 

6. Can I search for a taxpayer if I have the PAN of the taxpayer? 

You can search for the taxpayer's GSTIN by using the Find GSTIN functionality. The functionality allows 

you to enter the PAN details of the taxpayer and all the GSTINs associated with the given PAN details will 

be displayed. You can select the GSTIN from the list for which taxpayer details need to be searched. 

7. Can the Enforcement Officer search details of vertical business of the 

PAN in the states other than my state? 

Yes, Enforcement officer can search details of vertical business of the PAN in the states other than 

his/her state. 

8. Can the Enforcement Officer and Commissioner search taxpayer details 

that belong to the Centre’s jurisdiction of my state? 

Enforcement officer and Commissioner can view all the details of a GSTIN even if it belongs to Centre 

jurisdiction of their state. 

9. Can Enforcement officer and Commissioner search the taxpayer details 

that belong to the Centre’s jurisdiction or state jurisdiction of any other 

state other than my state? 

Enforcement officer and Commissioner can view only primary details of a GSTIN if it belongs to any other 

state. 

10. Can I check if the field visit has been conducted or not for the 

registration linked to a particular GSTIN? 



 

 

You can check if the Field Visit has been conducted or not for the registration linked to a particular GSTIN 

in the taxpayer's profile. 

Navigate to Services > Taxpayer Account > Get Taxpayer Details. Click the   arrow to extend the 

screen for taxpayer's details. You can view the details under “Field Visit Conducted?”. 

  

If the Field Visit ID status linked to a GSTIN is “Report Submitted”, “Field Visit Conducted?” would be 

displayed as “Yes”. 

For no field visits initiated against a GSTIN or in case any field visit is in progress linked to a GSTIN, 

‘Field Visit Conducted?’ would be displayed as “No”. 



 

 

Manual > Get Taxpayer Details 

How can I search for the details of a taxpayer? 

To search for details of a taxpayer in the GST Portal, perform following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

4. Click the Services > Taxpayer Account > Get Taxpayer Details Command. The Get Taxpayer 

Details page is displayed. 

 

 

  

In case you do not remember the GSTIN of the Tax Payer, Click the Find GSTIN/UIN link.  

  

4. In the GSTIN/UIN field, enter the GSTIN of the taxpayer whose details you need to find. 

5. Click the GO button. 

Note: You can click the Find GSTIN/UIN link to find the GSTIN of the taxpayer. Click here to know more 

about how to find GSTIN. 

The taxpayer’s details are displayed. Ledger summary is available as part of dealer profile under “Get 

Taxpayer Details”  

  



 

 

 

  

You can view the details related to: 

Electronic Cash Ledger 

Electronic Liability Register 

Form submitted by the taxpayer to engage with GST Practitioner 

  

Electronic Cash Ledger:  

  

a. Click the Electronic Cash Ledger link. 

  



 

 

 

  

b. Select the period for which you want to view the ledger details using the calendar. Click the GO button. 

Ledger details for a selected period are displayed. 

  

 



 

 

  

c. Use the scroll bar to move to the right and view more details. You can click the link under Integrated 

Tax, Central Tax, State Tax and Cess  to view further details. 

  

 

  

Note: The Minor Heads wise balance is displayed for the selected Major Head. The Minor Heads include: 

Tax, Interest, Penalty, Fee, Others and Total.  

  

 

  

Note: Click the SAVE AS PDF and SAVE AS EXCEL button to save the Ledger in the pdf and excel 

format. 



 

 

 

 

  

Electronic Liability Register:  

  

a. Click the Electronic Liability Register (Other than Return Related) link. 

  



 

 

 

  

b. Select the period for which you want to view the ledger details using the calendar. You can search 

details based on Stay Status as well. Click the GO button. 

  

 

  

Ledger details based on search criteria are displayed. 

  



 

 

 

  

c. Use the scroll bar to move to the right and view more details. You can click the link under Integrated 

Tax, Central Tax, State Tax and Cess  to view further details. 

  

 

  



 

 

Note: The Minor Heads wise balance is displayed for the selected Major Head. The Minor Heads include: 

Tax, Interest, Penalty, Fee, Others and Total.  

  

 

  

Note: Click the SAVE AS PDF and SAVE AS EXCEL button to save the Ledger in the pdf and excel 

format. 

 

 

  

Similarly, you can view other ledger details. 

  

To view the details of registration, authorized signatories, owners and each ledger, you can also click the 

Quick Links bar on the right hand side alongside the ledger Balance table.  

  

This will open a menu as shown in the screenshot below. Click on the links as required to view the 

relevant details. 

  



 

 

 

  

Form submitted by the taxpayer to engage with GST Practitioner 

  

a. Click the arrow to view more details related to taxpayer. 

  

 

  

b. The details related to taxpayer are displayed. Click the Name and Contact of GST Practitioner 

hyperlink to view the authorization form submitted by the taxpayer.  

  



 

 

 

  

The authorization form submitted by the taxpayer to engage with GST Practitioner is displayed.  

  



 

 

 

  



 

 

Utilizing Cash/ ITC for Payment of Demand 

FAQs > Utilizing Cash/ ITC for Payment of 
Demand on Behalf of Taxpayer 

1. What is utilization of cash/ ITC for payment of demand or any other 

amount due about? 

It is about payments of non-return related liabilities created through generation of Demand ID which may 

be reference number of the order or application, appearing in the Electronic Liability Register (Part -II). 

2. How can the payments against the liabilities of a particular demand ID be 

made? 

The payments against the liabilities of a particular demand can be made through the following sources:  

 Cash balance available in the Electronic Cash Ledger; and/or 

 Input tax credit balance available in the Electronic Credit Ledger. 

3. How can I get to know about outstanding demands of the taxpayer? 

You can get the information regarding outstanding demands from Electronic Liability Register (Part -II). 

Details may be accessed regarding a particular demand, as well as for demands raised during a 

particular period etc after entering GSTIN of the taxpayer. 

4. Who can, other than Tax officials, access the functionality of “Utilize 

cash/ITC for payment of demand or any other amount due? 

The following persons, other than the Tax officials, can have access to the functionality of Utilize cash/ITC 

for payment of demand or any other amount due: 

 Registered taxpayer having a valid GSTIN or 

 Person having temporary id and password or 

 GSTP as per the approval process or 

 Cancelled taxpayer 

5. What are the pre-conditions for utilization of cash /ITC for payment of 

demand or any other amount due? 

The pre-conditions are: 



 

 

 Demand ID is already generated and has an outstanding demand to be paid 

 User should have valid User ID and password and has necessary authority and access for the 

same 

6. What are the details displayed to the Tax Official after selecting a 

Demand ID? 

The following details are displayed after tax official selects the Demand ID against which he/she intends 

to make payment: - 

 Outstanding liability towards tax, interest, penalty, fees and Others for 

CGST/SSGST/UTGST/Cess against the selected Demand ID 

 Balance as per Electronic Cash ledger 

 Balance as per Electronic Credit Ledger 

 Amount intended to be paid –Self declared by the user 

 Amount to be paid through Cash- As per user declaration 

 Amount to be paid through ITC- As per user declaration 

7. How is the relief towards reduced penalty available if payment is made 

within the specified period as per law? 

In case Demand ID is created under section 74 of the CGST/SGST/IGST/Cess Act, then as per law,  GST 

Portal shows reduced payment liability towards penalty, if taxpayer makes payment, as per following 

conditions:    

• If Payment is being made within 30 days from the date of communication of the order and 

• taxpayer is making full payment of tax and interest, stated in the order;  

The penalty amount displayed is 50% of the amount stated in the order and the balance 50% of the 

penalty is waived off. A credit entry is passed in the Electronic Liability Register – Part II accordingly. 

8. Can I make part payment or multiple payments against a particular 

Demand ID? 

Yes, GST Portal allows the Tax Official for making part or multiple part payments against a particular 

demand ID till the outstanding balance becomes zero. 

9. Are there any conditions for a taxpayer to be eligible for waiver of 

penalty against a Demand ID? 

Only if the payment is made against a Demand ID, created under Section 74 of the Act, within the 

specified period of 30 days from the date of communication of the order, the taxpayer is eligible for waiver 

of 50% of the penalty levied in the order.  



 

 

Following conditions must also be fulfilled: 

• The amount of penalty waiver will be considered if the demands included in the order, is paid off 

completely, across the Acts. 

• If reduced penalty is not paid off along with tax and interest in full, within 30 days, no entries of reduced 

penalty will be posted in the Liability Register – Part II.  

• Non-payment of any amount included in the demand towards “others” or Fees” won’t be considered 

towards eligibility of waiver of 50% of the penalty amount. 

• This convention will hold for each demand created under the aforesaid section.  

• Such entry of waiver of penalty will be tagged against the same demand only for which the payment is 

being made. 

10. How would the Tax Official know that the utilization of cash/ITC has 

been successful? 

On click of “Set-Off” button, if payment is successful, a success message is displayed along with PRN 

(Payment Reference Number) and all the relevant ledgers get updated. 

11. Which ledgers of the taxpayer gets updated on utilization of cash/ITC? 

i. On utilization of ITC, Debit entry number is generated and posting is done against that demand ID in 

Electronic Liability Register Part-II as well as in the Electronic Credit Ledger. 

ii. On utilization of Cash, Debit entry number is generated and posting is done against that demand ID in 

Electronic Liability Register Part-II as well as in the Electronic Cash Ledger. 

iii. In case of full payment is made under Demand order raised under Section 74 of CGST/SGST Act read 

with section 20 of IGST Act or Section 21 of UTGST Act, an entry would be posted in the Electronic 

Liability Register - Part II for the 50% penalty waiver. 

12. What is Payment Reference Number? 

Payment Reference Number is a unique reference number for any payment transaction done on the GST 

Portal which gets posted to Electronic Liability Register Part-II. 



 

 

 

Manual > Utilizing Cash/ ITC for Payment of 
Demand on Behalf of Taxpayer 

How can I make payment towards outstanding demands appearing in 

Electronic Liability Register (Part-II) at the GST portal on behalf of a 

taxpayer? 

To make payment towards an outstanding demand appearing in Electronic Liabili ty Register (Part-II) at 

the GST portal on behalf of a taxpayer, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Services > Taxpayer Account > Get Taxpayer Details Command.  

  

 

  

4. The Get Taxpayer Details page is displayed. In the GSTIN/UIN/TEMPID field, enter the GSTIN of the 

taxpayer whose details you need to find. 

5. Click the GO button. 

Note: You can click the Find GSTIN/UIN link to find the GSTIN of the taxpayer. Click here to know more 

about how to find GSTIN. 

  

 

  

6. The taxpayer’s details are displayed. Click the Quick Links bar on the right hand side.  

  



 

 

 

  

7. This will open a menu as shown in the screenshot below. Click the Payment towards demand link.  

  

 

  

8. The Outstanding Demand page is displayed. You can see all the Demand IDs against which demand 

is outstanding. Click the link under Integrated Tax, Central Tax, State Tax and Cess to view further 

details.  

  



 

 

 

  

Note: The Minor Heads include: Tax, Interest, Penalty, Fee and Others. The Minor Head wise balance is 

displayed for the selected Major Head.  

9. Click the Close button. 

  

 

  

10. Click the SELECT button to select the Demand ID. 

  



 

 

 

  

11. Outstanding Demand, Cash Ledger Balance and Credit Ledger Balance details are displayed.  

  

Note:  

If you are making payment before 30 days, you will get a message on top of the Payment of Demand 

page that "Demand created under section 74 of CGST/SGST Act read with section 20 of IGST Act or 

Section 21 of UTGST Act, is eligible for 50% waiver of Penalty, if the amount of Tax, Interest and 50% of 

the Penalty stated in the order is paid within 30 days from the date of communication of such order. 

Hence, the Penalty amount displayed in "Outstanding Demand table" is 50% of the Penalty amount 

specified in the order". 

Further penalty amount is shown to reduced amount. 

  



 

 

 

  

11 (a) Outstanding Demand 



 

 

The outstanding demand against the Demand ID as on date are shown in below table.  

    

 



 

 

  

11 (b) Amount intended to be paid against the Outstanding Demand  

Use the scroll bar to move to the right to enter the amount intended to be paid against that Demand ID.  

  



 

 

 

  

11 (c) Cash Ledger Balance  



 

 

The cash available as on date are shown in below table. 

  

 



 

 

  

11 (d) Amount of Outstanding Demand Paid through Cash  

Use the scroll bar to move to the right to enter the amount to be paid through cash against that Demand 

ID. 

  



 

 

 

  

11 (e) Credit Ledger Balance 



 

 

The ITC available as on date are shown in below table. 

  

 



 

 

  

11 (f) Amount of Outstanding Demand Paid through credit 

Use the scroll bar to move to the right to enter the amount to be paid through ITC against that Demand 

ID. 

  



 

 

 

  



 

 

Click here to know more about the Utilization principle 

https://tutorial.gst.gov.in/userguide/returns/index.htm#t=Utilization_Principles.htm  

  

12. Once you have entered the amount, click the SET-OFF button. 

  



 

 

 

  

13. A confirmation message is displayed. Click the OK button. 



 

 

  

 

  

14. A success message is displayed. Payment Reference Number is displayed on the screen. Click the 

OK button. 

  

 

  

Note: 

1. On utilization of ITC, Debit entry number will be generated and posting will be done against that 

demand ID in Electronic Liability Register Part-II as well as in the Electronic Credit Ledger. 

2. On utilization of Cash, Debit entry number will be generated and posting will be done against that  

demand ID in Electronic Liability Register Part-II as well as in the Electronic Cash Ledger. 

3. In case of full payment made under Demand order raised under Section 74 of CGST/SGST Act read 

with section 20 of IGST Act or Section 21 of UTGST Act, an entry would be posted in the Electronic 

Liability Register - Part II for the 50% penalty waiver. 



 

 

Search ARN 

FAQs > Search ARN 

1. What is ARN? Why is the ARN generated? 

The Acknowledgement Reference Number (ARN) is a 15-digit reference number generated by the GST 

Portal after successful completion of a work item.  

For example, an ARN is generated after successful submission of new registration application and 

successful e-filing of return. 

ARN is generated to identify and locate each work item uniquely in the data base. 

2. How can I access the ARNs allocated to me for processing? 

All ARNs allocated to you are available for your action from your personalized Dashboard under the 

relevant sections like Registrations and Returns. 

You will also get an Alert in your Dashboard when a work item is allocated to you. 

  

If you’re looking for a specific ARN, you can use the SEARCH ARN DETAILS feature in the Tax Official’s 

interface of the GST Portal. You can view the status of the form and data linked to an ARN within your 

state only. 

3. How do I search for an ARN of a taxpayer that is not in my state? 

You can only view the status of the form and data linked to an ARN within your state.  



 

 

Manual > Search ARN 

How can I search details of a work item by searching with an ARN? 

To search the details of a work item by searching with an ARN, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Services> Taxpayer Account > Search ARN Details command.  

  

 

  

The Search ARN Details page is displayed. 

  

In case of Search option when you know ARN: 

  

a. In the Status drop-down list, select the status of the ARN. 

b. In the ARN field, enter the ARN. 

c. Click the SEARCH button 

. 

The search results are displayed. By default, ARNs are displayed as per latest on the basis of ARN 

date. 

  

 

  

Note: 

• You can view the data linked to the ARN within a State. 



 

 

• You can click the ARN link to go directly to the work-item related to the ARN. 

  

In case of Advanced Search when you know the GSTIN/UIN: 

  

a. In the Status drop-down list, select the status of the ARN. 

b. In the GSTIN/UIN field, enter the GSTIN or UIN. 

c. In the Related To drop-down list, select the specific module. 

d. Select the From and To ARN Date  using the calendar. 

e. Click the SEARCH button. 

  

The search results are displayed. By default, ARNs are displayed as per latest on the basis of ARN date.  

  

 



 

 

Find GSTIN/UIN 

FAQs > Find GSTIN/UIN 

1. Can I search for GSTIN/ UIN of a taxpayer in case I do not know the PAN 

of the taxpayer? 

The Find GSTIN service allows you to look for the GSTIN of a taxpayer using one or more search 

parameters like PAN, Email address, Legal Name of the Business and Trade Name of the Business. 



 

 

Manual > Search GSTIN 

How can I search for the GSTIN/UIN of a taxpayer? 

To search for the GSTIN/UIN of a taxpayer, perform following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Services> Taxpayer Account > Find GSTIN Command.  

  

 

  

The Find GSTIN page is displayed. 

  

In case of Search when know the PAN: 

a. In the Permanent Account Number (PAN) field, enter the PAN of the taxpayer. 

b. In the Email Address field, enter the email address of the taxpayer. 

c. Click the SEARCH button. 

The search results are displayed. 

  

 

  

In case of Advance Search: 



 

 

a. In the Legal Name of Business field, enter the legal name of the business of the taxpayer. 

b. In the State, District and Circle  drop-down list, select the appropriate choice. 

c. Click the SEARCH button. 

The search results are displayed. 

  

 



 

 

Record Search 

FAQs > Record Search 

1. Can I search detailed record of a taxpayer? 

The Record Search feature allows Tax Officials to search for various order and notices generated under 

the various function for a taxpayer. The search results will be displayed for active as well as cancelled 

GSTINs. 

2. What is Reference ID? 

Reference ID is any reference number generated from the BO Officer end. Reference ID is used to issue 

all notices/ orders. 

3. I don’t know the GSTIN of the taxpayer and it is a mandatory field to 

execute a Record Search. What should I do? 

You can use the 'FIND GSTIN/UIN' feature to search for a particular GSTIN/UIN. 

4. How can I view the return filed by a taxpayer? 

To view the return filed by a taxpayer, navigate to Services> Taxpayer Account > Record Search > 

enter the GSTIN/ UIN/ TEMPID > select the Document Type as ARN and Related to as Return from the 

drop-down list. 

5. How can I view Form GSTR-2A of a taxpayer? 

To view GSTR-2A of a taxpayer, navigate to Services> Taxpayer Account > Record Search > enter the 

GSTIN/ UIN/ TEMPID > select the Document Type as GSTR2A and Return from the Related to drop-

down list. 

6. How can I view the challan history of a taxpayer? 

To view the challan history of a taxpayer, navigate to Services> Taxpayer Account > Record Search > 

enter the GSTIN/ UIN/ TEMPID > select the Document Type as CPIN and Payment from the Related to 

drop-down list. 



 

 

7. Can I search record of the taxpayer who is not under my jurisdiction? 

Can Enforcement officer have the facility to search record of the taxpayers 

registered in other States/ UT or falling under jurisdiction of CBEC? 

You can search record of the taxpayers registered in your State/UT.   

The officers notified by the department shall have search facility to access record of the taxpayers 

registered in other States/ UT. 

8. Who gives access to search record of the taxpayers registered in other 

States/ UT or falling under jurisdiction of CBEC? 

State Admins can use the User Role & Jurisdiction Administration service to give access to search 

record of the taxpayers registered in other States/ UT or falling under jurisdiction of CBEC to specific roles 

as notified by the department. 



 

 

 

Manual > Record Search 

How do I search a particular record in the GST Portal or How can I view the 

return filed by a taxpayer? 

To search a record in the GST Portal, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Services> Taxpayer Account > Record Search Command.  

  

 

  

The Record Search page is displayed.  

  

4. In the GSTIN/UIN field, enter the GSTIN of the taxpayer whose record you want to search.  

  

Note: You can click the Find GSTIN/UIN link to find the GSTIN of the taxpayer. 

  

5. In the Document Type drop-down list, select the type of the document.  

  

 

  

6.  In the Related To drop-down list, select the process to which the document is related.  

  



 

 

 

  

7. In the Reference ID (ARN) field, enter the reference ID of the document. 

8. In the Year drop-down list, select the year the document was submitted. 

9. Click the Search button.   

  

The search results are displayed. 

  

 

  

Note: To search the ARN related to returns, select Return from the drop-down list. 

List of ARNs will be displayed for all returns filed by the given taxpayer.  

  

Note:  

1. Any Tax Official can view the list of returns filed by a taxpayer of any State. However, details/ data of 

returns can be accessed only for respective State. 

2. To view the ledger details of a taxpayer, navigate to Services > Taxpayer Account > Get Taxpayer 

Details. 

3. TRAN-1 ARNs are also displayed in the same list with “Related To” as GSTR1.  

  

Click the Reference ID (ARN) link from the search result to view the return filed by the taxpayer. 

  



 

 

 

  

The Return is displayed in a new window. Click the Close button to close the return. 

  



 

 

 



 

 

  

Note: To search the data related to GSTR-2A for a taxpayer, select GSTR2A from the drop-down list.  

  

 

  

Select all the other details from the drop-down list. 

  

 

  

To see the data for any particular month, click the Tax period link. GSTR-2A page is displayed. You can 

click on various tabs to see respective details.  

  



 

 

 



 

 

Record Search Returns 

Record Search Returns 

1. Can I search detailed return of a taxpayer? 

The Record Search (returns) feature allows Tax Officials to search for various returns like Form GSTR-1, 

Form GSTR-3B (or Form GSTR-4 if applicable) filed by a taxpayer. 

Based on the search results, a tabular representation of filed returns are displayed. On clicking of 

Acknowledgment Reference Number (ARN), the summary return will be displayed.   

Alternatively, you can use the Record Search feature to view the detailed return of a taxpayer. Click here 

to know more about how Record Search feature. 

2. How can I view the return filed by a taxpayer? 

To view the return filed by a taxpayer, navigate to Services > Taxpayer Account > Record Search 

(returns) option. 

3. What does the grid table view signify? 

The grid view displays the applicable returns which are required to be filed by the searched GSTIN and 

current filing status.  

a. If return is filed - ARN is displayed, 

b. If return is not filed - ‘Not filed’ is displayed 

c. If Return is not applicable – ‘Not Applicable’ is displayed  

4. What values are displayed on the Graphs? 

There are two graphs which displays the following details:  

a. Total Taxable Turnover – based on Form GSTR-3B (Monthly) / Form GSTR-4 (Quarterly) 

b. Total Tax paid in Cash – based on Form GSTR-3B (Monthly) / Form GSTR-4 (Quarterly)   



 

 

Record Search Returns 

How can I view the return filed by a taxpayer? 

To view the return filed by a taxpayer in the GST Portal, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Services > Taxpayer Account > Record Search (Returns) Command.  

  

 

  

4. The Record Search Returns page  is displayed.  

  

 

  

5. In the GSTIN/UIN field, enter the GSTIN of the taxpayer whose record you want to search for returns.  

Note: You can click the Find GSTIN/UIN link to find the GSTIN of the taxpayer. Click here to know more 

about how to find the GSTIN of the taxpayer 

6. In the Year drop-down list, select the year for which you want to search for returns.  

7. Click the Search button.   

  

 

  

8. The search results are displayed. Graphical presentation of Total Taxable Turnover and Total tax paid 

in cash based on Form GSTR-3B/ GSTR-4 is displayed month wise. 



 

 

Note:  

a. If return is filed - ARN is displayed, 

b. If return is not filed - ‘Not filed’ is displayed 

c. If Return is not applicable – ‘Not Applicable’ is displayed 

  

(a) Graphical presentation of Total Taxable Turnover and Total tax paid in cash based on Form GSTR-3B 

& Form GSTR-1 is displayed month wise. 

  

 

  

9. Click the particular link under Month from the search result to view a particular Return filed by the 

taxpayer. 

  



 

 

 

  

10. The Return Form is displayed. 

  



 

 

 



 

 

  

  





 

 

Reassign Work-Items 

Overview > Reassign Work-Items 

Reassign Work-Items 

 FAQs 

 Manual > Reassign Work Item 

 Manual > Work Items Reassigned to my desk 

 Manual > Work Items Reassigned from my desk 



 

 

Overview > Reassign Work-Items 

Reassign Work-Items 

 FAQs 

 Manual > Reassign Work Item 

 Manual > Work Items Reassigned to my desk 

 Manual > Work Items Reassigned from my desk 



 

 

FAQs > Reassign Work Item 

1. What is the Reassign Work Item functionality? 

The Reassign Work Item functionality allows a Tax Official to reassign the pending work items from one 

subordinate to the desired subordinate Tax Officials so that work item is completed in the stipulated time. 

2. What details are available to me when I view a particular work item? 

You can view the following details in the work item form: 

1. ARN/Work Item ID 

2. GSTIN/UIN 

3. Date of Receipt/Initiation 

4. Expected due date of completion  

5. Days to expected due date 

3. I am trying to use the Reassign Work Item functionality but I am getting 

an error message. What should I do? 

There are four possible error messages you may get depending on the type of error:  

  

S.No. Error Message Action to be taken 

1. 
You cannot allocate the work item(s) 

without entering comments. 

Enter comments before reassigning work 

items. 

2. 

Work item <item> is being processed 

upon, cannot be reassigned at this 

moment.  

The Work item is already under 

processing and cannot be reassigned. 

You can reassign any other work items. 

3. 

Work cannot be assigned to <user> 

as he does not have the relevant role 

assigned. 

Assign the work items to a Tax Official 

who has relevant role 

4. No record found 

No work items found based on the 

search criteria, enter a valid search 

criteria 

5. 
No Tax Officials available with 

pending tasks 

There are no subordinates present in the 

jurisdiction to whom work can be 

reassigned 

4. How many times can I reassign pending work item? 



 

 

You can reassign pending work items any number of times. However, it is recommended you reassign 

work items only twice to maintain the sanctity. 

5. Can I Reassign Work Items between subordinates who are at different 

levels in the hierarchy? 

A Supervisor Tax Official can reassign work in own jurisdiction from one subordinate to another for any 

lower level in the hierarchy. 

However, a State Admin can reassign work item from any Tax Official to another Tax Official across the 

State 

6. How many work items can I reassign at a time? 

You can reassign work items by selecting individual work item one-by-one. Alternatively, you can 

reassign all pending work items with a subordinate by selecting the Reassign All option. 

7. I need to reassign a work item urgently; however I am unable to due to 

restrictions in my role? 

Please contact your State Admin. 



 

 

Manual > Reassign Work Item 

I am Tax Official. How do I reassign work items assigned to one tax official 

to another in the GST Portal? 

To reassign a work item in the GST Portal, as a Tax Official, perform following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Services > Work > Reassign Workitem command.  

  

 

  

4. Click the Reassign Work Items link. 

  

 

  

A summarized list of work items pending with the subordinates of the user is displayed.  

5. To search for a particular work item, enter data for any of the fields displayed and then click  the Search 

button. 

Number of work items pending with the subordinate is displayed along with other details.  

6. Click the View link, corresponding to the User name, to view the list of work items pending with that 

User under each module.  

7. Click the Reassign All link under the Action column to reassign all the listed work items.  

8. Click on the module name to view the list of work items pending with the User for that module.  

The work items are displayed w.r.t ARN/ Work Item ID, GSTIN, Name of the Business, Date of 

Receipt/Initiation, Expected due date of completion, Days to expected due date. 

9. Click the REASSIGN button to re-assign an individual item or multiple items. 

The page displayed lists all the subordinates of the User to whom the work item can be reassigned.  

Corresponding to the name of the official, details such as Role, Designation, and Total Pendency etc. are 

displayed.  



 

 

10. To reassign a task, select the Name of the Official to whom you want to allocate the work item, and 

then click the Allocate button.  

11. In the Comments field, enter your remarks / input comments and then click the Confirm button.  

  

  



 

 

Manual > Work Items Reassigned to my desk  

I am a Tax Official. Where can I view the work items assigned to me in the 

GST Portal? 

To view the work items reassigned to you in the GST Portal, perform following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Services > Work > Reassign Workitem command.  

  

 

  

4. Click the Work Items Reassigned to my desk link. 

  

 

  

A list of work items reassigned to you is displayed module wise. Click the Module link to see the list of 

ARNs reassigned to you.  

  

 

  

You can click the ARN link to start working on the work items. 

  



 

 

 



 

 

Manual > Work Items Reassigned from my 
desk  

I am a Tax Official. How can I view the work items that I assigned to another 

Tax Officials in the GST Portal? 

To view the work items reassigned to me in the GST Portal, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Services > Work > Reassign Workitem command.  

  

 

  

4. Click the Work Items Reassigned from my desk link. 

  

 

  

A list of work items reassigned by you is displayed module wise. Click the Module link to see the list of 

ARNs reassigned to you. 

  

 

  

 You can click the ARN link to start working on the work items. 

  



 

 

 

  



 

 

Administrative Tasks 

Overview > Administrative Tasks 

User Role & Jurisdictional Administration 

 FAQs 

 Manual  

Revoke Role 

 FAQs 

 Manual  

Update Jurisdiction of Taxpayer 

 FAQs 

 Manual  

Upload/Delete Published Documents 

 FAQs 

 Manual  

Directory of Office Addresses 

 FAQs 

 Manual > Add a New Office Address 

 Manual > Search or Edit an Office Address  

Directory of Officials 

 FAQs 

 Manual > Add a New Record 

 Manual > Search or Edit a Record 

 Manual > Create Records of Tax Officials 
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 FAQs 

 Manual  

Transfer of Charge 

 FAQs 

 Manual  

Target Allocation 

 FAQs 

 Manual > Assign Target 

 Manual > View Target 

 Manual > Update Achievements 

Broadcast Message 

 FAQs 

 Manual  

Blocking/ Unblocking ITC of a Taxpayer 

 FAQs 

 Manual  

  



 

 

 

Overview > Administrative Tasks 
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 Manual  
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User Role & Jurisdictional Administration 

FAQs > User Role & Jurisdictional 
Administration and Creation & Update 
Records of Tax Officials 

1. Who will create State Admin for each state? 

Central Admins will use the Create and Update Record of Officials service to: 

• Create record of Tax Officials nominated by the State who will be performing the role of State Admin 

• Allocate the role of State Admin to Tax Officials nominated by the State 

2. What activities can the state admin perform? 

The state admin can perform following functions through GST Portal Tax Officials Interface:  

  

Create and Update Record of Officials service  User Role & Jurisdiction Administration  

1.     Create record of a Tax Official in the GST 

Portal 

2.     Once the record of Tax Official is created, 

update the record of a Tax Official 

  

  

Note: The functionality for creating and updating a 

record, is available from the Services > Admin > 

Create and Update of record of officials. 

1.     User Role & Jurisdiction Administration 

2.     Assignment of Role and Jurisdiction after 

creation of role of New Official Record 

  

This functionality is available from the Services > 

Admin > User Role & Jurisdiction 

Administration service. 

  

3. Who will create record of the State Commissioner? 

The Central Admin will create the record of the State Commissioner.  

4. Whom does the State Admin report to? 

The State Admin will report to the Central Admin in the GST Portal. This reporting is only for facilitating 

the functioning of the GST Portal. 



 

 

5. Who is the Sub State Admin? What are the functions of the sub-state 

admin?  

The Sub-State Admin performs Administrative function for the jurisdiction assigned to him within the 

State. The State Admin can delegate their responsibilities and create Sub-State Admins, as deemed fit.  

6. How does a State Admin decide which role is to be allocated to the Tax 

Official? 

The role assignment is on the basis of the expected functions to be performed by the Tax Officials of your 

department. A State Tax officer, for example, is expected to approve the registration application needs to 

be assigned role of “Registration Approval”. 

  

Role Description of the Role 
Sample Task List associated 

with the Role 

State Admin  
The State Admin is expected 
to perform Administrative 
function for the state.  

Upload / Delete Published 
Documents, Directory of 

Officials, Directory of Office 
Addresses, Broadcast Message  

Sub-State 

Admin  

The Sub-State Admin is 

expected to perform 
Administrative function for the 
jurisdiction assigned to him 

with in the state.  

Create and Update of records of 

Officials, User Role & 
Jurisdiction Administration, 
Update Jurisdiction of a 

Taxpayer, Transfer Of Charge  

Commissioner  

This role is to be given to the 
Tax Officials working at 

Commissioner Level created 
by the Central Admin.  

Create Challan, Find GSTIN, 
Target Allocation, View Officials 

Details, View orders, view 

Proposals, Direction to file 
Appeal, Drop proceedings, 

Other Communication from 
Commissioner, View Directions 
from Commissioner, Generate 

cause list.  

Registration 

Approval  

The Tax Official with role 
Registration Approval is 
expected to approve all 

Registration Applications other 
than those for which separate 
role is provided. 

Processing of Registration ,Find 
GSTIN, Target Allocation, View 

Officials Details, Record Search, 
Get taxpayer Details, Search 

ARN, Leave Application, 
Reassign Work item  

Registration 
Enforcement  

The Tax Official with role 
Registration Enforcement is 

expected to perform 
enforcement activities 
including Suo Moto 

registration.  

Suo Moto Registration, Find 
GSTIN, Target Allocation, View 
Officials Details , Record 

Search, Get taxpayer Details, 
Search ARN, Leave Application  

GSTP 
Approval  

The Tax Official with role 
GSTP Approval is expected to 

GST Practitioner, Find GSTIN, 
Target Allocation, View Officials 



 

 

approve Registration 
Applications of GST 

Practitioners. This role should 
be given at the State Level 
since GSTP is not limited to 

any jurisdiction.  

Details , Record Search, Get 
taxpayer Details, Search ARN, 

Leave Application   

View 
Jurisdictional 

Records  

The Tax Official with role View 
Jurisdictional Records will be 
given view access to records 

of the taxpayers within his/her 
jurisdiction.  

Find GSTIN, Reassign Work 
item, Leave Application, View 

Officials Details , Record 
Search, Get taxpayer Details, 

Search ARN   

Adjudicating 

Authority  

The Tax Official with role 
Adjudicating Authority will be 

given access to issue orders 
related to demand/penalty.  

Suo Moto Registration, Find 
GSTIN, Determination of tax 
(Fraud/ Others), View Officials 

Details, View Appeal orders, 
View Revision orders, view 
notices, counter reply, File 

Appeal to Appellate Authority, 
View Directions from 
Commissioner, Update status to 

commissioner, View 
Proceedings of the first Appeal, 
Generate Cause list 

Approving 
Authority For 
Assessment  

The Tax Official with role 
Approving Authority For 

Assessment will be given 
access to issue withdrawal 
orders or rejection orders 

related to summary 
assessment. 

Suo Moto Registration, Find 
GSTIN, Determination of tax 
(Fraud/ Others), View Officials 

Details, View Appeal orders, 
View Revision orders, view 
notices, counter reply, File 

Appeal to Appellate Authority, 
View Directions from 
Commissioner, Update status to 

commissioner, View 
Proceedings of the first Appeal, 
Generate Cause list 

Grievance 

Processing  

The Tax Official with role 

Grievance Processing will be 
given access to address 
grievances raised by 

taxpayers.  

Grievance application 
processing, Find GSTIN, Record 
Search, Target Allocation, View 

Officials Details, Get taxpayer 

Details, Search ARN, Leave 

Application, Reassign Work item  

Recovery 
Officer  

The Tax Official with role 
Recovery Officer will be given 
access to create to utilize 

amount against any demand 
raised, to create demand 
entries pertaining to earlier 

laws and for doing recovery of 
GST related demands.  

Payment towards demand, Find 
GSTIN, Record Search, Target 
Allocation, Create new entry in 

DCR, Get taxpayer Details, 

Search ARN, Leave Application, 
Reassign Work item  

Senior 
Recovery 
Officer  

The Tax Official with role 
Senior Recovery Officer will be 

given access to create to 
utilize amount against any 

Payment towards demand, Find 

GSTIN, Record Search, Target 

Allocation, View DCR, Get 

taxpayer Details, Search ARN, 



 

 

demand raised & to approve 
demand entries created by 

Recovery officer pertaining to 
earlier laws.  

Leave Application, Reassign 

Work item  

UIN Approval  

The Tax Official with role UIN 

Approval is expected to 
approve Registration 
Applications of UN bodies, 

embassies & other notified 
persons.  

UN Body/ Embassy/ ONP, 

Allotment of UIN, Find GSTIN, 
Restore Registration, Get 
taxpayer Details, Search ARN, 

Leave Application, Reassign 

Work item, Record Search   

CGST Member 
- Appellate 
Authority for 

Advance 
Ruling  

The Tax Official with role 
CGST Member - Appellate 

Authority for Advance Ruling is 
expected to approve Advance 
Ruling Appeal and Advance 

Ruling referred Applications. 

Advance Ruling Application - 

Referred to Appellate Authority, 
Appeal Application filed by 

Taxpayer / Jurisdictional Officer, 
Get taxpayer Details, Search 

ARN, Leave Application, 
Reassign Work item, Record 
Search  

CGST Member 
- Authority for 
Advance 

Ruling  

The Tax Official with role 

CGST Member - Authority for 
Advance Ruling is expected to 
process Advance Ruling 

Applications filed by 
Applicants.  

Advance Ruling Application - 
Tax Payer, Get taxpayer Details, 

Search ARN, Leave Application, 
Reassign Work item, Record 

Search    

Concerned 

Officer  

The Tax Official with role 
Concerned Officer is expected 
to provide all the documents, 

data as required by Authority / 
Appellate Authority members 
and represent the department.  

Advance Ruling Application - 

Tax Payer, Advance Ruling 
Application - Referred to 
Appellate Authority, Appeal 

Application filed by Taxpayer / 
Jurisdictional Officer, Get 
taxpayer Details, Search ARN, 

Leave Application, Reassign 

Work item, Record Search  

Jurisdictional 

Officer  

The Tax Official with role 
Jurisdictional Officer is 
expected to represent the 

department & will be given 
access to view all advance 
ruling applications in his 

jurisdiction and file 
rectification, replies and 
appeal.  

Advance Ruling Application - 

Tax Payer, Advance Ruling 
Application - Referred to 
Appellate Authority, Appeal 

Application filed by Taxpayer / 
Jurisdictional Officer, View 
cause list, View Other Appeals & 

Orders, 
Get taxpayer Details, Search 

ARN, Leave Application, 
Reassign Work item, Record 
Search  

LUT 
Processing  

The Tax Official with role LUT 
Processing is expected to 
process LUT applications filed 

by taxpayer within his/her 
jurisdiction.  

Process LUT applications, Find 

GSTIN, Record Search, DSC 

Registration , Get taxpayer 

Details, Search ARN, Leave 

Application, Reassign Work item 

  

Registrar - The Tax Official with role Advance Ruling Application - 



 

 

Appellate 
Authority for 

Advance 
Ruling  

Registrar - Appellate Authority 
for Advance Ruling is expected 

to issue Notice for personal 
hearing in case of Advance 
Ruling Appeals and referred 

Advance Ruling Applications.  

Referred to Appellate Authority, 
Appeal Application filed by 

Taxpayer / Jurisdictional Officer, 
Get taxpayer Details, Search 

ARN, Leave Application, 
Reassign Work item, Record 
Search  

Registrar - 

Authority for 
Advance 
Ruling  

The Tax Official with role 
Registrar - Authority for 
Advance Ruling is expected to 
issue Notice for personal 

hearing in case of Advance 
Ruling applications and 
referring the AR Application to 

Appellate Authority on 
instructions from Authority 
members.  

Advance Ruling Application - 

Tax Payer, Get taxpayer Details, 

Search ARN, Leave Application, 
Reassign Work item, Record 

Search   

SGST Member 

- Appellate 
Authority for 
Advance 

Ruling  

The Tax Official with role 
SGST Member - Appellate 
Authority for Advance Ruling is 

expected to process Advance 
Ruling Appeal and Advance 
Ruling referred applications.   

Advance Ruling Application - 
Referred to Appellate Authority, 
Appeal Application filed by 

Taxpayer / Jurisdictional Officer, 
Get taxpayer Details, Search 

ARN, Leave Application, 
Reassign Work item, Record 
Search  

SGST Member 
- Authority for 
Advance 

Ruling  

The Tax Official with role 
SGST Member - Authority for 

Advance Ruling is expected to 
process Advance Ruling 
Applications filed by taxpayers.  

Advance Ruling Application - 

Taxpayer, Get taxpayer Details, 

Search ARN, Leave Application, 
Reassign Work item, Record 

Search  

Steno - 

Appellate 
Authority for 
Advance 

Ruling  

The Tax Official with role 
Steno - Appellate Authority for 
Advance Ruling expected to 

draft Orders, record the 
hearing proceedings & upload 
additional documents.  

Advance Ruling Application - 
Referred to Appellate Authority, 

Appeal Application filed by 
Taxpayer / Jurisdictional Officer, 
Get taxpayer Details, Search 

ARN, Leave Application, 
Reassign Work item, Record 

Search   

Steno - 

Authority for 
Advance 
Ruling  

The Tax Official with role 
Steno - Authority for Advance 

Ruling is expected to draft 
orders, record the hearing 
proceedings, upload additional 

documents.  

Advance Ruling Application - 
Tax Payer, Get taxpayer Details, 

Search ARN, Leave Application, 

Find GSTIN, Reassign Work 

item, Record Search  

MIS User  
The Tax Official with role MIS 
User will be given access to 

view jasper reports.  
View Details, New Reports  

Refund 
Processing  

The Tax Official with role 

Refund Processing is expected 

to process the refund 

applications filed by taxpayer 

Process Refund applications, 
Find GSTIN, Record Search, 

DSC Registration, Get taxpayer 
Details, Search ARN, Leave 

Application, Reassign Work item  



 

 

under his jurisdiction. 

Appellate 

Authority  

The Tax Officer with role 

Appellate Authority is expected 

to process the Appeal 

applications received under his 

jurisdiction.  

Process appeal applications filed 
by taxpayer and Legal officer, 

Find GSTIN, Record Search, 
DSC Registration, Get taxpayer 
Details, Search ARN, Leave 

Application, Reassign Work 

item, 
Admit appeal, , Reject appeal, 
Issue Appeal Order, View 
Orders, notices, View supporting 
documents, Upload documents, 

Search (ARN/RFN), Issue 
Personal Hearing notice/ 
Adjournment Notice/ Show 

cause notice, View Counter 
reply, Initiate and view 
Rectification Request, View 

cause list.  

Assistant to 

Appellate 

Authority  

The Tax Officer with role 

Appellate Authority is expected 

to process the Appeal 

applications received under his 

jurisdiction. 

View Application related details, 

View Orders, View supporting 

documents, Upload documents, 

Search (ARN/RFN), Issue 

Personal Hearing notice/ 

Adjournment Notice/ Show 

cause notice, View Counter 

reply, Initiate and view 

Rectification Request, View 

cause list., Get taxpayer Details, 

Search ARN, Leave Application, 

Reassign Work item, Record 

Search, DSC Registration, Find 

GSTIN  

Internal 

Review Cell 

Member 

The Tax Officer with role 

Internal Review Cell is 

expected to propose review of 

an order prejudicial to the 

interest of the revenue, under 

his jurisdiction.  

Search (ARN/RFN), View 

Orders, Initiate review Proposal, 

Upload document, View 

Proposal, View Proposal Status, 

Other Communication from 

Commissioner, View cause list., 

Get taxpayer Details, Search 

ARN, Leave Application, 

Reassign Work item, Record 

Search, DSC Registration, Find 

GSTIN 



 

 

Legal Officer  

The Tax Officer with role Legal 

officer is expected to file 

Appeal on behalf of Tax 

department and Upload Other 

Appeals & Orders.  

Search (ARN/RFN), View 

Orders, View Directions from 

Commissioner, Other 

Communication from 

Commissioner, Application to 

Appellate Authority, Update 

appeal details, Upload 

document, View Counter reply 

and notices and orders, Upload 

Other Appeals & Orders, View 

cause list. Get taxpayer Details, 

Search ARN, Leave Application, 

Reassign Work item, Record 

Search, DSC Registration, Find 

GSTIN  

Revisionary 

Authority  

The Tax Officer with role 

Revisionary Authority is 

expected to pass Revision 

order based on the proposal 

sent by Internal review cell or 

on its own motion.  

Search (ARN/RFN), View 

Revision Orders and orders 

issued by Tax department, Issue 

Revision Order, Upload Revision 

Order, View Directions from 

Commissioner, Update status to 

commissioner, View Notices, 

Issue Personal Hearing notice/ 

Adjournment Notice/ Show 

cause notice, Upload 

documents, View counter reply, 

View cause list. Get taxpayer 

Details, Search ARN, Leave 

Application, Reassign Work 

item, Record Search, DSC 

Registration, Find GSTIN  

  

Based on the role, the Tax Official will get: 

 Access to the different functionalities at the GST Portal (Tax Official Interface)   

 Work-items in the queue for processing 

  

For example, the Tax Official with role “Registration-Approval” will be assigned work items for 

processing of Registration Applications. Similarly, “GSTP-Approval” will be assigned work items for 

processing of Enrolment Application of the Tax Practitioner. Therefore, it is advisable to go through the 

Access grid carefully. 



 

 

  

Important 

Please note, the functionalities will be available in GST Portal Tax Officials Interface in a phased manner. 

Once the functionalities are available, respective Roles will get access to the same automatically. No 

update is required by State/ Sub-State Admin. In case of addition of new Roles later, State/ Sub-State 

admin would need to assign such Roles to the Tax Officials. These will be updated as and when new 

Roles and functionalities will be available. 

  

7. What are the fields that need to be filled in, while creating a record of an 

Official? Can I create record of Tax Officials if I do not have mandatory 

information like PAN or e-mail ID? 

You need to enter the fields mentioned below to create a record of a Tax Official.  

*Fields marked with asterisk are mandatory. 

You cannot create a record if you do not have the mandatory information.  

Please contact the relevant department or the Official for the information.  

If you contact the Official, please verify the information (Official should produce originals) before 

submitting the same into the system. 

  

1. 
State (Drop-down appears only for Super 

Admin and not for State Admin) 
  

2. Name of the Tax Official  

Salutation 

First 

Middle* 

  Last* 

3.  Designation    

4.  Start Date for current designation held*   

5. Scale Pay   

6. Grade Pay    

7. Email Address    

8. Mobile Number   

9. Date of Birth*   

10. PAN    



 

 

10. UID (Aadhar No.)   

12. PRAN Number or CPF/GPF Number   

13. Employee ID*   

14. Home State   

15. District (In Case of Home State)   

16. Date of Joining Service   

17. Employee Status   

  

8. Is there any facility to create multiple records of Tax Official in one go? 

Yes, there is a facility to create multiple records of Tax Officials in one go. The State Admin can use the 

Bulk Upload template to create record of multiple Tax Officials in one go. On clicking Bulk Upload, a 

screen will open where Admin can upload an excel, with details of the Tax Officials whose records are to 

be created. 

9. How do I check duplication of records? 

Duplication for a record of a tax Official will be checked by the GST System basis combination of PAN of 

the employee + PF (CPF/GPF) Number + PRAN. 

10. I am not sure if the record of a tax Official exists. I want to search for 

the Tax Official before creating the record. Can I search for a Tax Officials 

record in the GST Portal? 

Yes, you can enter one or more parameters to search for the Tax Official’s record. In case your search 

returns more than one result, the results will be displayed list -wise and you can select the relevant Official 

by clicking on their name. Navigate to Services > Admin > View Officials Details. 

11. Can a State Admin edit the record of the Tax Official in the GST Portal? 

Is it mandatory to provide reasons for the update? 

Yes, a State Admin can edit the record of the Tax Official in the GST Portal. 

Yes, a State Admin needs to provide reasons for the update and upload supporting documents for the 

updates. The portal will maintain log of the updates made. 



 

 

12. Can I see a history or a log of profile updates for the Tax Official? 

Yes, you can view record of the Tax Official by clicking the Create and Update of records of Officials > 

View/ Update service. The search result of the employee will display following information: 

• Roles & Jurisdictions Currently Assigned to the Official 

• Roles & Jurisdictions Assigned to the Official in Past 

• Log of Updates made in Profile of Official 

13. Who is an off-boarded employee? OR When do I mark an employee as 

off-boarded? 

The Off-boarded employees are those employees who voluntarily resigned from their role at any time 

before their retirement and are no longer a part of the department. An employee of the Off-boarded status 

is not assigned any work item. 

Refer the user manual to follow the steps of off-boarding an employee.  

14. What process is followed for off boarding an employee? 

To off board an employee, state admin needs to perform following actions:  

1. Reassign the pending work items to another official with same jurisdiction and role. Click here to view 

the detailed steps of Reassign work items. This step is not mandatory. In case work items are not 

reassigned, the work items will be reassigned as part of next step, Transfer of Charge. 

2. Transfer of charge to another official with same jurisdiction and role. Click here to view the detailed 

steps of Transfer of Charge. 

3. Update status of employee as “off boarded”. Click here to view the detailed steps of updating status of 

an employee. 

15. How can I search details of a Tax officer? 

Click the Services > Admin > User Role & Jurisdiction Administration service and the Official Record 

Search page is displayed.  

Click the Advance Search icon and enter the search parameters like Name, Email ID, Mobile No, 

Designation, Date of Joining, Employee Status, PAN of the Employee, Role to search for the Official. 

From the search results, click the name of the Official and you will be directed to the record of the Tax 

Official. From this page, you can do the following: 

• Edit the profile of the Tax Official 

• Add a new role to the Tax Official 

• View the roles allocated to the Tax Official 

• Deallocate the roles allocated to the Tax Official 



 

 

16. If a Tax Official is transferred from one state to another, who will 

allocate the new role to the Tax Official? 

If a Tax Official is transferred from one state to another, the State Admins of both the state will have to 

perform the following actions: 

• State Admin from which the Tax Official has been transferred will have to make the Employee Status as 

Inactive 

• State Admin in which the Tax Official is transferred will have to create a new record and assign a role 

17. Can a Tax Official report to two Supervisors? 

A Tax Official can be allocated roles of two different jurisdictions. However, the reporting manager will be 

Supervisor of the primary jurisdiction of that officer. 

18. If a role of Tax Official is deallocated, what will happen to the work 

items pending with the Tax Official? 

When a State Admin deallocates a role, GST Portal directs the State Admin to first Transfer the charge of 

that particular officer. Once charge is transferred, the work items pending with Tax Offic ial will be 

reassigned to the Tax Official to whom such charge is transferred. 

19. I am unable to upload supporting document while creating users. What 

should I do? 

Please check the format and size of the document being uploaded. The GST Portal accepts files that are 

less than 500 KB in size and only in PDF or JPEG formats. 

  



 

 

Manual > User Role and Jurisdiction 
Administration 

I am Tax Official. How can I assign a new role to a Tax Official? 

To assign a new role to a Tax Official, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Services > Admin > User Role & Jurisdiction Administration command. 

  

 

  

4. The Official Record Search page is displayed. Click the Advanced Search link and search the record 

of the Tax Official by entering any of the details and click the SEARCH button.  

5. The List of Tax Officials is displayed. Click the Username link. 

  



 

 

 

  

6. To assign a new role to the official, click the ADD NEW ROLE button.  

  

 

  

The Add New Role page is displayed for the selected profile.   

7. In the Role Type drop-down list, select the type of role applicable for this user. 

  



 

 

 

  

Note: The State field is auto-populated. 

  

8. Select whether the role is a Primary Jurisdiction. 

9. In the Jurisdiction Levels section, select the zone, unit and circle where the officer needs to be given 

the role. 

Note: This is the jurisdiction in which the officer is designated to operate. For example, if officer is 

designated to be the registration approval authority for all wards in a zone, then these steps will have to 

be repeated for all wards in that zone.  

  

10. In the Effective Start Date field, either enter the date manually or click the calendar icon to select the 

date from the calendar displayed. Effective date indicates the date when the user will start working as per 

the new role.  

11. Under the Reports to (Jurisdiction Levels) section, select the zone, unit and circle of the person to 

whom the officer will report. Select the Designation of the person to whom the officer will report to and 

name of the people available will get populated in the Report to drop-down list. From the Reports to 

drop-down list, select the person to whom the officer will report to. 

Note:  

The person, to whom the officer will report, should have been assigned role & jurisdiction prior. In case 

the name does not appear, please check the following –  

a) Jurisdiction assigned to the person, to whom the officer will report, is same as being selected in 

Step #11 

b) The profile of person, to whom the officer will report, has same designation as being selected in 

Step # 11 

For example, if the person to whom the officer will report, is allocated to Zone, then “Reports to 

Jurisdiction Levels” should be till zone only.  

  

11. Click the Choose File button to attach the supporting documents. This is an optional step. 

12. Click the ASSIGN button to add the new role.  

  



 

 

 

  

13. Click the CONFIRM button to save the new role details. 

  

 

  



 

 

A success message is displayed for the assignment of the new role.  

  

 



 

 

Revoke Role 

FAQs > Revoke Role 

1. Who can revoke role of a Tax Official? 

The Central Admin, State Admin or Sub-State Admin can revoke role of a Tax Official. 

Respective Admin can revoke role of a Tax official limited to his jurisdiction only. 

2. How can I revoke role of a Tax Official? 

Navigate to Services > Admin > User Role & Jurisdiction Administration to revoke role of a Tax 

Official. Search for a tax officer whose role needs to be revoked. Click on username of the officer, list of 

all the roles and jurisdiction assigned to tax officer will be displayed against which “Revoke” option will be 

present. 

3. What are the pre-conditions to revoke role of a Tax Official? 

Below provided are the pre-conditions to revoke role of a Tax Official: 

 No subordinates are assigned to the Tax Official.  

 No work items are pending with the Tax Official whose role/roles are required to be revoked.  

4. I want to revoke role of a Tax Official but he has subordinates assigned 

to him. What do I do? 

You need to update the reporting of the subordinates to new officers to revoke role/roles of that Tax 

Official. 

5. I want to revoke role of a Tax Official but he has work items pending with 

him. What do I do? 

You need to reassign work items to some other Tax official to revoke role/roles of that Tax Official.  



 

 

Manual > Revoke Role 

How can I revoke role of a Tax Official? 

To revoke role of a Tax Official, in the role of Central Admin, State Admin or Sub-State Admin, perform 

following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Services > Admin > User Role & Jurisdiction Administration command. 

  

 

  

4. The Update User Role & Jurisdiction page is displayed. Click the Advanced Search link. 

  

 

  

5. Search the record of the Tax Official by entering any of the details and click the SEARCH button.  

  



 

 

 

  

6. The List of Tax Officials is displayed. Click the Username link. 

  



 

 

 

  

7. To revoke role of the Tax official, select the Revoke link.  

Note: As you can see in the screenshot below that there are three roles assigned to the Tax Official. You 

need to select the Revoke link against each role to revoke it. Here, as an example, Registration-Approval 

role of the Tax official is been revoked. 

  



 

 

 

  

8. Click the CONFIRM button. 

  

 

  

9. A success message is displayed that role has been revoked successfully.  

  



 

 

 

  

  



 

 

Update Jurisdiction of Taxpayer 

FAQs > Update Jurisdiction of Taxpayer 

1. If a taxpayer has wrongly entered the jurisdiction, can a Tax Official 

update the jurisdiction of the taxpayer? 

Yes, a State Admin or an Sub-State Admin can change the jurisdiction of the taxpayer so that the work 

item is assigned to a Tax Official in correct jurisdiction. 

2. Can the jurisdiction of a taxpayer be updated? 

Jurisdiction of a taxpayer can be updated only by State Admin or Sub-State Admin. 

3. Is it possible to bulk update the jurisdiction of taxpayers? 

Yes, a State Admin or an Sub-State Admin can update jurisdiction of multiple taxpayers in one go.  

4. Under what circumstances can the jurisdiction of a taxpayer be updated? 

A State Admin or an Sub-State Admin may update jurisdiction of a taxpayer in following cases:  

1. Taxpayer may request for change due to incorrect mapping. 

2. Split of District/Division/Ward may result in change of taxpayer’s jurisdiction. 

3. Identification of wrong mapping by tax authority 

4. Deemed approved cases where jurisdiction has not been mapped 

Note: Approval from Jurisdictional Officer is mandatory for updating jurisdiction of a taxpayer. 



 

 

Manual > Update Jurisdiction of a Taxpayer 

I am a State Admin. I need to change the jurisdiction of Taxpayers as an 

incorrect jurisdiction is assigned to them. How can I change Taxpayers 

jurisdiction in the GST Portal? 

To change jurisdiction of taxpayers in the GST Portal, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click Services > Admin > User Role & Jurisdiction Administration command. 

  

 

  

The Update Jurisdiction of a Taxpayer page is displayed.  

The Search tab enables you to allocate jurisdiction to a taxpayer. 

  

The List of New Registrations tab enables you to allocate jurisdiction to New Registration Applicants / 

Taxpayers to whom the jurisdiction has not been allocated. 

4. In the GSTIN / UIN field, enter the GSTIN / UIN of the taxpayer. 

5. In the State Jurisdiction section, select the Zone, Unit and Circle. 

6. Click the SEARCH button.  

  



 

 

 

  

The list of taxpayers is displayed on the basis of the search criteria entered. 

7. Select Taxpayers from the list displayed to change jurisdiction. You can select multiple Taxpayers from 

the list. 

8. Click the PROCEED button.  

  

 

  

9. In the District and Circle drop-down-list, select the details of the jurisdiction to be changed. 

10. Click the ASSIGN button. 

  

 

  

11. The list of taxpayer with updated preview is displayed. Click the PROCEED button.  



 

 

  

 

  

12. . Click the PROCEED button.  

  

 

  

A confirmation message  is displayed that the jurisdiction is updated for the Taxpayer.  

  



 

 

 



 

 

Upload/Delete Published Documents 

FAQs > Upload/Delete Published Documents 

1. Who can publish a document on the GST Portal? 

Only State Admin can publish or delete documents for the taxpayers as well as Tax Officials. 

2. Which documents can I publish for taxpayers or Tax Officials? 

State Admins can upload, archive or delete published documents for the taxpayers as well as Tax 

Officials such as act, rules, rate schedule, notification, trade circular, press release, internal circular, 

judgments, office orders, advance ruling, amendment, training artefact, instruction sheet, FAQs and 

citizen charter. 

3. Can I bulk upload/delete documents? 

You can upload/delete only one document at a time at the GST Portal.  

4. I am unable to delete the document. Why? 

A published document can be deleted till one month from the date of upload. After one month a document 

can only be archived by changing its archive date. 



 

 

Manual > Upload/Delete Published 
Documents 

I am required to upload some latest published documents and delete the 

older in the GST Portal. How can I upload and delete published documents 

on the GST Portal? 

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal. 

3. Click the Services > Admin > Upload / Delete Published Document command.  

  

 

  

In case of Search: 

The Search tab available on the page enables you to search, view or delete a document.  

  

4.In the Act drop-down list, select whether the document is related to IGST, CGST, SGST, or Cess Act 

of the State. 

5. In the Document Type drop-down list, select the type of the document.  

6. In the Document Number field, enter the document number.  

7. In the To be made visible to option, select who can view the content in the published document.  

8. In the Issued By field, enter the name of the issuing authority. 

9. Select the Date of Issuance of the document using the calendar. 

10. Select the Date of Upload of the document using the calendar. 

11. Select the Date of Archival of the document using the calendar. 

  



 

 

 

  

The search results are displayed. 

You click the View link to view the document. 

You click the Delete button to delete the document. 

You click the Edit button to edit the document. 

You click the Download button to download the document. 

  

 

  

In case of Upload: 

The Upload tab available on the page enables you to upload a document. 



 

 

12. In the Act drop-down list, select whether the document is related to IGST, CGST, SGST, or RTI Act of 

the State. 

13. In the Document Type drop-down list, select the type of the document.  

14. In the Language of Document drop-down list, select language of the content in the published 

document.  

15. In the To be made visible to option, select who can view the content in the published document.  

16. In the Document Number field, enter the document number.  

17. In the Effect on Linked Document drop-down list, select the effect that the published document will 

have on the linked document.   

18. In the Issued By field, enter the name of the issuing authority. 

19. In the Title of the Document field, enter the title of the document. 

20. In the Functional Area drop-down list, select the area regarding which the document is published, 

such as Returns, Registration, and Payment etc. 

21. In the Meta Tag Values(keywords) field, enter the mega tag values or keywords to be associated 

with the document. 

22. Select the Date of Issuance of the document using the calendar. 

23. Select the Date of Archival of the document using the calendar. 

24. In the Document Number of Linked Document field, enter the previous document number linked 

with the document. 

25. Click the Choose File button to upload the document and other supporting documents. 

26. Click the SUBMIT button.  

  



 

 

 

  

27. Click the Confirm button to proceed.  

  



 

 

 

  

A success message is displayed saying the document has been updated.  

  

 



 

 

Directory of Office Addresses 

FAQs > Update Directory of Official Addresses 

1. Who can update Directory of Official addresses? From where can I 

access Directory of Official addresses? 

Only the State Admin can add a record, edit or delete a record from the directory of office addresses. The 

updated directory of office addresses will be displayed on the GST Portal Taxpayers Interface as well as 

Tax Officials Interface. 

The State Admin can access the functionality from the post login Dashboard of the State Admin. 



 

 

 

Manual > Add a New Office Address 

How can I add a new office address in the Directory of office addresses? 

To add a new office address in the Directory of office addresses, perform following steps: 

1. Access the GST Portal. The GST Home page  is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Services > Admin > Directory of Office Addresses command.  

  

 

  

4. The Directory of Office Addresses page is displayed. Click the ADD A RECORD button. 

According to State, Jurisdiction levels will appear on the screen. 

  

 

  

The Add New page is displayed.  

5. From the Head quarter drop-down list, select the headquarter. 

6. Click the SEARCH FOR ADDRESSES button. 

  



 

 

 

  

7. Select the Address from the available List of Addresses. 

8. From the Office of drop-down list, select the office for which the record has to be added. 

9. In the Email Address field, enter the email address. 

10. Click the ADD RECORD button. 

  

 

  

11. A confirmation message is displayed. Click the PROCEED button. 

  



 

 

 

  

A confirmation message is displayed that a new record has been added successfully.  

  

 



 

 

Manual > Search or Edit an Office Address  

How can I search or edit an office address in the Directory of office 

addresses? 

To search for an office address in Directory of office addresses, perform following steps: 

  

1. Access the GST Portal. The GST Home page  is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Services > Admin > Directory of Office Addresses command. 

  

 

  

The Directory of Office Addresses page is displayed.  

4. From the Office of drop-down list, select the office for which the record has to be searched. 

5. From the Head quarter drop-down list, select the headquarter for which the record has to be searched.  

6. Click the SEARCH button. 

  

 

  

The search results are displayed. You can click the EDIT button to edit the record. 

  



 

 

 



 

 

Directory of Officials 

Update Directory of Officials 

1. Who can view or update Directory of Officials? From where can I access 

Directory of Officials? 

The BO State Admin can view or update Directory of Officials. You can login to the GST Portal and click 

the Services > Admin > Directory of Officials command to access Directory of Officials. 

2. Can a BO Common User update Directory of Officials? 

No. A BO Common User cannot update Directory of Officials.  

3. Will CBEC and Model 1 States have access and update Directory of 

Officials of their states? 

CBEC and Model 1 states will be able to access and update the Directory of Officials of their states 

through APIs. They will not have access to this service on the GST Portal. 

4. What is Directory of Officials? What information is contained in Directory 

of Officials? 

Directory of Officials displays the list of Tax Officials with the below information: 

 Office of 

 State Jurisdiction 

 Name of the Tax Officer 

 Email Address 

 Mobile Number 

 Landline Number 

 Address with PIN Code 

5. Is their any difference between Model I & II states regarding Directory of 

Officials? What is the difference? 

The GST Portal is designed for Model II States. Model I states will use their own system regarding 

Directory of Officials. 



 

 

6. What are mandatory fields required to add a new record in Directory of 

Officials? 

You need to enter the user name, select the office and jurisdiction to add a new record in Directory of 

Officials. 

7. What is the basic information needed to search a record? 

You need to select the Office/ Jurisdiction/ Name of the Tax authority for whom the record has to be 

searched. 



 

 

Manual > Add a New Record in Directory of 
Officials 

How can I add a new record in Directory of Officials? 

To add a new record in Directory of Officials, perform following steps:  

  

1. Access the GST Portal. The GST Home page  is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Services > Admin > Directory of Officials command.  

  

 

  

4. The Directory of Officials page is displayed. Click the ADD A RECORD button. 

  

 

  

The Add New page is displayed.  

5. In the User Name field, enter the user name to be added to the directory of officials. 

6. From the Office of drop-down list, select the office for which the record has to be added. 

7. From the District drop-down list, select the district. 

8. Click the SEARCH FOR OFFICE button. 



 

 

  

 

  

9. Office records are displayed. Click the ADD RECORD button. 

  

 

  

10. A confirmation message is displayed. Click the PROCEED button. 

  



 

 

 

  

A confirmation message is displayed that a new record has been added successfully. 

  

 



 

 

Manual > Search or Edit a Record 

How can I search or edit a record in Directory of Officials? 

To search or edit a record in Directory of Officials, perform following steps:  

  

1. Access the GST Portal. The GST Home page  is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Services > Admin > Directory of Officials command.  

  

 

  

The Directory of Officials page is displayed.  

4. From the Office of drop-down list, select the office for which the record has to be searched. 

5. In the Name of Tax Authority field, enter the name of the Tax authority whose record has to be 

searched. 

6. From the District drop-down list, select the district for which the record has to be searched.  

7. Click the SEARCH button. 

  

 

  



 

 

The search results are displayed. You can click the EDIT button to edit the record or DELETE button to 

delete the record. 

  

 



 

 

Manual > Create Records of Tax Officials 

How can State Admins create and update official records of the Tax 

Authorities with respect to their profile within the GST Portal? 

To create and update records of officials in the GST Portal, perform following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Services> Admin > Create and Update of records of Officials command.  

  

Note: Only the Tax Officials with administrative rights have access to create and update records of 

officials and not all the Tax Officials. 

  

 

  

The Create Record page is displayed. To create records of tax Officials you have two options:  

  

• Create records individually 

• Create multiple records in bulk 

  

Click each hyperlink to view the corresponding steps. 

  



 

 

 

Create Records Individually 

4. In the Create Record page, the Create tab is opened by default. Enter general details of the Tax 

Official in the mandatory fields such as, Salutation, First Name, Email Address and Mobile Number. 

5. Select an option PRAN or CPF No. \ GPF No. and enter the data for the selected field.   

6. In the Date of Birth field, enter the date of birth of the Tax Official. 

7. In the Permanent Account Number (PAN) field, enter the PAN of the Tax Official whose record needs 

to be created. 

8. In the Employee Status drop-down list, select the status of the Tax Official. The options available are: 

  

Active: In case the Tax Official is an active employee. 

Off-boarded: In case the Tax Official has moved to some different state. The employee status in the 

current state will be off-boarded. 

Retired: In case the Tax Official has retired from service. 

9. In the State drop-down list, select the State to which the Tax Official belongs. 

10. In the Designation drop-down list, select the designation of the Tax Official. 

11. In the Scale Pay field, enter the pay scale of the Tax Official. 

12. In the Grade Pay field, enter the grade pay of the Tax Official. 

13. In the Home State drop-down list, select the home state of the Tax Official. 

Note: Home State will be auto populated in case of State/ Sub-State Admin whereas in case of Super 

Admin, Home state will be a dropdown. 

14. In theDistrict (In Case of Home State) drop-down list, select the district to which the Tax Official 

belongs. 

15. In the Date of Joining Service field, either manually enter the date of joining or select the date of 

joining using the calendar. 

16. In the UID (Aadhaar No.) field, enter the Aadhaar number of Tax Official. 



 

 

17. Select theStart Date for current designation Held using the calendar. 

18. Click the Choose File button to attach the supporting document with the record. 

  

Once the attachment is attached to the record, the Preview button is displayed.  

19. Click the SUBMIT button to save the details and create record of the Tax Official. 

  

 

  

20. A Warning message is displayed confirming if you want to create a new official record. Click the 

CONFIRM button to create an official record of the Tax Official.  

  



 

 

 

  

21.The profile is created with the details entered.  A success message is displayed at the top of the page 

informing that an official record has been created and an email is sent to the user with username and 

OTP. The user is required to login using the username and OTP received within 15 minutes of receiving 

the OTP after which it gets expired and needs to be generated again. 

  

 

Create Multiple Records in Bulk 

4. In the Create Record page, the Create tab is opened by default. Click the Upload Bulk Data tab. 



 

 

5. In the Upload Bulk Data tab page, download the template by using the hyperlink - Click here to 
download the template  hyperlink.  
   

 
   
6. In the bulktemplate.xls, enter the details of the Tax Officials records to be created. Select a designation 
from the Designation drop-down list. On selection of designation, the Designation ID will be auto-filled. 

You can add multiple records of Tax officials. Save and close the template.   
   

 
   
7. In the Upload Bulk Data tab page, upload the filled template using the Choose File button. Similarly, 

upload the supporting document using the Choose File button in the corresponding section. Once 
uploaded you can Preview or Delete the uploaded files.  
   



 

 

 
   

8. Click the Submit button. You will view the success message on screen. Check your email. In case of 

errors, correct the errors on the template and upload again. 

  

 



 

 

 

Manual > Update Records of Tax Officials 

I am a Tax Official. I need to make changes in the jurisdiction of some Tax 

Officials and assign new roles to them. How can I update the official record 

of the Tax Official on the GST Portal? 

You can update the records of officials to make changes in their jurisdiction or roles by using the View / 

Update option. To use the View / Update option, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Services > Admin > Create and Update of records of Officials command.  

4. Click the View / Update tab to update an existing official record.   

5. Enter the mandatory fields to search for the record you want to update and click the SEARCH button. 

Record found with the matched details is listed at the bottom of the page.  

  

 

  

6. Click the Edit icon displayed next to the record in the list to update / edit the details.  

  

 



 

 

  

7. The Update Record page is displayed in the edit mode. Update / Edit the details.  

8. Click the Choose File button to attach the supporting document with the record.  

9. In the Reasons for Update  field, enter the reason for updating the field. 

10. Click the SUBMIT button to save the updates. 

  

 

  

11. A Warning message is displayed confirming if you want to update the record. Click the CONFIRM 

button to save the updates.  

  



 

 

 

  

The updated record is displayed and an email is sent to the user with the updated status of the record. 

Also, the user receives notification regarding the record update. The user cannot update his or her own 

profile.  

  

 



 

 

Update Holiday Calendar 

FAQs > Update Holiday Calendar 

1. How can I update Holiday Calendar? 

Navigate to Services > Admin > Update Holiday Calendar to update the holiday calendar. 

2. Why it is important to update holiday calendar? 

As for discharging the statutory functions say registration application etc. certain time lines (working days) 

are prescribed within which the pending task is to be disposed by the Tax officials. Therefore, updating 

holidays in the Calendar in the backend is important to enable Tax Official to monitor its pendency of work 

items and to dispose it within the stipulated time period. Similarly,  GST Portal provides facility to the 

taxpayer from the State to see the working /non-working days on GST Portal. 

3. What all functions can be performed using Update Holiday Calendar 

option? 

You can perform below functions using the Update Holiday Calendar option:  

1. View Holiday Calendar 

2. Add Holiday 

3. Edit Holiday 

4. Delete Holiday 

5. Configure Non-Working Days 

6. Configure Saturday as Non-Working Days 

4. Can I delete an existing holiday? 

Yes, you can delete an existing holiday.  

Navigate to Services > Admin > Update Holiday Calendar > click the Delete button. 

5. Can I edit an existing holiday? 

Yes, you can edit an existing holiday.  

Navigate to Services > Admin > Update Holiday Calendar > click the Edit button. 

Note: Modification of Future dates are only allowed. You cannot modify holiday for any past date. 

6. Can I bulk update Saturday as non-working days? 



 

 

Yes, you can bulk update Saturday as non-working days.  

Navigate to Services > Admin > Update Holiday Calendar > Select the Month and Dates for which 

Saturday has to be configured as Non-working days. 

7. I have bulk updated Saturday as non-working days for a particular 

month. Can I undo it now? 

Yes, you can undo the changes in case you have bulk updated Saturday as non-working days for a 

particular month.  

Note: You can only modify Future dates. 

8. Can I update holiday status for other States? 

BO Admin can update holiday status only for his own State. 

9. Why some dates are already marked as holidays? 

By default, all Sundays will be provided in the GST Portal as holiday. State wise Admin users have to 

record other holidays including Saturdays. 



 

 

 

Manual > Update Holiday Calendar 

How can I update the holiday calendar on the GST Portal. 

To update the holiday calendar on the GST Portal, perform following steps.  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click Services > Admin > Update Holiday Calendar. 

  

 

  

4. The Holiday Calendar is displayed.  

  



 

 

 



 

 

  

5. Click the link below to know more details. 

  

A. View Holiday Calendar 

B. Add Holiday 

C. Edit Holiday 

D. Delete Holiday 

E. Configure Non-Working Days 

F. Configure Saturday as Non-Working Days 

A. View Holiday Calendar 

a. You can use the left and right arrow to scroll through months to view the holiday calendar. 

  



 

 

 



 

 

  

B. Add Holiday 

a. To add a new holiday, click the ADD HOLIDAY button. 

  



 

 

 



 

 

  

b. In the Remarks field, enter the remarks for the holiday. 

c. Select the Date for the holiday using the calendar. 

d. Click the Choose File button to support the supporting document. 

Note: You can upload file in PDF/ JPEG format with file size of 500 KB. 

  



 

 

 



 

 

  

e. Click the CONFIRM button.  

Note: You can click the Preview or Delete link to preview or delete the supporting document. 

  



 

 

 



 

 

  

f. Click the CONFIRM button.  

  

 

  

g. A success message is displayed that holiday is added successfully.  

  



 

 
 



 

 

  

h. Notice that the holiday is added successfully in the holiday calendar.  

  



 

 

 



 

 

C. Edit Holiday 

a. To edit an existing holiday, click the Edit button. 

  



 

 

 



 

 

  

b. Click the PROCEED button. 

  

 

  

c. In the Remarks field, enter the remarks for the holiday. 

d. Click the Choose File button to support the supporting document. 

Note: You can upload file in PDF/ JPEG format with file size of 500 KB. 

  



 

 

 



 

 

  

e. Click the CONFIRM button. 

  

 

  

f. A success message is displayed that holiday is edited successfully.  

  



 

 
 



 

 

  

g. Notice that the holiday is edited successfully in the holiday calendar.  

  



 

 

 



 

 

  

D. Delete Holiday 

a. To delete an existing holiday, click the Delete button. 

  



 

 

 



 

 

  

b. Click the PROCEED button. 

  

 

  

c. A success message is displayed that holiday is deleted successfully.  

  



 

 
 



 

 

  

d. Notice that the holiday is deleted successfully in the holiday calendar.  

  



 

 

 



 

 

  

E. Configure Non-Working Days 

a. To configure any date as non-working day, select one date from the calendar. 

b.  Select Yes for Update as non-working date. 

c. In the Remarks field, enter the remarks for the holiday. 

d. Click the Choose File button to support the supporting document. 

Note: You can upload file in PDF/ JPEG format with file size of 500 KB. 

e. Click the SUBMIT button. 

  



 

 

 



 

 

  

f. Click the CONFIRM button. 

  

 

  

g. A success message is displayed that date has been added successfully.  

  



 

 

 



 

 

  

i. Notice that the non-working day is added successfully in the holiday calendar.  

  



 

 

 



 

 

F. Configure Saturdays as Non-Working Days 

a. Select the Month from the drop-down list for which Saturday has to be configured as Non-working 

days. 

b. Select the checkbox for dates which you want to configure as Non-working days. 

c. Enter the Remarks. 

d. Click the Choose File button to upload any supporting document. 

Note: You can upload PDF/JPEG file with 500 KB in size. 

e. Click the SUBMIT button. 

  



 

 

 

  

f. A success message is displayed that data has been updated successfully. 

  



 

 

 



 

 

Transfer of Charge 

FAQs > Transfer of Charge 

1. What will happen to pending work items in case I transfer the charge 

from one Tax Official to another Tax Official? 

In case charge is transferred from one Tax Official to another, the pending work items will also get 

transferred to the Tax Official. 

2. Can a Supervisory Authority execute a Transfer of Charge for 

subordinates? 

Only the State Admin or Sub-State Admin can transfer the charge from one Tax Official to another Tax 

Official. 

3. If a Tax Official has multiple roles and his/her charge is transferred, will 

the transfer be applicable to all roles? 

During Transfer of Charge, the State Admin or Sub-State Admin can select the roles to be transferred. 

4. Can a Supervisory Authority execute a Transfer of Charge for 

subordinates in one go? 

No, the Transfer of charge can be carried out for only one Tax Official at a time.  

5. I am unable to transfer the charge to the intended Tax Official. What 

should I do? 

Check if the transferee is on leave because charge cannot be transferred to Tax  Officials in case their 

access is blocked due to leave applied by them. 

6. The charge was transferred from one Tax Official to another. Can it be 

given back to the original Tax Official? 

In case charge is to be handed back to the original Tax Official, the process for transfer of charge has to 

be undertaken again. 



 

 

7. Once the charge is transferred, will the Tax Official need fresh login 

credentials to access the new role? 

Tax Officials can continue to use their existing login credentials. Their respective Dashboards will be 

updated with their new roles once the Transfer of Charge is executed successfully in the sy stem. 



 

 

 

Manual > Transfer of Charge 

I am a BO State / Sub-State Admin, I need to transfer a role / charge from 

one user to another. How can I transfer charge in the GST Portal? 

To transfer the charge from one BO user to another BO user in the GST Portal, perform following steps:  

  

1. Access the GST Portal. The GST Home page  is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click Services > Admin > Transfer of Charge  command.  

  

 

  

The Transfer of Charge page is displayed.  

4. In the Enter Username field, enter the user whose charge is to be transferred 

5. Click the Go button. 

  

 

  

6. The Charge Allocated section is displayed at the bottom of the page. The Role Type available with the 

user are displayed with an option to select multiple roles. Select the charge to be allocated. 

7. Select the Effective Date from when the transfer of charge will be effective using the calendar. 

8. Click the TRANSFER CHARGE button. 

  



 

 

 

  

9. In the User Name field, enter the name of the user to whom the charge is to be transferred.  

10. From the Designation drop-down list, select the designation of the user. 

  

 

  

11. Under the List of the Officials section , select the Name of the Official to whom the charge is to be 

transferred, and then click the Transfer button.  

12. In the Remarks section, enter the remarks in context to the charge transfer.  

13. Click the Choose File button to attach the supporting transfer order. It is mandatory to attach the 

transfer order while transfering a charge from one user to another. 

14. Click the ALLOCATE button. 

  



 

 

 

  

15. Click the PROCEED button.  

  

 

  

The Transfer Confirmation message is displayed on successful transfer of charge. 

  



 

 

 



 

 

Target Allocation 

FAQs > Target Allocation 

1. What are the user goals of this functionality? 

BO Users can allocate functional targets for different periods (months) for different financial years to 

officers in their jurisdiction.  

2. Which types of Admins can execute this functionality on the GST Portal? 

The BO State Admin can do so for the entire state. 

The BO Office - Sub State Admin can do so for the jurisdiction assigned. 

3. From where can I access this functionality? 

As a BO Admin (State or Office), you can access this functionality from the post login dashboard.  

4. How do I execute this functionality? 

To execute this functionality, please perform the following steps: 

  

Step Action description 

  Target allocation 

MF-1      User accesses Target Allocation 

MF-2      By default, list of users will appear which are under the jurisdiction of the user 

MF-3      Alternatively user selects role type with jurisdiction combination 

MF-4      List of officials matching the search criteria appears 

MF-5      User selects the period for which target is to be allocated by selecting Financial Year & Month 

MF-6      Basis the selection existing target is displayed 

MF-7      User selects officials for whom targets need to be allocated/changed 

MF-8      User can edit the record to update the target 

MF-9      User sets target and confirms the same 

MF-10   Target is available for individual to view in his Dashboard, User selects period to view target 

allocated 



 

 

MF-11   Alternatively, 

Target can be allocated by a BO State Admin to any User in the State 

Target can be allocated by a BO office Admin to any User in the jurisdiction assigned.  

  View Target 

MF-12   Any user can view his targets in the dashboard 

MF-13   System will updated the achieved target for the User. E.g.: Registration approved , Revenue 

collected etc., 

MF-14   User will select year and basis that selection targets allocated for all functions will be 

displayed to him month wise 

MF-15   User will be also provided with achievement figures of targets as per system and as per his 

own input 

  

5. Does a BO Common User have access to this functionality? 

Yes, Tax Officials would be allowed to allocate targets to their junior Officials only within their own 

jurisdiction and one more step lower. 

6. When can I allocate targets? 

Target can be allocated during any month of the current financial year.  

7. Are targets allocated on a monthly or yearly basis? 

Target allocation will be for months only. Yearly values will be aggregated as per values available for the 

months. 

8. I want to change the targets for the previous year? 

Targets cannot be changed for previous financial year. 



 

 

Manual > Assign Target 

How can I assign targets to junior officials in my jurisdiction at GST Portal? 

To assign targets to junior officials in your jurisdiction, perform following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Services > Work > Target Allocation command.  

 

 

  

4. Click the Assign Target tab. 

5. In the Financial Year and Month drop-down list, select the financial year and month for which you 

want to allocate targets. 

6. To search for the Tax Official to whom you want to assign targets, perform following steps:  

  

Search using Advance Search Options 

a. Click the Advance Search link. 

b. In the Role Type drop-down list, select the role of the Tax Official to whom you want to assign the 

targets. 

c. In the Name of the Current Official field, enter the name of the Tax Official to be searched and click 

the Search icon. 

d. In the Zone and Ward drop-down list, select the Zone and Ward of the Tax Official to whom you want 

to assign the targets. 

  

7. Click the SEARCH button.  



 

 

 

 

  

The List of Officials matching the search criteria are displayed. 

8. Select the Name of the official and a green tick will appear next to the official’s name. 

9. Click the ASSIGN button.  

Note:You can click the EDIT link to edit the targets and click the View Achieved link to view the achieved 

targets. 

  

 

  

10. The Assign Target page is displayed. Enter the targets under various heads. 

11. Click the ASSIGN button. 

  



 

 

 

 

  

12. Click the PROCEED button. 



 

 

 

 

  

A success message is displayed that the target has been assigned.  

 

 

  

After the targets are allocated: 

• The officer to whom targets are allocated can view the targets in his/her Dashboard.  

• Achieved targets are updated against the achieved target in the Dashboard. The percentage of target 

achieved will change basis the target newly assigned. 

  



 

 

Manual > View Target 

How can I view the targets assigned to me at GST Portal? 

To view the targets assigned to you, perform the following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Services > Work > Target Allocation command.  

 

 

  

4. In the Financial Year drop-down list, select the financial year for which you want to view the targets. 

5. Click the VIEW TARGET button. 

The target is displayed for the selected financial year. 

Note: To update the achievement against the allocated targets, click the UPDATE ACHIEVEMENT 

button. 

 

 



 

 

  



 

 

Manual > Update Achievements 

How can I update the achievements against the targets assigned to me at 

GST Portal? 

To update the achievements against the targets assigned to you, perform following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Services > Work > Target Allocation command. 

 

 

  

4. In the Financial Year drop-down list, select the financial year for which you want to update the targets. 

5. Click the VIEW TARGET button. 

The target is displayed for the selected financial year. 

6. Click the UPDATE ACHIEVEMENT button. 

 

 



 

 

  

7. The Update Achievement page  is displayed. Update the achievement against the allocated targets. 

Click the SAVE button. 

  

  

  

8. Click the PROCEED button. 



 

 

 

 

  

A success message is displayed that the target achieved has been updated.  

 

 



 

 

Broadcast Message 

FAQs > Broadcast Message 

1. What is a broadcast message? 

Broadcast message is a kind of information circulated among the specific selected audience/ group(s ) by 

the authority. 

2. Who can broadcast message on the GST Portal? 

BO State Admins can broadcast message on the GST Portal post login.  

3. Is there any way for me to see a list or an archive of previous messages 

pushed for broadcast? 

Broadcasts shall be stored and displayed to the broadcaster for 3 years from date of issuance depending 

on the category of broadcast. Broadcast shall be stored in the receiver’s dashboard for <X> days as 

determined by the broadcaster. 

4. Who can see the broadcast message? 

Broadcast message can be seen by the selected recipient for a message as per role type or jurisdiction 

when a new broadcast is created. 

5. What are the type of messages that can be broadcasted?   

The user can enter any information that he/she wants to communicate to the Tax Officials. 

6. Is there any size limit to broadcast a message? 

Message description cannot exceed 4000 characters. 

7. Broadcast messages are available till what time to the receiver? 

Broadcast messages are available in the receiver’s dashboard for <X> days as determined by the 

broadcaster. 



 

 

8. Will CBEC and Model 1 States have access to broadcast message on the 

GST Portal? 

CBEC and Model 1 states will not have access to broadcast message on the GST Portal.  



 

 

Manual > Broadcast Message 

How can I broadcast a message or a document to a group? 

To broadcast a message or to broadcast a document to a group of people, perform the following steps:  

  

1. Access the GST Portal. The GST Home page  is displayed. 

2. Using your valid credentials, login to the GST Portal. 

3. Click Services > Admin > Broadcast Message  command.  

  

 

  

The New Broadcast page is displayed. 

4. In the Title of Message field, enter the title of the message. 

5. In the Message Content field, enter the description of the message. 

Note: Message description cannot exceed 4000 characters. 

6. In the To be made visible for (in days) field, enter the number of days the message should be visible 

to the audience. 

7. In the Issued By field, enter the name of the person who is issuing the message. 

8. Select the checkbox for Jurisdiction. 

9. Click the Choose File button and attach the document to be published. 

10. From the Audience drop-down list, select the audience who will receive the message. 

11. Click the BROADCAST button. 

  



 

 

 

  

12. A confirmation message is displayed. Click the CONFIRM button. 

  

 

  

A confirmation message is displayed that the message has been broadcasted.  

  

 

  



 

 

Blocking/ Unblocking ITC of a Taxpayer 

FAQs > Blocking/ Unblocking ITC of a 
Taxpayer  

1. What is blocking of ITC in Electronic Credit Ledger? 

The Jurisdiction Officer of a taxpayer may scrutinize the amount of ITC claimed by a taxpayer through 

GST TRAN-1 and GST TRAN-2 etc. for its authentication. The concerned Jurisdiction Officer may decide 

to temporarily block the ITC available to a taxpayer, wherever it is felt that further investigation is required, 

in the interest of the revenue. The Jurisdictional Officer may block CGST, SGST, IGST & Cess balance in 

whole or in part. 

The Jurisdictional Officer after investigation may unblock the ITC, that was previously blocked.  

An email and SMS is sent to the taxpayer for blocking or unblocking of ITC. 

2. Who can block ITC of a taxpayer? 

Any Jurisdictional Officer of CBEC authorized by CBEC may block/ unblock ITC of a taxpayer.  

Any Jurisdictional Officer of a State authorized by State Tax Department may block/ unblock ITC of a 

taxpayer. 

3. Which kind of taxpayer’s ITC will be blocked? 

The ITC will be blocked for taxpayers for whom there is sufficient balance in the Electronic Credit ledger.  

4. What is the path to block/ unblock ITC of a taxpayer? 

Navigate to Services > Taxpayer Account > Block/ Unblock Credit command to block/ unblock credit 

of a taxpayer. 



 

 

 

Manual > Blocking/ Unblocking ITC of a 
Taxpayer  

1. How can I block/ unblock ITC of a taxpayer? 

To block/ unblock ITC of a taxpayer, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal. The Tax Official’s Dashboard is displayed.  

3. Click the Services > Taxpayer Account > Block/ Unblock Credit Command. 

  

 

  

4. In the GSTIN field, enter the GSTIN of the taxpayer. 

5. Click the SEARCH button. 

  

 

  

The Block/Unblock Input Tax Credit page is displayed. 

  

Block Input Tax Credit 

Unblock Input Tax Credit 

Block Input Tax Credit 

1. Select the Block Input Tax Credit checkbox. 



 

 

  

 

  

2. Click the VIEW BALANCE IN ELECTRONIC CREDIT LEDGER button to view the balance in 

Electronic Credit Ledger of the taxpayer. 

  

 

  

3. Enter the reasons for temporary blocking of Input Tax Credit of the taxpayer.  

4. Enter the amount to be blocked. 

  

5. Click the SUBMIT WITH DSC button. 

  



 

 

 

  

The success message is displayed that amount is blocked. Click the CLOSE button. 

  

 

  

An email and SMS is sent to the taxpayer for blocking of ITC. 

Unblock Input Tax Credit 

1. Select the Unblock Input Tax Credit checkbox. 

  



 

 

 

  

2. Enter the reasons for unblocking of Input Tax Credit of the taxpayer. 

3. Enter the amount to be unblocked. 

4. Click the SUBMIT WITH DSC button. 

  

 

  

The success message is displayed that amount is unblocked. Click the CLOSE button. 

  



 

 

 

  

An email and SMS is sent to the taxpayer for unblocking of ITC. 





 

 

MIS Reports 

Overview > MIS Reports 

Settlement Reports 

 FAQs 

 Manual  

Current Reports 

 FAQs 

 Manual  

MIS Reports 

 FAQs 

 Manual  

MIS Dashboard 

 FAQs 

 Manual  

  

  



 

 

Overview > MIS Reports 

Settlement Reports 

 FAQs 

 Manual  

Current Reports 

 FAQs 

 Manual  

MIS Reports 

 FAQs 

 Manual  

MIS Dashboard 

 FAQs 

 Manual  

  

  

  



 

 

Settlement Reports 

FAQs > Settlement Reports 

1. What is a Settlement of Accounts between Centre and States? 

During GST regime, liability under SGST or CGST can be settled by using the ITC available under IGST 

and vice versa. It involves transfer of funds between Centre and State depending upon the amount of ITC 

utilised from one major head for the liability under other major head. 

Settlement between CGST and IGST is done through book adjustment. Settlement also occurs on 

account of B to C inter-State supplies, based on destination based consumption princ iple. 

2. Will CBEC and Model 1 States have access to Settlement reports? 

No. Settlement Reports are displayed on GST Portal for Tax Authorities of Model 2 States. CBEC and 

Model 1 States can access the data through the G2G API. 

3. Can I download the Settlement reports? 

Yes. The Settlement reports can be viewed only after downloading. Report will be downloaded in a 

password protected zip containing report in Excel (.csv) format. 

Note: Check the Downloads folder of your computer, to view the downloaded file. While downloading, 

the file may be downloaded in another location of your choice, as specified by you.  

4. Can State Tax Authorities view the Settlement Reports for the Centre? 

No. State Tax Authorities can view the IGST-SGST Settlement Reports for their States only. 

5. Can Central Tax Authorities view the Settlement Reports for the State? 

No. Central tax authorities can view only CGST settlement reports for the whole country . 

6. Who has access to the Settlement Ledger report? 

The State Commissioner has access to this report. The report can be accessed from Services > 

Settlement Report menu. 

However, the State Admin, on direction from the State Commissioner, can assign "View Settlement" role 

to additional designated officers, who will then have access to this report. 



 

 

7. What is the periodicity of settlement reports? 

Settlement Reports will run only once in a month for entire India. Reports of ‘M’ month will capture only 

the data reported/ processed up to <20th> of ‘M’ month. 

8. Does settlement between States is also included in these reports? 

No. Settlement reports are only about settlement between State and Centre.  

  



 

 

Manual > Settlement Reports 

1. How can I view the Settlement Report? 

To view the Settlement reports, perform following steps: 

  

1. Access the GST Portal for Tax Officials. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal for Tax Officials.  

3. Click the Services > Settlement Reports option. 

  

 

  

4. Select the Year and Month for which you want to view the reports using the drop-down list. 

5. Click the GO button. 

  

 

  

6. The Consolidated Settlement Register is displayed.  

  

 



 

 

  

6.1. You can click the SAVE AS EXCEL button to download it in excel format. 

  

 

  

7. The report is downloaded in excel format. 

  

 



 

 

  

6.2. Click the link under Details column to view the details. 

Amount to be credited: Amount receivable from Centre to State/UT 

Amount to be debited: Amount payable by State/UT to Centre 

Net Settlement Amount: Summation of amount to be credited and debited 

  

 

  

7. Settlement of accounts between Centre and State/UT relating to Returns is displayed.  

  



 

 

 

  

7.1. You can click the SAVE AS EXCEL button to download it in excel format. 

  



 

 

 

  

8. The report is downloaded in excel format. 

  



 

 

 

  

7.2. You can click the Download link available under the Download column, to the right of the report 

name, to download the report. 

  



 

 

 

  

In case the total amount is a positive figure, the amount will be received from Centre to State. In case the 

total is a negative figure, the amount will be payable by State to Centre. 

  

Here is a short description of the Settlement Ledger Reports available at the GST Portal for view of 

authorised Tax Officials. 

  

Report Description 



 

 

Number 

01.02 

List of registered persons of the State or Union Territory who 

have adjusted liability of Integrated Tax from the input tax credit 

of State Tax or Union Territory Tax and Central Tax, as provided 

under section 53 of the Central Goods and Services Tax Act and 

the State Goods and Services Tax Act, or section 21 of the Union 

Territory Goods and Services Tax Act (including cross utilisation 

by Input Service Distributor), as the case may be, in FORM GST 

STL – 01.02. 

01.03 

List of registered persons of the State or Union territory who have 

adjusted liability of State Tax or Union 

Territory Tax, as the case may be, from the input tax credit of 

Integrated Tax, as provided under section 18 of the Integrated 

Goods and Services Tax Act, in FORM GST STL – 01.03. 

01.04 

List of registered persons of other State or Union Territory who 

have made outward inter-State 

supply, including Input Service Distributor distribution, to 

unregistered persons or units of the 

concerned State or Union Territory or taxpayers who have made 

exports or have made supplies to 

SEZ on payment of tax, including non filers who have Integrated 

Tax credit available with them , 

in FORM GST STL – 01.04. 

01.05 

List of registered persons of other State or Union Territory who 

have made inter-State supply to 

composition taxable person or Non-resident taxpayer or Unique 

Identification Number holders of 

the State, in FORM GST STL – 01.05. 

01.06 

List of registered persons of other State or Union Territory who 

have made inter-State inward 

supplies for which input tax credit is declared as ineligible as 

provided for in section 17 of the 

Central Goods and Services Tax Act and State Goods and 

Services Tax Act and section 21 of the 

Union Territory Goods and Services Tax Act, or whose 

Integrated tax input tax credit has lapsed 

due to opting into composition scheme as provided for in sub-

section (4) of section 18 of the 

Central Goods and Services Tax Act and State Goods and 



 

 

Services Tax Act or whose input tax 

credit of Integrated tax has lapsed due to cancellation of 

registration, in FORM GST STL – 01.06. 

01.07 

List of registered persons in a State or Union Territory who have 

made inter-State inward supplies on 

which input tax remains unutilised till end of September of the 

subsequent financial year and thus 

input tax credit on Integrated Tax paid is not available as per 

sub- section (4) of section 16 of Central 

Goods and Services Tax Act and State Goods and Services Tax 

Act and section 21 of the Union 

Territory Goods and Services Tax Act, and the said Integrated 

Tax paid is to be apportioned under 

section 17 of the Integrated Goods and Services Tax Act, in 

FORM GST STL – 01.07. 

01.08 

List of unregistered persons who have made imports in the 

concerned State or Union Territory, 

under clause (d) of sub-section (1) of section 17 of the Integrated 

Goods and Services Tax Act, in 

FORM GST STL – 01.08. 

01.09 

List of composition taxpayer or Unique Identification Number 

holders in a State or Union Territory 

who have made imports, in FORM GST STL – 01.09. 

01.10 

List of registered persons in a State or Union Territory who have 

made imports, on which input tax 

credit is declared as ineligible as provided for in section 17 of the 

Central Goods and Services Tax 

Act and State Goods and Services Tax Act and section 21 of the 

Union Territory Goods and 

Services Tax Act, in FORM GST STL – 01.10. 

01.11 

List of registered persons in a State or Union Territory who have 

made import on which input tax credit 

remains unutilised till end of September of the subsequent 

financial year and thus input tax credit on 

Integrated Tax paid is not available as per sub-section (4) of 

section 16 of Central Goods and Services 

Tax Act and State Goods and Services Tax Act and section 21 of 

the Union Territory Goods and 

Services Tax Act, and the said Integrated Tax paid is to be 



 

 

apportioned under section 17 of the 

Integrated Goods and Services Tax Act, in FORM GST STL – 

01.11. 

01.12 

List of registered persons in a State or Union Territory who have 

paid interest on Integrated Tax, in 

FORM GST STL – 01.12. 

  

8. Click the DOWNLOAD button.  

  

 

  

9. The report is downloaded in zip format. Note the password displayed on the screen which needs to be 

entered to view the report. 

Note: Check the Downloads folder of your computer, to view the downloaded file. While downloading, the 

file may be downloaded in another location of your choice, as specified by you.  

  

 

  

10. Unzip the file using the Tool-7 zip and open the report in excel format. 

  



 

 

 

  

11. In the Enter password field, enter the password displayed on the Download screen.  

12. Click the OK button. 

  

 

  

The downloaded report is displayed in the excel format. 

  



 

 

 

  

  



 

 

Current Reports 

FAQs > Current Reports 

1. Who all can generate MIS Reports?  

All Tax Officials can generate MIS reports for their respective jurisdictions level as per access rights.  

E.g. Every senior and supervisory officers (Level1, Level 2 etc.) would be able to view and generate 

reports in respect of formations under their administrative charge as per access rights.  

2. In which formats can MIS Reports be downloaded? 

MIS reports can currently be generated in PDF and CSV formats.  

Note: The functionality to download the reports in the Excel format will be available shortly. 

3. Which reports are available for download in the GST Portal at present? 

The following reports are available for viewing and downloading by the Tax Officials:  

  

Report Name Access Available To Description 

Summary of Approved 

Registrations 

(Voluntary/Others) 

Based on Type of 

Taxpayer 

All Tax Officials for 

their respective 

jurisdictions level 

This report provides a summary of Taxpayer-wise approved 

registrations in the Tax Official’s jurisdiction, for the 

registration types – Voluntary Registration and Other 

Registration. 

Registration 

Application Register 

All Tax Officials for 

their respective 

jurisdictions level 

This report provides a summary of all the ARNs of Registration 

applications filed in a Tax Official's jurisdiction. The data in 

this report is collated on the basis of selected application 

statuses and type of Taxpayers within a specified date range. 

Casual Taxpayer’s 

Details Report 

All Tax Officials for 

their respective 

jurisdictions level 

This report for Casual Taxpayers provides details on the basis of 

their Registration jurisdiction and GSTIN. In case of Casual 

Taxable persons, the reason of liability to obtain Registration is 

defaulted to “Voluntary Registration”. This report extracts 

Taxpayer-wise information on their GSTIN, dates of entering 

and exiting the scheme, amounts of money deposited as 

advance, tax payable, tax paid, ITC received, ITC utilized, and 

outstanding amounts, if any. 

Summary of 

Collection Report 
based on Type of 
Taxpayer  

All Tax Officials for 

their respective 

jurisdictions level 

The report provides amount of tax collected at specific 

level based on:  

1) IGST 

2) CGST 

3) CESS 

4) SGST/UTGST 



 

 

Tax Collection List  
All Tax Officials for 

their respective 

jurisdictions level 
This report provides taxpayer level tax collection report. 



 

 

Manual > Current Reports 

How can I as a Tax Officer generate a report? 

The steps to generate any MIS report are given below:  

Note: The steps to generate any MIS report are same. Only the steps to enter report generation criteria 

can be report specific. 

1. Login to the Tax Official’s interface of GST Portal with your Tax Officer’s login credentials.  

2. In case you are assigned multiple roles, select the role under which you want to generate this report. 

3. Click the MIS link in the menu header bar to display the MIS Dashboard screen.  

  

 

  

4. Under the Registration Reports section towards right hand side, click the report name. In this 

example, we have selected the Summary of Approved Registrations (Voluntary/Others) Based on Type of 

Taxpayer link. 

Note: This report can be generated by Tax Officials of Level-1, Level-2 and Level-3. 

  

 

  

5. Enter the criteria for report generation. In this example, the fields of State and Head Quarter are auto-

populated and can’t be changed, since they relate to the Tax Official’s selected role and jurisdiction. Enter 

the Date range in the From Date and To Date fields. 

  



 

 

 

  

6. Click SUBMIT. 

  

 

  

7. Report will get generated and will be displayed on the screen. 

8. Report can be downloaded in PDF or CSV formats. 

  

 

  



 

 

8A. Click the PDF icon to download the report in PDF Format, which looks like the sample shown below.  

  

 

  

8B. Click the Excel icon to download the report in CSV Format, which looks like the sample shown below.  

  

 

  

If level 1 officer has logged in and selected zone, division and ward, then only ward specific report will be 

generated. In case no further lower level is selected then next level (here it is ‘Zone’) wise report will be 

generated.  



 

 

MIS Reports 

FAQs > MIS Reports 

1. Who has access to MIS reports? 

All Tax Officials including Head of the Department can generate MIS reports (Java based Jasper Reports) 

for their respective jurisdictions. Every senior and supervisory officers (Level1, Level 2 etc.) would be able 

to view and generate these reports in respect of formations under their administrative charge.  

2. Which role can view MIS reports? 

"View Jurisdiction Records" Role can view MIS reports.  

3. Who can assign role to view MIS reports? 

The role to view MIS reports can be assigned by State admin. While assigning the role, the jurisdiction 

should be marked as Primary. 

4. Can I download MIS reports? 

Yes, you can download MIS reports in PDF or XLSX format. 

5. Which reports are available for download in MIS reports at GST Portal? 

The following reports are available for viewing and downloading by the Tax Officials:  

Note: These reports are accessible to all Tax Officials for their respective jurisdictions level. 

  

S.No. 
Report 

Number 
Report Name Description 

Registration 

1 1.01  

Disposal and 

Pendency of New 

Registration 

Applications  

This report provides count of disposed and pending 

registration applications in the selected time period. In this 

report, day wise break up of pending application is also 

provided along status of SCN issued or not. Report is also 

helpful in keeping the track of number of application 

received and processed in a particular time period.  

  

Click here to view the screenshot. 



 

 

2 1.02  

Mode of 
Approved New 
Registration 

Applications and 
Break up 
Pendency  

The report provides number of new registration 

applications which are deemed or manually approved. This 

report also provides number of pending applications for the 

selected time period.  

  

Note: If the Officer's Details are blank, the Registration 

Application is aligned to Center. 

  

Click here to view the screenshot. 

3 1.03  

Summary of 

Approved 
Registrations 
(Voluntary/ 

Others) based 
on Type of 
Taxpayer  

The report provides count of approved registrations based 

on Registration type for each type of taxpayer.  

  

Note: The report provides the count based on the time 

range selected by the user using the From and TO date 

filters.  

  

Click here to view the screenshot. 

4 1.04 

Summary 
Registered 
Taxpayers 

(Composition/ 
Normal) during a 
Period  

The report provides count of taxpayers registered under 

composition and other than composition in the selected 

time period.  

  

Note: Here, column 5 indicates the number of registered 

taxpayers based on the change of jurisdiction by the Tax 

Official from the Tax Officials Interface.  

  

Click here to view the screenshot. 

5 1.05 

Disposal and 

Pendency of 
Amendment 
Applications  

The report provides number of amendment applications 

(core amendment only) with status of disposal and 

pendency.  

  

Note: When generating this report, in case users observes 

that in the reports some ARN do not show with the 

associated officer’s name, it implies that ARN is with 

central jurisdiction for processing. 

  

Click here to view the screenshot. 

6 1.06 

Summary of 
Approved 
Amendment 

Applications 
based on Nature 

The report provides number of approved amendment 

applications for core amendments, only bifurcated further 

into, taxpayer wise. 

  



 

 

of Amendment  Click here to view the screenshot. 

7 1.07 

Disposal and 
Pendency of 

Cancellation on 
Application  

The report provides disposal and pendency statistics of 

Application filed for cancellation for the selected time 

period (From-to).  

  

Note: This reports provided details for cancellations 

initiated by taxpayer ONLY and will not cover suo moto 

proceedings for cancellation initiated by Tax offic ials. 

  

Click here to view the screenshot. 

8 1.08 

Summary of Suo 

Moto 

Cancellations 

The report provides information about Number of 

taxpayers whose registration has been cancelled by the 

Authority and age wise detail of pending notices within the 

selected from-to time period.  

  

Click here to view the screenshot. 

9 1.09 

Number of 

Cancellations 
done by Reason 
during a Period  

The report provides number of Registrations cancelled due 

to various reasons during a selected period (From-to). This 

report includes taxpayer initiated cancellations as well as 

tax official’s initiated suo-moto cancellations. 

  

Click here to view the screenshot. 

10 1.10a 

Registration 
Application 

Register (New 
Registrations)  

The report provides list of registration applications filed 

during the input Period along with status of each 

application.  

  

Note: The report provides the list of ARNs generated 

between the time period selected by user using the From 

and TO date filters. 

  

Report displays one of the following status for each ARN 

“approved”, “Pending”, “Rejected”, “Clarification pending”.  

  

If status of an ARN is NOT “A”, it implies that ARN is not 

approved and hence there will not be any GSTIN for that 

specific ARN. 

Click here to view the screenshot. 

11 1.10b 
Registration 
Application 

Register 

The report provides list of registration applications for 

migrated taxpayers filed during the input Period along with 



 

 

(Migrated 
taxpayer)  

status of each application.  

  

Note: The report provides list of registration applications 

filed by migrated taxpayers filed from 8th November, 2016 

till yesterday. 

  

Click here to view the screenshot. 

12 1.11 

Number of 

Taxpayers based 
on Constitution / 
Nature of 
Business  

The report provides number of taxpayers based on: 

1. Constitution of Business 

2. Nature of Business  

  

Note: This is a summary report and displays the count of 

taxpayers whose registration has been approved based of 

Constitution of Business or Nature of business as selected 

in the Enrolment/ Registration application till date (i.e. As 

on date). 

  

Click here to view the screenshot. 

13 1.12 

Summary of 

Taxpayers with 
Single/Multiple 
Registrations 
based on PAN  

The report provides count of taxpayers having single or 

multiple registrations based on single PAN within and 

outside the State.  

  

Click here to view the screenshot. 

14 1.13 

Summary of 

Status of 

Revocation 

Application  

The report provides information about action taken on 

revocation application submitted between selected time 

period by  

1. Proper Officer 

2. Appellate Authority 

  

Click here to view the screenshot. 

15 1.14 

List of Taxpayers 
based on 
Constitution of 

Business/Nature 
of Business  

The report provides list of taxpayers of specific lowest level 

based on: 

1. Constitution of Business 

2. Nature of Business  

  

Click here to view the screenshot. 

16 1.15 
Amendment 
Applications 
Register  

The report provides list of amendment applications (core 

field only) submitted during the period selected using the 

From and To date filter. Report displays one of the 



 

 

following status for each ARN i) Approved ii) Rejected iii) 

Pending iv) Clarification pending.   

  

Click here to view the screenshot. 

17 1.16 

List of 

Revocation 

Application 

The report provides list of revocation applications (GSTIN 

wise) submitted in the selected Input Period along with the 

disposal status of each application. 

  

Click here to view the screenshot. 

18 1.17 

List of Taxpayers 

with 

Single/Multiple 

Registrations 

The report provides count of Taxpayers having: 

1. Single PAN and Single GSTIN/UIN within State based 

on single/multiple nature of business  

2. Single PAN and Multiple GSTIN/UIN within State 

3. Single PAN and Multiple GSTIN/UIN across States 

  

Click here to view the screenshot. 

19 1.18 

List of Suo-moto 

Cancellation and 

Cancellation on 

application  

This report provide list of those GSTINs whose registration 

is cancelled either on application (REG-16) or Suo-moto in 

the selected time period. User can search the status based 

on single GSTIN (of that jurisdiction).  

  

Click here to view the screenshot. 

20 3.17 

Allotment of 

Provisional IDs 

against 

Enrollment 

Application  

The report provides details of allotment of provisional IDs 

against Enrolment application.  

  

Click here to view the screenshot. 

Payments 

21 2.01 

Summary of 

Collection Report 
based on Type of 
Taxpayer  

The report provides amount of tax collected at specific 

level based on type of taxpayer.  

  

Click here to view the screenshot. 

22 2.02 

Tax Paid and 

Summary of 

Defaulters 

The report provides details of payment defaulters based 

on selected Type of Return.  

  

Click here to view the screenshot. 

23 2.03 
Summary of 
Outstanding 
Liability  

The report provides outstanding liabilities based on: 

1. Arising out of Return 

2. On Account of Mismatch 



 

 

3. Other than Returns  

Hyperlink exists on Column Header. 

  

Click here to view the screenshot. 

24 2.04 Mode of Payment 
for Tax Collection  

The report provides amount of tax collection mode of 

payment wise for selected Input Period.  

  

Click here to view the screenshot. 

25 2.05 
Lowest unit wise 
Daily Tax 

Collection  

The report provides taxpayer type wise tax collection for a 

selected single day (as on date).  

  

Click here to view the screenshot. 

26 2.06 

Lowest Unit Wise 

Monthly 

Collection  

The report provides monthly tax collection for multiple 

lowest levels. 

  

Click here to view the screenshot. 

27 2.07a 
Tax Collection 
List Monthly 
Basis  

The report provides taxpayer level tax collection report for 

selected month. The report is generated for Lowest level 

available.  

  

Click here to view the screenshot. 

28 2.07b 
Tax Collection 

List Daily Basis  

The report provides taxpayer level tax collection report for 

the selected date (single day As on Date). The report is 

generated for Lowest Level available.   

  

Click here to view the screenshot. 

29 2.08 
Tax Collection 
List (debit 
utilization)  

This report displays tax collection for during and upto the 

month based on debited from Electronic Cash Ledger of 

the selected taxpayers. 

  

Click here to view the screenshot. 

30 2.09 
List of Taxpayers 
with Outstanding 

Liabilities  

The report list of taxpayers having outstanding liabilities on 

the selected particular date.  

The report displays total Outstanding liability not paid by 

taxpayers till date (As on Date). 

  

Click here to view the screenshot. 

31 2.10 
Payment 

Register of 

The report provides details of Payment made by 

Unregistered Persons. 



 

 

Unregistered 

Taxpayers 

  

Click here to view the screenshot. 

32 2.11 
Enforcement 

Collections 

The report provides the delay in depositing the amount 

collected from taxpayers by tax officials.  

  

Click here to view the screenshot. 

33 2.12 
Remittance 

Defaulter Banks  

The report provides the list of Banks Defaulting in 

Remitting the Tax Collected on behalf of the Government  

with in prescribed time. 

Note: This is a daily report (Current Date (By default)). 

Reports are available for earlier dates also. 

  

Click here to view the screenshot.  

Returns 

34 3.01 
State Level Inter 

State Supply 

The report provides information about taxable turn over 

(outward & inward) and IGST (payable and receivable) for 

State Level interstate supply based on selected type of 

Taxpayer. 

  

Click here to view the screenshot.  

35 3.03 
Mode of Signing 
Return Form  

The report provides mode wise count of return forms 

signed and filed during the selected input period.  

  

Click here to view the screenshot. 

36 3.05 

Summary of 

Taxpayers 

making Inter-

State Purchases 

but not filing 

Valid Return 

The report provides count of non/short filers, amount of 

inward supplies and IGST involved and State’s SGST 

share. 

  

Click here to view the screenshot. 

37 3.06 

Aggregate 

turnover Wise 

classification of 

taxpayers 

This report provides classification of taxpayers and growth 

percentage based on input range provided for aggregate 

turnover, taxable turnover, ITC utilized, tax payment and 

selected type of taxpayers for single/multiple tax periods.  

  

Click here to view the screenshot. 

38 3.08 
List of Return 

Defaulters  

The report provides list of defaulters (non-filers /short 

filers) based on: 

1. Return Form Number 



 

 

2. Type of Taxpayer 

With estimated tax liability. 

  

Click here to view the screenshot. 

39 3.10 

Casual 
Taxpayer’s 
Details Report  

This report provides list of active Casual taxpayers for the 

selected time period.  

User can also view the details for a single GSTIN.  

  

Click here to view the screenshot. 

40 3.11 

Non Resident 

Taxpayer's 

Details Report 

The report provide details of turn over, deposited advance 

tax, tax liability, tax paid etc. of Non Resident taxpayers 

within selected time period. User can also see the status of 

various fields (as given above) related to specific Non 

Resident Taxpayer based on GSTIN. 

  

Click here to view the screenshot. 

41 3.12 

Composition 
Taxpayer 
changed to 

Normal Taxpayer 
within Specified 
Period  

The report provides list of taxpayers changed from 

Composition to Normal type within the specified period 

along with reason of opting out. 

  

Click here to view the screenshot. 

42 3.13 

List of Normal 
Taxpayers 
Changed to 

Compounding 
within Financial 
year  

The report provides list of normal taxpayers opting for 

composition with other details like ARN, date of filing, 

constitution of business, etc.     

  

Click here to view the screenshot. 

43 3.15 

Taxpayer's 

Turnover Details 

- GSTR- 3B 

The report provides turnover details of taxpayer's as 

indicated in Form GSTR-3B. 

  

Click here to view the screenshot. 

44 4.06 

Details of 
taxpayers whose 
credit has been 

blocked or un-
blocked  

The report provides taxpayer level detail whose credit has 

been blocked or un-blocked.  

  

Click here to view the screenshot. 

4. When I generate the report I am unable to find details of the registration/ 

taxpayers as per current jurisdiction. Why? 



 

 

In certain cases, jurisdiction of a taxpayer is transferred. In such cases, post transfers, details of the 

registration/ taxpayers will be visible in the older jurisdiction for the period registration/ taxpayers were in 

previous jurisdiction. 

However, post transfer is approved, the details of the registration/ taxpayers will be visible in the new 

jurisdiction from the period registration/ taxpayers were in new jurisdiction 

5. Whether these reports show real time data? 

These reports shows by default previous date data (T-1 date). At few occasions, it may be of earlier date, 

if the reporting data is not updated. An update to show the date of data on the report is also planned and 

shall be available soon. 

6. What are the features of MIS reports? 

There are multiple features available to Tax Officials to filter/sort the data in the MIS reports before 

downloading the report:  

 Drill Down  

 Hyperlink  

 Sorting on a Column - Ascending Order 

 Sorting on a Column - Descending Order 

 Hiding a Column 

 Searching for a Value 

 Resizing Column width 

 Conditional formatting 

 Downloading reports 

  

Drill Down  

  

Drill down feature helps tax official drill down to the lowest level. There is no requirement of selecting the 

post/designation as, it will be available by default. If a Senior officer wants to view the report in respect of 

his subordinate jurisdiction/formation only, he may select accordingly. 

  

For example: For the report below Punjab is auto-populated in Level 1 and Amritsar is Level 2. Click on 

Amritsar, which further drill downs to Amritsar 1 (Level 3). 

  



 

 

 

  

Click on Amritsar 1, which further drill downs to Amritsar 1-ward (Level-4). 

  

 

  

Report can be drilled down till lowest level available. 

  



 

 

 

  

Hyperlink  

  

Hyperlink feature provide details of each record. Hyperlink is available for the numbers mentioned in blue. 

Click the number to get the detail of each record.  

  

 

  

Details of each record: 

  



 

 

 

  

Sorting on a Column - Ascending Order 

  

Detailed Records can be sorted in Ascending order. To sort the data in ascending order, click Up arrow 

on top of the column. 

  

 

  

Sorting on a Column - Descending Order 

  

Detailed Records can be sorted in descending order. To sort the data in descending order, click Down 

arrow on top of the column. 

  



 

 

 

  

Hiding a Column 

  

A column can be hidden with ‘Hide Column’ Option. 

  

 

  

Column is hidden from the screen. 

  



 

 

 

  

Searching for a Value 

  

Tax official can search for particular value from the selected column and pull the report only for the 

matching results.  

  

 

  



 

 

 

  

  

 

  

Resizing Column width 

  

Tax official can resize the selected column.  

  



 

 

 

  

 

  

Conditional formatting 

  

Tax official can perform conditional formatting for particular values from the selected column and pull the 

report with same formatting.  

  



 

 

 

  

 

  



 

 

 

  

 

  

Downloading reports 

  

1.     Report can be downloaded in PDF/ XLSX formats. 

  



 

 

 

  

a. Click the PDF icon to download the report in PDF Format, which looks like the sample shown below. 

  

 

  

b. Click the XLSX icon to download the report in excel Format, which looks like the sample shown below. 

  



 

 

 

  

6. If I hide the column in online MIS report will the column be still available 

in downloaded report? 

No, hidden column will not be available in downloaded report. 



 

 

 

Manual > New Reports 

How can I as a Tax Officer generate New MIS Reports? 

The steps to generate any New MIS report are given below:  

Note:  

 The steps to generate any New MIS report are same. Only the steps to enter report generation 

criteria can be report specific.  

 These reports are Java based Jasper reports. 

 "View Jurisdiction Records" Role can view New MIS reports.  

  

1. Login to the Tax Official’s interface of GST Portal with your Tax Officer’s login credentials. 

2. Click the MIS > New Reports link in the menu header bar to display the New MIS Dashboard screen 

for New Reports.  

  

 

  

3. Under the folder Public > MIS Reports > Reports section towards left hand side, click the report name 

which is displayed on the right hand side.  

  



 

 

 

  

4. Click the report name. In this example we have selected ‘Tax Collection List Monthly’ report link.  

  

 

  

5. Enter the criteria for report generation. In this example, the field of Level 1 can’t be changed, since it is 

auto-populated as per Tax Official’s jurisdiction.  

6. Select the Financial Year and Month from the drop-down list. 



 

 

7. Select the appropriate options from drop down list of Level 2, Level 3, Level 4. 

  

 

  

Note: Levels will be auto populated till lowest level according to Alphabetical order. E.g. If a Tax Official 

has access to Annuppur and Bhopal-1 both wards, Annuppur will be auto populated first. However, 

Bhopal-1 will still be available for selection.  

8. Click the Apply button. 

  

 

  

9. Report will get generated and will be displayed on the screen. 

  



 

 

 

  

10. Report can be downloaded in PDF/ CSV/ XLSX/ PPTX formats. 

  

 

  

Sample screenshot is provided below for reports: 

Registration 

1. Disposal and Pendency of New Registration Applications 

  



 

 

 

  

2.1. Mode of Approved New Registration Applications and Break up of Pendency – Screen-1 

  

 

  

2.2. Mode of Approved New Registration Applications and Break up of Pendency – Screen-2 

  



 

 

 

  

2.3.  Mode of Approved New Registration Applications and Break up of Pendency- Hyper link 

  

 

  

3. Summary of Approved Registrations (Voluntary/ Others) based on Type of Taxpayer 

  



 

 

 

  

4. Summary Registered Taxpayers (Composition/ Normal) during a Period 

  

 

  

5.1.  Disposal and Pendency of Amendment Applications 

  



 

 

 

  

5.2.  Disposal and Pendency of Amendment Applications - Hyperlink 

  

 

  

6.1. Summary of Approved Amendment Applications based on Nature of Amendment  – Screen-1 

  



 

 

 

  

6.2.  Summary of Approved Amendment Applications based on Nature of Amendment  – Screen-2 

  

 

  

7. Disposal and Pendency of Cancellation on Application 

  



 

 

 

  

Summary of Suo Moto Cancellations 

  

 

  

8. Number of Cancellations done by Reason during a Period 

  



 

 

 

  

9.1 Registration Application Register (New Registration) – Screen-1 

  

 

  

9.2 Registration Application Register (New Registration) – Screen-2 

  



 

 

 

  

10.1.  Registration Application Register (Migrated tax payer) – Screen-1 

  

 

  

10.2.  Registration Application Register (Migrated tax payer) – Screen-2 

  



 

 

 

  

11. Number of Taxpayer based on COB/NOB 

  

 

  

12. Summary of Taxpayers with Single/Multiple Registrations based on PAN 

  



 

 

 

  

Summary of Status of Revocation Application 

  

 

  

  

13. List of Taxpayers based on Constitution of Business/Nature of Business  

  



 

 

 

  

14.1 Amendment Applications Register – Screen-1 

  

 

  

14.2 Amendment Applications Register – Screen-2 

  



 

 

 

  

List of Revocation Application 

  

 

  

List of Taxpayers with Single/Multiple Registrations 

  



 

 

 

  

  

15.1. List of Suo-moto Cancellation and Cancellation on application – Screen-1 

  

 

  

15.2. List of Suo-moto Cancellation and Cancellation on application – Screen-2 

  



 

 

 

  

Allotment of Provisional IDs against Enrollment Application 

  

 

Payments 

16. Summary of Collection Report based on Type of Taxpayer 

  



 

 

 

  

Tax Paid and Summary of Defaulters 

  

 

  

  

17.1.  Summary of Outstanding Liability  – Screen-1 

  



 

 

 

  

17.2. Summary of Outstanding Liability – Screen-2 

  

 

  

17.3 Summary of Outstanding Liability - Hyperlink 

  



 

 

 

  

18. Mode of Payment wise Tax Collection (Mode of Payment for Tax Collection) 

  

 

  

19. Lowest unit Wise Daily Tax Collection (Ward Wise Daily Tax Collection) 

  



 

 

 

  

Lowest Unit Wise Monthly Collection  

  

 

  

20. Tax Collection List (Monthly)  

  



 

 

 

  

21. Tax Collection List (Daily) 

  

 

  

22.1 Tax Collection List(Debit utilization) – Screen-1 

  



 

 

 

  

22.2 Tax Collection List(Debit utilization) – Screen-2 

  

 

  

23.1. List of Taxpayers with Outstanding Liabilities – Screen-1 

  



 

 

 

  

23.2. List of Taxpayers with Outstanding Liabilities – Screen-2 

  

 

  

Payment Register of Unregistered Taxpayers 

  



 

 

 

  

Enforcement Collections 

  

 

  

24. Remittance Defaulter Banks 

  



 

 

 

Returns 

State Level Inter State Supply 

  

 

  

25. Mode of Signing Return Form 

  



 

 

 

  

Summary of Taxpayers making Inter-State Purchases but not filing Valid Return 

  

 

  

Aggregate turnover Wise classification of taxpayers 

  



 

 

 

  

List of Return Defaulters  

  

 

  

26.1. Casual Taxpayer’s Details Report – Screen-1 

  



 

 

 

  

26.2. Casual Taxpayer’s Details Report – Screen-2 

  

 

  

Non Resident Taxpayer Details 

  



 

 

 

  

27.1 Composition Taxpayer changed to Normal Taxpayer within Specified Period- Screen 1 

  

 

  

27.1 Composition Taxpayer changed to Normal Taxpayer within Specified Period - Screen 2 

  



 

 

 

  

28. List of Normal Taxpayers Changed to Compounding within Financial year 

  

 

  

Taxpayer's Turnover Details - GSTR- 3B 

  



 

 

 

  

29. Block/Unblock credit work around 

  

 

  

  

  

  



 

 

MIS Dashboard 

FAQs > MIS Dashboard 

1. Who has access to MIS Dashboard? 

All State officers who are at Level 1, Level 2 and Level 3 can access MIS Dashboard for their respective 

jurisdictions. 

Levels are Jurisdictions of State defined in vertical hierarchy which may vary from State to State. These 

jurisdictions  are maintained  on the GST Portal as shared by States. 

There can be maximum 4 hierarchy levels in any State:  

• Level 1 

• Level 2 

• Level 3 

• Level 4 

And State Admin can define and decide which role will be linked to which Level as per delegations of 

statutory functions and responsibilities as per Statute.   

2. Who can provide access to MIS Dashboard? 

State admin or Sub state admin can provide access to MIS Dashboard.  

3. Which module data are available under MIS Dashboard? 

Collection, Returns and Registration related data are available under MIS Dashboard. 

  

Dashlet Description 

Collection Dashlet 

Dashlet-1 – Collection 

This dashlet shows only SGST/UTGST collection figures under 

four categories: 

i)  Previous day of current year (on that specific date)  

ii) Corresponding day of last year  

iii) Current month till date  

iv) Current financial year till date 

Dashlet-2 – Collection Range  
This dashlet shows number of taxpayers spread across different 

ranges based on only SGST/UTGST collection from them. 

Dashlet-3 – Collection Target 

vs Actual  

This dashlet shows two type of data: 

i) Figures of target along with collection amount of current month 



 

 

(only SGST/UTGST collection) till date of current year v/s 

previous financial year of corresponding month.  

ii) Figures of target along with collection of current financial year 

till date v/s corresponding previous year period of collection (only 

SGST/UTGST collection). Current month and financial year 

collection will be further bifurcated in collection from Composition 

users and other than compositions users. 

Dashlet-4 –  Collection Trend  

This dashlet shows month wise collection (only SGST/UTGST) 

trend for current financial year and corresponding months of 

previous financial year. 

Dashlet-5 – Taxpayer wise 

collection Summary   

This dashlet shows current month till date collection (only 

SGST/UTGST is considered) taxpayers wise, which is bifurcated 

into: 

i) Normal  

ii) Composition  

iii) Casual and Non-Resident  

iv) TDS  

v) TCS  

vi) Non-Resident online service provider 

Dashlet-6 – Top 10 Taxpayers 

This dashlet shows top 10 taxpayers based on collection (only 

SGST/UTGST) of current month till date. In order to get more 

number of top taxpayer’s hyperlink is provided from where list of 

upto 500 top taxpayers can be generated based on user input. 

Returns Dashlet 

Dashlet-1 – GSTR-3B filing 

current Vs Previous month  

This dashlet shows count of GSTR-3B filed by due date and after 

due date for both latest and previous return period. Count is also 

displayed in percentage for each type of filing. 

Dashlet-2 – GSTR-1 filing 

current Vs Previous month   

This dashlet shows count of GSTR-1 filed before due date and 

after due date for both latest and previous return period. Count is 

also displayed in percentage for each type of filing. 

Dashlet-3 – GSTR-3B Non-

filers  

This dashlet shows GSTR-3B non-filers count and percentage in 

month wise trend for current financial year. 

Dashlet-4 – GSTR-1 Non-

filers  

This dashlet shows GSTR-1 non-filers count and percentage in 

month wise trend for current financial year.   

Dashlet-5 – GSTR-3B Return 

filing trend 

This dashlet shows numbers of GSTR-3B return filing trend month 

wise for current financial year with breakup of filed before due 

date and after due date along with count of taxpayers who have 

yet to file return.  



 

 

Dashlet-6 – GSTR-1 Return 

filing Trend  

This dashlet shows numbers of GSTR-3B return filing trend month 

wise for current financial year with breakup of filed before due 

date and after due date along with count due for filing.  

Registration Dashlet 

Dashlet-1 – Registered 

Taxpayer (till date)  

  

This dashlet shows the count of total taxpayers registered and 

active till date bifurcated into four categories: 

 i) Normal  

ii) Casual  

iii) Composition  

iv) Others (includes all other type of taxpayers) 

Dashlet-2 – Application 

Pendency (till Date)  

This dashlet shows total count of pending application under 

following categories: 

 i) registration  

ii) Amendment  

iii) Cancellation section till date.  

This count is further bifurcated to showcase pendency based on 

days/months. 

You can click the Total Pendency hyperlink to view the total 

pendency details age wise. 

Dashlet-3 – New Registration 

Status (Month till date)  

This dashlet shows count of total registration application received 

so far in the month which is further bifurcated based on: 

i) Approved by officer 

ii) Deemed approved  

iii) Rejected 

iv) Pending.  

Count of pending application is further sub-divided to provide 

details of  pendency. 

You can click the Pendency of New Registration hyperlink to 

view the pendency of new registration application across different 

categories. 

Dashlet-4 – Cancellation (year 

till date) 

This dashlet shows total count of registration cancellation from 

start of financial year till date.  

Count of cancellation is divided into: 

i) Suo moto cancellation  

ii) On application 

Dashlet-5 – Year wise 

Registration and Registration  

This dashlet shows last five financial year wise rolling count of 

cancellation and registration.  

Dashlet-6 – Monthly 

Registration and Cancellation  

This dashlet shows month wise count of registration and 

cancellation for the current financial year.  



 

 

4. Can I download the Report from Dashboard? 

No, you cannot download the Report from Dashboard. 

5. Can I print the Report from Dashboard? 

There is no separate print functionality available to print the Dashboard. You can print the Dashboard 

using the default printing functionality of the browser. 

6. Whether Dashboard shows real time data? 

No section shows real time data. Different sections show data related to different timelines and at the 

maximum data related to previous day is displayed. 

7. Can I view the data of other jurisdictions on the Dashboard? 

Data on the dashboard is displayed based on officer’s level of original/supervisory jurisdiction as 

Dashboard’s access has been provided at L1, L2 and L3 level respectively. 

8. How can I expand the graph for a larger view? 

You can click  icon to expand the graph for a larger view. 

9. How can I undo last change done on the Dashboard? 

You can click   icon to undo last change done on the Dashboard. 

10. How can I redo the last change done on the Dashboard? 

You can click  icon to redo last change done on the Dashboard. 

11. How can I Reset Dashboard to its last saved date on the Dashboard? 

You can click  icon to Reset Dashboard to its last saved date on the Dashboard. 

12. How can I search the entire repository to view reports? 

You can enter the search parameter (name of reports) in the Search box  

provided on the top right of the page to search for any reports. 



 

 

13. Is there any Help available for Jasper Reports? 

Please click on Help   link to view the Help related to Jasper Reports. Once you click the Help link, 

a new window will open with Help contents. 



 

 

Manual > MIS Dashboard 

How can I view MIS on my Dashboard? 

1. Login to the Tax Official’s interface of GST Portal with your login credentials. 

2. Click the MIS > Dashboard link in the menu header bar to display the New MIS Dashboard screen.  

  

 

  

3. MIS Dashboard is displayed with Collection, Returns or Registration sections.  

By default, Collection section tab is displayed.  

  

3 (a). Collection Dashboard: 

  

 

  

3 (b).Returns Dashboard: 

  



 

 

 

  

3 (c).Registration Dashboard: 

3 (c).1.1. You can click the Total Pendency hyperlink to view the total pendency details. 

  

 

  

3 (c).1.2. Total Pendency details are displayed in a new window. 

  

 

  

3 (c).2.1. You can click the Pendency of New Registration hyperlink to view the pendency of new 

registration application. 

  

 

  

3 (c).2.2. Pendency of new registration application is displayed in a new window.  

  

 

  

4. In case you want to drill down further, you can select the appropriate value in the input parameters in 

the left hand side of the dashboard.       



 

 

5. Click the Apply button. 

  

 

  

6. Based on the selected input parameters, data on the Dashboard is displayed.  

  

 

  

 Other available features in input parameters are explained below:  

  

a) Reset: You can click the Reset button in case you want to go back to reset the changes applied to 

Level 1 and Level 2 choices. 

  



 

 

 

  

b) Select All: You can click the Select All link in case you want to select all the options in Level 1 or 

Level 2 choices. 

  



 

 

 

  

c) None: You can click the None link in case you want to deselect all the options in Level 1 or Level 2 

choices. 

  



 

 

 

  

d) Inverse (in reverse order): You can click the Inverse link in case you want to inverse the selections 

made in Level 1 or Level 2 choices. 

  



 

 

 



 

 

Appeal 

Overview > Appeal 

Restore Registration Application 

 FAQs 

 Manual  

Internal Review Cell 

 FAQs 

 Manual  

File an Appeal before the First Appellate Authority 

 FAQs 

 Manual  

Processing Appeal Applications 

 FAQs 

 Manual > Appeal filed by Taxpayer 

 Manual > Appeal filed by Tax Department 

Upload details of Appeal to Higher Authority (Other than First Appeal) 

 FAQs 

 Manual  

View Cause List 

 FAQs 

 Manual  

Conduct Revision Order Proceedings 

 FAQs 

 Manual  



 

 

  



 

 

Overview > Appeal 

Restore Registration Application 

 FAQs 

 Manual  

Internal Review Cell 

 FAQs 

 Manual  

File an Appeal before the First Appellate Authority 

 FAQs 

 Manual  

Processing Appeal Applications 

 FAQs 

 Manual > Appeal filed by Taxpayer 

 Manual > Appeal filed by Tax Department 

Upload details of Appeal to Higher Authority (Other than First Appeal) 

 FAQs 

 Manual  

View Cause List 

 FAQs 

 Manual  

Conduct Revision Order Proceedings 

 FAQs 

 Manual  

  

  



 

 

Restore Registration Application 

FAQs > Restore Registration Application 

1. Can I restore Registration of applications which have been rejected by 

me? 

Yes, you can restore Registration of ARN’s which have been rejected by you ONLY in case applicant/ 

taxpayer has filed an appeal against Rejection order and appellate Authority has issued the Order in 

applicant’s favor on the basis of which registration can be restored in the GST system. 

2. Which Registration applications can be restored through Restore 

Application functionality? 

Restore Registration functionality can be used to restore following Registration Applications:  

a. Registration Applications viz, Normal Taxpayer/ Composition scheme/ Casual  Taxable Person/ Input 

Service Distributor (ISD)/ SEZ Developer/ SEZ Unit 

b. Registration of UIN 

c. Enrolment of GST Practitioner 

3. Is there any time limit for Tax Official to approve the Rejected ARN with 

Appeal in Favor of the applicant? 

There is no time limit prescribed under law for Tax Official to approve the Rejected ARN in compliance of 

the order of Appellate Authority. However, it is responsibility of the proper officer to follow the direction of 

the Appellate Authority if order has achieved finality and approve the registration in time. 

4. What will be the effective date of restoring the Registration Application? 

Effective Date of restoring the registration application will be the same date as mentioned in the 

application. However: 

 If difference between "Date on which liable to register arises" and "Date of ARN for application for 

registration" is less than or equal to 30 days, then it will be the date of liability. 

 If the difference between "Date on which liable to register arises" and "Date of ARN for 

application for registration" exceeds 30 days' date on which application was rejected, then it will 

be the date of grant of registration. 



 

 

Manual > Restore Registration Application 

1. How can I restore the Registration application? 

To restore the Registration application, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Registration > Registration> Restore Application command. 

  

 

  

3. On clicking the link, a screen will open. In the ARN of the Rejected Application field, enter the ARN of 

the rejected application for which registration needs to be restored. 

4. Click the APPEAL IN FAVOUR button. 

  

 

  

The system will validate whether the status of ARN which is entered by the Tax Official is ‘Rejected’. If the 

status is Rejected, the Restore Application page is expanded to enable you to enter further details of the 

appeal. 

If ARN status is not ‘Rejected’ in the system, an error message is displayed on the screen indicating ARN 

is already approved. 

  

5. In the Remarks section, add the remarks. 



 

 

6. You need to attach the ‘Appeal Order issued in favor of applicant as an evidence for restoring the 

registration. Click the Choose File button and attach the Appeal Order in favor of the applicant. 

Note: Document attachment type should be only PDF or JPEG and maximum limit of the document 

upload is 2 MB.   

  

7. In the Place of Approver field, enter the place of approver. 

8. Click the APPROVE button to approve the Registration application. 

  

 

  

Registration Certificate will be generated and digitally signed by the Tax Official.  

Note: 

 On Approval, work-item will get closed. Status of the ARN will change to “Approved”. 

 Registration Certificate will be available on the taxpayers' dashboard to view, print or download.  

 The Primary Authorized Signatory will be communicated about approval of the Registration 

application through SMS or Email. 

  

  



 

 

Proceedings and Order of Appeal Applications (Form 
GST APL-02 and APL-04) 

FAQs >  Proceedings and Order of - Appeal 
filed by Taxpayer and Tax Department (Form 
GST APL-02 and APL-04) 

1. I am not getting Filing Appeal Inbox link in my Dashboard. Why? 

You may not have been assigned the role of Appellate Authority by the state admin. Request your state 

admin to allocate you the Appellate Authority role. Once the role is assigned, you will be allocated Appeal 

Inbox module for further action. 

  

Click here to learn about the various roles available in Tax Officials Interface and how a Admin can assign 

the role to Tax Officials. 

2. What are the steps involved in Proceedings & Order of First Appeal? 

All the Appeals submitted by the Appellant’s (Taxpayer/ Tax Official) will land on the First Appellate 

Authority’s Dashboard. 

The First Appellate Authority after verifying the form of Appeal will issue a date of hearing for the Appeal.  

The First Appellate Authority may, if sufficient cause is shown at any s tage of hearing of an appeal, grant 

adjournment to the parties and adjourn the hearing of the appeal for reasons to be recorded in wri ting. 

The First Appellate Authority after making such inquiry as may be necessary, pass such an order, 

confirming, modifying or annulling the decision or order appealed against. 

3. Who can file an Appeal? 

Application for appeal has to be submitted by the Taxpayer or any other person, if aggrieved with the 

order/decision of the adjudicating authority passed under the provisions of the Act.  The proper officer of 

the tax department can also file appeal.   

4. Who are Appellants? 

Appellants are either Taxpayers/other persons who are aggrieved with the order /decision of the 

adjudicating authority, or a Tax Department Officials, when authorised by the Commissioner, to file  an 

appeal to the Appellate Authority. 



 

 

5. How can I admit an appeal application? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Appeal & Revision > 

Application Inbox > Case Detail > Orders > ADMIT APPEAL APPLICATION > option. 

6. Before admitting the application, I want to examine the payments details 

from the liability register. Where is this available on the GST Portal? 

To examine the payments details from the liability register,  perform following steps: 

1.     Navigate to Services > Taxpayer Account > Get Taxpayer Details option. 

2.     Enter GSTIN/UIN/Temporary ID. 

3.     Click the GO button. Details, along with the hyperlinks to the Electronic Cash and Credit 

Ledgers/Registers will be displayed. You can click the hyperlinks to examine the payments details. 

7. How can I reject an appeal application? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Appeal & Revision > 

Application Inbox > Case Detail > Orders > REJECT APPEAL APPLICATION > option. 

8. Can the Appellate Authority pass an "appeal order" only if the 

application is admitted? 

Yes. The Appellate Authority will pass "appeal order" only if the application is admitted. In case the 

application is rejected, the Authority cannot pass the "appeal order".  

9. What happens after I admit an application? 

On successful admission of Application, following actions take place:  

         Status of the application on the GST Portal will change from "Appeal Submitted" to "Appeal 

Admitted". 

         An email will be sent to the Appellant, with Jurisdictional Officer and Concerned Officer in copy, 

regarding the Admission of Application.  

         An SMS will be sent to Taxpayer only regarding the Admission of Application.  

10. What happens when appeal is rejected? 

On rejection of an Application, following actions take place:  

         Status of application on the GST Portal will change from Appeal Submitted to Appeal Rejected. 

         An SMS and email will be sent to the Appellant regarding the Rejection of Application.  



 

 

11. How can I issue a notice? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Appeal & Revision > 

Application Inbox > Case Detail > Notices option. 

12. Where can I view the reply filed by the taxpayers? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Appeal & Revision > 

Application Inbox > Case Detail > Replies option. 

13. In case I need to upload additional documents (invoices, offline 

calculations, etc.) related to a particular case on the GST Portal, where do I 

upload? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Appeal & Revision > 

Application Inbox > Case Detail > Reference > ADDITIONAL DOCUMENT  option.  

14. How can I issue an adjournment? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Appeal & Revision > 

Application Inbox > Case Detail > Notices option. 

15. How many times adjournment can be granted? 

Adjournment can be granted maximum 3 times to each party (appellant /respondent). However, 

Adjournment on account of administrative grounds cannot be counted.  

16. What is the allowed time limit for an Appellant to submit certified copies 

before the First Appellate Authority? 

The appellant need to submit certified copies within 7 (seven) days from the date of application.  If certified 

copy is submitted after 7 (seven) days from date of application, then date of submission of certified copy 

will be considered as date of filing of such appeal. 

17. How can I issue an order? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Appeal & Revision > 

Application Inbox > Case Detail > Orders option. 

18. When can I pass rectification of order? 



 

 

Rectification of Appeal Order can be passed, if there is a mistake which is apparent on the records. 

Application for rectification can be submitted within 3 months from the date of order, sought to be 

rectified. 

19. On what grounds can the First Appellate Authority reject the 

application? 

Rejection may be on the ground of time limit or non-payment of admitted tax/pre-deposit or non-receipt of 

certified copies or any other reason as specified by the Appellate Authority. 

20. What entries are passed in Part-II of the Liability Register when a 

demand related order is passed? 

When demand related order is passed, the GST Portal creates entries in Part -II of the Liability Register as 

under: 

• Debit entry against a new demand Id for demand raised through Appeal order.  

• Credit entry against old demand Id for the amount under dispute.  

• Transfer out entry from old Demand Id to new Demand Id for the remaining balance in old Demand Id to 

make old Demand id balance NIL. 

• Transfer In entry to new Demand Id from old Demand Id. 

• When Appeal is rejected, no entries in Liability Register and the existing demand Id will continue.  

21. What are the various status of the application for Proceedings & Order 

of First Appeal? 

The list below provides the list of statuses of the application for Proceedings & Order of First Appeal:  

  

1. Appeal admitted: Appeal application Form is successfully admitted by taxpayer or concerned person 

2. Hearing notice issued: When notice for hearing is issued by First Appellate Authority 

3. Counter reply received: When Counter Reply is received against notice  

4. Show cause notice issued: When Show cause notice is issued to taxpayer or concerned person 

5. Appeal order passed: Appeal is confirmed/modified/rejected by First Appellate Authority 

6. Adjournment granted: When hearing is adjourned and next date of hearing is issued  

7. Rectification request received: When application is filed for Rectification of order 

8. Rectification request rejected: When application for Rectification is rejected  

9. Rectification order passed: When application for Rectification is passed 

22. Where can the taxpayers view the notice issued to them? 



 

 

After logging in to the GST portal, the taxpayers can navigate to Services > My Applications > Select 

Case > Notices option. Or, he can view this under Services > User Services > Additional Notices & 

Order option. 

23. Does a taxpayer get any intimation about the notice or order issued to 

them? 

Taxpayer will get intimation of all notices and orders issued to them though SMS and e-mail. 



 

 

 

Manual > Proceedings and Order of - Appeal 
filed by Taxpayer (Form GST APL-02 and APL-
04) 

How can I (in the role of Appellate Authority) initiate proceedings and 

hearing process for disposing Appeal application? 

To initiate proceedings and hearing process for disposing Appeal application, in the role of Appellate 

Authority, perform following steps: 

  

A. Go to Appeal application page by either searching for the ARN (Application Reference 

Number)/GSTIN/Status/Period 

B. View Appeal Application Documents submitted by the taxpayer 

C. Issue an Order 

 C (1) Admit Appeal Application 

 C (2) Reject Appeal Application 

D. Issue a Show Cause Notice (SCN)  

E. View Replies by the Appellant & Respondent, if any 

F. Issue Personal Hearing Notice, if any 

G. Issue an Adjournment, if needed 

H. Issue an Appeal Order 

I.  Add Additional Document, if any 

  

Click each hyperlink above to know more. 

A. Go to Appeal application page by either searching for the ARN 

(Application Reference Number)/GSTIN/Status/Period 

To go to Appeal application page, perform following steps: 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Appeal & Revision > Application Inbox  option. 

  

 



 

 

  

4. Select the Appeal filed by Tax Payer option. 

  

 

  

5. Search page is displayed. Choose any one of the four displayed fields as your search criteria and enter 

the required information: ARN, GSTIN/Temporary ID/UIN, Status or Period From and Period To Date 

Note: You must enter data in at least one of the field to proceed.   

6. Click the SEARCH button. 

  

 

  

7. Based on your search criteria, the required ARN(s) gets displayed. Click the ARN hyperlink of the case 

you want to act on.   

  



 

 

 

  

8. Appeal Case Detail page is displayed. From this page, you can initiate Proceedings and Hearing 

process for disposing Appeal related to this particular case by operating on the tabs provided at the left-

hand side of the page: APPLICATIONS, NOTICES, REPLIES, ORDERS, INTERNAL 

COMMUNICATION, RECTIFICATION and ADDITIONAL DOCUMENT. 

Note: On this page, the APPLICATIONS tab is selected by default.  

  

 

  

Go back to the Main Menu 

B. View Appeal application document submitted by the taxpayer 

To view Appeal application document submitted by the taxpayer, perform following steps:  

  



 

 

1. On the Case Detail page of that particular taxpayer, select the APPLICATIONS tab if it is not selected 

by default. This tab displays the entire application, in PDF mode, with all its attachments.  

2. Click the Document links under View Documents column to view the application and its attachments in 

PDF mode.  

  

 

  

Go back to the Main Menu 

C (1) Admit an Appeal Application 

To admit an appeal application, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab. This tab displays a table 

of all the records for which you would issue orders against the case created.  

2. Click ADD ORDER to open the drop-down list and select ADMIT APPEAL APPLICATION. 

  

 

  

3. The Admit Appeal Application page is displayed. 

  



 

 

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. Click the Choose File button to upload any supporting document if required. 

Note:  

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 2 other documents can be attached in the application.  

 Click on Add Document button to add the uploaded Supporting Document. Uploaded document 

will be 'Discarded' if 'Add Document' button is not clicked. 

6. Place is auto-populated. However, you can edit the same. 

7. Click PREVIEW and a system-generated draft order gets downloaded into your machine as displayed.  

  



 

 

 

  

8. Check the system-generated draft order carefully to rule out any discrepancy. 

  



 

 

 

  

9. Go back to the Order page. Click SUBMIT.  

  



 

 

 

  

10. Click PROCEED button.  

  

 

  

11. Click ISSUE with DSC.  

  



 

 

 

  

12. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

13. The updated Case Detail page is displayed, with the table containing the record of the order just 

admitted and the Status updated to "Appeal Admitted". Also, system would send the intimation to the 

taxpayer via email and SMS, and make this order available on the taxpayer’s dashboard.  

  

 

  



 

 

Go back to the Main Menu 

C (2) Reject an Appeal Application 

To reject an appeal application, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab. This tab displays a table 

of all the records for which you would issue orders against the case created.  

2. Click ADD ORDER to open the drop-down list and select REJECT APPEAL APPLICATION. 

  

 

  

3. The Reject Appeal Application page is displayed. 

  



 

 

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. Date of appeal is auto-populated. However, you can edit the same. 

6. Select the Reason of Rejection from the drop-down list. 

  

 

  

7. Click the Choose File button to upload any supporting document if required. 

Note:  

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 2 other documents can be attached in the application.  



 

 

 Click on Add Document button to add the uploaded Supporting Document. Uploaded document 

will be 'Discarded' if 'Add Document' button is not clicked. 

8. Place is auto-populated. However, you can edit the same. 

9. Click PREVIEW and a system-generated draft order gets downloaded into your machine as displayed.  

  

 

  

10. Check the system-generated draft order carefully to rule out any discrepancy. 

  



 

 

 

  

11. Go back to the Order page. Click SUBMIT.  

  



 

 

 

  

12. Click PROCEED button.  

  

 

  

13. Click ISSUE with DSC.  

  



 

 

 

  

14. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

15. The updated Case Detail page is displayed, with the table containing the record of the order just 

rejected and the Status updated to "Appeal Rejected". Also, system would send the intimation to the 

taxpayer via email and SMS, and make this order available on the taxpayer’s dashboard.  

  

 

  



 

 

Go back to the Main Menu 

D. Issue a Show Cause Notice (SCN)  

To issue a Show Cause Notice (SCN) to a taxpayer, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (SCN/Personal Hearing/Adjournment) issued against the case 

created.  

2. Click ADD NOTICE to open the drop-down list and select SHOW CAUSE NOTICE. 

  

 

  

3. The SCN page is displayed. 

  



 

 

 

  

4. Click the Generate Notice Number hyperlink. Notice Number field gets auto-populated.  

5. Select the Recipient of Notice  from the drop-down list. 

  

 

  

6. In the Subject field, enter the purpose of calling the hearing.   

7. Select the Previous Date of Hearing using the calendar, if any.   

8. Select the Status of Previous Hearing from the drop-down list, if any.   

  



 

 

 

  

9. Select the New Date of Hearing using the calendar. 

10. Select the New Time of Hearing from the drop-down list. 

11. In the Place of Hearing field, enter the name of the place where you would like to call the taxpayer 

for personal hearing.   

12. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

SCN. 

13. Click PREVIEW and a system-generated draft SCN gets downloaded into your machine as displayed.  

  

 

  



 

 

14. Check the system-generated draft notice carefully to rule out any discrepancy. 

  

 

  

15. Go back to the Notice page. Click SUBMIT.  

  



 

 

 

  

16. Click PROCEED button.  

  

 

  

17. Click ISSUE with DSC.  



 

 

  

 

  

18. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

19. The updated Case Detail page is displayed, with the table containing the record of the SCN just 

issued and the Status updated to "Show Cause Notice Issued".  

  

 

  



 

 

Go back to the Main Menu 

E. View Replies by the Appellant & Respondent, if any 

To view replies submitted by the Appellant & Respondent, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the REPLIES tab. This tab displays all 

replies filed by the Taxpayer/ Tax official.  

  

 

  

2. Click the documents in the Documents section to download and ascertain their contents.  

  

 

  

Go back to the Main Menu 

F. Issue Personal Hearing Notice, if any 

To issue personal hearing notice, perform following steps: 



 

 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (SCN/Personal Hearing/Adjournment) issued against the case 

created.  

2. Click ADD NOTICE to open the drop-down list and select PERSONAL HEARING. 

  

 

  

3. The PERSONAL HEARING page is displayed. 

  



 

 

 

  

4. Click the Generate Notice Number hyperlink. Notice Number field gets auto-populated.  

5. Select the Recipient of Notice  from the drop-down list. 

  

 

  

6. In the Subject field, enter the purpose of calling the hearing.   

7. Select the New Date of Hearing using the calendar. 

8. Select the New Time of Hearing from the drop-down list. 



 

 

9. In the Place of Hearing field, enter the name of the place where you would like to call the taxpayer for 

personal hearing.   

10. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

notice. 

11. Click PREVIEW and a system-generated draft notice of personal hearing gets downloaded into your 

machine as displayed. 

  

 

  

12. Check the system-generated draft notice carefully to rule out any discrepancy. 

  



 

 

 

  

13. Go back to the Notice page. Click SUBMIT.  

  



 

 

 

  

14. Click PROCEED button.  

  

 

  

15. Click ISSUE with DSC.  

  



 

 

 

  

16. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

17. The updated Case Detail page is displayed, with the table containing the record of the personal 

hearing just issued and the Status updated to "Hearing Notice Issued". Also, system would send the 

intimation to the taxpayer via email and SMS, and make this personal hearing notice available on the 

taxpayer’s dashboard.  

  



 

 

 

  

Note: Intimation of issue of personal hearing will be sent to taxpayer via email and SMS. It will also be 

available on taxpayer’s dashboard.   

  

Go back to the Main Menu 

G. Issue an Adjournment, if needed 

To update adjournment details for a respondent, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (SCN/Personal Hearing/Adjournment) issued against the case 

created.  

2. Click ADD NOTICE to open the drop-down list and select ADJOURNMENT. 

  

 

  

3. The ADJOURNMENT page is displayed. 

  



 

 

 

  

4. Click the Generate Notice Number hyperlink. Notice Number field gets auto-populated.  

5. Select the Recipient of Notice  from the drop-down list. 

  

 

  

6. In the Subject field, enter the purpose of calling the hearing.   

7. Select the Previous Date of Hearing using the calendar.   

8. Select the Status of Previous Hearing from the drop-down list.   

  



 

 

 

  

9. Select the New Date of Hearing using the calendar. 

10. Select the New Time of Hearing from the drop-down list. 

11. In the Place of Hearing field, enter the name of the place where you would like to call the taxpayer 

for personal hearing.   

12. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

notice. 

13. Click PREVIEW and a system-generated draft notice of adjournment gets downloaded into your 

machine as displayed. 

  

 



 

 

  

14. Check the system-generated draft notice carefully to rule out any discrepancy. 

  

 

  

15. Go back to the Notice page. Click SUBMIT.  

  



 

 

 

  

16. Click PROCEED button.  

  

 

  

17. Click ISSUE with DSC.  



 

 

  

 

  

18. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

19. The updated Case Detail page is displayed, with the table containing the record of the Adjournment 

just issued and the Status updated to "Adjournment Granted". Also, system would send the intimation to 

the taxpayer via email and SMS, and make this Adjournment notice available on the taxpayer’s 

dashboard.  

  



 

 

 

  

Note: Intimation of issue of adjournment will be sent to taxpayer via email and SMS. It will also be 

available on taxpayer’s dashboard.   

  

Go back to the Main Menu 

H. Issue an Appeal Order 

To issue an appeal order, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab. This tab displays a table 

of all the records for which you would issue orders against the case created.  

2. Click ADD ORDER to open the drop-down list and select APPEAL ORDER. 

  

 

  

3. The Appeal Order page is displayed. 

  



 

 

 

  

4. Click the Generate Order Number hyperlink. Order Number field gets auto-populated.  

5. Select the Status of Order from the drop-down list. 

  



 

 

 

  

6. Scroll right to view the amount of demand/ refund confirmed. 

7. Click the Choose File button to upload details of Personal Hearing & Order in brief in PDF format as 

Annexure to Form GST APL-04. 

Note: 

  File with PDF format is only allowed. 

  Maximum file size for upload is 10MB. 

8. Click the Choose File button to upload any supporting document if required. 

Note:  

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 2 other documents can be attached in the application.  

 Click on Add Document button to add the uploaded Supporting Document. Uploaded document 

will be 'Discarded' if 'Add Document' button is not c licked. 

9. Place is auto-populated. However, you can edit the same. 

10. Click PREVIEW and a system-generated draft order gets downloaded into your machine as 

displayed. 

  



 

 

 

  

11. Check the system-generated draft order carefully to rule out any discrepancy. 

  



 

 

 

  

12. Go back to the Order page. Click SUBMIT.  

  



 

 

 

  

13. Click PROCEED button.  

  



 

 

 

  

14. Click ISSUE with DSC.  

  

 

  

15. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

16. The updated Case Detail page is displayed, with the table containing the record of the order just 

issued and the Status updated to "Appeal Order Passed". Also, system would send the intimation to the 

taxpayer via email and SMS, and make this order available on the taxpayer’s dashboard.  

  



 

 

 

  

Note: 

Note: 

1. When Appellate Authority passes the Order with status as "Modified" :  

The GST Portal will create entries in Part-II of the Liability Register as under: 

• Debit entry against a new demand Id for demand raised through Appeal order • Credit  

entry against old demand Id for the amount under dispute  

2. When Appellate Authority passes the Order with status as "Rejected" (Demand Confirmed): 

The GST Portal will create no entries in the Part-II of the Liability Register. 

 3. When Appellate Authority passes the Order with status as "Confirmed" (Demand Rejected): 

The GST Portal will create entries in Part-II of the Liability Register as under: 

• Credit entry against old demand Id to the extent of amount under dispute  

  

Go back to the Main Menu 

I. Add Additional Document, if any 

To add any additional documents, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ADDITIONAL DOCUMENT tab if it is 

not selected by default. This tab displays the additional documents submitted physically by any party (i.e. 

Applicant or Jurisdictional Officer- Authority for Advance Ruling or Concerned Officer) during the hearing. 

Only Appellate Authority / Assistant to Appellate Authority can upload the additional documents.  

2.  Click the ADD DOCUMENTS button. 

  



 

 

 

  

3. Select the Date of Hearing using the calendar. 

4. In the Document Description field, enter the description of the document i.e. the name or type of 

document that is provided during hearing. 

5. In the Documents Submitted By field, enter the name of the person who submitted the additional 

document. In case of multiple names, all the names will be separated by comma. 

6. Click the Choose File button to upload the additional document. 

Note:  

 You can upload PDF file with maximum size of upload as 5 MB. 

 Maximum 5 additional documents can be attached for one Date of hearing.  

  

 

  

7. Click the ADD button. 



 

 

  

 

  

8. Click the SUBMIT button. 

Note: You can click the DELETE or PREVIEW button to delete or preview the uploaded additional 

documents. You can delete the document uploaded, till the document is not submitted.  

You can also add another additional documents here. 

  

 

  



 

 

9. Click the PROCEED button. 

  

 

  

10. After documents are successfully submitted, the updated details will be visible to Appellate Authority / 

Assistant to Appellate Authority. 

  

 

  

Go back to the Main Menu 

  



 

 

 

Manual > Proceedings and Order of - Appeal 
filed by Tax Department (Form GST APL-02 
and APL-04) 

How can I (in the role of Appellate Authority) review appeal application 

submitted by Tax Department? 

To review appeal application submitted by Tax Department, in the role of Appellate Authority, perform 

following steps: 

  

A. Go to Appeal application page by either searching for the ARN (Application Reference 

Number)/GSTIN/Status/Period 

B. View Appeal Application Documents submitted by the Tax Department  

C. Issue an Order 

 C(1). Admit Appeal Application 

 C(2). Reject Appeal Application 

D. Issue a Show Cause Notice (SCN)  

E. View Replies by the Appellant & Respondent, if any 

F. Issue Personal Hearing Notice, if any 

G. Issue an Adjournment, if needed 

H. Issue an Appeal Order 

I. Add Additional Document, if any 

  

Click each hyperlink above to know more. 

A. Go to Appeal application page by either searching for the ARN 

(Application Reference Number)/GSTIN/Status/Period 

To go to Appeal application page, perform following steps: 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Appeal & Revision > Application Inbox  option. 

  

 



 

 

  

4. Select the Appeal filed by Tax Department option. 

  

 

  

5. Search page is displayed. Choose any one of the four displayed fields as your search criteria and enter 

the required information: ARN, GSTIN/Temporary ID/UIN, Status or Period From and Period To Date  

Note: You must enter data in at least one of the field to proceed.   

 Further following status will be available in Status drop-down list. 

  

 

  

6. Click the SEARCH button. 

  

 

  

7. Based on your search criteria, the required ARN(s) gets displayed. Click the ARN hyperlink of the case 

you want to act on.   



 

 

  

 

  

8. Appeal Case Detail page is displayed. From this page, you can initiate Proceedings for disposing 

Appeal related to this particular case by operating on the tabs provided at the left-hand side of the page: 

APPLICATIONS, NOTICES, REPLIES, ORDERS, INTERNAL COMMUNICATION, RECTIFICATION 

and ADDITIONAL DOCUMENT. 

Note: By default APPLICATIONS tab is selected as shown in the screenshot below.  

  

 

  

Go back to the Main Menu 

B. View Appeal application document submitted by the Tax Department 

To view Appeal application document submitted by the Tax Department, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the APPLICATIONS tab if it is not selected 

by default. This tab displays the entire application, in PDF mode, with all its attachments.  



 

 

2. Click the Document links under View Documents column to download the application and its 

attachments in PDF mode.  

  

 

  

Go back to the Main Menu 

C(1). Admit an Appeal Application 

To admit an appeal application, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab. This tab displays a table 

of all the records for which you would issue orders against the case created.  

2. Click ADD ORDER to open the drop-down list and select ADMIT APPEAL APPLICATION. 

  

 

  

3. The Admit Appeal Application page is displayed. 

  



 

 

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. Click the Choose File button to upload any supporting document if required. 

Note:  

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 2 other documents can be attached in the application.  

 Click on Add Document button to add the uploaded Supporting Document. Uploaded document 

will be 'Discarded' if 'Add Document' button is not clicked. 

6. Place is auto-populated. However, you can edit the same. 

7. Click PREVIEW and a system-generated draft order gets downloaded into your machine as displayed.  

  



 

 

 

  

8. Check the system-generated draft order carefully to rule out any discrepancy. 

  



 

 

 

  

9. Go back to the Order page. Click SUBMIT.  

  



 

 

 

  

10. Click PROCEED button.  

  

 

  

11. Click ISSUE with DSC.  

  



 

 

 

  

12. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

13. The updated Case Detail page is displayed, with the table containing the record of the order just 

admitted and the Status updated to "Appeal Admitted". Also, system would send intimation to the 

Taxpayer via email and SMS, and make this order available on the Taxpayer's dashboard for view. 

System would send the intimation to the Tax Official via email. 

  

 

  



 

 

Go back to the Main Menu 

C(2). Reject an Appeal Application 

To reject an appeal application, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab. This tab displays a table 

of all the records for which you would issue orders against the case created.  

2. Click ADD ORDER to open the drop-down list and select REJECT APPEAL APPLICATION. 

  

 

  

3. The Reject Appeal Application page is displayed. 

  



 

 

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. Date of appeal is auto-populated. However, you can edit the same. 

6. Select the Reason of Rejection from the drop-down list. 

  

 

  

Note: If you select "Other reason", a blank field will appear. Enter the reason in the field.  

  



 

 

 

  

7. Click the Choose File button to upload any supporting document if required. 

Note:  

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 2 other documents can be attached in the application.  

 Click on Add Document button to add the uploaded Supporting Document. Uploaded document 

will be 'Discarded' if 'Add Document' button is not clicked. 

8. Place is auto-populated. However, you can edit the same. 

9. Click PREVIEW and a system-generated draft order gets downloaded into your machine as displayed. 

  



 

 

 

  

10. Check the system-generated draft order carefully to rule out any discrepancy. 

  



 

 

 

  

11. Go back to the Order page. Click SUBMIT.  

  



 

 

 

  

12. Click PROCEED button.  

  

 

  

13. Click ISSUE with DSC.  

  



 

 

 

  

14. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

15. The updated Case Detail page is displayed, with the table containing the record of the order just 

rejected and the Status updated to "Appeal Rejected". Also, system would send the intimation to the 

Taxpayer via email and SMS, and make this order available on the Taxpayer's dashboard.  

  

 

  

Go back to the Main Menu 



 

 

D. Issue a Show Cause Notice (SCN)  

To issue a Show Cause Notice (SCN), perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab, if it is not selected by 

default. This tab displays all the notices (SCN/Personal Hearing/Adjournment) issued against the case 

created.  

2. Click ADD NOTICE to open the drop-down list and select SHOW CAUSE NOTICE. 

  

 

  

3. The SCN page is displayed. 

  



 

 

 

  

4. Click the Generate Notice Number hyperlink. Notice Number field gets auto-populated.  

5. Select the Recipient of Notice  from the drop-down list. 

  

 

  

6. In the Subject field, enter the purpose of calling the hearing.   

7. Select the Previous Date of Hearing using the calendar, if any.   

8. Select the Status of Previous Hearing from the drop-down list, if any.   

  



 

 

 

  

9. Select the New Date of Hearing using the calendar. 

10. Select the New Time of Hearing from the drop-down list. 

11. In the Place of Hearing field, enter the name of the place where you would like to call the taxpayer 

for personal hearing.   

12. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

SCN. 

13. Click PREVIEW and a system-generated draft SCN gets downloaded into your machine as displayed.  

  

 

  



 

 

14. Check the system-generated draft notice carefully to rule out any discrepancy. 

  

 

  

15. Go back to the Notice page. Click SUBMIT.  

  



 

 

 

  

16. Click PROCEED button.  

  

 

  

17. Click ISSUE with DSC.  



 

 

  

 

  

18. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

19. The updated Case Detail page is displayed, with the table containing the record of the SCN just 

issued and the Status updated to "Show Cause Notice Issued". System would send the intimation to the 

Taxpayer via email and SMS, and make this notice available on the Taxpayer's dashboard for replying. 

System would send the intimation to the Tax Official via email.  

  



 

 

 

  

Go back to the Main Menu 

E. View Replies by the Appellant & Respondent, if any 

To view replies submitted by the Appellant & Respondent, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the REPLIES tab. This tab displays all 

replies filed by the Taxpayer/ Tax official.  

  

 

  

2. Click the documents in the Documents section to download and ascertain their contents.  

  



 

 

 

  

Go back to the Main Menu 

F. Issue Personal Hearing Notice, if any 

To issue personal hearing notice, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (SCN/Personal Hearing/Adjournment) issued against the case 

created.  

2. Click ADD NOTICE to open the drop-down list and select PERSONAL HEARING. 

  

 

  

3. The PERSONAL HEARING page is displayed. 

  



 

 

 

  

4. Click the Generate Notice Number hyperlink. Notice Number field gets auto-populated.  

5. Select the Recipient of Notice  from the drop-down list. 

  

 

  

6. In the Subject field, enter the purpose of calling the hearing.   

7. Select the New Date of Hearing using the calendar. 

8. Select the New Time of Hearing from the drop-down list. 

9. In the Place of Hearing field, enter the name of the place where you would like to call the taxpayer for 

personal hearing.   



 

 

10. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

notice. 

11. Click PREVIEW and a system-generated draft notice of personal hearing gets downloaded into your 

machine as displayed. 

  

 

  

12. Check the system-generated draft notice carefully to rule out any discrepancy. 

  



 

 

 

  

13. Go back to the Notice page. Click SUBMIT.  

  



 

 

 

  

14. Click PROCEED button.  

  

 

  

15. Click ISSUE with DSC.  

  



 

 

 

  

16. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

17. The updated Case Detail page is displayed, with the table containing the record of the personal 

hearing just issued and the Status updated to "Hearing Notice Issued". Also, system would send the 

intimation to the Taxpayer via email and SMS, and make this personal hearing notice available on the 

Taxpayer's dashboard.  

  

 



 

 

  

Go back to the Main Menu 

G. Issue an Adjournment, if needed 

To update adjournment details, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (SCN/Personal Hearing/Adjournment) issued against the case 

created.  

2. Click ADD NOTICE to open the drop-down list and select ADJOURNMENT. 

  

 

  

3. The ADJOURNMENT page is displayed. 

  



 

 

 

  

4. Click the Generate Notice Number hyperlink. Notice Number field gets auto-populated.  

5. Select the Recipient of Notice  from the drop-down list. 

  

 

  

6. In the Subject field, enter the purpose of calling the hearing.   

7. Select the Previous Date of Hearing using the calendar.   

8. Select the Status of Previous Hearing from the drop-down list.   

  



 

 

 

  

9. Select the New Date of Hearing using the calendar. 

10. Select the New Time of Hearing from the drop-down list. 

11. In the Place of Hearing field, enter the name of the place where you would like to call the taxpayer 

for personal hearing.   

12. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

notice. 

13. Click PREVIEW and a system-generated draft notice of adjournment gets downloaded into your 

machine as displayed. 

  

 



 

 

  

14. Check the system-generated draft notice carefully to rule out any discrepancy. 

  

 

  

15. Go back to the Notice page. Click SUBMIT.  

  



 

 

 

  

16. Click PROCEED button.  

  

 

  

17. Click ISSUE with DSC.  



 

 

  

 

  

18. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

19. The updated Case Detail page is displayed, with the table containing the record of the Adjournment 

just issued and the Status updated to "Adjournment Granted". Also, system would send the intimation to 

the Taxpayer via email and SMS, and make this Adjournment notice available on the Taxpayer's 

dashboard.  

  



 

 

 

  

Go back to the Main Menu 

H. Issue an Appeal Order 

To issue an appeal order, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab. This tab displays a table 

of all the records for which you would issue orders against the case created.  

2. Click ADD ORDER to open the drop-down list and select APPEAL ORDER. 

  

 

  

3. The Appeal Order page is displayed. 

  



 

 

 

  

4. Click the Generate Order Number hyperlink. Order Number field gets auto-populated.  

5. Select the Status of Order from the drop-down list. 

  



 

 

 

  

6.1. Scroll right to view the disputed amount and determined amount for State/ UT Tax, Integrated tax and 

Cess. 

  

 

  

6.2. Scroll right to view the total of disputed amount and determined amount.  

  



 

 

 

  

7. Click the Choose File button to upload details of Personal Hearing & Order in brief in PDF format as 

Annexure to Form GST APL-04. 

Note: 

  File with PDF format is only allowed. 

  Maximum file size for upload is 10MB. 

8. Click the Choose File button to upload any supporting document if required. 

Note:  

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 2 other documents can be attached in the application.  

 Click on Add Document button to add the uploaded Supporting Document. Uploaded document 

will be 'Discarded' if 'Add Document' button is not clicked. 

9. Place is auto-populated. However, you can edit the same. 

10. Click PREVIEW and a system-generated draft order gets downloaded into your machine as 

displayed. 

  



 

 

 

  

11. Check the system-generated draft order carefully to rule out any discrepancy. 

  



 

 

 

  

12. Go back to the Order page. Click SUBMIT.  

  



 

 

 

  

13. Click PROCEED button.  

  



 

 

 

  

14. Click ISSUE with DSC.  

  

  

 

  

15. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

16. The updated Case Detail page is displayed, with the table containing the record of the order just 

issued and the Status updated to "Appeal Order Passed". Also, system would send the intimation to the 

Tax Official via email and SMS, and make this order available on the Taxpayer's dashboard.  



 

 

  

 

  

Note: 

1. When Appellate Authority passes the Order with status as "Modified" :  

The GST Portal will create entries in Part-II of the Liability Register as under: 

• Debit entry against a new demand Id for demand raised through Appeal order  

• Credit entry against old demand Id for the amount under dispute. 

• In DCR, existing demand status will be updated and new demand creation will be done.  

2. When Appellate Authority passes the Order with status as "Rejected" (Demand Confirmed): 

• The GST Portal will create no entries in the Part-II of the Liability Register. 

• In DCR, existing demand status will be updated and new demand creation will be done.  

 3. When Appellate Authority passes the Order with status as "Confirmed" (Demand Rejected): 

The GST Portal will create entries in Part-II of the Liability Register as under: 

• Credit entry against old demand Id to the extent of amount under dispute.  

• In DCR, existing demand status will be updated. 

  

Go back to the Main Menu 

I. Add Additional Document, if any 

To add any additional documents, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ADDITIONAL DOCUMENT tab if it is 

not selected by default. This tab displays the additional documents submitted physically by any party (i.e. 

Applicant or Jurisdictional Officer- Authority for Advance Ruling or Concerned Officer) during the hearing. 

Only Appellate Authority / Assistant to Appellate Authority can upload additional documents.  

2.  Click the ADD DOCUMENTS button. 

  



 

 

 

  

3. Select the Date of Hearing using the calendar. 

4. In the Document Description field, enter the description of the document i.e. the name or type of 

document that is provided during hearing. 

5. In the Documents Submitted By field, enter the name of the person who submitted the additional 

document. In case of multiple names, all the names will be separated by comma. 

6. Click the Choose File button to upload the additional document. 

Note:  

 You can upload PDF file with maximum size of upload as 5 MB. 

 Maximum 5 additional documents can be attached for one Date of hearing.  

  

 

  

7. Click the ADD button. 



 

 

  

 

  

8. Click the SUBMIT button. 

Note: You can click the DELETE or PREVIEW button to delete or preview the uploaded additional 

documents. You can delete the document uploaded, till the document is not submitted.  

You can also add another additional documents here. 

  

 

  



 

 

9. Click the PROCEED button. 

  

 

  

10. After documents are successfully submitted, the updated details will be visible to Appellant/ Appellate 

Authority / Assistant to Appellate Authority. 

  

 

  

Go back to the Main Menu 

  



 

 

Internal Review Cell 

FAQs > Conduct an Internal Review of Orders 
and Subsequently Take Actions on the 
Impugned Orders Prejudicial to the Interest 
of the Revenue 

1. Which all Tax Official Roles are involved in the process of the internal 

review of Orders? 

The process of the internal review of Orders and subsequently taking the required action on the 

impugnOrders prejudicial to the interest of the revenue involves the following four Tax Official roles 

defined on the GST Portal by the State Admin:  

1. Internal Review Cell (IRC) Members: Review Orders available on the GST Portal and submit 

proposal for review 

Note: Separate Internal Review Cells will be designated at Divisional level and State level. One division 

will have one Internal Review Cell. 

2. Commissioner/Senior tax officer (STO) or In charge of the internal review cell: Review the 

submitted proposals and issue the required directions on the impugned Orders prejudicial to the 

interest of the revenue 

Note: The Commissioner/STO may on his/her own motion create a Proposal case and also revise the 

Orders prejudicial to the interest of the revenue himself/herself as Revisional Authority. 

3. Legal Officer: Take necessary actions on the impugned Order as per the direction of the 

Commissioner/STO  

4. Revisional Authority: Take necessary actions on the impugned Order as per the direction of the 

Commissioner/STO  

2. On the GST Portal, what is the procedure followed by Tax Officials to do 

an internal review of Orders and issue the required directions on the 

Orders prejudicial to the interest of the revenue? 

On the GST Portal, the procedure followed by the Tax Officials to do an internal review of Orders and 

issue the required directions on the Orders prejudicial to the interest 

of the revenue comprises following steps: 

  

1. Internal Review Cell (IRC) reviews Orders (except Supreme Court orders) passed in case of any 

GSTIN/UIN/Temporary ID and examines them for legality and propriety. If found otherwise, IRC 



 

 

creates a Proposal case and submits it for examination and order by the Commissioner/STO to file 

appeal against such Orders, giving grounds for filing such an appeal against the Order, passed by 

appellate authority, Appellate Tribunal, High Court or with grounds of revision in case of revision.  

  

Note: The Commissioner/STO may on his/her own motion create a Proposal case. IRC Members cannot 

view such proposals created by Commissioner/STO.  

  

2. Commissioner/STO issues a Direction on the impugned Order: He/she will examine the 

submitted Proposal and issue one of the following directions (to Legal Officer or Revisional Authority 

or decide to revise the Order himself/herself) on case-basis: 

  

2a. DIRECT TO FILE APPEAL: If, after looking at the proposal, he/she is satisfied that the impugned 

Order is not legal/proper and filing of appeal is required; he/she will select one of the following options 

and direct a Legal Officer to: 

 File Appeal before Appellate Authority if the Proposal for Review is against an Adjudication Order 

and difference in the date of communication of Order and the date of directing it is less than or equal 

to <7> months.  

 File Appeal before the next higher forum if the Proposal for Review is against an Order passed by 

First Appellate Authority/Appellate Tribunal/Revision/High Court and difference in the date of 

communication of Order and the date of directing it is less than or equal to <7> months.  

  

2b. DROP THE CASE: If, after looking at the proposal, he/she is satisfied that the revision of the Order is 

not required and no appeal is required to be filed.  

  

Note: The Commissioner/STO may drop the case at any stage after the initiation of the Proposal case.  

  

2c. REVISE ORDER: If, after looking at the proposal, he/she is satisfied that the impugned Adjudication 

Order is not legal/proper and the difference in the date of communication of Order and the date of 

directing it is between 7 months and 3 years (the period of first appeal has expired) and he/she wishes to 

revise the order himself/herself as Revisional Authority 

  

2d. DIRECT TO REVISE THE ORDER: If, after looking at the proposal, he/she is satisfied that the 

impugned Adjudication Order is not legal/proper and the difference in the date of communication of Order 

and the date of directing it is between 7 months and 3 years (the period of first appeal has expired); 

he/she will direct the case to a Revisional Authority for revision.  

  

Note:  

 Revision of Order cannot be done within 6+1 (Six+ one) months from the Date of Communication of 

the decision or order sought to be revised. Although Directions to file an appeal can be issued. 

 Revision of Order cannot be done after 3 (Three) years from the Date of order sought to be revised. 



 

 

 Date of Order being sent by email and SMS will be considered as the Date of Communication of 

Order. If the order is sent by post/special messenger, the date as updated in the system will be 

considered.  

  

3. Providing update on the Actions taken on the issued Direction: After taking the required actions 

on the issued direction of Commissioner/STO, the Legal Officer or Revisional Authority or the 

Commissioner/STO himself/herself can update on the case by selecting one of the following options 

on case-basis: 

 FAILED TO FILE APPEAL: If the Legal Officer was unable to file Appeal as per the issued direction, 

where the difference in the date of communication of Order and the date of filing appeal was  more 

than 7 months 

 REVISION PROCEEDINGS INITIATED: If the Revisional Authority or the Commissioner/STO 

himself/herself has successfully initiated revision of the Order as per the issued direction 

 APPEAL INITIATED: If the Legal Officer has successfully filed an Appeal as per the issued direction 

 FAILED TO INITIATE REVISION: If the Revisional Authority or the Commissioner/STO 

himself/herself was unable to initiate revision of the Order as per the issued direction 

  

4. Once the ACTIONS tab is updated, the Commissioner/STO will review this update and either issue 

another direction (if the previous direction was not executed) or drop the case as per his/her 

discretion. 

3. What is the function of an Internal Review Cell, with respect to reviewing 

Orders on the GST Portal? 

Internal Review Cell (IRC) has the function to review Orders available on the GST Portal (except 

Supreme Court Orders), which were passed in case of any GSTIN/UIN/Temporary ID and examine them 

for legality and propriety on the basis of some of the following points: 

1. Misclassification of any goods or services or both; 

2. Wrong applicability of a notification issued under the provisions of this Act;  

3. Incorrect determination of time and value of supply of goods or services or both;  

4. Incorrect admissibility of input tax credit of tax paid or deemed to have been paid;  

5. Incorrect determination of the liability to pay tax on any goods or services or both;  

6. Whether applicant is required to be registered;  

7. Whether any particular thing done by the applicant results in supply of goods or services or both  

8. Rejection of application for registration on incorrect ground.  

9. Cancellation of registration for incorrect reasons  

10.  Transfer/Initiation of recovery/ Special mode of recovery  

11.  Tax wrongfully collected/Tax collected not paid to Government  

12.  Determination of tax not paid or short paid  

13.  Refund on wrong ground/Refund not granted/ Interest on delayed refund  

14.  Fraud or wilful suppression of fact  



 

 

15.  Anti profiteering related matter.  

16.  Any other point (other than the 15 points listed above) 

  

Note: Separate Internal Review Cells will be designated at Divisional level and State level. One division 

will have one Internal Review Cell. 

  

4. Which all Orders, uploaded in the GST Portal, can be reviewed by IRC? 

Except for Supreme Court Orders, IRC can review all the Orders uploaded on the GST Portal. These 

other Orders are: Adjudication Orders, Refund Orders, Revision Orders, Appellate Authority Orders, 

Appellate Tribunal Orders and High Court Orders. 

5. Can I view Orders older than 3 Years from today? 

No. Any Order older than 3 Years from today won’t appear in the queue of Orders for view. 

6. Can I also view the Orders which are currently subject to an Appeal or 

Revision? 

No. Any Order which is currently subject to an Appeal or Revision won’t appear in the queue of Orders.  

7. Can I also view the Orders against which an Order (proposal) by any 

higher authority has been issued? 

No. Any Order, against which an Order (proposal) by any higher authority has been issued, won’t appear 

in the queue of Orders. But, such Order (proposal) issued by the higher authority will appear in the 

respective queue. 

8. What is function of a Commissioner/STO, with respect to reviewing 

Orders? 

The Commissioner/STO may on his own motion, or upon information received by IRC or from 

Commissioner of other State/UT/Centre, examine any proceeding/order, and if he considers that any 

decision/order passed is erroneous in so far as it is prejudicial to the interest of the revenue and also is 

illegal or improper, he may, direct any officer to file an appeal with the appropriate authority against that 

order or if that order is an adjudicating order, revise such adjudicating order if the period of first appeal 

expired and if it is within three years of such adjudicating order.  

  



 

 

Note: The Commissioner/STO can issue direction once against one proposal. However, if initial direction 

is not executed and the Legal Officer fails to file an appeal, he/she can issue another direction.  The 

Commissioner/STO may drop the case at any stage after the initiation of the Proposal case. 

9. I am an IRC member. Can I view the Proposals created by a 

Commissioner/STO? 

No, Proposals created by a Commissioner/STO will not be visible to the IRC Members. It will be visible to 

the subordinate officer who has been directed to file appeal.  

10. What will happen after the Commissioner/STO directs a Legal Officer to 

file an Appeal? 

After the Commissioner/STO directs a Legal Officer to file an Appeal, the Legal Officer's Dashboard is 

updated with the issued Direction. Now, the Legal Officer will go through the impugned Order and the 

issued direction and take one of the following actions: 

 File Appeal before Appellate Authority on the GST Portal: If the issued direction is against an 

Adjudication Order and the difference in the date of communication of Order and the date of filing the 

appeal is less than or equal to <7> months. Subsequent to filing the appeal successfully, the Legal 

Officer will update the Proposal case on the GST Portal with the "APPEAL INITIATED" Action 

 File Appeal before Appellate Tribunal/High Court/Supreme Court Offline Manually: If the issued 

direction is against an Order issued by First Appellate Authority, Appellate Tribunal, High Court, 

Supreme court and the difference in the date of communication of Order and the date of filing appeal 

is less than or equal to <7> months. Subsequent to filing the appeal successfully, the Legal Officer 

will update the Proposal case on the GST Portal with the "APPEAL INITIATED" Action 

 Update the Proposal case on the GST Portal with the "FAILED TO FILE APPEAL" Action: If the 

issued direction is against an Adjudication Order, where the difference in the date of communication 

of Order and the date of filing appeal is more than 7 months 

11. I am a Commissioner and I am going to direct revision of an Order. 

What is time limit for doing self-revision or directing the Proposal for 

revision? 

Following is the time limit for doing self-revision or directing the Proposal for revision: 

 Revision of Order cannot be done within 6+1 (Six+ one) months from the Date of Communication of 

the decision or order sought to be revised. Although Directions to file an appeal can be issued. 

 Revision of Order cannot be done after 3 (Three) years from the Date of order sought to be revised.  

 Date of Order as being sent by email and SMS will be considered as the Date of Communication of 

Order. If the order is sent by post/special messenger, the date as updated in the system will be 

considered.  



 

 

12. What will happen after the Commissioner/STO directs a Revisional 

Authority to revise an Order? 

After the Commissioner/STO directs a Revisional Authority to revise an Order, the Revisional Authority's 

Dashboard is updated with the issued Direction. The Revisional Authority will go through the impugned 

Order and the direction issued and take one of the following actions: 

  

 Initiate Proceedings for Revision of the Impugned Order and issue notice to Taxpayer and Tax 

Officer for personal hearing. Subsequent to the issue of the notice for personal hearing, the 

Revisional Authority will update the Proposal case on the GST Portal with the "REVISION 

PROCEEDINGS INITIATED" Action. 

 Drop Proceedings for Revision of the Impugned Order and update the Proposal case on the GST 

Portal with the "FAILED TO INITIATE REVISION" Action. 

  

Note: The Proceeding can be dropped without issuing notice for hearing on Revisional Authority’s 

discretion. 

13. What will happen to the Proposal if the Legal Officer or the Revisional 

Authority fails to execute the direction of the Commissioner/STO? 

If the Legal Officer or the Revisional Authority fail to execute the direction of the Commissioner/STO with 

in time limit, the Commissioner/STO may either issue another direction or drop the case as per his/ her 

discretion.     

14. During the process of proposing review of an order prejudicial to the 

interest of the revenue, what all Status changes does a Proposal undergo? 

During the process of proposing review of an order prejudicial to the interest of the revenue, a Proposal 

can undergo following Status changes: 

  

 Review Proposal Submitted: When proposal for review submitted against an order to 

Commissioner/STO by IRC 

 Directed to file Appeal: When proposal for review is approved by Commissioner/STO & 

Commissioner/STO has directed to file appeal 

 Directed for Revision: When proposal for review is approved by Commissioner/STO & 

Commissioner/STO has directed for Revision of Order  

 Self-Revision: When Commissioner/STO is going to revise the order himself/herself as Revisional 

Authority.  

 Review Proposal dropped: When proposal for review after examination is closed by 

Commissioner/STO 



 

 

 Failed to file appeal: When Legal Officer was unable to file Appeal as directed by 

Commissioner/STO within time limit   

 Appeal Initiated: When Legal Officer has initiated filing of Appeal as directed by Commissioner/STO  

 Revision Proceedings Initiated: When Commissioner/STO or a Revisional Authority has initiated 

revision proceedings 

 Failed to Initiate Revision Proceedings: When Commissioner/STO or a Revisional Authority was 

unable to initiate revision proceedings within time limit   

  

  



 

 

 

Manual > Conduct an Internal Review of 
Orders and Subsequently Take Actions on the 
Impugned Orders Prejudicial to the Interest 

of the Revenue 

How can I conduct an internal review of Orders and subsequently take 

actions on the impugned Orders prejudicial to the interest of the revenue? 

To conduct an internal review of Orders and subsequently take actions on the impugned Orders 

prejudicial to the interest of the revenue, perform the following steps: 

  

Note: Following four Tax Official roles are defined on the GST Portal by the State Admin to conduct 

internal review of Orders and subsequently take action on the impugned Orders prejudicial to the interest 

of the revenue.  

  

1. Internal Review Cell (IRC) Members. Separate Internal Review Cells will be designated at Divisional 

level and State level. One division will have one Internal Review Cell 

2. Commissioner/Senior tax officer (STO) 

3. Legal Officer 

4. Revisional Authorities 

  

 Steps  
Tax Official Roles Responsible for 

Performing the Step 

Access-

type to 

Tabs in 

"Proposal" 

Screen 

A. Search Orders 

on GST Portal 

for review   IRC Members 

  

Note: Commissioner/STO also can, if 

required, search and view Orders for review 
  

 ---- 

  

  
  

B. View Orders 

and review 

them for legality 

and propriety   



 

 

C. Based on an 

impugned 

Order, Create a 

Proposal case 

and submit it to 

Commissioner/

STO for further 

actions 

IRC Members  

    
Note: The Commissioner/STO may on 
his/her own motion  create a Proposal case 
and take the required action on it.  

D. Search for 

Submitted 

Proposals and 

open the 

Proposal 

Screen 

 IRC Members 

 Commissioner/STO 

    
Note: IRC Members cannot view proposals 
created by Commissioner/STO. 

Note:  

  

A Proposal case, generated with an Internal Reference Number (IRN), is 

organized on the GST Portal's "Proposal" screen into the following four tabs:  

1. ORDER DETAILS: To view and download impugned Order  

2. PROPOSAL: To view and download submitted Proposal against the 

impugned Order  

3. DIRECTIONS: To view or issue directions against the impugned Order  

4. ACTIONS: To view or add actions taken on the issued direction 

  

Depending on the assigned roles, Tax Officials will have Read only i.e. only 

view/download access or both Read and Write Access i.e. access to both 

view/download and also perform actions access to these tabs on their Dashboard.  

  

E. From ORDER 

DETAILS tab: 

View and 

download the 

impugned 

Order to be 

IRC Members Read only 

Commissioner/STO Read only 

Legal Officer Read only 

Revisional Authority Read only 



 

 

reviewed   

F. From 

PROPOSAL 

tab: View and 

download 

Submitted 

Proposal 

against the 

impugned 

Order 

IRC Members Read only 

Commissioner/STO  Read only 

G. From 

DIRECTIONS 

tab: View or 

add following 

Directions— 

G. (1) DIRECT 

TO FILE 

APPEAL  

G. (2) REVISE 

ORDER  

G. (3) DIRECT 

TO REVISE THE 

ORDER  

G. (4) DROP 

THE CASE 
    

Note:  

 The 

Commissioner/ST

O can issue 

direction only once 

against one 

proposal. 

IRC Members Read only 

Commissioner/STO 
Read and 

Write 

Legal Officer 

  
Read only 

Revisional Authority Read only 



 

 

However, if initial 

direction is not 

executed, he/she 

can issue another 

direction.  

 The 

Commissioner/ST

O may revise the 

impugned Orders 

prejudicial to the 

interest of the 

revenue 

himself/herself as 

Revisional 

Authority. 

H. Search for 

Directed 

Proposals 

  

 Legal Officer 

 Revisional Authority 
 ---- 

  

I. From 

ACTIONS tab: 

View or add 

following 

Actions— 

  

I (1) FAILED TO 

FILE APPEAL  

I (2) REVISION 

PROCEEDINGS 

INITIATED  

I (3) APPEAL 

INITIATED  

I (4) FAILED TO 

INITIATE 

REVISION 

IRC Members Read only 

Commissioner/STO 
Read and 

Write 

Legal Officer 

  

Read and 

Write 

Revisional Authority 
Read and 

Write 



 

 

  

Note:  

  
 The 

Commissioner/ST

O can add Actions 

only if he/she has 

assigned the 

Proposal case to 

himself/herself for 

revision as 

Revisional 

Authority.  

 After reviewing the 

 action updated by 

Legal Officer or 

Revisional 

Authority, the 

Commissioner/ST

O may either issue 

another direction 

(if the previous 

direction was not 

executed) or drop 

the case as per 

his/her discretion. 

  

Click each hyperlink in the "Steps" column above to know more.  

A. Search Orders on GST Portal for Review  

To search orders for review, perform following steps: 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > View Orders option. 

  



 

 

 

  

4. View Orders Search page is displayed. You can search based on any of the displayed criterion. Enter 

data in the displayed fields as mentioned in the following steps:  

  

 

  

4a. In the Order category field, select the type of Order from the drop-down list. This is a mandatory field. 

  

 

  

4b. In the Period From & Period To fields, select the date from the calendar. This is a mandatory field. 



 

 

4c.In the Zone field, select the zone in which Order was issued, from the drop-down list. This is not a 

mandatory field. 

4d. In the Ward field, select the Ward in which Order was issued, from the drop-down list. This is not a 

mandatory field. 

4e. In the Tax Liabilities/Refund above  field, enter the amount. This is not a mandatory field. 

4f. In the GSTIN/Temporary ID/UIN field, enter the applicable data. This is not a mandatory field. 

4g. In the Order Number field, enter the Order number. This is not a mandatory field. 

4h. Click the SEARCH button.  

  

5. Based on your search criteria, the required Order or the list of the required Orders get displayed. Click 

View Order hyperlink to view the Order or click Propose Review  hyperlink to create a Proposal case and 

submit it for review to Commissioner/STO. 

  

Note: Propose Review  is for creating a Proposal of review for the case and submitting it for review to 

Commissioner/STO. View Order is for viewing a particular Order.  

  

 

  

Go back to the Main Menu 

B. View Orders and review them for Legality and Propriety  

To view Orders and review them for Legality and Propriety, perform following steps:  

  

1. Search Orders on GST Portal for review   

2. Based on your search criteria, the required Order or the list of the required Orders get displayed. 

Click View Order hyperlink in the "Action" column. 

  



 

 

 

  

3. View Order page is displayed. On this page, you can click the documents in Order Documents 

and/or Supporting Documents (if any) fields to download and review them. To go to the View 

Orders Search page, click BACK. To create a Proposal case and submit it for review to 

Commissioner/STO, click the PROPOSE REVIEW button. 

  

 



 

 

  

Go back to the Main Menu 

C. Create a Proposal case 

To create a Proposal case, perform following steps: 

  

Note: IRC Members will create a Proposal case and submit it to Commissioner/STO for further actions. 

However, the Commissioner/STO may on his/her own motion, create a Proposal case and take the 

required actions on it.   

  

1. Search Orders on GST Portal for review   

2. Based on your search criteria, the required Order or the list of the required Orders get displayed. 

Click Propose Review  hyperlink in the "Action" column.   

  

 

  

  

Note: You can initiate proposing review of an Order from View Order page also by clicking the 

PROPOSE REVIEW button as shown in the image below.  

  



 

 

 

  

3.  Proposal Review  page gets displayed. Click BACK to go to the previous page or enter data in 

the displayed fields as mentioned in the following steps:  

  



 

 

 

  

3a. In the Reference Number field, click the Generate Proposal Number hyperlink. Proposal Number 

field gets auto-populated. 

3b. In the Point for Review field, select the relevant point from the displayed points in the drop-down list 

and click ADD.  

  



 

 

 

  

Note: If you select "16. Others", a blank field will appear. Enter the reason in the field and click ADD.  

  

 

  

3c. In the Ground of review field, click Choose File to upload the relevant document(s) from your 

machine. 

3d. In the Upload Supporting Documents field, click Choose File to upload the relevant document(s) 

from your machine, if required. This is not a mandatory field.  

3e. Click SUBMIT and a Warning popup appears. Click PROCEED.  

  

 



 

 

  

4. Proposal View  page gets displayed with a green message on the top mentioning successful 

submission of the proposal and the generated IRN. You can download the documents you uploaded 

as ground of review by clicking on the document name. Click OK to continue and go back to View 

Orders Search page. 

  

 

  

Go back to the Main Menu 

D. Search for Submitted Proposals and open the Proposal Screen  

To search for submitted Proposals and open the Proposal Screen, perform following steps: 

  

Note: IRC Members cannot view proposals created by Commissioner/STO.   

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Appeal & Revision > Review Proposal option. 

  

 

  



 

 

4. Review Proposal Dashboard page gets displayed. You can search based on any of the 

displayed criterion. Enter data in the displayed fields as mentioned in the following steps:  

  

 

  

4a. In the Internal Reference Number field, enter the Proposal's Internal Reference Number (IRN) 

generated during creation. 

4b. In the GSTIN/Temporary ID/UIN field, enter the applicable data.  

4c. In the Status of Proposal field, select one of the IRN Status, from the drop-down list.  

  

 

  

4d. In the Period From & Period To fields, select the date from the calendar.  

4e. Click the SEARCH button.  

  

Note: Though none of the Search fields are mandatory, you must enter data in at least one field before 

clicking SEARCH. 

  

5. Based on your search criteria, the required Proposal(s) gets displayed. You can sort the list of 

displayed proposals based on their submission date by clicking the arrows next  to Date of 

Submission field. To open a particular proposal, click hyperlink in its IRN column.   

  



 

 

 

  

6. Proposal screen gets displayed. On this page, yellow header provides details of this proposal. 

Also, you can click tabs provided in the left side of the page to view details related to each tab.  

  

 

  

Note: ORDER DETAILS tab is selected by default. 

  

Go back to the Main Menu 

E. View and Download Order to be reviewed from ORDER DETAILS tab on 

the Proposal screen 

To view and download Order to be reviewed from ORDER DETAILS tab on the Proposal screen, perform 

following steps: 



 

 

  

1. Search for Submitted Proposals and open the Proposal Screen 

2. On the Proposal screen, select the ORDER DETAILS tab, if it is not selected by default. This tab 

displays the details of the impugned Order, based on which this Proposal case was created.  

  

 

  

3. Click the document-names in the Order Documents field to download and review.  

  

Go back to the Main Menu 

F. View and Download Submitted Proposal from PROPOSAL tab on the 

Proposal screen 

To view and download submitted Proposal to be reviewed from PROPOSAL tab on the Proposal screen, 

perform following steps: 

  

1. Search for Submitted Proposals and open the Proposal Screen 

2. On the Proposal screen, select the PROPOSAL tab. This tab displays the details of the Proposal 

case.  

  



 

 

 

  

3. Click the document-name(s) in the Ground of review  field or Supporting documents (if any) to 

download and review.  

  

Go back to the Main Menu 

G (1). DIRECT TO FILE APPEAL 

To add DIRECT TO FILE APPEAL direction, perform following steps: 

  

Note: Commissioner/STO will go through the submitted Proposal case and select DIRECT TO FILE 

APPEAL option to direct a Legal Officer to file appeal, if after examining the proposal, he/she is satisfied 

that the impugned Order is not legal/proper and filing of appeal is required. Appeals can be filed on the 

basis of the following two cases: 

 File Appeal before Appellate Authority if the Proposal for Review is against an Adjudication Order 

and difference in the date of communication of Order and the date of directing it is less than or equal 

to <7> months.  

 File Appeal before the next higher forum if the Proposal for Review is against an Order passed by 

First Appellate Authority/Appellate Tribunal/Revision/High Court and difference in the date of 

communication of Order and the date of directing it is less than or equal to <7> months.   

  

1. On the Proposal screen, select the DIRECTIONS tab. This tab displays the direction(s) issued 

against this particular Proposal. Click ADD DIRECTIONS. Then, select DIRECT TO FILE APPEAL.  

  



 

 

 

  

Note: The Commissioner/STO can issue direction only once against a proposal. However, if initial 

direction is not executed and the Legal Officer fails to file an appeal, he/she can issue another direction.  

  

2. DIRECT TO FILE APPEAL page is displayed. Click BACK to go to previous page or enter data 

in the displayed fields as mentioned in the following steps: 

  



 

 

      

  

2a.  In the Reference Number field, click the Generate Reference Number hyperlink. Reference 

Number field gets auto-populated. 

2b.  In the Direct To field, select the relevant authority from the drop-down list. 

2c.  In the Official Assigned field, select the jurisdiction level and the name of the tax officer from their 

respective drop-down lists. 

2d.  In the Point for Review field, select the relevant point from the displayed points in the drop-down list 

and click ADD.  

  



 

 

 

  

Note: If you select "16. Others", a blank field will appear. Enter the reason in the field and click ADD.  

  

 

  

2e.  The Point for review gets added. Click the trash-bin icon to delete it and add another.  

  

 

  

2f.  In the Document Upload field, click Choose File to upload the relevant document(s) from your 

machine. 

2g.  In the Upload Supporting documents field, enter description in Enter Document Description field 

and click Choose File to upload it from your machine, if required. This is not a mandatory field.  



 

 

2h. Click DIRECT and a Warning popup appears. Click PROCEED.  

  

 

  

3. Notice/Reminder/Order page is displayed. Click ISSUE WITH DSC. 

  

 

  

4. Click OK. 

  

 

  

5. DIRECT TO FILE APPEAL direction is added in the DIRECTIONS tab and the Status is changed 

to "Directed To File Appeal". Click the document-name(s) in the Documents field to download if 

required.  



 

 

  

 

  

Note 1: On clicking Click here for details hyperlink in the displayed added direction, following popup is 

displayed. Click OK to close the popup. 

  

 

  

Note 2: Simultaneously, the Legal Officer's Dashboard at Statutory Functions > Appeal & Revision > 

Directions > Proposal is also updated with the issued Direction as shown in the following image. The 

Legal Officer will now review the impugned Order (from ORDER DETAILS tab) and take action according 

to the issued direction.  

  

  

 

  

The Legal Officer can take one of the following actions according to the issued direction:  



 

 

  

 File Appeal before Appellate Authority on the GST Portal  if the difference in the date of 

communication of the impugned Order and the date of filing the appeal is less than or equal to <7> 

months. To know how to file Appeal before Appellate Authority on the GST Portal, click here. 

Subsequent to filing the appeal successfully, the Legal Officer will update the Proposal case on the 

GST Portal (at Statutory Functions > Appeal & Revision > Directions > Proposal > ACTIONS) with 

the "APPEAL INITIATED" Action. 

 File Appeal before Appellate Tribunal/High Court/Supreme Court Offline Manually if the 

difference in the date of communication of the impugned Order and the date of filing appeal is less 

than or equal to <7> months. To know how to file Appeal before Appellate Tribunal/High 

Court/Supreme Court Offline Manually, click here. Subsequent to filing the appeal successfully, the 

Legal Officer will update the Proposal case on the GST Portal (at Statutory Functions > Appeal & 

Revision > Directions > Proposal > ACTIONS) with the "APPEAL INITIATED" Action. 

 Send the Proposal case back to the Commissioner/STO (from Statutory Functions > Appeal & 

Revision > Directions > Proposal > ACTIONS) by updating the ACTIONS tab with “FAILED TO FILE 

APPEAL”, if the difference in the date of communication of the impugned Order and the date of filing 

appeal is more than 7 months. Thereafter, in this case, the Commissioner/STO may either issue 

another direction or drop the case as per his/her discretion.   

  

Go back to the Main Menu 

G (2). REVISE ORDER 

To add REVISE ORDER direction, perform following steps: 

  

Note 1: The Commissioner/STO will examine the submitted Proposal case and select REVISE ORDER 

option, if after examining the proposal, he/she is satisfied that the impugned Adjudication Order is not 

legal/proper and the difference in the date of communication of Order and the date of directing it is 

between 7 months and 3 years (the period of first appeal has expired) and he/she wishes to revise the 

order himself/herself as Revisional Authority.  

  

Note 2:  

 Revision of Order cannot be done within 6+1 (Six+ one) months from the Date of Communication 

of the decision or order sought to be revised. Although Directions to file an appeal can be issued.  

 Revision of Order cannot be done after 3 (Three) years from the Date of order sought to be 

revised. 

 Date of Order being sent by email and SMS will be considered as the Date of Communication of 

Order. If the order is sent by post/special messenger, the date as updated in the system will be 

considered.  

  



 

 

1. On the Proposal screen, select the DIRECTIONS tab. This tab displays the direction(s) issued 

against this particular Proposal. Click ADD DIRECTIONS. Then, select REVISE ORDER.  

  

 

  

2. A warning message is displayed. Click PROCEED. 

  

 

  

3. Successful submission message is displayed and the Status is changed to "Self-Revision". Also, 

path to the new case is mentioned. Navigate to the new case to revise it as Revisional Authority or 

click BACK. 

  

 



 

 

  

4. REVISE ORDER direction is added in the DIRECTIONS tab. 

  

 

  

Note: After issuing the "Self-Revision" direction, the Commissioner/STO may perform the following 

actions. 

  

 Initiate Proceedings for Revision of the Impugned Order and issue notice to Taxpayer and 

Tax Officer for personal hearing. To know how to do this on the GST Portal, click here. Subsequent 

to the issue of the notice for personal hearing, the Revisional Authority will update the Proposal case 

on the GST Portal with the "REVISION PROCEEDINGS INITIATED" Action. 

 Drop Proceedings for Revision of the Impugned Order from Statutory Functions > Appeal & 

Revision > Revision Proceedings. To know how to do this on the GST Portal, click here. Please 

note that depending on Revisional Authority’s discretion, the Proceeding can be dropped without 

issuing hearing as well. Thereafter, subsequent to this action, subsequent to this action, go to 

Statutory Functions > Appeal & Revision > Review Proposal and drop the Proposal case. 

  

Go back to the Main Menu 

G (3). DIRECT TO REVISE THE ORDER 

To add DIRECT TO REVISE THE ORDER direction, perform following steps: 

  

Note 1: Commissioner/STO will examine the submitted Proposal case and select DIRECT TO REVISE 

THE ORDER option, if after examining the proposal, he/she is satisfied that the impugned Adjudication 

Order is not legal/proper and the difference in the date of communication of Order and the date of 

directing it is between 7 months and 3 years (the period of first appeal has expired); he/she will direct the 

case to a Revisional Authority for revision.  

  

Note 2:  

 Revision of Order cannot be done within 6+1 (Six+ one) months from the Date of Communication 

of the decision or order sought to be revised. Although Directions to file an appeal can be issued.  



 

 

 Revision of Order cannot be done after 3 (Three) years from the Date of order sought to be 

revised. 

 Date of Order being sent by email and SMS will be considered as the Date of Communication of 

Order. If the order is sent by post/special messenger, the date as updated in the system will be 

considered.  

  

1. On the Proposal screen, select the DIRECTIONS tab. This tab displays the direction(s) issued 

against this particular Proposal. Click ADD DIRECTIONS. Then, select DIRECT TO REVISE THE 

ORDER.  

  

 

  

2. DIRECT TO REVISE THE ORDER page is displayed. Click BACK to go to previous page or 

enter data in the displayed fields as mentioned in the following steps:  

  



 

 

 

  

2a.  In the Reference Number field, click the Generate Reference Number hyperlink. Reference 

Number field gets auto-populated. 

2b.  In the Official Assigned field, select the jurisdiction level and the name of the tax officer from their 

respective drop-down lists. 

2c. In the Point for Review field, select the relevant point from the displayed points in the drop-down list 

and click ADD.  

  



 

 

 

  

Note: If you select "16. Others", a blank field will appear. Enter the reason in the field and click ADD.  

  

 

  

2d.  The Point for review gets added. Click the trash-bin icon to delete it and add another.  

  

 

  

2e.  In the Document Upload field, click Choose File to upload the relevant document(s) from your 

machine. 

2f.  In the Upload Supporting documents field, enter description in Enter Document Description field 

and click Choose File to upload it from your machine, if required. This is not a mandatory field.  



 

 

2g.   Click DIRECT and a Warning popup appears. Click PROCEED.  

  

 

  

3. Notice/Reminder/Order page is displayed. Click ISSUE WITH DSC. 

  

 

  

4. Click OK. 

  

 

  

5. DIRECT TO REVISE THE ORDER direction is added in the DIRECTIONS tab and the Status is 

changed to "Directed For Revision". Click the document-name(s) in the Documents field to 

download if required.  



 

 

  

 

  

Note 1: On clicking Click here for details hyperlink in the displayed added direction, following popup is 

displayed. Click OK to close the popup. 

  

 

  

Note 2: Simultaneously, the Revisional Authority's Dashboard at Statutory Functions > Appeal & 

Revision > Directions > Proposal is also updated with the issued Direction. The Revisional Authority will 

now review the impugned Order (from ORDER DETAILS tab) and take action according to the issued 

direction.  

  

 

  

The Revisional Authority can take one of the following actions according to the issued direction:  

  



 

 

 Initiate Proceedings for Revision of the Impugned Order and issue notice to Taxpayer and 

Tax Officer for personal hearing. To know how to do this on the GST Portal, click here. Subsequent 

to the issue of the notice for personal hearing, the Revisional Authority will update the Propos al case 

on the GST Portal (at Statutory Functions > Appeal & Revision > Directions > Proposal > ACTIONS)  

with the "REVISION PROCEEDINGS INITIATED" Action. 

 Drop Proceedings for Revision of the Impugned Order. To know how to do this on the GST 

Portal, click here. Please note that depending on Revisional Authority’s discretion, the Proceeding 

can be dropped without issuing hearing as well. Then, subsequent to this, update the Proposal case 

on the GST Portal (at Statutory Functions > Appeal & Revision > Directions > Proposal > ACTIONS) 

with the "FAILED TO INITIATE REVISION" Action. Thereafter, in this case, the Commissioner/STO 

may either issue another direction or drop the case as per his/her discretion.   

  

Go back to the Main Menu 

G (4). DROP THE CASE 

To add DROP THE CASE direction, perform following steps: 

  

Note: Commissioner/STO will examine the submitted Proposal case and select the DROP THE CASE 

option to close the case if, after examining the proposal, he/she is satisfied that the revision of the Order 

is not required and no appeal is required to be filed. He/she may drop the case at any stage after the 

initiation of the Proposal case.  

  

1. On the Proposal screen, select the DIRECTIONS tab. This tab displays the direction(s) issued 

against this particular Proposal. Click ADD DIRECTIONS. Then, select DROP THE CASE.  

  

 

  

2. DROP THE CASE page is displayed. Click BACK to go to previous page or enter data in the 

displayed fields as mentioned in the following steps: 

  



 

 

 

  

2a.  In the Reference Number field, click the Generate Reference Number hyperlink. Reference 

Number field gets auto-populated. 

2b.  In the Reason for Dropping the Proposal field, select the relevant point from the displayed points in 

the drop-down list and click ADD.  

  

 

  

Note: If you select "16. Others", a blank field will appear. Enter the reason in the field and click ADD.  

  



 

 

 

  

2c. The Reason for dropping the Proposal gets added. Click the trash-bin icon to delete it and add 

another.  

  

 

  

2d.  In the Upload Supporting documents field, enter description in Enter Document Description field 

and click Choose File to upload it from your machine, if required. This is not a mandatory field.  

2e.  Click DIRECT and a Warning popup appears. Click PROCEED.  

  

 

  

3. Notice/Reminder/Order page is displayed. Click ISSUE WITH DSC. 

  



 

 

 

  

4. Click OK. 

  

 

  

5. DROP THE CASE direction is added in the DIRECTIONS tab and the Status is changed to 

"Review Proposal Dropped". If supporting documents were also uploaded while issuing this direction, 

these will be available in the Documents field for download if required.  

  

 

  

  

Note: On clicking Click here for details hyperlink in the displayed added direction, following popup is 

displayed. Click OK to close the popup. 

  



 

 

 

  

Go back to the Main Menu 

H. Search for Directed Proposals 

To search proposals directed by Commissioner/STO, perform following steps: 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Appeal & Revision > Directions option. 

  

 

  

4. Directions Search screen is displayed. You can search based on any of the displayed criterion. 

Enter data in the displayed fields as mentioned in the following steps:  

  

 

  



 

 

4a. In the Internal Reference Number field, enter the Proposal's Internal Reference Number (IRN) 

generated during creation. 

4b. In the GSTIN/Temporary ID/UIN field, enter the applicable data.  

4c. In the Status of Proposal field, select the IRN Status, from the drop-down list.  

  

 

  

Note: Legal Officers will select the IRN Status as "Directed to File Appeal" and Revisional Authority will 

select "Directed for Revision".  

  

4d. In the Period From & Period To fields, select the date from the calendar.  

4e. Click the SEARCH button.  

  

Note: Though none of the Search fields are mandatory, you must enter data in at least one field before 

clicking SEARCH. 

  

5. List of Directed Proposals is displayed. Click the hyperlinks in the IRN column.  

  

 

  



 

 

6. Proposal screen gets displayed. On this page, yellow header provides details of this proposal. 

Also, you can click tabs provided in the left side of the page to view details related to each tab.  

  

 

  

Note: ORDER DETAILS tab is selected by default. 

  

Go back to the Main Menu 

I. View/Add Actions from ACTIONS tab on the Proposal screen 

To view or add Actions from ACTIONS tab on the Proposal screen, perform following steps: 

  

Note: The Commissioner/STO can add Actions only if he/she has assigned the Proposal case to 

himself/herself for revision as Revisional Authority.   

  

1. On the Proposal screen, in the ACTIONS tab, click ADD ACTIONS. This tab displays update on 

the actions taken by the Tax Officials on the Direction issued by the Commissioner/STO. Select any 

one of the following Actions on case-basis: FAILED TO FILE APPEAL or REVISIONS 

PROCEEDINGS INITIATED or APPEAL INITIATED or FAILED TO INITIATE REVISION. 

  



 

 

 

  

Note:  

Select the Actions based on the following cases: 

 FAILED TO FILE APPEAL: If the Legal Officer was unable to file Appeal as per the issued 

direction, where the difference in the date of communication of Order and the date of filing appeal 

was more than 7 months  

 REVISION PROCEEDINGS INITIATED: If the Revisional Authority or the Commissioner/STO 

himself/herself has successfully initiated revision of the Order as per the issued direction  

 APPEAL INITIATED: If the Legal Officer has successfully filed an Appeal as per the issued 

direction  

 FAILED TO INITIATE REVISION: If the Revisional Authority or the Commissioner/STO 

himself/herself  was unable to initiate revision of the Order as per the issued direction 

  

2. A new page is displayed in the Actions tab. Click BACK to go to previous page or enter data in 

the displayed fields as mentioned in the following steps: 

  



 

 

      

  

2a. In the Reference Number field, click the Generate Reference Number hyperlink. Reference Number 

field gets auto-populated. 

2b. In the Remarks field, enter information relevant to this action.  

2c.  In the Upload Supporting documents field, enter description in Enter Document Description field 

and click Choose File to upload it from your machine, if required. This is not a mandatory field. 

2d. Click SUBMIT and a Warning popup appears. Click PROCEED.  

  



 

 

 

  

3. Notice/Reminder/Order page is displayed. Click ISSUE WITH DSC. 

  

 

  

4. Click OK. 

  

 

  

5. Based on the selected Action, Actions tab's Dashboard page is updated with the related table 

and the IRN Status is updated accordingly.  

  



 

 

5a. In case of FAILED TO FILE APPEAL action, following table is added and the Status is changed to " 

FAILED TO FILE APPEAL". If supporting documents were also uploaded while adding this action, these 

will be available in the Documents field for download if required.  

  

 

  

5b. In case of REVISION PROCEEDINGS INITIATED action, following table is added and the Status is 

changed to "Revision Proceedings Initiated". If supporting documents were also uploaded while adding 

this action, these will be available in the Documents field for download if required.  

  

 

  

5c. In case of APPEAL INITIATED action, following table is added and the Status is changed to "Appeal 

Initiated". If supporting documents were also uploaded while adding this action, these will be available in 

the Documents field for download if required.  

  

 

  

5d. In case of FAILED TO INITIATE REVISION action, following table is added and the Status is 

changed to "Failed To Initiate Revision Proceedings". If supporting documents were also uploaded while 

adding this action, these will be available in the Documents field for download if required.  

  



 

 

 

  

6. Once the ACTIONS tab is updated, the Commissioner/STO will review this update and either 

issue another direction (if the previous direction was not executed) or drop the case as per his/her 

discretion. 

  

Go back to the Main Menu 

  

  



 

 

File an Appeal before the First Appellate Authority 
(Form GST APL-03) 

FAQs > File an Appeal before the First 
Appellate Authority 

1. I am not getting Filing Appeal link in my Dashboard. Why? 

You may not have been assigned the role of Legal Officer by the state admin. Request your state admin 

to allocate you the role of Legal Officer. Once the role is assigned you will be allocated Filing Appeal 

module for further action. 

  

Click here to learn about the various roles available in Tax Officials Interface and how a Admin can assign 

the role to Tax Officials. 

2. What are the pre-conditions to file an appeal before the First Appellate 

Authority? 

The pre-conditions to file an appeal before the First Appellate Authority are:  

1. Order has been issued by Adjudicating Authority.  

2. Review Proposal is received by the Commissioner by Internal Review Cell Commissioner directs, 

Legal Officer to file appeal before the First Appellate Authority.  

3. By when can I file an appeal before the First Appellate Authority? 

Appeal by the Department can be filed within 6 months from the date of communication of the Order. 

However on sufficient grounds, the Appellate Authority can allow it to be presented within a further period 

of one month and thus can condone the delay in filing to the extent of one month.  

If the appeal is not filed within 7 months, a message appears on screen that "prescribed time is lapsed do 

you stil want to file an appeal". You can click Yes and continue to file an appeal. 

4. How can I file an appeal before the First Appellate Authority? 

Navigate to Statutory Functions > Appeal & Revision > Filing Appeal > Appeal to Appellate 

Authority option to file an appeal before the First Appellate Authority. 

5. What happens when appeal application is filed by the Legal Officer? 



 

 

When appeal application is filed by the Legal Officer: 

1. Form of Appeal as submitted by Legal Officer lands in the Dashboard of First Appellate Authority’s 

queue of Appeal’s received. 

2. Admission & Rejection of Application for Appeal & First Appeal Proceedings/ Hearing use case for 

appeal procedure will be followed. 

6. How can I view notice issued by the First Appellate Authority? 

Navigate to Statutory Functions > Appeal & Revision > Filing Appeal  > Search Application > 

NOTICES option to view notice issued by the First Appellate Authority.  

7. How can I view order issued by the First Appellate Authority? 

Navigate to Statutory Functions > Appeal & Revision > Filing Appeal  > Search Application > 

ORDERS option to view notice issued by the First Appellate Authority.  

8. How can I view internal communication issued by the First Appellate 

Authority? 

Navigate to Statutory Functions > Appeal & Revision > Filing Appeal  > Search Application > 

INTERNAL COMMUNICATION option to view internal communication issued by the First Appellate 

Authority. 

9. What are the various status of the appeal application filed before the 

First Appellate Authority? 

The list below provides the list of statuses of the appeal application filed before the First Appellate 

Authority: 

  

1. Appeal admitted: Appeal application Form is successfully admitted by First Appellate Authority 

2. Hearing notice issued: When notice for hearing is issued by First Appellate Authority 

3. Counter reply received: When Counter Reply from taxpayer is received against notice  

4. Show cause notice issued: When Show cause notice is issued to taxpayer or concerned person 

5. Appeal order passed: Appeal is confirmed/modified/rejected by First Appellate Authority 

6. Adjournment granted: When hearing is adjourned and next date of hearing is issued  

7. Rectification request received: When application is filed for Rectification of order 

8. Rectification request rejected: When application for Rectification is rejected by First Appellate 

Authority 

9. Rectification order passed: When application for Rectification is passed by First Appellate Authority 



 

 

 

Manual > File an Appeal before the First 
Appellate Authority against order (Form GST 
APL-03) 

How can I (in the role of Legal Officer) file an appeal before the First 

Appellate Authority? 

To file an appeal before the First Appellate Authority, in the role of Legal Officer assigned for a 

jurisdiction, perform following steps: 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Appeal & Revision > Filing Appeal option. 

  

 

  

4. Select the Appeal to Appellate Authority link. 

  

 

  

5. The Appeal to Appellate Authority page is displayed.  

  

 

  

6.1. Here, you can either search the submitted application or file a new appeal application.  



 

 

6.2. To search for submitted application, choose any one of the four displayed fields as your search 

criteria and enter the required information: ARN, GSTIN/ Temporary ID/ UIN, or Period From & Period 

To date, Status (select from the drop-down list as shown).  

  

 

  

6.3. The search results are displayed. 

  

 

  

7. To file a new appeal application, click the NEW APPEAL button. 

  

 

  

8. The New Appeal page is displayed. 

  



 

 

 

  

9. Select the Order Type as Demand Order from the drop-down list. 

  

 

  

10. In the Order No field, enter the Order Number.  

11. Click the SEARCH button. 

  

 

  

12. The Application to the Appellate Authority page is displayed. 

  



 

 

 



 

 

  

13. Period of Dispute is displayed on the screen. However, you can edit the same.  

  

 

  

14. Select the Category of the case under dispute  from the drop-down list. 

  

 

  

Note: If you select "16. Others", a blank field will appear. Enter the reason in the field.  

  

 

  

15. Click the ADD button. 

  



 

 

 

  

16. You can add multiple line items from the Category of the case under dispute drop-down list by clicking 

the ADD button.  

Note: You can click the DELETE button to delete the details added. 

  

 

  

17.1. The amount of demand created under major and minor heads is displayed. Use the scroll bar to 

move to the right. 

  

 

  

17.2. The total amount of demand created is displayed. 

  



 

 

 

  

18.1. Enter the amount which is under dispute under major and minor heads. Use the scroll bar to move 

to the right. 

  

 

  

18.2. When total amount of demand is disputed, the admitted amount becomes zero and taxpayer is 

required to pre deposit 10% of disputed amount.   

Note: Once appeal is admitted, the demand is stayed for recovery purpose till the disposal of the matter.  

  

 



 

 

  

19. Click the Download Template  link to download the Annexure to GST APL-03. 

  

 

  

20. The GST APL-03 Template is downloaded. Open the downloaded template.  

  

 

  

21. Click the Enable Editing button. 

  



 

 

 
 
22. Enter the details.  
   



 

 

 
 
23. Once you have entered the details, click on the File button in top left corner.  
   

 
   
24. Click the Save As button.  
25. Now select the location to save the file and in the File Name list, type or select a name for the 

document.  

26. In the Save as type list, select PDF. 

27. Click the Save button. 

  



 

 

 

28. After entering the details, click the Choose File button to upload the PDF. 

Note: You can upload file with maximum size of upload as 5 MB. 

  

 

  

29. Select the PDF file which was saved and click the Open button. 

  



 

 

 

  

30. You can use the Delete button to delete the uploaded document, if required.  

  

 

  

31. To upload any other supporting document, enter the document description and click the Choose File 

button. 

Note: 

 Only PDF & JPEG file format is allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 supporting documents can be attached in the application.  

  



 

 

 

  

32. Select the file to be uploaded and click the Open button. 

  

 

  

33. Click the ADD DOCUMENT button to add the uploaded supporting document. 

  

 



 

 

  

34. The PDF file is uploaded. You can click the DELETE button to delete the uploaded PDF file. 

  

 

  

35. To preview the application before filing, Click the PREVIEW button.  

  

 

  

36. The PDF file will be downloaded. Open the pdf file and check if all the details are correctly updated. 

  



 

 

 

  

37. Enter the Place where application is filled. 

38. Click the PROCEED TO FILE button. 

  

 

  

39. Click the PROCEED button. 

  



 

 

 

  

40. The Issue Notice/Reminder/Order page is displayed. Click ISSUE with DSC.  

  

 

  

41. A confirmation message is displayed that form has been signed. You can click the DOWNLOAD 

button to download the acknowledgement receipt. 

  



 

 

 

  

42. The acknowledgement receipt is downloaded in the PDF format. 

  

 

  

43. Click OK.  

  



 

 

 

  

44. The status of the appeal application is updated to "Appeal Submitted". Select the ARN link. 

  

 

  

45. The updated Case Detail page is displayed, with the table containing the record of the application 

submitted.  

Note: When appeal application is filed by the Legal Officer:  

i. Form of Appeal as submitted by Legal Officer lands in the First Appellate Authority’s queue of Appeal’s 

received. 

ii. Admission & Rejection of Application for Appeal & First Appeal Proceedings/ Hearing use case for 

appeal procedure will be followed. 

  



 

 

 



 

 

Upload details of Appeal to Higher Authority (Other 
than First Appeal) 

FAQs > Appeal to Higher Authority - Upload 
details of appeals filed with or order issued 
by Appellate Tribunal/ High Court/ Supreme 
Court in GST Portal 

1. I am not getting Filing Appeal link in my Dashboard. Why? 

You may not have been assigned the role of Legal Officer by the State Admin. You may request your 

State Admin to allocate you the role of Legal Officer. Once the role is assigned you will be allocated 

"Filing Appeal" module for further action. 

  

Click here to learn about the various roles available in Tax Officials Interface and how Admin can assign 

the role to Tax Officials. 

2. Why do I need to upload appeal details filed with authorities like 

Appellate Tribunal, High Court, and Supreme Court? 

Appeals can be filed with various authorities like First Appellate Authority, Appellate Tribunal, High Court, 

and Supreme Court. GST Portal only has integration with the First Appellate Authority. Therefore, all 

other appeals filed with the authorities by Taxpayer or Tax Department needs to be uploaded manually on 

the GST Portal.  

  

Status of the appeal application on GST Portal will change only when Legal Officer updates the appeal 

details which have been filed with higher authorities offline. 

3. What are the pre-conditions to upload appeal details filed with 

authorities like Appellate Tribunal, High Court, and Supreme Court? 

Pre-conditions to upload appeal details filed with authorities like Appellate Tribunal, High Court, and 

Supreme Court are: 

 Appeal is filed with Appellate Tribunal/ High Court/ Supreme Court  

 Order is issued by Appellate Tribunal/ High Court/ Supreme Court  



 

 

4. What will happen after I upload appeal details filed with authorities like 

Appellate Tribunal, High Court, and Supreme Court? 

Once you upload appeal details filed with authorities like Appellate Tribunal, High Court, and Supreme 

Court: 

 Details of Appeal & Appeal Order will be available for viewing with the taxpayer, Tax Official who 

passed the order and the Commissioner. They can take print/ download the appeal details.  

 Adjudicating Officer will be notified about the Appeal being filed against his order.  

 If Demand Order-in-appeal is remanded, then the order will land back on Tax Official’s dashboard 

as a pending work item. 

5. From where can I upload appeal details filed with authorities like 

Appellate Tribunal, High Court, and Supreme Court? 

Navigate to Statutory Functions > Appeal & Revision > Filing Appeal > Appeal to Higher Authority 

option. 

6. From where can I view or add order issued by the Higher Authority? 

Navigate to Statutory Functions > Appeal & Revision > Filing Appeal > Appeal to Higher Authority 

> ORDER DETAILS option. 

Legal officer can upload proceedings of the case as PDF document.  

7. Who can view the appeal details after appeal details filed with authorities 

like Appellate Tribunal, High Court, and Supreme Court are uploaded on 

the GST Portal? 

Once you upload appeal details filed with authorities like Appellate Tribunal, High Court, and Supreme 

Court, details of Appeal & Appeal Order will be available for viewing with the taxpayer, Tax Official who 

passed the order and the Commissioner. 

8. What are the various statuses of appeal application while uploading 

appeal details filed with higher authorities? 

Listed below are various statuses of appeal application while uploading appeal details filed with higher 

authorities: 

1. Appeal Initiated:  When appeal is initiated with proper authority and details are uploaded on the GST 

Portal by Legal Officer 

2. Stay Order Issued: When stay order is issued by higher authorities and updated by Legal Officer on the 

GST Portal 



 

 

3. Appeal Order Issued: When appeal order is issued by higher authorities and updated by Legal Officer 

on the GST Portal 

4. Remand Instructions Issued: When remand instructions is issued by higher authorities and updated by 

Legal Officer on the GST Portal 

5. Remand Order Issued: When remand order is issued by higher authorities and updated by Legal 

Officer on the GST Portal 

  



 

 

 

Manual > Appeal to Higher Authority - Upload 
details of appeals filed with or order issued 
by Appellate Tribunal/ High Court/ Supreme 

Court in GST Portal 

How can I (in the role of Legal Officer) upload details of appeals filed with 

or order issued by Appellate Tribunal/ High Court/ Supreme Court in GST 

Portal? 

To upload details of appeals filed with or order issued by Appellate Tribunal/ High Court/ Supreme in GST 

Portal, the Legal Officer need to perform following steps: 

  

A. Upload Appeal Details 

B. Go to Appeal application page 

C. View Uploaded Appeal Application Documents 

D. Add Order 

 D (1) Add Remand Order 

 D (2) Add Remand Instructions 

 D (3) Add Stay Order 

 D (4) Add Appeal Order 

  

Click each hyperlink above to know more. 

A. Upload Appeal Details 

To upload details of appeal filed with higher authorities on the GST Portal, perform following steps: 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Appeal & Revision > Filing Appeal option. 

  

 

  

4. Select the Appeal to Higher Authority link. 

  



 

 

 

  

5. The Appeal to Higher Authority page is displayed. 

  

 

  

6. To file a new appeal application, click the NEW APPEAL button. 

  

 

  

7. The New Appeal page is displayed. 

  

 

  

8. In the GSTIN/ Temporary ID/ UIN field, enter the GSTIN or temporary ID or UIN of the taxpayer. 

9. In the Order No field, enter the Order Number.  

10. Click the SEARCH button. 

  

 



 

 

  

11. The Appeal details to be uploaded in GST Portal  page is displayed. 

  



 

 

 



 

 

  

12. In the Case/ Appeal No field, enter the case or appeal number. 

13. Select the Date of Appeal using the calendar. 

14. Select Appeal filed before using the drop-down list. 

  

 

  

15. In the Appellant field, enter the name of the Appellant. 

16. In the Respondent field, enter the name of the Respondent. 

17. Select the Date of hearing issued using the calendar. 

  

 

  

18. Select Yes or No for Stay Order issued. 

18.1. In case of Yes, enter the Stay Order Number. 

18.2. Select the Stay Order Date using the calendar. 

18.3. Click the Choose File button to upload the Stay Order document. 

Note: You can upload only PDF format with maximum size of upload as 5 MB. 

  

 

  

19. Click the Choose File button to upload the notice document. 



 

 

Note: You can upload only PDF format with maximum size of upload as 5 MB.  

20. To upload any other supporting document, enter the document description and click the Choose File 

button. 

Note: 

 Only PDF & JPEG file format is allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 supporting documents can be attached in the application.  

  

 

  

21. Click the ADD DOCUMENT button to add the uploaded supporting document. 

  

 

  

21.1. The PDF file is uploaded. You can click the DELETE button to delete the uploaded PDF file, in 

required. 

  



 

 

 

  

22. To preview the details before uploading, click the PREVIEW button.  

  



 

 

 

  

23. The PDF file will be downloaded. Open the pdf file and check if all the details are correctly updated. 

  



 

 

 

  

24. Click the SUBMIT button. 

  



 

 

 

  

25. Click the PROCEED button. 

  



 

 

 

  

26. A confirmation message is displayed that details are successfully uploaded. You can click the 

DOWNLOAD button to download the acknowledgement receipt. 

  

 

  

27. The acknowledgement receipt is downloaded in the PDF format. 

  



 

 

 

  

28. Click OK.  

  

 

  

29. The status of the appeal application is updated to "Appeal Initiated".  

  

 



 

 

  

30. Select the IRN (Internal Reference Number) link. 

  

 

  

31. The updated Case Detail page is displayed, with the table containing the record of the details 

uploaded.  

  

 

  

Go back to the Main Menu 

B. Go to Appeal application page by searching for the 

IRN/GSTIN/Status/Period 

To go to appeal application page, perform following steps: 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Appeal & Revision > Filing Appeal  option. 

  

 



 

 

  

4. Select the Appeal to Higher Authority link. 

  

 

  

5. The Appeal to Higher Authority page is displayed.  

  

 

  

6. To search for submitted application, choose any one of the four displayed fields as your search criteria 

and enter the required information: IRN, GSTIN/ Temporary ID/ UIN, or Period From & Period To date, 

Status (select from the drop-down list as shown).  

  

 

  

7. Click the SEARCH button. 

  

 

  

8. The search results are displayed. 

9. Select the IRN link. 

  



 

 

 

  

10. The updated Case Detail page is displayed, with the table containing the record of the details 

uploaded.  

  

 

  

Go back to the Main Menu 

C. View Uploaded Appeal Application Documents 

To view uploaded Appeal application documents, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the APPEAL DETAILS tab if it is not 

selected by default. This tab displays the entire application, in PDF mode, with all its attachments.  

2. Click the Document links under View Documents column to view the application and its attachments in 

PDF mode.  

  



 

 

 

  

Go back to the Main Menu 

D (1) Add Remand Order 

To add remand order issued by higher authorities, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the ORDER DETAILS tab. This tab displays 

a table of all the records for which you would issue orders against the case created.  

2. Click ADD ORDER to open the drop-down list and select REMAND ORDER. 

  

 

  

3. The Remand Order page is displayed. 

  



 

 

 

  

4. In the Remand Order Number field, enter the remand order number. 

5. Select the Remand Order Date using the calendar. 

6. Select the Date of Communication of the Order using the calendar. 

7. Click the Choose File button to upload remand order. 

8. To upload any other supporting document, enter the document description and click the Choose File 

button. 

Note: 

 Only PDF & JPEG file format is allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 supporting documents can be attached in the application.  

  

 



 

 

  

9. Click the ADD DOCUMENT button to add the uploaded supporting document. 

  

 

  

10. The PDF file is uploaded.  

10.1. You can click the DELETE button to delete the uploaded PDF file, in required. 

  

 

  

11. Click the SUBMIT button. 

  



 

 

 

  

12. Click the PROCEED button. 

  

 

  

13. The updated Case Detail page is displayed, with the table containing the record of the order just 

passed and the Status updated to "Remand Order Issued". Also, system would send the intimation to the 

taxpayer via email and SMS, and make this order available on the taxpayer’s dashboard.  

  



 

 

 

  

Go back to the Main Menu 

D (2) Add Remand Instructions 

To add remand instructions issued by higher authorities, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the ORDER DETAILS tab. This tab displays 

a table of all the records for which you would issue orders against the case created.  

2. Click ADD ORDER to open the drop-down list and select REMAND INSTRUCTIONS. 

  

 

  

3. The Remand Instructions page is displayed. 

  



 

 

 

  

4. In the Remand Instruction Number field, enter the remand instruction number. 

5. Select the Remand Instruction Date  using the calendar. 

6. Select the Date of Communication of the Order using the calendar. 

7. Click the Choose File button to upload order. 

8. To upload any other supporting document, enter the document description and click the Choose File 

button. 

Note: 

 Only PDF & JPEG file format is allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 supporting documents can be attached in the application.  

  



 

 

 

  

9. Click the ADD DOCUMENT button to add the uploaded supporting document. 

  

 

  

10. The PDF file is uploaded.  

10.1. You can click the DELETE button to delete the uploaded PDF file, in required. 

  

 

  

11. Click the SUBMIT button. 

  



 

 

 

  

12. Click the PROCEED button. 

  

 

  

13. The updated Case Detail page is displayed, with the table containing the record of the order just 

passed and the Status updated to "Remand Instructions Issued". Also, system would send the intimation 

to the taxpayer via email and SMS, and make this order available on the taxpayer’s dashboard.  

  



 

 

 

  

Go back to the Main Menu 

D (3) Add Stay Order 

To add stay order issued by higher authorities, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the ORDER DETAILS tab. This tab displays 

a table of all the records for which you would issue orders against the case created.  

2. Click ADD ORDER to open the drop-down list and select STAY ORDER. 

  

 

  

3. The Stay Order page is displayed. 

  



 

 

 

  

4. In the Stay Order Number field, enter the stay order number. 

5. Select the Stay Order Date using the calendar. 

6. Click the Choose File button to upload Stay Order. 

7. To upload any other supporting document, enter the document description and click the Choose File 

button. 

Note: 

 Only PDF & JPEG file format is allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 supporting documents can be attached in the application.  

  

 

  

8. Click the ADD DOCUMENT button to add the uploaded supporting document. 

  



 

 

 

  

9. The PDF file is uploaded.  

9.1. You can click the DELETE button to delete the uploaded PDF file, in required. 

  

 

  

10. Click the SUBMIT button. 

  



 

 

 

  

11. Click the PROCEED button. 

  

 

  

12. The updated Case Detail page is displayed, with the table containing the record of the order just 

passed and the Status updated to "Stay Order Issued". Also, system would send the intimation to the 

taxpayer via email and SMS, and make this order available on the taxpayer’s dashboard.  

  



 

 

 

  

Go back to the Main Menu 

D (4) Add Appeal Order 

To add appeal order issued by higher authorities, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the ORDER DETAILS tab. This tab displays 

a table of all the records for which you would issue orders against the case created.  

2. Click ADD ORDER to open the drop-down list and select APPEAL ORDER. 

  

 

  

3. The Appeal Order page is displayed. 

  



 

 

 

  

4. In the Appeal Order Number field, enter the appeal order number. 

5. Select the Appeal Order Date using the calendar. 

6. Select the Date of Communication of the Order using the calendar. 

7. Select the Status of Order from the drop-down list. 

  

 

  

8. Click the Choose File button to upload appeal order. 

9. To upload any other supporting document, enter the document description and click the Choose File 

button. 

Note: 

 Only PDF & JPEG file format is allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 supporting documents can be attached in the application.  

  



 

 

 

  

10. Click the ADD DOCUMENT button to add the uploaded supporting document. 

  

 

  

11. The PDF file is uploaded.  

11.1. You can click the DELETE button to delete the uploaded PDF file, in required. 

  

 

  

12. Click the SUBMIT button. 

  



 

 

 

  

13. Click the PROCEED button. 

  

 

  

14. The updated Case Detail page is displayed, with the table containing the record of the order just 

passed and the Status updated to "Appeal Order Issued". Also, system would send the intimation to the 

taxpayer via email and SMS, and make this order available on the taxpayer’s dashboard.  

  



 

 

 

  

Go back to the Main Menu 

  

  

  



 

 

View Cause List 

FAQs > Appeal > View Cause List 

1. What is a cause list? 

When an application is filed/referred or order has to be rectified by the authorities or to be declared as 

void ab initio, a date of hearing is issued by the Tax Official and communicated to the parties by the GST 

Portal. 

A cause list of all such dates is maintained in the GST Portal. This cause list can be printed/ saved in 

PDF. 

2. From where can I view the cause list? 

To view the cause list, navigate to Statutory Functions > Cause List option. 

3. Is the Cause List updated in real time? 

Yes, Cause list is updated on real time basis. 

4. Who can view Cause List? 

Cause List can be viewed by any Tax Official irrespective of their role.  

  



 

 

Manual > Appeal > View Cause List 

To search and view Cause List of appeal applications, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Navigate to Statutory Functions > Cause List option. 

  

 

  

4. The Cause List screen is displayed.  

  

 

  

5. Select the Type of Authority from the drop-down list. 

  

 

  

6. Select the Jurisdiction from the drop-down list. 

7. Select the From and To Date using the calendar. 

8. Click SEARCH. 

9. The Cause List of the day is displayed. 

  



 

 

 

  

  



 

 

Conduct Revision Order Proceedings 

FAQs > Conduct Revision Order Proceedings 

1. Which all Tax Official Roles are involved in Revision Order Proceedings? 

Following three Tax Official roles can be assigned by a State Admin to conduct proceedings related to 

Revision of impugned Orders, prejudicial to the interest of the revenue:  

  

1. Commissioner/Senior Tax Officer (STO): Issue the required directions on the impugned 

adjudication Orders to the Revisional Authority and/or Revise the Order as Revisional Authority 

himself/herself  

2. Revisional Authority (RA): Revise the impugned Adjudication Orders on his own motion or 

based on the directions given by the Commissioner/STO 

3. Adjudicating Authority (A/A): is the Tax Official who has issued the impugned adjudication 

Order. In Revision Proceedings, he/she needs to take action as directed by the RA, such as filing 

reply or appearing for Personal Hearing as specified in the Notice.  

  

2. On the GST Portal, how are Revision Order Proceedings conducted? 

On the GST Portal, the Revision Order Proceedings are conducted as per the following steps: 

  

1. Commissioner/STO issues the required directions on the impugned adjudication Orders to the RA.  

  

2. Commissioner/STO (himself/herself as RA) or RA initiates the proceedings by issuing a Revision 

Notice to the concerned parties. He/she will initiate proceedings if the difference in the date of 

communication of Order and the date of revising it is between 7 months and 3 years (the period of first 

appeal has expired). Or else, Revision Proceedings won't be initiated. 

  

Note: With the issue of the Revision Notice, following actions take place on the GST Portal:  

 An Internal Reference Number (IRN) is generated with the Status as "Revision Notice Issued".  

 Intimation of the issue of Notice is sent to the concerned taxpayer and the A/A on their registered 

email id. Taxpayers would receive an SMS notification also on their registered mobile.  

 Dashboard of the A/A and Taxpayer is updated with the record of the issued Notice. Taxpayer 

can view the issued Notice from the following navigation: Services > User Services > View 

Additional Notices/Orders and the A/A can view it from Statutory Functions > My Tasks > 

Reference Id > NOTICES  

 Date of hearing, as specified in the Notice, is updated in the GST Portal's Cause list.  



 

 

 The demand Id issued on the impugned Order by adjudication authority shall continue and status 

will be "stayed" until an Order is issued on the Revision Proceedings.  

  

3. Commissioner/STO or RA updates the Directed Proposal as "REVISION PROCEEDINGS INITIATED" 

or "FAILED TO INITIATE REVISION", as per the action taken on that particular case. In case of "FAILED 

TO INITIATE REVISION", the Commissioner/STO may either drop the Proposal or issue some other 

direction. In case of "REVISION PROCEEDINGS INITIATED", following actions take place.  

  

Note:  

 Commissioner/STO updates the Directed Proposal from: Statutory Functions > Appeal & 

Revision > Review Proposal. 

 RA updates the Directed Proposal from: Statutory Functions > Appeal & Revision > 

Directions 

  

4. The recipients of the Revision Notice can file their replies on the Portal.  

  

Note: With the filing of Reply, following actions also take place on the GST Portal:  

9. IRN Status gets changed to "Reply Submitted".   

10.  Dashboard of the RA and the concerned parties is updated with the record of the filed Reply.  

o Taxpayer can view the filed Reply from: Services > User Services > View Additional 

Notices/Orders 

o A/A can view the filed Reply from Statutory Functions > My Tasks > Reference Id > REPLIES . 

o RA can view the filed Reply from Statutory Functions > Appeal & Revision > Revision 

Proceedings. 

   

5. In case of no reply from the concerned parties, Revisional Authority can issue a Reminder to them. On 

the day of the hearing, parties appear before the Revisional Authority to present their case. Revisional 

Authority can adjourn the hearing and issue an adjournment notice with the new date/time and venue of 

personal hearing, if required. 

  

Note: With the issue of the Reminder or Adjournment, following actions also take place on the GST 

Portal: 

9. In case a Reminder is issued, the IRN Status gets changed to "Reminder Notice Issued" and in 

case of Adjournment the Status will be "Adjournment Granted".   

10.  Intimation of the issue of Notice is sent to the concerned taxpayer and the A/A on their registered 

email id. Taxpayers would receive an SMS notification also on their registered mobile.  

11.  Dashboard of the A/A and Taxpayer is updated with the record of the issued Notice. Taxpayer 

can view the issued Notice from the following navigation: Services > User Services > View 

Additional Notices/Orders and the A/A can view it from Statutory Functions > My Tasks > 

Reference Id > NOTICES. 

12.  Date of hearing, as specified in the Notice, will also be updated in the GST Portal's Cause list.  



 

 

  

6. After hearing both the parties, Revisional Authority will either issue "Drop Proceeding" Order or a 

"Revision Order" as he thinks just and proper including enhancing or confirming or modifying the demand 

of the original Order issued by the subordinate adjudicating officer.  

  

Note:  

  

1. With the issue of the "Drop Proceeding" Order, following actions take place on the GST Portal:  

 IRN Status gets changed to "Revision Proceedings Dropped".  

 Intimation of the issue of Order is sent to the concerned taxpayer and the A/A on their registered 

email id. Taxpayers would receive an SMS notification also on their registered mobile.  

 Dashboard of the A/A and Taxpayer is updated with the record of the issued Order. Taxpayer can 

view the issued Order from the following navigation: Services > User Services > View Additional 

Notices/Orders and the A/A can view it from Statutory Functions > My Tasks > Reference Id > 

ORDERS.  

 The demand Id issued on the original Order will stand.  

  

2. With the issue of the "Revision Order" Order, following actions take place on the GST Portal: 

9. IRN Status gets changed to "Revision Order Passed".  

10.  Intimation of the issue of Order is sent to the concerned taxpayer and the A/A on their registered 

email id. Taxpayers would receive an SMS notification also on their registered mobile.  

11.  Dashboard of the A/A and Taxpayer is updated with the record of the issued Order. Taxpayer can 

view the issued Order from the following navigation: Services > User Services > View 

Additional Notices/Orders and the A/A can view it from Statutory Functions > My Tasks > 

Reference Id > ORDERS.  

12.  Demand and Collection Register (DCR) and Tax Liability Ledger of Taxpayer will be updated with 

the Order accordingly. 

13.  The status of original demand Id will be "Demand Closed and Revised Demand Created" and 

new demand ID will be generated with the demand status as "Demand created against Revision 

Order" and will lie in unstayed state till Appeal is filed and admitted by Appellate Tribunal.  

  

3. I am a Revisional Authority. Can I initiate Revision Order Proceedings for 

any Order that I think is prejudicial to the interest of the revenue? 

You can initiate proceedings for any adjudication Order either as per direction of the Commissioner/STO 

(communicated regarding the same on the GST Portal—Statutory Functions > Appeal & Revision > 

Directions—or offline) or on your own motion. 



 

 

4. I am a Commissioner/STO. Can I initiate Revision Order Proceedings for 

any Order that I think is prejudicial to the interest of the revenue? 

Yes, you can initiate Revision Proceedings for any adjudication proceeding/Order that you consider to be 

prejudicial to the interest of the revenue or the adjudication Orders that have been proposed by the 

Internal Review Cell (IRC) for revision. 

5. I am a Revisional Authority. Can I pass orders without the directions of 

Commissioner/STO? 

You can pass orders without the directions of Commissioner/STO if you are authorized for the purpose 

(i.e. you must be Revisional Authority with statutory powers to do so).  

6. Can Revision Order Proceedings be dropped without any hearing? 

Yes, the Proceeding can be dropped without issuing hearing, as per Revisional Authority’s discretion.  

  

7. On what grounds can Revision Proceedings be dropped? 

Revision Proceeding can be dropped on any of the following ground(s): 

  

Note: Any one or more than one of the following reasons can be selected when issuing a "Drop 

Proceeding" Order.  

  

1. No misclassification of any goods or services or both; 

2. No wrong applicability of a notification issued under the provisions of this Act;  

3. No incorrect determination of time and value of supply of goods or services or both;  

4. No incorrect admissibility of input tax credit of tax paid or deemed to have been paid;  

5. No incorrect determination of the liability to pay tax on any goods or services or both;  

6. Applicant is not required to be registered;  

7. None of the particular thing done by the applicant results in supply of goods or services or both  

8. No rejection of application for registration on incorrect ground.  

9. No cancellation of registration for incorrect reasons  

10.  No transfer/Initiation of recovery/ Special mode of recovery  

11.  No tax wrongfully collected/Tax collected not paid to Government  

12.  No determination of tax not paid or short paid  

13.  No refund on wrong ground/Refund not granted/ Interest on delayed refund  

14.  No fraud or wilful suppression of fact  

15.  No anti profiteering related matter.  



 

 

16.  Any other point (other than the 15 points listed above) 

8. During the Revision Order Proceedings, what all Status changes does an 

IRN undergo? 

During the Revision Order Proceedings, an IRN undergoes following Status changes:  

  

 Revision Notice Issued: When Revisional Authority issues a Revision Notice to the concerned 

parties 

 Reply Submitted: When a Reply is filed by any party 

 Reminder Notice Issued: When Reminder is issued to one or all parties by the Revisional 

Authority 

 Adjournment Granted: When Adjournment of a hearing is issued  

 Revision Proceedings Dropped: When Revisional Authority issues a "Drop Proceeding" Order 

 Revision Order Passed: When Revisional Authority issues a "Revision" Order 

  

  

For more FAQs related to actions taken internally by Commissioner/STO or RA to revise an Order, refer 

to "Conduct an Internal Review of Orders and Subsequently Take Actions on the Impugned 

Orders Prejudicial to the Interest of the Revenue"  

  

  



 

 

 

Manual (BO) > Conduct Revision Order 
Proceedings 

How can I conduct proceedings related to Revision of Orders? 

To conduct proceedings related to Revision of impugned Orders, perform the following steps: 

  

Note: Following three Tax Official roles can be assigned by a State Admin to conduct proceedings related 

to Revision of impugned Orders, prejudicial to the interest of the revenue:   

  

1. Commissioner/Senior Tax Officer (STO): Issues the required directions on the impugned 

adjudication Orders to the Revisional Authority and/or Revise the Order as Revisional Authority 

himself/herself  

2. Revisional Authority (RA): Revises the impugned Adjudication Orders based on the directions 

given by the Commissioner/STO 

3. Adjudicating Authority (A/A): is the subordinate Tax Official who has issued the impugned 

adjudication Order. In Revision Proceedings, he/she needs to take action as directed by the RA, 

such as filing reply or appearing for Personal Hearing as specified in the Notice. 

  

 Steps  

Tax Official Roles 

(responsible for 

performing the step) 

A. Conduct an internal review of Orders and 

subsequently take following Actions: 

 The Commissioner/STO will direct the 

Order for "Self-revision" or for revision 

to the RA. 

 The RA to search for Proposals 

directed for revision from "Directions" 

link and view/download the impugned 

Order and directions provided by the 

Commissioner/STO.  

 After careful examination of the 

impugned Order, the 

Commissioner/STO or the RA will take 

  
 Commissioner/STO 

 RA 



 

 

the following action: Initiate 

proceedings or Drop the case. Based 

on the action taken, they will update the 

"ACTIONS" tab of the Proposal case. 

Commissioner/STO updates the 

Directed Proposal from: Statutory 

Functions > Appeal & Revision > 

Review Proposal. RA updates the 

Directed Proposal from: Statutory 

Functions > Appeal & Revision > 

Directions. 

     

    B. To revise Order, navigate to "Revision 

Proceedings" screen and initiate Proceedings 

  

Note: The Commissioner/STO can initiate 

proceedings for any Order that he/she considers to be 

prejudicial to the interest of the revenue or the ones 

that have been proposed by the Internal Review Cell 

(IRC). However, the RA can initiate proceedings for 

Orders directed by the Commissioner/STO only. 

    

 Commissioner/STO 

 RA 

C. Search and View Cause List of Revision 

Proceedings  

  

 Commissioner/STO 

 RA 

 A/A 

    D(1). Search for IRNs from "Revision 

Proceedings" screen 

             or  

    D(2). Navigate to "My Tasks" screen to open IRNs 

undergoing Revision or their related Reference IDs  

  

Note: A/A will not have access to the "Revision 

Proceedings" screen. They can access IRNs from "My 

Tasks" screen only. 

 Commissioner/STO 

 RA 

 A/A 

  

  

  



 

 

Note:  

  

An Internal Reference Number (IRN) undergoing Revision is organized on the 

GST Portal's "Revision" screen into the following tabs:  

1. NOTICES: To issue Notices (Reminder and Adjournment) and 

view/download them. Also, file reply to an issued Notice. 

2. REPLIES: To view and download filed Replies 

3. ORDERS: To issue Orders (Drop Proceeding and Revision Order) and 

view/download them 

4. INTERNAL COMMUNICATION: To be developed  

5. RECTIFICATION: To be developed 

6. ADDITIONAL DOCUMENT: To view and download documents related to 

the Revision Proceedings 

E. From NOTICES tab:  

E(1). Issue Reminder or Adjournment Notice 

E(2). File Reply 

 Commissioner/STO 

 RA 

 A/A 

  

  
Note: Only 
Commissioner/STO or RA 
can issue Notices. Others can 
only view/download them. 

F. From REPLIES tab: View and download filed 

Replies 

  

 Commissioner/STO 

 RA 

 A/A 

G. From ORDERS tab:  

G(1). Issue DROP PROCEEDING 

G(2). Issue REVISION ORDER 

  

Note:  

 The Proceeding can be dropped without 

issuing hearing as well, as per RA's discretion. 

 The RA can pass orders without the directions 

of Commissioner/STO if they are authorized 

for the purpose.(i.e. they must be an RA 

empowered to do so). 

 Commissioner/STO 

 RA 

 A/A 

  
Note: Only the 
Commissioner/STO or RA 
can issue Orders. Others can 
only view/download them.  



 

 

H. From ADDITIONAL DOCUMENT tab: Add and 

View/download added Documents  

 Commissioner/STO 

 RA 

 A/A  
  

I. Navigate to "My Tasks" screen to close IRNs 

or their related Reference IDs  

  

  

 Commissioner/STO 

 RA 

 A/A  
  

  

Click each hyperlink in the "Steps" column above to know more.  

  

B. To Revise Order, Navigate to "Revision Proceedings" screen and Initiate 

Proceedings 

To revise Order and navigate to "Revision Proceedings" screen and Initiate Proceedings, perform 

following steps: 

  

Note: The Commissioner/STO can initiate proceedings for any Order that he/she considers to be 

prejudicial to the interest of the revenue or the ones that have been proposed by the Internal Review Cell 

(IRC). However, the Revisional Authority can initiate proceedings for Orders directed by the 

Commissioner/STO only (communicated regarding the same on the GST Portal—Statutory Functions > 

Appeal & Revision > Directions—or offline). 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Appeal & Revision > Revision Proceedings option. 

  

 

  

4. Revision Proceedings screen is displayed. Click the INITIATE PROCEEDINGS button.  

  



 

 

 

  

5. Initiate Proceedings screen is displayed. Taxpayer Details and Order Details (impugned Order to be 

revised) are auto-populated. Click BACK to go back to the previous screen or enter data in the displayed 

fields as mentioned in the following steps:  

  



 

 

 

  

5a. Click the Generate Reference Number hyperlink. Reference No. field gets auto-populated.   

5b. In the Subject field, enter description of the revision notice to be issued.  

5c. In the Date of Hearing field, click the calendar and select the date. 



 

 

5d. In the Time of Hearing field, select the time from the drop-down list. 

5e. In the Place of Hearing field, enter the address of the place where you would like to call the parties 

for personal hearing.   

5f. The Place field will be auto-populated. However, you can edit it if required.  

5g. In the Reason for Revision field, click the Choose File button to upload the document(s) from your 

machine that state the reasons of issuing this revision notice. You can delete the uploaded document by 

clicking the trash-bin icon.  

  

 

  

5h. If required, you can also upload supporting documents in the Upload Supporting Documents field. 

This is not a mandatory field. Enter document description and click the Choose File button. ADD 

DOCUMENT button gets displayed. Click it to upload the document(s) from your machine related to this 

revision notice. You can delete the uploaded document by clicking the DELETE button.  

  

  

 

  

5i. Click PREVIEW and a system-generated draft notice gets downloaded into your machine. Check it 

carefully to rule out any discrepancy. 

  



 

 

 

  

5j. Click the PROCEED TO ISSUE button.  

5k. A warning message pop-up gets displayed. Click the PROCEED button. 

  



 

 

 

  

6. The Notice/Reminder/Order screen is displayed with a Warning message. On this screen, click the 

ISSUE WITH DSC button.  

  

 

  

7. The Provisional Acknowledgement page is displayed with the generated IRN. Click OK. 

  



 

 

 

  

Note: With the issue of this Provisional Acknowledgement on the Revision Notice, following actions also 

take place on the GST Portal: 

9. The generated IRN Status on the "Revision Proceedings" screen will be "Revision Notice Issued". 

10.   Intimation of the issue of Notice is sent to the concerned taxpayer and the A/A on their registered 

email id. Taxpayers would receive an SMS notification also on their registered mobile.  

11.  Dashboard of the A/A and Taxpayer is updated with the record of the issued Notice. Taxpayer 

can view the issued Notice from the following navigation: Services > User Services > View 

Additional Notices/Orders and the A/A can view it from Statutory Functions > My Tasks > 

Reference Id > NOTICES. 

12.  Date of hearing, as specified in the Notice, will also be updated in the GST Portal's Cause list.  

13.  The demand Id issued on the impugned Order by adjudication authority shall continue and status 

will be "stayed" until an Order is issued on the Revision Proceedings.  

  

8. The updated Revision Proceedings screen is displayed with the table containing the record of 

the IRN you had issued. Notice that the generated IRN Status is "Revision Notice Issued". Click the 

IRN hyperlink.  

  

 



 

 

  

9. The Revision screen is displayed. The yellow header lists the IRN related details. You can click 

on the tabs below it, on the left-hand side of the screen, to take further actions related to this IRN. 

  

 

  

Go back to the Main Menu 

  

D(1). Search for IRNs undergoing Revision  

To search for IRNs undergoing Revision, perform following steps: 

  

Note: Only the Commissioner/STO or the Revisional Authority can search for IRNs undergoing Revision 

using the following steps. 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Appeal & Revision > Revision Proceedings option. 

  

 

  

4. Revision Proceedings screen is displayed. Choose any one of the displayed fields as your search 

criteria and enter the required information as mentioned in the following steps:  

  



 

 

 

  

4a. Enter IRN. 

4b. Enter GSTIN/Temporary ID/UIN. 

4c. Select Status from the drop-down list. 

  

 

  

4d. Enter date in the Period From & Period To fields. 

4e. Click the SEARCH button. 

  

5. Based on your search criteria, the required IRNs or the list of the required IRNs gets displayed. 

Click any IRN hyperlink to open the "Revision" screen and carry out further proceedings.  

  



 

 

 

  

6. "Revision" screen gets displayed, where "NOTICES" tab is selected. From this screen, you can 

click the tabs provided on the left-hand side of the screen to take further actions related to this IRN. 

  

 

  

  

Go back to the Main Menu 

D(2). Navigate to My Tasks screen to open IRNs or the Reference IDs   

To navigate to "My Tasks" screen to open IRNs or the Reference IDs, perform following steps: 

  

Note: Commissioner/STO or the Revisional Authority can search for IRNs undergoing Revision using the 

"Revision Proceedings" screen or "My Tasks" screen. However, A/A will not have access to the "Revision 

Proceedings" screen and will be able to access IRNs from "My Tasks" screen only.  

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > My Tasks option. 



 

 

  

 

  

4. My Tasks screen is displayed. It has two sections.  

  

 From the top section, you can search for the tasks. Choose any one of the displayed fields as 

your search criteria and enter the required information: ARN, Reference ID or Start Date & End 

Date. Click the SEARCH button. Task list, in the second section below it, will get updated based 

on the search criteria.  

 In the second section, click the hyperlink in the ARN/IRN or the Reference ID column. 

  

 

  



 

 

5. "Revision" screen gets displayed, where "NOTICES" tab is selected. From this screen, you can take 

further actions related to this IRN. 

  

 

  

Note: In case you click the hyperlink in the Reference ID column, "Revision" screen gets displayed, 

where the reference-related tab is selected. From this screen, you can take further actions related to this 

IRN. 

  

 

  

Go back to the Main Menu 

  

E(1). Issue Reminder or Adjournment Notice 

To issue Reminder in case the parties have not replied to the issued Notice or issue Adjournment 

because the hearing is being adjourned, perform following steps:  

  

Note: Only the Commissioner/STO or Revisional Authority can issue Reminders or Adjournment. Others 

can only view/download them. 



 

 

  

1. On the Revision screen, select the NOTICES tab, if it is not selected by default. Click the Reminder or 

Adjournment hyperlink, as applicable, in the Notice table. 

  

 

  

2. The Reminder or the Adjournment page gets displayed based on what you had clicked on the 

previous screen. Click BACK to go back to the previous screen or enter data in the displayed fields as 

mentioned in the following steps:  

  



 

 

 

  



 

 

 

  

2a. Click the Generate Notice Number hyperlink. Notice No. field gets auto-populated.   

  

2b. In the Recipient of Notice field, select the recipient. 

 



 

 

  

2c. In the Subject field, enter description of the notice to be issued.  

2d. In the Previous Date of Hearing field, click the calendar and select the date if hearing has taken 

place earlier. Otherwise, leave this field blank.  

2e. In the Status of Previous Hearing field, select the hearing status if hearing has taken place earlier. 

Otherwise, leave this field blank.  

  

 

  

2f. In the New Date of Hearing field, click the calendar and select the date.  

2g. In the New Time of Hearing field, select the time from the drop-down list. 

2h. In the Place of Hearing field, enter the address of the place where you would like to call the parties 

for personal hearing.   

2i. If required, you can also upload supporting documents in the Upload Supporting Documents field. 

This is not a mandatory field. Enter document description and click the Choose File button. ADD 

DOCUMENT button gets displayed. Click it to upload the document(s) from your machine related to this 

revision notice. You can delete the uploaded document by clicking the DELETE button.  

  

  

 

  



 

 

2j. The Place field will be auto-populated. However, you can edit it if required.  

  

2k. Click PREVIEW and a system-generated draft notice gets downloaded into your machine. Check it 

carefully to rule out any discrepancy. 

  

 

  

Note: In case you are issuing an Adjournment, following draft notice gets downloaded when you click 

PREVIEW. 

  



 

 

 

  

2l. Click the SUBMIT button.  

2m. A warning message pop-up gets displayed. Click the PROCEED button. 

  



 

 

 

  

3. The Notice/Reminder/Order screen is displayed with a Warning message. On this screen, click the 

ISSUE WITH DSC button.  

  

 

  

4. A green message is displayed. Click OK. 

  

 



 

 

  

5. The updated NOTICES tab is displayed with the issued Reminder or Adjournment. In case a 

Reminder is issued, the Status gets changed to "Reminder Notice Issued" and in case of 

Adjournment the Status will be "Adjournment Granted".  

  

 

  

 

  

Note: With the issue of the Reminder or Adjournment, following actions also take place on the GST 

Portal: 

9. Intimation of the issue of Notice is sent to the concerned taxpayer and the A/A on their registered 

email id. Taxpayers would receive an SMS notification also on their registered mobile.  

10.  Dashboard of the A/A and Taxpayer is updated with the record of the issued Notice. Taxpayer 

can view the issued Notice from the following navigation: Services > User Services > View 

Additional Notices/Orders and A/A can view it from Statutory Functions > My Tasks > 

Reference Id > NOTICES. 

11.  Date of hearing, as specified in the Notice, will also be updated in the GST Portal's Cause list.  



 

 

  

Go back to the Main Menu 

E(2). File Reply   

To file reply against an issued Notice, perform following steps:  

  

Note: Replies can be filed by both the Taxpayer and the A/A. Following steps show how A/A can file their 

replies.  

  

1. On the Revision screen,  select the NOTICES tab, if it is not selected by default. Click the Reply 

hyperlink in the Notice table against which you want to file the Reply.  

  

 

  

2. The Reply screen gets displayed. Click BACK to go back to the previous screen or enter data in the 

displayed fields as mentioned in the following steps:  

  



 

 

 

  

2a. You can prepare the reply to the notice offline with the following information: Counter reply and 

Reliefs being claimed. Then, in the Details of Reply field, click the Choose File button to upload the 

prepared reply document(s). You can delete the uploaded document by clicking the trash-bin icon.  

  

 

  

2b. If required, you can also upload supporting documents in the Upload Supporting Documents field. 

This is not a mandatory field. Enter document description and click the Choose File button. ADD 

DOCUMENT button gets displayed. Click it to upload the document(s) from your machine related to this 

revision notice. You can delete the uploaded document by clicking the DELETE button.  

  



 

 

  

 

  

2c. Click the SUBMIT button.  

2d. A warning message pop-up gets displayed. Click the PROCEED button. 

  

 

  

6. The Notice/Reminder/Order screen is displayed with a Warning message. On this screen, click the 

ISSUE WITH DSC button.  

  



 

 

 

  

7. A green message is displayed. Click OK. 

  

 

  

8. The updated Replies tab is displayed with the filed Reply and the Status gets changed to "Reply 

Submitted".  

  

 

  

Note: Additionally, following actions also take place on the GST Portal:  

9.  Dashboard of the Taxpayer is updated with the record of the filed Reply.  



 

 

10.  Taxpayer can view it from the following navigation: Services > User Services > View Additional 

Notices/Orders. 

  

Go back to the Main Menu 

  

F. View and Download Filed Replies 

To view and download the Replies filed by the Taxpayer or the A/A, perform following steps:  

  

Note: All roles can view/download the filed replies from this tab.  

  

1. On the Revision screen of that particular IRN, select the REPLIES tab. This tab displays all the 

replies filed by you or the taxpayer against the Notices of this IRN.  

  

 

  

2. Click the document name(s) in the Documents section of the table to download into your 

machine and view them.  

  

Go back to the Main Menu 

G(1). Issue DROP PROCEEDING 

To issue "Drop Proceeding" Order, perform following steps: 

  

Note: 



 

 

 Only the Commissioner/STO or Revisional Authority can issue Orders. Others can only 

view/download them.  

 The Revisional Authority can pass orders without the directions of Commissioner/STO if they are 

authorized for the purpose (i.e. they must be Revisional Authority, allocated with this role, to do so).  

 The Proceeding can be dropped without issuing hearing as well, as per Revisional Authority’s 

discretion. 

  

1. On the Revision screen, select the ORDERS tab. Click ADD ORDER and select DROP 

PROCEEDING. 

  

 

  

2. DROP PROCEEDING screen is displayed. Click BACK to go to the previous page or enter data in the 

displayed fields as mentioned in the following steps:  

  



 

 

 

  

2a. In the Reference Number field, click the Generate Reference Number hyperlink. Reference 

Number field gets auto-populated. 

2b. In the Reason for Dropping the Proceedings field, select the relevant reason from the ones 

displayed in the drop-down list and click ADD. The selected reason will get displayed. To add more 

reasons, follow the same procedure.  

  



 

 

 

  

 

 

  

  

2b. If required, you can also upload supporting documents in the Upload Supporting Documents field. 

This is not a mandatory field. Enter document description and click the Choose File button. ADD 

DOCUMENT button gets displayed. Click it to upload the document(s) from your machine related to this 

revision notice. You can delete the uploaded document by clicking the DELETE button.  

  



 

 

  

 

  

2c. Click the SUBMIT button.  

2d. A warning message pop-up gets displayed. Click the PROCEED button. 

  

 

  

3. The Notice/Reminder/Order screen is displayed with a Warning message. On this screen, click the 

ISSUE WITH DSC button.  

  



 

 

 

  

4. A green message is displayed. Click OK. 

  

 

  

5. The updated ORDERS tab is displayed with the issued Order and the Status gets changed to 

"Revision Proceedings Dropped".  

  

 

  

  

Note 1: On clicking Click here for details hyperlink in the displayed Order, following popup is displayed. 

Click OK to close the popup. 



 

 

  

 

  

  

Note 2: Additionally, following actions also take place on the GST Portal:  

9. Intimation of the issue of Order is sent to the concerned taxpayer and the A/A on their registered 

email id. Taxpayers would receive an SMS notification also on their registered mobile.  

10.  Dashboard of the A/A and Taxpayer is updated with the record of the issued Order. Taxpayer can 

view the issued Order from the following navigation: Services > User Services > View 

Additional Notices/Orders and the A/A can view it from Statutory Functions > My Tasks > 

Reference Id > ORDERS. 

11.  The demand Id issued on the original Order will stand.  

  

Go back to the Main Menu 

G(2). Issue Revision Order 

To issue "Revision" Order, perform following steps: 

  

Note: 

 Only the Commissioner/STO or Revisional Authority can issue Orders. Others can only 

view/download them.  

 The Revisional Authority can pass orders without the directions of Commissioner/STO if they are 

authorised for the purpose (i.e. they must be assigned with the role of Revisional Authority to do so). 

  

1. On the Revision screen, select the ORDERS tab. Click ADD ORDER and select REVISION ORDER. 

  



 

 

 

  

2. REVISION ORDER screen is displayed. Click BACK to go to the previous page or enter data in the 

displayed fields as mentioned in the following steps:  

  



 

 

 



 

 

2a. Click the Generate Revision Order Number hyperlink. Revision Order Number field gets auto-

populated.   

2b. In the Status of Order field, select the status. Select "Modified" if you are making changes in the 

original Order issued by the Adjudication Authority. Or else, select "Confirmed".  

  

 

  

2b.i. In case you select "Confirmed", you will not be able to change the demand. Scroll on the right to view 

the "Total" column of the confirmed demand.  

  

 

  

2b.ii. In case you select "Modified", you can edit the demand in the "As per the Revised Order" columns 

under the provided heads. Scroll on the right to edit under the other provided heads. The modified 

demand gets auto-populated in the "Total" column.  

  



 

 

 

  

 

  

2c. In the Upload Annexure of the Order field, click the Choose File button to upload the document(s) 

from your machine. You can delete the uploaded document by clicking the trash-bin icon.  

2d. If required, you can also upload supporting documents in the Upload Supporting Documents field. 

This is not a mandatory field. Enter document description and click the Choose File button. ADD 

DOCUMENT button gets displayed. Click it to upload the document(s) from your machine related to this 

revision notice. You can delete the uploaded document by clicking the DELETE button.  

  



 

 

  

 

  

2e. The Place field will be auto-populated. However, you can edit it if required.  

  

2f. Click PREVIEW and a system-generated draft Order gets downloaded into your machine. Check it 

carefully to rule out any discrepancy. 

  



 

 

 

  

2g. Click the SUBMIT button.  

2h. A warning message pop-up gets displayed. Click the PROCEED button. 

  



 

 

 

  

3. The Notice/Reminder/Order screen is displayed with a Warning message. On this screen, click the 

ISSUE WITH DSC button.  

  

 

  

4. A green message is displayed. Click OK. 

  

 

  



 

 

5. The updated ORDERS tab is displayed with the issued Order and the Status gets changed to 

"Revision Order Passed".  

  

 

  

  

Note: Additionally, following actions also take place on the GST Portal:  

9. Intimation of the issue of Order is sent to the concerned taxpayer and the A/A on their registered 

email id. Taxpayers would receive an SMS notification also on their registered mobile.  

10.  Dashboard of the A/A and Taxpayer is updated with the record of the issued Order. Taxpayer can 

view the issued Order from the following navigation: Services > User Services > View 

Additional Notices/Orders and A/A can view it from Statutory Functions > My Tasks > 

Reference Id > ORDERS. 

11.  Demand and Collection Register (DCR) and Tax Liability Ledger of Taxpayer will be updated with 

the Order accordingly. 

12.  The status of original demand Id will be "Demand Closed and Revised Demand Created" and 

new demand ID will be generated with the demand status as "Demand created against Revision 

Order" and will lie in unstayed state till Appeal is filed and admitted by Appellate Tribunal.  

  

Go back to the Main Menu 

  

H. Add and View/download added Documents 

To add or view/download additional documents submitted physically by the parties during the hearing, 

perform following steps: 

  

Note: All roles can add and view/download the documents uploaded from this tab.  

  

1. On the Revision screen, select the ADDITIONAL DOCUMENT tab. Click ADD DOCUMENTS. 

  



 

 

 

  

2. Following fields get displayed. Click BACK to go to the previous page or enter data in the 

displayed fields as mentioned in the following steps:  

  

 

  

2a. Select the Date of Hearing using the calendar. 

2b. In the Document Description field, enter the description of the document i.e. the name or type of 

document that is provided during hearing. 

2c. In the Documents Submitted By field, enter the name of the person who submitted the additional 

document. In case of multiple names, all the names will be separated by comma.  



 

 

2d. In the Upload Documents field, click the Choose File button to upload the document(s) from your 

machine. You can delete the uploaded document by clicking the trash-bin icon and upload again.  

2e. Click the SUBMIT button.  

2f. A warning message pop-up gets displayed. Click the PROCEED button. 

  

 

  

3. The updated ADDITIONAL DOCUMENT tab is displayed with the added document table.  

  

 

  

Go back to the Main Menu 

  

I. Navigate to "My Tasks" screen to close IRNs or their related Reference 

IDs  



 

 

Once you have processed a work-item, you can close it. To navigate to "My Tasks" screen to close the 

work-items—IRNs or the Reference IDs— perform following steps: 

  

Note: Commissioner/STO or the Revisional Authority can search for IRNs undergoing Revision using the 

"Revision Proceedings" screen or "My Tasks" screen. However, A/A will not have access to the "Revision 

Proceedings" screen and will be able to access IRNs from "My Tasks" screen only.  

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > My Tasks option. 

  

 

  

4. My Tasks screen is displayed. Select one or more tasks you want to close.  

  



 

 

 

  

  

5.  The CLOSE TASKS button gets enabled. Click it. 

  



 

 

 

  

6.  My Tasks screen gets updated after removing the closed tasks. To access the closed tasks, click the 

Go To Closed Tasks hyperlink on the bottom-left.  

  



 

 

 

  

7. Closed tasks get displayed. To go back, click the Go To Open Tasks hyperlink on the bottom-left.  

  

 

  

  

Go back to the Main Menu 
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Overview > Refund 
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 Manual > Processing the Refund Application-RFD-01B 
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Refund on Account of Export of Goods (With Payment 
of Tax) 

FAQs > Refund on Account of Export of Goods 
(With Payment of Tax) 

1.    What is the process of claiming Refund on Account of Export of 

Goods? 

For all the taxpayers who have filed GSTR- 1 with data in the Export table (Table 6A) and have filed 

GSTR- 3B, the export data is sent to the ICEGATE. 

Note: Shipping bill details in table 6A are mandatory in processing of Refund.  

1.     Shipping bill details from GSTR-1 is shared by GST to ICEGATE/ CUSTOMS 

2.     GST shares below data with ICEGATE/CUSTOMS   

         Request Type (F- Fresh, R-Refund) 

         Tax Period 

         GSTIN (Trader (importer/exporter) identifier) 

         SB Number (Shipping Bill number that is the transaction identifier for export 

transactions) 

         SB Date (Export transaction Date) 

         Port Code (Location where the clearance of the export transaction is done) 

         Invoice Number (The identifier for Invoice) 

         Invoice Date (Date of Invoice) 

         Invoice Value GSTR (Value of the Invoice) 

         IGST Amount 

         EGM Date GSTN 

         EGM Number GSTR 

         GSTR-3B ARN 

         GSTR-3B Filing Date 

Note:  Request Type will be F (Fresh) in case of GSTR 3B.  

3.     Customs compares shipping bill data with Export. On successful verification, response from 

ICEGATE will be sent to GST. 

4.     Response from ICEGATE will contain additional fields as below:  

         INVOICEVALUECUSTOM (Invoice Value to be sent by CBEC post validation) 

         INVOICEVALUECUSTOM (IGST Value to be sent by CBEC post validation) 

         ACKNO (Acknowledgement number for future reference) 

         ERROR_CD (Error Codes updated during Validation by CBEC) 

         ERROR_MSG (Error Messages updated during Validation by CBEC) 



 

 

5.     Customs sends information regarding successful disbursement of Refund amounts. 

6.     Information sent by Customs will be acknowledged by the GST system with a Reference ID.  

7.     Based on response received from ICEGATE/CUSTOMS, communication will be sent to the 

Taxpayer via E-mail message and SMS. 

  

  

  

  



 

 

Processing the Refund Application-RFD-01B 

FAQs > Processing the Refund Application-
RFD-01B (Under Rule 97A of CGST and 
relevant rules of SGST/IGST) 

1. Can the proper officer update details of Refund Orders issued manually 

(RFD- 01B) on the GST Portal? 

Yes, the proper officer of a Model 2 State can update the details of Refund Orders issued manually by 

filling RFD-01B after logging to the GST Portal using valid login credentials. Navigate to Refund > 

Refund > RFD- 01B: Enter Refund Processing Details option. The Model 1 state and CBEC proper 

officer can update the details of manually issued refund order through his departments application. This 

application would be integrated through API with the GST System.   

2. Can the proper officer view the refund form filled by the taxpayer? 

Yes, a Model 2 State proper officer can view the refund form filled by the taxpayer by navigating to 

Refund > Refund > RFD- 01B: Enter Refund Processing Details > ARN Number link > Download 

Refund Application option. The Model 1 state and CBEC proper officer can view and download the 

refund form through his departments application. This application would be integrated through API with 

the GST System.  

The statement and other documents uploaded by taxpayer while filing refund application would also be 

available to proper officers. 

3. For which type of refund orders RFD-01B is to be updated by the Tax 

Officer? 

Below refund orders issued manually to the taxpayer by the Tax Officer are to be updated by filling RFD-

01B: 

1. RFD-04 (Provisional Refund Order) 

2. RFD-06 (Refund Sanction/Rejection Order) 

3. RFD-07A (Order for Complete Adjustment of Sanctioned Amount) 

On navigating to ‘Type of Order’ you would be able to select one of the above options from drop down 

available. 

4. RFD-04 (Provisional Refund Order) option can be selected for which 

types of refund? 



 

 

RFD-04 (Provisional Refund Order) option can be selected in case of following types of refund:  

• On Account of Export of Services- With Payment of Tax 

• On Account of Export of Goods or Services- without Payment of Tax i.e. ITC Accumulated 

• By supplier to SEZ unit/ SEZ Developer- With Payment of Tax (Refund of IGST) 

• Accumulated ITC on account of supplies made to SEZ unit/ SEZ Developer- without Payment of Tax 

5. On selection of RFD-04 (Provisional Refund Order) option can I fill in 

details of amount in-admissible? 

No. The row of “Refund Amount in-admissible” would be greyed out and un-editable. You would not be 

able to fill any amount in major or minor heads of tax. And there would be no corresponding entry in 

Electronic Credit Ledger of the taxpayer. 

6. On selection of RFD-04 (Provisional Refund Order) option do I need to fill 

details of payment? 

Yes. “Payment Advice Number and Payment Advice Date” would be available as mandatory field. 

7. On selection of RFD-06/ RFD-07A (Refund Sanction/Rejection Order or 

Complete Adjustment Order) option, can I fill in details of amount in-

admissible? 

Yes, you can fill details of amount in-admissible on selection of RFD-06/ RFD-07A (Refund 

Sanction/Rejection Order or Complete Adjustment Order) option. Re-credit takes place from “Refund 

Amount Inadmissible” column from RFD-01B. Tax officer need not enter any amount in row “Refund 

Amount in-admissible” if there is no amount to be re-credited. 

  

In case, there is any amount of in-admissible refund in the order issued which is to be re-credited, you 

need to fill details of that amount in the row “Refund Amount in-admissible” under major and minor heads 

of tax. Based on the amount entered, there would be corresponding credit entries of such amounts in 

Electronic Credit Ledger of the taxpayer, if the amount has been debited at the time of filing refund 

application. 

8. What is significance of amount in-admissible? 

Refund Amount in-admissible” under major and minor heads of tax, entered by tax official are credited to 

Electronic Credit Ledger of the taxpayer. 

9. On selection of RFD-06/ RFD-07A (Refund Sanction/Rejection Order or 

Complete Adjustment Order) option do I need to fill details of payment? 



 

 

You would need to fill details of payment only if any payment of refund is made while issuing the order. 

Therefore “Payment Advice Number and Payment Advice Date” would be available as an optional field. 

10. What steps need to be taken if while issuing final refund order (in case 

where provisional refund has been granted) it is found that the remaining 

amount of refund is less than the amount of refund rejected or in-

admissible? 

If at the time of issuing final refund order it is found that excess provisional refund had been granted to 

the taxpayer, the excess amount of such refund already paid is to be transferred in liability/Demand and 

Collection Register through DRC-07 so that the same may be recovered. This is to be done manually by 

the proper officers. System would not generate any liability. 

11. Can I update details of Refund Orders issued manually for any 

Jurisdiction? 

No. You can update details of Refund Orders issued manually only for GSTIN under your jurisdiction.  

12. From where I can view the orders which are processed? 

You can navigate to Refund > Refund > View Submitted Orders to view all the orders which are 

processed. 



 

 

Manual > Processing the Refund Application-
RFD-01B (For Model 2 State Proper Officer) 

How can I update details of Refund Orders issued manually (RFD- 01B) on 

the GST Portal? 

To update details of Refund Orders issued manually, Tax Officer will have to fill RFD- 01B form on the 

GST Portal, by performing the following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Navigate to Refund > Refund > RFD- 01B: Enter Refund Processing Details option. 

  

 

  

4. The Refund Order Details page is displayed. Search for the respective ARN by using search option. 

Select the ARN/GSTIN/Temporary ID option from the Select ARN/ GSTIN/Temporary ID drop-down list. 

In the Enter ARN/ GSTIN/Temporary ID field, enter the ARN/GSTIN/Temporary ID for which the order 

details are to be updated, as per the search option you have selected. In case ARN is provided, then the 

respective ARN will be displayed in the search result.  

In case GSTIN is provided, then all the ARNs for the respective GSTIN will be displayed in search result. 

5. Click the SEARCH button. 

  



 

 

 

  

6. The details are displayed. Select the ARN link for which details are to be updated. 

  



 

 

 

  

7. Select the Type of Order issued to the taxpayer from the Type of Order drop-down list. 

8. In the Order No. field, enter the Order Number. 

9. Select the Order Issuance Date using the calendar. 

10. In the Payment Advice No. field, enter the Payment Advice Number. 

11. Select the Payment Advice Date  using the calendar. 

  



 

 

Note: 

 If you select RFD-06/ RFD-07A (Refund Sanction/Rejection Order or Complete Adjustment 

Order) from the drop-down, “Payment Advice Number and Payment Advice Date” is available as 

an optional field. 

 If you select RFD-04 (Provisional Refund Order) from the drop-down, “Payment Advice Number 

and Payment Advice Date” is a mandatory field. 

12. Select to whom the refund has been issued from the Refund Issued to drop-down list. 

13. Enter your remarks in the Remarks field. 

14. You can click the PDF and excel file to download the refund application and Statement/or any other 

document uploaded by the taxpayer. 

15. “Refund Issued by” will be auto-populated.  

  

 

  

Note: Supporting documents/ annexure along with statements, uploaded by taxpayer in RFD-01A, will be 

available for download in RFD-01B to the refund processing Tax Officer. 

  

16. Refund amount claimed will be auto-populated from the respective refund application form. All other 

fields are to be punched in by the Tax Officer as per the order issued.  

Note: 

 In row “Refund Sanctioned on provisional basis”, enter the amount of the refund sanctioned to the 

tax payer as per refund order number RFD-04. 



 

 

 In row “Refund Amount in-admissible” any refund amount for which the tax payer is not eligible, is 

to be entered so that the same can be re-credited to the taxpayer’s Electronic Cash/ Credit 

Ledger. 

 In row “Interest (if any)” amount to be paid to the taxpayer on account of delayed refund amount, 

is to be entered. 

 Any amount adjusted against any recoverable dues from the taxpayer is to be entered in “Amount 

adjusted against outstanding demand under the existing law or under the Act” 

 Net amount to be paid shall be the amount for which the Tax Officer has issued Payment Advice, 

for the disbursement of refund amount. 

 If  you select RFD-04 (Provisional Refund Order) from the drop-down, “Refund Amount in-

admissible” row in table “Refund Amount Details” is greyed out for all the major heads (Integrated 

Tax/Central Tax/State/UT Tax/ Cess) and minor heads with zero amount displayed in the cells 

and is non-editable. There will be no ledger entry in Electronic Credit Ledger from RFD-04. 

 If you select RFD-06/ RFD-07A (Refund Sanction/Rejection Order or Complete Adjustment 

Order) from the drop-down, “Refund Amount in-admissible” row in table “Refund Amount Details” 

is to be provided by you. There will be ledger entry in the Electronic Cash/Credit Ledger for the 

amount entered in “Refund Amount in-admissible”.  

 Re-credit takes place from “Refund Amount Inadmissible” column from RFD-01B in Electronic 

Credit Ledger of the taxpayer. Tax officer may not enter any amount in row “Refund Amount in-

admissible” if there is no amount to be re-credited. 

  

17. Click the Choose File button to upload the order. 

The file uploaded should be in PDF or JPEG format with maximum size as 2 MB. 

18. Click the SAVE button. 

  



 

 

 



 

 

  

Note: In case you want to view/ delete the order uploaded click the Preview/ Delete button. 

  

 

  

19. You can click the PREVIEW button to view the details of refund before submitting on the GST Portal. 

  

 

  

20. The downloaded PDF is displayed. 

  



 

 

 

  

21. Click the SUBMIT WITH DSC button. 

  



 

 

 



 

 

  

22. Click the PROCEED button. 

  

 

  

23. Affix your DSC and click the Sign button. 

  

 

  

24. A success message is displayed that refund order has been successfully submitted. Click the OK 

button.  

  



 

 

 

  

25. Notice that the status of the Refund Application is changed to "Processed”.  

Note: You can navigate to Refund > Refund > View Submitted Orders to view all the orders which are 

processed. 

  

 

  



 

 

View Submitted Refund Orders 

How can I view submitted refund orders on the GST Portal? 

To view submitted refund orders on the GST Portal, perform following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Navigate to Refund > Refund > View Submitted Orders option. 

  

 

  

4. The Refund Order Details page is displayed. Search for the respective ARN by using search option. 

Select the ARN/GSTIN/Temporary ID option from the Select ARN/ GSTIN/Temporary ID drop-down list. 

In the Enter ARN/ GSTIN/Temporary ID field, enter the ARN/GSTIN/Temporary ID, as per the search 

option you have selected. In case ARN is provided, then the respective ARN will be displayed in the 

search result. 

In case GSTIN is provided, then all the ARNs for the respective GSTIN will be displayed in search result.  

5. Click the SEARCH button. 

  

 

  

6. The details are displayed. Select the Refund Order link to download the refund order in PDF format. 

  



 

 

 

  

7. The refund order is displayed in the PDF format. 
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Determination of Tax 

Upload of Summary of Order of Tax 

1. What is Form GST DRC-07? 

Form GST DRC 07 is a summary of the order, issued by the Proper Officer, to be uploaded on GST 

Portal, specifying the amount of tax, interest or penalty payable by the person chargeable with tax, under 

Section 73(9), or Section 74(9) or Section 76(3) of CGST Act, 2017. 

2. When is the GST DRC-07 to be uploaded on the GST Portal? 

Details in Form GST DRC 07 is to be uploaded on GST Portal after issue of the order for:  

1. Determining the liability of persons under section 73 (9) (tax not paid or short paid or erroneously 

refunded or ITC wrongly availed or utilized for any reason other than fraud, or any willful misstatement or 

suppression of facts) 

2. Determining the liability of persons under section 74 (9) (tax not paid or short paid or erroneously 

refunded or ITC wrongly availed or utilized for any reason of fraud, or any willful misstatement or 

suppression of facts) 

3. Determining the liability of persons under section 76 (3) (tax collected but not paid to Government).  

3. What is to be filled in Form GST DRC-07? 

The Assessing /Adjudicating Authority, issuing the order, needs to fill the following in Form DRC-07: 

1. Details of the Order (Order no., Order date, Tax period) 

2. Issues involved (select from dropdown) 

3. Description of goods/services 

4. Details of demand as contained in the Order (including the turnover, tax rate, tax amount, interest, 

penalty) 

4. What is the effect of Form GST DRC-07? 

Electronic Liability Register Part-II and Demand and Collection Register (DCR), gets updated with the 

demand specified in the order after uploading of information in Form GST DRC-07. The order uploaded is 

to be treated as the notice for recovery as per Rule 142(6) of the CGST Rules, 2017.  

5. How do I sign Form GST DRC-07? 

Summary of order in Form GST DRC-07 are to be issued by officer concerned by attaching his/her DSC. 



 

 

6. What is the path to issue GST DRC-07? 

Navigate to Statutory Functions > Assessment/Adjudication > Determination of tax (Fraud/Other) 

option to issue Form GST DRC-07. 

7. Can I save the Form GST DRC-07 and retrieve at a later point in time? 

In case you want to save the form as draft and fill it at a later point in time, click the SAVE DRAFT button.  

Note: Subsequently, to retrieve the saved draft, navigate to Statutory Functions > 

Assessment/Adjudication > Determination of tax (Fraud/Other) > View Saved Drafts link and 

complete the details before issue. 

  

You can retrieve the saved drafts within 15 days of saving, after which it will get purged.  

  



 

 

Manual > Upload of Summary of Order of Tax 

How can I upload Form DRC 07 on the GST Portal? 

To upload summary of the order, issued for determining tax liability, perform following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Navigate to Statutory Functions > Assessment/Adjudication > Determination of tax (Fraud/other) 

option. 

  

 

  

4. Under Quick links, click the Issue Order link. 

  

 

  

5. In the GSTIN field, enter the GSTIN of the taxpayer of whom summary of the order has to be uploaded.  

  

 

  

6. The Order form with various tabs is displayed. On the top of the page, there are four tabs as  Order 

Details, Description Goods and Services, Details of Demand and Attach Documents. Click each tab 

to enter the details. 

  

Order Details 

Description Goods and Services 



 

 

Details of Demand 

Attach Documents 

    

 
 

Order Details tab: 

  

The Order Details tab is selected by default. This tab displays the order information to be filled by the 

Tax Officer. 

  

7. In the Order No. field, enter the order number. 

Note: Order number can be of maximum 20 characters with special characters including “/” and “-“.  

8. Select the Order Type from the drop-down list. 

  

 

  



 

 

9. Select the Order Date using the calendar. 

10. Select the Demand to be paid by Date using the calendar. 

11. Select the tax period for which the order has to be issued. 

12. Select the Issue Involved from the drop-down list.  

Note: You can choose only one option for issue involved from the drop-down list. 

  

 

  

13. Click the SAVE & CONTINUE button. You will notice a blue tick on the Order Details section 

indicating the completion of the tab information.  

  

 

  

Description Goods and Services 



 

 

  

This tab page displays the details of the goods and services in which the taxpayer is dealing with.  

  

Goods Tab: 

To add the HSN Code, perform following steps: 

14. In the Search HSN Chapter field, enter the HSN Code. 

HSN Code is successfully added. 

  

Services Tab: 

To add the SAC Code, perform the following steps: 

15. In the Search SAC field, enter the SAC Code. 

SAC Code is successfully added. 

  

16. Click the SAVE & CONTINUE button. 

  

 

  

Details of Demand 

  

This tab page displays the details of the demand. 

  

17. Enter the details of demand like the tax rate, turnover, Place of Supply, relevant Act, tax interest etc.  

18. Click the ADD button to insert more information in case of goods/services having more than one tax 

rates, place of supply, etc. 

19. Click the SAVE & CONTINUE button. 

  

 Note: You can select multiple tax rate for the same Act and Place of Supply.   



 

 

  

 

  

Attach Documents 

  

20. Select the Choose File button and attach document. 

  

 

  

In case you want to save the form as draft and fill it at a later point in time, click the SAVE DRAFT button.  

  



 

 

Note: Subsequently, to retrieve the saved draft, navigate to Statutory Functions 

>Assessment/Adjudication > Determination of tax (Fraud/other) > View Saved Drafts link and 

complete the details before issue. 

  

21. You can preview the order before issuing to the taxpayer, by clicking the PREVIEW button. The 

summary of the order is downloaded in PDF format. 

  

 

  

22. Click the ISSUE WITH DSC button. 

  



 

 

 

  

23. Click the PROCEED button. 

24. Affix your DSC and click the Sign button. 

  

 

  



 

 

25. A success message will be displayed that order reference number has been generated. Click the OK 

button.  

  

 

  

  



 

 

Manual > View Saved Draft 

How can I view saved drafts of the orders to be issued to the taxpayer for 

determination of tax liability? 

To view the saved draft order to be issued to the taxpayer for determination of tax liability, perform 

following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Navigate to Statutory Functions > Assessment/Adjudication > Determination of tax (Fraud/Other) 

option. 

  

 

  

Under Quick links, click the View Saved Drafts link. 

  

 

  

The list of saved drafts is displayed. You can click the Timestamp link to view the saved order.  

Note: You can retrieve the saved drafts at any point in time until it is submitted by you.  

  

 

  

The saved draft of the order is displayed. You can now enter the details and submit the order.  



 

 

  

 



 

 

Manual > View Orders Issued 

How can I view the orders issued to the taxpayer of determination of tax 

liability? 

To view the order issued to the taxpayer of determination of tax liability, perform the following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Navigate to Statutory Functions > Assessment/Adjudication > Determination of tax(Fraud/other) 

option. 

  

 

  

Under Quick links, click the View Orders Issued link. 

  

 

  

The List of Orders issued is displayed. You can click the Download link to download the order. 

  



 

 

 

  



 

 

General Penalty 

FAQs > General Penalty 

1. When can I impose a General Penalty on a taxable person? 

You can impose a General Penalty on a taxable person when he/she contravenes any of provisions of 

Section 125 of CGST/ SGST Act or any rules made thereunder, for which no penalty is separately 

provided for in this Act. Normally, penalties not related to tax deficiency can be covered under General 

Penalty.    

2. Can I impose a General Penalty on a person not registered under the 

GST Act? 

Yes, under Section 125, General penalty can be imposed on any person—Registered or Unregistered—

who had committed offence/contravened provisions of the CGST/SGST Act, for which no penalty is 

provided under any other section specifically.  

3. Can I impose a General Penalty on a person on whom a penalty is 

already levied under some other section for the same default? 

No. In case penalty is levied under any other section for some default, then no penalty can be imposed 

u/s 125 for the same default on the same person.   

4. How will I impose a General Penalty on an Unregistered person? 

You can impose a General Penalty on an Unregistered person by creating his/her temporary ID before 

issuing notice. 

5. I need to serve an SCN to a case recommended from enforcement. How 

can I do that? 

On the Search page, select “Pending for action by tax officer” in the Status field and click the SEARCH 

button. List of all cases recommended from enforcement/Audit/Special audit/LUT, etc. would be 

displayed. Select the ARN/Case ID of the case number you want to act on and you will be taken to the 

page from where you can serve SCN.   



 

 

6. How much time do I need to give to the taxpayer for replying to the Show 

Cause Notice (SCN) issued? 

15 days of time can be given for furnishing a reply to the SCN.   

7. Where can the taxpayers view the SCN issued to them? 

After logging in to the GST portal, the taxpayers can navigate to Services > User Services > View 

Additional Notices and Orders option. 

8. Where can I view the reply filed by the taxpayers? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > General Penalty > Case Detail > Replies option. 

9. What are the next steps after a taxpayer has replied to the notice? 

If reply to notice furnished by taxable person within 15 days or extended period is satisfactory, then 

proceedings can be dropped by the officer by issuing an order to that effect and no further action will be 

taken in this regard. 

  

If reply to notice furnished by taxable person within 15 days or extended period is not satisfac tory, then 

officer may issue the order for imposing penalty.   

10. What is the next step if a taxpayer neither replies to notice within time 

specified in notice nor attends personal hearing? 

In such a case, you can issue a reminder to the taxpayer. Maximum three reminders can be given. If the 

taxpayer neither replies to notice within time specified in notice nor attends personal hearing even after 

issue of reminder(s), an Order can be issued. 

11. In case notice/order, etc. is issued by post/special messenger, where do 

I update details of the case? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > General Penalty > Case Details > References > Communication  option. 

12. In case I need to upload additional documents (invoices, offline 

calculations, etc.) related to a particular case on the GST Portal, where do I 

upload? 



 

 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > General Penalty > Case Detail > Reference > ADD REFERENCE > 

REFERENCES OF CASE option.  

13. In case notice/order etc. is issued by post/special messenger, then what 

will be the “Date of issue”? 

Date of delivery will be considered as "Date of issue".  

14. What is Suo Moto Proceedings for? 

Suo Moto Proceedings are for initiating new proceedings u/s 125 against those registered or unregistered 

taxpayers who are liable to pay a general penalty.  

15. During General Penalty proceedings, at what different stages will a 

taxpayer receive an intimation via SMS or email? 

During General Penalty proceedings, a taxpayer will receive an intimation via SMS or email at the 

following stages: 

A. Issue of SCN 

B. Submission of each Reply filed by the taxpayer 

C. Issue of each Adjournment notice 

D. Issue of each Reminder 

E. Issue of Penalty Order or Drop Proceeding Order 

16. How many Reminders do I need to issue to a taxpayer after the issue of 

SCN? 

After the issue of SCN, you can send only 3 Reminders. Once you have issued 3 Reminders, system 

would not allow you to send any more reminders.  

17. Can I issue first reminder again? 

No, you cannot issue first reminder again. When issuing second reminder, the system will not allow you to 

select '1'  from the drop-down list of the "Reminder No." field-box and will display a following red message 

below the box: "Reminder no. 1 already issued." 



 

 

 

Manual > General Penalty 

How can I conduct Assessment/Adjudication proceedings on a person 

liable to pay a general penalty? 

To conduct Assessment/Adjudication proceedings on a person liable to pay a general penalty, perform 

following steps: 

  

A. Go to that particular person's Case Detail page by either searching for the ARN (Application 

Reference Number)/Case ID of the person liable to pay a general penalty or Suo Moto 

B. Issue a Show Cause Notice (SCN)  

C. Issue a Reminder, if needed 

D. View Replies by the Taxpayer, if any 

E. Issue an Adjournment, if needed 

F. Record Personal Hearing Proceedings, if any 

G. Record Other Communications related to the case, if any 

H. Record References related to the case, if any 

I. Issue Penalty order u/s 125 or Drop Proceeding 

  

Click each hyperlink above to know more. 

  

A. Searching for the ARN (Application Reference Number)/Case ID of the 

person liable to pay a general penalty 

To search for a particular ARN (Application Reference Number)/Case ID of the person liable to pay a 

general penalty, perform following steps: 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > General Penalty option. 

  



 

 

 

  

4. Search page is displayed. Choose any one of the four displayed fields as your search criteria and enter 

the required information: ARN, GSTIN, Status (select from the drop-down list as shown) or From Date & 

to Date  

  

 

  

Note 1: You must enter data in at least one field to proceed.   

  



 

 

Note 2: To view the list of all cases created or recommended from enforcement/Audit/Special audit/LUT 

(Letter of Undertaking), etc. you can choose the search criteria as “Pending for action by tax officer” in the 

Status field. For the purpose of this Manual, this is chosen as search criteria.  

  

5. Click the SEARCH button. 

  

 

  

6. Based on your search criteria, the required ARN/Case ID or the list of the required ARNs/Case ID 

of person (s) liable to pay a general penalty gets displayed. Click the ARN/Case ID hyperlink of the 

case you want to act on.   

  

 

  

Note: Because “Pending for action by tax officer” was selected in the Status field earlier, all those 

ARNs/Case ID that were pending for action gets displayed.   



 

 

  

7. Case Detail page is displayed. From this page, you can initiate conducting any 

Assessment/Adjudication proceedings related to this particular case by operating on the five tabs 

provided at the left-hand side of the page: NOTICES, REPLIES, PROCEEDINGS, ORDERS and 

REFERENCES. 

  

 

  

Note: On this page, the NOTICES tab is selected by default.  

  

Go back to the Main Menu 

 A. Suo Moto 

To Suo Moto, i.e. initiate a new proceeding on a person liable to pay a general penalty, perform following 

steps: 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > General Penalty option. 

  



 

 

  

  

4. Search page is displayed. Click the SUO MOTO PROCEEDING button.  

  

 

  

  

5. Suo Moto page is displayed. The “Proceeding Type” field gets auto-populated with “General 

Penalty”. Enter the GSTIN or UIN or Temporary Id of the taxpayer and then click the GO button. 

This will enable the CREATE button. 

  



 

 

 

  

Note 1: Six fields are mandatory. You must enter the required data in these six fields to proceed.   

  

Note 2: To create Temporary Id of an unregistered taxpayer, you can click the Click here hyperlink 

provided on the left-below side of the page. To know more on how to create a Temporary ID, refer to the 

Suo Moto Registration User Manual.  

  

6. Select the Financial Year from the drop-down list. 

7. Select the Tax Period from the From and To drop-down lists. 

8. Click the CREATE button. 

  



 

 

 

  

9. The Success popup is displayed. Click the CONTINUE button. 

  

 

 

  



 

 

10.  Case Detail page is displayed. From this page, you can initiate conducting all 

Assessment/Adjudication proceedings related to this particular case by operating on the five tabs 

provided at the left-hand side of the page: NOTICES, REPLIES, PROCEEDINGS, ORDERS and 

REFERENCES. 

  

 

  

Note: On this page, the NOTICES tab is selected by default.  

  

Go back to the Main Menu 

  

B. Issue a Show Cause Notice (SCN) 

To issue a Show Cause Notice (SCN) to a taxpayer, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected 

by default. This tab displays all the notices (SCN/Reminder/Adjournment) issued against the case 

created.  

  



 

 

 

  

Note: Current application Status as displayed is "Pending for action by tax officer".  

  

2. Click ADD NOTICE to open the drop-down list and select SHOW CAUSE NOTICE. 

  

 

  

3. The SCN page is displayed. The Type and the Financial Year fields are auto-populated. Enter 

the required data in the other four mandatory fields to proceed.   

  



 

 

 

  

Note: If you fill any one of the three non-mandatory fields—Personal Hearing Date , Personal Hearing 

Time and Venue, all these three fields will become mandatory. 

  

4. Enter the relevant section in the Section Number field. 

5. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

6. In case it is required to provide taxpayer the opportunity of personal hearing, click the calendar 

and select the date to enter it in the Personal Hearing Date  field. 

7. In the Personal Hearing Time  field, click time-calendar and select the time—hours and minutes. 

  

8. In the Venue field, enter the name of the place where you would like to call the taxpayer for 

personal hearing.   

9. In the Due Date to Reply field, click calendar and select the date to enter.     

10.  Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

SCN. 

11.  Click PREVIEW and a system-generated draft SCN gets downloaded into your machine as 

displayed. 

  



 

 

 

  

12.  Check the system-generated draft notice carefully to rule out any discrepancy. 

  



 

 

 

  

13.  Go back to the SCN page. Click ISSUE with DSC.  

  



 

 

 

  

14.  The Issue Notice/Order page is displayed with a Warning message. On this page also, click 

ISSUE with DSC.  

  

 

  

15.  The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 



 

 

  

16.  The updated Case Detail page is displayed, with the table containing the record of the SCN just 

issued and the Status updated to "Pending for reply by taxpayer".  

  

 

  

Note: As mentioned in the confirmation message on the Dashboard page, you can serve the SCN to the 

taxpayer by post or through a special messenger as well. For this, click the documents attached in the 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

Go back to the Main Menu 

C. Issue a Reminder, if needed 

To issue a Reminder to a taxpayer who has neither replied to the SCN within time specified nor attended 

a personal hearing, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected 

by default. This tab displays all the notices (SCN/Reminder/Adjournment) issued against the case 

created.  

  

 

  



 

 

2. Click ADD NOTICE to open the drop-down list and select REMINDER. 

  

 

  

3. The REMINDER page is displayed. The Type and the Section Number fields are auto-

populated. Enter the required data in the other four mandatory fields to proceed.   

  

 

  

Note: If you fill any one of the three non-mandatory fields—Personal Hearing Date , Personal Hearing 

Time and Venue, all these three fields will become mandatory. 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated. 

5. In case it is required to provide taxpayer the opportunity of personal hearing, cl ick the calendar 

and select the date to enter it in the Personal Hearing Date  field. 

6. In the Personal Hearing Time  field, click time-calendar and select the time—hours and minutes. 

7. In the Venue field, enter the name of the place where you would like to call the taxpayer for 

personal hearing.   

8. In the Due Date to Reply field, click calendar and select the date to enter.         

9. Select Reminder number from the drop-down list in the Reminder No. field.    



 

 

  

 

  

Note: After the issue of SCN, you can send only 3 Reminders. If you had already sent first reminder, 

system would not allow you to select 1 as displayed. 

  

10.  Click Choose File to upload the document(s), if required, from your machine that state the 

reasons of issuing this Reminder. 

11.  Click PREVIEW and a system-generated draft Reminder gets downloaded into your machine.  

  

 

  

12.  Check the system-generated draft reminder carefully to rule out any discrepancy. 

  



 

 

 

  

13.  Go back to the Reminder page. Click ISSUE with DSC.  

  



 

 

 

  

14.  The Issue Notice/Order page is displayed with a Warning message. On this page also, click 

ISSUE with DSC.  

  

 

  

15.  The Dashboard page is displayed with a confirmation message. Click OK.  

  

 



 

 

  

16.  The updated Case Detail page is displayed, with the table containing the record of the second 

reminder just issued and the Status updated to "Reminder No. 2 Issued".  

  

 

  

Note: As mentioned in the confirmation message on the Dashboard page, you can serve the Reminder(s) 

to the taxpayer by post or through a special messenger as well. For this, click the documents attached in 

the Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

Go back to the Main Menu  

D. View Replies by the Taxpayer, if any 

To view replies submitted by the taxpayer, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the REPLIES tab. This tab displays all 

replies filed by the taxpayer.  

  



 

 

 

  

2. Click the documents in the Attachments section to download and ascertain their contents.  

  

 

  

3. Here's a sample Reply that would have been filed by the taxpayer.  

  



 

 

 

  

Note:  

 If reply to notice furnished by taxable person within 15 days or extended period is satisfactory, 

then proceedings can be dropped by issuing order to that effect and no further action shall be taken 

in this regard.  

 If reply to notice furnished by taxable person within 15 days or extended period is not satisfactory, 

then officer shall issue the order for imposing penalty.  

  

Go back to the Main Menu  

E. Issue an Adjournment, if needed 

To update adjournment details for a taxpayer who has filed an application of extension offline, perform 

following steps: 

  

Note: You can approve Adjournment maximum 3 times. If you reject adjournment, the tax payer will have 

to furnish explanation or attend the personal hearing on the date specified in the SCN. 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected 

by default. This tab displays all the notices (SCN/Reminder/Adjournment) issued against the case 

created.  

  



 

 

 

  

2. Click ADD NOTICE to open the drop-down list and select Adjournment. 

  

 

  

3. The Adjournment page is displayed. The Type and the Section Number fields are auto-

populated. Enter the required data in the other two mandatory fields to proceed.  

  

 

  

Note: If you fill any one of the three non-mandatory fields—Personal Hearing Date , Personal Hearing 

Time and Venue, all these three fields will become mandatory. 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated. 



 

 

5. In case it is required to provide taxpayer the opportunity of personal hearing, click the calendar 

and select the date to enter it in the Personal Hearing Date field. 

6. In the Personal Hearing Time  field, click time-calendar and select the time—hours and minutes. 

  

7. In the Venue field, enter the name of the place where you would like to call the taxpayer for 

personal hearing.   

8. In the Due Date to Reply field, click the calendar and select the date to enter it.    

9. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

this Adjournment. 

10.  Click the ISSUE button. 

11.  A success message pops up on the screen. Click CONTINUE. 

  

 

  

12.  The updated Case Detail page is displayed, with the table containing the record of the 

Adjournment just issued. Also, system would send the intimation to the taxpayer via email and SMS, 

and make this Adjournment notice available on the taxpayer’s dashboard.  

  



 

 

 

  

Note 1: Intimation of issue of adjournment will be sent to taxpayer via email and SMS. It will also be 

available on taxpayer’s dashboard.   

  

  

Go back to the Main Menu 

F. Record Personal Hearing Proceedings, if any 

To update the proceeding details related to Personal Hearing, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the PROCEEDINGS tab. This tab 

displays a table of all the records of the proceedings' you would update.  

  

 

  

2. Click ADD PROCEEDINGS to open the drop-down list and select PERSONAL HEARING. 

  



 

 

 

  

3. PERSONAL HEARING page is displayed. The Type field is auto-populated. Enter Date by 

clicking the calendar icon and selecting the date when Personal Hearing was conducted.  

  

 

  

4. Type the required text in the Proceeding for the day field. 

  

 

  

5. Click Choose File to select the documents related to the Personal Hearing, if any.  



 

 

  

6. Click the SUBMIT button. 

  

 

  

7. The updated Case Detail page is displayed, with the table containing the record of the Personal 

Hearing just submitted. 

  

 

  

Go back to the Main Menu 

G. Record other Communications related to the case, if any 

To record any other communications related to the case, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the References tab. This tab displays 

a table of all the records of the References so far updated.  

  



 

 

 

  

2. Click ADD REFERENCE to open the drop-down list and select COMMUNICATION. 

  

 

  

  

3. COMMUNICATION page is displayed. Enter Date, Type of Communication and click Choose 

File to select the documents related to this communication, if any. 

  

 

  

Note: If you select, the Type of Communication as Special Messenger, you must fill the name of the 

person, who delivered this communication, in the Delivered by field. 

  



 

 

 

  

4. Click the SUBMIT button. 

  

 

  

5. The updated Case Detail page is displayed, with the table containing the record of the 

communication just submitted. 

  

 

  

Go back to the Main Menu 

H. Record References related to the case, if any 



 

 

To record the References related to the case such as invoices,offline calculations, etc., perform following 

steps: 

  

1. On the Case Detail page of that particular taxpayer, select the References tab. This tab displays 

a table of all the records of the References' you would update.  

  

 

  

2. Click ADD REFERENCE to open the drop-down list and select REFERENCES OF CASE. 

  

 

  

3. REFERENCES OF CASE page is displayed. The Date field is auto-populated with the system 

date. Click Choose File to upload the documents related to References of Case. 

  



 

 

 

  

  

4. Click the SUBMIT button. 

  

5. The updated Case Detail page is displayed, with the table containing the record of the 

References of Case just submitted. 

  

 

  

Go back to the Main Menu 

  

I. Issue Penalty order u/s 125 

To issue Penalty order u/s 125 against case created, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab. This tab displays a 

table of all the records for which you would issue orders against the case created.  

  



 

 

 

  

2. Click ADD ORDER to open the drop-down list and select GENERAL PENALTY ORDER. 

  

 

  

3. GENERAL PENALTY ORDER page is displayed. The Type, SCN Ref No., Date of SCN, 

Section Number, Tax Period and the Financial Year fields are auto-populated. Enter the required 

data in the other mandatory fields to proceed. 

  



 

 

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated. 

5. In the Due Date of Payment field, click calendar and select the date to enter.   

6. To add demand for each required month of the applicable tax period, select the From and To 

drop-down lists of the Tax period field. Click ADD to add more rows for entering demand for each 

month.  

  

 

  



 

 

7. Scroll to the right and select the Act from the drop-down list. Also, select the Place of Supply 

(POS) from the drop-down list.  

Note: POS is required only in case of IGST 

  

 

  

8. Again scroll to the right and in the Penalty field, enter the amount that the taxpayer must pay. 

  

.  

  

9. Click Choose File to upload the documents(s) from your machine that state the reasons of 

issuing this Order. 

10.  Click PREVIEW and a system-generated draft ORDER gets downloaded into your machine.  

11.  Check the system-generated draft ORDER carefully to rule out any discrepancy. 

  



 

 

 

  

13.  Go back to the GENERAL PENALTY ORDER page. Click ISSUE with DSC.  

14.  The Issue Notice/Order page is displayed with a Warning message. On this page also, click 

ISSUE with DSC.  

  

 

  

15.  The Dashboard page is displayed with a confirmation message. Click OK.  

  



 

 

 

  

16.  The updated Case Detail page is displayed, with the table containing details of the GENERAL 

PENALTY ORDER you just issued and the Status updated to "Order for creation of demand 

issued".  

  

 

  

Note: As mentioned in the confirmation message on the Dashboard page, you can serve the Order to the 

taxpayer by post or through a special messenger as well. For this, click the documents attached in the 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

Go back to the Main Menu  

  

I. Drop Proceeding 

To drop the proceedings, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab. This tab displays a 

table of all the records for which you would issue orders against the case created.  

  



 

 

 

  

2. Click ADD ORDER to open the drop-down list and select DROP PROCEEDING. 

  

 

  

3. DROP PROCEEDING page is displayed. The Type, SCN Ref No., Date of SCN, and the 

Financial Year fields are auto-populated.  

  



 

 

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. Click Choose File to upload the document(s) from your machine that state the reasons of 

dropping this proceeding. 

6. Click PREVIEW and a system-generated draft ORDER gets downloaded into your machine.  

7. Check the system-generated draft ORDER carefully to rule out any discrepancy. 

  

 

  

8. Go back to the DROP PROCEEDING page. Click ISSUE with DSC.  

9. The Issue Notice/Order page is displayed with a Warning message. On this page also, click 

ISSUE with DSC.  

  



 

 

 

  

  

10.  The Dashboard page is displayed with a confirmation message. Click OK.  

  

 

  

11.  The updated Case Detail page is displayed, with the new table containing the record of the 

DROP PROCEEDING Order you just issued and the Status updated to "Order for dropping 

proceedings issued".  

  

 

  



 

 

Note: As mentioned in the confirmation message on the Dashboard page, you can serve the Order to the 

taxpayer by post or through a special messenger as well. For this, click the documents attached in the 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

Go back to the Main Menu  

  



 

 

Intimation of Voluntary Payment 

FAQs > Intimation of Voluntary Payment 

1. Where can the taxpayer view the SCN and summary (GST DRC-01)? 

After logging in to the GST portal, the taxpayers can navigate to Services> User Services> View 

Additional Notices and Orders option. 

2. In case notice/order, etc. is issued by post/special messenger, where do I 

update details of the case? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Intimation of Voluntary Payment > Case Details > References > 

Communication option. 

3. In case I need to upload additional documents (invoices, offline 

calculations, etc.) related to a particular case on the GST Portal, where do I 

upload? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Intimation of Voluntary Payment > Case Detail > Reference > ADD 

REFERENCE > REFERENCES OF CASE option.  

4. Do I have to exclude the Period stayed by an order of a Court or Tribunal 

while computing the period of limitation for issuing the order? 

Yes. In case, the notice is stayed by a Court or a similar matter stayed by court, the period stayed and the 

time spent during those proceedings shall be excluded in computing the period of limitation for issuing the 

order. 

5. Can I drop proceedings for voluntary payments made without SCN? 

No. You cannot drop proceedings for voluntary payments made without SCN. Only acknowledgement can 

be issued. 

6. Can I issue acknowledgement for voluntary payments made against 

SCN? 



 

 

No. You cannot issue acknowledgement for voluntary payments made against SCN. Acknowledgements 

can be issued only when you are satisfied with intimation of payment before SCN is issued.  

7. What documents will the taxpayer receive, once I issue 

Acknowledgement? 

Taxpayer will receive two documents, i.e. Form GST DRC-04 generated by system and annexure 

uploaded by you, if any. 

8. What documents will the taxpayer receive, once I issue the DROP 

PROCEEDING Order? 

Taxpayer will receive two documents, i.e. Form GST DRC-05 generated by system and annexure 

uploaded by you, if any. 

  



 

 

 

Manual > Intimation of Voluntary Payment 

How can I conduct Assessment/Adjudication proceedings on a person who 

has voluntarily made the payment? 

To conduct Assessment/Adjudication proceedings on a person who has voluntarily made the payment, 

perform following steps: 

  

A. Search for the ARN (Application Reference Number)  

B. View the Details of the Voluntary Payment  

C. Acknowledge the Voluntary Payment (Form DRC - 04) or Drop Proceeding (Form DRC-05)  

D. Record Other Communications related to the case, if any 

E. Record References related to the case, if any 

  

Click each hyperlink above to know more. 

  

A. Search for the ARN (Application Reference Number) 

To search for a particular ARN (Application Reference Number) of the person who has voluntarily made 

the payment before the issue of an SCN, perform following steps:  

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > Intimation of Voluntary Payment 

option. 

  

 

  

4. Search page is displayed. Choose any one of the five displayed fields as your search criteria and enter 

the required information: ARN, GSTIN, Status (select from the drop-down list as shown) or From Date & 

to Date. 

  



 

 

 

  

Note 1: You must enter data in at least one field to proceed.   

  

5. Click the SEARCH button. 

6. Based on your search criteria, the required ARN or the list of the required ARNs of person (s) 

who have voluntarily made the payment gets displayed. Click the ARN hyperlink of the case you 

want to act on.  

  

Note: Because we had selected From Date & to Date as our Search criteria, all those ARNs that were 

created in that period gets displayed. 

  

 

  

7. Case Details page is displayed. From this page, you can initiate conducting all 

Assessment/Adjudication proceedings related to this particular case by operating on the three tabs 

provided at the left-hand side of the page: APPLICATIONS, ORDERS and REFERENCES. 



 

 

  

Note: On this page, the APPLICATIONS tab is selected by default.  

  

 

  

Go back to the Main Menu 

B. View the Details of the Voluntary Payment  

To view the details of the Voluntary Payment made by the taxpayer, perform  following steps: 

  

1. On the Case Details page of that particular taxpayer's application, select the APPLICATIONS tab if it 

is not selected by default. This tab displays all the PRNs (Payment Reference Number) of the voluntary 

payments made by the taxpayer, in a table.  

  

 

  

2. Click the PRN Number hyperlink.  

  

 

  

3. Details of Payment made are displayed. Click the hyperlink provided, to view the amount details 

deposited under various heads—IGST, CGST, SGST/UTGST and CESS.  



 

 

  

Note: At any time, you can click the BACK button to go to the previous page.  

  

 

  

 

  

 

  

 

  

 

  

Go back to the Main Menu 

C. (1) Acknowledge the Voluntary Payment (Form DRC - 04) 

To acknowledge the Voluntary Payment made by the taxpayer, before issue of SCN, perform following 

steps: 

  

1. On the Case Details page of that particular taxpayer's application, select the ORDERS tab.  

  



 

 

 

  

Note: Current application Status as displayed is "Pending for action by tax officer".  

  

2. Click ADD ORDER to open the drop-down list and select ISSUE ACKNOWLEDGEMENT. 

  

 

  

  

3. ISSUE ACKNOWLEDGEMENT page is displayed. Click the Generate Reference Number 

hyperlink to auto-populate the Order Number field.  

  

 

  

4. As mentioned in the tool-tip of the Order Number field, copy the generated Reference Number 

and paste it in your documents to be uploaded.  

  



 

 

 

  

5. Click Choose File to upload the documents(s) from your machine that state the reasons of 

issuing this order. 

6. Click PREVIEW and a system-generated draft ORDER gets downloaded into your machine.  

7. Check the system-generated draft ORDER carefully to rule out any discrepancy. 

  

 

  

8. Go back to the ISSUE ACKNOWLEDGEMENT page. Click ISSUE with DSC.  

9. The Issue Order page is displayed with a Warning message. On this page also, click ISSUE with 

DSC.  

  



 

 

 

  

10.  The Dashboard page is displayed with a confirmation message. Click OK.  

  

 

  

11.  The updated Case Details page is displayed, with the table containing the record of the 

ACKNOWLEDGEMENT just issued and the Status of application is updated to "Acknowledged".  

  

 

  

Note: As mentioned in the confirmation message on the Dashboard page, you can serve the 

ACKNOWLEDGEMENT to the taxpayer by post or through a special messenger as well. For this, click 

the documents attached in the Attachments section of the table to download them. Take a print and then 

sign the printed document manually before sending.  



 

 

  

12.  Here's an example of the ACKNOWLEDGEMENT in Form GST DRC04, which would be 

generated once you submit the application by clicking the ISSUE with DSC button. 

  

 

  

Go back to the Main Menu 

  

D. Record Other Communications related to this case, if any 

To record any other communication related to the case, perform following steps:  

  

1. On the Case Details page of that particular taxpayer, select the References tab. This tab displays 

a table of all the records of the References you would update here. 

  

 

  

2. Click ADD REFERENCE to open the drop-down list and select COMMUNICATION. 

  



 

 

 

  

  

3. COMMUNICATION page is displayed. Enter Date and Type of Communication and click 

Choose File to upload the documents related to this communication, if any. 

  

 

  

  

Note: If you select, the Type of Communication as Special Messenger, you must fill the name of the 

person, who delivered this communication, in the Delivered by field. 

  

 

  

4. Click the SUBMIT button. 

  



 

 

5. The updated Case Details page is displayed, with the new table containing the record of the 

COMMUNICATION you just submitted. 

  

 

  

Go back to the Main Menu 

E. Record References related to this case, if any 

To record the References related to the case, perform following steps:  

  

1. On the Case Details page of that particular taxpayer, select the References tab. This tab displays 

a table of all the records of the References you would update here. 

  

 

  

2. Click ADD REFERENCE to open the drop-down list and select REFERENCES OF CASE. 

  

 

  

  



 

 

3. REFERENCES OF CASE page is displayed. Enter Date by clicking the calendar icon and 

selecting the date of these References.  

  

 

  

  

4. Click Choose File to upload the documents related to these References of Case, if any.  

  

5. Click the SUBMIT button. 

  

6. The updated Case Details page is displayed, with the new table now containing the record of the 

References of Case you just submitted in the top row. 

  

 

  

Go back to the Main Menu 

  

C. (2) Drop Proceeding (Form DRC-05) 

To drop the Assessment/Adjudication proceedings on a person who has satisfactorily made the payment 

against SCN or Statement, in compliance to the provisions mentioned under section 73 and 74; perform 

following steps: 

  

1. On the Case Details page of that particular taxpayer's application, select the ORDERS tab.  

  



 

 

 

  

Note: Current application Status as displayed is "Pending for action by tax officer".  

  

2. Click ADD ORDER to open the drop-down list and select DROP PROCEEDING. 

  

 

  

  

3. DROP PROCEEDING page is displayed. Click the Generate Reference Number hyperlink to 

auto-populate the Order Number field.  

  

 

  

4. As mentioned in the tool-tip of the Order Number field, copy the generated Reference Number 

and paste it in your documents to be uploaded.  

5. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

this Order. 

6. Click PREVIEW and a system-generated draft ORDER gets downloaded into your machine.  

7. Check carefully the system-generated draft ORDER for any discrepancy. 



 

 

  

 

  

8. Go back to the DROP PROCEEDING page. Click ISSUE with DSC.  

9. The Issue Order page is displayed with a Warning message. On this page also, click ISSUE with 

DSC.  

  

 

  

10.  The Dashboard page is displayed with a confirmation message. Click OK.  

  



 

 

 

  

11.  The updated Case Details page is displayed, with the new table containing the record of the 

DROP PROCEEDING Order you just issued and the Status updated to "Proceedings dropped".  

  

 

  

Note: As mentioned in the confirmation message on the Dashboard page, you can serve the DROP 

PROCEEDING Order to the taxpayer by post or through a special messenger as well. For this, click the 

documents attached in the Attachments section of the table to download them. Take a print and then 

sign the printed document manually before sending.  

  

12.  Here's an example of the DROP PROCEEDING Order in Form GST DRC05, which would be 

generated by clicking the ISSUE with DSC button. 

  

 

  



 

 

Go back to the Main Menu 

  

  

  

  

  

  

  

  

  



 

 

Assessment of Unregistered Persons 

FAQs > Assessment of Unregistered Persons 

1. Who all fall under "Unregistered Persons" category? 

Following persons will fall under "Unregistered Persons" category: 

1. Taxpayers who are not registered under the GST and have not applied for registration under GST Act, 

but are liable to get registered as per the provisions of the Act.  

2. Taxpayers whose registration has been cancelled due to some reason and they are liable to pay tax. 

2. When does the procedure of the Assessment of Unregistered Persons 

start? 

The procedure of the Assessment of Unregistered Persons starts when a tax officer comes to know, 

either during inspection or survey or enforcement or through the information available with intelligence 

unit or through any other means, that a taxable person has failed to obtain registration or paid taxes even 

though liable to do so.  

3. What is Suo Moto Proceedings for? 

Suo Moto Proceedings are proceedings in which tax officers initiate new proceedings against an 

unregistered taxpayer, who are liable to obtain registration or whose registration has been cancelled but 

are liable to pay tax. 

4. What documents will taxpayers receive once I issue Show Cause Notice 

(SCN)? 

Taxpayers will receive two documents: Show Cause Notice (SCN) in Form GST ASMT- 14, generated by 

the system and Annexure for detailed reasons, if any, uploaded while issuing the SCN.  

5. Where can the taxpayers view notices and Orders issued to them? 

Taxpayers can view the notices and Orders issued to them by logging to the GST portal with their 

credentials and navigating to Services > User Services > View Additional Notices and Orders option. 

6. In the case of unregistered persons, is it mandatory to serve the SCN 

and Reminders by post/special messenger? 



 

 

Yes. It is mandatory to serve the SCN and Reminders to an unregistered taxpayer by post/special 

messenger. 

7. In case notice/order, etc. is issued by post/special messenger, where do I 

update details of the case? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Assessment of unregistered persons > Case Detail > References > 

COMMUNICATION option. 

8. In case notice/order etc. is issued by post/special messenger, then what 

will be the “Date of issue”? 

Date of delivery will be considered as "Date of issue".  

9. How many reminders do I need to issue to a taxpayer after the issue of 

SCN? 

After the issue of SCN, you can issue maximum 3 Reminders on the Portal. Once you have issued 3 

Reminders, system would not allow you to send any other reminder.  

10. Can I issue first reminder again? 

No, you cannot issue first reminder again. When issuing second reminder, the system will  not allow you to 

select '1' from the drop-down list of the "Reminder No." field-box and will display a following error 

message below the box in red ink: "Reminder no. 1 already issued."  

11. How much time can be given to the taxpayers for responding and 

attending the Personal Hearing? 

Taxpayer in general are given a time of 15 days to attend personal hearing. They can also seek extension 

(offline). However, the tax officer can accept the application of extension and grant Adjournments up to 

maximum of three times on the Portal.  

12. What is the next step if a taxpayer does not attend personal hearing? 

In such a case, you can issue a reminder to the taxpayer. Maximum three reminders can be given. If the 

taxpayer does not appear within the time specified even after issue of reminder(s), an ex-parte order can 

be issued by tax official on the basis of available information and records.  



 

 

13. During Assessment/Adjudication proceedings against an unregistered 

person, at what different stages will a taxpayer receive an intimation via 

SMS or email? 

During Assessment/Adjudication proceedings against an unregistered person, a taxpayer will receive an 

intimation via SMS or email if mobile no. and email ID is available with tax authorities and it is entered by 

the official at the time of Suo Moto registration proceedings. Intimation via SMS or email will be sent at 

the following stages: 

A. Issue of SCN 

B. Issue of each Adjournment notice 

C. Issue of each Reminder 

D. Issue of Assessment Order or Drop Proceeding Order 

14. In case I need to upload additional documents (invoices, offline 

calculations, etc.) related to a particular case on the GST Portal, where do I 

upload? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Assessment of unregistered persons > Case Detail > Reference > ADD 

REFERENCE > REFERENCES OF CASE option.  

15. What happens on the GST Portal when an Assessment Order is issued 

to an Unregistered Person? 

When an Assessment Order is issued to an Unregistered Person, following actions will happen on the 

GST Portal: 

 Intimation of the issue of order is sent to the concerned taxpayer via his/her email ids and SMS.  

 Status of ARN/Case ID and RFN will be changed to ‘Order for creation of demand issued’.  

 Reference number of the order will be generated. 

 Electronic liability register and DCR of the unregistered person shall also get updated with the 

demand specified in the order 



 

 

 

Manual > Assessment of Unregistered 
Persons 

How can I conduct Assessment/Adjudication proceedings on an 

Unregistered person? 

To conduct Assessment/Adjudication proceedings on an Unregistered person, perform following steps:  

  

A. Create a new Case ID using SUO MOTO PROCEEDING button or search for the ARN 

(Application Reference Number)/Case ID 

B. Issue a Show Cause Notice (SCN)  

C. Issue a Reminder, if required 

D. Issue an Adjournment, if required 

E. Record Personal Hearing Proceedings, if any 

F. Record Other Communications related to the case, if any 

G. Record References related to the case, if any 

H. Issue an Assessment order u/s 63 or Drop Proceeding 

  

Click each hyperlink above to know more. 

A. (1) SUO MOTO PROCEEDING 

To initiate a new Suo Moto proceeding, against an unregistered person liable to pay tax, perform 

following steps: 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > Assessment of unregistered 

persons option. 

  



 

 

  

  

4. Search page is displayed. Click the SUO MOTO PROCEEDING button.  

  

 

  

  

5. Suo Moto proceeding page is displayed. The “Proceeding Type” field gets auto-populated with 

“Assessment of unregistered persons”. Enter the GSTIN or UIN or Temporary Id of the taxpayer and 

then click the GO button. This will enable the CREATE button. 

  



 

 

 

  

Note 1: Six displayed fields are mandatory. You must enter the required data in these six fields to 

proceed.  

  

Note 2: To create Temporary Id of an unregistered taxpayer, you can click the Click here hyperlink 

provided on the left-below side of the page. To know more on how to create a Temporary ID, refer to the 

Suo Moto Registration User Manual.  

  

6. Select the Financial Year from the drop-down list. 

7. Select the Tax Period from the From and To drop-down lists. 

8. Click the CREATE button.  

9. The Success popup is displayed. Click the CONTINUE button. 

  

  

  



 

 

10.  Case Detail Page is displayed. From this page, you can initiate conducting all 

Assessment/Adjudication proceedings related to this particular case by operating on the four tabs 

provided at the left-hand side of the page: NOTICES, PROCEEDINGS, ORDERS and 

REFERENCES. 

  

 

  

Note: On this page, the NOTICES tab is selected by default.  

  

Go back to the Main Menu 

A. (2) Search for the ARN (Application Reference Number)/Case ID  

To search for a particular ARN (Application Reference Number)/Case ID of the unregistered person, 

perform following steps: 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > Assessment of unregistered 

persons option. 

  



 

 

 

  

4. Search page is displayed. Choose any one of the four displayed fields as your search criteria and enter 

the required information: ARN, GSTIN, Status (select from the drop-down list as shown) or From Date & 

To Date  

  

 

  

Note: You must enter data in at least one field to proceed.   

  

5. Click the SEARCH button. 

  

6. Based on your search criteria, the required ARN or the list of the required ARNs of unregistered 

person (s) liable to be assessed will be displayed. Click the ARN hyperlink of the case you want to 

act on.  

  



 

 

 

  

Note: Because From Date & To Date was selected earlier as the Search criteria, all those ARNs that 

were created in that period gets displayed.  

  

7. Case Detail Page is displayed. From this page, you can initiate conducting all 

Assessment/Adjudication proceedings related to this particular case by operating on the four tabs 

provided at the left-hand side of the page: NOTICES, PROCEEDINGS, ORDERS and 

REFERENCES. 

  

 

  

Note: On this page, the NOTICES tab is selected by default.  

  

Go back to the Main Menu 

B. Issue a Show Cause Notice (SCN) 

To issue Show Cause Notice (SCN) to an unregistered taxpayer, perform following steps: 



 

 

  

1. On the Case Detail page of that particular unregistered taxpayer, select the NOTICES tab if it is 

not selected by default. This tab displays all the notices (SCN/Reminder/Adjournment) you would 

issue against the case created.  

  

 

  

Note: Current application Status as displayed is "Pending for action by tax officer".  

  

2. Click ADD NOTICE to open the drop-down list and select SHOW CAUSE NOTICE. 

  

 

  

3. The SCN page is displayed. The Type, Financial Year, and the From & To fields of Tax Period 

are auto-populated. Enter the required data in the other mandatory fields to proceed.   

  



 

 

 

  

4. Enter the relevant section number in the Section Number field. 

5. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

6. Enter the Personal Hearing Date  field by clicking the calendar and selecting the date. 

7. In the Personal Hearing Time  field also, click calendar and select the time—hours and minutes.   

8. In the Venue field, enter the address of the place where you would like to call the taxpayer for 

personal hearing.   

9. In the Reason to Issue Notice  field, select the reason from the drop-down list.   

  

Note 1: As displayed in the image below, if you select reason to issue notice as "Failed to obtain 

registration", you are required to fill Liable to be registered u/s field.    

  

 

  

Note 2: As displayed in the image below, if you select reason to issue notice as "Cancellation of 

registration", you are required to fill Date of Cancellation field.    

  



 

 

 

  

10.  Click Choose File to upload the documents(s) from your machine that state the reasons of 

issuing SCN. 

11.  Click PREVIEW and a system-generated draft SCN gets downloaded into your machine. 

12.  Check the system-generated draft notice carefully to rule out any discrepancy. 

  

 

  

Note: The above system-generated draft notice is for the unregistered taxpayer whose registration has 

been cancelled. If you are issuing this notice to an unregistered taxpayer who has failed to obtain 

registration, following draft notice would be generated: 

  



 

 

 

  

  

13.  Go back to the SCN page. Click the PROCEED button.  

  

14.  The Submit Application page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  



 

 

 

  

15.  The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

16.  The updated Case Detail page is displayed, with the table containing the record of the SCN just 

issued and the Status updated to "Pending for reply by taxpayer".  

  

 

  

Note: As mentioned in the confirmation message on the Dashboard page, you can serve the SCN to the 

taxpayer by post or through a special messenger as well. For this, click the documents attached in the 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  



 

 

  

17.  Here's a sample SCN that would be sent to the taxpayer whose registration has been cancelled: 

  

 

  

18.  Here's a sample SCN that would be sent to the taxpayer who has failed to obtain registration:  

  



 

 

 

  

Go back to the Main Menu 

C. Issue a Reminder, if required 

To issue a reminder to taxpayer who has neither replied to the SCN within time specified nor attended a 

personal hearing, perform following steps: 

  



 

 

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected 

by default. This tab displays all the notices (SCN/Reminder/Adjournment) you have issued against 

the case created.  

  

 

  

2. Click ADD NOTICE to open the drop-down list and select REMINDER. 

  

 

  

3. The REMINDER page is displayed. The Type and the Section Number fields are auto-

populated. Enter the required data in the other mandatory fields to proceed.   

  

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated. 



 

 

5. Enter the Personal Hearing Date  field by clicking the calendar and selecting the date. 

6. In the Personal Hearing Time  field also, click calendar and select the time—hours and minutes.   

7. In the Venue field, enter the address of the place where you would like to call the taxpayer for 

personal hearing. 

8. Select Reminder number from the drop-down list in the Reminder No. field.    

  

 

  

Note: After issue of SCN, you can send only 3 Reminders. If you had already sent first reminder, system 

would not allow you to select 1 as an option here. As displayed, following red message will appear below 

the box: "Reminder no. 1 already issued."  

  

9. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

this Reminder. 

10.  Click PREVIEW and a system-generated draft Reminder gets downloaded into your machine.  

11.  Check the system-generated draft Reminder carefully to rule out any discrepancy. 

  



 

 

 

  

12.  Go back to the Reminder page. Click the PROCEED button. 

13.  The Submit Application page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  



 

 

 

  

14.  The Dashboard page is displayed with a confirmation message. Click OK.  

  

 

  

16.  The updated Case Detail page is displayed, with the table containing the record of the Reminder 

1 you just issued and the Status updated to "Reminder No. 1 Issued".  

  

 

  



 

 

Note: As mentioned in the confirmation message on the Dashboard page, you can serve the Reminder(s) 

to the taxpayer by post or through a special messenger as well. For this, click the documents attached in 

the Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

17.  Here's a sample reminder that would be sent to the taxpayer: 

  

 

  

Go back to the Main Menu  

D. Issue an Adjournment, if required 



 

 

To update adjournment details for a taxpayer who has filed an application of extension offline, perform 

following steps: 

  

Note: You can approve Adjournment maximum 3 times. If you reject an application of extension,  the tax 

payer will have to furnish explanation or attend the personal hearing on the date specified in the SCN.  

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected 

by default. This tab displays all the notices (SCN/Reminder/Adjournment) issued against the case 

created.  

  

 

  

2. Click ADD NOTICE to open the drop-down list and select Adjournment. 

  

 

  

3. The Adjournment page is displayed. The Type and the Section Number fields are auto-

populated. Enter the required data in the other four mandatory fields to proceed. 

  

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated. 

5. Enter the Personal Hearing Date  field by clicking the calendar and selecting the date. 

6. In the Personal Hearing Time  field also, click calendar and select the time—hours and minutes.   

7. In the Venue field, enter the address of the place where you would like to call the taxpayer for 

personal hearing. 



 

 

8. Click Choose File to upload the document(s), if any, from your machine that state the reasons of 

issuing this adjournment. 

9. Click the ISSUE button. 

10.  A success message pops up on the screen. Click CONTINUE. 

  

 

  

11.  The updated Case Detail page is displayed, with the table containing the record of the 

Adjournment just issued. Also, system would send the intimation to the taxpayer via email and SMS.  
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E. Record Personal Hearing Proceedings, if any 

To update the proceeding details related to Personal Hearing, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the PROCEEDINGS tab. This tab 

displays a table of all the records of the proceedings you would update. Click ADD PROCEEDINGS 

to open the drop-down list and select PERSONAL HEARING. 

  



 

 

 

  

2. PERSONAL HEARING page is displayed. The Type field is auto-populated. Enter Date by 

clicking the calendar icon and selecting the date when Personal Hearing was conducted.  

  

 

  

3. Type the required text in the Proceeding for the day field. 

  

4. Click Choose File to upload the documents related to the Personal Hearing, if any.  

  

5. Click the SUBMIT button. 

  

6. The updated Case Detail page is displayed, with the table containing the record of the Personal 

Hearing just submitted. 
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F. Record other Communications related to the case, if any 



 

 

To record any other communications related to the case, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the References tab. This tab displays 

a table of all the records of the References you would update. Click ADD REFERENCE to open the 

drop-down list and select COMMUNICATION. 

  

 

  

2. COMMUNICATION page is displayed. Enter the two mandatory fields— Date and Type of 

Communication.  

  

 

  

Note: As displayed in the image below, if you select, the Type of Communication as Special 

Messenger, you must fill the Delivered by field with the name of the person who delivered this 

communication. 

  

 

  

3. Click Choose File to upload the document(s), if any. 



 

 

4. Click the SUBMIT button. 

5. The updated Case Detail page is displayed, with new table containing the record of this 

communication just submitted. 

  

 

  

Go back to the Main Menu 

G. Record References related to the case, if any 

To record the References related to the case, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the References  tab. This tab displays 

a table of all the records of the References you would update. Click ADD REFERENCE to open the 

drop-down list and select REFERENCES OF CASE. 

  

 

  

2. REFERENCES OF CASE page is displayed. Enter Date by clicking the calendar icon and 

selecting the date of these References.  

  

 

  

  

3. Click Choose File to upload the document(s) related to this case. 

  



 

 

4. Click the SUBMIT button. 

  

5. The updated Case Detail page is displayed, with the table containing the record of the 

References just submitted. 

  

 

  

Go back to the Main Menu 

H.(1) Issue an Assessment order u/s 63 

To issue Assessment order against the case created, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab. Click ADD ORDER 

to open the drop-down list and select ASSESSMENT ORDER - ASMT-15. 

  

 

  

2. ASSESSMENT ORDER - ASMT-15 page is displayed. The Type, SCN Ref No., Date of SCN, 

Section Number, Financial Year and overall Tax Period fields are auto-populated in accordance 

with the SCN you had issued. Enter the required data in the other mandatory fields to proceed. 

  

Note: If you have not issued SCN, you won't be able to issue Order.  

  



 

 

 

  

Note: Click the ADD button to add more rows containing details of the amount assessed and payable by 

the taxpayer.  

  

3. In the Order Number field, click the Generate Reference Number hyperlink. Reference Number 

field gets auto-populated. 

4. In the Due Date of Payment field, click calendar and select the date to enter.   

5. In the Reason to Issue Order field, select the reason from the drop-down list. 

6. To add demand for each required month of the applicable tax period, select the From and To 

drop-down lists of the Tax period field. Click ADD to add more rows for entering demand for each 

month.  

  

 

  



 

 

7. Scroll to the right and select the Act from the drop-down list. Also, select the Place of Supply 

(POS) from the drop-down list.  

  

Note: POS is required only in case of IGST. 

  

 

  

  

8. Again scroll to the right and in the  field and enter the amount that the taxpayer must pay in the 

applicable fields: Tax/Cess, Interest, Penalty, Others. 

  

.  

  

9. Click Choose File to upload the document(s) from your machine that state the detailed reasons 

of issuing this Order. 

10.  Click PREVIEW and a system-generated draft ORDER gets downloaded into your machine.  

11.  Check the system-generated draft ORDER carefully to rule out any discrepancy. 

  



 

 

 

  



 

 

Note: The above system-generated draft Order is for the unregistered taxpayer whose registration has 

been cancelled. If you are issuing this Order to an unregistered taxpayer who has failed to obtain 

registration, following draft notice would be generated: 

  

 



 

 

  

13.  Go back to the ASSESSMENT ORDER - ASMT-15 page. Click the PROCEED button.  

14.  The Submit Application page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  

 

  

15.  The Dashboard page is displayed with a confirmation message. Click OK.  

  

 

  

16.  The updated Case Detail page is displayed, with the new row containing the record of the 

ASSESSMENT ORDER - ASMT-15 just issued and the Status updated to "Order for creation of 

demand issued".  

  



 

 

 

  

Note 1: As mentioned in the confirmation message on the Dashboard page, you can serve this Order to 

the taxpayer by post or through a special messenger as well. For this, click the documents attached in the 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

Note 2:  

To sum up, once Assessment Order is issued to an Unregistered Person, following actions take place on 

the GST Portal: 

 Intimation of the issue of order is sent to the concerned taxpayer via his/her email ids and SMS.  

 Status of ARN/Case ID and RFN will be changed to ‘Order for creation of demand issued’.  

 Reference number of the order will be generated. 

 Electronic liability register and DCR of the unregistered person shall also get updated with the 

demand specified in the order 

  

17.  Here's an example of the two-page order that would be sent to the taxpayer whose registration 

has been cancelled: 

  



 

  



 

 

  

18.  Here's an example of the two-page Order that would be sent to the taxpayer who has failed to 

obtain registration: 

  



 

 

 

  



 

 

Go back to the Main Menu  

  

H. (2) Drop Proceeding 

To drop the proceedings, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab. Click ADD ORDER 

to open the drop-down list and select DROP PROCEEDING. 

  

 

  

2. DROP PROCEEDING page is displayed. The Type, SCN Ref No., Date of SCN, Financial Year, 

and the Tax Period fields are auto-populated. Enter the required data in the mandatory fields to 

proceed. 

  

 



 

 

  

3. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

4. Click Choose File to upload the document(s) from your machine that state the reasons of 

dropping this proceeding. 

5. Click PREVIEW and a system-generated draft ORDER gets downloaded into your machine.  

6. Check the system-generated draft ORDER carefully to rule out any discrepancy. 

  

 

  

8. Go back to the DROP PROCEEDING page. Click the PROCEED button.  

9. The Submit Application page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  



 

 

 

  

10.  The Dashboard page is displayed with a confirmation message. Click OK.  

  

 

  

11.  The updated Case Detail page is displayed, with the table containing the record of the DROP 

PROCEEDING Order just issued and the Status updated to "Order for dropping proceedings 

issued".  

  

 

  

Note: As mentioned in the confirmation message on the Dashboard page, you can serve the Order to the 

taxpayer by post or through a special messenger as well. For this, click the documents attached in the 



 

 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

12.  Here's an example of the Order that would sent to the taxpayer:  

  

 

  

Go back to the Main Menu  

  

  



 

 

Assessment of Non-filers of Returns 

FAQs > Assessment of Non-filers of Returns 

1. Who will fall under "Non-filers of Return" category for assessment? 

All those registered taxpayers will fall under "Non-filers of Return" category for assessment, who are 

required to file a valid return and have not filed it within 15 days of issuance of Notice u/s 46 of the GST 

Act, 2017 in Form GSTR-3A.   

2. On the Non-filers Search page, can I select multiple tax periods to get 

non-filers data of last 3 months? 

No, you cannot select more than one tax period for assessment. You can only search for a particular 

month, one at a time. To get non-filers data of last 3 months, you will have to search it 3 times by 

selecting each tax period, one by one.  

3. I am on the Non-filers Search page. What does the field name "Turnover" 

refer to? Do I need to fill this also before clicking the Search button? 

Turnover means turnover of the business. 

  

You need not fill this, as it is not a mandatory field. Only Type of return and Tax period fields are 

mandatory fields.  

4. One of the taxpayers in my jurisdiction has filed the return before 

completion of the proceedings. What will happen in this case? 

In case, the tax payer files the return before initiation or the completion of proceedings, then system will 

automatically change the status to ’Return filed, no action required’. No action will be required from your 

end, in such a case. 

5. What are the pre-conditions to frame assessment against a Non-filer? 

Pre-conditions to frame assessment against a Non-filer are: 

 Notice u/s 46 in Form GSTR-3A must have been sent to the registered taxable person who 

required to file the requisite return.   

 Taxpayer has defaulted in complying with the notice.  

 15 days’ time has elapsed from the date of issuance or service of notice.  



 

 

6. How to access material for framing assessment under section 62 of the 

GST Act, 2017? 

All the relevant material of a particular case available on record could be accessed using the following 

hyperlinks provided on the top-right side of the ASSESSMENT ORDER - ASMT-13 page (To access the 

page use path : Orders > Add Order > ASSESSMENT ORDER - ASMT-13): 

 MIS Reports: Contains all available MIS Reports.  

 Tax Liability: Contains details of estimated tax liabilities of current tax period as updated from 

Form GSTR-1, 1A and Form GSTR-2, 2A  

 Tax Return History: Contains details of the returns of the previous tax periods, and also option 

to view any other return of the defaulter.  

  

Note: If taxpayer has submitted any information/record in reply to Notice, that may also be examined and 

taken into consideration while passing the assessment order.  

7. Give an example of determining tax liability of a Non-filer? 

On the basis of returns of preceding tax periods filed and transactions appearing in Form GSTR- 1, 1A, 2 

& 2A of current tax period, here is an example that may result in probable tax liability.  

  

Let's suppose: 

 Form GSTR-1A captures auto-populated data of outward supplies reported by recipients in Form 

GSTR- 2 of a taxpayer for INR 1,00,000; and 

 Form GSTR-2Acaptures auto-populated data of inward supplies from Form GSTR-1 of 

corresponding suppliers for INR 2,00,000 for the same taxpayer.  

  

Based on above data, tax officer may proceed to determine the tax liability in the following manner for that 

particular tax period: 

 Total inward supplies: INR 2,00,000 

 Additional Notional Profit @20%: INR 40,000 

 Total taxable inward supplies: INR 2,40,000 

 Tax liability with the rate of tax @ 18%: INR 43,200 

 Any amount accounted for assessment purpose (to be determined by the tax officer): Rs. 100000  

 Amount of Interest, if applicable (to be determined by the tax officer) 

 Amount of penalty (to be determined by the tax officer) 

  

Note: Please note that above example is only indicative in nature for tax officials.  

8. What documents will taxpayers receive, once I issue Assessment order 

u/s 62 against him/her? 



 

 

Taxpayer will receive two documents, order in Form GST ASMT-13 generated by system and annexure 

uploaded by you, if any.  

9. What happens on the GST Portal when Assessment order u/s 62 is 

issued against a Non-filer? 

Once Assessment Order u/s 62 is issued against the non-filer of return, following actions take place on 

the GST Portal: 

 Intimation of the issue of order is sent to the concerned taxpayer on his/her email ids and SMS.  

 Form GST ASMT-13 generated by system and annexure uploaded by officer is made available 

on the taxpayer's dashboard.  

 A Demand ID is created as per ID master data (which shall be same as order reference no).  

 Electronic liability register, upon generation of demand ID and DCR of the non-filer gets updated 

with the demand ID specified in the order.  

  

10. After issue of the Assessment order u/s 62, does the GST System do 

any auto-check on whether the return is filed or not? 

Yes, after issue of the Assessment order u/s 62 the GST System does following auto-check on whether 

return is filed or not. 

  

On the 30th day of the issue of order, system checks whether the return (for which notice was issued 

under section 46 of the Act to the taxpayer) is filed within 30 days of the order or not and system also 

checks whether the filed return is a valid return or not. Following cases may occur:  

i. Return is filed by taxpayer: Demand order shall be deemed to be withdrawn automatically, and 

Electronic liability register will be updated (reversed) accordingly, for all  major and minor heads. On 

the GST portal, the Status on the Case Detail page will be changed to ‘Order deemed Withdrawn’ 

and Status of Demand in DCR will be changed to ‘Demand settled‘.  

ii. Return is not filed by taxpayer: Demand will continue to remain in Liability Register for 

recovery. 

11. When can proceedings be dropped for a non-filer? 

Proceedings can be dropped for a non-filer, if proceedings are undertaken or intended to be undertaken 

under any other sections. 

12. What happens on the GST Portal when Drop Proceeding Order is 

issued? 



 

 

Once Drop Proceeding Order is issued to the non-filer of return, following actions take place on the GST 

Portal: 

 Intimation of the issue of order is sent to the concerned taxpayer on his/her email ids and SMS.  

 Annexure, if any, uploaded by officer will be made available on the Taxpayer's dashboard.  

13. What documents will taxpayer receive once I issue Drop Proceeding 

Order? 

Taxpayer will receive annexure, if any, uploaded by you.  

14. Where can the taxpayers view notices and orders issued to them? 

Taxpayers can view the notices and orders issued to them by logging on to the GST portal with their 

credentials and navigating to Services > User Services > View Additional Notices and Orders option. 

15. In case order is issued by post/special messenger, where do I update 

details of the case? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Assessment of Non-filers of Returns > Case Detail > References > 

COMMUNICATION option and enter/update details in relevant columns.   

16. In case notice/order etc. is issued by post/special messenger, then what 

will be the “Date of issue”? 

Date of delivery will be considered as "Date of issue".  

17. In case I need to upload additional documents (invoices, offline 

calculations, etc.) related to a particular case on the GST Portal, where do I 

upload? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Assessment of Non-filers of Returns > Case Detail > References > 

ADD REFERENCE > REFERENCES OF CASE option and upload additional documents. 

18. Can a Non-filer file an appeal against the issued order?  

Yes, a Non-filer can file an appeal against the issued order, within the time period specified in law. 



 

 

19. What happens when a non-filer neither makes payment of demand 

mentioned in the order nor files an appeal? 

When a non-filer neither makes payment of demand within time period specified in the order nor files 

appeal within the time period specified in law, then after expiry of said period, tax authorities can initiate 

recovery proceedings. 

20. During the Assessment/Adjudication proceedings on the 

case/application of a Non-filer of Return, what all Status changes does the 

case/application undergo? 

During the Assessment/Adjudication proceedings on the case/application of a Non-filer of Return, the 

case/application may undergo following Status changes:  

  

 Pending for action by tax officer: When status of RFN (Notice reference number) is under work 

item of tax officer. 

 Return filed, no action required: When return is filed by taxpayer before initiating/completion of 

proceedings 

 Order for creation of demand issued: When order is issued by tax official 

 Order deemed withdrawn: When return is filed by taxpayer within 30 days of issuance of order 

 Proceedings initiated/Saved as draft: When proceedings are initiated but not completed (i.e. 

order is yet to be issued) 

 Proceedings Dropped, undertaken under other section: When proceedings are undertaken or 

intended to be undertaken under other section of the Act 

 Demand created: Status of demand Upon issuance of order (GST ASMT-13) by tax officer 

 Demand settled: Status of demand if return is filed within 30 days of order or service of the order 



 

 

 

Manual > Assessment of Non-filers of Returns 

How can I conduct Assessment/Adjudication proceedings on Non-filer of 

Return? 

All those registered taxpayers will fall under "Non-filers of Return" category for assessment, who are 

required to file a valid return and have not filed it within 15 days of issuance of Notice u/s 46 of the GST 

Act, 2017 in Form GSTR-3A.   

  

To conduct Assessment/Adjudication proceedings on Non-filers of Return, perform following steps: 

  

A. View List of Non-filers 

B. Search for an already-created ARN/Case ID 

C. Initiate Proceedings against the Non-filer  

D. Record Communications related to the case 

E. Record References related to the case, if any 

F. Issue an Assessment order u/s 62 or Drop Proceeding 

  

Click each hyperlink above to know more. 

  

A. View List of Non-filers 

To view list of Non-filers of Returns, perform following steps: 

  

1. Access the GST Back Office Portal for tax officials. The Home page is displayed. 

2. Login using your valid credentials. The Dashboard page is displayed. 

3. Navigate to Statutory Functions > Quick Links > View Non-filers option. 



 

 

 

 

  

4. Non-filers Search page is displayed. Enter data in the displayed fields and click SEARCH 

button. With the RESET button, you can reset the data and then search again.  

  

 

  

Note 1: Type of Return and Tax Period are mandatory fields. Make sure you fill them before clicking 

SEARCH. 

  

Note 2: In the Tax Period field, both From and To fields should be filled up (you can search non-filers for 

a particular month or quarter only at a time).  

  



 

 

5. Based on your search criteria, list is displayed. You can sort the list using Columns Turnover, 

Tax Paid and RC Surrendered. Also, 10 records are displayed per page. To view other pages of the 

list, click the page number-buttons 1, 2, 3... displayed below.  

  



 

 

 



 

 

  

Note: Once the list is displayed, you can close the "Search" area by clicking the downward-arrow below 

the DOWNLOAD button and view only the list. It changes to upward arrow and only list is displayed as 

shown in the image below. To view the "Search" area again, click the upward arrow. 

  

 

  

6. Click the Download button to download the entire list. It will be downloaded in a .csv format as 

displayed. 

  



 

 

 

  

Go back to the Main Menu 

B. Search for an already-created ARN/Case ID 

To search for a particular ARN/Case ID of the Non-filers of returns, perform following steps: 

  

1. Access the GST Back Office Portal for tax officials. The Home page is displayed. 

2. Login using your valid credentials. The Dashboard page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > Assessment of Non-filers of 

Returns option. 

  

 

  

4. Case Detail Search page is displayed. Choose any one of the four displayed fields as your search 

criteria, enter the required information: ARN, GSTIN, Status (select from the drop-down list) or From 

Date & To Date, and click the SEARCH button. 

  



 

 

 

  

Note: You must enter data in at least one field to proceed.   

  

5. Based on your search criteria, the required ARN or the list of the required ARNs of Non-filers of 

returns is displayed. Click the ARN hyperlink of the case you want to act on.  

  

 

  

Note: Because From Date & To Date was selected earlier as the Search criteria, all those ARNs that 

were created in that period get displayed.  

  

6. Case Detail Page is displayed. From this page, you can initiate conducting all 

Assessment/Adjudication proceedings related to this particular case by operating on the two tabs 

provided at the left-hand side of the page: ORDERS and REFERENCES. 

  



 

 

 

  

Note 1: On this page, the ORDERS tab is selected by default.  

Note 2: Status of the ARN/Case is "Pending for action by tax officer". In case, a tax payer has filed the 

return before the completion of proceedings, then the system will automatically change the Status to 

"Return filed, no action required" as shown in the image below. 

  

 

  

Go back to the Main Menu 

C. Initiate Proceedings against the Non-filer  

To initiate proceedings against the non-filer, you must create a new ARN (Application Reference 

Number)/Case ID against the Non-filer. To do this, perform following steps: 

  

1. Search for the list of Non-filers as mentioned in Step A - View the List of Non-filers. 

2. On the Non-filers Search page, list of non-filers of return is displayed, based on the search 

criteria. In the displayed list of Non-filers, scroll to the right and click the INITIATE PROCEEDINGS 

button in Column "Action", in the row of the taxpayer you want to take action on. 

  



 

 

 

  

3. Suo Moto page is displayed. All displayed fields will be auto-populated. Click CREATE. You can 

also click BACK to go back to the Non-filers Search page. 

  

 

 

  



 

 

4. The Success popup is displayed. Click the CONTINUE button. 

  

 

 

  

5. Case Detail Page is displayed. From this page, you can initiate all Assessment/Adjudication 

proceedings related to this particular case by operating on the two tabs provided at the left-hand side 

of the page: ORDERS and REFERENCES. 

  

 

  

Note 1: On this page, the ORDERS tab is selected by default.  

Note 2: Status of the ARN/Case is "Pending for action by tax officer". In case,a tax payer has filed the 

return before the completion of proceedings, then the system will automatically change the Status to 

"Return filed, no action required" as shown in the image below. 

  



 

 

 

  

  

Go back to the Main Menu 

D. Record Communications related to the case, if any 

To record any communication related to the case, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the REFERENCES tab. This tab 

displays a table of all the records of the References you would update. Click ADD REFERENCE to 

open the drop-down list and select COMMUNICATION. 

  

 

  

2. COMMUNICATION page is displayed. Enter the two mandatory fields— Date and Type of 

Communication (select one of the following options from the drop-down list—Post or Special 

Messenger. To go to the previous page, click BACK. 

  



 

 

 

  

Note: As displayed in the image below, if you select, Type of Communication as Special Messenger, 

you must fill the Delivered by field with the name of the person who delivered this communication.  

  

 

  

2a. Click Choose File to upload the document(s), if any. You can also delete the uploaded file by clicking 

on the trash-bin icon.  

2b. Click the SUBMIT button. 

  

3. The updated Case Detail page is displayed, with new table containing the record of this 

communications submitted. 



 

 

  

 

  

  

Go back to the Main Menu 

E. Record References related to the case, if any 

To record the References related to the case, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the REFERENCES tab. This tab 

displays a table of all the records of the References you would update. Click ADD REFERENCE to 

open the drop-down list and select REFERENCES OF CASE. 

  

 

  

2. REFERENCES OF CASE page is displayed. Enter Date by clicking the calendar icon and 

selecting the date of these References. To go to the previous page, click BACK. 

  



 

 

 

  

  

2a. Click Choose File to upload the document(s) related to this case. You can also delete the uploaded 

file by clicking on the trash-bin icon.  

2b. Click the SUBMIT button. 

  

3. The updated Case Detail page is displayed, with the table containing the record of the references 

just submitted. 

  

 

  

  

Go back to the Main Menu 

F.(1) Issue an Assessment order u/s 62 

To issue an assessment order against the case created, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab. Click ADD ORDER 

to open the drop-down list and select ASSESSMENT ORDER - ASMT-13. 

  



 

 

 

  

Note: Current application Status as displayed is "Pending for action by tax officer". This status will 

change once you issue this order.  

  

2. ASSESSMENT ORDER - ASMT-13 page is displayed. The Type, SCN Ref No., Date of SCN, 

Return Type, Section Number, Financial Year and Tax Period fields are auto-populated. Enter the 

required data in the following mandatory fields to proceed: Order Number, Due Date of Payment, 

Demand grid below the Tax Period field, Attachments. To go back to the previous page, click 

BACK.  

  



 

 

 

  

Note: Before issuing the Order, if required, you can also refer to the following hyperlinks provided on the 

right-side of the page to view various details: MIS Report, Tax Liability and Tax Return History. 

  

2a. In the Order Number field, click the Generate Reference Number hyperlink. Order Number field gets 

auto-populated. 

2b. In the Due Date of Payment field, click calendar and select the date to enter.   

2c. In the demand grid, select the From and To drop-down lists of the Tax period field. Click ADD to add 

more rows for entering demand for each month.  

  



 

 

 

  

2d. In the demand grid, scroll to the right and select the Act from the drop-down list. Also, select the 

Place of Supply (POS) from the drop-down list.  

  

Note: POS is required only in case of IGST. 

  

 

  

2e. In the demand grid, again scroll to the right and in the following fields enter the amount that the 

taxpayer must as applicable: Tax/Cess, Interest, Penalty, Others. 

  

.  

  

2f. Click Choose File to upload the document(s) from your machine that state the detailed reasons of 

issuing this order. To delete any uploaded document, click the trash-bin icon.  



 

 

2g. Preview button gets enabled. Click PREVIEW and a system-generated draft ORDER gets 

downloaded into your machine.  

2h. Check the system-generated draft ORDER carefully to rule out any discrepancy. 

  



 

 

 



 

 

  

3. Go back to the ASSESSMENT ORDER - ASMT-13 page. Click the PROCEED button.  

4. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  

 

  

5. The Dashboard page is displayed with a confirmation message. Click OK.  

  

 

  

6. The updated Case Detail page is displayed, with the new row containing the record of the 

ASSESSMENT ORDER - ASMT-13 just issued and the Status updated to "Order for creation of 

demand issued".  

  

 



 

 

  

  

Note 1: As mentioned in the confirmation message on the Dashboard page, you can serve this order to 

the taxpayer by post or through a special messenger as well. For this, click the documents attached in the 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

7. Here's an example of the two-page order that would be sent to the taxpayer: 

  



 

 

 



 

 

  

Note:  

  

To sum up, once assessment order is issued to the non-filer of return, following actions take place on the 

GST Portal: 

 Intimation of the issue of order is sent to the concerned taxpayer on his/her email ids and SMS.  

 Form GST ASMT-13 generated by system and annexure uploaded by officer is made available 

on the taxpayer's dashboard.  

 A Demand ID is created as per ID master data (which shall be same as order ref no).  

 Electronic liability register, upon generation of demand ID and DCR of the non-filer gets updated 

with the demand ID specified in the order.  

 On the 30th day of the issue of order, system will check whether the return (for which notice was 

issued under section 46 of the Act to the taxpayer) is filed within 30 days of the order or not and 

system also checks whether the filed return is valid or not. Following cases may occur: 

a. Return is filed by taxpayer: Demand order shall be deemed to be withdrawn automatically, and 

Electronic liability register will be updated (reversed) accordingly, for all major and minor heads. On 

the GST portal, the Status on the Case Detail page will be changed to ‘Order deemed Withdrawn’ 

and Status of Demand in DCR will be changed to ‘Demand settled‘.  

b. Return is not filed by taxpayer: Demand will remain as it is and Demand will continue to remain 

in Liability Register for recovery. 

  

 

  

Go back to the Main Menu  

  

F. (2) Drop Proceeding 

To drop the proceedings, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab. Click ADD ORDER 

to open the drop-down list and select DROP PROCEEDING. 

  



 

 

 

  

Note: Current application Status as displayed is "Pending for action by tax officer". This status will 

change once you issue this order.  

  

2. DROP PROCEEDING page is displayed. The Type, SCN Ref No., Date of SCN, Financial Year 

fields are auto-populated. Only the Order Number field is mandatory. To go to the previous page, 

click BACK. 

  

 

  

2a. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

2b. Click Choose File to upload the document(s) from your machine that state the reasons of dropping 

this proceeding. 

3. Click the PROCEED button to issue the Order.  

4. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  



 

 

 

  

5. The Dashboard page is displayed with a confirmation message. Click OK.  

  

 

  

6. The updated Case Detail page is displayed, with the table containing the record of the DROP 

PROCEEDING Order just issued and the Status updated to "Proceeding Dropped, undertaken 

under other section".  

  

 

  

Note 1: As mentioned in the confirmation message on the Dashboard page, you can serve the order to 

the taxpayer by post or through a special messenger as well. For this, click the documents attached in the 



 

 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

Note 2: Once Drop Proceeding Order is issued to the non-filer of return, following actions take place on 

the GST Portal: 

 Intimation of the issue of order is sent to the concerned taxpayer on his/her email ids and SMS.  

 Annexure, if any, uploaded by officer will be made available on the Taxpayer's dashboard.  

  

Go back to the Main Menu  

  



 

 

Determination of Tax u/s 73 and 74 

FAQs > Determination of Tax u/s 73 and 74 

1. What is Section 73 & 74? 

Section 73: Covers determination of tax not paid or short paid or erroneously refunded or ITC availed 

wrongly or utilized for any reason other than fraud, willful misstatement or suppression of facts.   
  

Section 74: Covers determination of tax not paid or short paid or erroneously refunded or ITC availed 
wrongly or utilized by reason of fraud, willful misstatement or suppression of fac ts.  

2. What are the reasons for initiating Assessment/Adjudication 

proceedings u/s 73 and 74? 

Some of the reasons for initiating Assessment/Adjudication proceedings u/s 73 and 74 are given below:  

         Where the taxpayer has violated the conditions prescribed for availing composition scheme 

         Where the ISD has distributed excess credit or distributed credit in contravention of the provisions of 

the Act 

         Where the tax deductor fails to comply with the TDS provisions mentioned in section 51 

         Where the taxpayer fails to comply with the notice issued u/s 61 or explanation given is not found 

satisfactory after the scrutiny of return 

         Where the summary assessment framed u/s 64 has been withdrawn by Additional/Joint 

Commissioner either Suo moto or on application 

         Where a case is recommended based on the Audit conducted u/s 65 

         Where a case is recommended by Special Audit conducted u/s 66 

         Where a case is recommended based on the on the survey conducted u/s 67 

         Where there are other cases of tax not paid/short paid/erroneously refunded/ITC wrongly availed or 

utilized 

3. What is the general procedure of conducting Assessment/Adjudication 

proceedings u/s 73 and 74? 

General procedure of conducting Assessment/Adjudication proceedings u/s 73 and 74 is:  

 Notice shall be issued to the taxpayer for furnishing reply to show cause notice. In case the Tax 

Official has called for a Personal Hearing in the notice; date, time and venue of personal hearing wil l 

also be provided there   

 If reply to notice furnished by taxable person within time specified or extended period is 

satisfactory, then "Drop Proceeding" Order will be issued.  



 

 

 If reply to notice furnished by taxable person within time specified or extended period is not 

satisfactory, then officer can issue "Assessment order u/s 73 or 74" within specified period. 

4. During Assessment/Adjudication proceedings u/s 73 and 74 against a 

taxpayer, at what different stages will a taxpayer receive an intimation via 

SMS or email? 

During Assessment/Adjudication proceedings, a taxpayer will receive an intimation via SMS or email on 

registered mobile no. and email ID.  

  

Intimation via SMS or email will be sent at the following stages:  

 Issue of Acknowledgement in form GST DRC-04, if Voluntary Payment was made before the 

issue of SCN 

 Issue of ‘intimation of conclusion of proceeding’ in form GST DRC-05, if payment was made 

within 30 days of issue of SCN 

 Issue of SCN and summary of show cause notice in form GST DRC-01 

 Issue of Statement and a summary of the statement in Form GST DRC-02. 

 Submission of Reply in Form GST DRC-06 

 Issue of each Adjournment notice 

 Issue of each Reminder 

 Issue of Assessment Order and summary of order in form GST DRC-07 or Drop Proceeding 

Order 

5. In case the taxpayer makes voluntary payment before the issue of Show 

Cause Notice (SCN), what is the procedure of conducting 

Assessment/Adjudication proceedings u/s 73 and 74? 

In case, taxpayer makes voluntary payment before issue of Show Cause Notice (SCN) and files 

Intimation of voluntary payment by filing DRC 03 at portal, the procedure of conducting 

Assessment/Adjudication proceedings u/s 73 and 74 will be as under:  

 Tax officer will check and assess the payment made.  

 If the tax officer is satisfied that the payment of amount mentioned in the case is made, then 

status of ARN/Case id will be changed to “Acknowledged” and intimation of acknowledgment of 

acceptance of payment made voluntarily will be sent to person via email and SMS and 

Acknowledgement will be issued in Form GST DRC-04. 

 In case, voluntary payment made before SCN is found to be deficient or person has not made 

voluntary payment, tax officer has option to issue SCN for the amount which falls short of the amount 

actually payable. Tax officer has to decide the section in which proceedings are to be initiated i.e. 

section 73 or section 74. 



 

 

6. What is the criteria of determining tax u/s 73? 

Following is the criteria of determining tax u/s 73: 

 Time limit for issuance of Show Cause Notice (SCN): 3 months prior to end of time limit of 
issuance of order 

 If taxpayer pays the liability before issue of SCN: Tax + Interest + Penalty (in some cases). 

 If taxpayer pays the liability within 30 days of issue of notice: Tax+ Interest + Penalty (in 
some cases, to be decided by the tax officer). 

 If any amount collected as tax, but has not been paid within period of 30 days from the due 
date of payment of such tax: Penalty shall be payable if payment is made after issue of SCN 
but within 30 days. 

 Time limit of issuance of order: 3 Years from due date of filing of annual return for the year to 
which tax relates. 

 Amount of demand: Tax + Interest + penalty (10% of tax or Rs. 10,000 whichever is higher) 

  
Note: Please refer to relevant Section/ Rule for details. 

7. What is the criteria of determining tax u/s 74? 

Following is the criteria of determining tax u/s 74: 

 Time limit for issuance of Show Cause Notice (SCN): 6 months prior to time limit of issuance 
of order 

 If taxpayer pays the liability before issue of SCN: Tax+ Interest+ Penalty (15% of tax) 

 If taxpayer pays the liability within 30 days of issue of notice: Tax+ Interest+ Penalty (25% of 
tax) 

 If any amount collected as tax, but has not been paid within period of 30 days from the due 
date of payment of such tax: Penalty shall be payable if payment is made after issue of SCN 

but within 30 days. 

 Time limit of issuance of order: 5 Years from due date of filing of annual return for the year to 
which tax relates. 

 Amount of demand: Tax + Interest + Penalty (100% of tax). 

 If taxpayer pays the demand within 30 days of communication of order: Tax+ Interest+ 
Penalty (50% of tax) 

  
Note: Please refer to relevant Section/ Rule for details. 

8. What documents will taxpayers receive once I issue SCN u/s 73 or 74? 

Taxpayer will receive two documents i.e. SCN under section 73 or 74, Summary of notice in Form GST 
DRC-01 generated by system and annexure uploaded by officer. 

9. What happens on the GST Portal when SCN is issued? 

Once SCN is issued, following actions take place on the GST Portal: 

 ARN/Case ID Status is updated as "Pending for reply by taxpayer".  



 

 

 Intimation of the issue of SCN is sent to the concerned taxpayer via his/her email ids and SMS.  

 Dashboard of Taxpayer is updated with the record of the issued SCN. Taxpayer can view the 

issued SCN from the following navigation: Services > User Services > View Additional 

Notices/Orders > View > Case Details. 

10. In what case do I need to issue Statement u/s 73 or 74? 

Statement u/s 73 or 74 can be issued for period not covered in SCN (on the same grounds as in the SCN 

under consideration).  

11. Can I issue Statement u/s 74, where provisions of Section 73 are 

applicable? 

Yes, you can issue Statement u/s 74, where provisions of Section 73 are applicable. You will be provided 

with an option to select provisions of Section 73 while issuing Statement u/s 74.  

12. While issuing Statement u/s 73/74, do I need to select tax period ahead 

of the selected SCN tax period? 

Yes, you need to select tax period ahead of the selected SCN tax period while issuing Statement u/s 

73/74. 

13. What documents will taxpayers receive once I issue Statement u/s 73 or 

74? 

Taxpayer will receive two documents i.e. Statement, and summary of Statement in Form GST DRC-02 

generated by system and annexure uploaded by officer, if any. 

14. What happens on the GST Portal when Statement u/s 73 or 74 is 

issued? 

Once Statement u/s 73 or 74 is issued, following actions take place on the GST Portal:  

 Intimation of the issue of Statement is sent to the concerned taxpayer via his/her email  ids and 

SMS. 

 Statement u/s 73 or 74 and Form GST DRC-02 generated by system and annexure uploaded by 

officer will be made available on the Taxpayer's dashboard: Services > User Services > View 

Additional Notices/Orders > View > Case Details. 

15. How many reminders do I need to issue to a taxpayer after the issue of 

SCN/Statement? 



 

 

After the issue of SCN/Statement, you can issue maximum 3 Reminders on the Portal. Once you have 

issued 3 Reminders, system would not allow you to send any other reminder.  

16. What happens on the GST Portal when a Reminder is issued? 

Once a Reminder is issued, following actions take place on the GST Portal:  

 ARN/Case ID Status is updated as "Reminder No. 1 Issued" or "Reminder No. 2 Issued" or 

"Reminder No. 3 Issued" in accordance with the Reminder No. you had selected while issuing the 

Reminder. 

 Intimation of the issue of Reminder is sent to the concerned taxpayer via his/her email ids and 

SMS. 

 Dashboard of Taxpayer is updated with the record of the issued Reminder. Taxpayer can view 

the issued Reminder from the following navigation: Services > User Services > View Additional 

Notices/Orders > View > Case Details. 

17. Where can I view the reply filed by the taxpayers? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Determination of tax (Fraud/Other) > Case Detail > Replies option. 

18. When can the tax officer drop Assessment/Adjudication proceedings 

u/s 73 or 74 against the taxpayer? 

The tax officer can drop Assessment/Adjudication proceedings u/s 73 or 74 against a taxpayer, if amount 

of dues is paid by the taxpayer or the reply filed by the taxpayer has been found satisfactory.  

  

The proceedings can be deemed to be concluded in following cases:  

 For section 73: If taxpayer makes the payment of tax along with interest and penalty @10% (if 

applicable) within 30 days of issue of notice and the tax officer is satisfied with above voluntary 

payment, then in such case, it shall be deemed that all the proceedings have been concluded.  

 For section 74: If taxpayer makes the payment of tax and interest along with penalty@25% of 

tax within 30 days of issue of notice and the tax officer is satisfied with voluntary payment, then in 

such case, it shall be deemed that all the proceedings have been concluded. 
  
Note: Please refer to relevant Section/ Rule for details. 

19. What happens on the GST Portal when a DROP PROCEEDING Order is 

issued? 

Once DROP PROCEEDING Order is issued, following actions take place on the GST Portal:  

 ARN/Case ID Status is updated to "Order for dropping proceedings issued".  



 

 

 Intimation of the issue of order is sent to the concerned taxpayer via his/her email ids and SMS.  

 Order generated by system and annexure uploaded by officer will be made available on the 

Taxpayer's dashboard: Services > User Services > View Additional Notices/Orders > View > 

Case Details. 

20. While issuing the Assessment order and GST DRC-07 on the GST 

Portal, is it mandatory to enter description of both Goods and Services?  

No, it is not mandatory to enter description of both Goods and Services while issuing the Assessment 

order and GST DRC-07 on the GST Portal. You can enter description in any one section and proceed to 

the next tab.  

21. How to access material available on record, related to a particular case, 

for issuing Statement or Order u/s 73 or 74? 

All the relevant material of a particular case available on record could be accessed using the following 

hyperlinks provided on the top-right side of the related Statement/Order page: 

 MIS Reports: Contains all available MIS Reports.  

 Tax Liability: Contains details of estimated tax liabilities of current tax period as updated from 

Form GSTR-1, 1A, Form GSTR-2, 2A and other Returns and Statements 

 Tax Return History: Contains details of the returns of the previous tax periods, and also option 

to view any other return of the defaulter.  

  

Additionally, the Tax Official can also refer to the following material:  

 Refund orders, etc.  

 Document /information received from Taxpayer/third party source 

22. What is the criteria of issuing Order u/s 73 or 74? 

In case, the tax officer is not satisfied with the response of the taxpayer or if the taxpayer does not attend 

the personal hearing and neither furnish Reply on date specified in SCN or extended date, then tax officer 

can issue order u/s 73 or 74. 

23. What happens on the GST Portal when Order u/s 73 or 74 is issued? 

Once Order u/s 73 or 74 is issued, following actions take place on the GST Portal:  

 Intimation of the issue of order is sent to the concerned taxpayer via his/her registered email ids 

and SMS. 

 Order u/s 73 or 74 and Form GST DRC-07 generated by system and annexure uploaded by 

officer will be made available on the Taxpayer's dashboard. 



 

 

 Demand ID will be created as per ID master data. (which shall be same as order ref no).  

 Electronic liability register upon generation of demand ID and DCR would also get updated.  

 Status of ARN/Case id will be changed to “Order for creation of demand issued”. 

24. What documents will taxpayers receive once I issue Assessment Order 

u/s 73 or 74? 

Taxpayer will simultaneously receive two documents i.e. Order and summary of the order in Form GST 

DRC-07 generated by system. 

25. Where can the taxpayer view the SCN and summary (GST DRC-

01)/Statement/Orders issued against him/her? 

To view the SCN and summary (GST DRC-01)/Statement/Orders issued against him/her, the taxpayer 

must login to the GST portal and navigate to Services> User Services> View Additional Notices and 

Orders option. 

26. In the case of unregistered persons, is it mandatory to serve the 

SCN/Statement/Reminders/Order by post/special messenger? 

Yes. It is mandatory to serve SCN/Statement/Reminders/Order to an unregistered person by post/special 

messenger. 

27. During the proceedings related to Determination of Tax u/s 73 and 74, 

the ARN/Case ID undergoes several status changes. What all and when 

these status changes take place? 

During Determination of Tax u/s 73 and 74 proceedings, the ARN/Case ID may undergo following Status 

changes: 

  

 Pending for action by tax officer: When status of ARN/Case ID is under work item of tax officer 

 Pending for reply by taxpayer: When tax officer sends notice to the taxpayer 

 Reminder No.1 issued: When tax officer sends the first Reminder to the taxpayer for replying to 

the notice issued earlier 

 Reminder No.2 issued: When tax officer sends the second Reminder to the taxpayer for replying 

to the notice issued earlier 

 Reminder No.3 issued: When tax officer sends the third Reminder to the taxpayer for replying to 

the notice issued earlier 

 Reply furnished, pending for Order by tax officer: When taxpayer replies to the notice issued 

by tax officer and the same is pending order/decision by tax officer 



 

 

 Reply not furnished, pending for order: When taxpayer does not reply to the issued notice, 

within the period specified in the notice 

 Order for dropping proceedings issued: When tax officer passes an order for dropping 

proceedings 

 Order for creation of demand issued: When tax officer passes an order for creation of demand 

  



 

 

 

Manual > Determination of Tax u/s 73 and 74 

How can I conduct Assessment/Adjudication proceedings for the 

determination of tax-liability u/s 73 and 74? 

To conduct Assessment/Adjudication proceedings for determining tax -liability of a person under section 

73 and 74, perform the following steps: 

  

A. Conduct Assessment/Adjudication proceedings on intimation of voluntary payment  

B. Create a new Case ID 

B(1). Create a new Case ID using SUO MOTO PROCEEDING button  

B(2). Search for the ARN (Application Reference Number)/Case ID 

C. Take action using NOTICES tab of Case Detail page:  

C(1). Issue Show Cause Notice (SCN) and summary in Form GST DRC-01  

C(2). Statement and summary in Form GST DRC-02  

C(3). Reminder  

C(4). Adjournment 

D. Take action using REPLIES tab of Case Detail page: View replies Filed by the taxpayer, if any 

E. Take action using PROCEEDINGS tab of Case Detail page: Record Personal Hearing 

Proceedings, if any 

F. Take action using ORDERS tab of Case Detail page:  

F(1). Issue an Assessment order u/s 73 or 74  

F(2). Drop Proceeding 

G. Take action using REFERENCES tab of Case Details page:  

G(1). Record Communications  

G(2). References related to the case, if any 

  

Click each hyperlink above to know more. 

  

 B(1). Suo Moto PROCEEDING 

For Suo Moto proceedings, i.e. to initiate a new proceeding for determining tax-liability of a person under 

section 73 and 74, perform following steps:  

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 



 

 

3. Navigate to Statutory Functions > Assessment/Adjudication > Determination of tax 

(Fraud/Other) option. 

 

 

  

4. Search page is displayed. Click the SUO MOTO PROCEEDING button.  

  

 

  

  

5. Suo Moto page is displayed. The “Proceeding Type” field gets auto-populated with “Determination 

of tax(Fraud/Others)”. Enter the GSTIN or UIN or Temporary Id of the taxpayer and then click the 

GO button. This will enable the CREATE button. To go to the previous Search page, click BACK.  

  



 

 

 

  

Note 1: All fields are mandatory. You must enter the required data in these fields to proceed.   

  

Note 2: To create Temporary Id of an unregistered taxpayer, you can click the Click here hyperlink 

provided on the left-below side of the page. To know more on how to create a Temporary ID, refer to the 

Suo Moto Registration User Manual.  

  

6. Select the Financial Year from the drop-down list. 

7. Select the Tax Period from the From and To drop-down lists. 

8. Click the CREATE button. 

9. A Success popup appears. Click the CONTINUE button. 

  

 

 

  



 

 

10.  Case Detail page is displayed. From this page, you can initiate all Assessment/Adjudication 

proceedings related to this particular case by operating on the tabs provided at the left-hand side of 

the page: NOTICES, REPLIES 

  

 

  

Note 1: On this page, the NOTICES tab is selected by default.  

  

Note 2: Currently, Status of the ARN/Case is "Pending for action by tax officer". It will change as you 

conduct the proceeding. 

  

Go back to the Main Menu 

  

B(2). Search for the ARN (Application Reference Number)/Case ID 

To search for a particular ARN (Application Reference Number)/Case ID, perform following steps:  

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > Determination of tax (Fraud/Other) 

option. 

  



 

 

 

  

4. Search page is displayed. Choose any one of the four displayed fields as your search criteria and enter 

the required information: ARN, GSTIN, Status (select from the drop-down list as shown) or From Date & 

to Date  

  

 

  

Note: You must enter data in at least one field to proceed.   

  

5. Click the SEARCH button. 

  

6. Based on your search criteria, the required ARN/Case ID or the list of the required ARNs/Case ID 

gets displayed.  

  



 

 

 

  

Note: Because From Date & To Date was selected earlier as the Search criteria, all those ARNs that 

were created during that period is displayed.  

  

Click the ARN/Case ID hyperlink of the case you want to act on.   

  

7. Case Detail page is displayed. From this page, you can initiate conducting all 

Assessment/Adjudication proceedings related to this particular case by operating on the tabs 

provided at the left-hand side of the page: NOTICES, REPLIES 

  

 

  

Note 1: On this page, the NOTICES tab is selected by default.  

  

Note 2: Currently, Status of the ARN/Case is "Pending for action by tax officer". It will change as you 

conduct the proceeding. 

  

Go back to the Main Menu 

C(1). Show Cause Notice (SCN) and Form GST DRC-01 



 

 

To issue Show Cause Notice (SCN) u/s 73 or 74, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected 

by default. This tab displays all the notices (SCN/Reminder/Adjournment) you would issue against 

the case created.  

  

 

  

Note: Current Status as displayed is "Pending for action by tax officer". It will change once you issue 

SCN. 

  

2. Click ADD NOTICE to open the drop-down list and select SCN u/s 73/74 and GST DRC-01. 

  

 

  

3. The SCN page is displayed. The Type, Financial Year, and the From & To fields of overall Tax 

Period are auto-populated. Enter details in the other displayed fields as mentioned in the following 

steps. To go to the previous page, click BACK.  

  



 

 

 

  

3a. Select the relevant section number in the drop-down list of the Section Number field.  

  

 

  

3b. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

  

 

  



 

 

3c. Select the check-box if Personal Hearing is required. In case you select it, following fields will appear: 

Personal Hearing Date, Personal Hearing Time, Venue . Enter data in these fields also as mentioned in 

the following steps: 

  

 

  

i. Enter the Personal Hearing Date  field by clicking the calendar and selecting the date. 

ii. In the Personal Hearing Time  field also, click calendar and select the time—hours and minutes.   

iii. In the Venue field, enter the address of the place where you would like to call the taxpayer for 

personal hearing.   

  

3d. In the ARN field, select ARN of Voluntary payment intimation if applicable.  ARN date gets auto-

populated.  

  

 

  

3e. In the Due Date to Reply field, click the calendar and select the date. 

  

 

  

3f. Select the From and To drop-down lists of the Tax period field.  

  

 

  



 

 

3g. Scroll to the right and select the Act from the drop-down list. Also, select the Place of Supply (POS) 

from the drop-down list.  

  

Note: POS is required only in case of IGST. 

  

 

  

3h. Again scroll to the right and in the following fields enter the amount in the applicable fields: Tax/Cess, 

Interest, Penalty, Others. 

  

 

  

3i. Click ADD to add more rows for entering demand for each month. Another row gets displayed. Scroll 

to the left and enter details in this row also in the same way, as mentioned in the steps above—3f, 3g and 

3h.  

  



 

 

 

  

3j. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

SCN. 

3k. Click PREVIEW and a system-generated draft SCN and Form GST DRC-01 gets downloaded into 

your machine. 

3l. Check the system-generated draft notice and Form GST DRC-01 carefully to rule out any discrepancy. 

3m. Go back to the SCN page. Click the PROCEED button.  

  

4. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  

 

  

5. The Dashboard page is displayed with the following confirmation message. Click OK.  

  



 

 

 

  

6. The updated Case Detail page is displayed, with the table containing the record of the SCN just 

issued and the Status updated to "Pending for reply by taxpayer".  

  

 

  

Note: As mentioned in the confirmation message on the Dashboard page, you can serve the SCN to the 

taxpayer by post or through a special messenger as well. For this, c lick the documents attached in the 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

Go back to the Main Menu 

  

C(2). Statement and Summary in Form GST DRC-02  

To issue Statement and Summary in Form GST DRC-02 for period not covered in SCN (on the same 

grounds as in the SCN under consideration), perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected 

by default. This tab displays all the notices (SCN/Statement/Reminder/Adjournment) you would issue 

against the case created. Click ADD NOTICE to open the drop-down list and select Statement u/s 

73/74 and DRC-02. 

  



 

 

 

  

  

2. The Statement u/s 73/74 and DRC-02 page is displayed. Enter details in the other displayed 

fields as mentioned in the following steps. To go to the previous page, click BACK.  

  



 

 

 

  

Note:  

Before issuing the Statement, if required, you can also refer to the following hyperlinks provided on the 

right-side of the page to view various details:  

 MIS Reports: Contains all available MIS Reports.  

 Tax Liability: Contains details of estimated tax liabilities of current tax period as updated from 

Form GSTR-1, 1A, Form GSTR-2, 2A and other Returns and Statements 

 Tax Return History: Contains details of the returns of the previous tax periods, and also option 

to view any other return of the defaulter.  

  

2a. Select the relevant section number from the drop-down list of the Section Number field.  

  



 

 

 

  

Note: If you select 74, following field will also appear. Select the check box, if applicable. On selecting the 

check box, system will auto-calculate the Penalty considering the provisions of Section 73.  

  

 

  

2b. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

  

 

  

2c. Select the check-box if Personal Hearing is required. In case you select it, following fields will appear 

for entry: Personal Hearing Date, Personal Hearing Time, Venue . Enter data in these fields also as 

mentioned in the following steps: 

  

 

  

i. Enter the Personal Hearing Date  field by clicking the calendar and selecting the date. 

ii. In the Personal Hearing Time  field also, click calendar and select the time—hours and minutes.   

iii. In the Venue field, enter the address of the place where you would like to call the taxpayer for 

personal hearing.   

  

2d. In the SCN Ref No. field, select SCN number from the dropdown list. Date of SCN gets auto-

populated.  

  



 

 

 

  

Note: On selecting an SCN Ref No., an Error popup gets displayed informing you about the tax period of 

the SCN. Click OK. You must select the tax period in the Financial Year and Overall Tax Period fields 

ahead of the selected SCN tax period.  

  

 

  

2e. In the Financial Year and Overall Tax Period fields, select the relevant tax period from the drop-

down list. Make sure you select the tax period ahead of the selected SCN tax period.  

  

 

  

2f. In the Due Date to Reply field, click the calendar and select the date. 

  

 

  

2g. Select the From and To drop-down lists of the Tax Period field for entering demand for that period.  

  



 

 

 

  

2h. Scroll to the right and select the Act from the drop-down list. Also, select the Place of Supply (POS) 

from the drop-down list.  

  

Note: POS is required only in case of IGST. 

  

 

  

2i. Again scroll to the right and in the following fields and enter the amount in the applicable fields: 

Tax/Cess, Interest, Penalty, Others. 

  

 

  

Note: If you are issuing Statement u/s 74 and have selected the "Provision of Sec. 73 applicable" check 

box, system will auto-calculate the Penalty considering the provisions of Section 73 based on what you 

enter in Act, POS, Tax/Cess, Interest and Penalty fields.  



 

 

  

2j. Click ADD to add more rows for entering demand for each month. Another row gets displayed. Scroll 

to the left and enter details in this row also in the same way, as mentioned in the steps above—2g, 2h 

and 2i.  

  

 

  

2k. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

SCN. 

2l. Click PREVIEW and a system-generated draft Statement u/s 73/74 and Form GST DRC-02 (Summary 

of Statement) gets downloaded into your machine. 

2m. Check the system-generated draft Statement and Form GST DRC-02 (Summary of Statement) 

carefully to rule out any discrepancy. 

2n. Click the PROCEED button.  

  

4. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  

 



 

 

  

5. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

6. The updated Case Detail page is displayed, with the table containing the record of the Statement 

u/s 73/74 and Form DRC-02 just issued.  

  

 

  

Note: As mentioned in the confirmation message on the Dashboard page, you can serve the notice to the 

taxpayer by post or through a special messenger as well. In the case of unregistered persons, it is 

mandatory to serve the notices by post/special messenger. For this, click the documents attached in the 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

7. Once Statement u/s 73 or 74 is issued, following actions take place on the GST Portal:  

 Intimation of the issue of the Statement is sent to the concerned taxpayer via his/her email ids 

and SMS. 

 Statement u/s 73 or 74 and Form GST DRC-02 generated by system and annexure uploaded by 

officer will be made available on the Taxpayer's dashboard: Services > User Services > View 

Additional Notices/Orders > View > Case Details. 

  

Go back to the Main Menu 

  



 

 

C(3). Reminder  

To view or issue a Reminder against an ARN/Case ID in case the taxpayer has not submitted any Reply 

on the issued SCN or Statement, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected 

by default. This tab displays all the notices (SCN/Statement/Reminder/Adjournment) you would issue 

against the case created. Click ADD NOTICE to open the drop-down list and select REMINDER. 

  

 

  

  

2. The REMINDER page is displayed. Type and Section Number fields are auto-populated. Enter 

details in the displayed fields as mentioned in the following steps. To go to the previous page, click 

BACK. 

  

 



 

 

  

2a. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

  

 

  

2b. In the Personal Hearing Required? field, select the check-box if required. If you select the check-

box, following fields get displayed. Enter details in these fields as well.  

i. Enter the Personal Hearing Date  field by clicking the calendar and selecting the date. 

ii. In the Personal Hearing Time field also, click calendar and select the time—hours and minutes.   

iii. In the Venue field, enter the address of the place where you would like to call the taxpayer for 

personal hearing.   

  

 

  

2c. In the Due Date to Reply field, click calendar and select the date to enter.   

  

 

  

2d. Select the Reminder No. from the drop-down list.   

  

  

Note: You can issue maximum 3 Reminders on the Portal. Once you have issued 3 Reminders, system 

would not allow you to send any more reminders. 

  

2e. Click Choose File to upload the document(s) from your machine that state the reasons of issuing this 

notice, if any. This is not a mandatory field.  



 

 

2f. Click PREVIEW and a system-generated draft notice gets downloaded into your machine. Check the 

draft carefully to rule out any discrepancy. Once satisfied with your entered details, click the PROCEED 

button.  

  

3. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  

 

  

4. The Dashboard page is displayed with a confirmation message. Click OK.  

  

 

  

5. The updated NOTICES tab is displayed, with the record of the issued Reminder and the Status is 

updated in accordance with the Reminder No. you had selected.  

  



 

 

 

  

Note: As mentioned in the confirmation message on the Dashboard page, you can serve the notice to the 

taxpayer by post or through a special messenger as well. In the case of unregistered persons, it is 

mandatory to serve the notices by post/special messenger. For this, click the documents attached in the 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

6. Additionally, the following actions take place on the GST Portal after the issue of the Reminder.  

9. Intimation of the issue of Reminder is sent to the concerned taxpayer via email id and SMS. 

10.  Dashboard of Taxpayer is updated with the record of the issued Reminder. Taxpayer can view 

the issued Reminder from the following navigation: Services > User Services > View Additional 

Notices/Orders > View > Case Details. 

  

Go back to the Main Menu 

  

C(4). Adjournment 

To view or issue an Adjournment of a hearing against an ARN/Case ID, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected 

by default. This tab displays all the notices (SCN/Statement/Reminder/Adjournment) you would is sue 

against the case created. Click ADD NOTICE to open the drop-down list and select 

ADJOURNMENT. 

  



 

 

 

  

2. ADJOURNMENT page is displayed. Type and Section Number fields are auto-populated. Enter 

details in the displayed fields as mentioned in the following steps. To go to the previous page, click 

BACK. 

  

 

  

2a. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

  

 



 

 

  

2b. In the Personal Hearing Required? field, select the check-box if required. If you select the check-

box, following fields get displayed. Enter details in these fields as well.  

i. Enter the Personal Hearing Date  field by clicking the calendar and selecting the date. 

ii. In the Personal Hearing Time  field also, click calendar and select the time—hours and minutes.   

iii. In the Venue field, enter the address of the place where you would like to call the taxpayer for 

personal hearing.   

  

 

  

2c. In the Due Date to Reply field, click calendar and select the date to enter.   

  

   

2d. Click Choose File to upload the document(s) from your machine that state the reasons of issuing this 

notice, if any. This is not a mandatory field.  

2e. Click the ISSUE button.  

  

3. A success message popup is displayed. Click CONTINUE.  

  

 

  

4. The updated NOTICES tab is displayed, with the record of the issued Adjournment. Status of 

ARN remains the same.  



 

 

  

 

  

  

5. Additionally, the following actions take place on the GST Portal after the issue of the 

Adjournment. 

9. Intimation of the issue of Adjournment is sent to the concerned taxpayer via email id and SMS.  

10.  Dashboard of Taxpayer is updated with the record of the issued Adjournment.  

11.  Taxpayer can view the issued Adjournment from the following navigation: Services > User 

Services > View Additional Notices/Orders > View > Case Details. 

  

Go back to the Main Menu 

  

D. View Replies Filed by the Taxpayer, if any 

To view replies submitted by the taxpayer, perform following steps:  

  

1. Go to the Case Detail page of that particular taxpayer. You will see the Status as "Reply 

furnished, pending for order by tax officer. Select the REPLIES tab. This tab displays all replies filed 

by the taxpayer.  

  

 

  

2. Click the documents in the Attachments section to download and ascertain their contents.  

  



 

 

 

  

3. Here's a sample Reply that could be filed by the taxpayer.  

  

 



 

 

  

Note:  

  

         If reply to SCN furnished by taxable person within time specified or extended period is satisfactory, 

then proceedings can be dropped and no further action may be taken in this regard.  

         If reply to SCN furnished by taxable person within time specified or extended period is not 

satisfactory, then officer may issue order within specified period.  

  

Go back to the Main Menu  

E. Record Personal Hearing Proceedings, if any 

To update the proceeding details related to Personal Hearing, if any, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the PROCEEDINGS tab. This tab 

displays a table of all the records of the personal hearing proceedings' related to the ARN/Case. 

Click ADD PROCEEDINGS to open the drop-down list and select PERSONAL HEARING. 

  

 

  

2. PERSONAL HEARING page is displayed. The Type field is auto-populated. Enter Date by 

clicking the calendar icon and selecting the date when Personal Hearing was conducted.  

  



 

 

 

  

3. Type the required text in the Proceeding for the day field. 

  

4. Click Choose File to select the documents related to the Personal Hearing, if any. This is not a 

mandatory field. 

  

5. Click the SUBMIT button. 

  

6. The updated Case Detail page is displayed, with the table containing the record of the Personal 

Hearing you submitted. 

  

 

  

Go back to the Main Menu 

F(1). Assessment order u/s 73 or 74 



 

 

To issue an assessment order against the case created, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab. Click ADD ORDER 

to open the drop-down list and select Assessment order and GST DRC-07. 

  

 

  

Note: Current application Status as displayed is "Reply furnished, pending for action by tax officer". This 

status will change once you issue this order.  

  

2. Assessment order and GST DRC-07 page is displayed. Enter the required data as mentioned in 

the following steps. To go back to the previous page, click BACK.  

  



 

 

 

  

Note:  

Before issuing the Order, if required, you can also refer to the following hyperlinks provided on the right -

side of the page to view various details:  

 MIS Reports: Contains all available MIS Reports.  

 Tax Liability: Contains details of estimated tax liabilities of current tax period as updated from 

Form GSTR-1, 1A, Form GSTR-2, 2A and other Returns and Statements 

 Tax Return History: Contains details of the returns of the previous tax periods, and also option 

to view any other return of the defaulter.  

  

2a. Select the Order Details tab, if not selected by default. Type, Section Ref No., Date of SCN, 

Section Number, Financial Year and Tax Period fields are auto-populated. Enter the required data as 

mentioned in the following steps: 

(i)  Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

(ii) In the Due Date of Payment field, click calendar and select the date to enter.   

(iii) In the Issue Involved field, select the check-box(es) against the listed issues from the drop-down list. 

The selected issues will appear below the Issue Involved field. 



 

 

  

             

  

(iv) Click the CONTINUE button or select the Details of Goods and Services tab from the top. This will 

change the colour of the Order Details tab and a tick mark will appear on it. 

  



 

 

 

  

(v). This will change the colour of the Order Details tab and a tick mark will appear on it. 

  

 



 

 

  

2b. Select the Details of Goods and Services tab. Enter the required data as mentioned in the following 

steps:  

(i) In Goods section, enter description of the Goods or select from the drop-down list. The drop-down list 

will show the relevant description based on your entered description.  

  

 

  

(ii) Tick Mark will appear on the tab. Also, the selected description will appear. Click DELETE to delete 

the description and enter again. You can enter more than one description, as required.  

  



 

 

 

  

(iii) Select the Services section, if required and enter description of the Services or select from the drop-

down list. The drop-down list will show the relevant description based on your entered description.  

  

  

 



 

 

  

Note: In the Details of Goods and Services tab, it is not mandatory to enter description of both Goods 

and Services sections. You can enter description in any one section and proceed to the next tab.  

  

(iv) Click the CONTINUE button or select the Details of Demand tab from the top.  

  

 

  

(v) This will change the colour of the Details of Goods and Services tab. 

  

 

  

2c. Select the Details of Demand tab. Enter the required data as mentioned in the following steps: 

(i) Select the From and To drop-down lists of the Tax period field.  

  



 

 

 

  

(ii) Enter the relevant amount in the Tax Rate and Turn Over fields. 

  

 

  

(iii) Scroll to the right and select the Act from the drop-down list. Also, select the Place of Supply (POS) 

from the drop-down list.  

  

Note: POS is required only in case of IGST. 

  

 

  

(iv) Again scroll to the right and in the following fields enter the amount in the applicable fields: Tax/Cess, 

Interest, Penalty, Others. 

  

 

  



 

 

(v) Click ADD to add more rows for entering demand for each month. Another row gets displayed. Scroll  

to the left and enter details in this row also in the same way, as mentioned in the steps above. 

  

 

  

(vi) Click the CONTINUE button or select the Attach Documents tab from the top.  

  

 

  

(vii) This will change the colour of the Details of Demand tab and tick mark will appear on it.  

  



 

 

 

  

2d. Select the Attach Documents tab. Enter the required data as mentioned in the following steps: 

  

(i) Click Choose File to upload the document(s) from your machine. 

  

 

  

(ii) Click the trash-bin icon to delete the uploaded attachment or click PREVIEW and a system-generated 

draft Assessment order and Form GST DRC-07 gets downloaded into your machine. Check this draft 

carefully to rule out any discrepancy. Thereafter, click PROCEED.  

  



 

 

 

  

3. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  

 

  

5. The Dashboard page is displayed with a confirmation message. Click OK.  

  



 

 

 

  

6. The updated Case Detail page is displayed, with the table containing the record of the 

Assessment order and Form GST DRC-07 just issued and the Status updated to "Order for 

creation of demand issued".  

  

 

  

Note 1: As mentioned in the confirmation message on the Dashboard page, you can serve the Order to 

the taxpayer by post or through a special messenger as well. In the case of unregistered persons, it is 

mandatory to serve the Order by post/special messenger. For this, click the documents attached in the 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

Note 2: Once Assessment order and Form GST DRC-07 is issued, following actions take place on the 

GST Portal: 

 Intimation of the issue of order is sent to the concerned taxpayer on his/her email ids and SMS.  

 Order generated by system and annexure uploaded by officer will be made available on the 

Taxpayer's dashboard: Services > User Services > View Additional Notices/Orders > View > 

Case Details. 

  

Go back to the Main Menu 

F(2). Drop Proceeding 

To drop the proceedings, perform following steps: 

  



 

 

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab. Click ADD ORDER 

to open the drop-down list and select DROP PROCEEDING. 

  

 

  

Note: Current application Status as displayed is "Reply furnished, pending for action by tax officer". This 

status will change once you issue this order.  

  

2. DROP PROCEEDING page is displayed. The Type, SCN Ref No., Date of SCN, Financial Year 

fields are auto-populated. Only the Order Number field and Choose File fields are mandatory. To 

go to the previous page, click BACK. 

  

 

  

2a. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

2b. Click Choose File to upload the document(s) from your machine that state the reasons of dropping 

this proceeding. 

2c. Click PREVIEW and a system-generated draft Order gets downloaded into your machine. 

2d. Check the system-generated draft Order carefully to rule out any discrepancy. 

3. Click the PROCEED button to issue the Order.  



 

 

4. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  

 

  

5. The Dashboard page is displayed with a confirmation message. Click OK.  

  

 

  

6. The updated Case Detail page is displayed, with the table containing the record of the DROP 

PROCEEDING Order just issued and the Status updated to "Order for dropping proceedings 

issued".  

  

 



 

 

  

Note 1: As mentioned in the confirmation message on the Dashboard page, you can serve the Order to 

the taxpayer by post or through a special messenger as well. In the case of unregistered persons, it is 

mandatory to serve the Order by post/special messenger. For this, click the documents attached in the 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

Note 2: Once Drop Proceeding Order is issued, following actions take place on the GST Portal:  

 Intimation of the issue of order is sent to the concerned taxpayer on his/her email ids and SMS.  

 Order generated by system and annexure uploaded by officer will be made available on the 

Taxpayer's dashboard: Services > User Services > View Additional Notices/Orders > View > 

Case Details. 

  

Go back to the Main Menu 

  

G(1). Record Communications related to the case, if any 

To view or record any communication related to the case, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, click the REFERENCES tab. This tab 

displays references related to this ARN/Case ID. Click ADD REFERENCE to open the drop-down list 

and select COMMUNICATION. 

  

 

  

2. COMMUNICATION page is displayed. The Type field is auto-populated. Enter details in the 

displayed fields as mentioned in the following steps. To go to the previous page, click BACK. 

  



 

 

 

  

2a.  In the Notice/Order/Reminder Reference Number, select the notice number from the drop-down list 

the Issue Date gets auto-populated.  

  

 

  

2b. In the Type of Communication, select one of the following options from the drop-down list—Post or 

Special MessengerIssue Date 

  

Note: As displayed in the image below, if you select, Type of Communication as Special Messenger, 

Delivered by field gets displayed. You must enter the name of the person who delivered this 

communication as well. 

  

 

  

2c. In the Communication Date field, select date from the calendar. 

2d. Click Choose File to upload the document(s), if any. This is not a mandatory field.  



 

 

2e. Click the SUBMIT button. 

  

3. The updated References tab is displayed, with the record of the communication submitted. You 

can click the document(s) attached in the Attachments section of the table, if any, to download 

them.  

  

 

  

Go back to the Main Menu 

  

G(2). Record References related to the case, if any 

To view or record the References related to the case, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the REFERENCES tab. This tab 

displays references related to this ARN/Case ID. Click ADD REFERENCE to open the drop-down list 

and select REFERENCES OF CASE. 

  

 

  

2. REFERENCES OF CASE page is displayed. Type and Date fields are auto-populated. Click 

Choose File to upload the document(s) related to this case,if any. This  is not a mandatory field. 

Then, click the SUBMIT button. To go to the previous page, click BACK. 

  



 

 

 

  

3. The updated References tab is displayed, with the table containing the record of the references 

just submitted. You can click the document(s) attached in the Attachments section of the table to 

download them.  

  

 

  

Go back to the Main Menu 

  



 

 

Summary Assessment 

FAQs > Conducting Summary Assessment 
Proceedings u/s 64 

1. On the GST Portal, which all Tax Official Roles are responsible for 

conducting Summary Assessment Proceedings u/s 64? 

Following two Tax Official roles, defined on the GST Portal, by the State Admin are responsible for 

conducting Summary Assessment Proceedings u/s 64:  

 Adjudicating Authority (A/A)  

 Additional Commissioner (AC)/Joint Commissioner (JC) 

2. When can a Tax Official proceed to assess the tax liability of a tax payer 

and frame Summary Assessment u/s 64 against him/her on the GST Portal? 

If an Adjudicating or A/A comes across any evidence showing a tax liability of a person, he/she can 

proceed to assess the tax liability of such person to protect the interest of revenue and issue a summary 

assessment order, if he has sufficient grounds to believe that any delay in doing so may adversely affect 

the interest of revenue. In case, the person to whom the liability pertains is not ascertainable and such 

liability pertains to supply of goods, the person in-charge of such goods shall be deemed to be the taxable 

person liable to be assessed and liable to pay tax and any other amount due.   

  

Note: A/A cannot frame the Summary Assessment u/s 64 without prior approval of AC/JC. It is 

recommended that he/she should seek approval from AC/JC offline via emails and proceed to frame 

summary assessment on the GST Portal only in case of approval. AC/JC can either approve the request 

or seek clarifications from A/A or reject the approval request.   

3. I am an A/A, the Adjudicating Authority and wants to send a request to 

AC/JC seeking approval on initiating Summary Assessment proceedings 

against a taxpayer. What do I need to do on the GST Portal? 

It is recommended that you should first seek approval from AC/JC offline via emails and proceed to frame 

summary assessment on the GST Portal only in case of approval. Make sure you save the email 

communication in your machine in a PDF or JPEG format and then upload it on the GST Portal.  

  

Note: A/A will upload the related communication. AC/JC can only view the uploaded communication but 

cannot upload anything.  



 

 

4. I am not getting Summary Assessment applications in my Dashboard? 

You may not have been assigned the A/A or AC/JC role by the State Admin. Request your State Admin to 

allocate you the role applicable to you. Once the role is assigned you will be allocated Summary 

Assessment applications for further action. 

5. What is procedure of framing Summary Assessment u/s 64 on the GST 

Portal? 

On the GST Portal, following is the procedure of framing Summary Assessment u/s 64 in case AC/JC 

approves the request: 

  

1. Adjudicating Authority (A/A) logs on to the GST Portal and creates an ARN/Case ID against 

the taxpayer.  

2. A/A uploads the email communication of approval received from AC/JC and updates the 

ARN/Case ID status to "Approval granted, pending for order by tax officer".  

  

Note:  

GST Portal provides A/A the option to store the internal communication with AC/JC and select from the 

following ARN/Case ID Status options (on the page available by navigating to the path— Dashboard > 

Summary Assessment > Case Detail > INTERNAL COMMUNICATION > TYPE OF COMMUNICATION > 

APPROVAL AUTHORITY FOR SUM. ASSESSMENT): 

  

 Pending for Approval by AC/JC: To be selected when A/A has sent the approval request or 

clarification details on the request to the AC/JC 

 Pending for clarification on approval by tax officer: To be selected when AC/JC has sent the 

approval request back to the A/A seeking further clarification on the request  

 Approval granted, pending for order by tax officer: To be selected when AC/JC has approved the 

request of A/A 

 Approval of summary assessment rejected: To be selected when AC/JC has rejected the request 

for issuing summary assessment order. In this case, now A/A will close the case. No further action 

can be taken on the case.  

  

3. Once the ARN/Case ID status gets updated to "Approval granted, pending for order by tax 

officer", A/A issues the "Order for creation of demand" against the taxpayer. Demand ID is 

created and Electronic liability register gets updated along with DCR.  

  

4. Once the "Order for creation of demand" is issued, following cases may happen: 

  



 

 

4a. AC/JC can do a suo moto withdrawal of the order if he/she considers the order as erroneous 

and recommend initiation of proceedings for determination of tax u/s 73 /74 against that ARN/Case ID.  

Also, the original order framed u/s 64(1) will stand withdrawn and demand will get updated in Electronic 

Liability Register (a credit entry will be passed into the Liability Register reversing the demand and DCR 

will be updated accordingly).    

  

OR 

  

4b. The taxpayer can file an application for withdrawal against the issued order within 30 days (of 

the communication of Order for creation of demand) and send it to AC/JC. Taxpayers who are Temp ID 

holders can file the application for withdrawal offline and send it to AC/JC.  

  

Note: The facility of filing offline application is available only for the Temp ID holders and not for other 

taxpayers.  

  

5. On receiving the withdrawal application from the taxpayer, AC/JC can take following actions: 

  

5a. Do a suo moto withdrawal of accepted offline application filed by the Temp ID holder. In this case, 

ARN/Case ID status gets updated to "Order withdrawn, Recommended for action u/s 73/74". Also, the 

original order framed u/s 64(1) will stand withdrawn and demand will get updated in Electronic Liability 

Register (a credit entry will be passed into the Liability Register reversing the demand and DCR will be 

updated accordingly).    

  

Note: AC/JC can do a suo moto withdrawal also in the case of offline applications filed by the Temp ID 

holders (who were unable to file the application on the GST Portal due to EVC issue), which he/she 

considers should be accepted.  

  

OR 

  

5b. Accept the application and issue "ASSESSMENT ACCEPTANCE ORDER - ASMT-18(A)" and 

recommend it for proceedings to be initiated u/s 73 /74 for determination of tax. Also, the original order 

framed u/s 64(1) will stand withdrawn and demand will get updated in Electronic Liability Register (a 

credit entry will be passed into the Liability Register reversing the demand and DCR will be updated 

accordingly).    

  

OR 

  

5c. Reject the application and issue "ASSESSMENT REJECTION ORDER - ASMT-18(R)" confirming 

the Order for creation of demand, i.e. the demand order will stand. 

  



 

 

6. Once AC/JC has issued the order, Taxpayer/Temp ID holder would receive the intimation of 

the issue of acceptance/rejection via email id and SMS and following actions take place on the 

GST Portal: 

 Dashboard of the Taxpayer/Temp ID holder is updated with the record of the issued Order and 

they can view it from the following navigation: Services > User Services > View Additional 

Notices/Orders > View > Case Details > WITHDRAWL ORDER  

 In case of acceptance, a credit entry will be passed into the Liability Register reversing the 

demand and DCR will be updated accordingly.   

 In case of rejection, the matter will remain adjudicated and the issued "Order for Creation of 

Demand" is confirmed. 

  

Note: In the case of rejection of an offline application filed by a Temp ID holder, no action will take place 

on the GST Portal. Intimation of rejection will be sent to the taxpayer offline by AC/JC.  

6. How can I frame Summary Assessment u/s 64 against an unregistered 

taxpayer? 

You can frame Summary Assessment u/s 64 against an unregistered taxpayer by creating his/her 

temporary ID from the Suo Moto page, before initiating the Summary Assessment proceedings.  

7. I don't see any functionality to add communication in the INTERNAL 

COMMUNICATION tab? 

You may have been assigned the role of AC/JC by the State Admin. AC/JC role has Read only access to 

the INTERNAL COMMUNICATION tab. Refer to the User Manual for more information.  

8. How to access material available on record, related to a particular case, 

for framing Summary Assessment u/s 64? 

All the relevant material of a particular case available on record could be accessed using the following 

hyperlinks provided on the top-right side of the related Order page—ASSESSMENT ORDER - ASMT-16, 

ASSESSMENT ACCEPTANCE ORDER - ASMT-18(A), ASSESSMENT REJECTION ORDER - ASMT-

18(R):  

 MIS Reports: Contains all available MIS Reports.  

 Tax Liability: Contains details of estimated tax liabilities of current tax period as updated from 

Form GSTR-1, 1A and Form GSTR-2, 2A  

 Tax Return History: Contains details of the returns of the previous tax periods, and also option 

to view any other return of the defaulter.  



 

 

9. What happens on the GST Portal once an order for creation of demand is 

issued? 

Once an order for creation of demand is issued, following actions happen on the GST Portal:  

 ORDERS tab on the issuing officer's dashboard displays the record of the issued ASSESSMENT 

ORDER - ASMT-16. 

 ARN/Case ID Status is updated to "Order for creation of demand issued".  

 Intimation of the issue of order is sent to the concerned taxpayer via email id and SMS.  

 Dashboard of AC/JC (and A/A in case Order is issued by AC/JC) and Taxpayer is updated with 

the record of the issued Order. Taxpayer can view the issued order from the following navigation: 

Services > User Services > View Additional Notices/Orders and A/A or AC/JC can view it from 

Dashboard > Summary Assessment > Case Detail > ORDERS. 

 Demand ID is created and Electronic liability register gets updated along with DCR.  

10. What documents will taxpayer receive once I issue an order for creation 

of demand? 

Taxpayer will receive two documents i.e. Form GST ASMT-16 generated by system and annexure 

uploaded by officer. 

11. In the case of unregistered persons, is it mandatory to serve the orders 

by post/special messenger? 

Yes. It is mandatory to serve the issued orders to an unregistered taxpayer by post/ special messenger. 

12. What happens if no application is filed by taxpayer for withdrawal within 

30 days of the issuance of order for creation of demand? 

If no application is filed by taxpayer for withdrawal of order within 30 days of the issuance of order for 

creation of demand, then demand will stand. 

13. What happens on the GST Portal once a taxpayer files an application for 

withdrawal of the issued order? 

Once a taxpayer files an application for withdrawal of the issued order, following actions happen on the 

GST Portal: 

 Dashboard of the taxpayers gets updated with the record of the filed application (Form GST-

ASMT-17). Also, acknowledgement of the filed application is sent via email id and SMS along with 

the generated ARN. 

 ARN/Case ID Status is updated to "Pending for Processing by AC/JC". 



 

 

 Dashboard of A/A and AC/JC is updated with the record of the filed application. A/A and AC/JC 

can view it from Dashboard > Summary Assessment > Case Detail > WITHDRAWAL 

APPLICATIONS. 

14. What happens on the GST Portal once the taxpayer's application for 

withdrawal is approved? 

Once the taxpayer's application for withdrawal is approved, following actions happen on the GST Portal:  

 Intimation of the issue of order is sent to the concerned taxpayer via email id and SMS.  

 Dashboard of A/A and Taxpayer is updated with the record of the issued Order. Taxpayer can 

view the issued order from the following navigation: Services > User Services > View Additional 

Notices/Orders > View > Case Details > WITHDRAWL ORDER and A/A can view it from 

Dashboard > Summary Assessment > Case Detail > WITHDRAWL ORDER. 

 Demand ID is created and Electronic liability register gets updated along with DCR.  

15. What documents will taxpayer receive once I approve his/her 

application for withdrawal? 

Taxpayer will receive two documents i.e. Form GST ASMT-18(A) generated by system and annexure 

uploaded, if any, by officer. 

16. What happens on the GST Portal once the taxpayer's application for 

withdrawal is rejected? 

Once the taxpayer's application for withdrawal is rejected, following actions happen on the GST Portal:  

 Intimation of the issue of order is sent to the concerned taxpayer via email id and SMS.  

 Dashboard of A/A and Taxpayer is updated with the record of the issued Order. Taxpayer can 

view the issued order from the following navigation: Services > User Services > View Additional 

Notices/Orders > View > Case Details > WITHDRAWL ORDER and A/A can view it from 

Dashboard > Summary Assessment > Case Detail > WITHDRAWL ORDER. 

 The matter will remain adjudicated and the issued "Order for Creation of Demand" will be 

confirmed. 

17. What documents will taxpayer receive once I reject his/her application 

for withdrawal? 

Taxpayer will receive two documents i.e. Form GST ASMT-18(R) generated by system and annexure 

uploaded by officer. 



 

 

18. Can I not record a Communication Reference without issuing an Order 

for creation of demand? 

Yes, you cannot record a Communication Reference without issuing an Order for creation of demand. 

Once you have issued an order for creation of demand, you will be able to record the communication sent 

by post/special messenger. 

19. During the Summary Assessment proceedings, what all and when the 

Status changes take place in an ARN/Case ID? 

During the Summary Assessment proceedings, the ARN/Case ID may undergo following Status changes:  

  

1. Pending for action by tax officer: When status of ARN/Case ID is under work item of tax 

officer. 

2. Order for creation of demand issued: When order is issued by A/A. 

3. Pending for Processing by AC/JC: When a taxpayer file Form GST-ASMT-17 of withdrawal. 

4. Application for withdrawal rejected: When AC/JC rejects withdrawal application of a taxpayer. 

5. Order withdrawn, Recommended for action u/s 73/74: When AC/JC approves withdrawal 

application of a taxpayer. 

  

Additionally, GST Portal provides A/A the option to store the internal communication with AC/JC and 

select an applicable ARN/Case ID Status options (from the following navigation: Dashboard > Summary 

Assessment > Case Detail >  INTERNAL COMMUNICATION > TYPE OF COMMUNICATION > 

APPROVAL AUTHORITY FOR SUM. ASSESSMENT). Based on this selection, the ARN/Case ID may 

undergo following Status changes: 

  

6. Pending for Approval by AC/JC: To be selected when A/A has sent the approval request or 

clarification details on the request to the AC/JC 

7. Pending for clarification on approval by tax officer: To be selected when AC/JC has sent the 

approval request back to the A/A seeking further clarification on the request  

8. Approval granted, pending for order by tax officer: To be selected when AC/JC has approved 

the request of A/A 

9. Approval of summary assessment rejected: To be selected when AC/JC has rejected the 

request for issuing summary assessment order (In this case, now A/A will close the case. No further 

action can be taken on the case.) 

  

  



 

 

 

Manual > Conducting Summary Assessment 
Proceedings u/s 64 

How can I conduct Summary Assessment proceedings u/s 64 against a 

taxpayer? 

To conduct Summary Assessment proceedings u/s 64, perform following steps:  

  

Note: For conducting Summary Assessment Proceedings u/s 64, following two Tax Official roles need to 

be defined on the GST Portal by the State Admin:  

 Adjudicating Authority (A/A)  

 Additional Commissioner (AC)/Joint Commissioner (JC) 

  

 Steps  

Roles  Assigned 

to Tax Officials 

for Performing 

Steps 

 Case Detail Tabs 

Access Type 

A. Initiate Suo Moto Proceeding and 

create a Case for Summary 

Assessment  

 A/A  ---- 

Note:  
    

A Case for Summary Assessment, generated with an Application Reference Number 

(ARN)/Case ID, is organized on the GST Portal's "Case Detail" screen into the 

following tabs:  

  

 ORDERS: To view/Issue Assessment Order u/s 64 

 INTERNAL COMMUNICATION: To view/upload approval/rejection 

communication between A/A and AC/JC 

 WITHDRAWL ORDERS: To view/issue acceptance/rejection order on a 

Taxpayer's application for withdrawal 

 REFERENCES: To view/add communications and references related to the 

case 

 WITHDRAWAL APPLICATIONS: To view Taxpayer's application for 

withdrawal 



 

 

  

Depending on the assigned roles, Tax Officials will have Read only i.e. only view 

access or both Read and Write Access i.e. access to both view and perform the 

related actions access to these tabs on their Dashboard.  

  

B. Search for an already-created 

ARN/Case ID   A/A and AC/JC  ----  

C. From INTERNAL 

COMMUNICATION tab: View or 

Upload Approval/Rejection 

Communication from AC/JC 

A/A 

  

 A/A: Read 

and Write 

Access 

 AC/JC: Read 

only 

D. From ORDERS tab: Issue or View 

an Assessment order u/s 64  A/A  

 A/A: Read 

and Write 

Access 

 AC/JC: Read 

only 

E. From WITHDRAWL ORDERS tab: 

Initiate Suo Moto Withdrawal of 

Order  

AC/JC 

 A/A: Read 

only 

 AC/JC: Read 

and Write 

Access 

F. From WITHDRAWAL 

APPLICATIONS tab: View 

Withdrawal Application from the 

Taxpayer 

A/A and AC/JC 

 A/A: Read 

only 

 AC/JC: Read 

only 

G. From WITHDRAWL ORDERS tab: 

Initiate Suo Moto Withdrawal of 

Order on the basis of Accepted 

Offline Application filed by a Temp 

AC/JC 

 A/A: Read 

only 

 AC/JC: Read 

and Write 



 

 

ID holder  Access 

H. From WITHDRAWL ORDERS tab: 

Accept or Reject the Withdrawal 

Application Filed by the Taxpayer 

AC/JC 

 A/A: Read 

only 

 AC/JC: Read 

and Write 

Access 

I. From REFERENCES tab: 

Record/View Communications 

Related to the Case Once an 

Order is Issued 

A/A and AC/JC 

 A/A: Read 

and Write 

Access 

 AC/JC: Read 

and Write 

Access 

J. From REFERENCES tab: 

Record/View References related 

to the case, if any 

A/A and AC/JC 

 A/A: Read 

and Write 

Access 

 AC/JC: Read 

and Write 

Access 

  

Click each hyperlink in the "Steps" column above to know more.  

 A. Initiate Suo Moto PROCEEDING and Create a Case for Summary 

Assessment 

To Suo Moto, i.e. initiate a new proceeding for assessing tax-liability of a person under section 64, 

perform the following steps: 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > Summary Assessment 

option. 



 

 

 

 

  

4. Search page is displayed. Click the SUO MOTO PROCEEDING button.  

  

 

  

  

5. Suo Moto page is displayed. The “Proceeding Type” field gets auto-populated. Enter the GSTIN 

or UIN or Temporary Id of the taxpayer and then click the GO button. This will enable the CREATE 

button. To go to the previous Search page, click BACK.  

  

 



 

 

  

Note 1: All fields are mandatory. You must enter the required data in these fields to proceed.   

  

Note 2: To create Temporary Id of an unregistered taxpayer, you can click the Click here hyperlink 

provided on the left-below side of the page. To know more on how to create a Temporary ID, refer to the 

Suo Moto Registration User Manual.  

  

6. Select the Financial Year from the drop-down list. 

7. Select the Tax Period from the From and To drop-down lists. 

8. Click the CREATE button. 

9. ARN/ Case Id is created and a Success popup appears confirming this. Click the CONTINUE 

button. 

  

 

 

  

10.  Case Detail page is displayed. From this page, you can initiate conducting all 

Assessment/Adjudication proceedings related to this particular case by operating on the tabs 

provided at the left-hand side of the page: ORDERS, INTERNAL COMMUNICATION, WITHDRAWL 

ORDERS, REFERENCES, WITHDRAWAL APPLICATIONS.  

  



 

 

 

  

Note 1: On this page, the ORDERS tab is selected by default.  

  

Note 2: Currently, Status of the ARN/Case is "Pending for action by tax officer". It will change as you 

conduct the proceeding. 

  

Go back to the Main Menu 

  

B. Search for an already-created ARN/Case ID 

To search for a particular ARN/Case ID, perform following steps: 

  

1. Access the GST Back Office Portal for tax officials. The Home page is displayed. 

2. Login using your valid credentials. The Dashboard page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > Summary Assessment option. 

 

 

  

4. Case Detail Search page is displayed. Choose any one of the four displayed fields as your search 

criteria, enter the required information: ARN, GSTIN, Status (select from the drop-down list) or From 

Date & To Date, and click the SEARCH button. 



 

 

  

 

  

Note: You must enter data in at least one field to proceed.   

  

5. Based on your search criteria, the required ARN or the list of the required ARNs is displayed. 

Click the ARN hyperlink of the case you want to act on.  

  



 

 

 

  

Note: Because the search criteria of Status as "Approval granted, pending for order by tax officer" 

was selected earlier as the Search criteria, all those related ARNs get displayed.  

  

6. Case Detail page is displayed. From this page, you can initiate conducting all 

Assessment/Adjudication proceedings related to this particular case by operating on the tabs 

provided at the left-hand side of the page: ORDERS, INTERNAL COMMUNICATION, WITHDRAWL 

ORDERS, REFERENCES, WITHDRAWAL APPLICATIONS.  

  



 

 

 

  

Note 1: On this page, the ORDERS tab is selected by default.  

  

Note 2: Currently, Status of the ARN/Case is "Pending for action by tax officer". It will change as you 

conduct the proceeding. 

  

Go back to the Main Menu 

C. View or Upload Approval/Rejection Communication from AC/JC 

To upload the saved email communication related to approval for Summary Assessment, perform 

following steps: 

  

Note: 

  

(a) Adjudicating Authority (A/A) cannot proceed to frame summary assessment until Additional 

Commissioner (AC)/Joint Commissioner (JC) approves it.  

(b) Once A/A sends the approval request, AC/JC can take the following actions:  

 Approve the request. 

 Seek clarifications from A/A in case the approval request does not provide complete information.  

 Reject the approval request. (In this case, now A/A will close the case. No further action can be 

taken on the case.)  

  

(c) All communication related to seeking/providing approval between A/A and AC/JC will take place via 

email. A/A must save the email communication in his/her machine in a PDF or JPEG format and then 

upload it on the GST Portal.  

  

(d) A/A will upload the related communication. AC/JC can only view the uploaded communication but 

cannot upload anything.  

  



 

 

1. Go to the Case Detail page of that particular taxpayer's application. Click the INTERNAL 

COMMUNICATION tab. Click TYPE OF COMMUNICATION. From the drop-down, click APPROVAL 

AUTHORITY FOR SUM. ASSESSMENT.  

  

 

  

2. APPROVAL AUTHORITY FOR SUM. ASSESSMENT page is displayed. To go to the previous 

screen, click BACK.  

  

 

  

3. Select the applicable Status from the drop-down list. To easily choose an appropriate applicable 

status, help-text is provided on the right-side.  



 

 

4. Click Choose File to upload the email communication, you have saved earlier, from your 

machine.  

5. Click SUBMIT.  

6. As per the chosen Status, the INTERNAL COMMUNICATION tab and the ARN status gets 

updated with the submitted details. You can click the document(s) attached in the Attachments 

section of the table to download them.  

  

 

  

Go back to the Main Menu 

  

D. Issue/View an Assessment order u/s 64 

To view or issue an assessment order u/s 64 against the case created, perform following steps: 

  

Note:  

 A/A cannot proceed to frame summary assessment until AC/JC approves it.  

 Only A/A will issue the Order. AC/JC can only view the issued Order. 

  

  

1. On the Case Detail page of that particular taxpayer, click the ORDERS tab, if not selected by 

default.  This tab displays order for creation of demand issued against the ARN/Case ID. Click ADD 

ORDER to open the drop-down list and select ASSESSMENT ORDER - ASMT-16. 

  



 

 

 

  

Note: Current Case Status as displayed is "Approval granted, pending for order by tax officer". This 

status will change once you issue this order.  

  

2. ASSESSMENT ORDER - ASMT-16 page is displayed. The Type, Financial Year and Overall 

Tax Period fields are auto-populated. Enter the required data in the displayed fields to proceed. To 

go back to the previous page, click BACK.  

  



 

 

 

  

Note:  

Before issuing the Order, if required, you can also refer to the following hyperlinks provided on the right-

side of the page to view various details:  

 MIS Reports: Contains all available MIS Reports.  

 Tax Liability: Contains details of estimated tax liabilities of current tax period as updated from 

Form GSTR-1, 1A and Form GSTR-2, 2A  

 Tax Return History: Contains details of the returns of the previous tax periods, and also option 

to view any other return of the defaulter.  

  

2a. In the Order Number field, click the Generate Reference Number hyperlink. Order Number field gets 

auto-populated. 

2b. In the Addl./Joint Commissioner field, select the name of the Approving authority for Assessment 

from the drop-down list.  



 

 

2c. Enter details in Godown Address field. 

2d. Enter details in Vehicle Details field. 

2e. Enter details in Location of Vehicles field. 

2f. In the Due Date of Payment field, click calendar and select the date to enter.   

2g. Enter details in Section Number field. 

2h. In the demand grid, select the From and To drop-down lists of the Tax period field.  

  

 

  

2i. In the demand grid, scroll to the right and select the Act from the drop-down list. Also, select the Place 

of Supply (POS) from the drop-down list.  

  

Note: POS is required only in case of IGST. 

  

 

  

2j. In the demand grid, again scroll to the right and in the following fields enter the amount that the 

taxpayer must pay, as applicable: Tax/Cess, Interest, Penalty, Others. 

  



 

 

.  

  

2k.  If required, you can also click the ADD button to add more rows in the demand grid for entering 

demand for each month and fill the added rows in the same manner as mentioned in the above steps.  

  

 

  

2l. Click Choose File to upload the annexure/document(s) from your machine related to this order.  

2m. Click PREVIEW and a system-generated draft ORDER gets downloaded into your machine. Check 

the system-generated draft ORDER carefully to rule out any discrepancy 

  

3. Once satisfied with your entered details, click the PROCEED button.  

4. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  



 

 

 

  

5. The Dashboard page is displayed with a confirmation message. Click OK.  

  

 

  

6. The updated ORDERS tab is displayed, with the record of the issued ASSESSMENT ORDER - 

ASMT-16 and the Status updated to "Order for creation of demand issued".  

  

 

  

  



 

 

Note 1: As mentioned in the confirmation message on the Dashboard page, you can serve this order to 

the taxpayer by post or through a special messenger as well. For this, click the documents attached in the 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

Note 2: In the case of unregistered persons, it is mandatory to serve the issued orders to an unregistered 

taxpayer by post/special messenger.  

  

7. Additionally, the following actions take place on the GST Portal after the issue of the Order.  

9. Intimation of the issue of order is sent to the concerned taxpayer on his/her registered email id 

and SMS. 

10.  Dashboard of AC/JC (and A/A in case Order is issued by AC/JC) and Taxpayer is updated with 

the record of the issued Order.  

11.  Taxpayer can view the issued order from the following navigation: Services > User Services > 

View Additional Notices/Orders and AC/JC can view it from Dashboard > Summary 

Assessment > Case Detail > ORDERS. 

12.  Demand ID is created and Electronic liability register gets updated along with DCR.  

  

Go back to the Main Menu  

  

E. Initiate Suo Moto Withdrawal of Order 

To initiate Suo Moto Withdrawal of Order process, perform following steps : 

  

Note: Suo Moto Withdrawal of Order can be done by AC/JC only. He/she may initiate Suo Moto 

Withdrawal of an Order issued by A/A in case he/she considers that the Order issued by A/A is 

erroneous.  

  

1. On the Case Detail page of that particular application, click the WITHDRAWL ORDER tab. This 

tab displays the Withdrawal orders related to acceptance or rejection of Withdrawal application filed 

by the taxpayer. Click Type of Order and select ASSESSMENT ACCEPTANCE ORDER - ASMT-

18(A).  

  



 

 

 

  

Note 1: Current application Status as displayed is "Order for creation of demand issued". This status will 

change once you withdraw this order. 

  

Note 2: You won't be able to issue the rejection order—ASSESSMENT REJECTION ORDER - ASMT-

18(R). If you select ASSESSMENT REJECTION ORDER - ASMT-18(R), following page with an error 

message will be displayed.  

  

 

  

2.  ASSESSMENT ACCEPTANCE ORDER - ASMT-18(A) page is displayed. Enter details in the 

displayed fields as mentioned in the following steps. To go back to the previous page, click BACK.  

  



 

 

 

  

Note 1:  

Before issuing the Order, if required, you can also refer to the following hyperlinks provided on the right -

side of the page to view various details:  

 MIS Reports: Contains all available MIS Reports.  

 Tax Liability: Contains details of estimated tax liabilities of current tax period as updated from 

Form GSTR-1, 1A and Form GSTR-2, 2A  

 Tax Return History: Contains details of the returns of the previous tax periods, and also option 

to view any other return of the defaulter.  

  

2a. All details except Order number are auto-populated. Click the Generate Reference Number 

hyperlink. Order number field gets auto-populated. 

2b. Click Choose File to upload the annexure/document(s) from your machine related to this order.  

2c. Click PREVIEW and a system-generated draft ORDER gets downloaded into your machine. Check 

the system-generated draft ORDER carefully to rule out any discrepancy. 

2d. Once satisfied with your entered details, click the PROCEED button.  

  

3. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  



 

 

 

  

4. The Dashboard page is displayed with a confirmation message. Click OK.  

  

 

  

5. The updated WITHDRAWL ORDER tab is displayed, with the record of the issued 

ASSESSMENT ACCEPTANCE ORDER - ASMT-18(A) and the Status updated to "Order 

withdrawn, Recommended for action u/s 73/74".  

  

 

  



 

 

Note 2: As mentioned in the confirmation message on the Dashboard page, you can serve this order to 

the taxpayer by post or through a special messenger as well. For this, click the documents attached in the 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

6. Additionally, the following actions take place on the GST Portal after the issue of the Order.  

  

9. Intimation of the issue of order is sent to the concerned taxpayer via email id and SMS.  

10.  Dashboard of A/A and Taxpayer is updated with the record of the issued Order.  

11.  Taxpayer can view the issued order from the following navigation: Services > User Services > 

View Additional Notices/Orders and A/A can view it from Dashboard > Summary 

Assessment > Case Detail > WITHDRAWL ORDER. 

12.  The original order framed u/s 64(1) will stand withdrawn and demand will get updated in 

Electronic Liability Register (a credit entry will be passed into the Liability Register reversing the 

demand and DCR will be updated accordingly).    

  

Go back to the Main Menu  

F. View Withdrawal Application from the Taxpayer 

To view Withdrawal Application from the Taxpayer, perform following steps:  

  

1. On the Case Detail page of that particular application, click the WITHDRAWAL APPLICATIONS 

tab. This tab displays the applications filed by the taxpayer.  

  

 

  



 

 

2. Click the document name(s) in the Attachments section of the table to download the filed 

application.  

  

Go back to the Main Menu 

  

G. Initiate Suo Moto Withdrawal of Order on the basis of Accepted Offline 

Application filed by a Temp ID holder  

To initiate Suo Moto Withdrawal of Order on the basis of accepted Offline Application filed by a Temp ID 

holder, perform following steps: 

  

Note:  

 This Suo Moto Withdrawal of Order is allowed only in the case of Temp ID holders who are 

unable to file application online due to EVC issue.  

 Suo Moto Withdrawal of Order can be done by AC/JC only. A/A can only view the issued Order.  

  

1. On the Case Detail page of the ARN/Case ID of the Temp holder, click the WITHDRAWL 

ORDER tab. This tab displays the Withdrawal orders related to acceptance or rejection of Withdrawal 

application filed by the taxpayer. Click Type of Order and select ASSESSMENT ACCEPTANCE 

ORDER - ASMT-18(A).  

  

 

  

Note 1: Current application Status as displayed is "Order for creation of demand issued". This status will 

change once you withdraw this order. 

  



 

 

Note 2: You won't be able to issue the rejection order—ASSESSMENT REJECTION ORDER - ASMT-

18(R). If you select ASSESSMENT REJECTION ORDER - ASMT-18(R), following page with an error 

message will be displayed.  

  

 

  

2.  ASSESSMENT ACCEPTANCE ORDER - ASMT-18(A) page is displayed. Enter details in the 

displayed fields as mentioned in the following steps. To go back to the previous page, click BACK.  

  

 

  

Note 1:  

Before issuing the Order, if required, you can also refer to the following hyperlinks provided on the right -

side of the page to view various details:  

 MIS Reports: Contains all available MIS Reports.  

 Tax Liability: Contains details of estimated tax liabilities of current tax period as updated from 

Form GSTR-1, 1A and Form GSTR-2, 2A  



 

 

 Tax Return History: Contains details of the returns of the previous tax periods, and also option 

to view any other return of the defaulter.  

  

2a. All details except Order number are auto-populated. Click the Generate Reference Number 

hyperlink. Order number field gets auto-populated. 

2b. Select the "On request of tax payer?" check-box. "Applied for Withdrawal On" field appears. 

Select the date using the calendar.  

  

 

  

Note: Because only Orders from the last 30 days will be considered, only dates of last 30 days from the 

issue of Order will be enabled in the calendar.  

  

2c. Click Choose File to upload the annexure/document(s) from your machine related to this order.  

2d. Click PREVIEW and a system-generated draft ORDER gets downloaded into your machine. Check 

the system-generated draft ORDER carefully to rule out any discrepancy. 

2e. Once satisfied with your entered details, click the PROCEED button.  

  

3. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  

 

  

4. The Dashboard page is displayed with a confirmation message. Click OK.  

  



 

 

 

  

5. The updated WITHDRAWL ORDER tab is displayed, with the record of the issued 

ASSESSMENT ACCEPTANCE ORDER - ASMT-18(A) and the Status updated to "Order 

withdrawn, Recommended for action u/s 73/74".  

  

 

  

Note: In the case of unregistered persons with a temp id, it is mandatory to serve the issued orders to 

them by post/special messenger. For this, click the documents attached in the Attachments section of 

the table to download them. Take a print and then sign the printed document manually before sending.  

  

6. Additionally, the following actions take place on the GST Portal after the issue of the Order. 

  

9. Intimation of the issue of order is sent to the concerned taxpayer via email id and SMS.  

10.  Dashboard of A/A and Taxpayer is updated with the record of the issued Order. Taxpayer can 

view the issued order from the following navigation: Services > User Services > View 

Additional Notices/Orders and A/A can view it from Dashboard > Summary Assessment > 

Case Detail > WITHDRAWL ORDER. 

11.  The original order framed u/s 64(1) will stand withdrawn and demand will get updated in 

Electronic Liability Register (a credit entry will be passed into the Liability Register reversing the 

demand and DCR will be updated accordingly).    

  

Go back to the Main Menu 

  



 

 

H. Accept or Reject the Withdrawal Application Filed by the Taxpayer 

To accept or reject the withdrawal application, perform following steps:  

  

Note: Only AC/JC can withdraw the order or reject the withdrawal application filed by the taxpayer. A/A 

can only view it. 

  

1. On the Case Detail page of that particular application, click the WITHDRAWL ORDER tab. This 

tab displays the Withdrawal orders related to acceptance or rejection of Withdrawal application filed 

by the taxpayer. Click Type of Order and select the order to be issued.  

  

 

  

Note: Current application Status as displayed is "Pending for processing by AC/JC". This status will 

change once you withdraw this order. 

  

2.  Based on your choice of the selected Order, the Type field is auto-populated with either 

ASSESSMENT ACCEPTANCE ORDER - ASMT-18(A) or ASSESSMENT REJECTION ORDER - 

ASMT-18(R). Enter details in the displayed fields as mentioned in the following steps. To go back to 

the previous page, click BACK.  

  

Note:  

 If you select “ASSESSMENT ACCEPTANCE ORDER - ASMT-18(A)”, this means that you are 

allowing the application for withdrawal filed by the taxpayer. As a result, the original order framed u/s 

64(1) will stand withdrawn and demand will get updated in Electronic Liability Register (a credit entry 

will be passed into the Liability Register reversing the demand and DCR will be updated accordingly). 

   

 If you select “ASSESSMENT REJECTION ORDER - ASMT-18(R)”, this means that you are 

rejecting the application for withdrawal filed by the taxpayer. As a result, the demand order will stand.  



 

 

  

 

  

  

  

 



 

 

  

Note:  

Before issuing the Order, if required, you can also refer to the following hyperlinks provided on the right-

side of the page to view various details:  

 MIS Reports: Contains all available MIS Reports.  

 Tax Liability: Contains details of estimated tax liabilities of current tax period as updated from 

Form GSTR-1, 1A and Form GSTR-2, 2A  

 Tax Return History: Contains details of the returns of the previous tax periods, and also option 

to view any other return of the defaulter.  

  

2a. All details except Order number are auto-populated. Click the Generate Reference Number 

hyperlink. Order number field gets auto-populated. 

2b. Click Choose File to upload the annexure/document(s) from your machine related to this order.  

2c. Click PREVIEW and a system-generated draft ORDER gets downloaded into your machine. Check 

the system-generated draft ORDER carefully to rule out any discrepancy 

2d. Once satisfied with your entered details, click the PROCEED button.  

  

3. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  

 

  

4. The Dashboard page is displayed with a confirmation message. Click OK.  

  



 

 

 

  

5. The updated WITHDRAWL ORDER tab is displayed, with the record of the issued 

ASSESSMENT ACCEPTANCE ORDER - ASMT-18(A) or ASSESSMENT REJECTION ORDER - 

ASMT-18(R) and the Status updated to "Order withdrawn, Recommended for action u/s 73/74" 

or "Application for withdrawal rejected" respectively.  

  

 

  

Note 1: As mentioned in the confirmation message on the Dashboard page, you can serve this order to 

the taxpayer by post or through a special messenger as well. For this, click the documents attached in the 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

Note 2: In the case of unregistered persons with a temp id, it is mandatory to serve the issued orders to 

them by post/special messenger.  

  

6. Additionally, following actions take place on the GST Portal after the issue of the Order.  

  

(a) In case of issue of ASSESSMENT ACCEPTANCE ORDER - ASMT-18(A): 

  

9. Intimation of the issue of order is sent to the concerned taxpayer via email id and SMS.  

10.  Dashboard of A/A and Taxpayer is updated with the record of the issued Order. Taxpayer can 

view the issued order from the following navigation: Services > User Services > View 

Additional Notices/Orders and A/A can view it from Dashboard > Summary Assessment > 

Case Detail > WITHDRAWL ORDER. 



 

 

11.  The original order framed u/s 64(1) will stand withdrawn and demand will get updated in 

Electronic Liability Register (a credit entry will be passed into the Liability Register reversing the 

demand and DCR will be updated accordingly).    

  

(b) In case of issue of ASSESSMENT REJECTION ORDER - ASMT-18(R): 

  

9. Intimation of the issue of order is sent to the concerned taxpayer via email id and SMS. 

10.  Dashboard of A/A and Taxpayer is updated with the record of the issued Order. Taxpayer can 

view the issued order from the following navigation: Services > User Services > View 

Additional Notices/Orders and A/A can view it from Dashboard > Summary Assessment > 

Case Detail > WITHDRAWL ORDER. 

11.  The original issued "Order for Creation of Demand" will be confirmed, i.e. the demand order will 

stand. 

  

Go back to the Main Menu 

I. Record/View Communications Related to the Case Once an Order is 

Issued 

To view or record any communication related to the case, perform following steps:  

  

Note: You will be able to record a communication only once an order for creation of demand has been 

issued. 

  

1. On the Case Detail page of that particular taxpayer, click the REFERENCES tab. This tab 

displays references related to this ARN/Case ID. Click ADD REFERENCE to open the drop-down list 

and select COMMUNICATION. 

  

 

  



 

 

2. COMMUNICATION page is displayed. Enter the three mandatory fields— 

 Notice/Order/Reminder Reference Number (select from the drop-down list), Type of 

Communication (select one of the following options from the drop-down list—Post or Special 

Messenger) and Communication Date . To go to the previous page, click BACK. 

  

 

  

Note: As displayed in the image below, if you select, Type of Communication as Special Messenger, 

you must fill the Delivered by field with the name of the person who delivered this communication. 

  

 

  

2a. Click Choose File to upload the document(s), if any. This is not a mandatory field.  

2b. Click the SUBMIT button. 

  

3. The updated References tab is displayed, with the record of the communication submitted. You 

can click the document(s) attached in the Attachments section of the table to download them.  

  



 

 

 

  

Go back to the Main Menu 

J. View/Record References related to the case, if any 

To view or record the References related to the case, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the REFERENCES tab. This tab 

displays references related to this ARN/Case ID. Click ADD REFERENCE to open the drop-down list 

and select REFERENCES OF CASE. 

  

 

  

2. REFERENCES OF CASE page is displayed. Enter Date by clicking the calendar icon and 

selecting the date of these References. To go to the previous page, click BACK. 

  



 

 

 

  

2a. Click Choose File to upload the document(s) related to this case if any. This is not a mandatory  field. 

2b. Click the SUBMIT button. 

  

3. The updated References tab is displayed, with the table containing the record of the references 

just submitted. You can click the document(s) attached in the Attachments section of the table to 

download them.  

  

 

  

  

Go back to the Main Menu 

  



 

 

Rectification of Orders 

FAQs > Conducting Proceedings u/s 161 for 
Rectification of Orders 

1. How can Rectification of errors in decision, Orders, notice or certificate 

or any other document be done? 

Rectification of errors, which is apparent on the face of record in such decision, order, notice or certificate, 

can be done by the authority, who has passed such decision/order/notice, etc. either on his/her own 

motion or whether such error is brought to its notice by tax official or by the affected person.  

2. What is the time limit within which a taxpayer can file application for 

rectification? 

Taxpayer must file the rectification application within a period of three months, from the date of issue of 

such order.  

3. I've received an offline rectification request from a taxpayer who holds a 

Temp ID. Can I process this request on the GST Portal?  

Yes, you can process this request on the GST Portal using the SUO MOTO PROCEEDING button. 

Note: Temp id holder cannot file application for rectification on GST Portal due to EVC issue. So in this 

case officer will create case id on the basis of offline application submitted by taxpayer to officer.  

4. I am initiating a suo moto rectification of an Order and it is going to 

adversely affect the taxpayer. What do I do? 

If rectification of an Order is going to adversely affect any person, then Adjudication Authority (A/A) must 

provide him/her an opportunity of being heard. For this, the A/A must issue "Additional Information" notice 

to the concerned taxpayer, hear him/her in Personal Hearing and then issue the Rectification Order. 

5. Can I not rectify an Order if a taxpayer has filed an “Application for 

Deferred Payment/ Payment in Installments” or an "Application for Appeal" 

against the Order? 

Yes, you cannot rectify an Order if a taxpayer has filed an “Application for Deferred Payment/ Payment in 

Installments” or an "Application for Appeal" against the Order.  



 

 

6. What is the limitation period for concluding Rectification of Order related 

proceedings and pass an Order? 

The Rectification Order must be passed by A/A within 6 months from date of original order, except in 

cases of Orders that require rectification of clerical/arithmetical mistake in them (arising from any 

accidental slip or omission). In such cases of clerical/arithmetical mistake in Orders, rect ification order can 

be issued even after six months.  

7. What documents will taxpayer receive once an Additional Information 

notice is issued? 

Once a notice for seeking "Additional Information" is issued, the taxpayer will receive two documents i.e. 

system-generated Notice for seeking clarification for rectification of order and annexure uploaded by 

officer. 

8. What happens on the GST Portal once I issue an Additional Information 

notice/Reminder/Adjournment? 

Once you issue a notice, following actions take place on the GST Portal: 

 Intimation of the issue of notice is sent to the concerned taxpayer via email id and SMS.  

 The NOTICES tab gets updated with the record of the filed reply in a table and with the Status 

updated to "Pending for reply by taxpayer" or "Reminder No.1 issued" or "Reminder No.2 

issued" or "Reminder No.3 issued" as applicable.  

 Dashboard of taxpayer is updated with the record of the issued notice. Taxpayer can view the 

issued notice from the following navigation: Services > User Services > View Additional 

Notices/Orders > View > Case Details. 

9. In case notice/order etc. is issued by post/special messenger, then what 

will be the “Date of issue”? 

Date of delivery will be considered as "Date of issue".  

10. What happens on the GST Portal if rectification order is issued? 

If rectification order is issued, then: 

 Rectification order will be generated and intimation of issue of order shall be sent via email and 

SMS to taxpayer 

 Order will also be available at the dashboard of taxpayer for view, print  and download 

 Electronic liability register and DCR will be updated accordingly  

 Status of ARN will be changed to ‘Order rectified’ in case of application received from taxpayer 



 

 

 Status of ARN/Case id and RFN will be changed to ‘Order rectified’ in case of s uo moto 

rectification 

11. What happens on the GST Portal if rectification order is rejected? 

If application for rectification is rejected, then: 

 ‘Rejection of application for rectification’ shall be issued and intimation of issue of order shall be 

sent via email and SMS to taxpayer 

 Order will also be available at the dashboard of taxpayer for view, print and download 

 Status of ARN shall get updated to ‘Application rejected’ 

12. During the Rectification of Orders proceedings, what all and when the 

Status changes take place in an ARN/Case ID? 

During the Rectification of Orders proceedings, the ARN/Case ID may undergo following Status changes:  

  

1. Pending for action by tax officer: When a taxpayer files the application for rectification order or 

when status of ARN/Case ID is under work item of tax officer as a result of Suo Moto initiation.  

2. Pending for reply by taxpayer: When A/A sends Notice to the taxpayer for seeking additional 

information.  

3. Reply furnished, pending for Order by tax officer: When taxpayer replies to the Notice issued 

by A/A and now the case is pending with A/A for decision. 

4. Reminder No.1 issued: When A/A sends the first Reminder to the taxpayer for replying to the 

notice on providing additional information issued earlier.  

5. Reminder No.2 issued: When A/A sends the second Reminder to the taxpayer for replying to 

the notice on providing additional information issued earlier.  

6. Reminder No.3 issued: When A/A sends the third Reminder to the taxpayer for replying to the 

notice on providing additional information issued earlier. 

7. Reply not furnished, pending for order: When taxpayer does not reply to the issued Notice 

even after 3 reminders. 

8. Order rectified: When A/A passes a rectification of order.  

9. Application rejected: When A/A rejects rectification of Order application of a taxpayer. 

  



 

 

 

Manual > Conducting Proceedings u/s 161 for 
Rectification of Orders 

How can I conduct proceedings u/s 161 for Rectification of Orders? 

To conduct proceedings u/s 161 for Rectification of Orders, perform following steps:  

  

A. Initiate Suo Moto or Search for ARN 

A(1). Initiate Suo Moto Proceeding  

A(2). Search for an already-created ARN/Case ID 

B. Take action using APPLICATIONS tab of Case Details screen: View Application filed by the 

taxpayer 

C. Take action using NOTICES tab of Case Details screen:  

C(1). Issue/View Additional Information Notice  

C(2). Reminder  

C(3). Adjournment 

D. Take action using REPLIES tab of Case Details screen: View replies filed by the taxpayer  

E. Take action using PROCEEDINGS tab of Case Details screen: Add/View Proceedings details  

F. Take action using ORDERS tab of Case Details screen:  

F(1). Issue/View Rectification Order  

F(2). Rejection Order 

G. Take action using REFERENCES tab of Case Details screen:  

G(1). Record/View Communications Related to the Case Once an Order is Issued  

G(2). References related to the case 

  

Click each hyperlink above to know more. 

 A(1). Initiate Suo Moto PROCEEDING 

For initiating a Suo Moto proceeding, i.e. to initiate a new proceeding for rectification of Order, under 

section 161, perform following steps: 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > Rectification of Orders 

option. 



 

 

 

 

  

4. Case Detail Search page is displayed. Click the SUO MOTO PROCEEDING button.  

  

 

  

  

5. Suo Moto page is displayed. The “Proceeding Type” field gets auto-populated. Enter details in the 

displayed fields as mentioned in the following steps. To go to the previous Search page, click BACK.  

  



 

 

 

  

Note: All fields are mandatory. You must enter the required data in these fields to proceed.   

  

5a. Enter the GSTIN or UIN or Temporary Id of the person and then click the GO button. In case you 

enter a Temporary Id, perform the following two additional steps before proceeding further: 

  

5a. i. Select the "Are you creating case on tax payer request?" check-box.  

  

 

  

5a. ii. Once you select the check-box, "Date of offline application" field appears. Select the date using 

the calendar.  

  

 

  

Note: Temp id holder cannot file application for rectification due to EVC issue. So in this case officer will 

create case id on the basis of offline application submitted by taxpayer to officer.  

  



 

 

5b. In the Rectification Type field, select the option from the drop-down list. This will enable the 

CREATE button. Also, it will initiate loading numbers of all Orders in the Original order number field. 

Wait until the message "Loading data please wait..." disappears.  

  

 

  

 

  

5c. Once the message "Loading data please wait..." disappears and "Select Order to rectify" re-appears 

in the Original order number field, select the option from the drop-down list.  

  

  

Note: In case you select "OTHERS", an additional text field gets displayed. Enter a brief description of the 

type of rectification which you are creating for this case.  

  

 

  

  

5d. Based on the selection in Original order number field, Tax Period field gets auto-populated.  

5e. Click the enabled CREATE button. 

6. A Success popup appears. Click the CONTINUE button. 



 

 

  

  

  

7. Case Detail page is displayed and case id is successfully created. From this page, you can 

initiate conducting all Assessment/Adjudication proceedings related to this particular case, by 

using/operating  on the tabs provided at the left-hand side of the page: APPLICATIONS, NOTICES, 

REPLIES, PROCEEDINGS, ORDERS, REFERENCES. To go back to the Search page, click BACK. 

  

 

  

Note 1: On this page, the APPLICATIONS tab is selected by default. It does not contain any record of the 

filed application because this ARN is created as a result of the SUO MOTO PROCEEDINGS initiation.  

  

Note 2: Currently, Status of the ARN/Case is "Pending for action by tax officer". It will change as you 

conduct the proceeding. 

  

Go back to the Main Menu 

A(2). Search for an already-created ARN/Case ID 



 

 

To search for a particular ARN/Case ID, perform following steps: 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > Rectification of Orders 

option. 

 

 

  

4. Case Detail Search page is displayed. Choose any one of the four displayed fields as your search 

criteria and enter the required information: ARN, GSTIN, Status (select from the drop-down list) or From 

Date & To Date, and click the SEARCH button. 

  

 

  

Note: You must enter data in at least one field to proceed.   

  

5. Based on your search criteria, the required ARN or the list of the required ARNs is displayed. 

Click the ARN hyperlink of the case you want to act on.  

  



 

 

 

  

Note: Because the search criteria of Status as "Pending for action by tax officer" was selected earlier 

as the Search criteria, all ARNs related to this criteria gets displayed.  

  

6. Case Detail page is displayed. From this page, you can initiate conducting all 

Assessment/Adjudication proceedings related to this particular case by operating on the tabs 

provided at the left-hand side of the page: APPLICATIONS, NOTICES, REPLIES, PROCEEDINGS, 

ORDERS, REFERENCES. To go back to the Search page, click BACK. 

  

 

  

Note 1: On this page, the APPLICATIONS tab is selected by default. It does not contain any record of the 

filed application because this ARN was the result of your SUO MOTO PROCEEDINGS initiation.  

  

Note 2: Currently, Status of the ARN/Case is "Pending for action by tax officer". It will change as you 

conduct the proceeding. 

  



 

 

Go back to the Main Menu 

B. Take action using APPLICATIONS tab of Case Details screen: View 

Application filed by the taxpayer 

To view Application filed by the taxpayer, perform following steps: 

  

1. On the Case Details page of that particular application, select the APPLICATIONS tab, if it is not 

selected by default. This tab provides you an option to view the application filed for the case in PDF 

mode. Click BACK to go back to the Search page.  

  

 

  

2. Click the View hyperlink to download and view the application in PDF mode.  

  

Go back to the Main Menu 

C(1). Take action using NOTICES tab of Case Details screen: Issue/View 

Additional Information Notice 

To view or issue Additional Information against an ARN/Case ID, perform following steps: 

  

1. On the Case Details page of that particular application, select the NOTICES tab. This tab 

displays all the notices (Additional Information/Reminder/Adjournment) you will issue. Click ADD 

NOTICE and select ADDITIONAL INFORMATION. 

  



 

 

 

  

2. ADDITIONAL INFORMATION page is displayed. Enter details in the displayed fields as 

mentioned in the following steps. To go to the previous page, click BACK. 

  

 

  

Note: Before issuing the notice, if required, you can also refer to the following hyperlinks provided on the 

right-side of the page to view various details:  

 MIS Reports: Contains all available MIS Reports.  

 Tax Liability: Contains details of estimated tax liabilities of current tax period as updated from 

Form GSTR-1, 1A and Form GSTR-2, 2A  



 

 

 Tax Return History: Contains details of the returns of the previous tax periods, and also option 

to view any other return of the defaulter.  

  

2a. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

  

 

  

2b. In the Personal Hearing Required? field, select the check-box if required. If you select the check-

box, following fields get displayed. Enter details in these fields as well . 

i. Enter the Personal Hearing Date  field by clicking the calendar and selecting the date. 

ii. In the Personal Hearing Time  field also, click calendar and select the time—hours and minutes.   

iii. In the Venue field, enter the address of the place where you would like to call the taxpayer for 

personal hearing.   

  

 

  

2c. In the Due Date to Reply field, click calendar and select the date by when the taxpayer must file the 

reply to the issued notice.   

2d. Click Choose File to upload the document(s) from your machine that state the reasons of issuing this 

notice. 

2e. Click PREVIEW and a system-generated draft notice gets downloaded into your machine. Check the 

draft carefully to rule out any discrepancy. Once satisfied with your entered details, click the PROCEED 

button.  

  

3. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  



 

 

 

  

4. The Dashboard page is displayed with a confirmation message. Click OK.  

  

 

  

5. The updated NOTICES tab is displayed, with the record of the issued notice and with the Status 

updated to "Pending for reply by taxpayer".  

  

 

  

  

Note: As mentioned in the confirmation message on the Dashboard page, you can serve this notice to 

the taxpayer by post or through a special messenger. For this, click the documents attached in t he 



 

 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

6. Additionally, the following actions take place on the GST Portal after the issue of the Order.  

9. Intimation of the issue of notice is sent to the concerned taxpayer via email id and SMS. 

10.  Dashboard of Taxpayer is updated with the record of the issued notice. Taxpayer can view the 

issued notice from the following navigation: Services > User Services > View Additional 

Notices/Orders > View > Case Details. 

  

Go back to the Main Menu 

  

C(2). Take action using NOTICES tab of Case Details screen: Issue/View 

Reminder 

To view or issue a Reminder against an ARN/Case ID, perform following steps: 

  

1. On the Case Details page of that particular application, select the NOTICES tab. This tab 

displays all the notices (Additional Information/Reminder/Adjournment) you will issue. Click ADD 

NOTICE and select REMINDER. 

  

 

  

  

2. REMINDER page is displayed. Type and Reminder No. fields are auto-populated. Enter details 

in the displayed fields as mentioned in the following steps. To go to the previous page, click BACK. 

  



 

 

 

  

Note: Before issuing the reminder, if required, you can also refer to the following hyperlinks provided on 

the right-side of the page to view various details:  

 MIS Reports: Contains all available MIS Reports.  

 Tax Liability: Contains details of estimated tax liabilities of current tax period as updated from 

Form GSTR-1, 1A and Form GSTR-2, 2A  

 Tax Return History: Contains details of the returns of the previous tax periods, and also option 

to view any other return of the defaulter.  

  

2a. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

  

 

  

2b. In the Personal Hearing Required? field, select the check-box if required. If you select the check-

box, following fields get displayed. Enter details in these fields as well.  

i. Enter the Personal Hearing Date  field by clicking the calendar and selecting the date. 

ii. In the Personal Hearing Time  field also, click calendar and select the time—hours and minutes.   

iii. In the Venue field, enter the address of the place where you would like to call the taxpayer for 

personal hearing.   



 

 

  

 

  

2c. In the Due Date to Reply field, click calendar and select the date by when the taxpayer must file the 

reply to the issued notice.    

2d. Click Choose File to upload the document(s) from your machine that state the reasons of issuing this 

notice, if any. This is not a mandatory field.  

2e. Click PREVIEW and a system-generated draft notice gets downloaded into your machine. Check the 

draft carefully to rule out any discrepancy. Once satisfied with your entered details, click the PROCEED 

button.  

  

3. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  

 

  

4. The Dashboard page is displayed with a confirmation message. Click OK.  

  

 

  



 

 

5. The updated NOTICES tab is displayed, with the record of the issued Reminder and with the 

Status updated to "Reminder No.1 issued".  

  

 

  

Note 1: As mentioned in the confirmation message on the Dashboard page, you can serve this notice to 

the taxpayer by post or through a special messenger. For this, click the documents attached in the 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

Note 2: You can issue three reminders against a particular case.  

  

6. Additionally, the following actions take place on the GST Portal after the issue of the Order.  

9. Intimation of the issue of notice is sent to the concerned taxpayer via email id and SMS.  

10.  Dashboard of Taxpayer is updated with the record of the issued notice. Taxpayer can view the 

issued notice from the following navigation: Services > User Services > View Additional 

Notices/Orders > View > Case Details. 

  

Go back to the Main Menu 

C(3). Take action using NOTICES tab of Case Details screen: Issue/View 

Adjournment 

To view or issue an Adjournment against an ARN/Case ID, perform following steps: 

  

1. On the Case Details page of that particular application, select the NOTICES tab. This tab 

displays all the notices (Additional Information/Reminder/Adjournment) you will issue. Click ADD 

NOTICE and select ADJOURNMENT. 

  



 

 

 

  

  

2. ADJOURNMENT page is displayed. Type field is auto-populated. Enter details in the displayed 

fields as mentioned in the following steps. To go to the previous page, click BACK. 

  

 

  

Note: Before issuing the reminder, if required, you can also refer to the following hyperlinks provided on 

the right-side of the page to view various details:  

 MIS Reports: Contains all available MIS Reports.  

 Tax Liability: Contains details of estimated tax liabilities of current tax period as updated from 

Form GSTR-1, 1A and Form GSTR-2, 2A  



 

 

 Tax Return History: Contains details of the returns of the previous tax periods, and also option 

to view any other return of the defaulter.  

  

  

2a. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

  

 

  

2b. In the Personal Hearing Required? field, select the check-box if required. If you select the check-

box, following fields get displayed. Enter details in these fields as well.  

i. Enter the Personal Hearing Date  field by clicking the calendar and selecting the date. 

ii. In the Personal Hearing Time  field also, click calendar and select the time—hours and minutes.   

iii. In the Venue field, enter the address of the place where you would like to call the taxpayer for 

personal hearing.   

  

 

  

2c. In the Due Date to Reply field, click calendar and select the date by when the taxpayer must reply to 

the issued notice.     

2d. Click Choose File to upload the document(s) from your machine that state the reasons of issuing this 

notice, if any. This is not a mandatory field.  

2e. Click the PROCEED button.  

  

3. A success message popup is displayed. Click CONTINUE.  

  



 

 

 

  

4. The updated NOTICES tab is displayed, with the record of the issued Adjournment. Status of 

ARN remains the same.  

  

 

  

Note: As mentioned in the confirmation message on the Dashboard page, you can serve this notice to 

the taxpayer by post or through a special messenger. For this, click the documents attached in the 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

6. Additionally, the following actions take place on the GST Portal after the issue of the Order.  

9. Intimation of the issue of notice is sent to the concerned taxpayer via email id and SMS.  



 

 

10.  Dashboard of Taxpayer is updated with the record of the issued notice. Taxpayer can view the 

issued notice from the following navigation: Services > User Services > View Additional 

Notices/Orders > View > Case Details. 

  

Go back to the Main Menu 

D. Take action using REPLIES tab of Case Details screen: View replies filed 

by the taxpayer 

To view replies submitted by the taxpayer, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the REPLIES tab. This tab displays all 

replies filed by the taxpayer.  

  

 

  

2. Click the documents in the Attachments section to download and ascertain their contents.  

  

Go back to the Main Menu 

  

E. Take action using PROCEEDINGS tab of Case Details screen: Add/View 

Proceedings details 

To update the proceeding details related to Personal Hearing, if any, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the PROCEEDINGS tab. This tab 

displays a table of all the records of the personal hearing proceedings' related to the ARN/Case. 

Click ADD PROCEEDINGS to open the drop-down list and select PERSONAL HEARING. 

  



 

 

 

  

2. PERSONAL HEARING page is displayed. The Type field is auto-populated. Enter Date by 

clicking the calendar icon and selecting the date when Personal Hearing was conducted.  

  

 

  

3. Type the required text in the Proceeding for the day field. 

  

4. Click Choose File to select the documents related to the Personal Hearing, if any. This is not a 

mandatory field. 

  

5. Click the SUBMIT button. 

  

6. The updated Case Detail page is displayed, with the table containing the record of the Personal 

Hearing you submitted. 

  



 

 

 

  

Go back to the Main Menu 

F(1). Take action using ORDERS tab of Case Details screen: Issue/View 

Rectification Order (Form GST DRC-08)  

To view or issue the Rectification Order against the ARN/case created, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, click the ORDERS tab.  This tab displays 

order issued against the ARN/Case ID. Click ADD ORDER to open the drop-down list and select 

RECTIFICATION OF ORDER - DRC-08. 

  

 

  

Note: Current application Status as displayed is "Pending for reply by taxpayer". This status will 

change once you issue order.  

  

2. RECTIFICATION OF ORDER - DRC-08 page is displayed. The Type, Original Order No., 

Original Order Date, Section Number and Tax Period fields are auto-populated. Enter details in 

the displayed fields as mentioned in the following steps. To go back to the previous page, click 

BACK.  

  



 

 

 

  

Note: Before issuing the Order, if required, you can also refer to the following hyperlinks provided on the 

right-side of the page to view various details:  

 MIS Reports: Contains all available MIS Reports.  

 Tax Liability: Contains details of estimated tax liabilities of current tax period as updated from 

Form GSTR-1, 1A and Form GSTR-2, 2A  

 Tax Return History: Contains details of the returns of the previous tax periods, and also option 

to view any other return of the defaulter.  

  

  



 

 

2a. In the Order Reference Number field, click the Generate Reference Number hyperlink. Reference 

Number field gets auto-populated. 

  

 

  

2b. In the Due Date of Payment field, click calendar and select the date to enter.   

2c. In the demand grid, select the From and To drop-down lists of the Tax period field.  

  

 

  

2d. In the demand grid, scroll to the right and select the Act from the drop-down list. Also, select the 

Place of Supply (POS) from the drop-down list.  

  

Note: POS is required only in case of IGST. 

  

 

  

2e. In the demand grid, again scroll to the right and in the following fields enter the amount that the 

taxpayer must pay, as applicable: Tax/Cess, Interest, Penalty, Others. 

  



 

 

.  

  

2f. If required, you can also click the ADD button to add more rows in the demand grid for entering 

demand for each month and fill the added rows in the same manner as mentioned in the above steps.  

  

 

  

2g. Click Choose File to upload the annexure/document(s) from your machine related to this order.  

2h. Click PREVIEW and a system-generated draft ORDER gets downloaded into your machine. Check 

the system-generated draft ORDER carefully to rule out any discrepancy and once satisfied with your 

entered details, click the PROCEED button.  

  

 

  

3. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  



 

 

 

  

5. The Dashboard page is displayed with a confirmation message. Click OK.  

  

 

  

6. The updated ORDERS tab is displayed, with the record of the issued RECTIFICATION OF 

ORDER - DRC-08 and the Status updated to "Order rectified".  

  

 

  

Note: As mentioned in the confirmation message on the Dashboard page, you can serve this order to the 

taxpayer by post or through a special messenger. For this, click the documents attached in the 



 

 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

7. Additionally, the following actions take place on the GST Portal after the issue of the Order.  

9. Intimation of the issue of order is sent to the concerned taxpayer via email id and SMS. 

10.  Dashboard of the Taxpayer is updated with the record of the issued Order. Taxpayer can view the 

issued order from the following navigation: Services > User Services > View Additional 

Notices/Orders. 

11.  Demand ID is created and Electronic liability register gets updated along with DCR. 

  

Go back to the Main Menu 

F(2). Take action using ORDERS tab of Case Details screen: Issue/View 

Rejection Order 

To view or issue a Rejection order against the application filed by the taxpayer, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, click the ORDERS tab.  This tab displays 

order issued against the ARN/Case ID. Click ADD ORDER to open the drop-down list and select 

REJECTION ORDER. 

  

 

  

Note: Current application Status as displayed is "Pending for reply by taxpayer". This status will 

change once you issue this order.  

  

2. REJECTION ORDER page is displayed. The Type, Original Order No. and Original Order Date 

fields are auto-populated. Enter details in the displayed fields as mentioned in the following steps. To 

go back to the previous page, click BACK.  

  



 

 

 

  

Note: Before issuing the Order, if required, you can also refer to the following hyperlinks  provided on the 

right-side of the page to view various details: 

 MIS Reports: Contains all available MIS Reports.  

 Tax Liability: Contains details of estimated tax liabilities of current tax period as updated from 

Form GSTR-1, 1A and Form GSTR-2, 2A  

 Tax Return History: Contains details of the returns of the previous tax periods, and also option 

to view any other return of the defaulter.  

  

  

2a. In the Order Number field, click the Generate Reference Number hyperlink. Order Number field gets 

auto-populated. 

2b. Click Choose File to upload the annexure/document(s) from your machine related to this order.  

2c. Click PREVIEW and a system-generated draft ORDER gets downloaded into your machine. Check 

the system-generated draft ORDER carefully to rule out any discrepancy and once satisfied with your 

entered details, click the PROCEED button.  

  

3. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  



 

 

 

  

5. The Dashboard page is displayed with a confirmation message. Click OK.  

  

 

  

6. The updated ORDERS tab is displayed, with the record of the issued REJECTION ORDER and 

the Status updated to "Application rejected".  

  

 

  

Note: As mentioned in the confirmation message on the Dashboard page, you can serve this order to the 

taxpayer by post or through a special messenger. For this, click the documents attached in the 



 

 

Attachments section of the table to download them. Take a print and then sign the printed document 

manually before sending.  

  

7. Additionally, the following actions take place on the GST Portal after the issue of the Order:  

9. Intimation of the issue of order is sent to the concerned taxpayer on his/her registered email id 

and SMS. 

10.  Dashboard the Taxpayer is updated with the record of the issued Order. Taxpayer can view the 

issued order from the following navigation: Services > User Services > View Additional 

Notices/Orders. 

  

Go back to the Main Menu 

  

G(1). Take action using REFERENCES tab of Case Details screen: 

Record/View Communications Related to the Case Once an Order is Issued  

To view or record any communication related to the case, perform following steps: 

  

Note: You will be able to record a communication only once the Additional Information Notice has been 

issued. 

  

1. On the Case Detail page of that particular taxpayer, click the REFERENCES tab. This tab 

displays references related to this ARN/Case ID. Click ADD REFERENCE to open the drop-down list 

and select COMMUNICATION. 

  

 

  

2. COMMUNICATION page is displayed. Enter details in the displayed fields as mentioned in the 

following steps. To go to the previous page, click BACK. 

  



 

 

 

  

2a.  In the Notice/Order/Reminder Reference Number, select the notice number from the drop-down list 

2b. In the Type of Communication, select one of the following options from the drop-down list—Post or 

Special Messenger 

  

Note: As displayed in the image below, if you select, Type of Communication as Special Messenger, 

Delivered by field gets displayed. You must enter the name of the person who delivered this 

communication as well. 

  

 

  

2c. In the Communication Date field, select date from the calendar. 

2d. Click Choose File to upload the document(s), if any. This is not a mandatory field.  

2e. Click the SUBMIT button. 

  

3. The updated References tab is displayed, with the record of the communication submitted. You 

can click the document(s) attached in the Attachments section of the table, if any, to download 

them.  

  



 

 

 

  

Go back to the Main Menu 

G(2). Take action using REFERENCES tab of Case Details screen: 

Record/View References related to the case, if any 

To view or record the References related to the case, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the REFERENCES tab. This tab 

displays references related to this ARN/Case ID. Click ADD REFERENCE to open the drop-down list 

and select REFERENCES OF CASE. 

  

 

  

2. REFERENCES OF CASE page is displayed. Type and Date fields are auto-populated. Click 

Choose File to upload the document(s) related to this case,if any. This  is not a mandatory field. 

Then, click the SUBMIT button. To go to the previous page, click BACK. 

  



 

 

 

  

3. The updated References tab is displayed, with the table containing the record of the references 

just submitted. You can click the document(s) attached in the Attachments section of the table to 

download them.  

  

 

  

Go back to the Main Menu 

  



 

 

Provisional Attachment 

FAQs > Provisional Attachment 

1. What is Provisional Attachment? 

If proceedings are pending under section 62 or 63 or 64 or 73/74 i.e. (proceedings are yet to be 

concluded) and Commissioner/ Competent authority is of opinion that for the purpose of protecting the 

interest of Government revenue, it is necessary to provisionally attach the property or bank account 

belonging to such taxable person, then Commissioner/ Competent authority may pass an order of 

provisional attachment. 

2. What process is to be followed for provisional attachment? 

Tax Officer need to follow below process for provisional attachment:  

 Tax Officer needs to upload the request email, select the status as ‘‘Pending for approval’.  

 On receipt of request, Commissioner/ Competent authority will give his comments and have 

following option (by email): 

  Approve 

  Reject 

  Seek Additional Information 

 In case, additional information is sought by Commissioner/ Competent authority and request for 

seeking additional information is received by officer on email then officer will select the status as 

‘Pending for clarification’ and upload such email.   

 Accordingly, Adjudicating Authority will provide required information to Commissioner/ Competent 

authority on email and update by clicking on ‘Internal communication’ folder, select the status as 

‘Pending for approval’ and upload the clarification email given by officer to Commissioner/ 

Competent authority. 

 If request for provisional attachment is not allowed by Commissioner/ Competent authority (by 

email), then status of ARN/Case id will be changed to ‘Proposal for attachment rejected’ and 

officer will upload the rejection email by clicking on ‘Internal communication’ folder, selecting the 

status as ‘Proposal for attachment rejected’ and attach rejection email.  

 If request for provisional attachment is allowed by Commissioner/ Competent authority (by email), 

then status of ARN/Case id will be changed to ‘Approval granted, pending for order by tax officer 

and officer will upload the approval email by clicking on ‘Internal communication’ folder, selecting 

the status as ‘Approval granted, pending for order by tax officer’ and attach approval email.  

 Adjudicating Authority will take a print of order and same shall be served (by post) to particular 

bank/ financial institution/ post office/ Immovable property registering authority who is custodian 

of assets. 



 

 

 The date of service of order i.e. the proof of delivery of order to the Bank/ Registrar or Custodian 

will be updated in the GST Portal by the Office Assistant/ Nominee.  

3. To whom the order of Provisional Attachment is served? 

Order of provisional attachment is served to bank/ financial institution/ post office/ Immovable property 

registering authority, who is custodian of such assets. 

4. What is the validity of Provisional Attachment? 

Order of provisional attachment is valid for one year from the date of order.  

5. What are the pre-conditions to issue Provisional Attachment? 

Pre-conditions to issue Provisional Attachment are: 

• Proceedings u/s 62 or 63 or 67 or 73/74 should be pending; and 

• Approval of Commissioner/ Competent authority must have been obtained.  

6. Is it mandatory to get approval from Commissioner/ Competent authority 

to provisionally attach the property? 

Yes, it is mandatory to get approval from Commissioner/ Competent authority to provisionally attach the 

property. Approval request shall be sent via email or through manual file.  

7. What happens when approval is granted by Commissioner/ Competent 

authority to issue Provisional Attachment? 

• Order of provisional attachment will be generated and it will be served to bank/ post office/ financial 

institution/ immovable property registering authority by post or through special messenger.  

• Status of Internal Reference Number (IRN) will get updated to ‘Order issued’.  

8. What are the various statuses for Provisional Attachment? 

Various statuses for Provisional Attachment chosen by Tax Official are:  

1. Pending for approval - Status of ARN/Case ID upon request sent to Commissioner/ Competent 

authority for approval of provisional attachment. 

2. Pending for clarification - Status of ARN/Case ID if any clarification is sought by Commissioner/ 

Competent authority. 

3. Approval granted, pending for order by tax officer - Status of ARN/Case ID, if approval is granted by 

Commissioner/ Competent authority and same is pending for order by tax officer.  



 

 

4. Proposal for attachment rejected - Status of ARN/Case ID, if approval is not granted by Commissioner/ 

Competent authority.   

  

Status for Provisional Attachment updated automatically by GST Portal is: 

1. Order issued - Status of ARN/Case ID upon issue of order of provisional attachment by tax officer.  

9. Do I need to upload details of receipt of order sent by post to the 

custodian of assets? 

In case notice/ order etc. is issued by post/ special messenger, then officer needs to update the details of 

same in ‘Reference’ folder i.e. date of delivery and upload the receipt related to post on the GST Portal.  

10. What is the difference between Communication and References tab?  

Communication tab is used to upload documents which have been used to communicate internally within 

Tax officials. 

References tab is used to upload additional documents or communication done with the taxpayer related 

to the case. 



 

 

 

Manual > Provisional Attachment 

How can I issue Provisional Attachment of property to protect the revenue 

of Government? 

To issue Provisional Attachment of property to protect the revenue of Government, perform following 

steps: 

  

A. Initiate Suo-Moto Proceedings 

B. Go to Provisional Attachment application page by either searching for the ARN (Application Reference 

Number)/GSTIN/Status/Period 

C. Send Internal Communication 

D. Issue Provisional Attachment Order 

E. Upload Communication 

F. Upload References of Case 

  

Click each hyperlink above to know more. 

A. Initiate Suo-Moto Proceedings 

1. Access the GST Back Office Portal for tax officials. 

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Quick Links > List of proceedings pending  option. 

  

 

  

4. The List of proceedings pending page is displayed. 

  



 

 

 

  

5. Select the Type of Proceedings from the drop-down list. 

  

 

  

6. Select the From and To Date using the calendar. 

7. Click SEARCH. 

8. The search results are displayed. 

Note:  

 If you select ‘Proceedings pending under section 62 or 63 or 73/74’, it will display the list of 

pending cases i.e. proceedings in which notices have been issued.  

 If you select ‘Proceedings pending under section 64’, it will display the list of pending cases i.e. 

proceedings in which summary assessment orders have been issued.  

9. Click INITIATE PROCEEDINGS button. 

  



 

 

 

  

10. The Suo Moto page is displayed. Click CREATE. 

  

 

  

11. A success message is displayed. Click CONTINUE. 

  



 

 

 

  

12. Provisional Attachment Case Detail page is displayed. From this page, you can initiate provisional 

attachment process by operating on the tabs provided at the left-hand side of the page: ORDERS, 

INTERNAL COMMUNICATION and REFERENCES. 

  

 

  

Or, you can also search the Provisional Attachment application page by either searching for the ARN 

(Application Reference Number)/GSTIN/Status/Period by navigating to Statutory Functions > 

Assessment/Adjudication > Provisional Attachment option. 

  

Go back to the Main Menu 

B. Go to Provisional Attachment application page by either searching for 

the ARN (Application Reference Number)/GSTIN/Status/Period 

1. Access the GST Back Office Portal for tax officials. 

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > Provisional  Attachment option. 



 

 

 

 

  

4. Search page is displayed. Choose any one of the four displayed fields as your search criteria and enter 

the required information: ARN, GSTIN, Status or Period From and Period To Date 

Note: You must enter data in at least one field to proceed.   

5. Click the SEARCH button. 

  

 

  

6. Based on your search criteria, the required ARN(s) gets displayed. Click the ARN hyperlink of the case 

you want to act on.   

  



 

 

 

  

7. Provisional Attachment Case Detail page is displayed. From this page, you can initiate provisional 

attachment process by operating on the tabs provided at the left-hand side of the page: ORDERS, 

INTERNAL COMMUNICATION and REFERENCES. 

Note: On this page, the ORDERS tab is selected by default.  

  

Go back to the Main Menu 

C. Send Internal Communication 

To send internal communication, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the INTERNAL COMMUNICATION tab if it 

is not selected by default. This tab displays all communications sent against the case created.  

2. Click TYPE OF COMMUNICATION to open the drop-down list and select Commissioner/ competent 

Authority. 

  



 

 

 

  

3. The Internal Communication page is displayed. 

  

 

  

4. Select the Status from the drop-down list. 

Note: 

 Tax Officer needs to upload the request email, select the status as ‘‘Pending for approval’.  

 On receipt of request, Commissioner/ Competent authority will give his comments and have 

following option (by email): 

 Approve 

 Reject 

 Seek Additional Information 

 In case, additional information is sought by Commissioner/ Competent authority and request for 

seeking additional information is received by officer on email then officer will select the status as 

‘Pending for clarification’ and upload such email.   

 Accordingly, Adjudicating Authority will provide required information to Commissioner/ Competent 

authority on email and update by clicking on ‘Internal communication’ folder, select the status as 



 

 

‘Pending for approval’ and upload the clarification email given by officer to Commissioner/ 

Competent authority. 

 If request for provisional attachment is not allowed by Commissioner/ Competent authority (by 

email), then status of ARN/Case id will be changed to ‘Proposal for attachment rejected’ and 

officer will upload the rejection email by clicking on ‘Internal communication’ folder, selecting the 

status as ‘Proposal for attachment rejected’ and attach rejection email.  

 If request for provisional attachment is allowed by Commissioner/ Competent authority (by email), 

then status of ARN/Case id will be changed to ‘Approval granted, pending for order by tax officer 

and officer will upload the approval email by clicking on ‘Internal communication’ folder, selecting 

the status as ‘Approval granted, pending for order by tax officer’ and attach approval email. 

  

5. Click the Choose File button to upload any attachment. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

  

 

  

6. Click the SUBMIT button. 

  



 

 

 

  

7. The updated Case Detail page is displayed, with the table containing the record of the communication 

sent. 

  

 

  

Go back to the Main Menu 

D. Issue Provisional Attachment Order 

To Issue Provisional Attachment Order, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab if it is not selected by 

default. This tab displays a table of all the records for which you would issue orders against the case 

created.  

2. Click ADD ORDER to open the drop-down list and select PROVISIONAL ATTACHMENT ORDER - 

DRC - 22. 

  



 

 

 

  

3. The Provisional Attachment Order page is displayed. 

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. Enter the name, address and designation of the authority/ bank to whom the provisional attachment 

order is to be served i.e. who is custodian of the assets.  

6. In the Section Number field, enter the section number. 

7. Select the Type of Attachment from the drop-down list. 

8. Click the Choose File button to upload any attachment. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application. 

9. Select the Type of Attachment from the drop-down list. 

  



 

 

 

  

10.1. In case of Bank, enter the Type of Account, Name of Bank/Financial Institutions/Post 

Office/Depository Participants, Account Number and Location details.  

  



 

 

 

  

10.2. In case of Property, enter the Registration Authority, Property ID, Property Name and Property 

Address details. 

  



 

 

 

  

11. Click PREVIEW and a system-generated draft order gets downloaded into your machine as 

displayed. 

  



 

 

 

  

12. Check the system-generated draft order carefully to rule out any discrepancy. 

  



 

 

 

  

13. Click PROCEED button.  

  



 

 

 

  

14. Click ISSUE with DSC.  

  

 

  

15. The Dashboard page is displayed with the following confirmation message. Click OK.  

  



 

 

 

  

16. The updated Case Detail page is displayed, with the table containing the record of the order just 

admitted. 

Note: 

 Status of order is changed to "Order Issued". 

 Adjudicating Authority will take a print of order and same shall be served (by post) to particular 

bank/ financial institution/ post office/ Immovable property registering authority who is custodian 

of assets. 

 The date of service of order i.e. the proof of delivery of order to the Bank/ Registrar or Custodian 

will be updated in the GST Portal by the Office Assistant/ Nominee.  

  

 

  

Go back to the Main Menu 

E. Upload Communication 

To upload any references for communication, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the REFERENCES tab if it is not selected 

by default. This tab displays all communications sent against the case created.  

2. Click ADD REFERENCE to open the drop-down list and select COMMUNICATION. 

  



 

 

 

  

3. The References page is displayed. 

  

 

  

4. Select the Notice/Order/Reminder Reference Number from the drop-down list. 

5. Select the Type of Communication from the drop-down list. 

6. Select the Issue Date and Communication Date  using the calendar. 

7. Click the Choose File button to upload any attachment. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

8. Click the SUBMIT button.  

  



 

 

 

  

7. The updated Case Detail page is displayed, with the table containing the record of the communication 

sent. 

  

 

  

Go back to the Main Menu 

F. Upload References of Case 

To upload any references for case, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the REFERENCES tab if it is not selected 

by default. This tab displays all communications sent against the case created.  

2. Click ADD REFERENCE to open the drop-down list and select REFERENCES OF CASE. 

  



 

 

 

  

3. Click the SUBMIT button.  

  

 

  

4. The updated Case Detail page is displayed, with the table containing the record of the reference of 

case. 

  

 

  

Go back to the Main Menu 

  



 

 

Restoration of Provisional Attachment 

FAQs > Restoration of Provisional Attachment 

1. I am not getting Restoration of Provisional Attachment link in my 

Dashboard. Why? 

You may not have been assigned the role of Adjudicating Authority by the State Admin. You may request 

your State Admin to allocate you the role of Adjudicating Authority. Once the role is assigned, you will be 

allocated 'Restoration of Provisional Attachment' link for further action. 

  

Click here to learn about the various roles available in Tax Officials Interface and how Admin can assign 

the role to Tax Officials. 

2. What is Restoration of Provisional Attachment? 

If proceedings are pending under section 62 or 63 or 64 or 67 or 73/74 i.e. (proceedings are yet to be 

concluded) and Commissioner/ Competent authority is of opinion that for the purpose of protecting the 

interest of Government revenue, it is necessary to provisionally attach the property or bank account 

belonging to such taxable person, then Commissioner/ Competent authority may pass an order of 

provisional attachment. 

  

Any person whose property is attached may, within 7 days of attachment order, file an application for 

restoration of provisional attachment to the effect that the property attached was or is not liable to 

attachment. 

3. To whom the order of Restoration of Provisional Attachment is served? 

Restoration of provisional attachment order is served to bank/ financial institution/ post office/ Immovable 

property registering authority, who is custodian of such assets.  

4. Application for Restoration of Provisional Attachment can be filed by 

which date by taxpayer? 

Application for restoration of provisional attachment may be filed by a taxpayer within 7 days of 

provisional attachment order. 

5. What are the pre-conditions to issue Restoration of Provisional 

Attachment? 



 

 

Pre-conditions to issue Restoration of Provisional Attachment are:  

 Provisional attachment order is passed. 

 Commissioner/ Competent authority‘s approval is provided. 

6. Is it mandatory to get approval from Commissioner/ Competent authority 

to restore the provisional attachment? 

Yes, it is mandatory to get approval from Commissioner/ Competent authority to restore the provisional 

attachment. Approval request shall be sent via email or through manual file.  

7. What happens when approval is granted by Commissioner/ Competent 

authority to restore the provisional attachment? 

• Order of provisional attachment restoration will be generated and it will be served to bank/ post office/ 

financial institution/ immovable property registering authority by post or through special messenger.  

• Status of ARN/ Case ID will get updated to ‘Restoration Order issued’.  

8. What are the various statuses for Restoration of Provisional 

Attachment? 

Various statuses for Restoration of Provisional Attachment chosen by Tax Official are:  

1. Pending for approval on restoration - Status of IRN upon request sent to Commissioner/ Competent 

authority for approval of restoration  

2. Pending for clarification by tax officer - Status of IRN if any clarification is sought by Commissioner/ 

Competent authority  

3. Approval granted, pending for restoration order - Status of IRN if approval is granted by Commissioner/ 

Competent authority  

4. Proposal for restoration rejected - if approval is not granted by Commissioner/ Competent authority: 

  

Various statuses for Restoration of Provisional Attachment updated automatically by GST Portal are:  

1. Pending for action by tax officer - Status of ARN upon application received for restoration of provisional 

attachments  

2. Pending for reply by taxpayer - Status of ARN/ RFN upon issue of notice to taxpayer to seek 

clarification  

3. Restoration order issued - Status of ARN/Case ID  upon issue of restoration order 

4. Reply furnished, pending for order - Status of ARN/ RFN upon reply received from taxpayer  

9. Do I need to upload details of receipt of order sent by post to the 

custodian of assets? 



 

 

Tax Officer needs to update the details of receipt of order sent by post to the custodian of assets in 

‘Reference’ folder i.e. date of delivery and upload the receipt related to post on the GST Portal.  

10. What is the difference between Communication and References tab?  

Communication tab is used to upload documents which have been used to communicate to taxpayer 

offline. 

References tab is used to upload additional documents or communication related to the case.  

11. Who will update the status and upload e-mails received from 

Commissioner/ Competent authority in the Internal Communication tab?  

Adjudicating Authority needs to update the status and upload e-mails received from Commissioner/ 

Competent authority in the Internal Communication tab. 



 

 

 

Manual > Restoration of Provisional 
Attachment 

How can I act on the application received for Restoration of Provisional 

Attachment? 

To act on the application received for Restoration of Provisional Attachment, in the role of Adjudicating 

Authority, perform following steps: 

  

A. Initiate Suo-Moto Proceedings for Restoration of Provisional Attachment 

B. Go to Restoration of Provisional Attachment application page by searching for the ARN (Application 

Reference Number)/GSTIN/Status/Period 

C. View application document submitted by the Taxpayer or information in case of Suo Moto Restoration 

D. Issue Additional Information Notice, if any 

E. View Replies by the Taxpayer 

F. Issue an Adjournment, if needed 

G. Add Personal Hearing Proceedings 

H. Send Internal Communication 

I.  Upload Communication 

J. Upload References of Case 

K. Issue Order of Provisional Attachment Restoration Order - DRC-23 

L. Issue Restoration Rejection Order  

  

Click each hyperlink above to know more. 

A. Initiate Suo-Moto Proceedings for Restoration of Provisional Attachment 

1. Access the GST Back Office Portal for tax officials. 

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > Restoration of Provisional 

Attachment option. 

  



 

 

 

  

4. The Restoration of Provisional Attachment page is displayed. 

  

 

  

5. Click the SUO MOTO PROCEEDING button. 

  

 

  

10. The Suo Moto page is displayed. The “Proceeding Type” field gets auto-populated.  

  



 

 

 

  

11. Enter the GSTIN or UIN or Temporary Id of the taxpayer. 

12. Click the GO button. This will enable the CREATE button.  

13. Select the Financial Year from the drop-down list. 

14. Select the Tax Period from the From and To drop-down lists. 

15. Click the CREATE button. 

  

 

  

16. A success message is displayed. Click CONTINUE. 

  

 

  



 

 

17. Restoration of Provisional Attachment Case Detail page is displayed. From this page, you can 

initiate restoration of provisional attachment process by operating on the tabs provided at the left -hand 

side of the page: APPLICATIONS, NOTICES, REPLIES, PROCEEDINGS, ORDERS, INTERNAL 

COMMUNICATION and REFERENCES. 

  

 

  

Or, you can also search the Restoration of Provisional Attachment application page by either searching 

for the ARN (Application Reference Number)/GSTIN/Status/Period by navigating to Statutory Functions 

> Assessment/Adjudication > Restoration of Provisional Attachment option. 

  

Go back to the Main Menu 

B. Go to Restoration of Provisional Attachment application page by 

searching for the ARN (Application Reference 

Number)/GSTIN/Status/Period 

1. Access the GST Back Office Portal for tax officials. 

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > Restoration of Provisional 

Attachment option. 

  



 

 

 

 

  

4. Search page is displayed. Choose any one of the four displayed fields as your search criteria and enter 

the required information: ARN, GSTIN, Status or Period From and Period To Date. 

Note: You must enter data in at least one field to proceed.   

  

 

  

5. Click the SEARCH button. 

  

 

  

6. Based on your search criteria, the required ARN(s) gets displayed. Click the ARN hyperlink of the case 

you want to act on.   

  



 

 

 

  

7. Restoration of Provisional Attachment Case Detail page is displayed. From this page, you can 

initiate restoration of provisional attachment process by operating on the tabs provided at the left-

hand side of the page: APPLICATIONS, NOTICES, REPLIES, PROCEEDINGS, ORDERS, INTERNAL 

COMMUNICATION and REFERENCES. 

Note: On this page, the APPLICATIONS tab is selected by default.  

  

 

  

Go back to the Main Menu 



 

 

C. View application document submitted by the Taxpayer or information in 

case of Suo Moto Restoration 

To view application/ document submitted by the taxpayer or information in case of Suo Moto Restoration, 

perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the APPLICATIONS tab if it is not selected 

by default. This tab displays the entire application, in PDF mode, with all its attachments.  

2. Click the View links under View Documents column to view the application/ information and its 

attachments in PDF mode.  

  

 

  

Go back to the Main Menu 

D. Issue Additional Information Notice, if any 

To issue notice for additional information from the taxpayer, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (Additional Information/Adjournment) issued against the case 

created.  

2. Click ADD NOTICE to open the drop-down list and select ADDITIONAL INFORMATION. 

  



 

 

 

  

3. The ADDITIONAL INFORMATION page is displayed. 

  

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. In case personal hearing is required, select the Is Personal Hearing Required checkbox . 

6. Select the Personal Hearing Date using the calendar. 

7. Select the Personal Hearing Time . 

8. In the Venue field, enter the name of the place where you would like to call the taxpayer for personal 

hearing.   

9. Select the Due Date to reply using the calendar. 



 

 

10. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

notice. 

11. Click PREVIEW and a system-generated draft notice of personal hearing gets downloaded into your 

machine as displayed. 

  

 

  

12. Check the system-generated draft notice carefully to rule out any discrepancy. 

  



 

 

 

  

13. Go back to the Notice page. Click PROCEED button.  

  



 

 

 

  

14. Click ISSUE with DSC.  

  

 

  

15. The Dashboard page is displayed with the following confirmation message. Click OK.  

  



 

 

 

  

16. The updated Case Detail page is displayed, with the table containing the record of the personal 

hearing just issued and the Status updated to "Pending for Reply by Taxpayer". Also, system would send 

the intimation to the Taxpayer via email and SMS, and make this personal hearing notice available on the 

Taxpayer's dashboard.  

  

 

  

Go back to the Main Menu 

E. View Replies by the Taxpayer 

To view replies submitted by the taxpayer, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the REPLIES tab. This tab displays all 

replies filed by the Taxpayer. 

2. Click the documents in the Attachments section to download and ascertain their contents.  

  



 

 

 

  

Go back to the Main Menu 

F. Issue an Adjournment, if needed 

To update adjournment details, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (Additional Information/Adjournment) issued against the case 

created.  

2. Click ADD NOTICE to open the drop-down list and select ADJOURNMENT. 

  

 

  

3. The ADJOURNMENT page is displayed. 



 

 

  

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. In case personal hearing is required, select the Is Personal Hearing Required checkbox. 

6. Select the Personal Hearing Date using the calendar. 

7. Select the Personal Hearing Time . 

8. In the Venue field, enter the name of the place where you would like to call the taxpayer for personal 

hearing.   

9. Select the Due Date to reply using the calendar. 

10. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

notice. 

11. Click PROCEED button.  

  



 

 

 

  

12. A success message is displayed. Click CONTINUE button.  

  

 

  

13. The updated Case Detail page is displayed, with the table containing the record of the adjournment 

just issued. Also, system would send the intimation to the Taxpayer via email and SMS, and make this 

adjournment notice available on the Taxpayer's dashboard.   

  



 

 

 

  

Go back to the Main Menu 

G. Add Personal Hearing Proceedings 

To add details of personal hearing, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the PROCEEDINGS tab if it is not selected 

by default. 

2. Click ADD PROCEEDINGS to open the drop-down list and select PERSONAL HEARING. 

  

 

  

3. The PROCEEDINGS page is displayed. 



 

 

  

 

  

4. Select the Date of personal hearing using the calendar. 

5. Click Choose File to upload the document(s) related to personal hearing from your machine.  

6. Click SUBMIT button.  

  

 

  



 

 

7. The updated Case Detail page is displayed, with the table containing the record of the proceedings.  

  

 

  

Go back to the Main Menu 

H. Send Internal Communication 

To upload documents, related to internal communication within Tax officials, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the INTERNAL COMMUNICATION tab if it 

is not selected by default. This tab displays all communications sent against the case created.  

2. Click TYPE OF COMMUNICATION to open the drop-down list and select Commissioner/ competent 

Authority. 

  

 

  

3. The Internal Communication page is displayed. 

  



 

 

 

  

4. Select the Status from the drop-down list. 

Note: 

1. Tax Officer needs to upload communication sent for approval, to issue restoration order to 

Commissioner/ Competent authority (by email) and select the status as ‘‘Pending for approval’.  

2. On receipt of request for approval to issue restoration order, Commissioner/ Competent authority will 

give his comments and can choose to any one of following option (by email): 

 Approve the request 

 Reject the request 

 Seek Additional Information on the matter. 

3. In case, additional information is sought by Commissioner/ Competent authority and request for 

seeking additional information is received by officer on email then: 

 Tax Officer will upload such email. 

 Tax Officer will update the status as ‘Pending for clarification by Tax Officer'.  

 Accordingly, Tax Officer will provide required information to Commissioner/ Competent 

authority on email.  

 Tax Officer will then upload clarification email and update the status as ‘Pending for 

approval on restoration’. 

4. If request for restoration of provisional attachment is not allowed by Commissioner/ Competent 

authority (by email), then: 

 Tax Officer will upload the rejection email. 



 

 

 Update the status as ‘Proposal for restoration rejected’.  

 Status of ARN will be changed to ‘Proposal for restoration rejected’.  

5. If request for restoration provisional attachment is allowed by Commissioner/ Competent authority (by 

email), then: 

 Tax Officer will upload the approval email. 

 Update the status as ‘Approval granted, pending for restoration order by tax officer’. 

 Status of ARN will be changed to ‘Approval granted, pending for restoration order'.  

  

 

  

5. Click the Choose File button to upload any attachment. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application. 

  

6. Click the SUBMIT button. 

  



 

 

 

  

7. The updated Case Detail page is displayed, with the table containing the record of the communication 

sent. 

  

 

  

Go back to the Main Menu 

I. Upload Communication 



 

 

To upload documents, which have been used to communicate with taxpayer offline, perform following 

steps: 

  

1. On the Case Detail page of that particular taxpayer, select the REFERENCES tab if it is not selected 

by default. This tab displays all communications sent against the case created.  

2. Click ADD REFERENCE to open the drop-down list and select COMMUNICATION. 

  

 

  

3. The Communication page is displayed. 

  

 

  



 

 

4. Select the Notice/Order/Reminder Reference Number from the drop-down list. 

5. Select the Type of Communication from the drop-down list. 

  

 

  

6. Select the Issue Date and Communication Date using the calendar. 

7. Click the Choose File button to upload any attachment. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

8. Click the SUBMIT button.  

  

 

  

9. The updated Case Detail page is displayed, with the table containing the record of the communication 

sent. 

  



 

 

 

  

Go back to the Main Menu 

J. Upload References of Case 

To upload any additional documents or communication related to the case, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the REFERENCES tab if it is not selected 

by default. This tab displays all communications sent against the case created.  

2. Click ADD REFERENCE to open the drop-down list and select REFERENCES OF CASE. 

  

 

  

3. Click the Choose File button to upload any attachment. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

4. Click the SUBMIT button.  



 

 

  

 

  

5. The updated Case Detail page is displayed, with the table containing the record of the reference of 

case. 

  

 

  

Go back to the Main Menu 

K. Issue Order of Provisional Attachment Restoration Order - DRC-23 

To issue Order of Provisional Attachment Restoration Order - DRC-23, perform following steps: 

  



 

 

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab if it is not selected by 

default. This tab displays a table of all the records for which you would issue orders against the case 

created.  

2. Click ADD ORDER to open the drop-down list and select Order of provisional attachment 

restoration DRC-23. 

  

 

  

3. The Provisional Attachment Order page is displayed. 

  



 

 

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. Select the Provisional Attachment Order No. from the drop-down list. Note that Date of Order, Type 

of Attachment, name, address and designation of the authority/ bank gets auto-populated.  

Note: In case of request from taxpayer for restoration of provisional attachment, select the checkbox for 

On request of taxpayer and select the date on which restoration is applied by the taxpayer. 

  

 

  

6. Click the Choose File button to upload any attachment. 

Note: 



 

 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

7. Click PREVIEW and a system-generated draft order gets downloaded into your machine as displayed.  

  

 

  

8. Check the system-generated draft order carefully to rule out any discrepancy. 

  



 

 

 

  

9. Click PROCEED button.  

  



 

 

 

  

10. Click ISSUE with DSC.  

  

 



 

 

  

11. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

12. The updated Case Detail page is displayed, with the table containing the record of the order just 

issued. 

Note:  

 Status of order is changed to "Restoration Order Issued". 

 Order of restoration of provisional attachment will be generated and it will be served to bank/ post 

office/ financial institution/ immovable property registering authority by post. 

 Proof of delivery must be updated on GST Portal in the References tab.  

  

 

  

Go back to the Main Menu 

L. Issue Restoration Rejection Order  

To issue Restoration Rejection Order, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab if it is not selected by 

default. This tab displays a table of all the records for which you would issue orders against t he case 

created.  

2. Click ADD ORDER to open the drop-down list and select Restoration Rejection. 

  



 

 

 

  

3. The Restoration Rejection page is displayed. 

  

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. Click the Choose File button to upload any attachment. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

6. Click PREVIEW and a system-generated draft order gets downloaded into your machine as displayed.  



 

 

  

 

  

7. Check the system-generated draft order carefully to rule out any discrepancy. 

  



 

 

 

  

8. Click PROCEED button.  

  



 

 

 

  

9. Click ISSUE with DSC.  

  

 

  

10. The Dashboard page is displayed with the following confirmation message. Click OK.  

  



 

 

 

  

11. The updated Case Detail page is displayed, with the table containing the record of the order just 

rejected. 

Note:  

 Status of order is changed to "Proposal for restoration rejected".  

 System would send the intimation to the taxpayer via email and SMS, and make this order 

available on the Taxpayer's dashboard.  

  

 

  

Go back to the Main Menu 



 

 

Tax collected but not deposited with Government 

FAQs > Assessment/ Adjudication for Tax 
collected but not deposited with Government 

1. I am not getting Tax collected but not deposited link in my Dashboard. 

Why? 

You may not have been assigned the role of Adjudicating Authority by the State Admin. You may request 

your State Admin to allocate you the role of Adjudicating Authority. Once the role is assigned, you will be 

allocated "Tax collected but not deposited" link module for further action. 

  

Click here to learn about the various roles available in Tax Officials Interface and how Admin can assign 

the role to Tax Officials. 

2. When can I conduct Assessment/ Adjudication on a taxable person for 

collecting the tax but not depositing with the Government? 

Any person whether registered or unregistered who had collected any amount representing the tax from 

other person, but failed to pay/credit this amount to the Government, will be liable to pay such amount. 

Action can be initiated by the tax officials under the head Assessment/ Adjudication of Tax collected but 

not deposited with Government, against such person, by issuing notice requiring him to show cause why 

the said amount should not be paid by him to Government. 

3. How can I issue a notice? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Tax collected but not deposited > Search ARN Page (List of 

Application/ Case Reference number > Case Detail > NOTICES  option. 

4. Where can the taxpayers view the notice issued to them? 

After logging in to the GST portal, the taxpayers can navigate to Services > User Services > Additional 

Notices & Order option to view the notice issued to them. Taxpayers with temporary ID can navigate to 

same option to view notices. However, taxpayers with temporary ID cannot reply to notice and personal 

hearing is mandatory for them. 

4. How can I issue notice to unregistered person? 



 

 

Tax Official has to first issue him a Temporary Id by initiating Suo Moto Proceeding. Then, Temporary Id 

can be used for generating notices against such unregistered person.  

Note: To know more on how to create a Temporary ID, refer to the Suo Moto Registration User Manual.  

5. Does a taxpayer get any intimation about the notice or order issued to 

them? 

Taxpayer will get intimation of all notices and orders issued to them though SMS and e-mail. Tax Official 

can send the notice by post or through special messenger also.  

6. Where can I view the reply filed by the taxpayers? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Tax collected but not deposited > Search ARN Page (List of 

Application/ Case Reference number> Case Detail > REPLIES option. 

7. What are the next steps after a taxpayer has replied to the notice? 

If reply to notice furnished by taxable person within 15 days or extended period is found satisfactory, then 

proceedings can be dropped by the officer by issuing an order to that effect and no further action will be 

taken in this regard. GST Portal will send the intimation of the order to the taxpayer via email and SMS, 

and make this order available on the Taxpayer's dashboard.  

  

If reply to notice furnished by taxable person within 15 days or extended period is not found satisfactory, 

then officer may issue the order confirming demand of such amount against such person on Back Office 

interface of GST portal. GST Portal will send the intimation of the order of creation of demand to the 

taxpayer via email and SMS, and make this order available on the Taxpayer's dashboard. Debit entry will 

get generated in Electronic Liability Register of the taxpayer.  

8. What is the next step if a taxpayer neither replies to notice within time 

specified in notice nor attends personal hearing? 

In such a case, you can issue a reminder to the taxpayer. Maximum three reminders can be issued. If the 

taxpayer neither replies to notice within time specified in notice, nor attends personal hearing even after 

issue of reminder(s), an Order can be issued. 

9. In case I need to upload additional documents related to a particular 

case on the GST Portal, where do I upload? 



 

 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Tax collected but not deposited > Search ARN Page (List of 

Application/ Case Reference number > Case Detail > REFERENCES  option. 

10. How can I issue an adjournment? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Tax collected but not deposited > Search ARN Page (List of 

Application/ Case Reference number > Case Detail > NOTICES > ADJOURNMENT  option. 

11. How many Reminders do I need to issue to a taxpayer after the issue of 

SCN? 

After the issue of SCN, you can send upto 3 Reminders. Once you have issued 3 Reminders, system 

would not allow you to send any more reminders. 

12. Can I issue first reminder again? 

No, you cannot issue first reminder again. When issuing second reminder, the system will not allow you to 

select ‘1’ from the drop-down list of the "Reminder No." field-box and will display a following red message 

below the box: "Reminder no. 1 already issued." 

13. How can I issue an order? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Tax collected but not deposited > Search ARN Page (List of 

Application/ Case Reference number > Case Detail > ORDERS  option. 

14. What are the various status of the applicat ion/case ID for Assessment/ 

Adjudication for Tax collected but not deposited with Government? 

The list below provides the list of statuses of the application/case ID for Assessment/ Adjudication for Tax 

collected but not deposited with Government: 

  

1. Pending for action by tax officer - Status of ARN/Case ID upon recommendations received  

2. Pending for reply by taxpayer - Status of ARN/ RFN upon issue of notice to taxpayer to seek 

clarification  

3. Reply furnished, pending for order by tax officer - Status of ARN/ RFN upon reply furnished or personal 

hearing  



 

 

4. Reply not furnished, pending for order  - Status of ARN/ RFN, if person does not attend Personal 

Hearing on date specified in SCN or extended date or does not give reply  

5. Order for dropping proceedings issued  - Status of ARN/ RFN upon proceedings dropped  

6. Order for creation of demand issued  - Status of ARN/ RFN upon issue of order  

7.Time limit of issue of order expired - Status of ARN/ RFN if period of 1 year has expired from date of 

issue of notice  

8. Demand created - Status of demand Upon issuance of order (Assessment order and GST DRC-07) by 

tax officer  

15. What is the difference between Communication and References tab?  

Communication tab is used to upload documents which have been used to communicate to taxpayer 

offline. 

References tab is used to upload additional documents or communication related to the case.  

16. In case notice/order, etc. is issued by post/special messenger, where do 

I update details of the case? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Tax collected but not deposited > Search ARN Page (List of 

Application/ Case Reference number > Case Detail > REFERENCES > COMMUNICATION option. 

17. In case I need to upload additional documents (invoices, offline 

calculations, etc.) related to a particular case on the GST Portal, where do I 

upload? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Tax collected but not deposited > Search ARN Page (List of 

Application/ Case Reference number> Case Detail > REFERENCES > REFERENCES OF CASE 

option. 



 

 

 

Manual > Assessment/ Adjudication for tax 
collected but not deposited with Government 

How can I conduct Assessment/ Adjudication for tax collected but not 

deposited with Government for a taxpayer? 

To conduct Assessment/ Adjudication for tax collected but not deposited with Government, in the role of 

Adjudicating Authority, perform following steps: 

  

A. Create a new case ID using  

 A (1) Suo-Moto Proceedings 

 A (2) Search for the ARN (Application Reference Number)/GSTIN/Status/Period 

B. Issue notice to the taxpayer 

C. View Replies furnished by the Taxpayer 

D. Issue an Adjournment, if needed 

E. Issue a reminder, if needed 

F. Add Personal Hearing Proceedings 

G. Upload Communication 

H. Upload References of Case 

I. Issue Order 

 I (1) Assessment Order - DRC-07 

 I (2) Issue Order for Dropping Proceedings 

  

Click each hyperlink above to know more. 

A (1). Initiate Suo-Moto Proceedings for conducting Assessment/ 

Adjudication for Tax collected but not deposited with Government 

1. Access the GST Back Office Portal for tax officials. 

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > Tax collected but not deposited  

option. 

  



 

 

 

  

4. The Search page is displayed. 

5. Click the SUO MOTO PROCEEDING button. 

  

 

  

6. The Suo Moto page is displayed. The “Proceeding Type” field gets auto-populated.  

  

 

  

7. Enter the GSTIN or UIN or Temporary Id of the taxpayer. 

Note: To create Temporary Id of an unregistered taxpayer, you can click the Click here hyperlink 

provided on the left-below side of the page. To know more on how to create a Temporary ID, refer to the 

Suo Moto Registration User Manual.  

  



 

 

8. Click the GO button. This will enable the CREATE button.  

9. Select the Financial Year from the drop-down list. 

10. Select the Tax Period from the From and To drop-down lists. 

11. Click the CREATE button. 

  

 

  

12. A success message is displayed and ARN/ Case ID is created and displayed on the screen. Click 

CONTINUE. 

  

 

  

13. Tax collected but not deposited Case Detail page is displayed. From this page, you can initiate 

proceedings for conducting Assessment/ Adjudication by operating on the tabs provided at the left-hand 

side of the page: NOTICES, REPLIES, PROCEEDINGS, ORDERS and REFERENCES.  

  



 

 

 

  

Or, you can also search the Tax collected but not deposited application page by either searching for 

the ARN (Application Reference Number)/Case ID/GSTIN/Status/Period by navigating to Statutory 

Functions > Assessment/Adjudication > Tax collected but not deposited option. 

  

Go back to the Main Menu 

A (2). Go to Tax collected but not deposited application page by either 

searching for the ARN (Application Reference 

Number)/GSTIN/Status/Period 

1. Access the GST Back Office Portal for tax officials. 

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > Tax collected but not deposited 

option. 

  

 

  

4. Search page is displayed. Choose any one of the four displayed fields as your search criteria and enter 

the required information: ARN/Case ID, GSTIN, Status or Period From and Period To Date. 

Note: You must enter data in at least one field to proceed.   

  



 

 

 

  

5. Click the SEARCH button. 

  

 

  

6. Based on your search criteria, the required ARN(s) gets displayed. Click the ARN hyperlink of the case 

you want to act on.   

  



 

 

 

  

7. Tax collected but not deposited Case Detail page is displayed. From this page, you can initiate 

proceedings for conducting Assessment/ Adjudication by operating on the tabs provided at the left-hand 

side of the page: NOTICES, REPLIES, PROCEEDINGS, ORDERS and REFERENCES.  

  

 

  

Go back to the Main Menu 

B. Issue Notice to the Taxpayer 

To issue notice to the taxpayer, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (SCN/Reminder/Adjournment) issued against the case created.  

2. Click ADD NOTICE to open the drop-down list and select SCN u/s 76 and GST DRC-01. 

  



 

 

 

  

3. The SCN page is displayed. The Type and Section Number fields are auto-populated.  

Note: Before issuing the notice, if required, you can also refer to the following hyperlinks provided on the 

right-side of the page to view various details:  

 MIS Reports: Contains all available MIS Reports.  

 Tax Liability: Contains details of estimated tax liabilities of current tax period as updated from 

Form GSTR-1, 1A and Form GSTR-2, 2A  

 Tax Return History: Contains details of the returns of the previous tax periods, and also option 

to view any other return of the defaulter.  

  



 

 

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. In case personal hearing is required, select the Is Personal Hearing Required checkbox . 

Note: Taxpayers with temporary ID cannot reply to notice and personal hearing is mandatory for them.  

6. Select the Personal Hearing Date using the calendar. 

7. Select the Personal Hearing Time . 

8. In the Venue field, enter the name of the place where you would like to call the taxpayer for personal 

hearing.   

9. Select the Due Date to reply using the calendar. 

10. In the Act/ Rules Provisions field, enter the name of the act or rule provision. 

11. Select the From and To drop-down lists of the Tax period field.  

  



 

 

 

  

12. Scroll to the right and enter the tax details.  

  



 

 

 

  

13. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

notice. 

  

 

  

14. Click PREVIEW and a system-generated draft notice of personal hearing gets downloaded into your 

machine as displayed. 

  



 

 

 

  

15. Check the system-generated draft notice carefully to rule out any discrepancy. 

  



 

 

 

  

16. Go back to the Notice page. Click PROCEED button.  

  



 

 

 

  

17. Click ISSUE with DSC.  

  



 

 

 

  

18. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

19. The updated Case Detail page is displayed, with the table containing the record of the personal 

hearing just issued and the Status updated to "Pending for Reply by Taxpayer". Also, system would send 

the intimation to the Taxpayer via email and SMS, and make this personal hearing notice available on the 

Taxpayer's dashboard.  

  

 

  

Go back to the Main Menu 



 

 

C. View Replies furnished by the Taxpayer 

To view replies submitted by the taxpayer, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the REPLIES tab. This tab displays all 

replies filed by the Taxpayer. 

2. Click the documents in the Attachments section to download and ascertain their contents.  

  

 

  

Go back to the Main Menu 

D. Issue an Adjournment, if needed 

To update adjournment details, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (SCN/Reminder/Adjournment) issued against the case created.  

2. Click ADD NOTICE to open the drop-down list and select ADJOURNMENT. 

  

 

  

3. The ADJOURNMENT page is displayed. 



 

 

  

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. In case personal hearing is required, select the Is Personal Hearing Required checkbox . 

6. Select the Personal Hearing Date using the calendar. 

7. Select the Personal Hearing Time . 

8. In the Venue field, enter the name of the place where you would like to call the taxpayer for personal 

hearing.   

9. Select the Due Date to reply using the calendar. 

10. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

adjournment. 

11. Click ISSUE button.  

  



 

 

 

  

12. A success message is displayed. Click CONTINUE button.  

  

 

  

13. The updated Case Detail page is displayed, with the table containing the record of the adjournment 

just issued. Also, system would send the intimation to the Taxpayer via email and SMS, and make this 

adjournment notice available on the Taxpayer's dashboard.   

  



 

 

 

  

Go back to the Main Menu 

E. Issue a Reminder, if needed 

To issue a reminder to the taxpayer, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (SCN/Reminder/Adjournment) issued against the case created.  

2. Click ADD NOTICE to open the drop-down list and select REMINDER. 

  

 

  

3. The REMINDER page is displayed. 

  



 

 

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. In case personal hearing is required, select the Is Personal Hearing Required checkbox . 

6. Select the Personal Hearing Date using the calendar. 

7. Select the Personal Hearing Time . 

8. In the Venue field, enter the name of the place where you would like to call the taxpayer for personal 

hearing.   

9. Select the Due Date to reply using the calendar. 

10. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

adjournment. 

11. Select the Reminder Number from the drop-down list. You can issue maximum of 3 reminders to the 

taxpayer. 

12. Click PREVIEW and a system-generated draft notice of personal hearing gets downloaded into your 

machine as displayed. 

  



 

 

 

  

13. Check the system-generated draft reminder carefully to rule out any discrepancy. 

  



 

 

 

  

14. Click PROCEED button.  

  



 

 

 

  

15. Click the ISSUE WITH DSC button.  

  

 

  

16. A success message is displayed. Click CONTINUE button.  

  



 

 

 

  

17. The updated NOTICES tab is displayed, with the record of the issued Reminder and with the Status 

updated to "Reminder No.1 issued". . Also, system would send the intimation to the Taxpayer via email 

and SMS, and make this adjournment notice available on the Taxpayer's dashboard.   

Note: You can issue upto three reminders only against a particular case.  

  

 

  

Go back to the Main Menu 

F. Add Personal Hearing Proceedings 

To add details of personal hearing, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the PROCEEDINGS tab if it is not selected 

by default. 

2. Click ADD PROCEEDINGS to open the drop-down list and select PERSONAL HEARING. 

  



 

 

 

  

3. The PROCEEDINGS page is displayed. 

  

 

  

4. Select the Date of personal hearing using the calendar. 

5. In the Proceeding for the day field, enter the details of the proceedings recorded. 

6. Click Choose File to upload the document(s) related to personal hearing from your machine. 

7. Click SUBMIT button.  

  



 

 

 

  

8. The updated Case Detail page is displayed, with the table containing the record of the proceedings. 

  

 

  

Go back to the Main Menu 

G. Upload Communication 

To upload any references for communication, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the REFERENCES tab if it is not selected 

by default. This tab displays all communications sent against the case created.  

2. Click ADD REFERENCE to open the drop-down list and select COMMUNICATION. 

  



 

 

 

  

3. The Communication page is displayed. 

  

 

  

4. Select the Notice/Order/Reminder Reference Number from the drop-down list. 

5. Select the Type of Communication from the drop-down list. 

  

 

  

6. Select the Communication Date  using the calendar. 



 

 

7. Click the Choose File button to upload any attachment. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

8. Click the SUBMIT button.  

  

 

  

9. The updated Case Detail page is displayed, with the table containing the record of the communication 

sent. 

  

 

  

Go back to the Main Menu 



 

 

H. Upload References of Case 

To upload any references for case, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the REFERENCES tab if it is not selected 

by default. This tab displays all communications sent against the case created.  

2. Click ADD REFERENCE to open the drop-down list and select REFERENCES OF CASE. 

  

 

  

3. Click the Choose File button to upload any attachment. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

4. Click the SUBMIT button.  

  

 

  



 

 

5. The updated Case Detail page is displayed, with the table containing the record of the reference of 

case. 

  

 

  

Go back to the Main Menu 

I (1). Issue Assessment Order and Summary in Form GST DRC-07 

To issue Assessment Order and summary in Form GST DRC-07, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab if it is not selected by 

default. This tab displays a table of all the records for which you would issue orders against the case 

created.  

2. Click ADD ORDER to open the drop-down list and select Assessment order and GST DRC-07. 

  

 

  

3. The Assessment Order page is displayed. 

  



 

 

 

  

4 (a). Order tab 

  

4.1 Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

4.2. Enter the name of Acts or Rules provisions. 

4.3. Select the due date of payment using the calendar. 

4.4. Click CONTINUE. 

  



 

 

 

  

4 (b). Details of Goods and Services tab 

  

4.5. Under Goods tab, in the Search HSN Chapter field, enter the HSN Code. HSN Code is successfully 

added. 

  



 

 

 

  

4.6. Under Services tab, in the Search SAC field, enter the SAC Code. SAC Code is successfully added. 

4.7. Click CONTINUE. 

  

 

  

4 (c). Details of Demand tab 

  



 

 

4.8. Enter the details of demand like the tax rate, turnover, Place of Supply, relevant Act, tax interest etc. 

4.9. Scroll to the right to enter tax details. 

  

 

  

4.10. Enter the tax, interest, penalty and other details. 

4.11. Click the ADD button to insert more information in case of goods/services having more than one tax 

rates, place of supply, etc. 

4.12. Click CONTINUE. 

  



 

 

 

  

4 (d). Attach Documents tab 

  

4.13. Click the Choose File button and attach document. 

4.14. You can preview the order before issuing to the taxpayer, by clicking the PREVIEW button. 

  

 

  



 

 

5. The summary of the order is downloaded in PDF format. 

  

 

  

6. Click PROCEED button.  

  



 

 

 

  

7. Click ISSUE with DSC.  

  

 

  

8. The Dashboard page is displayed with the following confirmation message. Click OK.  

  



 

 

 

  

9. The updated Case Detail page is displayed, with the table containing the record of the order just 

issued. 

Note:  

 Status of order is changed to "Order of creation of demand issued". 

 Intimation of issue of order is sent to email id and SMS of taxpayer as well as order will appear at 

the dashboard of the taxpayer. 

 Demand ID is created. 

 Electronic liability register and DCR is updated with the demand specified in order. 

  

 

  

Go back to the Main Menu 

I (2). Drop Proceedings 

To drop proceedings order, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab.  

2. Click ADD ORDER to open the drop-down list and select DROP PROCEEDING. 

  



 

 

 

  

3. The DROP PROCEEDING page is displayed. 

  

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. Enter the Name of Acts or Rules provisions. 

6. Click the Choose File button to upload any attachment. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

7. Click PREVIEW and a system-generated draft order gets downloaded into your machine as displayed.  

  



 

 

 

  

8. Check the system-generated draft order carefully to rule out any discrepancy. 

  

 



 

 

  

9. Click PROCEED button.  

  

 

  

10. Click ISSUE with DSC.  

  

 

  

11. The Dashboard page is displayed with the following confirmation message. Click OK.  

  



 

 

 

  

12. The updated Case Detail page is displayed, with the table containing the record of the DROP 

PROCEEDING Order just issued and the Status updated to "Order for dropping proceedings issued". 

  

 

  

Go back to the Main Menu 



 

 

Provisional Assessment and Release of Security 

FAQs > Provisional Assessment and Release 
of Security 

1. I am not getting Provisional Assessment link in my Dashboard. Why? 

You may not have been assigned the role of Adjudicating Authority by the State Admin. Request your 

State Admin to allocate you the role of Adjudicating Authority. Once the role is assigned, you will be 

allocated Provisional Assessment link for further action. 

  

Click here to learn about various roles available in Tax Officials Interface and how Admin can assign the 

role to Tax Officials. 

2. What is Provisional Assessment? 

If taxpayer is unable to determine either the value or tax rate or both for the goods/ services dealt in, then 

he/ she can file an application for provisional assessment to the Tax Official.  

3. What are the steps involved in disposing the application for provisional 

assessment and release of security? 

Steps for disposing the application for provisional assessment and release of security is explained below: 

  

1. Filing of application for provisional assessment by taxpayer in Form GST ASMT-01 

2. Issue of notice for seeking additional information in Form GST ASMT-02 

3. Furnishing of reply by taxpayer in Form GST ASMT-03 to the notice issued in Form GST ASMT-02 

4. Issue of order accepting the Provisional Assessment in Form GST ASMT-04 prescribing security and 

bond therein or to Reject the application 

5. Furnishing of security and bond by taxpayer in Form GST ASMT-06 & taxpayer to physically handover 

the Bank Guarantee and bond to Tax official  

6. Acceptance of security by Tax Officer, Process of correction of security, Resubmission of Security 

7. Taxpayer can start selling the goods or providing the services as per Provisional Assessment Order 

and pay the tax amount as per rate or valuation mentioned in Provisional Assessment Order.  

8. After period of provisional assessment is over, notice for seeking clarification in Form GST ASMT-06 to 

be issued to seek clarification for issue of final assessment order 

9.  Seeking extension of AC/JC for a period of six months if order is not issued within six months of issue 

of provisional order in Form GST ASMT-04 

10.  Further extension of Commissioner can be sought if order is not being issued within extended period 



 

 

11. Issue of Final Assessment order in Form GST ASMT-07 

12. Taxpayer to apply for release of security in Form GST ASMT-08 

13. Tax officer to obtain approval of competent authority for release of security  

14. Updation of internal communications 

15. Upload additional documents or communication done with the taxpayer related to the case from time 

to time 

16. Issue of order for release of security in Form GST ASMT-09 

17. Tax Official to physically handover the Bank Guarantee and bond to taxpayer 

4. How can I conduct provisional assessment initiated by a taxpayer? 

To dispose the application for provisional assessment, perform following steps:  

  

1. Login and search Provisional Assessment cases 

 1.1. Log into the GST Back Office Portal and navigate to Statutory Functions > 

Assessment/Adjudication > Provisional Assessment option. 

 1.2. Enter the search criteria and based on your search criteria, the required ARN(s) gets  

displayed. Click the ARN hyperlink of the case you want to act upon.   

 1.2. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > APPLICATIONS to view the application/ information and its 

attachments in PDF mode.  

  

2. Issue Additional Information Notice GST ASMT-02 for Provisional Assessment 

 2.1. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > NOTICES > ADDITIONAL INFORMATION GST ASMT-02 to 

issue notice to taxpayer asking for any additional information, if required. 

  

3. Issue Provisional Assessment order / Rejection Order 

 3.1. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > REPLIES > to view reply from the taxpayer. 

 3.2. Upon receipt of reply from taxpayer, navigate to Statutory Functions > 

Assessment/Adjudication > Provisional Assessment > Case Details > ORDERS > 

PROVISIONAL ASSESSMENT ORDER GST ASMT-04 to issue the order of provisional 

assessment in Form GST ASMT-04. 

OR 

 3.3. Upon receipt of reply from taxpayer or non-reply, navigate to Statutory Functions > 

Assessment/Adjudication > Provisional Assessment > Case Details > ORDERS > 

REJECTION ORDER to reject the order. 

  

4. Accept the furnished security 



 

 

 4.1. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > SECURITY to view the security furnished by the taxpayer. 

 4.2. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > ORDERS > PROVISIONAL FURNISHED SECURITY 

MODIFIED to modify the security furnished by the taxpayer, if required. 

 4.3. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > ORDERS > PROVISIONAL FURNISHED SECURITY 

RESUBMIT to resubmit the security furnished by the taxpayer, if required. 

 4.4. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > ORDERS > PROVISIONAL FURNISHED SECURITY 

ACCEPT to accept the security furnished by the taxpayer. 

  

5. Issue Additional Information Notice GST ASMT-06 for Final Assessment 

  

 5.1. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > NOTICES > ADDITIONAL INFORMATION GST ASMT-06 to 

issue notice to taxpayer for any additional information, if required.  

 5.2. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > REPLIES > to view reply from the taxpayer. 

 5.3. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > NOTICES > REMINDER to issue reminder to taxpayer, if 

required. 

 5.4. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > NOTICES > ADJOURNMENT to issue adjournment to 

taxpayer, if required. 

 5.5. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > PROCEEDINGS to add proceeding details. 

  

6. Upload Internal Communication 

 6.1. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > INTERNAL COMMUNICATION to upload communication 

sent for approval of extension of limitation period for issuing Final assessment Order.  

 6.2. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > INTERNAL COMMUNICATION to upload the clarification 

email from Commissioner/ Competent authority or AC/JC. 

 6.3. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > INTERNAL COMMUNICATION to upload the approval email 

from Commissioner/ Competent authority or AC/JC. 

 6.4. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > INTERNAL COMMUNICATION to upload the rejection email 

from Commissioner/ Competent authority or AC/JC. 



 

 

  

7. Issue provisional assessment order / Rejection Order 

 7.1. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > ORDERS > FINAL ASSESSMENT ORDER GST ASMT-07 to 

issue the final assessment order GST ASMT-07.  

OR 

 7.2. Upon receipt of reply from taxpayer or non-reply, navigate to Statutory Functions > 

Assessment/Adjudication > Provisional Assessment > Case Details > ORDERS > 

REJECTION ORDER to reject the order. 

  

8. Issue Additional Information Notice for Release of Security 

 8.1. Upon receiving application from taxpayer for release of security, navigate to Statutory 

Functions > Assessment/Adjudication > Provisional Assessment > Case Details > 

NOTICES > ADDITIONAL INFORMATION FOR RELEASE OF SECURITY to issue notice for 

additional information for release of security to the taxpayer, if required. 

  

9. Upload Internal Communication 

 6.1. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > INTERNAL COMMUNICATION to upload communication 

sent for approval to issue release order . 

 6.2. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > INTERNAL COMMUNICATION to upload the clarification 

email from Commissioner/ Competent authority or AC/JC. 

 6.3. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > INTERNAL COMMUNICATION to upload the approval email 

from Commissioner/ Competent authority or AC/JC. 

 6.4. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > INTERNAL COMMUNICATION to upload the rejection email 

from Commissioner/ Competent authority or AC/JC. 

  

10. Release of Security 

 10.1. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > ORDERS > RELEASE OF SECURITY GST ASMT-09 to 

issue the security release order. 

OR 

 10.2. Navigate to Statutory Functions > Assessment/Adjudication > Provisional 

Assessment > Case Details > ORDERS > ORDER OF REJECTION AGAINST RELEASE 

OF SECURITY to reject the security release order. 

5. From where can I issue notice to the taxpayers? 



 

 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Provisional Assessment > Case Detail > NOTICES option. 

6. From where can I view the reply filed by the taxpayers? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Provisional Assessment > Case Detail > REPLIES option. 

7. From where can I view security details furnished by the taxpayers? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Provisional Assessment > Case Detail > SECURITY option. 

8. From where can I issue orders to the taxpayers? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Provisional Assessment > Case Detail > ORDERS option. 

9. From where can I add additional documents related to Case ID? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Provisional Assessment > Case Detail > REFERENCES option. 

10. Does a taxpayer get any intimation about the notice or order issued to 

them? 

Taxpayer will get intimation about issuance of all notices and orders against his application though SMS 

and e-mail. 

11. How many reminders do I need to issue to a taxpayer after the issue of 

SCN? 

After the issue of SCN, you can issue maximum 3 Reminders on the Portal. Once you have issued 3 

Reminders, system would not allow you to send any other reminder.  

12. By which date Provisional Assessment Order can be issued by a Tax 

Official? 



 

 

If Adjudicating Authority accepts the application for Provisional Assessment, then ‘Provisional 

assessment order’ should be issued within 90 days of filing application, to allow to pay tax on provisional 

basis and Tax Official can specify the amount of bond/ surety required to be furnished. 

  

If Adjudicating Authority rejects the application, then order of rejection needs to be issued.  

13. If Provisional Assessment Order is issued, does a taxpayer need to 

submit the security in offline mode? 

In case, application is accepted and provisional assessment order is issued, taxpayer needs to capture 

the details of security online on GST Portal and also submit it manually to the authority/ Tax Official (both 

online and offline) and can start making payment of tax on the value/tax rate on provisional basis as 

specified in the order. 

14. By which date Final Assessment Order can be issued by Tax Official? 

Final assessment order needs to be issued within 6 months from date of issue of provisional order.  

Period of 6 months may be extended by Additional Commissioner /Joint Commissioner (AC/JC) for a 

further period not exceeding 6 months and by Commissioner/ Competent authority for such further period 

not exceeding 4 years. 

15. What a taxpayer needs to do in case final assessment order determines 

higher rate/ value than provisionally assessed values? 

If final assessment order determines higher rate/ value than provisionally assessed values, then the 

taxpayer needs to deposit the differential tax along with applicable interest.  

16. What a taxpayer needs to do in case final assessment order determines 

lower rate/ value than provisionally assessed values? 

If final assessment order determines lower rate/ value than provisionally assessed, then the taxpayer can 

apply for refund of the excess amount paid. 

17. Is it mandatory to get approval from Commissioner/ Competent 

authority to issue the Final assessment order? 

No, it not mandatory to seek approval for issue of order. Approval of higher authorities is required only to 

seek extension of time for issue of final assessment order. 

18. When can a taxpayer file for release of security? 



 

 

After finalization of provisional assessment process with the issue of final assessment order, taxpayer can 

file application for release of security. Tax Official will verify  the request and check whether the purpose 

for which security was furnished has been accomplished. 

If the purpose is not accomplished, an intimation will be sent to the taxpayer that security cannot be 

released and order for rejecting the application will be issued. 

If purpose is accomplished, then release order will be issued after seeking approval of competent 

authority and Tax Official will handover the security to taxpayer.  

19. What will happen after release of security? 

Once the security is released by Tax Official, online Release order will be generated and intimation of 

issue of order will be sent via email and SMS to taxpayer. Order will also be available at the dashboard of 

taxpayer for view, print and download. 

20. Is it mandatory to get approval from Commissioner/ Competent 

authority to release the security? 

Yes, it is mandatory to get approval from Commissioner/ Competent authority to release the security. 

Approval request needs to be sent via email copy of which will be uploaded by Adjudicating Authority 

under INTERNAL COMMUNICATION tab. 

21. What are the various statuses for Provisional Assessment? 

Various statuses for Provisional Assessment chosen by Tax Official are:  

1. Pending for approval on extension: Status of ARN upon request sent to AC/JC or Commissioner/ 

Competent authority for approval of extension of time period of finalization of provisional assessment for 

finalizing it  

2. Pending for clarification by tax officer on extension : Status of ARN if any clarification is sought by 

AC/JC or Commissioner/ Competent authority  

3. Approval granted, pending for final order: Status of ARN if approval is granted for extension of time 

period by AC/JC or Commissioner/ Competent authority  
4. Proposal for extension Rejected: Status of ARN if approval for extension of time period for finalization 
of provisional assessment is not granted by AC/JC or Commissioner/ Competent authority  

  

Various statuses for Provisional Assessment updated automatically by GST Portal are:  

1. Pending for action by tax officer: Status of ARN when application is in list of applications received for 

provisional assessment and is pending action at the end of tax official 

2. Pending for reply by taxpayer: Status of ARN upon issue of notice to taxpayer to seek clarification and 

reply is awaited from him 

3. Reply furnished, Pending for provisional order: Status of ARN upon reply received from taxpayer and 

case is pending for order at the end of tax official 



 

 

4. Reply not furnished, pending for order: Status of ARN,  if person does not attend PH/ furnish 

explanation on date specified in SCN or Extended date and case is pending for order at the end of tax 

official 

5. Rejected: Status of ARN upon rejection of application by tax official 

6. Provisional order issued, security pending: Status of ARN upon issue of provisional assessment order 

subject to furnishing of security by tax payer 

7. Security furnished, pending approval: Status of ARN upon furnishing of security  and case is pending 

for order at the end of tax official 

8. Security furnished: Status of ARN if Adjudicating Authority accepts the security furnished by taxpayer  

9. Security furnished: Status of ARN if Adjudicating Authority accepts the modified details of security 

furnished by taxpayer  

10. Pending for re-submission of security: Status of ARN if A/A ask for re-submission of security to the 

taxpayer 

11. Pending for final reply by taxpayer: Status of ARN upon issue of notice to taxpayer for final 

clarification for finalizing the provisional assessment   

12. Reply furnished, pending for final order: Status of ARN upon reply received from taxpayer and case is 

pending for order at the end of tax official 

13. Final order issued: Status of ARN upon finalization of provisional assessment by tax official on 

issuance of an order  

22. What are the various statuses for Release of Security?  

Various statuses for Release of Security chosen by Tax Official are:  

  

1. Pending for Approval on release: Status of ARN/Case id upon request sent to Commissioner/  

Competent authority for approval  

2. Pending for clarification by tax officer: Status of ARN/Case id if any clarification is sought by 

Commissioner/ Competent authority  

  

Various statuses for Release of Security updated automatically by GST Portal are:  

1. Pending for action by tax officer on Release: Status of ARN of applications received for withdrawal of 

security  

2. Pending for reply by taxpayer on Release notice: Status of ARN upon issue of notice to taxpayer to 

seek clarification  

3. Reply furnished, pending for order: Status of ARN upon reply received from taxpayer  

4. Approval granted, pending for release order: Status ofARN/Case id if approval is granted by 

Commissioner/ Competent authority  

5. Proposal for release rejected: Status of ARN/Case id if approval is not granted by Commissioner/ 

Competent authority  

6. Order for release of security issued: Status of ARN/Case id upon issue of release order  



 

 

7. Reply not furnished, pending for order: Status of ARN/ Case id and RFN, if person does not attend PH/ 

furnish explanation on date specified in SCN or Extended date  

23. When are the various statuses for Release of Security to be selected by 

a Tax Official? 

As approval from Commissioner is in offline mode, Tax Official has to select the statuses for Release of 

Security. GST Portal will allow the Tax Official to issue release order if and only if the status is changed to 

‘Approval granted, pending for release order’ in internal communication folder i.e. this status has been 

selected by Tax Official. 

24. When can I ask the taxpayer to resubmit the furnished security?  

In case of any discrepancies in security furnished or for any other valid reason, you can issue order to 

resubmit the furnished security to the taxpayer. 

25. What is the difference between Communication and References tab?  

Communication tab is used to upload documents which have been used to communicate to taxpayer 

offline. 

References tab is used to upload additional documents or communication done with the taxpayer related 

to the case. 

26. Who will update the status and upload e-mails received from 

Commissioner/ Competent authority in the Internal Communication tab?  

Adjudicating Authority needs to update the status and upload e-mails received from Commissioner/ 

Competent authority in the Internal Communication tab. 

  



 

 

 

Manual > Provisional Assessment and 
Release of Security 

How can I act on the provisional assessment cases? 

Steps for disposing the application for provisional assessment and release of security is explained below:  

  

1. Filing of application for provisional assessment by taxpayer in Form GST ASMT-01 

2. Issue of notice for seeking additional information in Form GST ASMT-02 

3. Furnishing of reply by taxpayer in Form GST ASMT-03 to the notice issued in Form GST ASMT-02 

4. Issue of order accepting the Provisional Assessment in Form GST ASMT-04 prescribing security and 

bond therein or to Reject the application 

5. Furnishing of security and bond by taxpayer in Form GST ASMT-06 & taxpayer to physically handover 

the Bank Guarantee and bond to Tax official  

6. Acceptance of security by Tax Officer, Process of correction of security, Resubmission of Security 

7. Taxpayer can start selling the goods or providing the services as per Provisional Assessment Order 

and pay the tax amount as per rate or valuation mentioned in Provisional Assessment Order.  

8. After period of provisional assessment is over, Notice for seeking clarification in Form GST ASMT-06 

for issue of final assessment order 

9.  Seeking extension of AC/JC for a period of six months if order is not issued within six months of issue 

of provisional order in Form GST ASMT-04 

10.  Further extension of Commissioner can be sought if order is not being issued within extended period 

11. Issue of Final Assessment order in Form GST ASMT-07 

12. Taxpayer to apply for release of security in Form GST ASMT-08 

13. Tax officer to obtain approval of competent authority for release of security  

14. Updation of internal communications 

15. Upload additional documents or communication done with the taxpayer related to the case from time 

to time 

16. Issue of order for release of security in Form GST ASMT-09 

17. Tax Official to physically handover the Bank Guarantee and bond to taxpayer 

  

To act on the pending provisional assessment cases, in the role of Adjudicating Authority, perform 

following steps: 

  

A. Searching for the pending Provisional Assessment cases 

B. Take action using APPLICATIONS tab of Case Detail page: View Submitted Application by the 

Taxpayer 

C. Take action using NOTICES tab of Case Detail page: Issue Notice to the Taxpayer 



 

 

 C (1). Additional Information in Form GST ASMT-02 

 C (2). Issue a Reminder 

 C (3). Issue an Adjournment 

 C (4). Additional Information in Form GST ASMT-06 

 C (4). Additional Information for Release of Security 

D. Take action using REPLIES tab of Case Detail page: View Replies by the Taxpayer, if any 

E. Take action using PROCEEDINGS tab of Case Detail page: Add Personal Hearing Proceedings 

F. Take action using ORDERS tab of Case Detail page: Issue Order 

 F (1). Issue Provisional Assessment Order in Form GST ASMT-04 

 F (2). Rejection Order 

 F (3). Furnished Security Modified 

 F (4). Furnished Security Resubmit 

 F (5). Furnished Security Accept 

 F (6). Final Assessment Order in Form GST ASMT-07 

 F (7). Release of Security in Form GST ASMT-09 

 F (8). Order of Rejection against Release of Security 

G. Take action using INTERNAL COMMUNICATION tab of Case Detail page:  

 G (1). Upload Internal Communication before Provisional Assessment Order  

 G (2). Upload Internal Communication before Release of Security 

H. Take action using SECURITY tab of Case Detail page: View Security details  

I. Take action using REFERENCES tab of Case Detail page: 

 I (1). Add Communication 

 I (2). Add Reference of Case 

  

Click each hyperlink above to know more. 

A. Go to pending Provisional Assessment cases by searching for the ARN 

(Application Reference Number)/GSTIN/Status/Period 

To go to pending Provisional Assessment cases page, perform following steps:  

  

1. Access the GST Back Office Portal for tax officials. 

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > Provisional Assessment option. 

  



 

 

 

  

4. Search page is displayed. Choose any one of the four displayed fields as your search criteria and enter 

the required information: ARN, GSTIN, Status or Period From and Period To Date. 

Note: You must enter data in at least one field to proceed.   

  

 

  

5. Click the SEARCH button. 

  

 

  



 

 

6. Based on your search criteria, the required ARN(s) gets displayed. Click the ARN hyperlink of the case 

you want to act on.   

  

 

  

7. Provisional Assessment Case Detail page is displayed. From this page, you can initiate proceedings 

for conducting provisional assessment by operating on the tabs provided at the left -hand side of the page: 

APPLICATIONS, NOTICES, REPLIES, PROCEEDINGS, ORDERS, INTERNAL COMMUNICATION, 

SECURITY and REFERENCES. 

  

 

  

Go back to the Main Menu 

B. View Submitted Application by the Taxpayer 

To view application/ document submitted by the taxpayer, perform following steps:  

  



 

 

1. On the Case Detail page of that particular taxpayer, select the APPLICATIONS tab if it is not selected 

by default. This tab displays the entire application, in PDF mode, with all its attachments.  

2. Click the View links under View Documents column to view the application/ information and its 

attachments in PDF mode.  

  

 

  

Go back to the Main Menu 

  

C (1). Additional Information in Form GST ASMT-02 

To issue notice for additional information from the taxpayer on the application filed, perform following 

steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (Additional Information/Reminder/Adjournment) issued against 

the case created.  

2. Click ADD NOTICE to open the drop-down list and select ADDITIONAL INFORMATION GST ASMT-

02. 

  



 

 

 

  

3. The ADDITIONAL INFORMATION GST ASMT-02 page is displayed. 

  

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. In the Acts/ Rules Provisions field, enter the Act or Rule provision detail. 

6. In the Section Number field, enter the section number. 

7. In case personal hearing is required, select the Is Personal Hearing Required checkbox . 

8. Select the Personal Hearing Date using the calendar. 

9. Select the Personal Hearing Time . 



 

 

10. In the Venue field, enter the name of the place where you would like to call the taxpayer for personal 

hearing.   

11. Select the Due Date to reply using the calendar. 

12. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

notice. 

13. Select the relevant document and click the Open button. 

  

 

  



 

 

 

  

13. Click PREVIEW and a system-generated draft notice of additional information gets downloaded into 

your machine as displayed. 

14. Check the system-generated draft notice carefully to rule out any discrepancy. 

  



 

 

 

  

15. Go back to the Additional Information page. Click PROCEED button.  

  



 

 

 

  

16. Click ISSUE with DSC.  

  

 

  

17. The Dashboard page is displayed with the following confirmation message. Click OK.  

  



 

 

 

  

18. The updated Case Detail page is displayed, with the table containing the record of the additional 

information just issued and the Status updated to "Pending for reply by taxpayer". Also, system would 

send the intimation to the taxpayer via email and SMS, and make this additional information notice 

available on the Taxpayer's dashboard.  

  

 

  

Go back to the Main Menu 

C (2). Issue a Reminder 

To issue a reminder to taxpayer who has neither replied to the SCN within time specified nor attended a 

personal hearing, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (Additional Information/Reminder/Adjournment) issued against 

the case created.  

2. Click ADD NOTICE to open the drop-down list and select REMINDER. 

  



 

 

 

  

3. The REMINDER page is displayed. 

  

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. In case, personal hearing is required, select the Is Personal Hearing Required checkbox . 

6. Select the Personal Hearing Date using the calendar. 

7. Select the Personal Hearing Time . 



 

 

8. In the Venue field, enter the name of the place where you would like to call the taxpayer for personal 

hearing.   

9. Select the Due Date to reply using the calendar. 

10. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

notice. 

  

 

  

11. Click PREVIEW and a system-generated draft notice of reminder gets downloaded into your machine 

as displayed. 

12. Check the system-generated draft reminder carefully to rule out any discrepancy. 

  



 

 

 

  

13. Go back to the reminder page. Click PROCEED button.  

  



 

 

 

  

14. Click ISSUE with DSC.  

  

 

  

15. The Dashboard page is displayed with the following confirmation message. Click OK.  

  



 

 

 

  

16. The updated Case Detail page is displayed, with the table containing the record of the reminder just 

issued and the Status updated to "Reminder No. 1 Issued". Also, system would send the intimation to the 

taxpayer via email and SMS, and make this reminder notice available on the Taxpayer's dashboard.  

Note: You can issue only three reminders against a particular case.  

  

 

  

Go back to the Main Menu 

C (3). Issue an Adjournment 

To update adjournment details for a taxpayer who has filed an application of extension offline, perform 

following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (Additional Information/Reminder/Adjournment) issued against 

the case created.  

2. Click ADD NOTICE to open the drop-down list and select ADJOURNMENT. 

  



 

 

 

  

3. The ADJOURNMENT page is displayed. 

  

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. In the Acts/ Rules Provisions field, enter the Act or Rule provision detail. 

6. In case personal hearing is required, select the Is Personal Hearing Required checkbox . 



 

 

7. Select the Personal Hearing Date using the calendar. 

8. Select the Personal Hearing Time. 

9. In the Venue field, enter the name of the place where you would like to call the taxpayer for personal 

hearing.   

10. Select the Due Date to reply using the calendar. 

11. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

notice as has been described earlier. 

12. Click PROCEED button.  

  

 

  

13. A success message popup is displayed. Click CONTINUE.  

  



 

 

 

  

14. The updated Case Detail page is displayed, with the table containing the record of the adjournment 

just issued and the Status updated to "Pending for reply by taxpayer". Also, system would send the 

intimation to the taxpayer via email and SMS, and make this adjournment details available on the 

Taxpayer's dashboard.  

  

 

  

Go back to the Main Menu 

  

C (4). Additional Information in Form GST ASMT-06 

To issue notice for additional information to the taxpayer for seeking any clarification in order to issue final 

assessment order, perform following steps: 

  



 

 

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (Additional Information/Reminder/Adjournment) issued against 

the case created.  

2. Click ADD NOTICE to open the drop-down list and select ADDITIONAL INFORMATION GST ASMT-

06. 

  

 

  

3. The ADDITIONAL INFORMATION GST ASMT-06 page is displayed. 

  



 

 

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. In the Acts/ Rules Provisions field, enter the act or rule provision detail. 

6. In the Section Number field, enter the section number. 

7. In case personal hearing is required, select the Is Personal Hearing Required checkbox . 

8. Select the Personal Hearing Date using the calendar. 

9. Select the Personal Hearing Time . 

10. In the Venue field, enter the name of the place where you would like to call the taxpayer for personal 

hearing.   

11. Select the Due Date to reply using the calendar. 

12. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

notice as has been described earlier. 

  



 

 

 

  

13. Click PREVIEW and a system-generated draft notice of additional information gets downloaded into 

your machine as displayed. 

14. Check the system-generated draft notice carefully to rule out any discrepancy. 

  



 

 

 

  

15. Go back to the Additional Information page. Click PROCEED button.  

  



 

 

 

  

16. Click ISSUE with DSC.  

  

 

  



 

 

17. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

18. The updated Case Detail page is displayed, with the table containing the record of the additional 

information just issued and the Status updated to "Pending for final reply by taxpayer". Also, system 

would send the intimation to the taxpayer via email and SMS, and make this additional information notice 

available on the Taxpayer's dashboard.  

  

 

  

Go back to the Main Menu 

C (5). Additional Information for Release of Security 

To issue notice for additional information for release of security to the taxpayer, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (Additional Information/Reminder/Adjournment) issued against 

the case created.  

2. Click ADD NOTICE to open the drop-down list and select ADDITIONAL INFORMATION FOR 

RELEASE OF SECURITY. 

  



 

 

 

  

3. The Additional Information page is displayed. 

  

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  



 

 

5. In the Acts/ Rules Provisions field, enter the act or rule provision detail. 

6. In the Section Number field, enter the section number. 

7. In case personal hearing is required, select the Is Personal Hearing Required checkbox . 

8. Select the Personal Hearing Date using the calendar. 

9. Select the Personal Hearing Time . 

10. In the Venue field, enter the name of the place where you would like to call the taxpayer for personal 

hearing.   

11. Select the Due Date to reply using the calendar. 

12. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

notice as has been described earlier. 

  

 

  

13. Click PREVIEW and a system-generated draft notice of additional information gets downloaded into 

your machine as displayed. 

14. Check the system-generated draft notice carefully to rule out any discrepancy. 

  



 

 

 

  

15. Go back to the Additional Information page. Click PROCEED button.  

  



 

 

 

  

16. Click ISSUE with DSC.  

  

 



 

 

  

17. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

18. The updated Case Detail page is displayed, with the table containing the record of the additional 

information just issued and the Status updated to "Pending for reply by taxpayer". Also, system would 

send the intimation to the taxpayer via email and SMS, and make this additional information notice 

available on the Taxpayer's dashboard.  

  

 

  

Go back to the Main Menu 

D. View Replies by the Taxpayer, if any 

To view replies submitted by the taxpayer for clarifications seeked by Tax Official, perform following 

steps: 

  

1. On the Case Detail page of that particular taxpayer, select the REPLIES tab. This tab displays all 

replies filed by the Taxpayer. 



 

 

2. Click the documents in the Attachments section to download and ascertain their contents.  

  

 

  

Go back to the Main Menu 

E. Add Personal Hearing Proceedings 

To add details of personal hearing conducted, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the PROCEEDINGS tab if it is not selected 

by default. 

2. Click ADD PROCEEDINGS to open the drop-down list and select PERSONAL HEARING. 

  

 

  

3. The PROCEEDINGS page is displayed. 



 

 

  

 

  

4. Select the Date of personal hearing using the calendar. 

5. Type the required text in the Proceeding for the day field. 

6. Click Choose File to upload the document(s) related to personal hearing from your machine as has 

been described earlier. 

7. Click SUBMIT button.  

  



 

 

 

  

8. The updated Case Detail page is displayed, with the table containing the record of the proceedings. 

  

 

  

Go back to the Main Menu 

F (1). Issue Provisional Assessment Order in Form GST ASMT-04 

To issue Provisional Assessment Order in Form GST ASMT-04, perform following steps: 

  



 

 

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab if it is not selected by 

default. This tab displays a table of all the records for which you would issue orders against the case 

created.  

2. Click ADD ORDER to open the drop-down list and select PROVISIONAL ASSESSMENT ORDER GST 

ASMT-04. 

  

 

  

3. The Provisional Assessment Order page is displayed. 

  



 

 

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. In the Amount of security to be furnished field, enter the amount of security to be furnished by the 

taxpayer. Amount of security to be furnished (in words) field gets auto-populated.  

Note: Mode of Security field is auto-populated.  

6. Select the Due date of furnishing the security using the calendar. 

7. In the Acts/ Rules Provisions field, enter the act or rule provision detail. 

8. Click the Choose File button to upload any attachment as has been described earlier. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

  



 

 

 

  

9. Click PREVIEW and a system-generated draft order gets downloaded into your machine as displayed. 

10. Check the system-generated draft order carefully to rule out any discrepancy. 

  



 

 

 

  

11. Click PROCEED button.  

  



 

 

 

  

12. Click ISSUE with DSC.  

  

 



 

 

  

13. The Dashboard page is displayed with the following confirmation message. Click  OK.  

  

 

  

14. The updated Case Detail page is displayed, with the table containing the record of the order just 

issued and the Status updated to "Provisional order issued, security pending". Also, system would send 

the intimation to the taxpayer via email and SMS, and make this order available on the Taxpayer's 

dashboard.  

  

 

  

Go back to the Main Menu 

  

F (2). Rejection Order for application of provisional assessment 

To issue rejection order in case of application of provisional assessment of the taxpayer, perform 

following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab if it is not selected by 

default. This tab displays a table of all the records for which you would issue orders against the case 

created.  

2. Click ADD ORDER to open the drop-down list and select REJECTION ORDER. 



 

 

  

 

  

3. The Rejection Order against application for provisional assessment page is displayed.  

  

 



 

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. Select the Reason for rejection from the drop-down list. 

  

 

  

6. In the Acts/ Rules Provisions field, enter the act or rule provision detail. 

7. Click the Choose File button to upload any attachment as has been described earlier. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application. 

  

 

  

8. Click PREVIEW and a system-generated draft order gets downloaded into your machine as displayed. 

9. Check the system-generated draft order carefully to rule out any discrepancy. 



 

 

  

 

  

10. Click PROCEED button.  

  



 

 

 

  

11. Click ISSUE with DSC.  

  

 

  

12. The Dashboard page is displayed with the following confirmation message. Click OK.  

  



 

 

 

  

13. The updated Case Detail page is displayed, with the table containing the record of the order just 

issued and the Status updated to "Rejected". Also, system would send the intimation to the taxpayer via 

email and SMS, and make this order available on the Taxpayer's dashboard.  

  

 

  

Go back to the Main Menu 

F (3). Furnished Security Modified 

To issue order for modifying the furnished security to the taxpayer, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab if it is not selected by 

default. This tab displays a table of all the records for which you would issue orders against the case 

created.  

2. Click ADD ORDER to open the drop-down list and select FURNISHED SECURITY MODIFIED. 

  



 

 

 

  

3. The Furnished Security Modified page is displayed. 

  

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. In the Security Amount field, enter the amount of security to be furnished by the taxpayer.  

6. Select the Due date of Re-furnishing the security using the calendar. 



 

 

7. Click the Choose File button to upload any attachment as has been described earlier. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

8. Click PROCEED button.  

  

 

  

9. Click ISSUE with DSC.  

  



 

 

 

  

10. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

11. The updated Case Detail page is displayed, with the table containing the record of the order just 

issued and the Status updated to "Pending for re-submission of security". Also, system would send the 

intimation to the taxpayer via email and SMS, and make this order available on the Taxpayer's  

dashboard.  

  



 

 

 

  

Go back to the Main Menu 

  

F (4). Furnished Security Resubmit 

To issue order to resubmit the furnished security to the taxpayer in case of any discrepancies in security 

furnished, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab if it is not selected by 

default. This tab displays a table of all the records for which you would issue orders against the cas e 

created.  

2. Click ADD ORDER to open the drop-down list and select FURNISHED SECURITY RESUBMIT. 

  



 

 

 

  

3. The Furnished Security Resubmit page is displayed. 

  

 

  

4. Select the Bank Guarantee Reference Number from the drop-down list. 



 

 

  

 

  

5. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

6. Select the Due date of Re-furnishing of security using the calendar. 

7. Enter the Reason to refurnish the security. 

8. Click the Choose File button to upload any attachment as has been described earlier. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

9. Click PROCEED button.  

  



 

 

 

  

10. Click ISSUE with DSC.  

  

 

  

11. The Dashboard page is displayed with the following confirmation message. Click OK.  

  



 

 

 

  

12. The updated Case Detail page is displayed, with the table containing the record of the order just 

issued and the Status updated to "Pending for re-submission of security". Also, system would send the 

intimation to the taxpayer via email and SMS, and make this order available on the Taxpayer's 

dashboard.  

  

 

  

Go back to the Main Menu 

F (5). Furnished Security Accept 

To issue order for accepting the furnished security to the taxpayer, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab if it is not selected by 

default. This tab displays a table of all the records for which you would issue orders against the c ase 

created.  

2. Click ADD ORDER to open the drop-down list and select FURNISHED SECURITY ACCEPT. 

  



 

 

 

  

3. The FURNISHED SECURITY ACCEPT page is displayed. 

  

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. Click the Choose File button to upload any attachment as has been described earlier. 



 

 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

6. Click PROCEED button.  

  

 

  

7. Click ISSUE with DSC.  

  

 



 

 

  

8. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

9. The updated Case Detail page is displayed, with the table containing the record of the order just 

issued and the Status updated to "Security furnished". Also, system would send the intimation to the 

taxpayer via email and SMS, and make this order available on the Taxpayer's dashboard.  

  

 

  

Go back to the Main Menu 

F (6). Final Assessment Order in Form GST ASMT-07 

To issue final assessment order in Form GST ASMT-07 to the taxpayer, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab if it is not selected by 

default. This tab displays a table of all the records for which you would issue orders against the case 

created.  

2. Click ADD ORDER to open the drop-down list and select FINAL ASSESSMENT ORDER GST ASMT-

07. 

  



 

 

 

  

3. The Final Assessment Order page is displayed. 

  

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  



 

 

5. In the Acts/ Rules Provisions field, enter the act or rule provision detail. 

6. Click the Choose File button to upload any attachment as has been described earlier. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

  

 

  

7. Click PREVIEW and a system-generated draft order gets downloaded into your machine as displayed. 

8. Check the system-generated draft order carefully to rule out any discrepancy. 

  



 

 

 

  

9. Click PROCEED button.  

  



 

 

 

  

10. Click ISSUE with DSC.  

  

 

  

11. The Dashboard page is displayed with the following confirmation message. Click OK.  



 

 

  

 

  

12. The updated Case Detail page is displayed, with the table containing the record of the order just 

issued and the Status updated to "Final order issued". Also, system would send the intimation to the 

taxpayer via email and SMS, and make this order available on the Taxpayer's dashboard.  

  

 

  

Go back to the Main Menu 

F (7). Release of Security in Form GST ASMT-09 

To issue order for release of security Order in Form GST ASMT-09, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab if it is not selected by 

default. This tab displays a table of all the records for which you would issue orders against the case 

created.  

2. Click ADD ORDER to open the drop-down list and select RELEASE OF SECURITY GST ASMT-09. 

  



 

 

 

  

3. The Release of Security page is displayed. 

  



 

 

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. In the Acts/ Rules Provisions field, enter the act or rule provision detail. 

6. Click the Choose File button to upload any attachment as has been described earlier. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

  



 

 

 

  

7. Click PREVIEW and a system-generated draft order gets downloaded into your machine as displayed. 

8. Check the system-generated draft order carefully to rule out any discrepancy. 

  



 

 

 

  

9. Click PROCEED button.  

  



 

 

 

  

10. Click ISSUE with DSC.  

  

 

  



 

 

11. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

12. The updated Case Detail page is displayed, with the table containing the record of the order just 

issued and the Status updated to "Order for release of security issued". Also, system would send the 

intimation to the taxpayer via email and SMS, and make this order available on the Taxpayer's 

dashboard.  

  

 

  

Go back to the Main Menu 

F (8). Order of Rejection against Release of Security 

To issue order for rejection against release of security, perform following steps: 

  



 

 

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab if it is not selected by 

default. This tab displays a table of all the records for which you would issue orders agains t the case 

created.  

2. Click ADD ORDER to open the drop-down list and select ORDER OF REJECTION AGAINST 

RELEASE OF SECURITY. 

  

 

  

3. The Order of Rejection against Release of Security page is displayed. 

  



 

 

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. In the Acts/ Rules Provisions field, enter the act or rule provision detail. 

6. Click the Choose File button to upload any attachment as has been described earlier. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

  



 

 

 

  

7. Click PREVIEW and a system-generated draft order gets downloaded into your machine as displayed. 

8. Check the system-generated draft order carefully to rule out any discrepancy. 

  



 

 

 

  

9. Click PROCEED button.  

  



 

 

 

  

10. Click ISSUE with DSC.  

  

 

  

11. The Dashboard page is displayed with the following confirmation message. Click OK.  

  



 

 

 

  

12. The updated Case Detail page is displayed, with the table containing the record of the order just 

issued and the Status updated to "Application for release of security Rejected". Also, system would send 

the intimation to the taxpayer via email and SMS, and make this order available on the Taxpayer's 

dashboard.  

  

 

  

Go back to the Main Menu 

G (1). Upload Internal Communication before Provisional Assessment 

Order  

To upload documents which have been used to communicate internally within Tax officials, perform 

following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the INTERNAL COMMUNICATION tab if it 

is not selected by default. This tab displays all communications undertaken against the case created.  



 

 

2. Click TYPE OF COMMUNICATION to open the drop-down list and select Commissioner/ Competent 

Authority or Approving Authority for Assessment. 

  

 

  

3. The Internal Communication page is displayed. The Type field is auto-populated based on the Type 

of Communication selected above. 

  



 

 

 

  

4. Select the Status from the drop-down list. 

  

 

  

Note: 

a. Tax officer need to upload communication sent for approval of extension of limitation period for issuing 

Final assessment order by selecting status as 'Pending for approval on extension'. Clarification provided, 

if any to Commissioner/Competent authority or AC/JC also needs to be uploaded by selecting the same 

status. 

b. On receipt of request for approval of extension of limitation period for issuing Final assessment order, 

Commissioner/ Competent authority or AC/JC will give his comments and can choose to any one of 

following option (by email): 



 

 

 Approve the request 

 Reject the request 

 Seek Additional Information on the matter. 

c. In case, additional information is sought by Commissioner/ Competent authority or AC/JC and request 

for seeking additional information is received by officer on email then:  

 Tax Officer will upload such email. 

 Tax Officer will update the status as ‘Pending for clarification by officer on extension'.  

 Accordingly, Tax Officer will provide required information to Commissioner/ Competent 

authority or AC/JC on email.  

 Tax Officer will then upload clarification email and update the status as ‘Pending for 

approval on extension’. 

d. If request for extension of limitation period for issuing Final assessment order is not allowed by 

Commissioner/ Competent authority or AC/JC (by email), then: 

 Tax Officer will upload the rejection email. 

 Update the status as ‘Proposal for extension Rejected’.  

e. If request for extension of limitation period for issuing Final assessment order is allowed by 

Commissioner/ Competent authority or AC/JC (by email), then: 

 Tax Officer will upload the approval email. 

 Update the status as ‘Approval granted, pending for final order’.  

  

5. Click the Choose File button to upload any attachment as has been described earlier. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application. 

  

6. Click the SUBMIT button. 

  



 

 

 

  

7. The updated Case Detail page is displayed, with the table containing the record of the communication 

sent. 

  

 

  

Go back to the Main Menu 



 

 

G (2). Upload Internal Communication before Release of Security  

To upload documents which have been used to communicate internally within Tax officials, perform 

following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the INTERNAL COMMUNICATION tab if it 

is not selected by default. This tab displays all communications sent against the case created.  

2. Click TYPE OF COMMUNICATION to open the drop-down list and select Commissioner/ Competent 

Authority or Approving Authority for Assessment. 

  

 

  

3. The Internal Communication page is displayed. The Type field is auto-populated based on the Type 

of Communication selected above. 

  



 

 

 

  

4. Select the Status from the drop-down list. 

  

 

  

Note: 

Note: 

a. Tax officer needs to upload communication sent for issuing release order by selecting status as 

'Pending for Approval on release. Clarification provided, if any to Commissioner/Competent authority or 

AC/JC also needs to be uploaded by selecting the same status.  

b. On receipt of request for  approval of extension of limitation period for issuing Final assessment order, 

Commissioner/ Competent authority or AC/JC will give his comments and can choose to any one of 

following option (by email): 

 Approve the request 



 

 

 Reject the request 

 Seek Additional Information on the matter. 

c. In case, additional information is sought by Commissioner/ Competent authority or AC/JC and request 

for seeking additional information is received by officer on email then:  

 Tax Officer will upload such email. 

 Tax Officer will update the status as ‘Pending for clarification by officer on release.  

 Accordingly, Tax Officer will provide required information to Commissioner/ Competent 

authority or AC/JC on email.  

 Tax Officer will then upload clarification email and update the status as ‘Pending for 

approval on extension’. 

d. If request for extension of issuing release order is not allowed by Commissioner/ Competent authority 

or AC/JC (by email), then: 

 Tax Officer will upload the rejection email. 

 Update the status as ‘Proposal for release Rejected’. 

e. If request for issuing release order is allowed by Commissioner/ Competent authority or AC/JC (by 

email), then: 

 Tax Officer will upload the approval email. 

 Update the status as ‘Approval granted, pending for release order’.  

  

5. Click the Choose File button to upload any attachment as has been described earlier. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

  

6. Click the SUBMIT button. 

  



 

 

 

  

7. The updated Case Detail page is displayed, with the table containing the record of the communication 

sent. 

  

 

  

Go back to the Main Menu 



 

 

H. View Security details  

To view security details furnished by the taxpayer, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the SECURITY tab. This tab displays all 

security details furnished by the Taxpayer. 

2. Click the documents in the Attachments section to download and ascertain their contents.  

  

 

  

Go back to the Main Menu 

I (1). Add Communication 

To upload documents which have been used to communicate with the taxpayer, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the REFERENCES tab if it is not selected 

by default. This tab displays all communications sent against the case created.  

2. Click ADD REFERENCE to open the drop-down list and select COMMUNICATION. 

  



 

 

 

  

3. The Communication page is displayed. 

  

 

  

4. Select the Notice/Order/Reminder Reference Number from the drop-down list. 

5. Select the Type of Communication from the drop-down list. 

  



 

 

 

  

6. Select the Issue Date and Communication Date  using the calendar. 

7. Click the Choose File button to upload any attachment as has been described earlier. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

8. Click the SUBMIT button.  

  

 

  

9. The updated Case Detail page is displayed, with the table containing the record of the communication 

sent. 

  



 

 

 

  

Go back to the Main Menu 

I (2). Add Reference of Case 

To upload additional documents which have been used to communicate internally within Tax officials, 

perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the REFERENCES tab if it is not selected 

by default. This tab displays all communications sent against the case created.  

2. Click ADD REFERENCE to open the drop-down list and select REFERENCES OF CASE. 

  

 

  

3. Click the Choose File button to upload any attachment as has been described earlier. 

Note: 

 File with PDF & JPEG format is only allowed. 



 

 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

4. Click the SUBMIT button.  

  

 

  

5. The updated Case Detail page is displayed, with the table containing the record of the reference of 

case. 

  

 

  

Go back to the Main Menu 

  

  



 

 

Scrutiny of Returns 

FAQs > Scrutiny of Returns 

1. I am not getting Scrutiny of Returns link in my Dashboard. Why? 

You may not have been assigned the role of Adjudicating Authority by the State Admin. Request your 

State Admin to allocate you the role of Adjudicating Authority. Once the role is assigned, you will be 

allocated Scrutiny of Returns link for further action. 

  

Click here to learn about the various roles available in Tax Officials Interface and how the Admin can 

assign the role to Tax Officials. 

2. When do a Tax Official need to conduct Scrutiny of Returns? 

In case, any discrepancy is found in return furnished by registered person on the basis of risk parameters 

or suo-moto on his / her own motion, then Tax Official can issue a notice informing the user of such 

discrepancies and seek clarification from that person. 

  

Registered person may either accept such discrepancies and pay tax, interest and penalty amount arising 

from such discrepancies and inform the same to the Tax Official or furnish an explanation for the 

identified discrepancy. 

  

Where the explanation furnished by the registered person is found to be satisfactory, the Tax Official 

needs to issue order of acceptance of reply against notice issued and if it is not acceptable, then Tax 

Official may proceed to determine the tax and other dues or may recommend the case to Audit/ Special 

audit/ Enforcement wing. 

3. From where can I issue notice to the taxpayers? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Scrutiny of Returns > Case Detail > NOTICES option. 

4. From where can I view the reply filed by the taxpayers? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Scrutiny of Returns > Case Detail > REPLIES option. 

5. From where can I recommend the case to other modules? 



 

 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Scrutiny of Returns > Case Detail > RECOMMEND option. 

6. When can I recommended a case to other modules? 

In case, reply to notice given by the taxpayer is not satisfactory, you can recommend to initiate 

proceedings u/s 73/74 for determination of tax or recommend to initiate action under Audit/ Special Audit/ 

Enforcement u/s 65/66/67.  

7. From where can I issue orders to the taxpayers? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Scrutiny of Returns > Case Detail > ORDERS option. 

8. What will happen once "Drop Proceedings" order is issued? 

In case, reply to notice given by the taxpayer is satisfactory, you can issue the  "Drop Proceedings" order.  

  

Once the "Drop Proceedings" order is issued, status of the case is updated to "Order for dropping 

proceedings issued". Also, system sends an intimation to the taxpayer via email and SMS, and makes 

this order available on the Taxpayer's dashboard.  

9. From where can I add additional documents related to Case ID? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Scrutiny of Returns > Case Detail > REFERENCES option. 

10. Does a taxpayer get any intimation about the notice or order issued to 

them? 

Taxpayer will get intimation about all notices and orders issued to him/her though SMS and e-mail. 

11. By when can a taxpayer reply to notice issued to them? 

The taxpayer need to reply within 30 days from the date of service of notice issued u/s 61 to furnish 

explanation or request for extension. 

12. What needs to be done in case reply to notice given by the taxpayer is 

not satisfactory? 



 

 

In case, reply to notice given by the taxpayer is not satisfactory, you need to recommend to initiate 

proceedings u/s 73/74 for determination of tax or recommend to initiate action under Audit/ Special Audit/ 

Enforcement u/s 65/66/67. Once it's recommended, then: 

 Internal Reference Number (ARN/Case id) will get generated  

 The work item (ARN/Case id) will appear in pending list under ‘Determination of Tax’ under 

Assessment & Adjudication module or will appear under work item list under Audit/ Special Audit/ 

Enforcement modules to initiate action 

 Internal status will be ‘Recommended for action u/s 73/74’ or ‘Recommended for audit u/s 65’ or 

‘Recommended for special audit u/s 66’ or ‘Recommended for enforcement/ Survey u/s 67’  

 Status of RFN for taxpayer will remain ‘Reply furnished, pending for order' 

13. What are the various statuses for Scrutiny of Returns? 

Various statuses for Scrutiny of Returns updated automatically by GST Portal are:  

1. Pending for Action by tax officer: Status of ARN of return under work item of A/A for scrutiny  

2. Closed: On removing the item from ‘List of Return under Scrutiny’  

3. Pending for reply by taxpayer: Status of ARN/ Case id and RFN upon issue of notice  

4. Reply furnished: Pending for order by tax officer: Status of ARN/ Case id and RFN upon submission of 

reply  

5. Reply not furnished, pending for order: Status of ARN/ Case id and RFN, if person does not attend PH/ 

furnish explanation on date specified in SCN or Extended date  

6. Order for dropping proceedings issued: Status of ARN/ Case id and RFN upon dropping the 

proceedings  

7. Recommended for action u/s 73: Status of ARN/ Case id upon initiating proceedings u/s 73 for 

Determination of Tax  

8. Recommended for action u/s 74: Status of ARN/ Case id upon initiating proceedings u/s 74 for 

Determination of Tax  

9. Recommended for Audit u/s 65: Status of ARN/ Case id upon recommended the case to Audit   

10. Recommended for Special Audit u/s 66: Status of ARN/ Case id upon recommended the case to 

Special Audit  

11. Recommended for Survey/ Inspection u/s 67: Status of ARN/ Case id upon Recommended the case 

under Enforcement  

12. Pending for order by tax officer: Status of ARN/ Case id and RFN, in case, no reply submitted against 

notice within time specified or extended time  

14. Do I need to upload details of receipt of order sent by post to the 

taxpayer? 

Tax Officer needs to update the details of receipt of order sent by post to the taxpayer in ‘Reference’ 

folder i.e. date of delivery and upload the receipt related to post on the GST Portal. 



 

 

15. What is the difference between Communication and References tab?  

Communication tab is used to upload documents which have been used to communicate to taxpayer 

offline. 

References tab is used to upload additional documents or communication related to the case. 

  



 

 

 

Scrutiny of Returns 

How can I conduct procedure of scrutiny of Returns against the taxpayer? 

To conduct procedure of scrutiny of Returns u/s 61 and proceed to determine tax & other dues u/s 73 or 

74 or to recommend for initiating action u/s 65, 66 or 67 against the taxpayer, in the role of Adjudicating 

Authority, perform following steps: 

  

A. Initiate Suo Moto or Search for ARN 

A(1). Initiate Suo Moto Proceeding  

A(2). Search for an already-created ARN/Case ID 

B. Take action using NOTICES tab of Case Details screen:  

B(1). Issue/View Notice  

B(2). Reminder  

B(3). Adjournment 

C. Take action using REPLIES tab of Case Details screen: View replies filed by the taxpayer  

D. Take action using ORDERS tab of Case Details screen: Drop Proceedings 

E. Take action using REFERENCES tab of Case Details screen:  

E(1). Upload Communication 

E(2). References related to the case 

F. Take action using RECOMMEND tab of Case Details screen: Add Recommendation  

  

Click each hyperlink above to know more. 

A (1). Initiate Suo-Moto Proceedings for Scrutiny of Returns 

1. Access the GST Back Office Portal for tax officials. 

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > Scrutiny of Returns option. 

  

 



 

 

  

4. The Scrutiny of Returns page is displayed. 

  

 

  

5. Click the SUO MOTO PROCEEDING button. 

  

 

  

6. The Suo Moto page is displayed. The “Proceeding Type” field gets auto-populated.  

  

 

  

7. Enter the GSTIN or UIN or Temporary Id of the taxpayer. 

8. Click the GO button. This will enable the CREATE button.  

9. Select the Financial Year from the drop-down list. 



 

 

10. Select the Tax Period from the From and To drop-down lists for the period for which you want to 

initiate scrutiny of returns.  

11. Click the CREATE button. 

  

 

  

12. A success message is displayed. Click CONTINUE. 

  

 

  

13. Scrutiny of Returns Case Detail page is displayed. From this page, you can initiate proceedings for 

Scrutiny of Returns by operating on the tabs provided at the left-hand side of the page: NOTICES, 

REPLIES, ORDERS, REFERENCES and RECOMMEND. 

  

 



 

 

  

Or, you can also search the Scrutiny of Returns application page by either searching for the ARN 

(Application Reference Number)/GSTIN/Status/Period by navigating to Statutory Functions > 

Assessment/Adjudication > Scrutiny of Returns option. 

  

Go back to the Main Menu 

A (2). Go to Scrutiny of Returns application page by searching for the ARN 

(Application Reference Number)/GSTIN/Status/Period 

1. Access the GST Back Office Portal for tax officials. 

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > Scrutiny of Returns option. 

  

 

  

4. Search page is displayed.  

  

 

  

5. Choose any one of the four displayed fields as your search criteria and enter the required information: 

ARN, GSTIN, Status or Period From and Period To Date. 

Note: You must enter data in at least one field to proceed.   

  



 

 

 

  

6. Click the SEARCH button. 

  

 

  

6. Based on your search criteria, the required ARN(s) gets displayed. Click the ARN hyperlink of the case 

you want to act on.   

  



 

 

 

  

7. Scrutiny of Returns Case Detail page is displayed. From this page, you can initiate proceedings for 

Scrutiny of Returns by operating on the tabs provided at the left -hand side of the page: NOTICES, 

REPLIES, ORDERS, REFERENCES and RECOMMEND. 

  

Note: On this page, the NOTICES tab is selected by default.  

  

 

  

Go back to the Main Menu 

B (1). Issue Notice 

To issue notice for information to the taxpayer, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the Notices/Reminder/Adjournment issued against the case created. 

2. Click ADD NOTICE to open the drop-down list and select NOITCE. 

  



 

 

 

  

3. The NOTICE page is displayed. 

  

 

  

Note: Before issuing the notice, if required, you can also refer to the following hyperlinks provided on the 

right-side of the page to view various details:  

 MIS Reports: Contains all available MIS Reports.  

 Tax Liability: Contains details of estimated tax liabilities of current tax period as updated from 

Form GSTR-1, 1A and Form GSTR-2, 2A  



 

 

 Tax Return History: Contains details of the returns of the previous tax periods, and also option 

to view any other return of the defaulter.  

  

4. In the Section Number field, enter the section number. 

5. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

6. Select the Due Date to reply using the calendar. 

7. In the Acts/ Rules Provisions field, enter the act or rule provision. 

8. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

notice. 

9. Click PREVIEW and a system-generated draft notice of additional information gets downloaded into 

your machine as displayed. 

  

 

  

10. Check the system-generated draft notice carefully to rule out any discrepancy. 

  



 

 

 

  

11. Go back to the notice page. Click PROCEED button.  

  



 

 

 

  

12. Click ISSUE with DSC.  

  

 



 

 

  

13. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

14. The updated Case Detail page is displayed, with the table containing the record of the notice just 

issued and the Status updated to "Pending for final reply by taxpayer". Also, system would send the 

intimation to the taxpayer via email and SMS, and make this notice available on the Taxpayer's 

dashboard.  

Note: You can click the hyperlinks under Attachments column to view the documents.  

  

 

  

Go back to the Main Menu 

B (2). Issue a Reminder 

To issue a reminder to taxpayer who has neither replied to the SCN within time specified nor attended a 

personal hearing, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (Notice/Reminder/Adjournment) issued against the case created.  

2. Click ADD NOTICE to open the drop-down list and select REMINDER. 

  



 

 

 

  

3. The REMINDER page is displayed. 

  

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. Select the Due Date to reply using the calendar. 

6. Select the Reminder No. from the drop-down list. 

7. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

notice. 

8. Click PREVIEW and a system-generated draft notice of reminder gets downloaded into your machine 

as displayed. 

  



 

 

 

  

9. Check the system-generated draft reminder carefully to rule out any discrepancy. 

  



 

 

 

  

10. Go back to the reminder page. Click PROCEED button.  

  



 

 

 

  

11. Click ISSUE with DSC.  

  

 

  

12. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  



 

 

13. The updated Case Detail page is displayed, with the table containing the record of the reminder just 

issued and the Status updated to "Reminder No. 1 Issued". Also, system would send the intimation to the 

taxpayer via email and SMS, and make this reminder notice available on the Taxpayer's dashboard.  

Note:  

 You can issue only three reminders against a particular case.  

 You can click the hyperlinks under Attachments column to view the documents. 

  

 

  

Go back to the Main Menu 

B (3). Issue an Adjournment 

To update adjournment details for a taxpayer who has filed an application of extension offline, perform 

following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the NOTICES tab if it is not selected by 

default. This tab displays all the notices (Notice/Reminder/Adjournment) issued against the case created.  

2. Click ADD NOTICE to open the drop-down list and select ADJOURNMENT. 

  



 

 

 

  

3. The ADJOURNMENT page is displayed. 

  

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. Select the Due Date to reply using the calendar. 

6. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

notice. 

7. Click ISSUE button.  

  



 

 

 

  

8. A success message popup is displayed. Click CONTINUE.  

  

 

  

9. The updated Case Detail page is displayed, with the table containing the record of the adjournment 

just issued and the Status updated to "Pending for reply by taxpayer". Also, system would send the 

intimation to the taxpayer via email and SMS, and make this adjournment notice available on the 

Taxpayer's dashboard.  

Note: You can click the hyperlinks under Attachments column to view the documents.  

  



 

 

 

  

Go back to the Main Menu 

C. View Replies by the Taxpayer, if any 

To view replies submitted by the taxpayer, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, select the REPLIES tab. This tab displays all 

replies filed by the Taxpayer. 

2. Click the documents in the Attachments section to download and ascertain their contents.  

  

 

  

Go back to the Main Menu 

D. Drop Proceedings 

To drop the proceedings, perform following steps: 

  



 

 

1. On the Case Detail page of that particular taxpayer, select the ORDERS tab if it is not selected by 

default. 

2. Click ADD ORDER to open the drop-down list and select DROP PROCEEDING. 

  

 

  

3. The DROP PROCEEDING page is displayed. 

  

 

  

4. Click the Generate Reference Number hyperlink. Reference Number field gets auto-populated.  

5. In the Acts/ Rules Provisions field, enter the act or rule provision. 

6. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

order. 



 

 

7. Click PREVIEW and a system-generated draft order gets downloaded into your machine as displayed.  

  

 

  

8. Check the system-generated draft order carefully to rule out any discrepancy. 

  



 

 

 

  

9. Go back to the notice page. Click PROCEED button.  

  



 

 

 

  

10. Click ISSUE with DSC.  

  

 

  

11. The Dashboard page is displayed with the following confirmation message. Click OK.  

  



 

 

 

  

12. The updated Case Detail page is displayed, with the table containing the record of the order just 

issued and the Status updated to "Order for dropping proceedings issued". Also, system would send the 

intimation to the taxpayer via email and SMS, and make this order available on the Taxpayer's 

dashboard.  

  

 

  

Go back to the Main Menu 

E (1). Upload Communication 

To upload documents, which have been used to communicate with taxpayer offline, perform following 

steps: 

  

1. On the Case Detail page of that particular taxpayer, select the REFERENCES tab if it is not selected 

by default. This tab displays all communications sent against the case created.  

2. Click ADD REFERENCE to open the drop-down list and select COMMUNICATION. 

  



 

 

 

  

3. The Communication page is displayed. 

  

 

  

4. Select the Notice/Order/Reminder Reference Number from the drop-down list. 

5. Select the Type of Communication from the drop-down list. 

  

 

  

6. Select the Issue Date and Communication Date using the calendar. 



 

 

7. Click the Choose File button to upload any attachment. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application.  

8. Click the SUBMIT button.  

  

 

  

9. The updated Case Detail page is displayed, with the table containing the record of the communication 

sent. 

Note: You can click the hyperlinks under Attachments column to view the documents.  

  

 

  

Go back to the Main Menu 



 

 

E (2). Upload References of Case 

To upload additional documents or communication related to the case, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the REFERENCES tab if it is not selected 

by default. This tab displays all communications sent against the case created.  

2. Click ADD REFERENCE to open the drop-down list and select REFERENCES OF CASE. 

  

 

  

3. Click the Choose File button to upload any attachment. 

Note: 

 File with PDF & JPEG format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 4 other documents can be attached in the application. 

4. Click the SUBMIT button.  

  

 

  



 

 

5. The updated Case Detail page is displayed, with the table containing the record of the reference of 

case. 

Note: You can click the hyperlinks under Attachments column to view the documents.  

  

 

  

Go back to the Main Menu 

F. Add Recommendation 

In case, reply to notice given by the taxpayer is not satisfactory, you may recommend to initiate 

proceedings u/s 73/74 for determination of tax or recommend to initiate ac tion under Audit/ Special Audit/ 

Enforcement u/s 65/66/67.  

  

To add recommendation related to the case, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the RECOMMEND tab if it is not selected 

by default. This tab displays all recommendation added against the case created.  

2. Click RECOMMEND to open the drop-down list and select ADD RECOMMENDATION. 

  

 

  

2. The Add Recommendation page is displayed. 

  



 

 

 

  

3. Select the Unit to Recommend from the drop-down list. 

  

 

  

4. Select the Recommending to Officer from the drop-down list. 

5. Select the Section from the drop-down list. 

  

 

  

6. Enter the comments or reasons to recommend to some other unit. 

7. Click Choose File to upload the document(s) from your machine that state the reasons of issuing 

notice. 

8. Click PROCEED button.  

  



 

 

 

  

9. The updated Case Detail page is displayed, with the table containing the record of the 

recommendation just issued and the Status updated to "Recommendation for action".  

Once it's recommended, then: 

 Internal Reference Number (ARN/Case id) will get generated  

 The work item (ARN/Case id) will appear in pending list under ‘Determination of Tax’ under 

Assessment & Adjudication module or will appear under work item list under Audit/ Special Audit/ 

Enforcement modules to initiate action 

 Internal status will be ‘Recommended for action u/s 73/74’ or ‘Recommended for audit u/s 65’ or 

‘Recommended for special audit u/s 66’ or ‘Recommended for enforcement/ Survey u/s 67’  

 Status of RFN for taxpayer will remain ‘Reply furnished, pending for order' 

  

10. Scroll to the right using the scroll bar to view more details.  

  



 

 

 

  

11. The details are displayed. 

  

 

  

Go back to the Main Menu 

  



 

 

Recommendations 

Recommendations 

1. From where recommendations are received? 

Recommendations are received from Enforcement or Audit or Special Audit or Others (LTU) module to 

ascertain or assess the tax liability of a person.  

2. What are the various functionalities under Recommendations? 

Listed below are the various functionalities under Recommendations:  

A. Search Recommendations : Search recommendations related to a particular use case or section 

received from various modules 

B. Seek Additional Information : Seek additional information from the Tax Official concerned 

C. View Additional Information : View the information provided by the concerned officer 

D. Assign Section : Assign case to different section of the Act  

E. Re Assign Section : Re-assign case to different section of the Act 

F. Initiate Proceedings : Create case ID and initiate proceedings against the case 

G. Reply to Recommendation : Reply to recommendations, related to particular use case or section 

received from various modules 

3. Which Tax Official uses which functionality under Recommendations? 

Below roles can use functionalities under Recommendations: 

A. Search Recommendations : Adjudicating Authority 

B. Seek Additional Information : Adjudicating Authority 

C. View Additional Information : Adjudicating Authority 

D. Assign Section : Adjudicating Authority 

E. Re Assign Section : Adjudicating Authority 

F. Initiate Proceedings : Adjudicating Authority 

G. Reply to Recommendation : Concerned Officer 

4. From where can I seek additional information from the concerned officer 

for recommendations? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Recommendations > Search > Seek Additional Information option. 



 

 

5. From where can I view additional information given by the concerned 

officer for recommendations? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Recommendations > Search > View Additional Information option. 

6. From where can I re-assign recommendations to some other section? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Recommendations > Search > ReAssign section option. 

7. From where can I initiate proceedings for recommendations? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > 

Assessment/Adjudication > Recommendations > Search > Initiate Proceedings option. 

8. What are the various statuses for recommendations? 

Various statuses for recommendations updated automatically by GST Portal are:  

1. Pending for action by tax officer: Status of ARN/Case id  

2. Pending for clarification by concerned officer: If any additional information is sought by A/A  

3. Clarification received, pending for action by tax officer: Upon Clarification received  

4. Recommendations assigned to section…. : Upon assignment of ARN/Case id to Particular Use case or 

Section  

5. Proceeding Initiated: Upon proceedings initiated against ARN/Case id 

9. From where can I reply to recommendations? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Quick Links > My 

Recommendations option. 

10. What is the difference between a section and a unit as referred in this 

document? 

Section refers to any Section of the Act, whereas unit related to functionalities related to different modules 

like Enforcement, Audit, Special Audit etc. within the organization. 



 

 

 

Recommendations 

How can I act on the recommendations related to particular use case or 

section received from various modules? 

To act on the recommendations related to particular use case or section received from various modules, 

in the role of Adjudicating Authority, perform following steps: 

  

A. Search Recommendations 

B. Seek Additional Information 

C. View Additional Information 

D. Assign Section 

E. Re Assign Section 

F. Initiate Proceedings 

G. Reply to Recommendation 

  

Click each hyperlink above to know more. 

A. Search Recommendations 

To search recommendations related to particular use case or section received from various modules, 

perform following steps: 

  

1. Access the GST Back Office Portal for tax officials. 

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Assessment/Adjudication > Recommendations option. 

  

 

  

4. Search page is displayed. Choose your search criteria.  

  



 

 

 

  

5. Select the Status from the drop-down list. 

  

 

  

6. Select the Recommended By (Unit) from the drop-down list. 

  

 

  

7. Select the Section of the Act from the drop-down list. 

  



 

 

 

  

8. Click the SEARCH button. 

  

 

  

9. Based on your search criteria, the recommendations gets displayed.  

  

 



 

 

  

9.1. Scroll to the right using scroll bar to view more details. 

  

 

  

9.2. More details are displayed. 

  

 

  

Go back to the Main Menu 

B. Seek Additional Information 

1. To seek additional information from the concerned Official, select the radio button against the GSTIN. 

2. Click the SEEK ADDITIONAL INFORMATION button. 

  



 

 

 

  

3. Enter your comments in the Comments box. 

4. Click the Choose File button to upload any attachments. 

Note: You can upload 4 files with PDF or JPEG format and maximum size of upload as 5 MB.  

5. Click the SUBMIT button. 

  

 

  

6. A confirmation message is displayed that additional information has been forwarded to concerned 

Officer. 

7. Click BACK to go to search page. 

  



 

 

 

  

8. The status is updated to "Pending for clarification by concerned officer".  

  

 

  

Go back to the Main Menu 

C. View Additional Information 

Adjudicating authority seeks clarification from concerned officer by clicking "SEEK ADDITIONAL 

INFORMATION" button. Once the concerned officer provides information, Adjudicating authority can click 

the "VIEW ADDITIONAL INFORMATION" button to view the information provided by the concerned 

officer. 

  



 

 

1. To view additional information provided by the Tax Official, select the radio button against the GSTIN. 

2. Click the VIEW ADDITIONAL INFORMATION button. 

  

 

  

3. The additional information is displayed. You can click the link under Attachment column to view the 

attached document along with information. 

  

 

  

4. Click BACK to go to search page. 

  

Go back to the Main Menu 

D. Assign Section 

Adjudicating authority can decide that which case should be assigned to which section of the Act. 

Suppose, Adjudicating authority is of the opinion that the case pertains to section 73 of the Act, then after 

assigning, the case will be displayed under section 73 (determination of tax) to take further action.  

  



 

 

1. To assign section to particular case, select the radio button against the GSTIN. 

2. Click the ASSIGN SECTION button. 

  

 

  

3. Select the Section from the drop-down list. 

4. Enter the Reason for Assigning different section. 

5. Click the SUBMIT button. 

  

 

  

6. A confirmation message is displayed that case has been assigned to that part icular section of the Act. 

After the case is assigned, it will display under particular use case relating to that section, it is assigned 

to. Adjudicating authority can then proceed further to take action in that particular use case, in which the 

case is assigned to. 

7. Click BACK to go to search page. 

  



 

 

 

  

Go back to the Main Menu 

E. Re Assign Section 

After a use case is assigned to a particular Section of the Act, if Adjudicating authority intends to assign 

this case to any other unit, then he can use the Reassign section option.  

  

1. To reassign section to some other unit, select the radio button against the GSTIN. 

2. Click the RE ASSIGN button. 

  

 

  



 

 

3. The Re assign page is displayed. 

  

 

  

4. Select the Unit to Recommend from the drop-down list. 

  

 

  

5. Select the Tax Authority to whom case is assigned from the drop-down list. 

6. Enter the Reason for reassigning in Comments box. 

7. Click the SUBMIT button. 

  

 

  

8. A confirmation message is displayed that case has been re-assigned successfully. 

9. Click BACK to go to search page. 

  



 

 

 

  

Go back to the Main Menu 

F. Initiate Proceedings 

Adjudicating authority can create case ID and initiate proceedings against a particular case using this 

functionality. 

  

1. To create case ID and initiate proceedings against the case, select the radio button against the GSTIN. 

2. Click the INITIATE PROCEEDINGS button. 

  

 

  

3. By clicking on ‘Initiate proceedings’, screen for creating case id will be opened.  



 

 

  

 

  

4. Here, Adjudicating authority will create case id and the case will be displayed under particular section, 

in which case is assigned. After this it will appear in pendency list of Concerned officer for taking action.  

  

Go back to the Main Menu 

G. Reply to Recommendation 

To reply to recommendations related to a particular use case or section of the Act, sought by adjudicating 

authority, the Concerned Officer may perform following steps:   

  

1. Access the GST Back Office Portal for tax officials. 

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Quick Links > My Recommendations option. 

  

 

  

4. Search page is displayed. Choose your search criteria.  

  

 

  



 

 

5. Select the Status from the drop-down list. 

  

 

  

8. Select the From and To Date using the calendar. 

8. Click the SEARCH button. 

  

 

  

9. Based on your search criteria, the case ID(s) gets displayed. 

  

 

  

10.1. View Case ID 



 

 

  

10.1.1. Click the Case ID link to view the case details. 

  

 

  

10.1.2. The case details are displayed. In scrutiny of return, if Adjudicating authority is not satisfied with 

reply furnished by taxpayer, then he will refer the case to section 73/74 (determination of tax) or other 

module. If case, it is recommended to section 74, then no action will be taken in scrutiny of return. 

Proceeding will be taken further under determination of tax use case.  

  

 

  

10.2. View the Comments 

  

10.2.1. Click the View link to view the comments given for seeking information. 



 

 

  

 

  

10.2.2. The comments are displayed. 

  

 

  

10.3. Reply to Queries 

  

10.3.1. Click the Reply link to reply to additional information query. 

  



 

 

 

  

10.3.2. Enter your remarks in the Comments box. 

10.3.3. Click the Choose File to upload any document. 

10.3.4. Click SUBMIT. 

  

 

  

10.3.5. A confirmation message is displayed that the additional information has been forwarded to 

concerned Officer. 

  



 

 

 

  

Go back to the Main Menu 

  



 

 

Policy Admin 

FAQs 

Policy Admin 

 FAQs 

 Manual 



 

 

Manual 

This functionality will be released shortly. 

  



 

 

Policy Admin 

FAQs > Policy Admin - Issuing Delegated 
Legislation  

1. Which all Tax Official Roles are involved in Policy Admin- Issuing 

Delegated Legislation? 

Following four Tax Official roles can be defined on the GST Portal by the State Admin to conduct 

activities related to Policy Admin- Issuing Delegated Legislation: 

  

1. Drafting officer: Drafts the delegated legislation and submits it to the Supervising Officer for 

review. 

2. Supervising Officer: Reviews the draft submitted by the Drafting Officer, makes the appropriate 

changes and submits it to the Approving Authority for approval. He/she may also choose to send the 

draft back to the Drafting Officer with comments.  

3. Approving Authority: Reviews the draft submitted by the Supervising Officer, makes the 

appropriate changes and submits it to the Signing and Publishing Authority. He/she may also choose 

to send the draft back to the Supervising Officer, with comments.  

4. Signing and Publishing Authority: Reviews the draft submitted by the Approving Authority, 

makes the appropriate changes and signs and publishes it. He/she may also choose to send the 

draft back to the Approving Authority, with comments.    

  

Note: If there are only three roles available—Drafting Officer, Supervising Officer, and Signing and 

Publishing Authority—the Supervising Officer or the Signing and Publishing Authority shall act as the 

Approving Authority as well and perform all the activities related to their role (Supervising Officer/Signing 

and Publishing Authority) and of the Approving Authority also.  

  

2. What types of delegated legislation can be processed and issued by the 

Policy Admin Officials on the GST Portal? 

Following three types of delegated legislation can be processed and issued by the Policy Admin Officials: 

Circulars, Notifications and Administrative Orders.  

3. Is there any time limit for the Supervising Officer and Approving 

Authority to close the draft file from their end once it has been submitted 

by the Drafting Officer? 

 Once the draft of the delegated legislation is submitted by the Drafting Officer, the Supervising Officer will 

have <<7 days>> (from the date of submission of the draft by the Drafting Officer) to submit the file. 



 

 

Otherwise, he/she will be reminded of the same with an e-mail alert at the end of the 7-day period. The 

same alert will also go to the Approving Officer regarding pendency of the file at the Supervising Officer’s 

level. 

Similarly, once the draft of the delegated legislation is submitted by the Supervising Officer, the Approving 

Authority will have <<7 days>> (from the date of submission of the draft by the Supervising Officer) to 

submit the file. Otherwise, he/she will be reminded of the same with an email alert at the end of the 7-day 

period.  

4. I have been assigned the role of Drafting Officer. Do I need to use my 

DSC while submitting the draft of the delegated legislation? 

No, you don't have to use your DSC for submitting the draft of the delegated legislation.  

5. I have been assigned the role of Supervising Officer and Approving 

Authority. Do I need to use my DSC while submitting the draft of the 

delegated legislation? 

No, you don't have to use your DSC for submitting the draft of the delegated legislation.  

6. What actions take place once the draft of the delegated legislation is 

signed and published? 

Once the delegated legislation is signed and published by the Signing and Publishing Authority, following 

actions will take place: 

  

In case of Notifications: 

 Notification is printed, physically signed, and forwarded to the Government Press for publication 

in the Official Gazette through normal mode. In case of e-Gazette publication, the same is forwarded 

by e-mail or otherwise as prescribed for receipt by the Publishing Authority with DSC incorporated.  

 Notification is also sent to the webmaster of the Department/field formation for putting up for 

public information.  

 The centralized serial number is auto-populated in the draft notification  

 The centralised serial numbering system for the appropriate class of notifications gets updated.  

  

In case of Circulars: 

 The centralized serial number is auto-populated in the draft circular once the same is approved. 

 Circular is forwarded to the mailing list as per instructions applicable for issue of circulars.  

 Circular is also sent to the webmaster of the Department/field formation for putting up for public 

information.  

 The centralised serial numbering system for the appropriate class of circulars gets updated. 



 

 

 In case of press note, the same is also issued to the Press Information Bureau for communication 

to the media. The press note will also be hosted on the GST portal under the head ‘Press Release’ . 

  

In case of Administrative Orders: 

 The centralized serial number is auto-populated in the draft Administrative Orders upon approval.  

 Administrative Orders is also sent to the webmaster of the Department/field formation for putting 

up for public information.  

 The centralised serial numbering system for the appropriate class of Administrative Orders gets 

updated. 

 The Administrative Order is forwarded to the BO Official for updation of the Role / Jurisdictional 

mapping. 

 Copy of the Administrative Order shall also be forwarded to the officers concerned through e-mail 

besides making it available on their dashboard. 

 The charge has to be transferred from one BO user to another BO user on issuance of 

transfer/promotion/deputation/demotion/order. 

7. Once the delegated legislation document is approved, signed and 

published, can it be altered? 

No, once the delegated legislation document is approved, signed and published, it cannot be altered.  

8. During processing of the Delegated Legislation, what all Status changes 

does it undergo? 

During processing of the Delegated Legislation, it undergoes following Status changes:  

  

 Returned to Approving Authority: When draft of the delegated legislation is sent back to the 

Approving Authority by the Signing and Publishing Authority, with comments.    

 Returned to Drafting Officer: When draft of the delegated legislation is sent back to the Drafting 

Officer by the Supervising Officer, with comments.    

 Returned to Supervising Officer: When draft of the delegated legislation is sent back to the 

Supervising Officer by the Approving Authority, with comments.    

 Submitted to Approving Authority: When draft of the delegated legislation is submitted by the 

Supervising Officer to the Approving Authority for approval. 

 Signed and Published: When draft of the delegated legislation is signed and published by the 

Signing and Publishing Authority.  

 Submitted to Supervising Officer: When draft of the delegated legislation is submitted by the 

Drafting Officer to the Supervising Officer for review. 



 

 

 Submitted to Signing and Publishing Authority: When draft of the delegated legislation is 

submitted by the Approving Authority to the Signing and Publishing Authority for signing and 

publishing.  

  

  



 

 

 

Manual > Policy Admin - Issuing Delegated 
Legislation  

How can I issue delegated legislation? 

To issue any delegated legislation, perform following steps: 

  

Note:  

  

Delegated legislation can be broadly categorized into the following three areas: Circulars, Notifications 

and Administrative Orders. To issue these three types of delegated legislation, following four Tax 

Official roles are defined on the GST Portal by the State Admin:  

  

1. Drafting officer: Drafts the delegated legislation and submits it to the Supervising Officer for 

review. 

2. Supervising Officer: Reviews the draft submitted by the Drafting Officer, makes the appropriate 

changes and submits it to the Approving Authority for approval. He/she may also choose to send the 

draft back to the Drafting Officer with comments.  

3. Approving Authority: Reviews the draft submitted by the Supervising Officer, makes the 

appropriate changes and submits it to the Signing and Publishing Authority. He/she may also choose 

to send the draft back to the Supervising Officer, with comments.  

4. Signing and Publishing Authority: Reviews the draft submitted by the Approving Authority, 

makes the appropriate changes and signs and publishes it. He/she may also choose to send the 

draft back to the Approving Authority, with comments.    

  

Please note that if there are only three roles available—Drafting Officer, Supervising Officer, and Signing 

and Publishing Authority—the Supervising Officer or the Signing and Publishing Authority shall act as the 

Approving Authority as well and perform all the activities related to their role (Supervising Officer/Signing 

and Publishing Authority) and of the Approving Authority also.  

  

Step 

 Tax Official Roles 

Responsible for 

Performing the Step 

A. Create a New delegated 

legislation and submit it for 

review 

Drafting officer  

B. Search and View the List of 

delegated legislation 

Drafting officer, Supervising 
Officer, Approving 
Authority, Signing and 
Publishing Authority 



 

 

C. Take Action on the draft of 

the delegated legislation 

submitted/returned to 

Supervising Officer 

Supervising Officer 

D. Take Action on the draft of 

the delegated legislation 

submitted/returned to 

Approving Authority 

Approving Authority 

E. Take Action on the 

approved draft of the 

delegated legislation 

submitted to Signing and 

Publishing Authority 

Signing and Publishing 
Authority 

  

  

Click each hyperlink in the "Steps" column above to know more.  

A. Create a New Delegated Legislation and Submit It for Review 

To create a New delegated legislation (Circulars, Notifications or Administrative Orders) and submit it for 

review Supervising Officer, perform following steps: 

  

Note: This step can be performed by the Drafting Officer only.  

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Policy Admin and select the type of delegated legislation to be 

created—Notifications, Circulars or Administrative Orders 

  

 
  

4. Search Page related to the selected delegated legislation is displayed. Click the button related to the 

New delegated legislation. 

  

4a. On selecting "Notifications", the Search Notification page is displayed. Click the NEW 

NOTIFICATION button.  

  

  



 

 

 
  

  

4b. On selecting "Circulars", the Search Circular page is displayed. Click the NEW CIRCULAR button.  

  

  

 
  

4c. On selecting "Administrative Orders", the Search Order page is displayed. Click the NEW ORDER 

button.  

  

 
  

5. Create Page of the selected delegated legislation is displayed. Click BACK to go back to the previous 

screen or enter data in the displayed fields as mentioned in the following steps.  

  



 

 

  

5a. On clicking the NEW NOTIFICATION button, the following Create page is displayed.  

  

 
  

  

5b. On clicking the NEW CIRCULAR button, the following Create page is displayed.  

  



 

 

 
  

  

5c. On clicking the NEW ORDER button, the following Create page is displayed.  

  



 

 

 

  

6. In the Class field, select the class of the delegated legislation to be issued from the drop-down list.  

  

6a. In case of Notifications, select the class of Notification from the following drop-down list.  

  

 

  

6b. In case of Circulars, select the class of Circular from the following drop-down list.  

  



 

 

 

  

6c. In case of Administrative Orders, select the class of Order from the following drop-down list.  

  

 

  

7. In the Level/Purpose of issue  field, select the level of the delegated legislation to be issued from the 

drop-down list.  

  

  

7a. In case of Notifications, in the Purpose of issue field, select the purpose of issue of the notification 

from the drop-down list.  

  

 

  



 

 

7b. In case of Circulars or Administrative Orders, in the Level field, select their level from the following 

drop-down list.  

  

 

  

8. If required, link the delegated legislation being created to the ones published previously. Let's see how 

to link a Circular. Notifications and Administrative Order will be linked in the same manner.   

  

(i) Click the Link to previous Circular hyperlink.   

  

 
  

(ii)  Circular Search page is displayed. Either enter the Reference Number in the Reference Number field 

or select the From & To dates from the calendar and click the SEARCH button. 

  

 
  

  

(iii)  List of Published Circulars is displayed. Select the Circular to be linked and click the LINK button.  

  



 

 

 

  

(iv). A warning popup is displayed. Click the PROCEED button.  

  

 

  

  

(v). A Success message is displayed. Click the OK button.  

  

 



 

 

  

(vi). You will be directed back to the Create page of the New Circular being created, where the link will be 

auto-populated.  

  

 

  

  

9.  In the Subject field, enter the relevant subject of 500 words. 

  

 

  

10. In the Main Document field, upload the Word file of that particular delegated legislation.  

  

 

  

11. If required, in the Supporting Document field, upload the PDF file of the related documents. 

  

 

  

12. Click the SUBMIT button. 

  

13. A warning popup is displayed related to the delegated legislation that has been submitted. Click the 

PROCEED button.  

  



 

 

 

  

14. A Success message is displayed related to the delegated legislation that has been submitted. Click 

the OK button.  

  

 

  

15. The delegated legislation you have submitted gets displayed  on the main page in the top of the list.  

  



 

 

 

  

Note: Once the draft of the delegated legislation is submitted by the Drafting Officer, the Supervising 

Officer will have <<7 days>> (from the date of submission of the draft by the Draft ing Officer) to submit 

the file. Otherwise, he/she will be reminded of the same with an e-mail alert at the end of the 7 day 

period. The same alert will also go to the Approving Officer regarding pendency of the file at the 

Supervising Officer’s level. 

  

Go back to the Main Menu 

  

B. Search and View the List of Delegated Legislation 

To search and view the list of delegated legislation (Circulars, Notifications or Administrative Orders), 

perform following steps: 

  

Note: This step can be performed by all the roles— Drafting Officer, Supervising Officer, Approving 

Authority, Signing and Publishing Authority 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Policy Admin and select the type of delegated legislation to be 

searched—Notifications, Circulars or Administrative Orders 

  



 

 

 
  

4. Search Page related to the selected delegated legislation is displayed. An example of the Circular 

Search page is displayed below. Search pages of Notifications and Administrative Orders contain the 

same fields. Choose any one of the displayed fields as your search criteria and enter the required 

information as mentioned in the following steps:  

  

 
  

4a. Enter date in the From & To fields using the calendar 

4b. Enter the Reference Number in the Reference Number field.  

4c. Select Status from the drop-down list. 

  

 

  

5. Click the SEARCH button and based on your search criteria, the required list gets displayed. You can 

navigate through the entire list using the numbered (1, 2...) buttons below. Click any of the Reference 

Number hyperlinks to open it and carry out further processing. 

  



 

 

 

  



 

 

 

  

  



 

 

 

  

Go back to the Main Menu 

  

C. Take Action on the Draft of the Delegated Legislation 

Submitted/Returned to Supervising Officer 

To take action on the draft of the delegated legislation (Circulars, Notifications or Administrative Orders) 

submitted/returned to Supervising Officer, perform following steps: 

  

Note: This step can be performed by the Supervising Officer only. He/she will have <<7 days>> (from the 

date of submission of the draft by the Drafting Officer) to submit the file. Otherwise, he/she will be 

reminded of the same with an email alert at the end of the 7 day period. The same alert will also go to the 

Approving Officer regarding pendency of the file at the Supervising Officer’s level.  

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Policy Admin and select the type of delegated legislation to take 

action on—Notifications, Circulars or Administrative Orders 

  



 

 

 
  

  

4. Search Page related to the selected delegated legislation is displayed. In the Status field, select 

"Submitted to Supervising Officer" or "Returned to Supervising Officer" and click the SEARCH button.  

  

  

 

  

5. The list of delegated legislation is displayed as per the search criteria you had selected. Click the 

Reference Number hyperlink on which you need to take action.  

  

 

  



 

 

6. The processing page of that delegated legislation is displayed. It contains table showing his tory of the 

draft. Click the documents in the Document(s) field to review them and then click the ACTION button.  

  

 

  

6. The draft of the delegated legislation as submitted by the Drafting Officer or returned by Approving 

Authority is displayed. Click BACK to go back to the previous screen or enter data in the displayed fields 

as mentioned in the following steps.  

  



 

 

 

  

  

  

6a. In the Class field, you can change the selection of the class of the delegated legislation from the 

drop-down list.  

  

6b. In the Level (in case of Circulars and Administrative Orders) /Purpose of issue (in case of 

Notifications) field, you can change the selection of the level/purpose of the delegated legislation to be 

issued from the drop-down list.  

  

6c. If required and not already linked, link the delegated legislation being created to the ones published 

previously. Please click "Linking Steps" to know more.  



 

 

  

6d. In the Subject field, you can edit the entered subject in 500 words. 

  

6e. In the Remarks field, enter the relevant text in 250 words. 

  

6f. In the Main Document field, upload the Word file of that particular delegated legislation.  

6g. If required, in the Supporting Document field, upload the PDF file of the related documents. 

  

7. To return the draft of the delegated legislation to the Drafting officer, click the RETURN button. Or, to 

forward it to Approving Authority for approval, click the SUBMIT button. 

  

8. A warning popup is displayed as per the action you take. Click the PROCEED button.  

  

 

  

9. A Success message is displayed related to the draft delegated legislation that has been submitted. 

Click the OK button to go to Search page of that delegated legislation.  

  

 



 

 

  

Note: Once the draft of the delegated legislation is submitted by the Supervising Officer, the Approving 

Authority will have <<7 days>> (from the date of submission of the draft by the Supervising Officer) to 

submit the file. Otherwise, he/she will be reminded of the same with an email alert at the end of the 7 day 

period.  

  

Go back to the Main Menu 

D. Take Action on the Draft of the Delegated Legislation 

Submitted/Returned to Approving Authority 

To take action on the draft of the delegated legislation (Circulars, Notifications or Administrative Orders) 

submitted/returned to Approving Authority, perform following steps:  

  

Note: This step can be performed by the Approving Authority only. He/she will have <<7 days>> (from 

the date of submission of the draft by the Supervising Officer) to submit the fi le. Otherwise, he/she will be 

reminded of the same with an email alert at the end of the 7 day period.  

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Policy Admin and select the type of delegated legislation to take 

action on—Notifications, Circulars or Administrative Orders 

  

 
  

  

4. Search Page related to the selected delegated legislation is displayed. In the Status field, select 

"Submitted to Approving Authority" or "Returned to Approving Authority" and click the SEARCH button.  

  

  



 

 

 

  

5. The list of delegated legislation is displayed as per the search criteria you had selected. Click the 

Reference Number hyperlink on which you need to take action.  

  

 

  

6. The processing page of that delegated legislation is displayed. It contains the table displaying the 

history of the draft. Click the documents in the Document(s) field to review them and then click the 

ACTION button.  

  



 

 

 

  

7. The draft of the delegated legislation as submitted by the Supervising Officer or returned by the Signing 

and Publishing Authority is displayed. Click BACK to go back to the previous screen or enter data in the 

displayed fields as mentioned in the following steps.  

  



 

 

 

  

6a. In the Subject field, you can edit the entered subject in 500 words. 

6b. In the Remarks field, enter the relevant text in 250 words. 

6c. In the Main Document field, upload the Word file of that particular delegated legislation.  

6d. If required, in the Supporting Document field, upload the PDF file of the related documents. 

  

7. To return the draft of the delegated legislation to the Supervising Officer, click the RETURN button. Or, 

to forward it to Signing and Publishing Authority for signing and publishing, click the SUBMIT button. 

  

8. A warning popup is displayed as per the action you take. Click the PROCEED button.  

  



 

 

 

  

9. A Success message is displayed related to the draft delegated legislation that has been submitted. 

Click the OK button to go to Search page of that delegated legislation.  

  

 

  

Note: Once the approved draft of the delegated legislation is submitted by the Approving Authority, the 

Signing and Publishing Authority informed of the same with an email alert.  

  

Go back to the Main Menu 

E. Take Action on the Approved Draft of the Delegated Legislation 

Submitted to Signing and Publishing Authority 

To take action on the approved draft of the delegated legislation (Circulars, Notifications or Administrative 

Orders) submitted to Signing and Publishing Authority, perform following steps:  

  



 

 

Note: This step can be performed by the Signing and Publishing Authority only.  

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Policy Admin and select the type of delegated legislation to take 

action on—Notifications, Circulars or Administrative Orders 

  

 
  

  

4. Search Page related to the selected delegated legislation is displayed. In the Status field, select 

"Submitted to Signing and Publishing Authority" and click the SEARCH button.  

  

  

 

  

5. The list of delegated legislation is displayed as per the search criteria you had selected. Click the 

Reference Number hyperlink on which you need to take action.  

  

 

  



 

 

6. The processing page of that delegated legislation is displayed. It contains the table displaying the 

history of the draft. Click the documents in the Document(s) field to review them and then click the 

ACTION button.  

  

 

  

7. The draft of the delegated legislation as submitted by the Approving Authority is displayed. Click BACK 

to go back to the previous screen or enter data in the displayed fields as mentioned in the following steps.  

  



 

 

 

  

Note: Signing and Publishing Officer needs to confirm if the document is legally vetted and language 

copy is available or not. If not, he/she needs to upload the original copy also.   

  

6a. In the Subject field, you can edit the entered subject in 500 words. 

6b. In the Remarks field, enter the relevant text in 250 words. 

6c. In the Main Document field, upload the Word file of that particular delegated legislation.  

6d. If required, in the Supporting Document field, upload the PDF file of the related documents. 

6e. To return the draft of the delegated legislation to the Approving Authority, click the RETURN button. 

Or, to sign and publish it, select the declaration check-box and then click the PROCEED button.  

  

8. A warning page is displayed. Click the ISSUE WITH DSC button.  

  



 

 

 

  

9. A Success message is displayed related to the delegated legislation that has been signed. Click the 

OK button to go to Search page of that delegated legislation.  

  

 

  

Note: Once the delegated legislation is signed and published by the Signing and Publishing Authority, 

following actions will take place: 

  

In case of Notifications: 

 Notification is printed, physically signed, and forwarded to the Government Press for publication 

in the Official Gazette through normal mode. In case of e-Gazette publication, the same is forwarded 

by e-mail or otherwise as prescribed for receipt by the Publishing Authority with DSC incorporated.  

 Notification is also sent to the webmaster of the Department/field formation for putting up for 

public information.  

 The centralized serial number is auto-populated in the draft notification  

 The centralised serial numbering system for the appropriate class of notifications gets updated. 

  

In case of Circulars: 

 The centralized serial number is auto-populated in the draft circular once the same is approved. 

 Circular is forwarded to the mailing list as per instructions applicable for issue of circulars.  

 Circular is also sent to the webmaster of the Department/field formation for putting up for public 

information.  

 The centralised serial numbering system for the appropriate class of circulars gets updated.  



 

 

 In case of press note, the same is also issued to the Press Information Bureau for communication 

to the media. The press note will also be hosted on the GST portal under the head ‘Press Release’.  

  

In case of Administrative Orders: 

 The centralized serial number is auto-populated in the draft Administrative Orders upon approval. 

 Administrative Orders is also sent to the webmaster of the Department/field formation for putting 

up for public information.  

 The centralised serial numbering system for the appropriate class of Administrative Orders gets 

updated. 

 The Administrative Order is forwarded to the BO Official for updation of the Role / Jurisdictional 

mapping. 

 Copy of the Administrative Order shall also be forwarded to the officers concerned through e-mail 

besides making it available on their dashboard. 

 The charge has to be transferred from one BO user to another BO user on issuance of 

transfer/promotion/deputation/demotion/order. 

  

  

Go back to the Main Menu 
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Conducting Prosecution Proceedings 

FAQs > Conducting Prosecution Proceedings 

1. Which all Tax Official Roles are involved in Prosecution Proceedings? 

Following three Tax Official roles can be defined on the GST Portal by the State Admin to conduct 

Prosecution proceedings:  

  

1. Prosecution and Compounding Officer (defined at the Jurisdiction level) also known as "P&C 

Officer": Initiates Prosecution proceedings by creating a Prosecution Proposal and submits it for the 

review of Prosecution and Compounding Senior Officer (P&C Senior Officer). Once the P&C Senior 

Officer issues "Initiate Prosecution" Order, the P&C Officer will file the Prosecution Complaint and 

issue Notice to the Taxpayer for making the payment of compounding amount, if any.  

2. Prosecution and Compounding Senior Officer (defined at the State level) also known as "P&C 

Senior Officer": Reviews the Prosecution Proposal submitted by the P&C Officer and issues "Initiate 

Prosecution" Order or "Reject Proposal".  

3. Assistant to Commissioner (defined at the State level): Performs all functions of P&C Senior 

Officer on his/her behalf.  

2. What are the steps involved in Prosecution Proceedings? 

Following steps are involved in Prosecution Proceedings: 

  

1. P&C Officer initiates Prosecution proceedings by creating a Prosecution Proposal and submits it for the 

review of Prosecution and Compounding Senior Officer (P&C Senior Officer).  

2. P&C Senior Officer reviews the Prosecution Proposal and may, if required, send a Memo to P&C 

Officer seeking additional information. In this case, the Proposal Status gets changed to "Additional 

information sought".  

3. P&C Officer submits his/her response to the additional information asked. In this case, the Proposal 

Status gets changed to "Additional information submitted".  

4. Once the P&C Senior Officer is satisfied with the response and has completed the review, he/she will 

take one of the following actions: Initiate the Proposal or Reject the Proposal.  

 In case of rejection, Proposal is dropped, Status is updated as "Proposal dropped".  

 In case of the acceptance of proposal, Status is updated as "Direction issued for prosecution" and 

following steps take place.  

5. P&C Officer files a private complaint offline with the First Class Judicial Magistrate/Court after taking 

print of the order of approval from the P&C Senior Officer for prosecution.  

6. P&C Officer adds the complaint details on the GST Portal. Status is updated as "Complaint filed"  



 

 

7. P&C Officer issues the Notice against the accused intimating about the initiation of prosecution 

proceedings.  

Note: With the issue of the Notice, following actions take place on the GST Portal:  

 Intimation of the issue of Notice is sent to the concerned taxpayer on his/her registered email id 

and mobile.  

 Dashboard of the Taxpayer is updated with the record of the issued Notice. He/she can view the 

issued Notice from the following navigation: Services > User Services > View Additional 

Notices/Orders. 

8. In accordance with the subsequent proceedings for that case against the complaint filed offline, P&C 

Officer updates the complaint status on the GST Portal.  

9. In case of subsequent Compounding Proceedings once the Order granting compounding is issued, the 

P&C Officer closes the complaint. Status of the Proposal gets updated to "Closed".  

3. What folders or tabs are available on the GST Portal for the Tax Official 

to conduct Prosecution Proceedings? 

GST Portal organizes the Prosecution Proposal on the "Case View" screen into the following 5 folders.  

1. PROSECUTION PROPOSAL: To download and view the Proposal for Prosecution and its supporting 

documents.  

2. NOTICES: To issue Notice to the Taxpayer 

3. ORDERS: To issue Orders ("Reject Proposal" or "Initiate Proposal") and view/download them 

4. PROSECUTION COMPLAINT: To file complaint against the Taxpayer 

5. INTERNAL COMMUNICATION: To add Memos and ask/provide additional information before issuing 

Order or sending Notice to the Taxpayer 

  

These folders are click able tabs. Tax Officials can click them and access the related information.  

4. How can I file the Prosecution Complaint on the GST Portal? 

A Prosecution Complaint cannot be filed online on the GST Portal. You must file this offline with the First 

Class Judicial Magistrate/Court. Once the complaint is filed, you can add the complaint details on the 

GST Portal using the PROSECUTION COMPLAINT tab. 

5. I have been assigned the role of P&C Senior Officer. Can I issue Notice? 

No, only the P&C Officer will add Notice. You, as a P&C Senior Officer, can only download and view the 

issued Notice. 

6. In what cases, can I close the Prosecution Complaint? 

You can close the Prosecution Complaint in the following cases:  



 

 

 If the prosecution complaint has been filed with the Magistrate and compounding is allowed by 

department, Tax officer will withdraw the complaint filed with the Magistrate / Court of competent 

jurisdiction, subject to payment of compounding amount by the taxpayer.  

 If no prosecution complaint has been filed with the Magistrate and compounding is allowed, no 

prosecution proceeding shall be initiated with the Magistrate / Court of competent jurisdiction subject 

to payment of compounding amount by the taxpayer. 

  

Note: 

 If the prosecution complaint has been filed with the Magistrate and compounding is not allowed, 

Tax officer will not take any action to withdraw the complaint and prosecution proceeding will 

continue in the Court of the Magistrate / Court of competent jurisdiction.  

 If no prosecution complaint has been filed with the Magistrate and compounding is not al lowed, 

Tax officer will proceed with prosecution proceeding. 

7. During Prosecution Proceedings, what all Status changes does the 

Proposal undergo? 

During Prosecution Proceedings, the Proposal undergoes following Status changes:  

Prosecution proposal Submitted: When prosecution proposal is successfully submitted by P&C Officer 

to P&C Senior Officer 

Additional information sought: When additional information is sought by P&C Senior Officer 

Additional information submitted: When additional information is submitted by P&C Officer to P&C 

Senior Officer 

Proposal dropped: When Proposal is dropped/rejected by P&C Senior Officer 

Direction issued for prosecution: When order is issued for prosecution by P&C Senior Officer 

Complaint filed: When details of prosecution complaint is uploaded by P&C Officer 

Closed: When status of complaint is updated as closed by P&C Officer 

  

  



 

 

 

Manual (BO) > Conducting Prosecution 
Proceedings 

How can I conduct Prosecution proceedings? 

To conduct Prosecution proceedings, perform the following steps: 

  

Note: Following three Tax Official roles can be defined on the GST Portal by the State Admin to conduct 

Prosecution proceedings:  

  

1. Prosecution and Compounding Officer (defined at the Jurisdiction level) also known as "P&C 

Officer": Initiates Prosecution proceedings by creating a Prosecution Proposal and submits it for the 

review of Prosecution and Compounding Senior Officer (P&C Senior Officer). Once the P&C Senior 

Officer issues "Initiate Prosecution" Order, the P&C Officer will file the Prosecution Complaint and 

issue Notice to the Taxpayer for making the payment of compounding amount, if any.  

2. Prosecution and Compounding Senior Officer (defined at the State level) also known as "P&C 

Senior Officer": Reviews the Prosecution Proposal submitted by the P&C Officer and issues "Initiate 

Prosecution" Order or "Reject Proposal".  

3. Assistant to Commissioner (defined at the State level): Performs all functions of P&C Senior 

Officer on his/her behalf.  

  

 Steps  

Tax Official Roles 

Responsible for Performing 

the Steps on the GST Portal 

A. Create a New Proposal for Prosecution and submit it for 

review 

  
  P&C Officer 

Note:  

Once a Proposal for Prosecution is submitted, a Reference Number is generated which will be the 

ARN/Case ID of the Proposal for Prosecution. GST Portal organizes this proposal on the "Case 

View" screen into the following 5 folders. These folders are click able tabs. Tax Officials can click 

them and access the related information.  

1. PROSECUTION PROPOSAL: To download and view the Proposal for Prosecution and its 

supporting documents.  

2. NOTICES: To issue Notice to the Taxpayer 

3. ORDERS: To issue Orders ("Reject Proposal" or "Initiate Proposal") and view/download 

them 

4. PROSECUTION COMPLAINT: To file complaint against the Taxpayer 

5. INTERNAL COMMUNICATION: To add Memos and ask/provide additional information 



 

 

before issuing Order or sending Notice to the Taxpayer 

     

    B. Go to the "Prosecution Inbox" to view the Open Proposals or 

Search for Them 

 P&C Officer 

 P&C Senior Officer or 

Assistant to Commissioner 

     

    C. From PROSECUTION PROPOSAL tab: Download Proposal 

for Prosecution and the supporting documents 

 P&C Officer 

 P&C Senior Officer or 

Assistant to Commissioner 

  

D. From INTERNAL COMMUNICATION tab: Add Memo to 

ask/provide additional information related to the 

Prosecution Proposal or Complaint 

  

Note: This is an optional step for the P&C Senior Officer. He/she 

may skip this step and directly perform Step E. 

  

 P&C Senior Officer 

seeks information 

 P&C Officer provides 

information 

E. From ORDERS tab:  

E(1). Reject Proposal 

Or 

E(2). Initiate Proposal 

 P&C Officer 

 P&C Senior Officer or 

Assistant to Commissioner 

  

Note: Only the P&C Senior 
Officer can issue Order. P&C 
Officer can only view/download 
it. 

F. File a private Prosecution Complaint offline with the First 

Class Judicial Magistrate/Court after taking print of the 

"Initiate Proposal" Order from the P&C Senior Officer.  

  

Note: A Prosecution Complaint cannot be filed online on the GST 

  P&C Officer 



 

 

Portal. Thus, this step takes place offline.  

G. From PROSECUTION COMPLAINT tab: Add or Update 

Prosecution Complaint Details Online on the GST Portal 

 P&C Officer 

 P&C Senior Officer or 

Assistant to Commissioner 

  

Note: Only the P&C Officer will 
add or update the complaint. P&C 
Senior Officer will only review 
and provide suggestions for 
update, if required. 

H. From NOTICES tab: Issue Notice 

 P&C Officer 

 P&C Senior Officer or 

Assistant to Commissioner 

    
Note: Only the P&C Officer will 
add Notice. P&C Senior Officer 
will only download and view it. 

I. From PROSECUTION COMPLAINT tab: Close Complaint 

  

  

  

 P&C Officer 

 P&C Senior Officer or 

Assistant to Commissioner 

  

Note: Only the P&C Officer 
can close the complaint on 
GST Portal. P&C Senior 

Officer can only download and 
view the closed complaint on 

GST Portal.  

  

  

Click each hyperlink in the "Steps" column above to know more.  

  

A. Create a New Proposal for Prosecution and Submit it for Review  

To create a New Proposal for Prosecution and submit it for review, perform following steps:  

  

Note: This step will be performed by the P&C Officer only.  

  

1. Access the GST Back Office Portal for tax officials.  



 

 

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Prosecution and Compounding > Prosecution Proposal option. 

  

 

  

4. Prosecution Inbox Search screen gets displayed. Click the NEW PROPOSAL button. 

  

 

  

5. Proposal for Prosecution screen is displayed. Click BACK to go back to the previous screen or enter 

data in the displayed fields as mentioned in the following steps:  

  



 

 

 



 

 

  

  

5a. Select Yes or No radio buttons to confirm if this proposal is being created against a previous Order or 

not.  

5a.(i) If you select "No", all fields related to Order will get removed. Enter GSTIN/Temporary ID/UIN and 

click on any blank area of the screen. The Legal Name field will get auto-populated.  

  

 

  

  

5a.(ii) If you select "Yes", select the Order No. and click SEARCH. The fields related to the selected 

Order—Date of Order, GSTIN/Temporary ID/UIN and Legal Name will get auto-populated.  

  

 

  

  

5b. In the Period of Offence field, select the "From" and "To" date from Calendar.  

  



 

 

 

  

5c. In the Amount of evasion involved field, enter the amount. 

  

 

  

Note: In case, you are creating this proposal based on an issued Order, Amount of evasion involved 

field will be auto-populated with the amount mentioned in the Order. You can edit it, if required.  

  

5d. Select the check-box or check-boxes, based on which you are initiating prosecution. 

  

 

  

Note: In case (g), (j) or (k) provisions are selected, the Amount of evasion involved can be nil.  

  



 

 

5e. Enter the details of the person to be prosecuted and click the ADD button. The details will be added in 

the Additional Accused Detail section. You can edit them using the EDIT button or delete using the 

DELETE button and add again.  

  

Note:  

  

 It is mandatory to fill the following fields—Name, Father's Name, Date of Birth, Sex, Address, 

Summary of Role played in the Offence.  

 Enter data in the following fields as available—PAN, Aadhaar Number, Passport Number, 

Driving License, Voter ID or Other document for ID & address proof. Please note that entering 

data in minimum one field is required to proceed further.  

 All the data fields left blank by you will be auto-populated as “NA”.  

  

 

  

Note: In case you wish to add details of more than one persons to be prosecuted, follow the same 

procedure as above and click the ADD button. You can add details of up to 100 persons in one Proposal.  



 

 

  



 

 

 



 

 

  

5f. If required, in the Upload Supporting Documents, if any field, you can also upload supporting 

documents. This is not a mandatory field. Enter document description and click the Choose File button. 

ADD DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. You can 

delete the uploaded document by clicking the DELETE button and upload again.  

  

  

 

  

5g. Click PREVIEW and a system-generated draft proposal gets downloaded into your machine. Check it  

carefully to rule out any discrepancy.  

  



 

 

 



 

 

  

5j. Click the PROCEED TO FILE button.  

5k. A warning message pop-up gets displayed. Click the PROCEED button. 

  

 

  

6. Proposal Submission Acknowledgement is displayed with the generated Reference no. Click OK.  

  

 

  

7. Case View screen gets displayed. All proceedings related to this Proposal will take place from this 

screen.  

  

 



 

 

  

Go back to the Main Menu 

B. Go to the "Prosecution Inbox" to view the Open Proposals or Search for 

Them.   

To go to the "Prosecution Inbox" and view the Open Proposals or Search for them, perform following 

steps: 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Prosecution and Compounding > Prosecution Proposal option. 

  

 

  

4. Prosecution Inbox Search screen gets displayed. Open Proposals are displayed in the table below 

the SEARCH section. You can select the buttons at the bottom of the page to display the required 

number of open proposals and then click any of the Proposal No. hyperlinks to open it. Or, you can 

choose any one of the fields displayed on the top as your search criteria and enter the required 

information as mentioned in the following steps:  

  



 

 

 

  

Note: On the "Prosecution Inbox Search" screen, the NEW PROPOSAL button will be visible to only the 

P&C Officer.  

  

4a. Enter Proposal No. 

4b. Enter GSTIN/Temporary ID/UIN. 

4c. Select Status from the drop-down list. 

  

 

  

4d. Enter date in the From & To fields. 



 

 

4e. Click the SEARCH button. 

  

5. Based on your search criteria, the required proposal or the list of the required proposals gets 

displayed. Click any of the Proposal No. hyperlinks to open it and carry out further proceedings.  

  

 

  

6. Case View screen gets displayed. All proceedings related to this Proposal will take place from this 

screen.  

  

 

  

  

Go back to the Main Menu 

C. From PROSECUTION PROPOSAL tab: Download Proposal for 

Prosecution and The Supporting Documents 



 

 

To download Proposal for Prosecution and the related supporting documents from the PROSECUTION 

PROPOSAL tab, perform following steps: 

  

1. On the Case View page of that particular proposal, select the PROSECUTION PROPOSAL tab, 

if it is not selected by default. This tab displays the hyperlinks to download and view all details related 

to the Proposal for Prosecution. You can also click the hyper-links of the Electronic Liability Registers 

Part-1 and Part-2 provided on the right-side of the page to view liabilities of the taxpayer.  

  

 

  

2. Click the document name(s) in the View Document section of the table to download into your machine 

and view them.  

3. Click the two links above the table to view the electronic liability register Part -I and Part-II.  

  

Go back to the Main Menu 

D. From INTERNAL COMMUNICATION tab: Add Memo to ask/provide 

additional information  

A Memo is added by P&C Senior Officer to seek further clarifications, if required, from the P&C Officer on 

the Prosecution Proposal. P&C Officer will reply to the sought clarifications by using the same 

functionality of adding Memo as described below.  

  

To add Memo, perform following steps: 

  

1. On the Case View page of that particular proposal, select the INTERNAL COMMUNICATION tab. This 

tab lists the Memos exchanged between the P&C Officer and P&C Senior Officer. Click ADD MEMO. 

  



 

 

 

  

Note: Current Case Status is "Prosecution proposal submitted". It will change once the P&C Senior 

Officer adds the Memo.  

  

2. Memo page is displayed. Click BACK to go back to the previous screen or enter data in the displayed 

fields as mentioned in the following steps:  

  

 

  

2a. In Memo for Additional Information field, enter text outlining your questions or information you want 

to seek.  



 

 

2b. If required, in the Upload Supporting Documents field, you can also upload supporting documents. 

This is not a mandatory field. Enter document description and click the Choose File button. ADD 

DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. You can delete 

the uploaded document by clicking the DELETE button and upload again.  

  

  

 

  

2c. Click SUBMIT. 

2d. A warning popup is displayed. Click PROCEED.  

  

 

  

3. The updated INTERNAL COMMUNICATION tab is displayed with the added Memo and the Status 

gets changed to "Additional information sought". 



 

 

  

 

  

Note: The P&C Officer will follow the same steps outlined above to reply to this Memo. Once he/she 

submits the reply, the case Status would change to "Additional information submitted".  

  

 

  

Go back to the Main Menu 

E(1). From ORDERS tab: Reject Proposal 

To reject Proposal for Prosecution, perform following steps: 

  

Note: After reviewing the submitted Proposal, P&C Senior Officer will issue an Order either rejecting or 

initiating the Proposal. Only the P&C Senior Officer can issue the Order. P&C Officer can only view and 

download this Order.  

  

1. On the Case View page of that particular proposal, select the ORDERS tab. This tab will list the Orders 

issued against the Proposal. Click ADD ORDER and select Reject Proposal.  

  



 

 

 

  

Note: Current Case Status is "Prosecution proposal submitted". It will change once the P&C Senior 

Officer issues the Order. 

  

2. Rejection of Prosecution Proposal page gets displayed. Click BACK to go back to the previous 

screen or enter data in the displayed fields as mentioned in the following s teps:  

  



 

 

 

  

2a. Click the Generate Reference Number hyperlink. Reference no. field gets auto-populated.   

2b. In the Reason for rejecting the proposal field, enter the relevant details 

2c. If required, in the Upload Supporting Documents field, you can also upload supporting documents. 

This is not a mandatory field. Enter document description and click the Choose File button. ADD 

DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. You can delete 

the uploaded document by clicking the DELETE button and upload again.  

  



 

 

  

 

  

2d. Click the PROCEED button.  

2e. A warning message pop-up gets displayed. Click the PROCEED button on this pop-up also.  

  

 

  

3. The Notice/Reminder/Order screen is displayed with a Warning message. On this screen, click the 

ISSUE WITH DSC button.  

  



 

 

 

  

4. Dashboard page is displayed with the generated reference no. Click OK.  

  

 

  

5. The updated ORDERS tab is displayed with the added Order and the Status gets changed to "Proposal 

dropped".  

  

 

  

6. Additionally, the dashboard of the P&C Officer also gets updated with the issued Order. No further 

action can be taken by the Tax officer on a Proposal with status “Proposal dropped”.  

  

Go back to the Main Menu 



 

 

E(2). From ORDERS tab: Initiate Proposal 

To initiate Proposal for Prosecution, perform following steps: 

  

Note: After reviewing the submitted Proposal, P&C Senior Officer will issue an Order either rejecting or 

initiating the Proposal. Only the P&C Senior Officer can issue the Order. P&C Officer can only view and 

download this Order.  

  

1. On the Case View page of that particular proposal, select the ORDERS tab. This tab will list the Orders 

issued against the Proposal. Click ADD ORDER and select Initiate Proposal.  

  

 

  

Note: Current Case Status is "Prosecution proposal submitted". It will change once the P&C Senior 

Officer issues the Order. 

  

2. Order for Initiation of Prosecution proceedings page gets displayed. Click BACK to go back to the 

previous screen or enter data in the displayed fields as mentioned in the following steps:  

  



 

 

 

  

2a. Click the Generate Reference Number hyperlink. Reference no. field gets auto-populated.   

2b. If required, in the Upload Supporting Documents field, you can also upload supporting documents. 

This is not a mandatory field. Enter document description and click the Choose File button. ADD 

DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. You can delete 

the uploaded document by clicking the DELETE button and upload again.  

  



 

 

  

 

  

2c. Click PREVIEW and a system-generated draft Order gets downloaded into your machine. Check it  

carefully to rule out any discrepancy. 

  



 

 

 



 

 

  

2d. Click the PROCEED button.  

2e. A warning message pop-up gets displayed. Click the PROCEED button on this pop-up also.  

  

 

  

3. The Notice/Reminder/Order screen is displayed with a Warning message. On this screen, click the 

ISSUE WITH DSC button.  

  

 

  

4. Dashboard page is displayed with the generated Order no. Click OK.  

  



 

 

 

  

5. The updated ORDERS tab is displayed with the added Order and the Status gets changed to "Direction 

issued for Prosecution". 

  

 

  

6. Additionally, the dashboard of the P&C Officer also gets updated with the issued Order. Now, he/she 

would go ahead with the Prosecution Proceedings.  

  

Go back to the Main Menu 

G. From PROSECUTION COMPLAINT tab: Add or Update Prosecution 

Complaint Details Online on the GST Portal 

To add or update Prosecution Complaint details online on the GST Portal, perform following steps:  

  

Note: After the P&C Senior Officer has passed the Order to initiate proposal, P&C Officer will file a 

complaint offline with the First Class Judicial Magistrate/Court. Once the complaint is filed, he/she will add 

the complaint details on the GST Portal. Only the P&C Officer can add or update the Prosecution 

Complaint details on the GST Portal. P&C Senior Officer can only view and download the added or 

updated Complaint on the GST Portal. 

  

1. On the Case View page of that particular proposal, select the PROSECUTION COMPLAINT tab. This 

tab will list the Complaint details filed against the Proposal. Click ADD/UPDATE.  

  



 

 

 

  

  

Note 1: Current Case Status is "Direction issued for Prosecution". It will change once the P&C Officer 

adds the complaint. 

  

Note 2: Once the P&C Senior Officer has passed the "Initiate Proposal" Order, the ADD/UPDATE button 

gets enabled.  

  

2. Prosecution complaint details page gets displayed. Click BACK to go back to the previous screen or 

enter data in the displayed fields as mentioned in the following steps:  

  



 

 

 

  

2a. Click the Generate Reference Number hyperlink. Reference no. field gets auto-populated.   

2b. In Court in which Prosecution complaint has been filed field, enter the name of the Court. 

2c. In Complaint No. field, enter the complaint number.  

2d. In the Date of filing field, select date from the calendar.  

2e. In the Complaint under which section of CrPC field, enter the section number.  

2f. In the Nature of Offence field, enter the relevant details related to the nature of offence. 

2g. In the Description as in complaint field, enter the relevant details related to the filed complaint.  

2b. If required, in the Upload Supporting Documents field, you can also upload supporting documents. 

This is not a mandatory field. Enter document description and click the Choose File button. ADD 

DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. You can delete 

the uploaded document by clicking the DELETE button and upload again.  

  



 

 

  

 

  

2c. Click PREVIEW and a system-generated draft complaint details gets downloaded into your machine. 

Check it carefully to rule out any discrepancy.  

  



 

 

 

  

2d. Click the PROCEED button.  

2e. A warning message pop-up gets displayed. Click the PROCEED button. 

  



 

 

 

  

3. Click the ISSUE WITH DSC button.  

  

 

  

4. Dashboard page is displayed with the generated Reference no. Click OK.  

  

 

  

5. The updated PROSECUTION COMPLAINT tab is displayed with the added complaint details and the 

Status gets changed to "Complaint filed". 



 

 

  

 

  

6. In accordance with the subsequent proceedings against the complaint filed offline, P&C Officer should 

update the complaint status on the GST Portal. Follow the same steps 1 to 5 mentioned above to update 

the details. Once you open the Prosecution complaint details page (as mentioned in Step 2), following 

details will be auto-populated and disabled—"Court in which Prosecution complaint has been filed", 

"Complaint No.", "Date of filing", "Complaint under which section of CrPC", "Nature of Offence". Enter 

details in the other fields as mentioned above.  

  



 

 

 

  

Note: When required, you can also close the Proposal using the "Close Complaint", also available on this 

page.   

  

Go back to the Main Menu 

  

H. From NOTICES tab: Issue Notice 

To issue Prosecution Notice, perform following steps: 

  



 

 

Note: On receipt of the direction to file complaint against accused, P&C Officer will issue a notice to the 

accused about initiation of prosecution proceedings. P&C Senior Officer can only view and download the 

issued Notice on the GST Portal.  

  

1. On the Case View page of that particular proposal, select the NOTICES tab. This tab will list the Notice 

issued against the Proposal. Click ADD NOTICE.  

  

 

  

Note: Once the P&C Officer has added the Prosecution Complaint details in the PROSECUTION 

COMPLAINT tab, the ADD NOTICE button gets enabled.  

  

2. Notice page gets displayed. Click BACK to go back to the previous screen or enter data in the 

displayed fields as mentioned in the following steps:  

  



 

 

 

  

2a. Click the Generate Reference Number hyperlink. Reference no. field gets auto-populated.   

2b. In the Description of Notice  field, enter the relevant details. 

2c. In the Upload Notice Document field, click Choose File to upload the PDF form of the notice.  

2d. If required, in the Upload Supporting Documents field, you can also upload supporting documents. 

This is not a mandatory field. Enter document description and click the Choose File button. ADD 

DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. You can delete 

the uploaded document by clicking the DELETE button and upload again.  

  



 

 

  

 

  

2d. Click the PROCEED button.  

2e. A warning message pop-up gets displayed. Click the PROCEED button. 

  

 

  

3. Click the ISSUE WITH DSC button.  

  



 

 

 

  

4. Dashboard page is displayed with the generated Notice no. Click OK.  

  

 

  

  

5. The updated NOTICES tab is displayed with the issued Notice. 

  

 

  

6. With the issue of the Prosecution Notice, following actions take place on the GST Portal:  

 Intimation of the issue of Notice is sent to the concerned taxpayer on his/her registered email id 

and mobile.  



 

 

 Dashboard of the Taxpayer is updated with the record of the issued Notice. He/she can view the 

issued Notice from the following navigation: Services > User Services > View Additional 

Notices/Orders. 

  

Go back to the Main Menu 

I. From PROSECUTION COMPLAINT tab: Close Complaint 

To close complaint, perform following steps: 

  

Note1: You can close the Prosecution Complain in the following cases:  

 If the prosecution complaint has been filed with the Magistrate and compounding is allowed by 

department, Tax officer will withdraw the complaint filed with the Magistrate / Court of competent 

jurisdiction, subject to payment of compounding amount by the taxpayer.  

 If no prosecution complaint has been filed with the Magistrate and compounding is allowed, no 

prosecution proceeding shall be initiated with the Magistrate / Court of competent jurisdiction subject 

to payment of compounding amount by the taxpayer. 

  

Note2: Only the P&C Officer can close the Prosecution Complaint on GST Portal. P&C Senior Officer can 

only view and download the closed Complaint details on GST Portal.  

  

1. On the Case View page of that particular proposal, select the PROSECUTION COMPLAINT tab. This 

tab will list the Complaint details filed against the Proposal. Click ADD/UPDATE.  

  

 

  

2. Prosecution complaint details page gets displayed. Click BACK to go back to the previous screen or 

enter data in the displayed fields as mentioned in the following steps:  

  



 

 

 

  

2a. Click the Generate Reference Number hyperlink. Reference no. field gets auto-populated.   

2b. In the Description as in complaint field, enter the relevant details related to the filed complaint.  

2c. If required, in the Upload Supporting Documents field, you can also upload supporting documents. 

This is not a mandatory field. Enter document description and click the Choose File button. ADD 

DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. You can delete 

the uploaded document by clicking the DELETE button and upload again.  

  



 

 

  

 

  

2d. Click PREVIEW and a system-generated draft Complaint details gets downloaded into your machine. 

Check it carefully to rule out any discrepancy.  

  

 



 

 

  

2d. Click the Close Complaint button.  

2e. A warning message pop-up gets displayed. Click the PROCEED button. 

  

 

  

3. Click the ISSUE WITH DSC button.  

  

 

  

4. Dashboard page is displayed with the generated Reference no. Click OK.  

  



 

 

 

  

5. The updated PROSECUTION COMPLAINT tab is displayed with the closed complaint details and the 

Status gets changed to "Closed". 

  

 

  

6. Dashboard of the Taxpayer is updated with the record of the closed complaint. He/she can view the 

closed complaint from the following navigation: Services > User Services > View Additional 

Notices/Orders. 

  

Go back to the Main Menu 

  



 

 

Processing Application for Compounding of Offence 

FAQs > Processing Application for 
Compounding of Offence (Form GST CPD-01) 

1. Which all Tax Official Roles are involved in Compounding Proceedings? 

Following three Tax Official roles can be defined on the GST Portal by the State Admin to conduct case 

proceedings related to compounding:  

  

1. Prosecution and Compounding Officer (defined at the Jurisdiction level) also known as "P&C 

Officer": Is the concerned Tax Official who had issued Notice for initiation of Prosecution 

Proceedings to the Taxpayer, with details of compounding fee to be paid. During the compounding 

proceedings, he/she will act as a Department Respondent and perform functions like filing reply or 

filing rectification and appearing for hearing as directed by the Commissioner.  

2. Prosecution and Compounding Senior Officer (defined at the State level) also known as "P&C 

Senior Officer": Is the Commissioner who will process the Compounding Application filed by the 

Taxpayers.  

3. Assistant to Commissioner (defined at the State level): Performs all functions of P&C Senior 

Officer on his/her behalf.  

2. What happens on the GST Portal once the Application for Compounding 

of Offence (Form GST CPD-01) is filed by a Taxpayer? 

Once the Application for Compounding of Offence (Form GST CPD-01) is filed by a Taxpayer, following 

actions take place on the GST Portal: 

 Status of the application on the GST Portal gets updated to "Compounding Application 

Submitted".  

 Dashboard of Taxpayer and the Tax Officials is updated with the record of the filed Application.  

 Taxpayer will receive an intimation on his/her registered Mobile and email informing about the 

successful filing of the application and the generated ARN. 

 Tax Officials will receive an intimation on their registered email informing them about the filed 

application and the generated ARN. 

 "My Tasks" page of the Tax Officials who are assigned the role of "P&C Senior Officer" and 

"Assistant to Commissioner", gets updated with this work-item.  

3. What happens on the GST Portal once the Commissioner issues the 

Hearing Notice? 



 

 

Once the Commissioner issues the Hearing Notice, following actions take place on the GST Portal:  

  

 ARN Status on the GST Portal gets updated to "Hearing notice issued".  

 Intimation of the issue of Notice is sent to the concerned recipient(s). In case the recipient is the 

Taxpayer, he/she will receive intimation on both— registered Mobile and email. In case the recipient 

is the Tax Official (role of P&C Officer), he/she will receive intimation on only his/her registered email.  

 Dashboard of the Taxpayer is updated with the record of the issued Notice. He/she can view the 

issued Notice from the following navigation: Services > User Services > My Applications  > 

NOTICES. 

 Dashboard of the Tax Official (role of P&C Officer) is updated with the record of the issued 

Notice. He/she can view the issued Notice from the following navigation: Statutory Functions > 

Prosecution and Compounding > Compounding Application > NOTICES or from the My Tasks 

page: Statutory Functions > My Tasks > Reference Id > NOTICES  

  

4. What happens on the GST Portal once the Commissioner issues the 

Adjournment Notice? 

Once the Commissioner issues the Adjournment Notice, following actions take place on the GST Portal:  

  

 ARN Status on the GST Portal gets updated to "Adjournment granted".  

 Intimation of the issue of Notice is sent to the concerned recipient(s). In case the recipient is the 

Taxpayer, he/she will receive intimation on both— registered Mobile and email. In case the recipient 

is the Tax Official (role of P&C Officer), he/she will receive int imation on only his/her registered email. 

 Dashboard of the Taxpayer is updated with the record of the issued Notice. He/she can view the 

issued Notice from the following navigation: Services > User Services > My Applications  > 

NOTICES. 

 Dashboard of the Tax Official (role of P&C Officer) is updated with the record of the issued 

Notice. He/she can view the issued Notice from the following navigation: Statutory Functions > 

Prosecution and Compounding > Compounding Application > NOTICES or from the My Tasks 

page: Statutory Functions > My Tasks > Reference Id > NOTICES  

  

5. What happens on the GST Portal once the P&C Officer files 

reply/counter-reply? 

Once the P&C Officer files a reply/counter-reply, following actions take place on the GST Portal:  

 ARN Status on the GST Portal gets updated to "Reply submitted".  

 P&C Senior Officer/Assistant to Commissioner will be intimated via their registered email and the 

Taxpayer will receive intimation on both— registered Mobile and email. 



 

 

 Dashboard of the Taxpayer is updated with the record of the filed reply. He/she can view the it 

from the following navigation: Services > User Services > My Applications  > REPLIES. 

 Dashboard of the Tax Official roles is updated with the record of the filed reply. They can view the 

of the filed reply from the following navigation: Statutory Functions > Prosecution and 

Compounding > Compounding Application > REPLIES or from the "My Tasks" page: Statutory 

Functions > My Tasks > Reference Id > REPLIES  

  

Note: P&C Officer will not be able to view his filed reply in the "My Tasks" page. 

6. What happens on the GST Portal once the P&C Senior Officer/Assistant 

to Commissioner files reply/counter-reply? 

Once the P&C Senior Officer/Assistant to Commissioner files reply/counter-reply, following actions take 

place on the GST Portal: 

 ARN Status on the GST Portal gets updated to "Reply submitted".  

 P&C Officer will be intimated via his/her registered email and the Taxpayer will receive intimation 

on both— registered Mobile and email. 

 Dashboard of the Taxpayer is updated with the record of the filed reply. He/she can view the it 

from the following navigation: Services > User Services > My Applications  > REPLIES. 

 Dashboard of the P&C Senior Officer/Assistant to Commissioner is updated with the record of the 

filed reply. They can view the of the filed reply from the following navigation: Statutory Functions > 

Prosecution and Compounding > Compounding Application > REPLIES. P&C Officer will be 

able to view it from the "My Tasks" page: Statutory Functions > My Tasks > Reference Id > 

REPLIES 

  

Note: P&C Senior Officer/Assistant to Commissioner  will not be able to view their filed reply in the "My 

Tasks" page. 

7. What happens on the GST Portal once the Taxpayer files reply/counter-

reply? 

Once the Taxpayer files reply/counter-reply, following actions take place on the GST Portal:  

 ARN Status on the GST Portal gets updated to "Reply submitted".  

 All Tax Officials (P&C Senior Officer, Assistant to Commissioner and P&C Officer) will be 

intimated via their registered email.  

 Dashboard of the Taxpayer is updated with the record of the filed reply. He/she can view the it 

from the following navigation: Services > User Services > My Applications  > REPLIES. 

 Dashboard of all the Tax Official roles is updated with the record of the filed reply. They can view 

the of the filed reply from the following navigation: Statutory Functions > Prosecution and 



 

 

Compounding > Compounding Application > REPLIES or from the "My Tasks" page: Statutory 

Functions > My Tasks > Reference Id > REPLIES  

  

8. What happens on the GST Portal once the Commissioner grants 

compounding? 

Once the Commissioner grants compounding, following actions take place on the GST Portal:  

  

 ARN Status on the GST Portal gets updated to "Compounding allowed".  

 Intimation of the issue of Order is sent to all the parties. The Taxpayer will receive intimation on 

both— registered Mobile and email. The Tax Official (role of P&C Officer) will receive intimation on 

only his/her registered email. 

 Dashboard of the Taxpayer is updated with the record of the issued Order. He/she can view the 

issued Notice from the following navigation: Services > User Services > My Applications  > 

ORDERS. 

 Dashboard of the Tax Official (role of P&C Officer) is updated with the record of the issued 

ORDER. He/she can view the issued Notice from the following navigation: Statutory Functions > 

Prosecution and Compounding > Compounding Application > ORDERS  

9. What happens on the GST Portal once the Commissioner rejects 

compounding? 

Once the Commissioner rejects compounding, following actions take place on the GST Portal:  

 ARN Status on the GST Portal gets updated to "Compounding Rejected".  

 Intimation of the issue of Order is sent to all the parties. The Taxpayer will receive intimation on 

both— registered Mobile and email. The Tax Official (role of P&C Officer) will receive intimation on 

only his/her registered email. 

 Dashboard of the Taxpayer is updated with the record of the issued Order. He/she can view the 

issued Notice from the following navigation: Services > User Services > My Applications  > 

ORDERS. 

 Dashboard of the Tax Official (role of P&C Officer) is updated with the record of the issued 

ORDER. He/she can view the issued Notice from the following navigation: Statutory Functions > 

Prosecution and Compounding > Compounding Application > ORDERS  

  

10. What happens on the GST Portal once the Commissioner withdraws 

compounding? 

Once the Commissioner withdraws compounding, following actions take place on the GST Portal:  



 

 

 Status of the ARN shall get updated to "Compounding Withdrawn". 

 Henceforth, no action can be performed, by the Taxpayer or the Tax Officials, on the withdrawn 

ARN.  

  

Note: The Commissioner may, as per his/her discretion, withdraw Compounding at any stage during the 

processing of the Compounding Application.   

  

11. What happens on the GST Portal once the Commissioner passes a 

Rectification Order? 

With the issue of the Rectification Order, following actions take place on the GST Portal:  

 ARN on the GST Portal gets updated to "Rectification order passed".  

 Intimation of the issue of Order is sent to all the parties. The Taxpayer will receive intimation on 

both— registered Mobile and email. The Tax Official (role of P&C Officer) will receive intimation on 

only his/her registered email. 

 Dashboard of the Taxpayer is updated with the record of the issued Order. He/she can view the 

issued Rectified Order from the following navigation: Services > User Services > My Applications 

 > ORDERS. 

 Dashboard of the Tax Official (role of P&C Officer) is updated with the record of the issued 

ORDER. He/she can view the issued Notice from the following navigation: Statutory Functions > 

Prosecution and Compounding > Compounding Application > ORDERS  

  

12. What happens on the GST Portal once a concerned Tax Official files a 

Rectification Application? 

Once a Rectification request is submitted by a concerned Tax Official, following actions take place on the 

GST Portal: 

 Status of the ARN on the GST Portal gets updated to "Rectification request submitted".  

 Dashboard of Taxpayer is updated with the record of the submitted Rectification request. He/she 

will receive its intimation on both— registered Mobile and email.  

 Dashboard of the P&C Senior Officer and the Assistant to Commissioner is updated with the 

record of the filed rectification application. They can view it from the "My Tasks" page: Statutory 

Functions > My Tasks > Reference Id > RECTIFICATION 

  

13. What happens on the GST Portal once a Taxpayer files a Rectification 

Application? 



 

 

Once a Rectification request is submitted by a Taxpayer, following actions take place on the GST Portal:  

 Status of the ARN on the GST Portal gets updated to "Rectification request submitted".  

 Dashboard of concerned Tax Official is updated with the record of the submitted Rectification 

request. He/she will receive its intimation on his/her registered  email.  

 Dashboard of the P&C Senior Officer and the Assistant to Commissioner is updated with the 

record of the filed rectification application. They can view it from the "My Tasks" page: Statutory 

Functions > My Tasks > Reference Id > RECTIFICATION 

  

14. What happens on the GST Portal once the Commissioner rejects a 

Rectification Application? 

With the issue of the Rectification Rejection Order, following actions take place on the GST Portal:  

  

 ARN Status on the GST Portal gets updated to "Rectification request rejected".  

 Intimation of the issue of Rectification Rejection Order is sent to the concerned Tax Officer and 

the Taxpayer. The Taxpayer will receive its intimation on both— registered Mobile and email. The 

Tax Official (role of P&C Officer) will receive intimation on only his/her registered email.  

 Dashboard of the Taxpayer is updated with the record of the issued Order. He/she can view the 

Rectification Rejection Order from the following navigation: Services > User Services > My 

Applications  > RECTIFICATION. 

 Dashboard of the Tax Official (role of P&C Officer) is updated with the record of the issued 

ORDER. He/she can view the issued Notice from the following navigation: Statutory Functions > 

Prosecution and Compounding > Compounding Application > RECTIFICATION  

  

15. During the Compounding Application proceedings, what all Status 

changes does an ARN undergo? 

During the Compounding Application proceedings, an ARN undergoes following Status changes:  

  

 Compounding Application Submitted: When the Compounding Application is successfully filed 

by the Taxpayer 

 Hearing notice issued: When hearing is issued (by the P&C Senior Officer/Assistant to 

Commissioner) to the Taxpayer or the P&C Officer or both 

 Reply Submitted: When anyone (P&C Senior Officer/Assistant to Commissioner/P&C Senior 

Officer/Taxpayer) files reply to the issued notice or a counter-reply 

 Adjournment granted: When adjournment notice is issued (by the P&C Senior Officer/Assistant 

to Commissioner) to the Taxpayer or the P&C Officer or both 



 

 

 Compounding allowed: When the application for Compounding of offense is allowed by the 

P&C Senior Officer/Assistant to Commissioner 

 Compounding Rejected: When the application for Compounding of offense is rejected by the 

P&C Senior Officer/Assistant to Commissioner 

 Compounding Withdrawn: When the application for Compounding of offense is withdrawn by 

the P&C Senior Officer/Assistant to Commissioner 

 Rectification request submitted: When application for Rectification is filed by the Taxpayer or 

the P&C Officer 

 Rectification request rejected: When application for Rectification is rejected by the P&C Senior 

Officer/Assistant to Commissioner 

 Rectification order passed: When the Order is rectified by the P&C Senior Officer/Assistant to 

Commissioner  

 Compounding fee determined:  

 Compounding fee paid: When the Taxpayer utilizes cash from the Electronic Cash Ledger to 

pay the compounding fee.  

  

  



 

 

 

Manual > Processing Application for 
Compounding of Offence (Form GST CPD-01) 

How can I process Application for Compounding of Offence (Form GST 

CPD-01) filed by the Taxpayers? 

To process Application for Compounding of Offence (Form GST CPD-01) filed by the Taxpayers, perform 

following steps: 

  

Note: Following three Tax Official roles can be defined on the GST Portal by the State Admin to conduct 

case proceedings related to compounding:  

  

1. Prosecution and Compounding Officer (defined at the Jurisdiction level) also known as "P&C 

Officer": Is the concerned Tax Official who had issued Notice for initiation of Prosecution 

Proceedings to the Taxpayer, with details of compounding fee to be paid. During the compounding 

proceedings, he/she will act as a Department Respondent and perform functions like filing reply or 

filing rectification and appearing for hearing as directed by the Commissioner.  

2. Prosecution and Compounding Senior Officer (defined at the State level) also known as "P&C 

Senior Officer": Is the Commissioner who will process the Compounding Application filed by the 

Taxpayers.  

3. Assistant to Commissioner (defined at the State level): Performs all functions of P&C Senior 

Officer on his/her behalf.  

  

  

 Steps  

Tax Official Roles 

Responsible for 

Performing the Steps on 

the GST Portal 

     A(1) Search for Applications Filed by the 

Taxpayer and open the "Case Detail" screen 

             or  

    A(2). Navigate to "My Tasks" screen to 

open ARNs or their related Reference IDs  

 P&C Officer 

 P&C Senior Officer or 

Assistant to 

Commissioner 

     B. From APPLICATIONS tab: View the 

Filed Compounding Application 

  

 P&C Officer 

 P&C Senior Officer or 

Assistant to 

Commissioner 

  



 

 

         

    C. From NOTICES tab:             

     

          C(1). Issue Hearing Notice      

  

   P&C Senior Officer or 

Assistant to Commissioner 

          C(2). Issue Adjournment Notice 

          C(3). View Issued Notices and File Reply 

to the issued Notice 

 P&C Officer 

  

    D.  From REPLIES tab: View Filed Replies 

and File Counter-reply  

 P&C Officer 

 P&C Senior Officer or 

Assistant to 

Commissioner 

  

E. From ADDITIONAL DOCUMENT tab: 

Upload Hearing-related Documents 

 P&C Officer 

 P&C Senior Officer or 

Assistant to 

Commissioner 

F. From ORDERS tab:  

F(1). Issue "Compounding granted" 

Order (Form No. GST CPD-02) 

Or 

F(2). Issue "Compounding Rejected" 

Order 

Or 

F(3) Withdraw Compounding  

Or 

F(4) Issue Rectification Order 

 P&C Senior Officer or 

Assistant to 

Commissioner 

  

    
Note: Only the P&C Senior 
Officer can issue Order. P&C 
Officer can only view/download 
it. 

           F(5) File Rectification Application Request  P&C Officer 

G. From RECTIFICATION tab:  

           G(1). View the Filed Rectification 

Applications 

 P&C Officer 

 P&C Senior Officer or 

Assistant to 

Commissioner 



 

 

           G(2). Reject the Filed Rectification 
Application Request 

P&C Senior Officer or 

Assistant to Commissioner 

  

Click each hyperlink in the "Steps" column above to know more.  

A(1). Search for Applications Filed by the Taxpayer and Open the "Case 

View" Screen 

To search for Applications filed by the Taxpayer and open the "Case Detail" screen, perform following 

steps: 

  

Note: This step can be performed by all the Tax Official roles.  

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Prosecution and Compounding > Compounding Application 

option.  

  

 

  

4. Compounding Application Search screen gets displayed. Open work-items are displayed in the table 

below the SEARCH section. You can select the buttons at the bottom of the page to display the required 

number of open work-items and then click any of the ARN/RFN hyperlink to open it. Or, you can choose 

any one of the fields displayed on the top as your search criteria and enter the required information as 

mentioned in the following steps:  

  



 

 

 

  

4a. Enter ARN/RFN. 

4b. Enter GSTIN/Temporary ID/UIN. 

4c. Select Status from the drop-down list. 

  

 

  

4d. Enter date in the From & To fields. 

4e. Click the SEARCH button. 

  

5. Based on your search criteria, the work-item or the list of the required work-items get displayed. 

Click any of the ARN/RFN. hyperlinks to open it and carry out further proceedings.  



 

 

  

 

  

6. Case View screen gets displayed. All proceedings related to this Compounding Application will take 

place by operating on the tabs provided on the left-hand side of this screen.  

  

 

  

Go back to the Main Menu 

A(2). Navigate to My Tasks screen to open ARNs or the Reference IDs   

To navigate to "My Tasks" screen to open ARNs or the Reference IDs, perform following steps:  

  

Note: This step can be performed by all the Tax Official roles.  

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > My Tasks option. 



 

 

  

 

  

4. My Tasks screen is displayed. It has two sections.  

  

 From the top section, you can search for the tasks. Choose any one of the displayed fields as 

your search criteria and enter the required information: ARN/IRN/Case ID, Reference ID or Start 

Date & End Date. Click the SEARCH button. Task list, in the second section below it, will get 

updated based on the search criteria.  

 In the second section, click the hyperlink in the ARN/IRN or the Reference ID column. 

  

 

  



 

 

5. Case View screen gets displayed. All proceedings related to this Compounding Application will take 

place by operating on the tabs provided on the left-hand side of this screen.  

  

 

  

Note: In case you click the hyperlink in the Reference ID column, "Case View" screen gets displayed, 

where the reference-related tab is selected. From this screen, you can take further actions related to this 

IRN. 

  

 

  

Go back to the Main Menu 

B. From APPLICATIONS tab: View the Filed Application 

To view the filed Application Details, perform following steps: 

  

Note: This step can be performed by all the Tax Official roles.  

  



 

 

1. On the Case View page of that particular application, select the APPLICATIONS tab, if it is not 

selected by default. This tab provides you an option to view the filed application, along with its 

supporting documents in PDF mode.  

  

 

  

2. In the "View Documents column, click the "View" hyperlink to download and view the related 

document.  

3. Click the two links above the table to view the electronic liability register Part -I and Part-II.  

  

Go back to the Main Menu 

C(1). From NOTICES tab: Issue Hearing Notice 

To issue Hearing Notice, perform following steps: 

  

Note: This step can be performed by only those Tax Officials who have been assigned the role of "P&C 

Senior Officer" or "Assistant to Commissioner".  

  

1. On the Case View screen of that particular application, select the NOTICES tab. This tab will list the 

Notices (Hearing/Adjournment) you will issue to the Taxpayer or the P&C Officer. Click ADD NOTICE and 

select the Hearing Notice option.  

  



 

 

 

  

2. Notice page gets displayed. Click BACK to go back to the previous screen or enter details in the 

displayed fields as mentioned in the following steps:  

  



 

 

 

  

2a. Click the Generate Reference Number hyperlink. Notice Reference Number field gets auto-

populated.   

2b. In the Subject field, enter the relevant description. 

2c. In the Recipient of Notice field, select the recipients.  

  



 

 

 

  

2d. In the Date field, enter the date of hearing using the calendar. 

2e. In the Time field, enter the time of hearing using the calendar. 

2f.  In the Venue field, enter the address of the venue. 

2g. In the Upload Notice Document field, click Choose File to upload the PDF form of the notice.  

2h. If required, in the Upload Supporting Documents (if any) field, you can also upload supporting 

documents. This is not a mandatory field. Enter document description and click the Choose File button. 

ADD DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. You can 

delete the uploaded document by clicking the DELETE button and upload again.  

  

  

 

  

2d. Click the PROCEED button.  

2e. A warning message pop-up gets displayed. Click the PROCEED button. 

  



 

 

 

  

3. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  

 

  

4. Dashboard page is displayed with a green success message containing the generated Notice 

Reference Number. Click OK.  

  

 



 

 

  

  

5. The updated NOTICES tab is displayed with the issued Notice. 

  

 

  

6. With the issue of the Hearing Notice, following actions take place on the GST Portal:  

 ARN Status on the GST Portal gets updated to "Hearing notice issued".  

 Intimation of the issue of Notice is sent to the concerned recipient(s). In case the recipient is the 

Taxpayer, he/she will receive intimation on both— registered Mobile and email. In case the recipient 

is the Tax Official (role of P&C Officer), he/she will receive intimation on only his/her registered emai l. 

 Dashboard of the Taxpayer is updated with the record of the issued Notice. He/she can view the 

issued Notice from the following navigation: Services > User Services > My Applications  > 

NOTICES. 

 Dashboard of the Tax Official (role of P&C Officer) is updated with the record of the issued 

Notice. He/she can view the issued Notice from the following navigation: Statutory Functions > 

Prosecution and Compounding > Compounding Application > NOTICES or from the My Tasks 

page: Statutory Functions > My Tasks > Reference Id > NOTICES 

  

Go back to the Main Menu 

C(2). From NOTICES tab: Issue Adjournment Notice 

To issue Adjournment Notice, perform following steps: 

  

Note: This step can be performed by only those Tax Officials who have been assigned the role of "P&C 

Senior Officer" or "Assistant to Commissioner".  

  



 

 

1. On the Case View screen of that particular application, select the NOTICES tab. This tab will list the 

Notices (Hearing/Adjournment) you will issue to the Taxpayer or the P&C Officer. Click ADD NOTICE and 

select the Adjournment Notice option.  

  

Note: "Adjournment Notice" option becomes visible only once the hearing notice has been issued.  

  

 

  

2. Notice page gets displayed. Click BACK to go back to the previous screen or enter details in the 

displayed fields as mentioned in the following steps:  

  



 

 

 

  

2a. Click the Generate Reference Number hyperlink. Notice Reference Number field gets auto-

populated.   

2b. In the Subject field, enter the relevant description. 

2c. In the Recipient of Notice field, select the recipients.  

  



 

 

 

  

2d. In the Previous date of Hearing field, enter the date using the calendar. 

2e. In the Status of previous hearing field, select the Status from the drop-down list.  

  

 

  

2f. In the Date field, enter the date of hearing using the calendar. 

2g. In the Time field, enter the time of hearing using the calendar. 

2h.  In the Venue field, enter the address of the venue. 

2i. In the Upload Notice Document field, click Choose File to upload the PDF form of the notice.  

2j. If required, in the Upload Supporting Documents (if any) field, you can also upload supporting 

documents. This is not a mandatory field. Enter document description and click the Choose File button. 

ADD DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. You can 

delete the uploaded document by clicking the DELETE button and upload again.  

  



 

 

  

 

  

2k. Click the PROCEED button.  

2l. A warning message pop-up gets displayed. Click the PROCEED button. 

  

 

  

3. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  



 

 

 

  

4. Dashboard page is displayed with a green success message containing the generated Notice 

Reference Number. Click OK.  

  

 

  

  

5. The updated NOTICES tab is displayed with the issued Notice. 

  



 

 

 

  

6. With the issue of the Adjournment Notice, following actions take place on the GST Portal:  

 ARN Status on the GST Portal gets updated to "Adjournment granted".  

 Intimation of the issue of Notice is sent to the concerned recipient(s). In case the recipient is the 

Taxpayer, he/she will receive intimation on both— registered Mobile and email. In case the recipient 

is the Tax Official (role of P&C Officer), he/she will receive intimation on only his/her registered email. 

 Dashboard of the Taxpayer is updated with the record of the issued Notice. He/she can view the 

issued Notice from the following navigation: Services > User Services > My Applications  > 

NOTICES. 

 Dashboard of the Tax Official (role of P&C Officer) is updated with the record of the issued 

Notice. He/she can view the issued Notice from the following navigation: Statutory Functions > 

Prosecution and Compounding > Compounding Application > NOTICES or from the My Tasks 

page: Statutory Functions > My Tasks > Reference Id > NOTICES 

  

Go back to the Main Menu 

C(3). From NOTICES tab: View Issued Notices and File Reply 

To view issued notices and file reply, perform following steps: 

  

Note: This step can be performed by all the Tax Official roles.  

  



 

 

1. On the Case View page of that particular application, select the NOTICES tab. This tab displays 

all the notices (Hearing Notice/Adjournment) issued by the Commissioner. In the "Documents" 

column, click the document-name hyperlink to download and view the related document.   

  

 

  

2. Select the radio button against the Notice for which you want to file your reply. The REPLY button 

gets enabled. Click the enabled REPLY button.  

  



 

 

 

  

3. The REPLY page is displayed. The following fields are auto-populated—Name of the 

respondent, Notice Reference No, Date of communication of Notice. Enter details in the other 

fields as mentioned in the following steps. To go to the previous page, click  BACK.  

  



 

 

 

  

3a. In the Details of Reply field, click Choose File to upload the document(s) related to your reply.  

3b. If required, in the Upload Supporting Documents, (if any) field, you can also upload supporting 

documents. This is not a mandatory field. Enter document description and click the Choose File button. 

ADD DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. You can 

delete the uploaded document by clicking the DELETE button and upload again.  

  



 

 

  

 

  

3d. Click the PROCEED button.  

3e. A warning popup is displayed. Click the PROCEED button in the popup as well.  

 

  

4. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  



 

 

 

  

5. Dashboard page is displayed with a green success message containing the generated Reply 

Reference Number. Click OK.  

  

 

  

6. The updated REPLIES tab is displayed, with the record of the filed reply in a table and with the 

Status updated to "Reply submitted". Click the documents in the Documents section of the table to 

download them. 

  

 

  

7. With the successful filing of the Reply, following actions take place on the GST Portal:  

 ARN Status on the GST Portal gets updated to "Reply submitted".  



 

 

 Intimation of the submission of Reply is sent to the concerned parties:  

o In case the P&C Officer has filed the reply: P&C Senior Officer and Assistant to Commissioner 

will be intimated via their registered email and the Taxpayer will receive intimation on both— 

registered Mobile and email. 

o In case the P&C Senior Officer/Assistant to Commissioner has filed the reply: P&C Officer will be 

intimated via his/her registered email and the Taxpayer will receive intimation on both— registered 

Mobile and email. 

o In case the Taxpayer has filed the reply: All Tax Officials (P&C Senior Officer, Assistant to 

Commissioner and P&C Officer) will be intimated via their registered email.  

o Dashboard of the Taxpayer is updated with the record of the filed reply. He/she can view the it 

from the following navigation: Services > User Services > My Applications  > REPLIES. 

o Dashboard of all the Tax Officials is updated with the record of the filed reply. They can view the 

of the filed reply from the following navigation: Statutory Functions > Prosecution and 

Compounding > Compounding Application > REPLIES or from the "My Tasks" page: Statutory 

Functions > My Tasks > Reference Id > REPLIES  

  

Note: In case P&C Senior Officer/Assistant to Commissioner has filed the reply, they will not be able to 

view their filed reply in the "My Tasks" page. Similarly, in case P&C Officer has filed the reply, he/she will 

not be able to view his/her filed reply in the "My Tasks" page.  

  

Go back to the Main Menu 

  

D. From REPLIES tab: View Filed Replies and File Counter-reply  

To view filed replies and file counter-reply, perform following steps:  

  

Note: This step can be performed by all the Tax Official roles.  

  

1. On the Case View page of that particular application, select the REPLIES tab. This tab displays 

the replies filed by all the parties. In the "Documents" column, click the document-name hyperlink to 

download and view the related document.  

  



 

 

 

  

2. Select the radio button against the Reply for which you want to file your counter-reply. The 

REPLY button gets enabled. Click the enabled REPLY button.  

  

 

  

3. The REPLY page is displayed. Follow the steps you would have performed to file your reply to 

the issued Notices. Click here to revisit those steps.  

  



 

 

 

  

Go back to the Main Menu 

E. From ADDITIONAL DOCUMENT tab: Upload Hearing-related Documents 

To upload Hearing-related documents, perform following steps:  

  

Note: This step can be performed by all the Tax Official roles.  

  

1. On the Case View page of that particular application, select the ADDITIONAL DOCUMENT tab. 

This tab displays the Hearing-related documents submitted by the parties during hearing.  

  



 

 

 

  

2. "Submission of Additional Document" page is displayed. Enter details in the other fields as 

mentioned in the following steps. To go to the previous page, click  BACK. 

  

 

  

2a. In the "Filed by" field, enter the name of the party who has submitted the document.  

2b. In the Upload Supporting Document field, enter document description and click the Choose File 

button. ADD DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. 

You can delete the uploaded document by clicking the DELETE button and upload again.  

  



 

 

  

 

  

2c. Click the PROCEED button.  

2d. A warning popup is displayed. Click the PROCEED button in the popup as well.  

  

 

  

3. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  



 

 

 

  

4. Dashboard page is displayed with a green success message. Click OK.  

  

 

  

5. The updated ADDITIONAL DOCUMENT tab is displayed, with the record of the uploaded 

document in a table. Click the documents in the Documents section of the table to download them. 

  

 

  

6. With the successful upload of the document, dashboard of all the Tax Officials is updated with the 

record of the of the uploaded document. They can view the uploaded document from the following 

navigation: Statutory Functions > Prosecution and Compounding > Compounding Application > 

ADDITIONAL DOCUMENT  



 

 

  

Go back to the Main Menu 

F(1). From ORDERS tab: Issue "Compounding granted" Order (Form No. 

GST CPD-02) 

To issue "Compounding granted" Order, perform following steps:  

  

Note: This step can be performed by only those Tax Officials who have been assigned the role of "P&C 

Senior Officer" or "Assistant to Commissioner".  

  

1. On the Case View page of that particular application, click the ORDERS tab. Click the ADD 

ORDER button and select "Compounding granted" option. 

  

 

  

2. "Form No. GST CPD-02" page is displayed. Enter details in the other fields as mentioned in the 

following steps. To go to the previous page, click  BACK.  

  



 

 

 



 

 

  

2a. In the Order Reference no. field, click the "Generate Reference Number" hyperlink. The Order 

Reference no. field gets auto-populated.  

2b. In the Compounding fee  field, select the check-boxes against the applicable Offence. Then, enter 

the applicable amount across each major head.  

  

 

  

Note:  

 If there are more than one offenses, the offense carrying maximum amount shall be the 

compounding amount.  

 Further, Total compounding fee as determined by the P&C Senior Officer will be divided in 

between major heads according to the proportion of Tax involved. 

  

2c. In the Compounding Fee payment due date  field, select the date using the calendar.  

2d. If required, in the Upload Supporting Document field, you can also upload supporting documents. 

This is not a mandatory field. Enter document description and click the Choose File button. ADD 

DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. You can delete 

the uploaded document by clicking the DELETE button and upload again.  

  



 

 

  

 

  

2e. Click PREVIEW to download and review your entered details. Once you are satisfied, click the 

PROCEED button.  

  



 

 

 

  

2f. A warning message pop-up gets displayed. Click the PROCEED button. 

  



 

 

 

  

3. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  

 

  

4. Dashboard page is displayed with a green success message containing the generated Order 

Reference Number. Click OK.  

  

 



 

 

  

  

5. The updated ORDERS tab is displayed with the issued ORDER. 

  

 

  

6. With the issue of the Order, following actions take place on the GST Portal:  

 ARN Status on the GST Portal gets updated to "Compounding allowed".  

 Intimation of the issue of Order is sent to all the parties. The Taxpayer will receive intimation on 

both— registered Mobile and email. The Tax Official (role of P&C Officer) will receive intimation on 

only his/her registered email. 

 Dashboard of the Taxpayer is updated with the record of the issued Order. He/she can view the 

issued Notice from the following navigation: Services > User Services > My Applications  > 

ORDERS. 

 Dashboard of the Tax Official (role of P&C Officer) is updated with the record of the issued 

ORDER. He/she can view the issued Notice from the following navigation: Statutory Functions > 

Prosecution and Compounding > Compounding Application > ORDERS  

  

Go back to the Main Menu 

F(2). From ORDERS tab: Issue "Compounding Rejected" Order 

To issue "Compounding Rejected" Order, perform following steps:  

  

Note: This step can be performed by only those Tax Officials who have been assigned the role of "P&C 

Senior Officer" or "Assistant to Commissioner".  

  

1. On the Case View page of that particular application, click the ORDERS tab. This tab provides 

you an option to view the issued order, with all its attached documents, in PDF mode. Click the ADD 

ORDER button and select "Compounding Rejected" option. 

  



 

 

 

  

2. "Form No. GST CPD-02: Order for Rejection of compounding of offence" page is displayed. Enter 

details in the other fields as mentioned in the following steps. To go to the previous page, click  

BACK.  

  



 

 

 

  

2a. In the Order Reference No. field, click the "Generate Reference Number" hyperlink. The Order 

Reference no. field gets auto-populated.  

2b. In the Reasons for rejection field, enter the relevant text in maximum 1000 characters. 

2c. If required, in the Upload Supporting Documents (if any) field, you can also upload supporting 

documents. This is not a mandatory field. Enter document description and click the Choose File button. 

ADD DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. You can 

delete the uploaded document by clicking the DELETE button and upload again.  



 

 

  

  

 

  

2d. Click PREVIEW to download and review your entered details. Once you are satisfied, click the 

PROCEED button.  

  



 

 

 

  

2e. A warning message popup gets displayed. Click the PROCEED button. 

  



 

 

 

  

3. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  

 

  

4. Dashboard page is displayed with a green success message containing the generated Order 

Reference Number. Click OK.  

  



 

 

 

  

5. The updated ORDERS tab is displayed with the issued ORDER. 

  

 

  

6. With the issue of the Order, following actions take place on the GST Portal: 

 ARN Status on the GST Portal gets updated to "Compounding Rejected".  

 Intimation of the issue of Order is sent to all the parties. The Taxpayer will receive intimation on 

both— registered Mobile and email. The Tax Official (role of P&C Officer) will receive intimation on 

only his/her registered email. 

 Dashboard of the Taxpayer is updated with the record of the issued Order. He/she can view the 

issued Notice from the following navigation: Services > User Services > My Applications  > 

ORDERS. 

 Dashboard of the Tax Official (role of P&C Officer) is updated with the record of the issued 

ORDER. He/she can view the issued Notice from the following navigation: Statutory Functions > 

Prosecution and Compounding > Compounding Application > ORDERS  

  

Go back to the Main Menu 

F(3). From ORDERS tab: Withdraw Compounding  

To withdraw Compounding, perform following steps:  

  

Note: This step can be performed by only those Tax Officials who have been assigned the role of "P&C 

Senior Officer" or "Assistant to Commissioner".  

  



 

 

1. On the Case View page of that particular application, select the ORDERS tab. In this tab, click 

the COMPOUNDING WITHDRAWAL button.  

  

 

  

2. A Warning popup is displayed. Click the PROCEED button.  

  

 

  

3. The updated ORDERS tab gets displayed, with a green success message and the Status is 

updated to "Compounding Withdrawn". 

  



 

 

 

  

4. Once the Commissioner withdraws compounding, following actions take place on the GST Portal:  

 Status of the ARN shall get updated to "Compounding Withdrawn".  

 Henceforth, no action can be performed, by the Taxpayer or the Tax Officials, on the withdrawn 

ARN.  

  

Note: The Commissioner may, as per his/her discretion, withdraw Compounding at any stage during the 

processing of the Compounding Application.   

  

Go back to the Main Menu 

F(4). From ORDERS tab: Issue Rectification Order 

To issue a Rectification Order, perform following steps:  

  

Note: This step can be performed by only those Tax Officials who have been assigned the role of "P&C 

Senior Officer" or "Assistant to Commissioner".  

  

1. On the Case View page of that particular application, click the ORDERS tab. Click the ADD 

ORDER button and select the "Rectification Order" option. 

  



 

 

 

  

Note: The "Rectification Order" option will become visible only when the "Compounding granted" Order 

has been issued.  

  

2. "Form No. GST CPD-02: Rectification of Order" page is displayed. Follow the same steps you 

performed to issue the "Compounding granted" Order. Click here to revisit the steps.  

  



 

 

 



 

 

  

3. Click PREVIEW to download and review your entered details. Once you are satisfied, click the 

PROCEED button.  

  

 

  

4. On clicking the PROCEED button, a warning message popup gets displayed. Click the PROCEED 

button in this popup as well. 

  



 

 

 

  

5. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  

 

  

6. Dashboard page is displayed with a green success message containing the generated Rectification of 

Order Reference Number. Click OK.  

  



 

 

 

  

7. The updated ORDERS tab is displayed with the issued ORDER. 

  

 

  

6. With the issue of the Rectification Order, following actions take place on the GST Portal:  

 ARN on the GST Portal gets updated to "Rectification order passed".  

 Intimation of the issue of Order is sent to all the parties. The Taxpayer will receive intimation on 

both— registered Mobile and email. The Tax Official (role of P&C Officer) will receive intimation on 

only his/her registered email. 

 Dashboard of the Taxpayer is updated with the record of the issued Order. He/she can view the 

issued Rectified Order from the following navigation: Services > User Services > My Applications 

 > ORDERS. 

 Dashboard of the Tax Official (role of P&C Officer) is updated with the record of the issued 

ORDER. He/she can view the issued Notice from the following navigation: Statutory Functions > 

Prosecution and Compounding > Compounding Application > ORDERS  

  

Go back to the Main Menu 

F(5). From ORDERS tab: File Rectification Application Request 

To file Rectification Application Request, perform following steps:  

  



 

 

Note: This step can be performed by only those Tax Officials who have been assigned the role of "P&C 

Officer".  

  

1. On the Case View page of that particular application, click the ORDERS tab. Select the radio 

button against the Order for which you want to initiate rectification. The INITIATE RECTIFICATION 

button gets enabled. Click the enabled INITIATE RECTIFICATION button.  

  

 

  

2. "Submission of Rectification request" page is displayed. The following fields are auto-populated—

Order Reference No, Date of communication of Order. Enter details in the other fields as 

mentioned in the following steps.  

  



 

 

 

  

2a. In the Details of Rectification field, click Choose File to upload the document(s) containing details of 

the rectification that needs to be done.  

2b. If required, in the Upload supporting documents field, you can also upload supporting documents. 

This is not a mandatory field. Enter document description and click the Choose File button. ADD 

DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. You can delete 

the uploaded document by clicking the DELETE button and upload again.  

  



 

 

  

 

  

2c. Click the PROCEED TO FILE button. A warning popup is displayed. Click the PROCEED button in the 

popup as well.  

  

 

  

3. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  



 

 

 

  

4. Dashboard page is displayed with a green success message containing the generated Rectification of 

Order Reference Number. Click OK.  

  

 

  

5. The updated RECTIFICATION tab is displayed, with the record of the filed rectification request in 

a table. Click the documents in the Documents section of the table to download them. 

  

 

  

Note:  

  



 

 

Once a Rectification request is submitted by a concerned Tax Official, following actions take place on the 

GST Portal: 

 Status of the ARN on the GST Portal gets updated to "Rectification request submitted".  

 Dashboard of Taxpayer is updated with the record of the submitted Rectification request. He/she 

will receive its intimation on both— registered Mobile and email.  

 Dashboard of the P&C Senior Officer and the Assistant to Commissioner is updated with the 

record of the filed rectification application. They can view it from the "My Tasks" page: Statutory 

Functions > My Tasks > Reference Id > RECTIFICATION 

  

Once a Rectification request is submitted by a Taxpayer, following actions take place on the GST Portal:  

 Status of the ARN on the GST Portal gets updated to "Rectification request submitted".  

 Dashboard of concerned Tax Official is updated with the record of the submitted Rectification 

request. He/she will receive its intimation on his/her registered  email.  

 Dashboard of the P&C Senior Officer and the Assistant to Commissioner is updated with the 

record of the filed rectification application. They can view it from the "My Tasks" page: Statutory 

Functions > My Tasks > Reference Id > RECTIFICATION 

  

Go back to the Main Menu 

  

G(1). From RECTIFICATION tab: View the Filed Rectification Applications 

To view the Filed Rectification Applications, perform following steps:  

  

Note: This step can be performed by all the Tax Official roles.  

  

1. On the Case View page of that particular application, select the RECTIFICATION tab. This tab 

displays all the rectification applications submitted by all the parties.  

  



 

 

 

  

2. In the "Documents" column, click the document name(s) to download them into your machine and 

view them.  

  

Go back to the Main Menu 

G(2). From RECTIFICATION tab: Reject the Filed Rectification Application 

Request 

To reject the filed Rectification Application Request, perform following steps:  

  

Note: This step can be performed by only those Tax Officials who have been assigned the role of "P&C 

Senior Officer" or "Assistant to Commissioner".  

  

1. On the Case View page of that particular application, select the RECTIFICATION tab. Select the radio 

button against the Rectification application which you want to reject. The RECTIFICATION REJECTION 

button gets enabled. Click the enabled RECTIFICATION REJECTION button.  

  



 

 

 

  

2. "Rejection of Rectification request" page is displayed. In the "Reason for rejection of rectification 

request" field, enter the relevant text in about 250 characters maximum and click the PROCEED TO 

FILE button.   

  

 

  

3.  A warning popup is displayed. Click the PROCEED button in the popup as well.  

  



 

 

 

  

4. The Notice/Reminder/Order page is displayed with a Warning message. On this page, click the 

ISSUE WITH DSC button.  

  

 

  

5. Dashboard page is displayed with a green success message. Click OK.  

  

 

  



 

 

6. The updated RECTIFICATION tab gets displayed with the record of the rejected rectificat ion request. 

Click the documents in the Documents section, if any, of the table to download them. 

  

 

  

7. Click the "View" hyperlink in the "Reasons for Rejection" column. The "Reason for Rejection of 

Rectification Request" popup is displayed. Click the cross button to close it.  

  

 

  

8. With the issue of the Rectification Rejection Order, following actions take place on the GST Portal:  

  

 ARN Status on the GST Portal gets updated to "Rectification request rejected".  

 Intimation of the issue of Rectification Rejection Order is sent to the concerned Tax Officer and 

the Taxpayer. The Taxpayer will receive its intimation on both— registered Mobile and email. The 

Tax Official (role of P&C Officer) will receive intimation on only his/her registered email.  

 Dashboard of the Taxpayer is updated with the record of the issued Order. He/she can view the 

Rectification Rejection Order from the following navigation: Services > User Services > My 

Applications  > RECTIFICATION. 



 

 

 Dashboard of the Tax Official (role of P&C Officer) is updated with the record of the issued 

ORDER. He/she can view the issued Notice from the following navigation: Statutory Functions > 

Prosecution and Compounding > Compounding Application > RECTIFICATION  

  

Go back to the Main Menu 

  



 

 

Demand & Collection Register 

Overview > Demand & Collection Register 

Create Entry in Demand & Collection Register 

 FAQs 

 Manual 

View Demand & Collection Register 

 FAQs 

 Manual 

Review Entry in Demand & Collection Register 

 FAQs 

 Manual 

Update Demand & Collection Register for Earlier Laws 

 FAQs 

 Manual 

  



 

 

Overview > Demand & Collection Register 

Create Entry in Demand & Collection Register 

 FAQs 

 Manual 

View Demand & Collection Register 

 FAQs 

 Manual 

Review Entry in Demand & Collection Register 

 FAQs 

 Manual 

Update Demand & Collection Register for Earlier Laws 

 FAQs 

 Manual 

  

  



 

 

Create, Review, View and Update Entry 

FAQs > Create, Review, View and Update 
Entry in Demand & Collection Register 

1. What is Demand & Collection Register (DCR)? 

Demand & Collection Register (DCR) is maintained by the departmental authorities for tracking and 

keeping record of the demands against taxpayers under earlier laws and is created as a result of 

adjudication process. DCR enables the tax department to carry out recovery proceedings in a systematic 

manner. 

2. What does DCR contain? 

DCR contains detailed summary of the demand created as per earlier law/GST law and its status. The 

details and the proceedings pertaining to each taxpayer are arranged Demand Order wise. The details 

covered in the DCR are: GSTIN/Temporary ID of Taxpayer, Name & Address, order number, amount of 

demand, interest, penalty, tax payable, tax paid, status of the proceedings, relevant documents, amount 

to be recovered, mode of recovery, etc. 

3. Who uses “Create New Entry in DCR” option in DCR? 

Mainly, Recovery Officers and Senior Recovery Officers use this option in DCR to manually enter and 

maintain demands related to earlier laws into the GST system, that cannot be auto-created. 

4. What is the path to “Create New Entry in DCR” option in DCR? 

Navigate to Statutory Functions > Demand and Collection Register > Create New Entry in DCR 

option. 

5. Where can I view the demand created using “Create New Entry in DCR” 

option in DCR? 

1. Navigate to Statutory Functions > Demand and Collection Register > View DCR option. 

2. Search the demand either by Demand belonging to the Financial Year or Demand created in the 

Financial Year and click the Demand ID hyperlink to view details of Demand ID.  

6. What is the path to view DCR? 



 

 

Navigate to Statutory Functions > Demand and Collection Register > View  DCR option. 

7. Which roles have access to view DCR? 

All roles will have access to view DCR. 

8. Can I view DCR as part of earlier laws? 

Only GST related demands will be shown in View DCR screen as of now and earlier law related Demands 

will be released along with “Create DCR” use case to be available shortly. 

9. Which demand is auto-created in DCR? 

The demand assessed/adjudicated under the GST Act (current law) is auto-created by the GST system in 

DCR. When an assessment/adjudication Order is confirmed against a taxpayer in current law, the details 

of that demand created in the assessment/adjudication order gets auto-created (and also auto-updated) 

in DCR and can be accessed from the View DCR sub-menu of DCR. 

10. Which demand is not auto-created in DCR and must be manually 

created using “Create New Entry in DCR” option? 

The demand assessed/adjudicated under the earlier law is not auto-created in DCR since their 

proceedings are done/happen outside the GST system. To enable tax officials to carry out further 

recovery process of demands related to earlier law, they have to manually enter such demands and 

record them in the GST system. Create New Entry in DCR option helps cater to this need.   

11. How can I view details of Demand ID? 

Navigate to Statutory Functions > Demand and Collection Register > View DCR option.  

  

Search the demand either by Demand belonging to the Financial Year or Demand created in the 

Financial Year and click the Demand ID hyperlink to view details of Demand ID. 

12. How is Demand and Collection Register (DCR) updated?   

The Demand and Collection Register of a taxpayer is updated with a liability, whenever a GST related 

demand is created by a Tax Official, due to activities related to assessment/appeal/returns/refund/ 

enforcement. 

  



 

 

Whenever any demand is created by a Tax Official or any liability against demand is paid by the taxpayer, 

by way of payment from Electronic Cash Ledger or Electronic Credit Ledger, the entry for the same is 

also posted in both Electronic Liability Register and Demand and Collection Register. 

  

NOTE: For earlier law related demands, a provision will be provided to the Tax Officials to create a 

Demand ID using the Create DCR functionality; and subsequently the same can be updated (about the 

amount paid and its status, against that particular Demand ID) using Update DCR functionality. 

13. What happens once DCR is updated?   

Once DCR is updated, this will go to Senior Recovery Officer for review. 

14. I am a Recovery Officer. What will be my role and what all actions can I 

perform in DCR? 

Your role in DCR will be to create/ update demand entries and submit them to your Senior Recovery 

Officer for review. In DCR, you will be able to view the DCR, create a new entry, and update the existing 

ones.  

15. I am a Senior Recovery Officer. What will be my role and what all 

actions can I perform in DCR? 

Your role in DCR will be to review the demands submitted by the Recovery Officers, under your charge. 

In DCR, you will be able to view the DCR, review a new entry, and review the updated entries. Demand 

ID will be created after approval of Senior Recovery Officer. A senior officer can add, modify, or reject a 

DCR entry of junior officer. 

16. From where I can view the Instalment Calendar of the taxpayer? 

Navigate to Statutory Functions > Demand and Collection Register > View DCR > Search > Demand 

ID > Instalment Calendar option. 

  



 

 

Manual > Create New Entry in Demand & 
Collection Register 

How can I create new entry in DCR? 

To create new entry in DCR, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Navigate to Statutory Functions > Demand and Collection Register > Create New Entry in DCR 

option. 

  

 

  

The Create New Entry in DCR page is displayed. 

Note: You can click the Update DCR or View DCR tabs to update the DCR and view the DCR under 

Quick Links respectively. 

  



 

 

 

  

4. In the GSTIN/ Temporary ID field, enter the GSTIN/ Temporary ID of the taxpayer. 

Once you enter the GSTIN/ Temporary ID, name of taxpayer and mobile number is auto-populated. 

5. Select the Financial Period for which Tax Period/ Demand belongs to. 

6. In the Order No. field, enter the Order Number. 

7. Select the Order Date using the calendar. 



 

 

8. Select the Date of Service of Order using the calendar. 

9. In the Authority who passed the Order field, enter the name of the authority who pass the order. 

  

 

  

10. Select the Status of Demand from the drop-down list. 

  



 

 

 

  

11. Select the name of the earlier law to which demand belongs to from the Earlier Law  drop-down list. 

  

 

  

12. In the Section field, enter the name of the section to which demand belongs to.  

Note: Major Head is auto-populated based on Earlier Law 

13. In the Amount Confirmed in the Order section, enter the details of the amount (Tax, Interest as per 

Order, Penalty, Fees Others) confirmed in the order.  

  



 

 

 

  

14. Scroll to the right using the scroll bar and enter other details. 

  

 

  

15. In the Amount Deposited by Taxpayer / Recovered upto this stage  section, enter the details of the 

amount (Tax, Interest as per Order, Penalty, Fees Others) that has been deposited by the taxpayer or 

recovered. 

  

 

  

16. Scroll to the right using the scroll bar and enter the Date of Payment, Reference No. and Remarks for 

payment to be made. 

Note: You can click ADD button to add more details. 

  



 

 

 

  

17.  In the Amount Pending for Recovery section, amount which is pending for recovery is displayed. 

  

 

  

18. Scroll to the right using the scroll bar and view other details.  

  

 

  

19. Select Yes for Recovery to be initiated immediately in case amount pending has to be recovered 

immediately. Or else, select No. 

In case “Yes” is selected, then Recovery ID will also be created along with Demand ID once the entry is 

created by Recovery Officer and approved by Senior Recovery Officer. 

20. In case you select No, in the Reason field, enter the reason for not recovering the demand 

immediately. 

21. Click the Choose File button to upload any supporting document. 



 

 

Note: You can upload PDF/ JPEG file format only with maximum 4 files of 5 MB each. 

22. Click the SUBMIT button. 

  

 

  

A success message is displayed that demand entry is created and submitted to senior recovery officer for 

approval. You can click the CANCEL button to go back to the Dashboard. 



 

 

  

 

  

  



 

 

 

Manual > View Demand & Collection Register 

How can I view details in DCR? 

To view details in DCR, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal. 

3. Navigate to Statutory Functions > Demand and Collection Register > View DCR option. 

  

 

  

4. The DEMAND AND COLLECTION REGISTER (DCR) search page is displayed. You can search the 

demand either by Demand belonging to the Financial Year or Demand created in the Financial Year.  

a. If you select any one option from the drop-down list Demand belonging to the Financial Year, the 

Demand created in the Financial Year field gets disabled. 

  



 

 

 

  

b. If you select any one option from the drop-down list Demand created in the Financial Year, the 

Demand belonging to the Financial Year field gets disabled. 

  



 

 

 

  

c. You can also use the other filter criteria like Period From and To, Headquarter, Earlier Laws/ GST 

Laws, Type of Demand to search the demand. 

  

d. You can also use the other filter like GSTIN/Temporary ID, Name of taxpayer under Advanced Search 

to search the demand. 

  

 

  



 

 

e. You can also search the demand based on status of demand. 

  

 

  

f. You can also search the demand by providing the demand amount range in From and To fields.  

  

 

  

5. Click the SEARCH button. 

Note: In case you want to reset the search criteria, you can click the RESET button. 

  



 

 

 

  

6. The search results are displayed. Use the scroll bar to move to the right to view other details.  

  



 

 

 



 

 

  

7 (a) 

i. Click the link under Integrated Tax, Central Tax, State/UT Tax and Cess to view further details.   

  



 

 

 



 

 

  

Note: The Minor Heads include: Tax, Interest, Penalty, Fee and Others. The Minor Head wise balance is 

displayed for the selected Major Head.  

ii. Click the Close button. 

  

 

  

7 (b) 

i. Click the Demand ID hyperlink to view further details.  

  



 

 

 



 

 

  

ii. The Demand and Recovery Summary page is displayed. Use the scroll bar to move to the right to 

view other details. 

  

 

  

iii. Click the link under Integrated Tax, Central Tax, State/UT Tax and Cess to view further details.   

  



 

 

 

  

Note: The Minor Heads include: Tax, Interest, Penalty, Fee and Others. The Minor Head wise balance is 

displayed for the selected Major Head.  

iv. Click the Close button. 

  

 

  

v. You can click the VIEW DOCUMENTS button to view the documents. 

  



 

 

 

  

vi. The PDF document is displayed. You can click on the PDF icon to download the document in PDF 

format. 

  



 

 

 

  

vii. You can click the Instalment Calendar hyperlink to view the instalment calendar of the taxpayer. 

  



 

 

 

. 

 viii. The Instalment Calendar page is displayed. 

  



 

 

 

  

ix. Click the major head hyperlink to view minor head details.  

  



 

 

 

  

x. The details are displayed. 

xi. Click the Close button. 

  



 

 

 

  

  

  



 

 

 

Manual > Review Entry in Demand & 
Collection Register 

How can I review entry in DCR? 

To review entry in DCR, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal. 

3. The Senior Recovery Officer's Dashboard is displayed. Click on the DCR tab.  

  

 

  

4. This tab shows all the DCRs pending with tax official for review. Click on the Review DCR entries 

received link to view the list of DCRs that needs to be reviewed.  

  

 

  



 

 

5. Click the Reference no. link to view the DCR. 

  

 

  

6. The DCR Entry for Review  page is displayed. You can either Approve, Reject, Modify or Cancel the 

DCR. 

  



 

 

 

  

Click each link to more about the same. 



 

 

  

APPROVE DCR 

REJECT DCR 

MODIFY DCR 

CANCEL DCR 

APPROVE DCR 

a. Click the APPROVE button to approve the DCR. 

  



 

 

 

  

b. Click the YES button. 



 

 

  

 

  

c. Click the ISSUE WITH DSC button. 

  

 

  

d. A success message is displayed that Demand is approved and Demand ID is generated. Click the 

CANCEL button to go to Dashboard. 

  



 

 

 



 

 

REJECT DCR 

a. Click the REJECT button to reject the DCR. 

  



 

 

 

  

b. In the Reason for Rejection/Modification field, enter the reason for rejection. 



 

 

  

 



 

 

  

c. Click the REJECT button to reject the DCR. 

  



 

 

 

  



 

 

d. Click the YES button. 

  

 

  

e. Click the ISSUE WITH DSC button. 

  

 

  

f. A success message is displayed that Reference ID is rejected. Click the CANCEL button to go to 

Dashboard. 

  



 

 

 



 

 

MODIFY DCR 

a. Click the MODIFY button to modify the DCR, if you want to modify any entry.  

  



 

 

 

  



 

 

b. You can edit the fields like Order No., Order Date, Date of Service of Order etc. highlighted in the 

screenshot below. In the Reason for Rejection/Modification field, enter the reason for modification. 

  



 

 

 



 

 

  

c. After making the changes, click the APPROVE button. 

  



 

 

 



 

 

  

d. Click the YES button. 

  

  

 

  

e. Click the ISSUE WITH DSC button. 

  

 

  

d. A success message is displayed that Demand is approved and Demand ID is generated. Click the 

CANCEL button to go to Dashboard. 

  



 

 

 



 

 

CANCEL DCR 

a. Click the CANCEL button to go back to the DCR Dashboard. 

  



 

 

 

  

  



 

 

 

Manual > Update Demand & Collection 
Register for Earlier Laws 

A. Update Entry in DCR 

B. Review Entry in DCR 

A. How can I update entry in DCR for Earlier Laws? 

To update entry in DCR for Earlier Laws, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal. 

3. Navigate to Statutory Functions > Demand and Collection Register > Update DCR option. 

  

 

  

The UPDATE DCR page is displayed. 

  

 

  

4. You can search the demand either by entering Demand ID/ GSTIN/Temporary ID/ Name of taxpayer. 

5. Click the SEARCH button. 

The search results are displayed. 

6. Click the Demand ID link to view the details of demand. 

  



 

 

 

  

7. The UPDATE DCR - EARLIER LAWS page is displayed. 

  



 

 

 

  

8. Select the Status for View DCR from the Updation of Status for View DCR drop-down list. 

  



 

 

 

  

9. Click the ADD button and enter the details. 

  



 

 

 

  

10. Select the details from the drop-down list. 

  



 

 

 

  

11. You can select “CR” for any amount recovered from taxpayer and “DR” for any increase in demand 

amount. 

  

 

  

12. Enter the Tax and Interest details and use the scroll bar to move right to enter other details.  

  



 

 

 

  

13. Enter the Date of Payment, Challan No./Order No. and Remarks for payment made.  

  



 

 

 

  

14. Amount Pending for Recovery is displayed based on details entered.  

  



 

 

 

  

15. Scroll to the right using the scroll bar to view other details . 

16. Select Yes for Recovery to be initiated immediately in case amount pending has to be recovered 

immediately. Or else, select No, 

17. In case you select No, in the Reason field, enter the reason for not recovering the demand 

immediately. 

18. Click the Choose File button to upload any supporting document. 

Note: You can upload PDF/ JPEG file format only with maximum 4 files of 5 MB each.  

19. Click the SUBMIT button. 

  



 

 

 

  

20. A success message is displayed that demand is updated. Once you update the DCR, this will go to 

Senior Recovery Officer for review. 

  



 

 

 

B. How can I review entry in DCR? 

To review entry in DCR, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal as a Senior Recovery Officer. 

3. The Senior Recovery Officer's Dashboard is displayed. Click on the DCR tab.  

  



 

 

 

  

4. This tab shows all the DCRs pending with tax official for review. Click on the Review DCR entries 

received link to view the list of DCRs that needs to be reviewed.  

  

 

  

5. Click the Reference no. link to view the DCR. 

  



 

 

 

  

6. The DCR Entry for Review  page is displayed. You can either Approve, Reject, Modify or Cancel the 

DCR. 

  



 

 

 

  

7. Click each link to know more about the same. 

  

(i). APPROVE DCR 

(ii). REJECT DCR 

(iii).MODIFY DCR 

(vi). CANCEL DCR 



 

 

7(i) APPROVE DCR 

a. Click the APPROVE button to approve the DCR. 

  

 

  

b. Click the YES button. 

  



 

 

 

  

c. Click the SUBMIT WITH DSC button. 

  

 

  

d. A success message is displayed that Demand is updated. Click the CANCEL button to go to 

Dashboard. 

  



 

 

 

7(ii) REJECT DCR 

a. Click the REJECT button to reject the DCR. 

  



 

 

 

  

b. In the Reason for Rejection/Modification field, enter the reason for rejection. 

  



 

 

 

  

c. Click the REJECT button to reject the DCR. 

  



 

 

 

  

d. Click the YES button. 

  



 

 

 

  

e. Click the ISSUE WITH DSC button. 

  

 

  

f. A success message is displayed that Reference ID is rejected. Click the CANCEL button to go to 

Dashboard. 

  



 

 

 

7(iii) MODIFY DCR 

a. Click the MODIFY button to modify the DCR. 

  



 

 

 

  

b. Edit the details and In the Reason for Rejection/Modification field, enter the reason for modification. 

c. After making the changes, click the APPROVE button. 

  



 

 

 

  

d. Click the YES button. 

  



 

 

 

  

e. Click the ISSUE WITH DSC button. 

  

 

  

d. A success message is displayed that Demand is updated. Click the CANCEL button to go to 

Dashboard. 

  



 

 

 

7(iv) CANCEL DCR 

a. Click the CANCEL button to go back to the DCR Dashboard. 

  



 

 

 

  

  

  

  



 

 

Recovery 

Overview > Recovery 

Processing of Applications for Deferred Payment or Payment in 

Instalments 

 FAQs 

 Manual 

Initiating Proceedings for Recovery of Taxes from Taxpayer 

 FAQs 

 Manual 

Letter to Liquidator in case of Liquidation of Company 

 FAQs 

 Manual 

  



 

 

Overview > Recovery 

Processing of Applications for Deferred Payment or Payment in 

Instalments 

 FAQs 

 Manual 

Initiating Proceedings for Recovery of Taxes from Taxpayer 

 FAQs 

 Manual 

Letter to Liquidator in case of Liquidation of Company 

 FAQs 

 Manual 

  

  



 

 

Processing of Applications for Deferred Payment or 
Payment in Instalments 

FAQs > Processing of Applications for 
Deferred Payment or Payment in Instalments 

1. How are the applications for deferred payment or payment in instalments 

processed on the GST Portal? 

All the application for payment in instalment/deferred payment submitted by the taxpayer will land in the 

Commissioner’s queue. Commissioner, after verifying the form of application for payment in 

instalment/deferred payment and after getting relevant material information from the recovery officer, shall 

approve/modify/reject the application. GST Portal allots a number to the approval/rejection order so 

issued. 

2. Does the system calculate interest on the instalments/deferred payment 

automatically? 

The system will not calculate interest on the instalments/deferred payment automatically.  In case there is 

any lateral interest, then tax officer may create a demand for same and issue DRC-07.  

3. What actions take place on the GST Portal once I approve, modify or 

reject the application? 

Once you have accepted, modified or rejected an applicat ion for deferred/payment in Instalments, 

following actions will take place on the GST Portal:  

 Approval, Modification or Rejection order will be generated and intimation of issue of order shall 

be sent via email and SMS to taxpayer. 

 Status of ARN shall get updated to ‘Rejected’ in case of rejection, "Approved" in case of 

acceptance, and "Application approved with modification" in case of modification.  

 Order will be available at the dashboard of taxpayer for view, print and download: Dashboard > 

Services > User Services > View Additional Notices/Orders  

 Status of Recovery ID remains the same in case of rejection.  

 In case of acceptance or modification: 

i. DCR will be updated with recovery status as “Deferred Payment/Payment by Instalments” against the 

Recovery ID and Instalment calendar will be updated (for Payment in Instalment application) 

ii. An alert for change in Recovery Case status (if any) at the time of approval of Application for Payment 

in Instalment/Deferred Payment will be sent to assigned Recovery Officer.  



 

 

4. What happens in case there is no Recovery ID created for a Demand for 

which payment is pending and I have approved the application for payment 

in instalment filed by the taxpayer? 

In case there is no Recovery ID created for a Demand for which payment is pending and taxpayer files 

application for payment in instalment and same is approved, then Recovery ID will be generated on the 

following day of the default in payment by the taxpayer as a consequence of instalment/deferred payment 

order issued by Commissioner. 

5. During the processing of applications for deferred payment or payment 

in instalments, what all and when the Status changes take place in an 

ARN/Case ID on the GST Portal? 

On the GST Portal, during the processing of applications for deferred payment or payment in instalments, 

the ARN/Case ID may undergo following Status changes:  

  

1. Pending for Processing: When a taxpayer files the application and it is under work item of tax 

officer 

2. Approved: When tax officer approves the application  

3. Application approved with modification: When tax officer approves the application with certain 

modifications  

4. Rejected: When tax officer rejects the application  

6. Will the interest be calculated by system as part of application for 

deferred payment/payment in instalment? 

Interest will not be calculated by system as part of application for deferred payment/payment in 

instalment. Instead, if any interest needs to be recovered from taxpayer as part of monthly instalment 

then tax officer will create separate demand ID which will be paid by taxpayer.   



 

 

 

Manual > Processing of Applications for 
Deferred Payment or Payment in Instalments 

How can I process applications for deferred payment or payment in 

instalments? 

To process application for deferred payment or payment in instalments, perform following steps: 

  

A. Search for an already-created ARN/Case ID 

B. Take action using APPLICATIONS tab of Case Details screen: View Application filed by the 

taxpayer 

C. Take action using ORDERS tab of Case Details screen: Issue or view Approval Order or 

Modification Order or Rejection Order 

  

Click each hyperlink above to know more. 

A. Search for an already-created ARN/Case ID 

To search for a particular ARN/Case ID, perform following steps: 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Recovery > Application for Deferred Payment/Payment in 

Instalments option. 

 

 

  

4.  Application for Deferred Payment/Payment in Instalments page is displayed. It has two sections. 

From the top section, you can search for the ARNs/Case IDs and from the section below it, you can open 

ARNs/Case IDs pending for processing.  

  



 

 

 

  

4a. To open ARNs/Case IDs pending for processing, click the ARN hyperlinks. 

  

 

  

4b. To search ARNs, choose any one of the five displayed search fields as your search criteria, enter the 

required information: ARN, GSTIN, Status (select from the drop-down list) or From Date & To Date, and 

click the SEARCH button. This will display the search results. Click the ARN hyperlink of the case you 

want to act on.  

  



 

 

 

  

Note: You must enter data in at least one field before clicking SEARCH.   

  

5. Case Detail page is displayed. From this page, you can initiate proceedings related to this 

particular case by operating on the tabs provided at the left-hand side of the page: APPLICATIONS, 

ORDERS.  

  

 

  

Note 1: On this page, the APPLICATIONS tab is selected by default.  

  

Note 2: Currently, Status of the ARN/Case is "Pending for Processing". It will change once you 

adjudicate on the application and either Accept or Reject the taxpayer's request.  

  

Go back to the Main Menu 

B. Take action using APPLICATIONS tab of Case Details screen: View 

Application filed by the taxpayer 

To view Application filed by the taxpayer, perform following steps:  

  



 

 

1. On the Case Details page of that particular application, select the APPLICATIONS tab, if it is not 

selected by default. This tab provides you an option to view the application in PDF mode, as filed by 

taxpayer with all the supporting documents, if attached by taxpayer while filing the application.  

  

 

  

  

2. Click the View hyperlink to download and view the application in PDF mode.  

  

Go back to the Main Menu 

  

C(1). Approval Order  

To issue an approval order, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, click the ORDERS tab, if not selected by 

default.  This tab will display order issued against the ARN/Case ID. Click ADD ORDER to open the 

drop-down list and select APPROVAL ORDER. 

  

 

  

  

2. APPROVAL ORDER page is displayed. Most of the fields are auto-populated. Enter the required 

data in the displayed fields to proceed as mentioned in the following steps . To go back to the 

previous page, click BACK.  



 

 

  

 

  



 

 

Note: In case the applicant has requested for Monthly installments, the data of Expected Monthly 

Instalments is also displayed and an additional "Select First Payment Month" field appears as shown 

in the image below. Select the radio button against Current Month or Next Month.  

  

 

  

  

2a. In the Order Number field, click the Generate Order Number hyperlink. Order Number field gets 

auto-populated. 

  

 

  

2b. Click Download Template  to download and manually fill details of Order and then convert it in to PDF 

format.  

  

2c. Click Choose File button to upload the converted PDF.  

  

2d. Click the ISSUE WITH DSC button.  A warning message popup is displayed. Click YES.  

  



 

 

 

  

3. The Notice/Reminder/Order page is displayed with a Warning message. On this page also, click 

the ISSUE WITH DSC button.  

  

 

  

4. The Dashboard page is displayed with a confirmation message. Click OK.  

  

 

  

  



 

 

5. The updated ORDERS tab is displayed, with the record of the issued Approval Order and the 

Status updated to "Approved".  

  

 

  

6. Additionally, the following actions take place on the GST Portal after the issue of the Order.  

7. Intimation of the issue of order is sent to the concerned taxpayer on his/her registered email id 

and SMS. 

8. Dashboard of the Taxpayer is updated with the record of the issued Order. Taxpayer can view the 

issued order from the following navigation: Services > User Services > View Additional 

Notices/Orders. 

i. DCR will be updated with recovery status as “Deferred Payment/Payment by Instalments” against the 

Recovery ID and Instalment calendar will be updated (for Payment in Instalment application) 

ii. An alert for change in Recovery Case status (if any) at the time of approval of Application for Payment 

in Instalment/Deferred Payment will be sent to assigned Recovery Officer.  

  

Go back to the Main Menu 

C(2). Modification Order  

 To issue a modification order, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, click the ORDERS tab, if not selected by 

default.  This tab will display order issued against the ARN/Case ID. Click ADD ORDER to open the 

drop-down list and select MODIFICATION ORDER. 

  

 



 

 

  

  

  

2. MODIFICATION ORDER page is displayed. Most of the fields are auto-populated. Enter the 

required data in the displayed fields to proceed as mentioned in the following steps . To go back to 

the previous page, click BACK.  

  



 

 
 



 

 

  

Note: In case the applicant has requested for Monthly installments, the data of Expected Monthly 

Instalments is also displayed and two additional fields appear.  

i. In "Number of Months", you can modify the number of months and click CALCULATE. Updated 

Expected Monthly Instalments based on your chosen number of months will be displayed.  

ii. In "Select First Payment Month" field, select the radio button against Current Month or Next Month. 

  

 

  

2a. In the Order Number field, click the Generate Order Number hyperlink. Order Number field gets 

auto-populated. 

  

 

  

2b. Click Download Template  to download and manually fill details of Order and then convert it in to PDF 

format.  

  

2c. Click Choose File button to upload the converted PDF.  

  



 

 

2d. In Reason for Modification field, enter details of issuing this modification order.  

  

2e. Click the ISSUE WITH DSC button.  A warning message popup is displayed. Click YES.  

  

 

  

3. The Notice/Reminder/Order page is displayed with a Warning message. On this page also, click 

the ISSUE WITH DSC button.  

  

 

  

4. The Dashboard page is displayed with a confirmation message. Click OK.  

  



 

 

 

  

  

5. The updated ORDERS tab is displayed, with the record of the issued Modified Order and the 

Status updated to "Application approved with modification".  

  

 

  

6. Additionally, the following actions take place on the GST Portal after the issue of the Order.  

7. Intimation of the issue of order is sent to the concerned taxpayer on his/her registered email id 

and SMS. 

8. Dashboard of the Taxpayer is updated with the record of the issued Order. Taxpayer can view the 

issued order from the following navigation: Services > User Services > View Additional 

Notices/Orders. 

i. DCR will be updated with recovery status as “Deferred Payment/Payment by Instalments” against the 

Recovery ID and Instalment calendar will be updated (for Payment in Instalment application) 

ii. An alert for change in Recovery Case status (if any) at the time of approval of Application for Payment 

in Instalment/Deferred Payment will be sent to assigned Recovery Officer.  

  

Go back to the Main Menu 

C(3). Rejection Order 

To issue a rejection order, perform following steps: 

  

1. On the Case Detail page of that particular taxpayer, click the ORDERS tab, if not selected by 

default.  This tab will display order issued against the ARN/Case ID. Click ADD ORDER to open the 

drop-down list and select REJECTION ORDER. 

  



 

 

 

  

  

  

2. REJECTION ORDER page is displayed. Most of the fields are auto-populated. Enter the required 

data in the displayed fields to proceed as mentioned in the following steps. To go back to the 

previous page, click BACK.  

  



 

 

 



 

 

  

Note: In case the applicant has requested for Monthly installments, the data of Expected Monthly 

Instalments is also displayed.  

  

 

  

2a. In the Order Number field, click the Generate Order Number hyperlink. Order Number field gets 

auto-populated. 

  

 

  

2b. Click Download Template  to download and manually fill details of Order and then convert it  in to PDF 

format.  

  

2c. Click Choose File button to upload the converted PDF.  

  

2d. In Reason for Rejection field, select one of the displayed radio buttons against the reason of issuing 

this rejection order. If you select the radio button against Others, also give brief description of the reason.  

  

2e. Click the ISSUE WITH DSC button.  A warning message popup is displayed. Click YES.  

  



 

 

 

  

3. The Notice/Reminder/Order page is displayed with a Warning message. On this page also, click 

the ISSUE WITH DSC button.  

  

 

  

4. The Dashboard page is displayed with a confirmation message. Click OK.  

  

 

  

  



 

 

5. The updated ORDERS tab is displayed, with the record of the issued Rejection Order and the 

Status updated to "Rejected".  

  

 

  

6. Additionally, the following actions take place on the GST Portal after the issue of the Order. 

7. Intimation of the issue of order is sent to the concerned taxpayer on his/her registered email id 

and SMS. 

8. Dashboard of the Taxpayer is updated with the record of the issued Order. Taxpayer can view the 

issued order from the following navigation: Services > User Services > View Additional 

Notices/Orders. 

  

Go back to the Main Menu 

  

  



 

 

Initiating Proceedings for Recovery of Taxes from 
Taxpayer 

FAQs > Initiating Proceedings for Recovery of 
Taxes from Taxpayer 

1. I am not getting Recovery link in my Dashboard. Why? 

You may not have been assigned the role of Recovery Officer or Assistant to Recovery Officer by the 

State Admin. Request your state admin to allocate you the Recovery Officer or Assistant to Recovery 

Officer role. Once the role is assigned you will be allocated Recovery module for further action.  

As Assistant to Recovery Officer, you will have "Read Only Access" to all folders and "Add" access to 

REFERENCES tab for uploading any supporting document or downloading the templates.  

  

Click here to learn about the various roles available in Tax Officials Interface and how the Admin can 

assign the role to Tax Officials. 

2. When recovery process in GST Portal is initiated? 

Recovery process in GST Portal is initiated under following conditions:  

Demand is created under Assessment, Enforcement, Appeal or Refund and 

 Prescribed time limit under the GST law for making the payment of GST has expired or 

 Stay Order against the recovery proceedings is not passed i.e., it is in recoverable stage 

3. What are the various modes of recovery process? 

In GST regime, where any sum is payable by the taxpayer on account of scrutiny, assessment, 

enforcement, adjudication or appeal process, and the amount remains unpaid, the tax authorities can 

initiate the recovery process by adopting any of the following modes as provided in the GST laws:  

 Detaining and selling of goods of the taxpayer in the possession of the tax department/ other 

officer 

 Issuance of letter / correspondence to third parties including banks / any other government 

departments/ debtors/ any other person provided in law/ successor or transferee or legal 

heir/Application before the Civil Court requesting execution for a decree 

 Distrain, detain and sell immovable and movable property 

 Issuance of certificate to revenue authorities for recovery as arrears of Land Revenue 

 Application to magistrate to recover as fine 

 Utilization of Cash/ITC from taxpayer’s ledger 

 Any other mode as prescribed under law 



 

 

4. When Recovery ID can be created? 

Recovery ID can be created for all Demand ID, from DCR, when any of following conditions exists:  

1. For return related liability - 3 months from the date of creation of Demand ID or earlier date (if 

mentioned) or next date from the due date of filing the return.  

2. If appeal is filed before the above period (except in case of returns related demands), then Recovery ID 

will be created on the date on which Order of First appeal is passed and recovery is  to be done. 

3. For others, Recovery and Demand ID for return related Liability can be created on the next day of due 

date of filling the Return or actual date of filling the Return, which ever is later.  

5. How will I know if any recovery ID is allocated to me? 

Navigate to Statutory Functions > My Tasks option to view the Recovery ID allocated to you and act on 

the recovery case. 

6. How can I make recovery against a taxpayer in case of mode of recovery 

as "Sale of taxable goods in control of Recovery officer"? 

To make recovery against a taxpayer in case of mode of recovery as "Sale of taxable goods in control of 

Recovery officer", perform following steps: 

  

1. Log into the GST Back Office Portal and send a notice to the taxpayer as to why the recovery should 

not be proceeded with. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail 

> NOTICES > Select Mode of Recovery as Sale of taxable goods in control of Recovery officer > 

 Select Notice Type as FORM GST DRC - 10 to issue notice for recovery to taxpayer. 

2. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > Replies tab to view 

the reply furnished by the taxpayer. In case of no reply or unsatisfactory response from the taxpayer, you 

can continue with the recovery process. The procedure of sale of goods through Auction /E-Auction is a 

manual process, mostly by Public Auction (to be conducted offline). The amount realized via sale needs 

to be adjusted towards outstanding dues and sale certificate needs to be issued to the taxpayer.  

3. Issue the notice of auction of goods to bidders offline. Navigate to Statutory Functions > Recovery > 

Recovery Cases > Case Detail > REFERENCES > Download Template > FORM GST DRC - 10 option 

to download the template to issue the notice of auction indicating the goods to be sold and the purpose of 

sale. 

4. Once the proceedings are completed and the sale proceeds are realized, log into the GST Back Office 

Portal. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > 

REFERENCES > option to upload the notice issued to bidders.  

5. After successful auction, navigate to Statutory Functions > Recovery > Recovery Cases > Case 

Detail > REFERENCES > Download Template > FORM GST DRC - 11 option to download the template 

to issue the notice to the successful bidder requiring him to make the payment.  



 

 

6. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > REFERENCES > 

option to upload the notice issued to the successful bidder.  

On payment of the full bid amount, transfer the possession of the said goods to the successful bidder.  

7. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > 

CERTIFICATES/ORDERS > Select Mode of Recovery > FORM GST DRC - 12 option issue a sale 

certificate. 

8. After receiving the amount from successful bidder, deposit the amount received from auction in 

Electronic Cash Ledger of the taxpayer reducing administrative cost or others by creating challan using 

“Create Challan” functionality and deposit the amount in cash ledger of the taxpayer. 

9. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > RECOVERY 

DETAILS > UTILIZE CASH/ITC option to initiate recovery against taxpayer by utilizing the Electronic 

Credit/Cash Ledger of the taxpayer. 

10. In case, recovery cannot be successfully completed, navigate to Statutory Functions > Recovery > 

Recovery Cases > Case Detail > RECOVERY DETAILS > DROP PROCEEDINGS  option to drop the 

particular mode of recovery. 

7. How can I make recovery against a taxpayer in case of mode of recovery 

as "Attachment/Seizure of Immovable/Movable properties by Tax 

Authorities"? 

To make recovery against a taxpayer in case of mode of recovery as "Attachment/Seizure of 

Immovable/Movable properties by Tax Authorities", perform following steps: 

  

1. Log into the GST Back Office Portal and send a notice to the taxpayer as to why the recovery should 

not be proceeded with. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail 

> NOTICES > Select Mode of Recovery as Attachment/Seizure of Immovable/Movable properties 

by Tax Authorities >  Select Notice Type as FORM GST DRC - 16 or FORM GST DRC - 22 to issue 

notice for recovery to taxpayer. 

2. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > Replies tab to view 

the reply furnished by the taxpayer.  

2 (a). In case of satisfactory response from the taxpayer, when recovery officer is satisfied that 

property attached is no longer liable for attachment or after giving an opportunity to taxpayer of 

being heard or if the taxpayer pays the amount, then such property can be released by issuing an 

order. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > 

CERTIFICATES/ORDERS > Select Mode of Recovery > FORM GST DRC - 23 option to issue 

order for restoration of provisionally attached property. 

2 (b). In case of no reply or unsatisfactory response from the taxpayer, you can continue with the 

recovery process. The procedure of attaching and sale of immovable/movable goods/shares of 

taxpayer through Auction /E-Auction is a manual process, mostly by Public Auction (to be 



 

 

conducted offline). The amount realized via sale needs to be adjusted towards outstanding dues 

and sale certificate needs to be issued to the taxpayer.  

3. Issue the notice of auction of goods to bidders offline. Navigate to Statutory Functions > Recovery > 

Recovery Cases > Case Detail > REFERENCES > Download Template > FORM GST DRC - 10 option 

to download the template to issue the notice of auction indicating the goods to be sold and the purpose of 

sale. 

4. Once the proceedings are completed and the sale proceeds are realized, log into the GST Back Office 

Portal. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > 

REFERENCES > option to upload the notice issued to bidders.  

5. After successful auction, navigate to Statutory Functions > Recovery > Recovery Cases > Case 

Detail > REFERENCES > Download Template > FORM GST DRC - 11 option to download the template 

to issue the notice to the successful bidder requiring him to make the payment.  

6. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > REFERENCES > 

option to upload the notice issued to the successful bidder.  

On payment of the full bid amount, transfer the possession of the said goods to the successful bidder. 

7. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > 

CERTIFICATES/ORDERS > Select Mode of Recovery > FORM GST DRC - 12 option issue a sale 

certificate. 

8. After receiving the amount from successful bidder, deposit the amount received from auction in 

Electronic Cash Ledger of the taxpayer reducing administrative cost or others by creating challan using 

“Create Challan” functionality and deposit the amount in cash ledger of the taxpayer.  

9. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > RECOVERY 

DETAILS > UTILIZE CASH/ITC option to initiate recovery against taxpayer by utilizing the Electronic 

Credit/Cash Ledger of the taxpayer. 

10. In case, recovery cannot be successfully completed, navigate to Statutory Functions > Recovery > 

Recovery Cases > Case Detail > RECOVERY DETAILS > DROP PROCEEDINGS  option to drop the 

particular mode of recovery. 

8. How can I make recovery against a taxpayer in case of mode of recovery 

as "Notice to Third Parties"? 

To make recovery against a taxpayer in case of mode of recovery as "Notice to Third Parties", perform 

following steps: 

  

1. Log into the GST Back Office Portal and send a notice to the taxpayer as to why the recovery should 

not be proceeded with. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail 

> NOTICES > Select Mode of Recovery as Notice to Third Parties >  Select Notice Type as FORM 

GST DRC - 13 or FORM GST DRC - 15 to issue notice for recovery to taxpayer. 

2. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > Replies tab to view 

the reply furnished by the taxpayer. In case of no reply or unsatisfactory response from the taxpayer, you 



 

 

can continue with the recovery process. The Recovery Officer need to send the notice to third party in 

offline mode.  

3. Issue the notice to third party offline. Navigate to Statutory Functions > Recovery > Recovery Cases 

> Case Detail > REFERENCES > Download Template > FORM GST DRC - 13 or FORM GST DRC - 

15 option to download the template to issue the notice to third party.  

4. Log into the GST Back Office Portal. Navigate to Statutory Functions > Recovery > Recovery Cases 

> Case Detail > REFERENCES > option to upload the notice issued to third party.  

5. After payments, navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > 

REFERENCES > Download Template > FORM GST DRC - 14 option to download the template to issue 

the certificate of payment to third person.  

6. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > REFERENCES > 

option to upload the certificate of payment issued to third person.  

7. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > 

CERTIFICATES/ORDERS > Select Mode of Recovery > FORM GST DRC - 14 option issue a sale 

certificate. 

8. After receiving the amount from third party, deposit the amount in Electronic Cash Ledger of the 

taxpayer reducing administrative cost or others by creating challan using “Create Challan” functionality 

and deposit the amount in cash ledger of the taxpayer. 

9. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > RECOVERY 

DETAILS > UTILIZE CASH/ITC option to initiate recovery against taxpayer by utilizing the Electronic 

Credit/Cash Ledger of the taxpayer. 

10. In case, recovery cannot be successfully completed, navigate to Statutory Functions > Recovery > 

Recovery Cases > Case Detail > RECOVERY DETAILS > DROP PROCEEDINGS  option to drop the 

particular mode of recovery. 

9. How can I make recovery against a taxpayer in case of mode of recovery 

as "Notice to Specified Officers"? 

To make recovery against a taxpayer in case of mode of recovery as "Notice to Specified Officers", 

perform following steps: 

  

1. Log into the GST Back Office Portal and send a notice to the taxpayer as to why the recovery should 

not be proceeded with. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail 

> NOTICES > Select Mode of Recovery as Notice to Specified Officers >  Select Notice Type as 

FORM GST DRC - 09 to issue notice for recovery to taxpayer. 

2. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > Replies tab to view 

the reply furnished by the taxpayer. In case of no reply or unsatisfactory response from the taxpayer, you 

can continue with the recovery process. 



 

 

3. Issue the notice to specified officer offline. Navigate to Statutory Functions > Recovery > Recovery 

Cases > Case Detail > REFERENCES > Download Template > FORM GST DRC - 09 option to 

download the template to issue the notice to specified officer. 

4. Log into the GST Back Office Portal. Navigate to Statutory Functions > Recovery > Recovery Cases 

> Case Detail > REFERENCES > option to upload the notice issued to specified officer.  

5. If Specified Officer has obtained any money in Recovery Process, he will send this money to the 

Recovery Officer. After receiving the amount from the specified officer, deposit the amount in Electronic 

Cash Ledger of the taxpayer reducing administrative cost or others by creating challan using “Create 

Challan” functionality and deposit the amount in cash ledger of the taxpayer.  

6. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > RECOVERY 

DETAILS > UTILIZE CASH/ITC option to initiate recovery against taxpayer by utilizing the Electronic 

Credit/Cash Ledger of the taxpayer. 

7. In case, recovery cannot be successfully completed, navigate to Statutory Functions > Recovery > 

Recovery Cases > Case Detail > RECOVERY DETAILS > DROP PROCEEDINGS  option to drop the 

particular mode of recovery. 

10. How can I make recovery against a taxpayer in case of mode of 

recovery as "Issuance of Certificate to Revenue Authorities"? 

To make recovery against a taxpayer in case of mode of recovery as "Issuance of Certificate to Revenue 

Authorities", perform following steps: 

  

1. Log into the GST Back Office Portal and send a notice to the taxpayer as to why the recovery should 

not be proceeded with. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail 

> CERTIFICATES/ORDERS > Select Mode of Recovery > FORM GST DRC - 18 option to send a 

certificate to the Collector or Deputy Commissioner of the district or any other officer to recover the 

amount. 

2. Issue the certificate offline. Navigate to Statutory Functions > Recovery > Recovery Cases > Case 

Detail > REFERENCES > Download Template > FORM GST DRC - 18 option to download the template 

to send a certificate to the Collector or Deputy Commissioner of the district or any other officer to recover 

the amount. 

3. Log into the GST Back Office Portal. Navigate to Statutory Functions > Recovery > Recovery Cases 

> Case Detail > REFERENCES > option to upload the certificate issued.  

4. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > REFERENC ES > 

option to upload reply received from Revenue Authority. 

5. After receiving the amount, deposit the amount in Electronic Cash Ledger of the taxpayer reducing 

administrative cost or others by creating challan using “Create Challan” functionality and deposit the 

amount in cash ledger of the taxpayer. 



 

 

6. Navigate to Statutory Functions > Recovery > Recovery Cases > Case Detail > RECOVERY 

DETAILS > UTILIZE CASH/ITC option to initiate recovery against taxpayer by utilizing the Electronic 

Credit/Cash Ledger of the taxpayer. 

7. In case, recovery cannot be successfully completed, navigate to Statutory Functions > Recovery > 

Recovery Cases > Case Detail > RECOVERY DETAILS > DROP PROCEEDINGS  option to drop the 

particular mode of recovery. 

11. From where can I change status of the Recovery Case ID? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Recovery > Recovery 

Cases > Case Detail > RECOVERY DETAILS > CHANGE STATUS option. 

  

If a Recovery Officer wants to hold any recovery in abeyance, then with reasons he can change the 

status from recoverable to ‘Held in abeyance’. When the status of the Recovery Case ID is changed to 

"Held in Abeyance", option to utilize Cash/ ITC is disabled. 

In case, status is already in Held in abeyance then Recovery Officer can click on “Change Status” button 

and change it to “Recoverable” at any stage. When the status of the Recovery Case ID is changed to " 

Recoverable ", option to utilize Cash/ ITC is abled again on the GST Portal for the officer.  

12. What happens once the status of the Recovery Case ID is changed to 

"Held in Abeyance"? 

When the status of the Recovery Case ID is changed to "Held in Abeyance", option to utilize Cash/ ITC 

is disabled. 

13. What type of notices can be issued? 

Based on Mode of Recovery selected, relevant notice type can be issued. The table below provides the 

list of notice types which can be issued based on mode of recovery. 

  

Mode of Recovery Notice Type 

Sale of taxable goods in control of 

Recovery officer 

FORM GST DRC - 10 (Notice for Auction of Goods under section 

79 (1) (b) of the Act) 

Notice to Third Parties 

FORM GST DRC - 13  (Notice to a third person under section 

79(1) (c)) 

FORM GST DRC - 15 (Application before the Civil Court 

requesting execution for a Decree) 

Attachment/Seizure of 

Immovable/Movable properties by 

Tax Authorities 

FORM GST DRC - 16 (Notice for attachment and sale of 

immovable/movable goods/shared under section 79) 

FORM GST DRC - 22 (Provisional attachment of property under 



 

 

section 83) 

Application to Magistrate for 

recovery as Fine 

FORM GST DRC - 19 (Application to the Magistrate for Recovery 

as Fine) 

Notice to Specified Officer 
FORM GST DRC - 09 (Order for recovery through specified 

officer under section 79) 

14. What type of certificates/ orders can be issued? 

Based on Mode of Recovery selected, relevant certificate/ order type can be issued. The table below 

provides the list of certificate/ order type which can be issued based on mode of recovery selected. 

  

Mode of Recovery Certificate/ Order Type  

Sale of taxable goods in control 

of Recovery officer 
FORM GST DRC - 12 (Sale Certificate) 

Notice to Third Parties 
FORM GST DRC - 14 (Certificate of Payment to a Third 

Person) 

Attachment/Seizure of 

Immovable/Movable properties 

by Tax Authorities 

FORM GST DRC - 12 (Sale Certificate) 

FORM GST DRC - 23 (Restoration of provisionally 

attached property / bank account under section 83) 

Issuance of Certificate to 

Revenue Authorities 

FORM GST DRC - 18 (Certificate action under clause (e) 

of sub-section (1) section 79) 

Recovery from other state 
FORM GST DRC - 18 (Certificate action under clause (e) 

of sub-section (1) section 79) 

15. From where can I initiate recovery against taxpayer by utilizing the 

Electronic Credit/Cash Ledger of the taxpayer? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Recovery > Recovery 

Cases > Case Detail > RECOVERY DETAILS > UTILIZE CASH/ITC option. 

16. What happens after recovery against taxpayer is done by utilizing the 

Electronic Credit/Cash Ledger of the taxpayer? 

In case of utilization from Electronic Credit/Cash ledger, Debit entry numbers is generated.  

1. Electronic Credit/Cash Ledger of the taxpayer gets updated. 

2. Intimation is sent to the taxpayer via SMS and E-mail on such utilization from Electronic Credit/Cash 

Ledger. 

3. Electronic Liability Register and DCR gets updated. 



 

 

4. “Mode of Recovery” column under Recovery Details folder gets updated with the amount recovered 

and date of transaction. 

17. From where can I view the reply filed by the taxpayers? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Recovery > Recovery 

Cases > Case Detail > REPLIES option. 

18. From where can I issue notice? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Recovery > Recovery 

Cases > Case Detail > NOTICES option. 

19. From where can I issue orders to the taxpayers? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Recovery > Recovery 

Cases > Case Detail > CERTIFICATES/ ORDER option. 

20. From where can I add additional documents related to Recover Case 

ID? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Recovery > Recovery 

Cases > Case Detail > REFERENCES option. 

21. From where can I download the template? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Recovery > Recovery 

Cases > Case Detail > REFERENCES option. 

22. Does a taxpayer get any intimation about the notice or order issued to 

them? 

Taxpayer will get intimation of all notices and orders issued to him/her though SMS and e-mail and 

dashboard of taxpayer is updated with the record of the issued notice/ order.  

23. What are the various recovery statuses? 

The list below provides the list of statuses for recovery: 

  

Status Recoverability  Trigger 



 

 

Recoverable  Yes 

1. As soon as a Recovery ID is created 

2. Upon re-initiation of the recovery proceedings after the 

expiry of demand payment deadline for the revised / 

rectification order 

3. Recovery Officer changes the status from "Held in 

Abeyance" to "Recoverable"  

Not 

Recoverable  
No  

1. As soon as the demand becomes "stayed" in Appeal 

module 

2. In case, the revised / rectification / appeal / other orders 

lead to either demand amount become zero or negative  

In Liquidation  Yes 

As soon as the Commissioner sets the liquidation flag for the 

GSTIN in DCR, upon receipt of intimation of liquidation 

proceedings.   

Held in 

Abeyance  
No  

Recovery Officer changes the status from "Recoverable" to 

"Held in Abeyance"  

Recovered  NA Demand is fully settled by making full payment  

Deferred 

Payment / 

Payment by 

Instalments  

No  
As soon as the Deferred Payment / Payment by Instalments 

application form is approved by the Commissioner  

24. What is enhancement or reduction of amount in appeal? 

Section 84 of the CGST Act provides that where government dues are enhanced in appeal, revision or 

other proceeding, the taxable person shall be served with a demand notice only in respect of the 

enhanced demand, and recovery proceedings in relation to hitherto government dues may be continued 

from the stage at which they were before disposal of appeal, revision or other proceedings.  

  

Further, in case of reduction in government dues in any appeal, revision or other proceedings, an 

intimation of reduction shall be sent to taxable person via Demand Notice and appropriate authority with 

whom recovery is pending. The recovery proceedings for the reduced demand shall be continued from 

the stage it was prior to disposal of appeal, revision or other proceedings. 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Recovery > Recovery 

Cases > Case Detail > NOTICES option. 



 

 

 

Manual > Initiating Proceedings for Recovery 
of Taxes from Taxpayer 

How can I act on the pending recovery cases? 

To act on the pending recovery cases, in the role of Recovery Officer, perform following steps:  

  

A. Go to Recovery Cases: 

 A (1) Searching for the Recovery Use Cases by providing Recovery Use Case ID or 

GSTIN/Temporary ID or Status or Recovery ID Creation Date 

 A (2) Through My Tasks 

B. Take action using RECOVERY DETAILS tab of Case Detail page: 

 B (1) Initiate recovery against taxpayer by utilizing the Electronic Credit/Cash Ledger of the 

taxpayer 

 B (2) Drop Proceedings 

 B (3) Change Status of Recovery Case ID, if required 

C. Take action using NOTICES tab of Case Detail page: Issue Notice to the Taxpayer 

D. Take action using REPLIES tab of Case Detail page: View Replies by the Taxpayer, if any 

E. Take action using CERTIFICATES/ORDERS tab of Case Detail page: Issue Certificate or Order 

F. Take action using REFERENCES tab of Case Detail page: 

 F (1) Add Reference Document 

 F (2) Download Template 

  

Click each hyperlink above to know more. 

A (1). Go to Recovery Cases page by either searching for the Recovery Use 

Case ID or GSTIN/Temporary ID or Status or Recovery ID Creation Date 

To go to recovery case page, perform following steps: 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Recovery > Recovery Cases option. 

  

 

  



 

 

4. The Recovery Cases search page is displayed. Choose any one of the four displayed fields as your 

search criteria and enter the required information: Recovery Use Case ID or GSTIN/Temporary ID or 

Status or Recovery ID Creation Date . 

Note: You must enter data in at least one of the field to proceed.   

Further following status will be available in Status drop-down list. 

  

 

  

5. Click the SEARCH button. 

  

 

  

6. Based on your search criteria, the required Recovery Case IDs gets displayed. Click the Recovery 

Case ID hyperlink of the case you want to act on.   

  



 

 

 

  

7. The Recovery Case Detail page is displayed. From this page, you can initiate recovery process related 

to this particular case by operating on the tabs provided at the left-hand side of the page: RECOVERY 

DETAILS, NOTICES, REPLIES, CERTIFICATES/ORDERS and REFERENCES. 

Note: On this page, the RECOVERY DETAILS tab is selected by default.  

  

 

  

Go back to the Main Menu 

A (2). Go to Recovery Cases page through My Tasks 

To go to recovery case page, perform following steps: 



 

 

  

1. Access the GST Back Office Portal for tax officials.  

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > My Tasks option. 

  

 

  

4. The Task List search page is displayed. Choose any one of the three displayed fields as your search 

criteria and enter the required information: ARN or Reference ID or Status or Task List Creation Date . 

Note: You must enter data in at least one of the field to proceed.   

5. Click the SEARCH button. 

  

 

  

6. Based on your search criteria, the ARN gets displayed. Click the Recovery Case ID hyperlink of the 

case you want to act on.   

  

 

  

7. The Recovery Case Detail page is displayed. From this page, you can initiate recovery process related 

to this particular case by operating on the tabs provided at the left -hand side of the page: RECOVERY 

DETAILS, NOTICES, REPLIES, CERTIFICATES/ORDERS and REFERENCES. 

Note: On this page, the RECOVERY DETAILS tab is selected by default.  

  



 

 

 

  

Go back to the Main Menu 

B (1). Initiate recovery against taxpayer by utilizing the Electronic 

Credit/Cash Ledger of the taxpayer 

To Initiate recovery against taxpayer by utilizing the Electronic Credit/Cash Ledger of the taxpayer, 

perform following steps: 

  

1. On the Case Detail page, select the RECOVERY DETAILS tab if it is not selected by default.  

2. Click UTILIZE CASH/ITC at the bottom of the page. 

Note: You can also click the UTILIZE CASH button in case you want to initiate recovery against taxpayer 

by only utilizing the Electronic Cash Ledger of the taxpayer. 

  



 

 

 

  

3. The Payment of Demand page is displayed. 

  



 

 

 

  

4 (a). Liability Details 

4.1. Liability details are displayed as shown in below table. 

  



 

 

 

  

4.2. Use the scroll bar to move to the right to enter the amount intended to be recovered. 

  

 

  

4 (b). Cash Ledger Balance 

4.3. The cash available as on date are shown in below table. 

  



 

 

 

  

4.4. Use the scroll bar to move to the right to enter the amount to be recovered through cash against the 

liability. 

  

 

  

4 (c). Credit Ledger Balance 

4.5. The ITC available as on date are shown in below table. 

  

 

  



 

 

4.6. Use the scroll bar to move to the right to enter the amount to be recovered through ITC against the 

liability. 

  

 

  

5. Once you have entered the amount, click the SET-OFF button. 

  



 

 

 

  

6. A confirmation message is displayed. Click the OK button. 

  



 

 

 

  

7. A success message is displayed. Payment Reference Number (PRN) is displayed on the screen. Click 

the OK button. 

  

 

  

8. The updated case detail page is displayed with “Mode of Recovery” column under Recovery Details 

folder gets updated with the amount recovered and date of transaction.  

  



 

 

 

  

Note: 

 In case of utilization from Electronic Credit/Cash ledger, Debit entry numbers is generated.  

 Electronic Credit/Cash Ledger of the taxpayer gets updated. 

 Intimation is sent to the taxpayer via SMS and E-mail on such utilization from Electronic 

Credit/Cash Ledger. 

 Electronic Liability Register and DCR gets updated. 

  

Go back to the Main Menu 

B (2). Drop Proceedings 

To drop proceedings of a particular mode of recovery of a particular Recovery Case ID, perform following 

steps: 



 

 

  

1. On the Case Detail page, select the RECOVERY DETAILS tab if it is not selected by default.  

2. Click DROP PROCEEDINGS to drop recovery by a particular mode of recovery. 

  

 

  

3. Enter the reason for dropping proceedings in the Remarks column. 

4. Click the Choose File button to upload any supporting document from your machine. 

5. Click OK. 

  



 

 

 

  

6. The status of Reference Number is changed to Proceedings Dropped. You can click the 

Proceedings Dropped link to view the remarks. 

  

 

  

7. The remarks entered is displayed. Click CLOSE. 

  



 

 

 

  

Go back to the Main Menu 

B (3). Change Status of Recovery Case ID, if required 

To change status of Recovery Case ID to Held in Abeyance or to make it Recoverable, perform 

following steps: 

  

1. On the Case Detail page, select the RECOVERY DETAILS tab if it is not selected by default.  

2. Click CHANGE STATUS. 

  

 

  

3. The status of the Recovery Case ID is changed to "Held in Abeyance" in this case. 

Note: When the status of the Recovery Case ID is changed to "Held in Abeyance", option to utilize 

Cash/ ITC is disabled. 

  



 

 

 

  

Go back to the Main Menu 

C. Issue Notice to the Taxpayer 

To issue a notice to the taxpayer, perform following steps: 

  

1. On the Case Detail page, select the NOTICES tab if it is not selected by default.  

2. Click ADD NOTICE. 

  

 

  

3. The Notice page is displayed. 

  



 

 

 

  

4 (a). In case there is Enhancement/ Reduction in Appeal  

  

4.1. Select Enhancement/ Reduction in Appeal as Yes. 

4.2. Select Notice Type to be issued from the drop-down list. 

  



 

 

 

  

4.3. Click the Generate Notice Number hyperlink. Notice Number field gets auto-populated.  

4.4. Click the Download Template  link to download the template. 

4.5. The Template is downloaded. Open the downloaded template.  

4.6. Click the Enable Editing button. 

4.7. Enter the details.  
4.8. Once you have entered the details, click on the File button in top left corner.  
4.9. Click the Save As button.  
4.10. Now select the location to save the file and in the File Name list, type or select a name for the 
document.  

4.11. In the Save as type list, select PDF. 

4.12. Click the Save button. 

4.13. After entering the details, click the Choose File button to upload the PDF. 

4.14. Click Upload Notice to upload the notice from your machine. 

  



 

 

 

  

4.15. Click ISSUE with DSC.  

  



 

 

 

  

4.16. Click PROCEED button.  

  

 

  

4.17. Click ISSUE with DSC.  

  



 

 

 

  

4.18. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

4.19. The updated Case Detail page is displayed, with the table containing the record of the notice just 

issued.  

  

 

  

4 (b). In case there is no Enhancement/ Reduction in Appeal  

  

4.1. Select Enhancement/ Reduction in Appeal as No. 

4.2. Select Mode of Recovery to be issued from the drop-down list. 



 

 

  

 

  

4.2. Select Notice Type to be issued from the drop-down list. 

Based on Mode of Recovery selected above, relevant notice type can be selected as shown in the 

screenshot below. 

  

Mode of Recovery Notice Type 

Sale of taxable 

goods in control of 

Recovery officer 

   

 

  

Notice to Third 

Parties 
  



 

 

 

  

Attachment/Seizure 

of 

Immovable/Movable 

properties by Tax 

Authorities 

  

 

  

Application to 

Magistrate for 

recovery as Fine 

  

 

  

Notice to Specified 

Officer 

  

 

  

  

4.3. Click the Generate Notice Number hyperlink. Notice Number field gets auto-populated.  

4.4. Click the Download Template  link to download the template. 



 

 

4.5. Enter the details and save as PDF. 

4.6. Click Upload Notice to upload the notice from your machine. 

  

 

  

4.7. Click ISSUE with DSC.  

  



 

 

 

  

4.8. Click PROCEED button.  

  

 

  

4.9. Click ISSUE with DSC.  

  



 

 

 

  

4.10. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

4.11. The updated Case Detail page is displayed, with the table containing the record of the notice just 

issued. Taxpayer will be intimated of the notice issued through SMS and e-mail. 

  

 

  

Go back to the Main Menu 

D. View Replies by the Taxpayer, if any 



 

 

To view replies submitted by the taxpayer, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the REPLIES tab. This tab displays all 

replies filed by the taxpayer. 

  

 

  

2. Click the documents in the Action section to download and ascertain their contents.  

  

 

  

Go back to the Main Menu 

E. Issue Certificate or Order 

To issue a certificate or order, perform following steps: 

  

1. On the Case Detail page, select the CERTIFICATES/ORDERS tab if it is not selected by default.  

2. Click ADD CERTIFICATE / ORDER. 

  



 

 

 

  

3. The Certificate/ Order page is displayed. 

  

 

  

4. Select Mode of Recovery to be issued from the drop-down list. 

  



 

 

 

  

5. Select Certificate/ Order Type  to be issued from the drop-down list. 

Based on Mode of Recovery selected above, relevant certificate/ order type can be selected as shown in 

the screenshot below. 

  

Mode of Recovery Certificate/ Order Type  

Sale of taxable 

goods in control of 

Recovery officer 

   

 

  

Notice to Third 

Parties 
  



 

 

 

  

Attachment/Seizure 

of 

Immovable/Movable 

properties by Tax 

Authorities 

  

 

  

Issuance of 

Certificate to 

Revenue 

Authorities 

  

 

  

Recovery from 

other state 

  

 

  

  

6. Click the Generate Certificate/ Order Number hyperlink. Certificate/ Order Reference Number field 

gets auto-populated.  

7. Click the Download Template  link to download the template. 



 

 

8. Follow the same steps as explained earlier to download the template, add details and save the word 

template to PDF. 

9. Click Upload Certificate/ Order to upload the Certificate/ Order from your machine. 

  

 

  

10. Click ISSUE with DSC.  

  



 

 

 

  

11. Click PROCEED button.  

  

 

  

12. Click ISSUE with DSC.  

  



 

 

 

  

13. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

14. The updated Case Detail page is displayed, with the table containing the record of the Certificate/ 

Order just issued. Taxpayer will be intimated of the Certificate/ Order issued through SMS and e-mail. 

  

 

  

Go back to the Main Menu 

F (1). Add Reference Document 



 

 

To add any reference documents, in the role of Assistant to Recovery Officer, perform following steps: 

  

1. On the Case Detail page, select the REFERENCES tab if it is not selected by default. This tab displays 

the additional documents uploaded by the Recovery Officer which can be uploaded at any stage for 

maintaining the same in records and is related to the selected recovery id.  

2.  Click the ADD REFERENCE button. 

  

 

  

3. In the Type of Reference  field, enter the name of type of document to be uploaded. 

4. In the Document Submitted By field, enter the name of type of person who is submitting the 

document. 

5. Click the SUBMIT button. 

  



 

 

 

  

6. Click the YES button. 

  

 

  

7. A success message is displayed and the updated Case Detail page is displayed, with the table 

containing the reference document just added.  

  



 

 

 

  

Go back to the Main Menu 

F (2). Download Template 

To download any template of the notified form, perform following steps: 

  

1. On the Case Detail page, select the REFERENCES tab if it is not selected by default. 

2.  Select the type of template to be downloaded from the Download Template  drop-down list. 

  

 

  

3. Click the Download Template link. 

  



 

 

 

  

4. The template is downloaded on your machine. 

  

 

  

Go back to the Main Menu 

  

  



 

 

Letter to Liquidator in case of Liquidation of Company 

FAQs > Letter to Liquidator in case of 
Liquidation of Company 

1. I am not getting "Liquidation Cases" link in my Dashboard. Why? 

You may not have been assigned the role of Commissioner by the State Admin. You may request your 

State Admin to allocate you the role of Commissioner. Once the role is assigned, you will be allocated 

'Liquidation Cases' link for further action. 

  

Click here to learn about the various roles available in Tax Officials Interface and how Admin can assign 

the role to Tax Officials. 

2. What are the pre-conditions to issue a letter to the liquidator of company 

intimating the current demand and likely demand under GST? 

When Commissioner receives an intimation from liquidator of a company informing about liquidation 

proceedings against any company, against which adjudged dues are pending, or a demand proceedings 

have been initiated, he/she can issue a letter to the liquidator of company intimating the outstanding 

demands due and demand and notices issued/ likely to be issued against the company under GST.  
Note: Intimation about winding up of Company to be received from Liquidator is an Offline process.   

3. How can issue a letter to the liquidator of company intimating the current 

demand and likely demand under GST? 

To issue a letter to the liquidator of company intimating the current demand and likely demand under 

GST, perform following steps: 

1. Create a case ID against GSTIN for winding up 

2. Search for the Liquidation Use Cases by providing Liquidation Case ID or GSTIN/Temporary ID or 

Status or Liquidation ID Creation Date 

3. View taxpayer's details along with Demand ID's pending against the GSTIN 

4. Issue Order in Form GST DRC-24, for intimation to Liquidator for recovery of amount 

5. Once the amount is realised by Liquidator against the GSTIN, the amount will be deposited in the 

Electronic Cash Ledger of taxpayer which can be utilized by Recovery officers and Jurisdictional Officers 

for utilizing the amount against pending demand. Recovery officer will create challan using “Create 

Challan” functionality and deposit the amount in Electronic Cash Ledger of the taxpayer.  



 

 

4. By when intimation of current demand and anticipated demand under 

GST should be sent to the Liquidator? 

Intimation to the Liquidator need to be sent within 3 months of receiving the Intimation of the appointment 

of the liquidator. 

5. How will Recovery Officers be intimated of demand? 

Alert to Recovery Officers about intimation of anticipated demand will be sent automatically upon 

updating of DCR by Commissioner. 

6. What is meant by flagging GSTIN for winding up? 

When a Tax Official flags GSTIN for Winding up, all the pending demands against that particular GSTIN 

gets flagged and status of Recovery in process gets changed to “In Liquidation”. By doing this 

Commissioner can issue a letter to the liquidator of company intimating the current demand and likely 

demand under GST, for recovery. 

7. From where can I flag GSTIN for winding up? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Demand and 

Collection Register > View DCR option. 

8. If a particular GSTIN has multiple demands pending against a taxpayer 

with separate demand ID, can a Tax Official flag GSTIN for one specific 

demand? 

No, Tax Official cannot flag GSTIN for winding up of only a specific or selected demands pending against 

a taxpayer. When a Tax Official flags GSTIN for winding up, all the pending demands against that 

particular GSTIN gets flagged for recovery. 

9. From where can I view demand details against GSTIN? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Demand and 

Collection Register > View DCR option. 

10. From where can I upload additional documents related to liquidation? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Recovery > 

Liquidation Cases > Case Search > REFERENCES option. 



 

 

11. From where can I issue order related to liquidation? 

After logging in to the GST Back Office portal, navigate to Statutory Functions > Recovery > 

Liquidation Cases > Case Search > ORDERS option. 

12. Can I edit the tax details which are auto-populated based on Demand ID 

pending against the GSTIN while issuing the Form GST DRC-24 Order? 

Yes, you can edit the tax details which are auto-populated based on Demand ID pending against the 

GSTIN while issuing the Form GST DRC-24 Order. You can either increase/ decrease the tax details. 

13. What will happen once Commissioner flags the GSTIN for liquidation? 

Once Commissioner flags the GSTIN for liquidation: 

 DCR will be updated with a flag about winding up of company. 

 Demand ID’s connected to liquidating GSTIN in the DCR will be flagged to show winding up of 

company. 

14. What will happen once Commissioner issues a letter to the liquidator of 

company intimating the current demand and likely demand under GST? 

Once Commissioner issues a letter to the liquidator of company intimating the current demand and likely 

demand under GST 

 Status of Liquidation Case ID is changed to "Intimation Sent to Liquidator".  

 An Intimation of current and anticipated demand will be sent to the Liquidator.  

15. What needs to be done once amount is realized by Liquidator against 

the GSTIN? 

Once the amount is realized by Liquidator against the GSTIN, the amount will be deposited in the 

Electronic Cash Ledger of taxpayer which can be utilized by Recovery officers and Jurisdic tional Officers 

against pending demand. Recovery officer will create challan using “Create Challan” functionality and 

deposit the amount in Electronic Cash Ledger of the taxpayer against the specific demand Id.  

Click here to know more about how to create challan. 

16. What are the various statuses under "Letter to Liquidator in case of 

Liquidation of Company"? 

Various statuses under "Letter to Liquidator in case of Liquidation of Company" are:  

1. Liquidation Case Initiated: When liquidation case is created against GSTIN for winding up 



 

 

2. Intimation sent to Liquidator: Once Commissioner issues a letter to the liquidator of company intimating 

the current demand and likely demand under GST 



 

 

 

Manual > Letter to Liquidator in case of 
Liquidation of Company 

How can I issue a letter to the liquidator of company, intimating the current 

demand and likely demand under GST? 

To issue a letter to the liquidator of company, intimating the current demand and likely demand under 

GST, in the role of Commissioner, perform following steps: 

  

A. Go to View DCR: Flag GSTIN for Winding Up 

B: Searching for a Liquidation Use Case 

C. Using LIQUIDATION CASE tab: View Demand Details 

D. Take action using ORDERS tab: Issue Order 

E. Take action using REFERENCES tab: Add Reference Document 

  

Click each hyperlink above to know more. 

A. Go to View DCR: Flag GSTIN for Winding Up 

To create a case ID against GSTIN for winding up, perform following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal. 

3. Navigate to Statutory Functions > Demand and Collection Register > View DCR option. 

  

 

  

4. The DEMAND AND COLLECTION REGISTER (DCR) search page is displayed.  

Click  here to know more about how to search demand. 

  



 

 

 

  

5. Click the Advanced Search link to flag a particular GSTIN for winding up. 

6. Enter the GSTIN/ Temporary ID against which winding up has to be initiated. 

7. Click the FLAG GSTIN FOR WINDING UP button. 

  



 

 

 

  

8. Click the YES button. 

  

 

  

9. A confirmation message is displayed that liquidation case has been created successfully. Once a 

GSTIN is flagged, a case ID is created with status as “Liquidation Case Initiated” against that GSTIN. 

Once the case ID is created, Commissioner can view all the liquidation cases under Statutory Functions 

> Recovery > Liquidation Cases.  

  

Note: You cannot flag GSTIN for winding up of only a specific or selected demands pending against a 

taxpayer. When GSTIN is flagged for winding up, all the pending demands against that particular GSTIN 

with Recoverable status gets flagged for recovery. 

  



 

 

 

  

Go back to the Main Menu 

B: Searching for a Liquidation Use Case 

To view all the liquidation cases, perform following steps:  

  

1. Access the GST Back Office Portal for tax officials. 

2. Login using your valid credentials. The Home page is displayed. 

3. Navigate to Statutory Functions > Recovery > Liquidation Cases option. 

  

 

  

4. Search page is displayed. Choose any one of the four displayed fields as your search criteria and enter 

the required information: Liquidation Case ID, GSTIN/Temporary ID, Status or Liquidation Case ID 

Creation From and To Date . 

Note: You must enter data in at least one field to proceed.   

  

 

  

5. Click the SEARCH button. 

  



 

 

 

  

6. Based on your search criteria, the required Liquidation Case ID(s) gets displayed. Click the 

Liquidation Case ID hyperlink of the case you want to act on.   

  

 

  

7. Liquidation Case Detail page is displayed. From this page, you can initiate liquidation process by 

operating on the tabs provided at the left-hand side of the page: LIQUIDATION CASE, ORDERS and 

REFERENCES. 

Note: On this page, the LIQUIDATION CASE tab is selected by default.  

  



 

 

 

  

Go back to the Main Menu 

C. Using LIQUIDATION CASE tab: View Demand Details 

To view details of demand pending against a taxpayer, along with Demand ID's, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the LIQUIDATION CASE tab if it is not 

selected by default. This tab displays the taxpayer and demand detai ls pending against the GSTIN 

2. Click the Hyperlinks links under Pending Demand Amount column to view the demand details under 

minor heads.  

  



 

 

 

  

3. The demand details under minor heads are displayed.  

4. Click the Close button. 

  

 

  

Go back to the Main Menu 

D. Take action using ORDERS tab of Case Detail page: Issue Order 

To issue Order in Form GST DRC-24, for intimation to Liquidator for recovery of amount, perform 

following steps: 

  



 

 

1. On the Case Detail page of that particular GSTIN, select the ORDERS tab if it is not selected by 

default. This tab displays a table of all the records for which you would issue orders against the case 

created.  

2. Click ADD ORDER button. 

  

 

  

3. The Order page is displayed. 

  



 

 

 

  

4. GST DRC-24 (Intimation to Liquidator for Recovery of Amount) is auto-populated in the Order 

Type drop-down list.  

5. Note that tax details are auto-populated based on Demand ID pending against the GSTIN in the 

editable format. You can edit the figures shown to add the Current/ Anticipated amount under major and 

minor heads.  

6. Scroll to the right using scroll bar to enter more details.  

  



 

 

 

  

7. Enter details in Penalty, Fees and Others column. 

  

 

  

8. Click the Generate Order Number hyperlink. Order Number field gets auto-populated.  

  



 

 

 

  

9. Click the Download Template  link to download the template to upload the order. 

  

 

  

10. The Form GST DRC-24 Template is downloaded. Open the downloaded template.  

11. Click the Enable Editing button. 

  



 

 

 
 
12. Enter the details.  
13. Once you have entered the details, click on the File button in top left corner.  
    

 
    
14. Click the Save As button.  



 

 

15. Now select the location to save the file and in the File Name list, type or select a name for the 
document.  

16. In the Save as type list, select PDF. 

17. Click the Save button. 

  

 
   

18. After entering the details, click the Choose File button to upload the PDF as created above. 

  

 

  

19. Select the PDF file which was saved and click the Open button. 

20. You can use the Delete button to delete the uploaded document, if required.  

  



 

 

 

  

21. Click ISSUE with DSC.  

  

 

  

22. Click the YES button. 

  



 

 

 

  

23. The Dashboard page is displayed with the following confirmation message. Click OK.  

  

 

  

24. The updated Case Detail page is displayed, with the table containing the record of the order just 

issued. 

Note:  

 Status of Liquidation Case ID is changed to "Intimation Sent to Liquidator".  

 Once the amount is realised by Liquidator against the GSTIN, the amount will be deposited in the 

Electronic Cash Ledger of taxpayer which can be utilized by Recovery officers and Jurisdictional 

Officers for utilizing the amount against pending demand. Recovery officer will create challan 

using “Create Challan” functionality and deposit the amount in Electronic Cash Ledger of the 

taxpayer. 

  

 

  

Go back to the Main Menu 



 

 

E. Take action using REFERENCES tab of Case Detail page: Add Reference 

Document 

To upload any additional documents or communication related to the case, perform following steps:  

  

1. On the Case Detail page of that particular taxpayer, select the REFERENCES tab if it is not selected 

by default. This tab displays all communications sent against the case created.  

2. Click ADD REFERENCE button. 

  

 

  

3. The ADD REFERENCE page is displayed. 

  

 

  

4. In the Type of Reference  field, enter the type of reference document which is being uploaded. 



 

 

5. In the Document Submitted By field, enter the name of official who submitted the document.  

6. Click the Choose File button to upload any attachment. 

Note: 

 File with PDF format is only allowed. 

 Maximum file size for upload is 5MB. 

 Maximum 5 documents can be attached in the application.  

7. Click the SUBMIT button.  

  

 

  

8. Click the YES button. 

  

 



 

 

  

9. The updated Case Detail page is displayed, with the table containing the record of the reference of 

case. 

  

 

  

Go back to the Main Menu 



 

 

Grievance Management 

Overview > Grievance Management 

Addressing Grievances 

 FAQs 

 Manual 

Viewing Grievance History 

 Manual 

Searching Grievance Details 

 Manual 

  



 

 

Overview > Grievance Management 

Addressing Grievances 

 FAQs 

 Manual 

Viewing Grievance History 

 Manual 

Searching Grievance Details 

 Manual 

  

  



 

 

Addressing Grievances 

FAQs > Addressing Grievances 

1. For which issues can a taxpayer raise a grievance? 

  

Grievance can be raised in case of following issues: 

a. Grievance related to GST applications issues 

b. Complaint against a tax payer 

c. Grievance related to tax payment 

  

2. Who can report grievances? 

  

Any registered taxpayer and any person can report grievances. 

  

3. How can I address a Grievance / Complaints on the GST Portal? 

  

Navigate to Grievances > Grievances Dashboard to address a Grievance / Complaints on the GST 

Portal. 

  

4. How can view the history of the Grievance / Complaints filed on the GST 

Portal? 

  

Navigate to Grievances > History to view the history of a Grievance / Complaints on the GST Portal.  

  

5. What will happen if the grievance officer does not take any action on the 

Grievance / Complaints filed on the GST Portal? 

  

In case the grievance officer does not take any action for 3 days, the grievance case will be forwarded to 

the supervisor of the grievance officer against whom the grievance has been raised.  



 

 

In case the supervisor does not take any action for 3 days, the grievance will be forwarded to his 

supervisor and so on. 

  

6. Can I forward the Grievance / Complaints filed on the GST Portal to any 

Tax Official? 

  

Yes, you can forward the Grievance / Complaints filed on the GST Portal to anyone within State/ Centre/ 

UT. 

  

  



 

 

Manual > Addressing Grievances 

How can I address grievances/ complaints filed on the GST Portal? 

To address grievances/ complaints filed on the GST Portal, perform the following steps:  

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Grievances option. 

  

 

  

4. Grievance Dashboard is displayed by default. Select the Grievance Number link. 

  



 

 

 

  

Grievance details are displayed. Here, you can Close/ Forward/ Classify the grievance.  

  

Close Grievance: 

  

5. Click the Choose File button and upload the response document. 

6. Click the CLOSE button. 

  

 

  

7. Enter the remarks for internal reference which can be viewed only by Tax Official. 

8. Enter the remarks for external reference which can be viewed only by taxpayer.  

9. Click the CLOSE button. 

  



 

 

 

  

10. A confirmation message is displayed. Click the Yes button. 

  

 

  

A confirmation message is displayed that Grievance is successfully closed. 

  

 

  

Forward Grievance: 



 

 

5. Click the FORWARD button. 

6. Enter the remarks for internal reference. 

7. Click the FORWARD button. 

  

 

  

8. Select the Role of the officer from the drop-down list. 

9. Click the SEARCH button. 

The search results are displayed. 

10. Select the name of the Tax Authority to whom you want to forward the grievance.  

11. Click the FORWARD button. 

  

 

  

12. A confirmation message is displayed. Click the Yes button. 

  



 

 

 

  

A confirmation message is displayed that Grievance is successfully forwarded.  

  

 

  

Classify Grievance: 

5. Click the CLASSIFY button. 

6. Select Confidential/ Non-Confidential from the drop-down list. 

7. Click the CLASSIFY button. 

  

 

  

A success message is displayed that the grievance is classified.  

  



 

 

 

  

  



 

 

Manual > Viewing Grievance History 

How can I view the history related to grievances/ complaints filed on the 

GST Portal? 

To search the history related to grievances/ complaints filed on the GST Portal, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Grievances option. 

  

 

  

4. Click the History tab. 

  



 

 

 

  

5. Select the grievance date using the calendar. 

6. Click the SEARCH button. 

  

 

  

The search results are displayed. Click the Grievance Number link to view the grievance details. 

  

 

  

You can click the arrow button to view the logs. 

  



 

 

 



 

 

Manual > Searching Grievance Details 

How can I search details related to grievances/ complaints filed on the GST 

Portal? 

To search the details related to grievances/ complaints filed on the GST Portal, perform following steps: 

  

1. Access the GST Portal. The GST Home page is displayed. 

2. Using your valid credentials, login to the GST Portal.  

3. Click the Grievances option. 

  

 

  

In case of Search: 

  

4. Click the Search tab. 

  



 

 

 

  

5. In the Grievance Number field, enter the grievance number. Or else, in the GSTIN/ UIN field, enter the 

GSTIN or UIN of the taxpayer. 

6. Click the SEARCH button. 

  

 

  

The details related to grievance number are displayed. 

  



 

 

 

  

In case of Advance Search: 

  

4. Click the Advance Search tab. 

  

 

  

5. Select the appropriate choice from list of options displayed to search the details.  

6. Click the SEARCH button. 

  

 

  

The details related to grievance are displayed. 

  



 

 

 

  

  

  

  

  

 


